
__ , ____ ._, ..... _ .. __ 

__ , ____ .... ___ _ 

- ·- ... .. .,. ,. 
__ ,. ___ .. -

, ......... 

.... 

Version 6
User Manual 

V.4.03
 March 19, 2025

1800 Shames Drive, Westbury, NY 11590 Tel: (516) 334-0870 Fax: (516) 338-4741 Email: sales@electroind.com 



   This page intentionally left blank.



     Doc#    E107707   i

CommunicatorPQA® and MeterManagerPQA® Version 6 Software User 

Manual V. 4.03

Published by:

Electro Industries/GaugeTech (EIG)

1800 Shames Drive

Westbury, NY 11590

Copyright Notice

All rights reserved. No part of this publication may be reproduced or transmitted in 

any form or by any means, electronic or mechanical, including photocopying, record-

ing, or information storage or retrieval systems or any future forms of duplication, for 

any purpose other than the purchaser's use, without the expressed written permission 

of Electro Industries/GaugeTech.

© 2025 Electro Industries/GaugeTech

Nexus®, Shark®, CommunicatorPQA®, MeterManagerPQA®, EnergyPQA.com®, and 

EnergyPQA® are registered trademarks of Electro Industries/GaugeTech. The distinc-

tive shapes, styles and overall appearances of the Nexus® 1500/1500+ meter and 

the Shark® meters are trademarks of Electro Industries/GaugeTech. MP200TM, V-

SwitchTM, Accu-MeasureTM, Constant CalibrationTM, HMIPQATM, HMIPQA+TM, and Ener-

gyReporterPQATM are trademarks of Electro Industries/GaugeTech.

Microsoft®, Excel®, and Windows® are either registered trademarks or trademarks 

of Microsoft Corporation in the United States and/or other countries.

Modbus® is a registered trademark of Schneider Electric, licensed to the Modbus 

Organization, Inc.

LTE is a trademark of ETSI.
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Customer Service and Support

Customer support is available 8:00 am to 8:00 pm, Eastern Standard Time, Monday 

through Friday. Please have the serial number and a detailed problem description 

available. When returning any merchandise to EIG, a return materials authorization 

number is required. For customer or technical assistance, phone 516-334-0870 or fax 

516-338-4741.

Disclaimer

The information presented in this publication has been carefully checked for 

reliability; however, no responsibility is assumed for inaccuracies. The information 

contained in this document is subject to change without notice.

Our Focus at Electro Industries/GaugeTech (EIG)

EIG exclusively delivers integrated energy and power quality monitoring solutions uti-

lizing AI and deep industry expertise to improve reliability, efficiency, and sustainabil-

ity. With over 50 years' experience in the electrical industry, EIG has developed 

extensive energy management and power quality expertise to help customers find 

ideal solutions to complex challenges. Our corporate culture promotes being cutting 

edge and investing in R&D to continually improve our customer experience.

Our solutions are designed to deliver results in days, not years. Known for our reputa-

tion as being a dependable provider and for exemplary service and support, EIG is 

committed to customer satisfaction. 
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License Agreement for Electro Industries/GaugeTech Software 
Applications

EIG SOFTWARE END USER LICENSE AGREEMENT (EULA)

This legal document is an Agreement between Electro Industries/GaugeTech ("EIG") 

and You, as the end user of EIG's software ("SOFTWARE"). EIG licenses this SOFT-

WARE to You only upon the condition that You accept all of the terms contained in this 

Agreement.  

BY SELECTING THE "AGREE" BUTTON BELOW THIS AGREEMENT OR BY INSTALLING, 

UPLOADING, ACCESSING, OR OTHERWISE COPYING OR USING ALL OR ANY PORTION 

OF THE SOFTWARE, YOU AGREE TO BE LEGALLY BOUND BY THE TERMS OF THIS 

AGREEMENT. 

IF YOU DO NOT ACCEPT THE TERMS OF THIS AGREEMENT, YOU MUST NOT USE THE 

SOFTWARE. If You are proposing to load the SOFTWARE from a disk or other portable 

media, select the "DISAGREE" button and the loading of the SOFTWARE will be can-

celed. If You are proposing to download the SOFTWARE or a License Key, do not do 

so. If You have acquired a physical software pack, do not open it. Promptly return the 

unopened software pack and other items (including the License Key, written materi-

als, binders or other containers, and hardware, if any) accompanying this Agreement 

to the place where You obtained them for a full refund. 

INSTALLATION, UPLOADING, ACCESS, OR OTHER COPYING OR USE OF THIS SOFT-

WARE OR ANY ACCOMPANYING DOCUMENTATION OR MATERIALS EXCEPT AS PER-

MITTED BY THIS AGREEMENT IS UNAUTHORIZED AND CONSTITUTES A MATERIAL 

BREACH OF THIS AGREEMENT AND AN INFRINGEMENT OF THE COPYRIGHT AND 

OTHER INTELLECTUAL PROPERTY RIGHTS IN SUCH SOFTWARE, DOCUMENTATION 

AND MATERIALS. YOU MAY BE LIABLE TO EIG FOR DAMAGES, AND YOU MAY BE SUB-

JECT TO CRIMINAL PENALTIES.

1.DEFINITIONS

1.1. "You" "Your" or "End User" shall refer to any individual or entity (including that 

entity's parent or affiliated companies) that installs, uploads, accesses or otherwise 

copies the SOFTWARE.



     Doc#    E107707      iv

1.2."EIG", "Electro", "Company", "we", "us", et al. shall refer to EI Electronics, LLC, d/

b/a Electro Industries/Gauge Tech.

1.3."SOFTWARE" shall refer to any one and/or any combination of the following soft-

ware provided by EIG:

1.3.1.CommunicatorPQA® application;

1.3.2.MeterManagerPQA® application;

1.3.3.EnergyReporterPQA™ application; and

1.3.4.HMIPQA™ application. 

As used herein, the term "SOFTWARE" may refer to any one of the above-listed soft-

ware applications individually or any combination thereof.

1.4"Hosted Software" means online software, platform and websites which You can 

access via the SOFTWARE and are maintained by EIG. 

1.5 "End User Data" means data entered or uploaded by You to the Hosted Software 

via the SOFTWARE and/or data pushed to the Hosted Software via the SOFTWARE 

including, but not limited to, data aggregated from metering devices, non-metering 

devices, etc., and data generated by the SOFTWARE.

1.6 "EIG Data" means all information, including, but not limited to, data, analyses, 

measurements, reports, trends, and metrics, generated from, derived from, based on 

or related to End User Data.

1.7"Computing Device" means any computing device or computing platform on which 

the SOFTWARE is installable or installed. 

1.8"Website" means the website accessible at EnergyPQA.com® or via the SOFT-

WARE.

2. GRANT OF LICENSE. In consideration of payment of the license fee and Your

Agreement to abide by the terms and conditions of this Agreement, EIG grants to You

the following non-exclusive rights:
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(a) Installation and Use. You may install and use one copy of the SOFTWARE program

on a single Computing Device at a single location, in accordance with the applicable

User Documentation and within the scope of this Agreement. The Computing Device

cannot have more than one copy (i.e. session or instance) of the SOFTWARE running

at any one time. EIG's license grant (and, with that grant, Your right to install and use

the SOFTWARE and User Documentation) is conditioned on Your continuous compli-

ance with all license limitations, restrictions and other terms in this Agreement. If You

violate any of these limitations, restrictions or other terms, the license grant will auto-

matically and immediately terminate. The license descriptions in this Section 2 (Grant

of License) define the scope of rights that EIG grants to You. Any usage of the SOFT-

WARE and/or User Documentation outside the scope of the applicable license grant or

otherwise not in accordance with this Agreement constitutes an infringement of EIG's

intellectual property rights as well as a material breach of this Agreement.

(b) Backup Copies. You may make one copy of the SOFTWARE solely for backup pur-

poses.

(c) Network Use. You may also install a copy of the SOFTWARE on a central storage

device, such as a network server, from which other computers and/or Computing

Devices may use it; however, You must acquire and dedicate a license for each copy

(i.e. session or instance) of the SOFTWARE running at any one time. A license for the

SOFTWARE may not be shared or used concurrently on different computers and/or

Computing Devices.

(d) Prohibited Use. EIG does not permit the following use and You acknowledge that

such use and/or actions shall be prohibited:

i.) Use. You may not (and may not permit any third party to) install, access, or other-

wise copy or use the SOFTWARE except as expressly authorized by this Agreement. 

ii.) Reverse Engineering. You may not (and may not permit any third party to) reverse 

engineer, decompile or disassemble the SOFTWARE.

iii.) Transfers. You may not distribute, rent, loan, lease, sell, sublicense, or otherwise 

transfer all or a portion of the SOFTWARE, or any rights granted in this Agreement, to 

any other person or legal entity without the prior written consent of EIG. 

iv.) Hosting or Third Party Use. You may not install or access, or allow the installation 

or access of, the SOFTWARE over the Internet, including without limitation, use in 
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connection with a Web hosting, commercial time-sharing, service bureau, or similar 

service, or make the SOFTWARE available to third parties via the Internet on Your 

computer system or otherwise.

v.) Notices. You may not remove, alter, or obscure any proprietary notices, labels, or 

marks from or on the SOFTWARE. 

vi.) Modifications. You may not modify, translate, adapt, arrange, or create derivative 

works based on the SOFTWARE for any purpose. 

vii.) Circumvention. You may not utilize any equipment, device, software, or other 

means designed to circumvent or remove any form of copy protection used by EIG in 

connection with the SOFTWARE, or use the SOFTWARE together with any authoriza-

tion code, serial number, or other copy-protection device not supplied by EIG directly 

or through an authorized distributor. In the case of a network version, You may not 

utilize any equipment, device, software, or other means designed to circumvent or 

remove the License Manager. You may not utilize any equipment, device, software, or 

other means designed to circumvent or remove any usage restrictions, or to enable 

functionality disabled by EIG in connection with the SOFTWARE. You may not bypass 

or delete any functionality or technical limitations of the SOFTWARE that prevent or 

inhibit the unauthorized copying or use of the SOFTWARE. 

viii.) Export. You may not export the SOFTWARE in violation of this Agreement, or 

U.S., or other applicable export control laws.

3.COLLECTION AND USE OF YOUR INFORMATION. You acknowledge that when You

download, install or use the SOFTWARE, EIG may use automatic means (including, for

example, cookies and web beacons) to collect information about Your Computing

Device and about Your use of the SOFTWARE (which is included in the definition of

End User Data). By downloading, installing, using, and providing information to or

through this SOFTWARE, You consent to all use and actions taken by us with respect

to Your information.

4.OWNERSHIP AND USE OF DATA. All ownership rights in and to the SOFTWARE shall

remain exclusively with EIG and its licensors, as applicable. Access to the SOFTWARE

is provided to You only to allow You to exercise Your rights under this Agreement, and

no implied license or right not expressly set forth in this Agreement is granted to You.
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"(a) End User Data. In connection with the SOFTWARE, EIG may collect and maintain 

End User Data provided by You. EIG shall maintain all personal identifiable aspects of 

all End User Data as confidential. All third parties authorized by EIG which may have 

access to the End User Data shall be under obligations of confidentiality to maintain 

the End User Data as confidential. You agree to and do hereby grant to EIG the irrevo-

cable, perpetual, transferrable right to use any End User Data.

"(b) EIG Data. All EIG Data is the sole property of EIG. EIG has the right to use, col-

lect, store, create, aggregate, mine, analyze or modify EIG Data in any form, for any 

purpose and in any manner. 

5. LICENSE KEY. The SOFTWARE may be  protected by a lock and may only be used in 

conjunction with a valid License Key (which may be either a hardware or software 

device) issued by or on behalf of EIG. EIG retains ownership of the License Key. You 

may use the License Key to operate the SOFTWARE for the term of this Agreement. 

6. COPYRIGHT. The SOFTWARE is owned by EIG and is the subject of copyright. You 

may be held legally responsible for any copyright infringement which is caused or 

encouraged by Your failure to abide by the terms of this Agreement. You must not 

copy or duplicate the SOFTWARE, the License Key, or any written materials, except as 

expressly provided for in this Agreement. EIG has the right to trace serial numbers of 

the License Keys at any time and in any reasonable manner.

7. USE RESTRICTIONS. You may physically transfer the SOFTWARE from one com-

puter/Computing Device to another provided that the SOFTWARE is used on only one 

computer/Computing Device at a time in conjunction with the License Key. You may 

not modify, adapt, translate, reverse engineer, decompile, or disassemble the SOFT-

WARE or the License Key, or create derivative works based on the SOFTWARE or the 

written materials.

8.   TRANSFER RESTRICTIONS. In no event may You transfer, assign, rent, lease, sell 

or otherwise dispose of the SOFTWARE, the License Key, or the written materials, on a 

temporary or permanent basis, except by returning them all to EIG.

9. TERMINATION. This Agreement is effective until terminated. This Agreement will 

terminate automatically without notice from EIG if You fail to comply with any provi-

sion of this Agreement. Upon termination for any reason, You must return all copies of 

the SOFTWARE, the License Key and the written materials to EIG, including all copies, 

whether modified, merged, or included with other software, and shall certify in writing 
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to EIG that You have not retained the SOFTWARE in any form. Termination of this 

Agreement pursuant to this clause does not affect any rights or remedies which EIG 

may otherwise have under this Agreement or at law.

10. UPDATE POLICY. EIG may create, from time to time, updated versions of the

SOFTWARE. EIG may make such updates available to You only if You have a current

SOFTWARE support contract for each SOFTWARE license You hold. Updated versions

of the SOFTWARE will be subject to the terms and conditions of this Agreement and

reference to the SOFTWARE in this Agreement means and includes any version

update.

11.ALL RIGHTS RESERVED. EIG retains title to and ownership of the SOFTWARE and

all copies thereof, and all other rights and interest, including without limitation, pat-

ents, copyrights, trademarks, trade secrets, and other intellectual property rights, in

and to the SOFTWARE and any copies thereof. You have only the limited rights with

respect to the SOFTWARE expressly set forth in this Agreement and You have no

other rights, implied or otherwise. The structure, organization, and code of the SOFT-

WARE are valuable trade secrets of EIG and You shall keep such trade secrets confi-

dential. The SOFTWARE and User Documentation are licensed, not sold.

12.WARRANTIES AND DISCLAIMER

(a)Limited Warranty. If You follow the instructions, the SOFTWARE will perform sub-

stantially as described in the EIG materials that You receive in or with the SOFTWARE.

(b) EIG warrants that any disks on which the SOFTWARE is supplied are free of

defects in manufacture under normal use for 30 days after purchase. During the 30

day period, a defective disk may be returned upon authorization by EIG to an autho-

rized EIG distributor identified by EIG who will replace the disk without charge unless

it has been damaged by accident or misuse.

(c) EIG warrants that if the License Key is a physical device, it is free of defects in

manufacture under normal use. A defective physical License Key may be returned

upon authorization by EIG to an authorized EIG distributor who will replace the

License Key without charge unless the item has been damaged by accident or misuse.

(d) To the full extent permitted by applicable law, any conditions or warranties

imposed or implied by law are hereby excluded. Insofar as any such provisions cannot

be excluded, then to the maximum extent permitted by the law, liability for breach of
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any implied condition or warranty is limited at EIG's option, to either the repair or 

replacement of the SOFTWARE or the License Key.

(e) In no event will EIG be liable to You for any loss, damage, or expense of any kind

whatsoever consequential upon or otherwise arising out of its supply of the SOFT-

WARE or the use of the SOFTWARE by You or any other person. This warranty does

not cover problems caused by Your acts (or failures to act), the acts of others, or

events beyond EIG's reasonable control.

(f) No oral or written information or advice given by EIG, its dealers, distributors,

agents or employees shall create a warranty or in any way increase the scope of the

warranties above and You may not rely on any such information or advice.

(g)Disclaimer. The limited warranty is the only direct warranty from EIG. EIG gives no

other express warranties, guarantees or conditions. Where allowed by Your local laws,

EIG excludes implied warranties of merchantability, fitness for a particular purpose

and non-infringement.

13. GOVERNING LAW. This Agreement is governed by the laws of the State of New

York, United States of America, regardless of conflict of law principles.

14.EXPORT CONTROL. The export of products, software, technology or information

may be subject to control or restriction by applicable laws or regulations on the con-

trol of export, notably the United States Export Administration Act and the regulations

there under, and the European Union Regulation 428/2009 applicable to dual use and

cryptographic products and technologies.  You are solely responsible for determining

the existence and application of any such law or regulation to any proposed export of

the SOFTWARE by You or Your representatives and for performing any declaration or

obtaining any required authorisation in relation therewith.  You agree not to export

the SOFTWARE from any country in violation of any applicable legal or regulatory obli-

gations or restrictions on that export. In the event the aforementioned legal or regu-

latory obligations or restrictions are violated by You or any of Your representatives in

relation with the export of the SOFTWARE, You shall indemnify and hold EIG and its

authorized representatives and/or resellers harmless from any claims and compen-

sate the same against any damages which any third party (including but not limited to

governmental and/or international authorities and/or organizations) will claim against

EIG and/or its authorized representatives and/or resellers as the result of any such

violation by You or Your representative(s).
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15.COMPLETE AGREEMENT. This Agreement and any addendum or amendment

included with the SOFTWARE constitutes the entire Agreement between EIG and You

in relation to Your use of the SOFTWARE and supersede any other previous or con-

temporaneous communications, Agreements, representations, warranties or advertis-

ing with respect to the SOFTWARE. Any change will be effective only if in writing

signed by EIG and You.

16.SEVERABILITY. If and to the extent any provision of this Agreement is held illegal,

invalid, or unenforceable in whole or in part under applicable law, such provision or

such portion thereof shall be ineffective as to the jurisdiction in which it is illegal,

invalid, or unenforceable to the extent of its illegality, invalidity, or unenforceability

and shall be deemed modified to the extent necessary to conform to applicable law so

as to give the maximum effect to the intent of the parties. The illegality, invalidity, or

unenforceability of such provision in that jurisdiction shall not in any way affect the

legality, validity, or enforceability of such provision in any other jurisdiction or affect

the legality, validity or enforceability of any other provision of this Agreement.

17.NO WAIVER. No term or provision hereof will be considered waived, and no breach

excused, unless such waiver is in writing signed on behalf of the party against whom

the waiver is asserted. No waiver (whether express or implied) will constitute a con-

sent to, waiver of, or excuse of any other, different, or subsequent breach.

18. AUDITS. To ensure compliance with this Agreement, You agree that upon reason-

able notice, EIG or EIG's authorized representative shall have the right to inspect and

audit Your Installation, Access, and use of the SOFTWARE. Any such inspection or

audit shall be conducted during regular business hours at Your facilities or electroni-

cally, either by EIG or by representatives authorized by EIG for this purpose. If such

inspections or audits disclose that You have Installed, Accessed, or permitted Access

to the SOFTWARE in a manner that is not permitted under this Agreement, then (i)

You are liable to pay for any unpaid license fees as well as the reasonable costs of the

audit; and (ii) without limitation of Section 2 (Grant of License), and unless EIG other-

wise elects in writing, the license grant with respect to the SOFTWARE will terminate

immediately. Any information obtained by EIG or EIG's authorized representative

during the course of such inspection and audit will be used and disclosed by EIG solely

for purposes of such inspection and audit and for enforcement of EIG's rights under

this Agreement and applicable law, unless other uses or disclosures are required
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under applicable law. Nothing in this Section shall be deemed to limit any legal or 

equitable remedies available to EIG for violation of this Agreement or applicable law.

19.CONSTRUCTION. Ambiguities in this Agreement will not be construed against the

drafter.

Should You have any questions concerning this Agreement, please contact Electro 

Industries/GaugeTech at 1800 Shames Dr. Westbury, New York 11590 USA. This legal 

document is an Agreement between You, as the end user of SOFTWARE, and Electro 

Industries/GaugeTech ("EIG"). 

E134749 Rev 1.05 
2/16/2021
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Revision History

The following table lists revision information for this manual, Doc #E107707, the 

CommunicatorPQA®, MeterManagerPQA®, and EnergyPQA.com® Software User 

Manual.

Version 
Number

Revision 
Date Summary of Changes

V.0.0 9/17/1999 First version released

V.1.16 1/25/2000 Various updates throughout manual

V.1.17 7/13/2000 Various updates throughout manual

V.1.18 11/8/2000 Internal Modem card added

V.1.19 4/25/2001  Ethernet, Modem, and Scheduler added

V.1.20 10/12/2001  Various updates throughout manual

V.1.21 4/24/2002 Various updates throughout manual

V.1.22 8/14/2002 Various screen and functionality updates 
throughout manual

V.1.23 3/27/2003 Energy Pulse Outputs, and Billing Module 
added

V.1.24 7/24/2003 Nexus® 1252/1262/1272 meter informa-
tion added; Flicker, new Polling screens, 
DNP Level 2, Power and Q readings added

V.1.25 8/27/2004 Software and manual name changed 
(Nexus® Communicator 2.0 changed to 
Communicator EXTTM 3.0); updates 
throughout manual

V.1.26 11/01/2004 Shark® 100 meter added

V.1.27 1/14/2005 HHF added; screen and functional updates 
throughout manual

V.1.28 11/11/2005  EN50160 added; Sealing Switch informa-
tion added; screen and functional updates 
throughout manual 

V.1.29 12/21/2005 Freeze period selection feature added

V.1.30 Internal release only - canceled due to design changes

V.1.31 4/9/2007 Screen and functional updates throughout 
manual
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V.1.32 8/31/2007  Shark® 200 meter added; updates 
throughout manual

V.1.33 12/20/2007 Updates throughout manual

V.1.34 5/20/2008 Updates throughout manual

V.1.35 8/11/2008  Updates throughout manual

V.1.36 8/20/2008 Nexus® 1500 meter added

V.1.37 9/15/2011 Enhanced functionality documented for the 
Nexus® 1252/1272/1500 meters and the 
Shark® 200 meter; Total Web Solutions 
added; external digital inputs added

V.1.38 3/15/2012 Updates throughout manual

V.1.39 9/30/2012 Chapter 5: Shark® 200 meter information 
updated for new features; Shark® 50 and 
Shark® 100B meters added to chapter

V.1.40 1/08/2013 Chapter 5: added settings for DNP over 
Ethernet for the Network card

V.1.41 3/4/2013 MP200 Metering System added

V.1.42 6/24/2013 Chapter 20 revised

V.1.43 7/23/2013 Chapters 3, 4, and 6 revised

V.1.44 9/10/2013 Chapters 6 and 19 updated

V.1.45 4/15/2014 Updates throughout manual

V.1.46 5/21/2014 Changes to chapters 6, 8, and 19

V.2.01 11/4/2014 Software changed to Communicator EXTTM 
4.0; manual re-formatted and rewritten 
throughout, updated screen captures 
throughout, MeterManager EXT added

V.2.02 12/11/2014 Added supported meters to Chapter 1

V.2.03 7/31/2015 Added Nexus® 1500+ meter to Chapter 
11; added information to chapters 15, 18, 
and 20.

V.2.04 10/20/2015 Edits to several chapters.

V.2.04 11/15/2015 Edits to chapters 1 and 8.

V.2.05 2/2/2016 Edits to Chapter 18.

V.2.06 7/27/2016 Edits to chapters 1 and 18.

Version 
Number

Revision 
Date Summary of Changes
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V.2.07 9/19/2016 Chapter 26 added; edits to chapters 5, 6, 
15, and 20.

V.2.08 2/28/2017 Edits to chapters 8, 11, 18, 19, 20, 21, 26 
and minor corrections.

V.2.09 5/3/2017 Edits to chapters 8 and 26.

V.2.10 9/6/2017 Edits to chapters 2, 6, 7, 20, and 26.

V.2.11 10/11/2017 Edits to Chapter 18.

V.2.12 12/11/2017 Chapter 27 added and edits to chapters 1, 
3, 4, 5, 6, 7, 8, 11, 12, 13, 14, 15, 26, and 
Appendix A. 

V.2.13 3/16/2018 Edits throughout.

V.2.14 4/16/2018 Minor edits in chapters 19 and 27.

V.2.15 5/10/2018 Edits to chapters 11 and 21.

V.2.16 7/11/2018 Added Chapter 28 and Shark® 250 Meter 
information throughout the manual.

V.2.17 8/21/2018 Edits to chapters 11, 15, 19, 20, and 25.

V.2.18 9/5/2018 Edits to Chapter 18.

V.2.19 9/26/2018 Edits to chapters 6, 11, 15, 18, and 27.

V.2.20 10/12/2018 Edits to chapters 18, 26 and 28.

V.2.21 11/5/2018 Edits to Chapter 10.

V.2.22 4/15/2019 Edits to chapters 2, 11, 19, 21, 25, 27, and 
the Glossary. 

V.2.23 6/20/2019 Edits to chapters 1, 3, 19, 20, 25, 26, and 
28.

V.2.24 8/15/2019 Edits to chapters 18, 20, 21, and 27.

V.2.25 Chapter 29 added; edits to Chapter 18.

V.3.0 2/14/2020 Rebranding of software throughout; edits 
to chapters 5, 6, 7, 16, 18, 20, 21, 22, 14, 
26, and 27.

V.3.1 3/23/2020 Updated EULA.

V.3.2 5/10/2020 Updates to chapters 7, 11, 12, 13, 16, 19, 
26, 27, 28. Chapter 29 added.

V.3.3 7/10/2020 Updates to chapters 1, 2, 18, and 29. 

V.3.4 8/19/2020 Added Chapter 30.

Version 
Number

Revision 
Date Summary of Changes
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V.3.5 10/2/2020 Edits to Chapter 29.

V.3.6 12/10/2020 Appendix F added.

V.3.7 2/10/2021 Changes to chapters 1-5, 8-10, 12, 16-20, 
and 29.

V.3.8 3/31/2021 Changes to chapters 6, 11, 20, and 21. 

V.3.9 4/27/2021 Changes to Chapter 29.

V.3.10 5/20/2021 Edits to chapters 5, 18, and 26.

V.3.11 7/27/2021 Edits to chapter 20 and 28.

V.3.12 12/21/21 Edits to chapters 8, 9, 29, and 30.

V.3.13 3/7/22 Edits to chapter 1, 11. 21, 27; added App. 
G

V.3.14 5/23/22 Edits to chapters 4, 6, 8, 11, 18, 20, 28.

V.3.15 7/19/2022 Edits to chapters 2 and 30.

V.3.16 8/4/2022 Edits to chapters 6, 20, 25, 26, 28.

V.3.17 1/20/2023 Edits throughout manual.

V.3.18 10/09/2023 Edits to chapters 2, 3, 18, 19, 20, 21, 25, 
26, 28.

V.4.01 1/10/2024 Release for Version 6 of the software.

V.4.02

3/19/2025 Edits to Chapter 10.

Version 
Number

Revision 
Date Summary of Changes

V.4.03

5/10/2024 Edits to chapters 8, 17, 19.
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1: Installing the CommunicatorPQA® Application

1: Installing the CommunicatorPQA®/Meter-
         ManagerPQA® V6 Application
1.1: Overview

The CommunicatorPQA® application and its MeterManagerPQA® automation compo-

nent, let you discover and group meters, configure meter settings, set up trending 

logs and automatic log retrieval, view real time readings, set system security, register 

meters with the EnergyPQA.com® system, and perform related meter activities. This 

manual explains how to use CommunicatorPQA® and MeterManagerPQA® software 

version 6. For earlier versions of the software, see the manual embedded in your ver-

sion of the CommunicatorPQA® application (Help>Contents from the main screen). 

You have three options for using the CommunicatorPQA® application: 

•   You can use the Lite Mode version of the software, which doesn’t allow you to 

access the MeterManagerPQA® automation component. This version is designed 

mostly for basic metering.

•   You can purchase a software license and use the Professional version of the 

application, which activates the MeterManagerPQA® automation component and 

all its features. 

•   You can sign up for the EnergyPQA.com® system directly and get access to all 

of the software, including EIG’s EnergyReporterPQATM application. This version 

allows you to access all the Cloud functionality, including energy management, 

AI, and power quality. See the EnergyPQA.com system webpage for documenta-

tion and additional information:

https://www.electroind.com/products/energypqa-com-energy-management-

system/.

In all three cases, you will install the CommunicatorPQA® application the same way 

(see 1.3: Installation Procedure, on page 1-11). 

https://www.electroind.com/products/energypqa-com-energy-management-system/
https://www.electroind.com/products/energypqa-com-energy-management-system/
https://www.electroind.com/products/energypqa-com-energy-management-system/
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1.1.1: New Features in Version 6

Version 6 (V6) of the CommunicatorPQA®/MeterManagerPQA® software has a signif-

icant number of changes centered around a new meter log database design. These 

changes include:

•  MS Access log databases are replaced with PostgreSQL. If you are currently using 

the old meter log MS Access databases, contact Electro Industries for the updated 

database documentation.

•  PostgreSQL is upgraded to v15.

•  Log retrieval now uses a common architecture, which means some of the old debug 

files (such as .nbl, .sbl, and .csv) may be deprecated. See the Log Retrieval tab 

instructions in 18.11.1: System Options, on page 18-142 for replacement file 

types.

•  LogViewer, LogConverter, and LogRetrieval application (specific to the Nexus® 

1500/1500+ meter) have been deprecated. All retrieval and viewing is done using 

the common libraries.

•  Meter log data that is older than 12 months can now be archived, and later loaded 

on demand, without removing recent data.

•  Database backup tools have been improved, allowing the backup and restoring of 

individual databases, including meter log data.

•  Database encryption is now supported. Contact Electro Industries Tech Support for 

the procedure to enable this.

•  CommunicatorPQA® Connection databases and Script & Scheduler are being dep-

recated. They will continue to operate on upgrades, but may not work on new 

installations.

Additional changes in V6 include:

•  LogViewer has been replaced with LogViewerPQA, which provides a new interface 

and features. See Chapter 19: Viewing Logs, on page 19-1 for details.
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•  The MeterManager Monitor UI has been updated for ease of use. See Chapter 18: 

MeterManagerPQA® Application, on page 18-1 for details.

1.2: Installation Requirements

The CommunicatorPQA®/MeterManagerPQA® application must be run on a computer 

with one of the following operating systems:

•  Windows 10 or 11 Operating System.

•  Windows® Server 2016.

•  Windows ®Server 2019.

•  Windows Server 2022.

If you are running Remote Desktop Host Server, you need to put it into Install mode 

before installing the CommunicatorPQA® software. See 1.2.1: Instructions for 

Remote Desktop (RD) Session Host Server, on page 1-8.

In addition, the following are minimum hardware requirements:

•  16 GB RAM.

•  1TB storage.

•  1440 x 768 display resolution.

Also, note that the CommunicatorPQA® and MeterManagerPQA® applications need 

.NET Framework 4.8 and .NET 6 to be installed on the PC running the applications. If 

you do not have those versions, the setup will install them and then exit. You will 

need to restart the PC if a message instructs you to do so. Whether or not you restart 

your PC, you will still need to restart the CommunicatorPQA® software setup. 

CommunicatorPQA®/MeterManagerPQA® software supported meters are:

•  Nexus® 1250/1252, 1262/1272, 1450, and 1500/1500+ meters.

•  Shark® 50/100/200/100S/200S/250/270/MP200/ST40 meters. 

Note that Futura+ CPU1000 and DMMS models are not supported. We recommend 

that you upgrade DM Series and Futura+ CPU1000 Series products to Nexus® or 

Shark® Series products if you wish to use CommunicatorPQA® application.
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This section explains the requirements for:

•  System resources for the full usage of the CommunicatorPQA/MeterManagerPQA® 

applications and the EnergyReporterPQATM application run on a single computer.

•  The PostGreSQL database server version 15, which is the version of the database 

server used by the CommunicatorPQA/MeterManagerPQA® V6 software. 

Optimum System Resource Requirements for the CommunicatorPQA/Meter-

ManagerPQA® Software (Concurrently, on One PC)

•  Storage: The storage requirements for running and storing meter data and reports 

depends on a number of factors. The majority of these factors are affected by the 

number of meters in the system. Items that are stored consist of:

•  Reports

•  Meter Log Databases

•  Retrieval Logs

•  EnergyReporterPQATM Databases

•  Internal Logs

•  The EnergyReporterPQATM application uses approximately 25 MB per year, per 

meter configured in the application. Meter log databases use approximately 6 MB 

per year for each historical channel. Different meters can have more or less config-

ured channels, so the amount used per meter will differ between a Shark® 200 

meter and a Nexus® 1500+ meter, for example. 

•  See the below table for examples.

# of Meters EnergyReporterPQATM 
Usage (MB)

Meter Log 
Database Usage 
for40 Channels 

(MB)

Meter Log 
Database Usage 

for 300 
Channels (MB)

1 25 240 1800

10 250 2400 18000

50 1250 12000 90000

100 2500 24000 180000

500 12500 120000 900000
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•  To calculate your estimated usage, find the usage for your expected number of 

points in the EnergyReporterPQATM application and add it to the expected usage 

for meter log databases. For example, if you have 10 billed meters in the Ener-

gyReporterPQATM application, five Shark® 200S with 40 channels being logged, 

and three Nexus® 1500+ meters with 450 channels being logged, your esti-

mated usage would be:

10*25 MB + 5*40*6 MB + 3*450*6 MB = ~9.5 GB per year.

•  System: The amount of system resources needed for running the various compo-

nents of the system depends both on the specific configuration of the system and 

on how it is being used. The majority of system usage occurs during log retrieval, 

importing data into the EnergyReporterPQATM application, and generating reports. 

The different usage loads are as follows:

•  Idle 

•  Viewing: Each CommunicatorPQA® software screen, MeterManager Monitor, 

EnergyReporterPQATM Settings Editor, and EnergyReporterPQATM Dashboard 

Viewer that is open, puts a load on the system, due to the functions of reading 

data from the database and refreshing the UI. The primary system usage is by 

the CPU, and it is caused by refreshing the UI. These open components (monitor, 

editor, dashboard) also occur in parallel, so their usage can result in cumulative 

loads on the system.

•  Retrieval: Retrieval of meter logs involves downloading the meter data and 

converting it to a local file database. This occurs at the retrieval interval speci-

fied by the user. These functions also occur in parallel, so they can result in 

cumulative loads on the system. A large amount of disk usage occurs while the 

log databases are converted and data is being written to the local database files.

•  Importing: Meter logs are checked every hour for new data to be imported into 

the EnergyReporterPQATM database. If there is no new data, only regular viewing 

usage occurs. When new data is found, the peak load of Importing occurs. While 

importing, a large amount of network and disk usage occurs while the new data 

is written to the database.

•  Reporting: Reports are checked every 12 hours. While checking, only regular 

viewing usage occurs. Once a month, multiple reports are generated for the 
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various EnergyReporterPQATM locations. At this time, the peak load of Reporting 

occurs. While generating reports, a large amount of disk usage occurs while data 

that needs to go into the reports is read from the database.

•  System requirements are given in the following table. The usage requirements 

that are shown should be considered the Peak usage (the highest values seen on 

a normal basis).

•  CPU: The CPU usage is given as a percent across the entire system, and can vary 

based on the number of threads (which determine how the CPU handles multiple 

software processes). For example, with 10 viewers, there are 11 softwares run-

ning, resulting in a cumulative usage of 400%. If there are 16 threading con-

texts, then each will only see a usage peak of 40% (with 5 contexts free for 

other tasks). However, if only 4 threading contexts are available, each will be 

loaded with 100% usage. See the Recommendations section, which follows.

•  Usage overflow: RAM, CPU, and Disk rely on each other, and overflowing one can 

lead to increased usage on the others. The numbers given above are dependent 

on enough free usage/space to accommodate the given tasks.

•  Other System Usage: If there are any other tasks running on the system at the 

same time (such as other applications), these can take system resources away 

from the CommunicatorPQA/MeterManagerPQA® software, which will cause all 

tasks to run more slowly.

Peak

idle viewing 
(per user)

viewing 
(10 users)

retrieval 
(per 

meter)

retrieval 
(10 

meters)
importing reporting

RAM 50 MB 140 MB 1000 MB 60 MB 600 MB 150 MB 500 MB

CPU (one 
thread)

0.24% 40% 400% 100% 1000% 150% 100%

Disk 2 kB/s 40 kB/s 400 kB/s 3,000 kB/s 30,000 kB/s 7,500 kB/s 3,000 kB/s
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•   Computer Resources Recommendation: 

•  CPU: As multi-threaded systems, the CommunicatorPQA/MeterManagerPQA® 

application and the EnergyReporterPQATM software can benefit from multiple CPU 

cores and threading contexts. It is recommended that the CPU have at least 4 

cores and 8 threading contexts (for example, the Intel I7 processor).

•  Disk Throughput: The greatest load on the system is reading from and writing to 

the databases on the disk. Because the entire system relies on reading from and 

writing to the disk, a slow disk will cause the entire system to run slowly. Under 

peak load, 50 MB/s can be read/written to the disk, so it is recommended that a 

High Performance Hard-Drive, such as a Solid State Drive, be used for database 

storage.

NOTES: 

•  This system is complex and runs multiple, simultaneous tasks. It is important to 

NOT try to run the system on less than capable hardware.

•  The meter log retrieval and report generation components of the software have 

heavy usage requirements when running. For an optimal system, it is recom-

mended that the CommunicatorPQA/MeterManagerPQA® application be run on a 

dedicated server, reserved solely for that purpose.

Disk Space 1 TB

CPU 4 core, 3 G Hz: Preferably Intel® I7 or greater

RAM 16 GB

Disk Throughput 200 MB/s
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PostGreSQL Version 15 Requirements

•  PostGreSQL server version 15 requires a 64-bit operating system. Chapter 1 

contains details about the MeterManagerPQA® application installation, including 

the PostGreSQL server 15 installation/upgrade. Note that supported Windows® 

operating systems are 10+, 2016, and 2019.

•  Storage Space - To upgrade the database from 9.5 to 15, enough space must exist 

on the hard drive for both databases to exist simultaneously, which is slightly more 

then double the size of the 9.5 database. Before upgrading, make sure this space is 

available on the destination drive. The installer will warn you if there might not be 

enough space.

•  Security - The installed databases will only be accessible through the MeterMana-

gerPQA® application. Enhanced passwords are assigned during install or upgrade, 

and cannot be changed. 

IMPORTANT! The end user(s) of the ComunicatorPQA® software must have read 

and write permissions for the following directory:

C:\Users\Public\Documents\Electro Industries

and its sub directories for the software to work correctly. Please ensure that the 

permissions are granted before the end user’s first use of the software.

1.2.1: Instructions for Remote Desktop (RD)
             Session Host Server

If you are running the RD Session Host Server on the PC that CommunicatorPQA® 

software will be installed on, you first need to put the RD Session Host Server into 

Install mode. Follow these instructions:

1. Click Start, type cmd in the search field, and press Enter.
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2. In the command line window, enter Change user /install at the C prompt. See the 

example screen, below.

3. Install the CommunicatorPQA® software application (see 1.3: Installation Proce-

dure, on page 1-11).
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4. When you have finished installing the CommunicatorPQA® software, repeat step 1 

to open the command line window and enter Change user /execute at the C prompt 

to put the RD Session Host Server back into normal, execute mode. See the exam-

ple screen, below.
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1.3: Installation Procedure 

The procedure shown here is the normal installation procedure. For instructions on 

silent mode installation, see 1.3.1: Silent Mode Installation, on page 1-22.

NOTE: Software applications in addition to the CommunicatorPQA® application also 

use Windows Installer (MSI) to install their product. It is possible for one of these pro-

cesses to be running in the background of your PC and not visible. If this happens, the 

installation of the CommunicatorPQA® application will fail, because only one MSI can 

run at a time. If the setup says it was interrupted, please restart your computer.

1. Download the link to the Professional version of CommunicatorPQA® software from 

EIG’s wesbite: 

https://www.electroind.com/products/communicatorpqa-power-monitoring-soft-

ware/. In the CommunicatorPQA® application webpage, click the Downloads tab.

 

•  If you want to purchase the CommunicatorPQA® application, click the Buy Now 

button toward the top of the webpage. As soon as your purchase is processed, 

you will receive a card with your software license and the link shown above.

https://www.electroind.com/products/communicatorpqa-software-application-5/
https://www.electroind.com/products/communicatorpqa-software-application-5/
https://www.electroind.com/products/communicatorpqa-software-application-5/
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2. You will see a page asking for contact information. At the bottom of the page there 

is the following note and two radio buttons:

•  As mentioned before, the CommunicatorPQA® application can be installed in 

either Lite Mode or Professional Mode. In order to use all of its features, you 

need a license. You can select Please Have Someone Send Me a License if you 

know you want the Professional version. If you want to try the software first, 

select I Understand.

3. Fill out the form completely and click Submit. The Setup.zip folder is downloaded to 

your PC. 

4. Open the folder and extract the Communicator Installer file. Double-click the file to 

begin installation. 

5. If you are prompted to give the Communicator Installer permission to make 

changes, click Yes to continue. 

6.You may see messages regarding Microsoft applications that need to be installed. 

These applications are necessary for the CommunicatorPQA® application. Click 

Install in the message windows to continue with the CommunicatorPQA® applica-

tion installation.
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7. You will see the following screen.

8. Next, you will see the screen below. 

9. Click Next to continue with the installation. You will see the Software End User 

License Agreement.
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10. Use the scroll bar to view the entire document. Please make sure you read the 

terms of the Software End User License Agreement. To continue the installation, 

click I accept the terms in the License Agreement. By doing so, you are agreeing to 

the full terms of this Software User End License Agreement. (If you do not accept 

the terms, you will not be able to install the application.)
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11. In the above screen, for a regular installation, leave the Default button selected 

and select Next. Then proceed to step 12. If you need to customize the installation, 

such as selecting a new location for files, or not installing certain parts of the appli-

cation, click the Custom button and continue with step 11a.

a. After selecting Custom, you will see the screen below.

Default Location
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b. The default location that files will be stored to, is shown. To save to a different 

file location, click Change. You will see the screen shown below.

• Browse to the location where you want to store the application files.

• You can create a new folder if you want.

• Click OK to close this screen and return to the Custom Setup screen.

c. From the Custom Setup screen, click on any of the applications and/or drivers 

you want to install and click Next to continue.

New storage location

           Browse                     New Folder
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12. You will see the screen below; click Next to begin installation.

13. You will see the screen below as files are being installed.
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14. You will see this message when installing MeterManagerPQA® software, if you 

don’t have the PostGreSQL Server 15 on your PC.

15. Click Install to continue. You will see the messages below as the MeterManager-

PQA® application is installed.
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16. You will see the screen below, indicating that the CommunicatorPQA® application 

installation is complete. Check the first box to launch the application. You can check 

the second box if you want the see a log with installation details. Click the Finish 

button to close this screen 

17. When you open the CommunicatorPQA® application for the first time, it will be in 

Lite Mode.
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18. The messages underneath Lite Mode tell you that the EnergyPQA.com® system is 

disabled and tell you how to enable a Trial for it. The button View Professional Fea-

tures lets you see what is different in the Professional Mode as opposed to the Lite 

Mode. See the screen below.

•  As you can see, if you have the Professional Mode, you have full software, along 

with free updates and support. If your license expires, you will no longer be able 

to get updates or support for the software, until you renew your software 

license.

19. You now have two options:

•  You can continue to use the Lite Mode of the software - in this case, you do not 

need to do anything else. You will find instructions for using the software in the 

rest of this manual (note that some chapters, e.g., Chapter 18 on MeterMana-

gerPQA® software, will not apply to the Lite Mode).

•  You can access the Professional version of the CommunicatorPQA® application. 

To do so:

a. Contact EIG to buy a software license: call 1-516-334-0870 or email 

sales @electroind.com.
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b. Once you receive the license, click Help>Software License from the top of 

the CommunicatorPQA® software’s Main screen.

c. In the screen below, click the button next to CommunicatorPQA® Profes-

sional and enter your license number in the Enter Registration Number 

field. 

d. Click Apply. You will now be able to use all of the features of the Communi-

catorPQA® application with the MeterManagerPQA® automation software. 

See 1.5: Using the Application, on page 1-29, for a description of the other 

chapters in this manual.
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1.3.1: Silent Mode Installation

If you want to install the CommunicatorPQA® and MeterManagerPQA® applications 

without requiring any user intervention, i.e., responding to prompts and making 

selections, follow these instructions to perform installation in “silent mode.”

In the PCs command line, key:

Setup.exe /s

If you find that the MeterManagerPQA® application is not being installed in silent 

mode, follow this two step process:

1. In the PC’s command line, key:

Setup.exe /s /e_inst_mtr_mgr=no

2. Once CommunicatorPQA® software has been installed, key the following in the PCs 

command line:

Metermanagerinstaller.exe /s /v/qn

NOTE: If MeterManagerPQA® software is being updated, the command shown 

here will install the application silently. Note that for a new installation, the Meter-

ManagerPQA® application can’t be installed without user intervention.
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1.4: Meter Database Migration - V5 to V6

CommunicatorPQA® V6 uses a PostgreSQL database rather than the MS Access data-

base used by earlier versions of the software. The MS Access databases will no longer 

be supported. You have the option of migrating up to two years of log data to the 

PostgreSQL database when you are updating from CommunicatorPQA® V5 to 

CommunicatorPQA® V6. This section explains how to perform the migration. 

•  Note that database migration is not necessary. If you don’t need the older log data 

there is no reason to migrate it. Also, you have the option of retrieving the log data 

again once you have installed the CommunicatorPQA® V6 application. 

•  New data available will be retrieved as normal into the V6 database whether or not 

you preform database migration. 

•  Note that the original V5 database is left untouched. It will still be available for 

auditing and review purposes, regardless of whether or not the data has been 

migrated. 

•  While the V6 LogViewerPQA® cannot access the V5 database, the V5 Log Viewer 

will be left on the computer to provide access to the data. However, note that the 

legacy V5 Log Viewer is deprecated, so it will not be supported even though it is 

available for use. Also note, if the original databases are not required, you will need 

to manually delete them to free up the disk space. See Chapter 16: Databases and 

Log Data, on page 16-1 for information on locating log files.

NOTE: Database migration is only available when performing an upgrade from V5 to 

V6. It can’t be used for new CommunicatorPQA® V6 installations, i.e., installing the 

application on a new machine.

Migration is only strongly recommended in the following circumstances:

•  Meter logging has less than two years of data, but the meter has been in service 

longer than that. This can occur if the logs were reset or rolled over. Migration will 

ensure you don’t lose the database records.

•  You are using a Shark® 100 meter with the MeterManagerPQA®'s software poller 

feature, which is used because those meters do not have logging (see 18.11.1: 

System Options, on page 18-142 for details).
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Following are some considerations when you are migrating meter log databases:

•  Since migration can take quite a long time and take up a large amount of memory, 

you should consider which meters and/or logs you want to migrate data for. 

•  Log retrieval is disabled for all meters that are eligible for migration until the 

meter’s log database migration is finished (or canceled). 

•  Any configured reports, such as ReportExporterTM or Custom Reports, will also be 

disabled during the meter’s log database migration process. 

•  As each meter finishes migration, log retrieval will be enabled again and meter data 

will begin to be retrieved. The meter log retrieval will begin where the V5 database 

left off. Once retrieval is completed, a report will be available for the migrated data. 

See 1.4.2: View Migration Status/History, on page 1-27.

Note the following restrictions on migrating databases:

•  Only meters configured in the MeterManagerPQA® Meter List at the time of 

upgrade, may be migrated. Any meter which is unassigned, or has meter log data-

bases which are not active, will not be available for migration. 

•  Any meter added to the system after upgrade to V6, but before migration, cannot 

be migrated.

•  Once a meter has been migrated, it cannot be selected for automatic migration 

again. This is only relevant if you migrated less than the full set of available data 

from that meter.

•  Retrieval and reports will be blocked until migration successfully completes or is 

canceled. Make sure to cancel migration if you decide not to continue with it, or log-

ging will not take place.
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1.4.1: Migration Procedure

1. Install CommunicatorPQA® V6. After the installation is finished, MeterManager-

PQA® will scan your system for meters that can be migrated. This process can take 

a while. Log retrieval is not available while the system is being scanned.

NOTE: If you are upgrading from CommunicatorPQA® V4 rather than V5, contact 

EIG customer support to confirm the best upgrade path. 

2. Open MeterManagerPQA® if it is not already open.When the scan is complete, you 

will see the following screen in MeterManager Monitor.

3. This screen lets you specify the migration options you want:

a. Range of data to migrate - you may select one (which is the default selection) or 

two years of data to migrate. The migration is for calendar years (Jan.-Dec.), so 

it will include data from January 1 of the year. 

b. Only migrate specific logs - if you only need certain logs to be migrated, you can 

speed up migration (and possibly reduce storage space requirements), by only 

migrating the logs that you need.

c. Include meters - select which meters to migrate at this time. You do not need to 

migrate all meters at one time. You can migrate some and then migrate others 

later if you need to. The options for this field are:

• Include all meters - All available meters will be migrated. Only one meter 

will be migrated at a time, so this can safely be selected in most circum-

stances. 
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• Include only selected meters - this option lets you process meters in 

groups, or only migrate specific meters. A list of all meters will be 

displayed, from which you can select the meters to migrate.

• Exclude selected meters - this option lets you select which meters you do 

not want to be migrated. Note that all meters that are not selected will be 

migrated.

4. Click OK to start migration. 

• If you don’t want to migrate at this time, you can click Skip.

• If you have migrated all the meters you want, click Disable to cancel any 

additional migrations.

    NOTES: 

•  If you chose to migrate only a few meters at a time or if you selected Skip, you 

can open the Log Upgrade Migration screen again from the Migration Summary 

window to continue migrating meters - see

•  You can also migrate meters individually from the Meter List screen. Right click 

on a meter in the list and select Migrate Meter Database. You will only see this 

option if the meter is available to migrate.

5. During migration, you can view its progress in MeterManagerPQA® in several 

ways:

• Meters being migrated and blocked from log retrieval will have a Locked 

icon in the Meter List.

When you click here you 
will have two options:
1. Migrate Old Database - 
    migration for this meter
    will start after other 
    meters have been 
    migrated.
2. Start New Database -
    migration will not take
    place. A new database
    will be created and logs 
    will be downloaded to it
    .     from the meter.
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• When migration begins, the Next Action column in the Meter List will dis-

play the status.

1.4.2: View Migration Status/History

You can see information about the migrations you have performed in two places:

•  From MeterManager Monitor, click Scripts>Log Actions>View Logs. The migrations 

are listed in the Actions History field.

          Locked icon      Next Action message
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•  Click the Migration icon in the Status bar to open the Migration Summary screen.

The Migration Summary screen displays the following information:

•  Migration Status - the current status of the migration.

•  Migration Report - a report of the success or failure of each meter that was 

migrated, including when migration started, and how long it took.

•  Migration Errors - a list of issues encountered during scanning and migrating.  

Note that some issues listed may not be a problem, for example, “Database not 

found” may only indicate that log retrieval was not performed for the meter in 

the past. However, the issues listed in this field will be helpful if the migration 

failed.

Migration icon
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•  Migration Pending - a list of all meters that are waiting to be migrated.

•  The buttons on the screen are as follows:

• Start Migration - opens the Migration Prompt screen, which you can use 

to begin the pending migrations.

• Acknowledge - When all pending migrations have been completed, click 

this button.

• Disable - Cancels migration for all remaining meters. 

1.5: Using the Application

The remainder of this manual explains how to use the CommunicatorPQA® and its 

related applications. 

Chapter 2 contains an overview of the application, including an explanation of the 

Main screen’s Menu Bar, icons, etc.

Chapter 3 contains detailed instructions for connecting to a meter, including direct 

connection through a serial port, network, or modem, and using the MeterManager-

PQA® application.

Chapter 4 contains detailed information on the Device Status screen, in general and 

for specific meters.

Chapter 5 contains information on all of the polling screens.

Chapter 6 contains security information - password protection and sealing switch.

Chapter 7 explains how to configure your meter, explaining the Device Profile screen 

and its features.

Chapter 8 contains detailed instructions for configuring the Shark® 200/200S meter. 

Chapter 9 contains detailed instructions for configuring the Shark® 100/100S/100B/

50 meter.

Chapter 10 contains detailed instructions for configuring the MP200TM metering sys-

tem.
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Chapter 11 contains detailed instructions for configuring the Nexus® 1500/1500+ 

meter.

Chapter 12 contains detailed instructions for configuring the Nexus® 1272/1272 

meter.

Chapter 13 contains detailed instructions for configuring the Nexus® 1250/1252 

meter.

Chapter 14 contains detailed instructions for configuring external I/O Devices.

Chapter 15 contains detailed instructions for configuring the Time of Use (TOU) 

feature.

Chapter 16 contains detailed instructions for retrieving meter logs and detailed 

explanation of the CommunicatorPQA® application’s databases.

Chapter 17 contains detailed information on using EIG’s Script & Scheduler.

Chapter 18 contains detailed information on MeterManagerPQA® software.

Chapter 19 explains EIG’s LogViewerPQA and gives detailed instructions for viewing 

the meters’ logs.

Chapter 20 contains detailed instructions for using additional CommunicatorPQA® 

application screens and functions, including using the Tools menu, the Options screen, 

and using the application’s Help function.

Chapter 21 contains detailed instructions for configuring a meter’s Network card and 

using Total Web SolutionsTM.

Chapter 22 contains instructions for customizing DNP3 configuration.

Chapter 23 contains detailed information on EN 50160/IEC 61000-4-30 Power Quality 

standards.

Chapter 24 contains instructions for configuring the modem Dial In/Dial Out settings.

Chapter 25 contains instructions for performing Flash updates.

Chapter 26 contains instructions for configuring the Shark® 270 meter.

Chapter 27 contains instructions for configuring the Nexus® 1450 meter.
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Chapter 28 contains instructions for configuring the Shark® 250 meter.

Chapter 29 contains information on the EnergyPQA.com® Cloud-based system’s doc-

umentation.

Chapter 30 contains detailed instructions for configuring the ST40 meter.

Appendix A contains information on Transformer/Line Loss Compensation (TLC) and 

the TLC worksheets.

Appendix B contains CommunicatorPQA® 4.0 software Command Line Arguments.

Appendix C contains a list of Ethernet Network error codes.

Appendix D contains instructions for TFTP Server Program setup.

Appendix E contains troubleshooting information.

Appendix F contains information on the Landis + Gyr Server Custom Reports feature.

There is a Glossary at the end of this manual.
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2: Overview of the Application

2.1: Meter Comparisons

Settings for the meters vary depending on the meter model you are connected to. For 

example, certain meters support Flicker measurement while others do not. See the 

following tables for a comparison of meter features. 

Note that some of these features are optional, or are determined by V-SwitchTM key. 

Refer to your meter’s Installation and Operation Manual for the capabilities associated 

with your meter’s options and V-SwitchTM key.

In the following tables, y=yes, and n=no.
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Table 1: Shark® Series Feature Comparison

NOTE: The number of available communication ports includes both standard and 

optional.

Shark® Meter Features 50  50B 100 100S  100B 200  200S 250 270 MP200 

Measurements
Multifunction Measurement y y y y y y y y y y

n n n n n y y y y y

Total W, VAR y y y y y y y y y y

# of 3 Phase Circuits 1 1 1 1 1 1 1 1 1 8

Accuracy Class 0.5 0.5 0.2 0.2 0.2 0.2 0.2 0.2 0.2 0.5

Communication
Modbus y y y y y y y y y y

Modbus TCP n y y y y y y y y y

DNP3 Serial n n y y n y y y y n
n n n n n y n y y n

BACnet MS/TP n y n n n n n n n n

BACnet /IP n n n n y n n n n n

IEC61850 n n n n n y n y y n

RS485 Ports 1 1 1 1 1 1 1 2 1 2

Ethernet Ports n 1 1 1 1 2 1 1 1 1

Fiber Ports n n n n n 2 n 1 n n

IRDA Ports/Optical Port (270) n 1 1 1 1 1 n 1 n
n n n n n n n n n

USB Ports n n n n n n n 1 n 1

WIFI Capable n n n y n n y n n y

0-1mA Outputs n n n n n n y n

4-20mA Outputs n n n n n n y n

Features
Load Profiling n n n n n y y y y y

Limits n n y y y y y y y y

Control Outputs n n n n n y y y y y

THD/TDD n/n n/n y/n y/n y/n y/n y/n y/y y/y y/n

Harmonic Components n n n n n y y y y y

Waveform Recording n n n n n y n y y n

Transformer Compensation n n n n n y y y y n

Line Loss Compensation n n n n n y y y y n

Time of Use n n n n n n n y y n

Programmable Display n n n n n n n n y n

Single phase W, VAR 

DNP3 over Ethernet

Cellular Modem
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Table 2: Nexus® Series Features Comparison 

Nexus®  Meter Features 1250 1252 1262 1272 1450 1500 1500+
Measurements

Multifunction Measurement y y y y y y y
Single Phase Watt, VAR Readings y y y y y y y

Total Watt, VAR y y y y y y y
Number of 3 Phase Circuits 1 1 1 1 1 1 1

Accuracy Class 0.04 0.06 0.06 0.06 0.06 0.06 0.06
Auto-Calibrating y y y y y y y

Communication
Modbus y y y y y y y

Modbus TCP y y y y y y y
DNP3 Serial

DNP3 Ethernet y y y y y y y
IEC 61850 n n n n y y

 IEC 61850 GOOSE n n n n n y
RS485 Ports 4 4 2 2 2 2

Ethernet Ports 1 1 1 1 1 2 2
Fiber Ports n n n n 1 1 1

ANSI Optical Port n n 1 1 n 1 1
USB Ports n n n n n 1 1

WIFI Capable n n n n n n n
0-1mA Outputs y y y y y y y

4-20mA Outputs y y y y y y y

Features
Load Profiling y y y y y y y

Limits y y y y y y y
Control Outputs y y y y y y y

THD y y y y y y y
Harmonic Components y y y y y y y

Waveform Recording y y y y y y y
n n n n n y
n n n n n y y

Transformer/Line Loss Compensation y y y y y y y
Test Mode n n y y y y y

Full IEC 61000-4-30 Class A Compliance n n n n y y y
EN 50160 Reporting n y n n y y y

y y y y y y y
n n n n n n y

Transient Capture
 Waveform Capture Response to  GOOSE msg 

PMU (Synchrophasors)
TOU
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NOTE: The number of available communication ports includes both standard and 

optional.

2.2: Main Screen

When you open the CommunicatorPQA® application, either from the Start menu, or 

by connecting to a meter through MeterManagerPQA® software, you see the soft-

ware’s Main screen.

•   You will see the above screen if you open the application from the Start menu and 

are not yet connected to a meter. The screen says Professional Mode when you are 

using a fully licensed version of the software. Notice that the Connect, Open Log, 

Conn Mgr, and Meter Mgr icons are available, but the other icons are grayed out 

and not selectable. 



     Doc#    E107707                                                 2-5

             2: Overview of the Application

•   You will see the above screen once you have connected to a meter (see Chapter 3 

for instructions), or if you have accessed CommunicatorPQA® from MeterManager-

PQA® software. All of the icons in the Icon Bar are available for use, except for the 

Connect icon, since you are already connected to a meter. 

The Main screen gives you access to all of the features of the software. Its basic 

components are:

•   Icon Bar - contains icons that open specific screens 

•   Status Bar - gives you information about the connected meter

•   Menu Bar - provides access to all of the software screens

These components are explained in the following sections.
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2.2.1: Main Screen’s Icon Bar    

From left to right, the icons in the Icon Bar and the actions they perform are as 

follows:

•   Profile - click this icon to open the Device Profile screen for the connected meter. 

See Chapter 7 for details on the Device Profile and the individual meter chapters for 

instructions for configuring your meter’s Device Profile.

•   Ret Log - click this icon to open a screen that lets you retrieve meter logs. See 

Chapter 16 for details on log retrieval.

•   Open Log - click to open the Log Viewer application, which gives you access to log 

data. See Chapter 19 for details on using the Log Viewer.

•   Conn Mgr - click this icon to open Connection Manager. Note that this is a legacy 

feature, for users that have installed earlier versions of CommunicatorPQA® soft-

ware and set up Connection Manager.

•   Meter Mgr - click this icon to open the MeterManager monitor screen. MeterMana-

gerPQA® functionality is explained in detail in Chapter 18.

•   Connect - when you are not connected to a meter, click this icon to open the Con-

nect screen. See Chapter 3 for connection instructions.

•   Disconnect - click this icon to disconnect from the meter you are currently 

connected to.

•   Polling - click this icon to open the Real Time polling screen for the meter you are 

connected to.

•   Energy - click this icon to open the Power and Energy polling screen for the meter 

you are connected to. 
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•   Harmonic - if the meter you are connected to supports Harmonic magnitude mea-

surement, click this icon to open the Harmonics polling screen. If your meter does 

not support Harmonic magnitude measurement, this icon will be grayed out and 

unselectable.

•   Phasor - click this icon to open the Phasor polling screen for the meter you are con-

nected to.

•   Flicker - if the meter you are connected to supports Flicker measurement, click this 

icon to open the Flicker polling screen. If your meter does not support Flicker mea-

surement, this icon will be grayed out and unselectable.

•   Log Stats - click this icon to open the Log Statistics screen for the meter you are 

connected to. See Chapter 16 for additional information about this screen.

•   Dev Stats - click this icon to open the Device Status screen. See Chapter 4 for an 

explanation of this screen.

•   Alarms - if the meter you are connected to supports Limits setting, click this icon to 

open the Limit Status polling screen. If your meter does not support Limits setting, 

this icon will be grayed out and unselectable.

•  EnergyPQA - provides access to the EnergyPQA.com® Cloud application.
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2.2.2: Main Screen’s Status Bar

The status bar is located at the bottom of the Main screen. The details of the informa-

tion shown depends on your meter connection - through a Network or a serial port.

NOTE: If you are not connected to a meter, the first field will say Disconnected and 

the other fields will be blank; and if you have tried to connect to a meter that the soft-

ware can’t locate, the first field will say Not Found and the other fields will be blank.

Status Bar for a Network Connection

The information shown in the Status Bar, from left to right, is:

•   Connection Status

•   Type of Connection

•   Network Protocol

•   Meter’s Modbus address and IP address 

•   Meter’s ID

•   Communication Protocol

•   Security Status: Password and Sealing Switch (if available for the meter) Enabled 

or Disabled

•   Battery Status (if applicable to the meter)*

•   Memo Field- If anything was entered into this field in the Labels or System settings 

screens, it is displayed here. Refer to your meter’s programming chapter for 

instructions.

•   Meter’s serial number
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Status Bar for a Serial Port Connection

The information shown in the Status Bar, from left to right, is:

•   Connection status: Connected or Disconnected

•   Serial Port

•   Baud Rate

•   Meter’s Modbus address 

•   Meter’s ID

•   Communication Protocol

•   Security Status: Password and Sealing Switch (if available for the meter) Enabled 

or Disabled

•   Battery Status (if applicable to the meter)*

•   Memo Field - For Nexus® meters, if anything was entered into this field in the 

Labels setting screen, it is displayed here. Refer to your meter’s programming 

chapter for instructions.

•   Meter’s Serial Number

*NOTES: 

•  For a Nexus® 1262/1272 meter, the Battery Status field displays Low Bat Nexus 

when the Internal or Modem battery is low, dead or missing.

•  For a Nexus® 1500/1500+ meter, the Battery Status field displays Low Batt when 

the battery backing up the meter’s clock is at 1.3 volts (1500)/2.55 volts (1500+). 

For the 1500+ meter, you can enable the battery status display from the Options 

screen - see 20.2.4: Miscellaneous, on page 20-68 for instructions. 
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2.2.3: Main Screen’s Menu Bar

The Menu Bar, located at the top of the CommunicatorPQA® application’s Main 

screen, has the following options: File, Connection, Real-Time Poll, Tools, I/O Devices, 

TOU Calendar, Logs, View, and Help. Each of these options open menus and sub-

menus when you click on them, giving you access to application features.

•   File: If you are not connected to a meter this is the menu you will see; if you are 

connected to a meter, you will only see the Open>EI Device Log File and Exit 

options. You can click Exit to close the application.

•   Click Open>Device Profile and then one of the Profiles to edit the profile of a 

meter or device that you are not connected to. See Chapter 7 for more informa-

tion on programming Device Profiles.
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•   Click Open>EI Device Log File to open the screen shown below if you have the 

Professional version of the CommunicatorPQA® application. To open a log, click 

on the meter you want to see the log for and click Select. If you have the Lite 

version of the software, you will be prompted to select the log database file 

directly from the Database directory. See Chapter 16 for information on retriev-

ing logs and Chapter 19 for information on viewing logs.

•   Click Open>Nexus Dial-In Log Index to open a window that lets you browse for 

the log index file. See Chapter 24 for information on this log.
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•   Real-Time: This menu gives you access to all of the polling screens for the 

connected meter. Depending on the meter you are connected to, you may see 

some different options than the ones shown in the example below. See Chapter 5 

for details on the polling screens. 

•   Tools: This menu gives you access to additional actions. Depending on the meter 

you are connected to, you may see some different options than the ones shown in 

the example below. See Chapter 20 for details on the Tools options. 
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•   I/O Devices: You will see this menu if you are connected to a Nexus® meter. It 

gives you access to programming and control screens for the meter’s optional 

external I/O modules. See Chapter 14 for detailed instructions on programming the 

external I/O devices.

•   TOU: You will see this menu if you are connected to a Nexus® meter. It gives you 

access to the Time of Use (TOU) Calendar settings. See Chapter 15 for instructions 

on configuring TOU settings.

•   Logs: This menu gives you access to information about the connected meter’s log 

status, lets you retrieve meter logs, and lets you load a saved log database file for 

viewing. See Chapter 16 for details on log databases and retrieving logs; and Chap-

ter 19 for details on viewing meter logs.    
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•   View: This menu lets you choose to hide the Tool Bar and/or the Status Bar. It also 

gives you access to the Options menu, which is explained in Chapter 20.   

•   Help Menu: This menu gives you access to additional information:  

•   Contents - click to open the CommmunicatorPQA®, MeterManagerPQA®, and 

EnergyPQA.com® Software User Manual.

•   Electro Industries Web Site - click to open the EIG website in your Web browser.

•   Check for Software Updates - click to run a check for any updates to your soft-

ware.

NOTE: Whenever you open the Professional (licensed) version of the software 

application, there is an automatic check for updates to it - see the next page for 

information on the software license.

•   End User License Agreement - click to view the EULA for this application.
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•   Software License - click to see the screen below. It gives you information about 

the status of your license for the application. To upgrade to the Professional 

version from the Lite version of the software, or to renew a license, enter your 

Registration number and click Apply. 

NOTE: 

• To purchase a software license, either:

• Call Sales at EIG - (516) 334-0870

• Email sales@electroind.com

• Contact your Regional sales representative

•   Give us Feedback - click to open EIG’s Customer Satisfaction survey in your 

browser.

•   Purchase a new meter - click to access EIG’s Web store.

If you already have
a license, it is shown
with its expiration 
date

For a new license,
enter your software
license key here and
click Apply 

See Chapter
29 for details
on the 
EnergyPQA.com®
Enterprise, EIG’s
Cloud Solution
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•   About CommunicatorPQA® software - click to view the screen shown below, 

which lists software version information. You will see the portion on the right 

when you click View Version Info on the bottom of the screen. That button turns 

to Hide Version Info once you click on it, now you can click it to close the 

detailed version information on the right side of the screen. 

As you can see, there are many different applications that make up the Commu-

nicatorPQA® application suite. The Installer package automatically builds all of 

the software applications and the user generally does not need to know about 

these software versions. The main version of the software on the splash page 

(above, left) is the most important reference version.

Click OK to close the About screen.
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3: Connecting to Your Meter

3.1: Overview

There are three methods for connecting to your meters:

•   Direct Connect - through serial port, network, IrDA, or USB.

•   Through Connection Manager - used for modem communication, multiple meters 
on a bus, and a gateway communication.

•   Using MeterManagerPQA® software- automatically connects to meters in your net-
work.

When connecting through an Ethernet network, using the MeterManagerPQA® 
application as your primary launchpad is the most convenient way to use the sys-
tem. 

Depending on your meter type and the options it is configured with, you will have one 

or more ways of connecting to your specific meter. There are two aspects of connect-

ing to a meter:

•   The meter’s communication port settings

•   The connection settings from your PC to the meter

Both of these are set through CommunicatorPQA® software. This chapter concerns 

the latter connection; see the programming chapter for your meter for the communi-

cation port settings: 

•   Chapter 8 for the Shark® 200/200S meter

•   Chapter 9 for the Shark® 50/100/100B/100S meter

•   Chapter 10 for the MP200TM metering system

•   Chapter 11 for the Nexus® 1500/1500+ meter

•   Chapter 12 for the Nexus® 1262/1272 meter

•   Chapter 13 for the Nexus® 1252 meter

•   Chapter 26 for the Shark® 270 meter.
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•   Chapter 27 for the Nexus® 1450 meter.

•   Chapter 28 for the Shark®250 meter.

•   Chapter 30 for the ST40 meter.

The following tables summarize the recommended settings for the EIG meters.
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NOTES: 

•   Except where specified, the Device Address field can be 1-247. 

•   The following tables shows you the settings needed in a PC to enable successful 

communication with the meter.

•   If specific settings are not given in the table, make settings that match your 

installation requirements.

                           Table 1: Shark® Meter Connection Settings

Connection 
Type Shark® 50 Shark® 

100/100S Shark® 100B
Shark® 200/
250/200S/

270
MP200 ST40

IrDA NA Device 
Address: 1
Port: the PC’s 
USB Port
Baud Rate: 
57600
Protocol: Mod-
bus ASCII; 
Flow Control: 
Hardware. The 
Shark® T 
meters do not 
support IrDA.

Device Address: 
1
Port: the PC’s 
USB Port
Baud Rate: 
57600
Protocol: Mod-
bus ASCII; Flow 
Control: Hard-
ware. The 
Shark® T meters 
do not support 
IrDA.

Device Address: 
1
Port: the PC’s 
USB Port
Baud Rate: 
57600
Protocol: Modbus 
ASCII; Flow Con-
trol: Hardware. 
The Shark® T 
meters and the 
270 do not sup-
port IrDA (the 
270 has an ANSI 
Optical port).

NA NA

ANSI Optical 
Port

NA NA NA Device Address: 
1
Port: PC’s RS232 
or USB Port
Baud Rate: Up to 
57600 
Protocol: Modbus 
RTU

NA NA
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RS485 Baud Rate: 
9600; 19200; 
38400; 57600 
Port: COM 1 - 
COM 256 (OS 
dependent)
Protocol: 
Modbus ASCII 
or RTU
Flow Control: 
None or Hard-
ware

Baud Rate: 
9600; 19200; 
38400; 57600 
Port: COM 1 - 
COM 256 (OS 
dependent)
Protocol: Mod-
bus ASCII or 
RTU
Flow Control: 
None or Hard-
ware

NA Baud Rate: 
1200*, 2400*, 
4800*, 9600, 
19200, 38400, 
57600 (for 
Shark® 200/
200S/270 
meters’ RS485 
connection, Port: 
COM 1 - COM 256 
(OS dependent)
Protocol: Modbus 
ASCII or RTU
Flow Control: 
None or Hard-
ware

Protocol: 
Modbus 
ASCII or RTU

Baud Rate: 
57600
Protocol: 
Modbus RTU

Ethernet/WiFi NA Default 
Settings are:
Device 
Address:1
IP Address: 
10.0.0.1
Port: 502
Protocol:
Modbus TCP

Default 
Settings are:
Device 
Address:1
IP Address: 
10.0.0.1
Port: 502
Protocol:
Modbus TCP

Default 
Settings are:
Device 
Address:1*
IP Address: 
10.0.0.2
Port: 502
Protocol:
Modbus TCP, and 
for Shark® 200/
200S/270 
meters: DNP3 
over Ethernet
(for 200/250/270 
the device 
address must be 
1)

Default 
Settings are:
Device 
Address:1
IP Address: 
10.0.0.1
Port: 502
Protocol:
Modbus TCP

Ethernet/
BACnet 
Default 
Settings are:
Device 
Address:1
IP Address: 
10.0.0.1
Port: 502
Protocol:
Modbus TCP

Connection 
Type Shark® 50 Shark® 

100/100S Shark® 100B
Shark® 200/
250/200S/

270
MP200 ST40
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 * With Runtime Firmware version 26 or higher

Fiber Optic NA NA NA Baud Rate:  
9600, 19200, 
38400, 57600 
Port: COM 1 - 
COM 256 (OS 
dependent)
Protocol: Modbus 
ASCII or RTU, 
DNP3
Flow Control: 
None or Hard-
ware
Echo Mode: No 
Echo or Static 
Echo. Static Echo 
should only be 
used when con-
necting to Fiber 
Optic devices that 
are configured for 
Echo. 
Parity: None
Shark® 270 
meter doesn’t 
offer Fiber Optic 
communication.

NA NA

USB NA NA NA 250 meter:
Port: the PC’s 
USB port
Baud Rate: 
57600
Protocol: ASCII
Flow Control: 
None
Echo Mode: No 
Echo 
Parity: None, 

Port: the 
PC’s USB 
port
Baud Rate: 
57600
Protocol: 
ASCII
8 Data Bits, 
Parity None, 
1 Stop Bit, 
Flow Control 
None

Port: Front 
panel micro-
USB
Baud Rate: 
57600
Protocol: 
ASCII

4GLTE Cell 
Modem

NA NA NA 270 meter:
Use cell modem’s 
IP address to 
make a Network 
connection.

NA NA

Connection 
Type Shark® 50 Shark® 

100/100S Shark® 100B
Shark® 200/
250/200S/

270
MP200 ST40
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                          Table 2: Nexus® Meter Connection Settings

3.2: Connecting Directly to Your Meter

You can connect directly to your meter in one of three ways:

•   Through a Serial Port (Section 3.2.1)

•   Through a Network (Section 3.2.2)

•   Through an IrDA Port (refer to your meter’s user manual for instructions)

3.2.1: Connect through a Serial Port

When you connect to a meter through a serial port, you make a direct, wired connec-

tion between one of your PC’s ports and one of the meter’s ports. Depending on the 

meter, you will be using either the PC’s USB port or RS232 port to connect to either 

the USB port or RS485 port of the meter.

Connection 
Type

Nexus®
1252/1450 Nexus® 1262/1272 Nexus® 1500/1500+

ANSI Optical 
Port

NA Port: the PC’s USB Port
Baud Rate up to 57600

Port: the PC’s USB port
Baud Rate up to 57600

RS485 Baud Rate: up to 115200
Protocol: Modbus RTU/ASCII, 
DNP3

Baud Rate: up to 115200
Protocol: Modbus RTU/ASCII, 
DNP3

Baud Rate: up to 115200
Protocol: Modbus RTU/ASCII, 
DNP3

Ethernet/WiFi/
Fiber Optic 
(Fiber Optic is 
available only 
with the 
Nexus® 1450/
1500/
1500+meter)

Default Settings are:
Device Address:1
IP Address: 10.0.0.1
Port: 502
Protocol:
Modbus TCP

Default Settings are:
Device Address:1
IP Address: 10.0.0.1
Port: 502
Protocol:
Modbus TCP

Default Settings are:
Device Address:1
IP Address: 10.0.0.1
(10.0.0.2 for the second 
Ethernet card)
Port: 502
Protocol:
Modbus TCP 

Internal 
Modem 

1252: 
Protocol: Modbus ASCII 
Device Address: 1

Protocol: Modbus ASCII
Device Address: 1

NA

USB N/A NA Port: the PC’s USB port
Baud Rate: up to 115200
Protocol: Modbus RTU
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Since many newer PC’s don’t have RS232 ports, you may need an adapter to convert 

your USB port to RS485 communication. If you do have an RS232 connection, you will 

need to use an RS232 to RS485 converter. EIG manufactures an RS485 to RS232 con-

verter, model number Unicom 2500, that can be used for this purpose.

Irrespective of the type of serial connection, the screens you use to connect to the 

meter with ® software are the same. Refer to your meter’s Installation and Operation 

manual for wiring details for the serial connection you’ll be using.

1. From the CommunicatorPQA® application’s Mains screen, click on the Connect 

icon. (You can also click Connection>Quick Connect from the Menu Bar.)

Click the 
Connect 
Icon
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2. The Connect screen opens. You will use this screen to specify your serial connection 

settings.

3. Note that the Serial Port button is selected. Enter the following information (see the 

tables in 3.1: Overview, on page 3-1, for specific settings):

•   Device Address - the Modbus address of the meter; you can change this address 

to any number 1-247.

•   Baud Rate - the speed that data bits are sent; select from the pull-down menu.

•   Click the Available Ports button and select the port to use from the pull-down 

menu. This button causes the software to search for the port it thinks will be 

appropriate for your use.

•   Protocol - select the protocol you are using from the pull-down menu.

•   Flow Control - select None or Hardware.

•   Echo Mode - select No Echo or Static Echo. Static Echo should only be used 

when connecting to Fiber Optic devices that are configured for Echo.
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•   Parity - indicates whether a data integrity check is included and how it is config-

ured; select from None, Even, or Odd. 

•  Disable DTR - check to ignore data terminal ready control signal.

4. Click Connect to connect to the meter with these settings. Once you are connected, 

the Device Status screen for the meter opens. See Chapter 4 for details on this 

screen.

EIG meters default to Modbus protocol and Parity: None. The user can change the 

baud rate as desired. The default protocol is almost always Modbus RTU, unless 

communicating using the Shark® meters’ IrDA port, or through the modem, in 

which case the protocol defaults to Modbus ASCII.

3.2.2: Connect through a Network

When you connect to a meter through a network you are not wired directly to the 

meter. Your network can be wireless or wired, depending on the meter you are 

connecting to.

All of the EIG meters offer either optional or standard 10/100BaseT Ethernet wired 

(RJ45) Network connections.

1. From the CommunicatorPQA® application’s Main screen, click the Connect 

button. (You can also click Connection>Quick Connect from the Menu Bar.)

Click the 
Connect 
Button
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2. The Connect screen opens. Click the Network button to change to the Network 

connection screen. You will use this screen to specify your network connection 

settings.

3. Enter the following information (see the tables in 3.1: Overview, on page 3-1 for 

specific settings):

•   Device Address - the Modbus address of the meter; you can change this address 

to any number 1-247.

•   Host - enter the meter’s IP address, i.e., the address of the Ethernet card or cell 

modem. The example above on the left is for an IPv4 address; the example on 

the right is for an IPv6 address (supported by the Nexus® 1450 and Shark® 

250/270 Gen 2 meters). If you are using IPv6 for network connection, you 

must enable it. See 20.2.8: Software, on page 20-79 for instructions.

•   The Network Port’s default is 502 - you can change this if necessary.

•   The default protocol is Modbus TCP. You an select Modbus ASCII, Modbus RTU, 

or EI protocol from the pull-down menu if necessary for your connection.

4. Click Connect to connect to the meter with these settings. Once you are connected, 

the Device Status screen for the meter appears. See Chapter 4 for details on this 

screen.

•   Connecting to a device through Quick Connect automatically adds the device to 

the  MeterManagerPQA® application. This is a convenient way to connect to 

gateway devices and Internet devices.

IPv4 Address                                                         IPv6 Address
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3.3: Using the MeterManagerPQA® Application

MeterManagerPQA® software gives you an easy method of connecting to your 

meters. The software automatically finds the meters on your network and lists them 

by meter type, so that you can manage them and view their data, easily. You can also 

add meters with a serial connection to the software’s Meter List - see Chapter 18 for 

details.

1. From the MeterManagerPQA® application Monitor right-click on the meter you want 

to connect to.

Right-click on a meter
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2. You will see the submenu shown below. The submenu provides you with a list of the 

different apps that can be launched, giving you multiple options for viewing the 

selected meter’s data.

3. Click on Connect to Meter. The CommunicatorPQA® application opens and auto-

matically software connects to the meter. You will see the Main screen.If you want 

to view meter data right away, you can click Real Time Readings from the submenu 

to open the Real Time polling screen. See Chapter 5 for information on polling.

NOTE: See Chapter 18 for a complete explanation of the MeterManagerPQA® appli-

cation.

Right-click on a meter 
for App launcher
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4: Viewing Device Status

4.1: Device Status Screen

When you connect to a meter with CommunicatorPQA® software (see Chapter 3 for 

instructions), the Device Status screen of the meter you are connected to opens. You 

can also open the meter’s Device Status screen by clicking on the Dev Stats icon or 

clicking Tools>Retrieve Device Status. (See Chapter 20 for more information on the 

Tools menu options.)

The only exception to this is if you connect to a meter through MeterManagerPQA® 

software, the Device Status screen does not automatically open. 

The Device Status screen displays information about the meter: device ID, device 

type, device serial number, V-SwitchTM key, and firmware version. In addition, some of 

the meter’s Device Status screens display additional information. 

All of the Device Status screens have buttons at the bottom of the screen:

•   OK - all of the screens have this button; click it to close the screen.

•   Copy - some of the screens have this button; click it to copy the information on the 

screen to the clipboard, from which you can paste it into another application, e.g., a 

document.

•   Help - some of the screens have this button; click it to open information on this 

screen.

The following sections show all of the meters’ Device Status screens, with an explana-

tion of the fields they contain. 

  Click on the 
Dev Stats Icon
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4.1.1: Shark® 200/200S Meter

The Shark® 200/200S meter’s Device Status screen displays:

•   Device Name - the name assigned to the meter in the System Settings screen (see 

Chapter 8)

•   Device Type - e.g., Shark200T - a Shark® 200 transducer

•   Meter’s Serial Number 

•   Boot - the version of the Boot firmware of the meter 

•   Run - the version of the Runtime firmware of the meter 

•   State - information about the meter, e.g., shown above Run Mode, Logging 

Enabled, means that the meter is running and logging is enabled for the meter

•   V-Switch: the number of the V-SwitchTM key currently installed in the meter

•   On Time: the date and time the meter was last powered on

•   ASIC - the Shark® 200 meter has some specialized circuitry to provide its 

advanced accuracy: this field is the internal chip’s hardware version 
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4.1.2: Shark® 50/100/100B/100S Meter

The Shark® 50/100/100B/100S Device Status screen displays:

•   Device Name - the name assigned to the meter in the Settings screen (see Chapter 

9)

•   Device Type - e.g., Shark 100 - a Shark® 100 meter

•   Run-time - the version of the Runtime firmware of the meter 

•   Meter’s Serial Number 

•   V-SwitchTM key
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4.1.3: MP200TM Metering System

 

The MP200TM metering system’s Device Status screen displays:

•   Device Name - the name assigned to the CPU in the System Settings screen (see 

Chapter 10)

•   Device Type - i.e., MP200 

•   Meter’s Serial Number 

•   Boot - the version of the Boot firmware of the meter 

•   Run - the version of the Runtime firmware of the meter 

•   State - information about the meter, e.g., shown above Run Mode, Logging 

Enabled, Battery OK means that the meter is running, logging is enabled for the 

meter, and the meter battery has sufficient operating power

•   V-Switch - the number of the V-SwitchTM key currently installed in the meter

•   On Time - the date and time the meter was last powered on
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4.1.4: Nexus® 1500/1500+ Meter

NOTE: Since the Nexus® 1500/1500+ meter’s Device Status screen shows so many 

fields, 3 screen captures are shown to include them all.
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The Nexus® 1500/1500+ meter’s Device Status screen displays:

•   Device Name - the name assigned to the meter in the Labels screen (see Chapter 
11)

•   Device Type - i.e., Nexus 1500+

•   Meter’s Serial Number 

•   Comm Boot - the version of the Boot firmware of the meter’s Communication 
processor

•   Comm Run - the version of the Runtime firmware of the meter’s Communication 
processor

•   DSP1 Boot - the version of the Boot firmware of the meter’s first digital signal 
processor - Nexus® 1500 meter only
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•   DSP1 Run/DSP2 Run - the version of the Runtime firmware of the meter’s first and 
second digital signal processor - Nexus® 1500 meter only

•   DSP Run - the version of the Runtime firmware of the meter’s digital signal proces-
sor - Nexus® 1500+ meter only

•   FPGA - the version of the FPGA firmware of the meter: FPGA is field programmable 
gate array, which is used in the Nexus® 1500/1500+ meter for the very high-
speed sampling

•   DSP2 Run ID - the version of the DSP2 Run ID firmware - Nexus® 1500 meter only 

•   DSP Run ID - the version of the DSP Run ID firmware - Nexus® 1500+ meter only

•   DSP2 Run Type - the version of the DSP2 Run Type firmware - Nexus® 1500 meter 
only

•   DSP Run Type - the version of the DSP Run Type firmware - Nexus® 1500+ meter 
only

•   V-Switch - the number of the V-SwitchTM key currently installed in the meter

•   Comm State - the state of the meter’s Communication Processor, e.g., Healthy or
 IEC 61850 Goose (Nexus® 1500+ meter only)

•   DSP1 State/DSP 2 State - the state of the meter’s first and second digital signal 
processor, e.g., Healthy - Nexus® 1500 meter only

•   DSP State - the state of the meter’s DSP - Nexus® 1500+ meter only

•   Protection - information about the meter’s password protection - e.g., partial 
access via Administrator password

•   On Time - the date and time the meter was last powered on

•   CF Serial # - the manufacturer’s serial number for the compact flash

•   CF FAT Type - the file system type used on the compact flash for storage of log files

•   CF Model # - the manufacturer’s model number for the compact flash 

•   Comm Boot Variation Strings - field used to indicate the configuration and func-
tionality supported by the Boot firmware (for developer use)

•   Comm Run Variation Strings- field used to indicate the configuration and function-
ality supported by the Run firmware (for developer use)

•   DSP1 Boot Variation Strings - the minimum hardware version needed to support 
the firmware (for developer use) - Nexus® 1500 meter only
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•   DSP1 Run Variation Strings - the minimum hardware version needed to support the 
firmware (for developer use) - Nexus® 1500 meter only

•   DSP2 Run Variation strings - field used to indicate hardware and firmware configu-
ration (for developer use) 

•   DSP Run Variation Strings - the minimum hardware version needed to support the 
firmware (for developer use) - Nexus® 1500+ meter only

•   Current Class - the Current Class supported by this meter

•   Flags - state of various meter settings, e.g., IRIG-B.

•   Security Features: additional information concerning the meter’s security settings - 
Nexus® 1500+ meter only

4.1.5: Nexus® 1252/1262/1272 Meter

NOTES: 

•   The Nexus® 1252/1262/1272 Device Status screens show the same fields.

•   Since the Device Status screen is very long, two screen captures are shown for it.

The Nexus® 1252/1262/1272 meter’s Device Status screen displays:

•   Device Name - the name assigned to the meter in the Labels screen (see chapters 

12 and 13)

•   Device Type - e.g., Nexus 1272
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•   Boot - the version of the Boot firmware of the Communication Processor of the 

meter 

•   Runtime - the version of the Runtime firmware of the Communication Processor of 

the meter 

•   DSP Boot - the version of the Boot firmware the of meter’s digital signal processor 

•   DSP Runtime - the version of the Runtime firmware of the meter’s digital signal 

processor 

•   Comm State - the state of the meter’s Communication Processor, e.g., Healthy

•   DSP State - the state of the meter’s digital signal processor, e.g., Healthy

•   On Time - the date and time the meter was last powered on

•   Meter’s Serial Number 

•   NVRAM - the amount of non-volatile RAM memory in the meter

•   Protection - information about the meter’s password protection and sealing switch 

- whether they are enabled or disabled

•   Xilinx DSP - the build version of the gate array for the digital signal processor

•   Xilinx COM - the build version of the gate array for the communication processor
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4.1.6: Shark® 250/270 Meter

The Shark® 250/270 meter’s Device Status screen displays:

•  Boot Firmware Version.

•  Run Firmware Version.

•  ASIC Revision: the meter has some specialized circuitry to provide its advanced 
accuracy - this field is the internal chip’s hardware version.

•  State: information about the meter, e.g., shown in the example screen, Run Mode, 
Logging Enabled, means that the meter is running and logging is enabled for the 
meter.

•  V-Switch: the current V-SwitchTM key level.

•  Power On Time: the date and time the meter was last powered on.

•  Assembly Date: the date and time of meter manufacture.

•  Temperature: temperature of the meter, in Celsius.

•  Option Card 1/Option Card 2: information about any option cards in the meter.

•  Protection: the Security status of the meter; e.g., Security: Passwords Enabled.

•  Modbus Map Version: the meter’s Modbus map version number.
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4.1.7: Nexus® 1450 Meter 

The Nexus® 1450 meter’s Device Status screen displays:

•  Comm Run firmware version.

•  Web Run firmware version.

•  DSP Run Firmware version.

•  Comm State - the state of the meter’s Communication Processor, e.g., Healthy, IEC 

61850 Goose Running.

•  DSP State - the state of the meter’s digital signal processor, e.g., Healthy.

•  Protection: the 1450 meter’s screen shows the status of Security for the meter; 

e.g., Security: Passwords Enabled.

•  On Time - the date and time the meter was last powered on.
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•  CF Serial # - the manufacturer’s serial number for the compact flash.

•  Current Class - the Current Class supported by this meter.

•  FPGA Serial # - the Serial number of the FPGA chip in the meter 

•  Internal Temperature - temperature of the meter, in Celsius.

4.1.8: ST40 Meter

NOTE: If your ST40 meter is the mV option, the Device Type will say ST40 mV.

The ST40/ST40 mV meter’s Device Status displays:

•  Boot firmware version.

•  Runtime firmware version.

•  ASIC - the ST40/ST40 mV meter has some specialized circuitry to provide its 

advanced accuracy: this field is the internal chip’s hardware version 

•  State - information about the meter, e.g., shown in the example screen, Run Mode, 

Logging Enabled, means that the meter is running and logging is enabled for the 

meter.

•  V-Switch - the current V-SwitchTM key level.

•  On Time - the date and time the meter was last powered on.
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5: Polling Your Meter 

5.1: Overview

The EIG meters offer Real Time polling, which lets you view instantaneous and stored 

values within one or several EIG meters. CommunicatorPQA® software provides tab-

ular views of metered values, circuit measurements, interval data, power quality val-

ues, pulse data and Input/Output status and accumulations. The Real-Time Polling 

features are divided into three groups, accessed by clicking the Real-Time Poll menu: 

Real Time Readings; Revenue, Energy and Demand Readings; and Power Quality and 

Alarms. In addition, the Nexus® 1500/1500+ meter has a feature to view RTU data 

from connected slave devices. Some Shark® meters also have a feature that allows 

for real time trends polling.

•   Some polling screens are different for the different meter types. Where there are 

differences, they are explained.

•   Depending on your meter type and ordered options, you may not have all of the 

polling screens shown in this chapter.

•   CommunicatorPQA® software receives data from one connected device at a time—

the Primary Device. To view polling data from multiple devices, either select Poll 

Multiple Devices (Section 5.2.4) or change the Primary Device (select Connec-

tion>Change Primary Device; see Section 3.6 for instructions).

•   Some of the polling screens are directly available by clicking on an icon in the Icon 

Bar. This is explained in the relevant sections.

5.1.1: Polling Screen Buttons

All of the polling screens have buttons at the bottom of the screen that let you 

perform certain tasks. The buttons and their actions are as follows:

•   Print - click to send a copy of the screen to a printer.

•   Pause - click to stop polling.

•   Resume - click to restart polling which has been stopped.
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•   Copy - click to copy the data to the clipboard from where it can be brought into 

another application, e.g., a spreadsheet or an email.    

•   Export - click to export the data to a file - you will be prompted to set the file name 

and location.

•   Help - click to view instructions for the screen. 

•   OK - click to return to the Main screen.

NOTE: A polling screen will have some combination of the above buttons. 

5.2: Real Time Readings

The menu above is for a Nexus® 1500/1500+ meter - the menu for your meter may 

look a bit different.
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5.2.1: Instantaneous Polling

To view instantaneous polling data for the primary device, either select Instantaneous 

Polling from the Real-Time Poll>Real Time Readings menu, or click the Polling button 

in the Icon Bar. 

If you are connected to a Nexus® device, you will see the screen shown above. If you 

are connected to a Shark® 200 device, you will see a similar screen, but it will not 

display the “AUX” or “Nm” readings; and it will display a “-Average” reading for Reac-

tive Power. 

•   The graphic representation on the right side of the screen is determined by the 

option selected from the pull-down menu at the bottom of the screen (Volts A, B, 
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C; Current A, B, C). Select either spectrum or waveform view by clicking on the 

Spectrum/Waveform button. An example of the spectrum display is shown below.

•   Click the radio button in the lower right corner to select either 1 Second or High 

Speed measurements for all data. You will not see this option if you are connected 

to a Shark® 200 meter. This is because the Shark® meter does not contain the 

high-speed readings as extensively as found in the Nexus® meter.
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If you are connected to a Shark® 100 meter, you will see the screen shown below.

It shows:

•   Voltage per phase and phase to phase

•   Maximum and minimum voltage readings

•   THD for voltage

•   Amps per phase

•   Maximum and minimum Demand

•   THD for current

•   Frequency, including maximum and minimum frequency
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If you are connected to the MP200TM metering system, you will see one of the follow-

ing screens.

You will see the screen shown above if you have the MP200-S single phase configura-

tion; it shows Voltage, Frequency, Current, Watts, VAR, VA, and Power Factor real 

time readings for all 24 meters.
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You will see the screen shown above if you have the MP200-Y three phase configura-

tion. The tabs let you see Voltage, Current, Watts, VAR, VA, and Power Factor real 

time readings.
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5.2.2: Poll Max and Min Readings

To view the maximum and minimum readings for the currently connected device, 

select Poll Max and Min Readings from the Real-Time Poll>Real Time Readings menu. 

NOTE: The Max/Min is the Max/Min of the Thermal Average in the profile.

You will see the screen shown above if you are connected to a Nexus® meter.

NOTES: 

•   Use the scroll bars to access all data. 

•   To adjust the column width, position the cursor on a line between columns at the 

top of the screen. When the cursor changes to a left/right arrow, hold down the left 

mouse button and drag the column border left or right. Release the button when 

the column is at the desired width.

•   You need to pause polling (click the Pause button) before you can copy the data in 

this screen.
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You will see the screen above if you are connected to an MP200-S metering system. 

Maximum and minimum value and the time it occurred are shown for each of the 

readings. Click on the tabs to see readings for all of the 24 meters.



     Doc#    E107707                                                  5-10

             5: Polling Your Meter

You will see the screen above if you are connected to an MP200-Y metering system or 

a Shark® 250/270 meter (the 250/270 meter doesn’t have the tabs). Maximum and 

minimum value and the time it occurred are shown for all of the readings. For 

MP200TM metering system, click on the meter tabs to see data for each of the 8 

meters.

The bottom of the Shark® 250/270 screen shows a demand reset counter that can be 

used to verify the number of resets reported by other systems.
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5.2.3: Poll Reading Grid

This screen is only available for the Nexus® meters. To view all available polling data 

of the currently connected device, select Poll Reading Grid from the Real-Time 

Poll>Real Time Readings menu. You will see the screen shown below.

•   Use the scroll bars to access all data. 

•   The first two columns are Instantaneous values, column 3 is the Thermal average, 

columns 4 - 7 are the positive and negative Thermal maximum and minimum val-

ues, and column 8 is a single cycle value captured during the last screen update.

•   To adjust the column width, position the cursor on a line between columns at the 

top of the screen. When the cursor changes to a left/right arrow, hold down the left 

mouse button and drag the column border left or right. Release the button when 

the column is at the desired width.

•   You need to pause polling (click the Pause button) before you can copy the data in 

this screen.
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5.2.4: Poll Multiple Devices

To view polled data from multiple devices connected to your computer, select Poll 

Multiple Devices from the Real-Time Poll>Real Time Readings menu. You will see the 

screen shown below.

This screen lets you see real time readings for all of the meters you are connected to; 

not just the primary meter as the other screens show. Click on the tabs to access the 

following readings: 

NOTE: If a particular meter does not support a reading or option, there will be no 

data shown in the unsupported fields.

•   High Speed - the following high speed readings for the meter: Volts AN, BN, CN, 

Aux, IA, B, C, Nm, Volts AB, BC, CA, VA A, B, C, Total, VAR A, B, C, Total, Watt A, B, 

C, Total, Freq, Power Factor A, B, C, Total, VAN Aux, Update Time. 
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•   1 Second - the following 1 second readings: Volts AN, BN, CN, Aux, IA, B, C, Nm, 

Nc, Volts AB, BC, CA, VA A, B, C, Total, VAR A, B, C, Total, Watt A, B, C, Total, Freq, 

Power Factor A, B, C, Total, Imb V, I, Update Time. 

•   Average - average value of the following readings: Volts AN, BN, CN, Aux, IA, B, C, 

Nm, Nc, Volts AB, BC, CA, VA A, B, C, Total, VAR A, B, C, Total, Watt A, B, C, Total, 

Freq, Power Factor A, B, C, Total, Imb V, I, Update Time. 

•   Maximum - maximum value of the following readings: Volts AN, BN, CN, Aux, IA, 

B, C, Nm, Nc, Volts AB, BC, CA, VA A, B, C, Total, P VAR A, B, C, Total, N VAR A, B, 

C, Total, P Watt A, B, C, Total, N Watt A, B, C, Total, Update Time.

•   Minimum - minimum value of the following readings: Volts AN, BN, CN, Aux, IA, B, 

C, Nm, Nc, Volts AB, BC, CA, VA A, B, C, Total, P VAR A, B, C, Total, N VAR A, B, C, 

Total, P Watt A, B, C, Total, N Watt A, B, C, Total, Update Time.

•   Hour Readings - the following readings: + Watthour, - Watthour, +VARhour, 

- VARhour, VAhour.

•   Device Time - the Device number, Date, and Time.

•   Accumulations - the following readings: I Squared T A, I Squared T B, I Squared T 

C, V Squared T A, V Squared T B, V Squared T C.

•   Relay Status - the status of any meter relays.

•   Internal Inputs - the status of any meter internal inputs.

Use the scroll bars to access all data.
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5.2.5: Poll External Analog Inputs

Nexus® Series meters have the capability of receiving information from external 

analog input modules. These modules can tell a user about many different process 

values. Such values can include temperature, humidity, flow, and many others. 

Shark® meters do not have this feature. 

To view readings from any external Analog Input modules connected to your 

meter, select Poll External Analog Inputs from the Real-Time Poll>Real Time Readings 

menu. You will see the screen shown below.

•   The name, Raw value and primary value are shown for each of the meter’s external 

analog inputs. 

•   The name can be programmed in the meter’s programmable settings. See sections  

11.5.1: Configuring the Input/Output Modules, on page 11-113 (Nexus® 1500/

1500+ meter), 27.5.1: Configuring the Input/Output Modules, on page 27-80 

(Nexus® 1450 meter), 12.5.1: Configuring the Input/Output Modules, on page 12-

98 (Nexus® 1262/1272 meter), or 13.5.1: Configuring the Input/Output Modules, 

on page 13-77 (Nexus® 1252 meter) for instructions.



     Doc#    E107707                                                  5-15

             5: Polling Your Meter

5.2.6: Poll Short Term Max and Min Readings

To see values for short term maximum and minimum readings, select Poll Short Term 

Max and Min Readings from the Real-Time Poll>Real Time Readings menu. You will 

see the screen shown below.

This screen shows the maximum, minimum, and average values for the previous 

interval. The values are updated every second. You will see the screen above if you 

are connected to a Nexus® 1450/1500/1500+ meter. This feature is used to provide 

a user with the value of a maximum and minimum within a load profiling interval. This 

is generally very useful for logging voltage where the greatest excursion value is the 

only concern. 

Note that if you are connected to a Nexus® 1450 meter, you won’t see phase to earth 

readings and the interval for averaging and peak values is set to 15 minutes.
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You will see the screen above if you are connected to an MP200-S metering system. It 

shows the short term:

•   Primary voltage maximum and previous interval maximum values

•   Primary voltage minimum and previous minimum values
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You will see the screen shown above if you are connected to an MP200-Y metering 

system. It shows the short term primary voltage maximum and minimum values for 

phase to phase and phase to reference.
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5.2.6.1: Uncompensated Power and Energy and Short Term Max and
               Min Voltage Readings (Shark® 200/250/270/ST40 Meter) 

The Shark® 200/250/270/ST40 meter has a screen that displays both short term 

maximum and minimum voltage readings and uncompensated power and energy 

readings. Select Uncompensated and Short Term Max and Min Readings from the 

Real-Time Poll>Real Time Readings menu. You will see the screen shown below. 

This screen has two tabs.

•  Uncompensated Readings Block tab, which displays per phase, net, and total Power 

and Energy values that have not been adjusted by Transformer Loss Compensation. 

This screen allows the user to view what the uncompensated power and energy is if 

Transformer Loss Compensation is enabled. This way a log of uncompensated and 

compensated readings can be kept, at the same time.
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•   Short Term Maximum and Minimum Voltages tab (shown above), which displays 

the Primary Voltage maximum and minimum values, for phase to phase and phase 

to reference. This reading is the maximum voltage seen within a logging interval 

and the minimum voltage seen within that same logging interval. This is often used 

to log in a history log so that a user is seeing the worst voltage excursion during 

the time period. It is often more useful data than an instantaneous log point or an 

average of the 15 minute voltage.
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 5.2.7: Poll Energy and Max Demands (MP200 Metering System)

The MP200TM metering system has a unique screen that shows instantaneous Energy 

and maximum Demand readings. Select Poll Energy and Max Demands from the Real-

Time Poll>Real Time Readings menu. 

You will see the screen above if you are connected to an MP200-S metering system. 
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You will see the screen above if you are connected to an MP200-Y metering system.

Click on the tabs to display information the readings for the additional meters.



     Doc#    E107707                                                  5-22

             5: Polling Your Meter

5.3: Revenue, Energy, and Demand Readings

The menu above is for a Nexus® 1500/1500+ meter - the menu for your meter may 

look a bit different.
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5.3.1: Poll Power

To view Power readings for the currently connected device, select Poll Power from the 

Real-Time Poll>Revenue, Energy, and Demand Readings menu. You will see the 

following screen if you are connected to a Nexus® meter.

The tabs at the top of the screen let you access the following readings:

•   Totals - 1 second, thermal, block, rolling, and predicted readings for Watts, VARS, 

VA and PF.

•   1 Second updated per phase - Total and per phase readings updated every second 

for Watts, VARS, VA and PF.

•   Thermal per phase - Total and per phase thermal readings for Watts, VARS, VA and 

PF.

•   Uncompensated - Total and per phase uncompensated readings for Watts, VARS, 

and VA values that have not been adjusted by Transformer Loss Compensation.

•   Fundamental - Total and per phase readings for fundamental Watts, VARs, VA, and 

PF.
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5.3.1.1: Poll Power and Energy (Shark® 50/100/200/
               250/270/ST40 Meters)

Instead of separate Power and Energy polling screens, the Shark® 50/100/200/250/

270/ST40 meters have a combined screen that shows both power and energy read-

ings. Click Real-Time Poll>Revenue, Energy and Demand Readings>Power and 

Energy. See the example screens, below. 

The tabs at the top of the screen let you access the following readings:

•   Total - Displays real time, maximum and minimum for power, energy, and demand 

for all phases.

•   Phase A, B, and C tabs show the same readings as the Total tab, but just for that 

phase. 

NOTE: If you are connected to a Shark® 100 meter, you will only see the Total tab.

Shark® 200 Meter Example                              Shark® 250/270 Meter Example
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5.3.2: Poll Demand

To view Demand data for the currently connected device, select Demand from the 

Real-Time Poll>Revenue, Energy, and Demand Readings menu. You will see the 

screen shown below if you are connected to a Nexus® meter.

The tabs at the top of the screen let you access the following readings:

•   Peak - displays the Thermal, Block, and Rolling Peak Demand for +/- Watts, +/- 

Watts Coincident VARS, and +/- VARS. 

•   Peak, or Maximum Demand is the largest Average Value for the selected 

Demand interval.

•   Thermal - displays averages, maximum, and minimum readings with timestamps 

for Watts, VARs, and VA. 

•   Thermal or Exponential Demand is used to emulate the operation of electrome-

chanical Thermal Demand meters. This measurement responds like lagged ther-

mal heating effects in electrical equipment.
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•   Thermal Average VARS/VA are the exponential average VARs/VA. Exponential 

averages are used because they discount older values and respond more like the 

thermal effects.

•   Block - displays averages, maximum, and minimum readings with timestamps for 

Watts, VARs, and VA; displays + and - Watt Coincident PF.

•   Rolling - displays averages, maximum, and minimum readings with timestamps for 

Watts, VARs, and VA; displays + and - Watt Coincident PF.

Note that the Nexus® 1450 meter’s Demands screen has a combined Block/Rolling 

tab.

You will see the polling screen above if you are connected to a Shark® 200/250/270 

meter.
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You will see the polling screen above if you are connected to a Shark® 100 or ST40 

meter.
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You will see the screen above if you are connected to an MP200-S metering system. 

Click the tabs to display Current, Positive Watts, Negative Watts, VAR, VA, and Power 

Factor Demand readings for the 24 meters.
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You will see the polling screen above if you are connected to an MP200-Y metering 

system. Click the tabs to display Current, Positive Watts, Negative Watts, VAR, VA, 

and Power Factor Demand readings for the 8 meters.
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5.3.2.1: Poll Demand Grid

The Shark® 250/270 meter has an additional Demand polling screen. Select Demand 

Grid from the Real-Time Poll>Revenue, Energy, and Demand Readings menu.

This screen shows the Total and per Phase Demand for the meter readings, as well as 

Cumulative and Continuous Cumulative values for the quadrants - use the scroll bar 

to display those fields.

Change to this screen for the May, 2021 CommunicatorPQA® software release:

•  Q hour positive and negative totals are shown rather than Q hour per phase. 
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5.3.3: Poll Energy

To view Energy data for the currently connected device, select Energy from the Real-

Time Poll>Revenue, Energy, and Demand Readings menu. 

5.3.3.1: Poll Energy (Nexus® Meter)

You will see the screen shown below if you are connected to a Nexus® meter.

The tabs at the top of the screen let you access the following readings:

•   Quadrant Energy (Primary) - displays readings for each quadrant of the four-quad-

rant Nexus® meter. 

•   Cumulative Demand - displays Delivered, Received, and Continuous Watts in 

Secondary and Primary.

•   I2 & V2 T - displays positive readings for phases A, B and C and average of the 

readings.

•   Q Hours - displays positive and negative Qhr readings in Secondary and Primary. 

NOTE: The Q Hour reading lags the Watt hour reading by 60o. A Q Hour meter 

measures power between 150o and 270o, which are quadrants 2 and 3. Q is one of 

the values used in calculating quadergy (VAR hours).
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•   Uncompensated Energy - displays + and - Wh, + and - VARh, and VAh readings 

that have not been adjusted by Transformer Loss Compensation, in Secondary and 

Primary.

•   Energy - displays primary and secondary + and - Wh, + and - VARh, and VAh 

readings.

5.3.3.2: Poll Energy (MP200TM Metering System)

You will see the Energy and Demand polling screen when you click Revenue and 

Energy Metering>Energy. See 5.2.7: Poll Energy and Max Demands (MP200 Metering 

System), on page 5-20.
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5.3.3.3: Poll Energy Grid (Shark® 250/270 Meter)

You will see the screen below if you are connected to a Shark® 250/270 meter. It 

shows compensated and uncompensated readings for Energy, the Energy in the Inter-

val, and Energy in the Interval (Pulses) based on primary, for all Energy channels. Use 

the scroll bar to view additional Energy channels. 

Changes to this screen for the May, 2021 CommunicatorPQA® software release:

•  Q hour positive and negative totals are shown rather than Q hour per phase. 

•  I2T and V2T values are shown.
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5.3.4: Poll Energy, Pulses, and Accumulations in the Interval

To view the Energy, Pulse & Accumulations in the Interval of the currently connected 

device, select Energy, Pulse & Accumulations in the Interval from the Real-Time 

Poll>Revenue, Energy, and Demand Readings menu. You will see the screen shown 

below if you are connected to a Nexus® meter.

Energy in the interval is the energy that is accumulated within a load profiling inter-

val. This is often the preferred method for logging because it is a summation of only 

that particular period of energy. 

This screen displays readings from the Interval set on several screens (see chapters 

11, 12, 13 for details):

•   Demand Integration Intervals 
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•   I and V Squared T Thresholds

•   Interval in minutes (15 = Initial setting)

•   Internal KYZ Outputs 

•   Pulse Accumulations 

The Interval field at the bottom right of the screen is the interval that the values 

on the screen represent; in this example, a 15 minute interval. The tabs at the top of 

the screen let you access the following readings:

•   Hour Counters - displays readings in all four quadrants for the interval pro-

grammed in the Device Profile, and displayed at the bottom right of the screen.

•   Uncompensated Energy - displays interval readings that are not adjusted by Trans-

former Loss Compensation.

•   Q Hours - displays Qhr interval readings.

•   Q is the quantity obtained by lagging the applied voltage to a Watt meter by 60 

degrees.

•   I & V Squared T - displays I and V Squared T readings per phase.

•   KYZ Pulse Output - displays readings for internal KYZ relays and/or LED.

•   Pulse Accumulations - displays readings for the eight high speed internal inputs 

and aggregators (set up in the Pulse Accumulations screen of the meter’s Device 

Profile).
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5.3.4.1: Energy in the Interval/Interval Energy

The Shark® 200 meter, ST40 meter, and the MP200TM metering system have a polling 

screen that shows interval energy readings. The interval is set in the Demand Averag-

ing settings - see chapters 8 and 10 for details.

Energy in the interval is the amount of energy actually accumulated in a logging inter-

val. This is commonly used as a load profiling value, so that the user can see usage 

without having to subtract energy counters.

•   For the Shark® 200 and ST40 meter, select Energy in the Interval from the Real-

Time Poll>Revenue, Energy, and Demand Readings menu. 

•   For the MP200TM metering system, select Interval Energy from the Real-Time 

Poll>Revenue, Energy, and Demand Readings menu. 

You will see the screen above if you are connected to a Shark® 200 meter. The field 

at the right bottom of the screen tells the time and date that these readings are from; 

in this example screen, 4 pm on August 28, 2014.
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You will see the screen above if you are connected to an MP200-S metering system. 

Click the tabs to see Watt Hour VA Hour and VAR Hour positive, negative, net and 

total readings for all 24 meters.
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You will see the screen above if you are connected to an MP200-Y metering system. 

Click the tabs to see Watt Hour received, delivered, net and total, per phase and 

totaled; VA Hour per phase and total; and VAR Hour positive, negative, net and total 

per phase and totaled.
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5.3.5: Poll Frozen Energy, Pulses, and Accumulations 

To view the Frozen Energy, Pulses, and Accumulations in the for the currently 

connected Nexus® meter, select Frozen Energy, Pulses, and Accumulations from the 

Real-Time Poll>Revenue, Energy, and Demand Readings menu. You will see the 

screen shown below.

This screen shows the same readings as explained in Section 5.3.4 (Poll Energy, 

Pulses, and Accumulations in the Interval), except that the values shown are frozen 

from the most recent hour, rather than updated on the programmed interval, e.g., 

every 15 minutes. 

This is designed so that a utility RTU or SCADA system will be able to poll the data 

after the fact, without it changing, so that there is no risk of losing the data. 
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Click on the tabs to view additional readings - refer to 5.3.4: Poll Energy, Pulses, and 

Accumulations in the Interval, on page 5-34, for a description of the tabs.

5.3.6: Poll Internal KYZ Output Accumulations 

To view the Internal KYZ Output Accumulations of the currently connected Nexus® 

meter, select Internal KYZ Output Accumulations from the Real-Time Poll>Revenue, 

Energy, and Demand Readings menu. You will see the screen shown below.

This screen displays the readings from the KYZ Output Relays. Refer to Chapters 11, 

12, 13, and 27 for instructions on configuring the Internal KYZ Outputs.

NOTE: The screen shown here is from a Nexus® 1272 meter. 

•   The screen for a Nexus® 1252 meter only shows the Heartbeat LED. On a Nexus® 

1252 meter, the heartbeat LED serves a dual purpose. It can be used as a meter 

heartbeat to signify that the system is working, or switched into a pulse mode to 

output a KYZ pulse to test and confirm accuracy.

•   The screen for the Nexus® 1500/1500+ meter only shows the relays.

•   The screen for the Nexus® 1450 meter shows two Test pulse LEDs and two Output 

pulses.
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5.3.7: Poll Total Average Power Factor

To view Total Average Power Factor for the Nexus® meter connected to your 

computer, select Total Average Power Factor from the Real-Time Poll>Revenue, 

Energy, and Demand Readings menu. You will see the screen shown below.

The readings on this screen are based on Power Factor settings (maximum and mini-

mum power settings) from the Device Profile of the connected device. 

NOTE: This feature is only available with the Nexus® meters, though not the Nexus® 

1450 meter.
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5.3.8: Poll Time of Use Registers

To view Time of Use Readings for the meter connected to your computer, select Time 

of Use from the Real-Time Poll>Revenue, Energy, and Demand Readings menu. You 

will see the screen shown below if you are connected to a Nexus® 12xx meter or a 

Nexus® 1500 meter. 

•   The readings on this screen are based on the Time of Use settings for the 

connected device.  

•   Use the drop-down menus at the top of the screen to view a choice of Groups and 

Registers. 
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•   To copy the data into another program, click Copy. You will see the screen shown 

on below. Select Groups and Registers and click OK. You will see a message that 

your data was copied to the clipboard. You can then paste it into a document.

•   Click Export to save the data as a CSV text file. You will see the screen above. 

Select Groups and Registers and click OK. You will be prompted to enter a name 

and location for the .csv file.
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If you are connected to a Nexus® 1450 or 1500+ meter or a Shark® 250/270 meter, 

you will see the screen shown below.

•  This screen has two tabs - the one above shows the data for TOU Channels.

•  Select the billing period for which you want to view data from the Billing Period 

pull-down menu.

•  Select the rate for which you want to view data from the Rate pull-down menu.

•  The following data is displayed for the billing period and rate you selected:

• TOU channel, e.g., Positive Wh for Quadrants 1 and 4

• Accumulator value for the channel

• Peak Demand for the channel

• Time of Peak Demand

• Type of Coincident Demand for the channel

• Coincident Demand value

• Type of Cumulative Demand 

• Cumulative Demand value
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•  Click the Status tab to display the screen shown below.

•  This screen displays information about the current TOU status. 

• The Billing Period fields tell you the current billing period, prior billing 

period, current season, and prior season.

• The Self Read Status fields tell you the self read times for the current bill-

ing period and season, and the prior billing period and season. You won’t 

see these fields in the Manual Read Status screen.

• The TOU Status tells you if TOU is currently running and which mode it is 

in (Self Read or Manual Read).

• The current time is also displayed.

Self Read
Mode Status
   Screen

Manual Read
Mode Status

Screen
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5.3.9: Poll Pulse Accumulations

To view the Pulse Accumulations readings for the currently connected Nexus® meter, 

select Poll Pulse Accumulations from the Real-Time Poll>Revenue, Energy, and 

Demand Readings menu. You will see the screen shown below.

Pulse accumulators allow the meter to be used as a totalizer, to count and totalize 

pulses from external devices. This will allow a user to count pulses from other meters, 

such as other electric or gas meters.   

This screen is the result of configuring the Pulse Accumulations setting in the meter’s 

Device Profile - see chapters 11, 12, 13, 27, and 28 for details. The Nexus® meter 

can be programmed to accumulate and aggregate pulses from any pulse generating 

device.
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This screen displays:

•   The scaled pulse accumulations from the Nexus® meter’s eight internal digital 

inputs 

•   The Fixed Window average and maximum Demand, with timestamp, for the eight 

pulse accumulations 

•   The Watt Hour Energy reading

•   The Acc To field which indicates the count added to or subtracted from an Aggrega-

tor, e.g, in the sample screen, +2 means a count is added to Aggregator 2, and -3 

means a count is subtracted from Aggregator 3. The pulse aggregators are set up 

in the meter’s Device Profile, in the Pulse Accumulations setting. See sections 

11.2.9: Pulse Accumulations, on page 11-50 (Nexus® 1500+ meter), 12.2.10: 

Pulse Accumulations, on page 12-64 (Nexus® 1262/1272 meter), and 13.2.10: 

Pulse Accumulations, on page 13-42 (Nexus® 1252 meter) for details.

•   Four totalizers (Aggregators), which are combinations of the eight internal inputs 

and the Nexus® meter’s Watt Hour counter.
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5.3.9.1: Poll Pulse Accumulators (Shark® 200/250/270 Meter 
                and the MP200TM Metering System)

The Shark® 200/250/270 meter equipped with a Pulse Output/Digital Input Card and 

the MP200TM metering system have a polling screen that displays accumulations for 

the Digital Inputs. Select Poll Pulse Accumulations from the Real-Time Poll>Revenue, 

Energy, and Demand Readings menu. 

You will see the screen above if you are connected to a Shark® 200/250/270 meter 

with a Relay and/or Pulse Output/Digital Input option card. It displays the current 

readings for the Input and Output accumulators for the cards. The readings are shown 

after the configured compression and units/count have been applied. See chapters 8, 

10, 26, and 28 for information on setting compression and units/count for accumula-

tors.
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You will see the screen above if you are connected to an MP200TM metering system. It 

shows the scaled and unscaled input and output for the embedded Relay Output/Digi-

tal Input card.
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5.3.10: Poll Previous Average Block

To view the previous Average Block readings for the currently connected Nexus® 

meter, select Previous Average Block from the Real-Time Poll>Revenue, Energy, and 

Demand Readings menu. You will see the screen shown below.

You can view Block Window Average Values or Rolling Window Average Values by 

clicking the radio button next to either option (this option is not available for the 

Nexus® 1450 meter).

This is a similar feature to a frozen register in that it provides the ability to capture a 

previous window of data. In this manner, the data can be polled and collected without 

risk that the data will be erased.
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5.3.11: Poll Previous Scaled Energy Block

To view the previous Scaled Energy Block Readings for the currently connected 

Nexus® meter, select Previous Scaled Energy Block from the Real-Time Poll>Reve-

nue, Energy, and Demand Readings menu. You will see the screen shown below.

This screen shows scaled compensated and uncompensated energy readings.
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5.3.12: Poll Mean, Block Max/Min for Interval 1
               and 2

To view the Means and Block Max/Min readings for Interval 1 and 2 for the currently 

connected Nexus® meter, select Mean, Block Max/Min for Interval 1 and 2 from the 

Real-Time Poll>Revenue, Energy, and Demand Readings menu. You will see the 

screen shown below. 

Use the scroll bar to view all of the data. The fields in this polling screen are as 

follows:

•   Mean Vpn is the arithmetic average of all 3 phase to neutral voltages (Van +Vbn + 

Vcn  / 3).
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•   Mean Ip is the arithmetic average of all 3 current phases (Ia +Ib + Ic  / 3).

•   Mean Vpp is the arithmetic average of all 3 phase to phase voltages (Vab +Vbc + 

Vca  / 3).

•   The 10 min Mean THD TS is the date and time of each 10 min intervals.

•   The 10 min Mean THD Va,Vb,Vc,Ia,Ib,Ic, I the arithmetic average of each THD 

value within 10 minutes, sampled each second (e.g., THD Va at 1 second + THD Va 

2 seconds….+THD Va at 600 seconds / 600 seconds).

•   This polling screen was developed to meet a specific customer need. The concept 

of INTERVAL 1 and INTERVAL 2 because the application necessitated that some val-

ues be averaged within 10 minutes (e.g., THD,V, and I) and some other values be 

averaged within 5 minutes (e.g., Energy). INTERVAL 1 is equal to 10 minutes and 

INTERVAL 2 is equal to 5 minutes.

•   Block Max / Min TS is the date and time of each interval.

•   Block Max interval 1 mean Vpn/Ip/Vpp/+VAR/-VAR/+W/-W is the value of the 

sample with the highest value, of the 600 samples within 10 minutes.

•   Block Max interval 2 mean Vpn/Ip/Vpp/+VAR/-VAR/+W/-W is the value of the 

sample with the highest value, of the 300 samples within 5 minutes.

•   Block Min interval 1 mean Vpn/Ip/Vpp/+VAR/-VAR/+W/-W is the value of the 

sample with the lowest value, of the 600 samples within 10 minutes.

•   Block Min interval 2 mean Vpn/Ip/Vpp/+VAR/-VAR/+W/-W is the value of the 

sample with the lowest value of the 300 samples within 5 minutes.
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5.3.13: Poll Pulse Aggregators (Shark® 250/270 Meter)

To view the values for the meter’s aggregators values for the meter’s, select Poll Pulse 

Aggregators from the Real-Time Poll>Revenue, Energy, and Demand Readings menu. 

You will see the screen shown below. 

Select the aggregator you want to view from the pull-down menu at the top of the 

screen. 

•  The screen shows any inputs and Energy source used to create the aggregator.

•  A plus sign next to the value means the input/energy value is added to the aggre-

gator; a minus sign means it is subtracted from the aggregator.

•  The aggregator value is shown in the total field.
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5.4: Power Quality and Alarms

The menu above is an example from a Nexus® 1500+ meter - the menu for your 

meter may look a bit different. For example, if you have a Nexus® 1500+ meter with 

a digital input option card, you will see “Poll Digital Input Option cards” after Poll 

Internal Inputs.
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5.4.1: Poll Phasors

The Phasors screen displays the phase relationships of the voltages and the currents 

of the currently connected device. The Frequency, Configuration, and Form (Nexus® 

1262/1272 meter, only) are shown at the top of the screen.

NOTE: See Section E.1 for information on using the Phasors screen to diagnose 

wiring errors.

Select Phasors from the Real-Time Poll>Power Quality and Alarms menu, or click the 

Phasors icon in the Icon Bar. You will see the screen shown below if you are connected 

to a Nexus® 1500/1500+ meter.
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If you have an auxiliary voltage reading (i.e., generator and bus where the VAux is 

the generator), the Aux box and the VAux Phasor are displayed. The VAux Phasor is 

referenced to VA phase.

For the MP200 metering system, depending on your circuit configuration, you’ll see 

one of the following screens. 

Click on the tabs to see the phasor display for each of the 8 meters.

MP200-Y Metering System
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From the pull-down menu, select which of the 24 meters you want to see the phasor 

display for.

The Phasor screen is a graphical representation of the voltage and current phase 

angles. Phase angles are the difference in phase between the voltage and current in 

an AC electrical system. In addition to the Phasor graphic, there are fields on the 

screen that give the phase angles and phase values for phases A,B,C of current and 

voltage and VAUX, if applicable

                   MP200-S Metering System
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To adjust the Phasor display:

1. Click Options at the bottom of the screen. You will see one of the screens shown 

below, depending on which EIG device you are connected to.

2. Click the checkbox next to Display Voltage Phase To Phase Readings When In Wye 

Configuration, if you want to include that reading in the graph. This option is only 

available for Nexus® meters.

3. In the Display Angles Increasing and Phasor Rotation boxes, select either Clockwise 

or Counter Clockwise for the display.

4. For a Nexus® meter, from the When Device is Configured for Delta pull-down 

menu, select 2 or 3 voltage phasors to display.

5. From the pull-down menu next to Display, select Vectors, Triangles, or Vectors and 

Triangles to change the graphic representation of the data.
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6. To change the phasor diagram colors, click the Set Phasor Diagram Colors button. 

Depending on the meter you are connected to, you will see one of the following 

screens.

•   To change a color for an element, click in the color field to the right of it. A small 

screen opens that lets you choose colors. Click on the color you want and click 

OK.

•   To return to the original color scheme, click Load Default.

7. Click OK to close the Color Settings screen. 

8. Click OK to close the Options screen and return to the phasor display. 
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5.4.2: Poll Harmonics

Many of the EIG meters have the ability to calculate the harmonic components of the 

electrical waveforms. These screens allow a user to conduct a harmonic analysis and 

view the amount of higher level harmonics on a line.

If Harmonic magnitude measurement is available for the connected meter, select 

Harmonics from the Real-Time Poll>Power Quality and Alarms menu. You will see the 

screen shown below.

NOTE: You will only see the KFactor field when you are viewing Harmonic Magnitudes 

for Current.
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You will see the previous screen if you are connected to a Nexus® meter.

You will see the screen above if you are connected to a Shark® 200/250/270/ST40 

meter.

•   To change the presentation format, click on the Values, Spectrum or Waveform 

buttons. The two previous screens are in Values mode. The Spectrum Mode and 

Waveform Mode screens are shown on the next page.

•   The Waveform button works like a real time oscilloscope. It allows a user to view 

what the waveform would look like for the given harmonics. This is available for 

each voltage and current channel. 
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                             Real Time Waveform View

                        Harmonic Spectrum Analysis
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•   To change the channel, use the pull-down menu beneath the Spectrum radio 

button to select from Volts A, B, C or Current (I) A, B, C.

•   Use the scroll bar to view all of the data. 

5.4.3: Flicker

Flicker is a measurement of visible change of brightness of a lamp due to rapid fluctu-

ations of voltage. If Flicker is beyond a reasonable point, it can cause detrimental 

effects to people. For this reason, our meters have the capability to measure Flicker.

To view Flicker data for the currently connected Nexus® meter, select Flicker from the 

Real-Time Poll>Power Quality and Alarms menu. You will see the screen shown below.

•   To view Short Term or Long Term Flicker data, click on the tabs at the top of the 

screen. You will see the screens shown on the next page.
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•   Flicker is generally calculated in EIG meters using the IEC 61000-4-15 and IEC 

61000-4-30 Class A standards.
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•   Use the Flicker Monitoring buttons to Start or Stop Flicker monitoring or to Reset 

the meter's Flicker monitoring.

    NOTES: 

•   If you are connected to a Nexus® 1450/1500/1500+ meter, you will only see 

the Reset button.

•   If level 2 password protection has been enabled for Flicker Start/Stop and Reset, 

and you have not signed on with the level 2 password, you will not see any 

buttons in the Flicker Monitoring section.
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5.4.4: Poll Voltage and Current Unbalance

Unbalanced circuits are caused by many factors. A common factor is non-linear 

switching loads, which produce large amounts of 3rd order harmonics that add up in 

neutral wires.

To view data concerning unbalance for the currently connected Nexus® meter, select 

Voltage and Current Unbalance (Nexus® 1450/1500/1500+) or Voltage Unbalance 

(other Nexus® meters) from the Real-Time Poll>Power Quality and Alarms Menu. (For 

the Shark® 200 meter, select Symmetrical Components from the menu. See the fol-

lowing section.) You will see the following screen.

NOTES: 

•   The screen is for a Nexus® 1450 or 1500/1500+ meter. There are two tabs which 

let you view either Voltage or Current unbalance. For the other Nexus® meters, 

you can only view Voltage unbalance.

•   The EN50160/IEC61000-4-30 standards are applied to the voltage.
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•   In addition to the Positive, Negative, and Zero Symmetrical Components, there is a 

field called 10 Min Neg Ratio, which is the Negative Sequence reading divided by 

the Positive Sequence reading.

•   For the Nexus® 1450 or 1500/1500+ meter, click the Current tab to view Current 

unbalance data.
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5.4.5: Poll Symmetrical Components

Symmetrical components are used to analyze unbalanced three phase power 

systems. To view Symmetrical Components data for the currently connected device, 

select Symmetrical Components from the Real-Time Poll>Power Quality and Alarms 

Menu. You will see the screen shown below if you are connected to a Nexus® meter.

•   You can view the symmetrical components for Voltage or Current by clicking the 

radio button next to either option.
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•   If you are connected to a Shark® 200/250/270/ST40 meter, you will see a slightly 

different screen, which also displays Current unbalance and zero sequence and 

negative sequence Voltage unbalance. See the screen below.

•   The drop-down menus allow you to select Scaling and the direction of the dis-

played angles.
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5.4.6: Poll IEC Harmonics and Interharmonics (Nexus® 1450 and
              1500+Meters)

To view harmonic and interharmonic IEC 61000-4-30 data for the Nexus® 1450 and 

1500+ meters, select IEC Harmonics and Interharmonics from the Real-Time 

Poll>Power Quality and Alarms menu. You will see the screen shown below.

•  This screen has two tabs. The first, shown above, shows the values for Mains 

Signaling and the Harmonic and Interharmonic groups and subgroups depending 

on the search criteria you enter:

•  Update Rate - choose from the pull-down menu:
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• 10/12 cycles

• 150/180 cycles

• 10 minutes

• 2 hours

•  Channel - choose from the pull-down menu:

• Volts AN, BN, CN, or Aux

• Amps IA, IB, IC, or IN
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•  Click Graph to see the data in graphic format. See the example screen below.
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5.4.7: Poll Alarm/Limits Status

To view Alarm (Limits) Status data for the currently connected device, select Alarm 

Status (Nexus® meters) or Limits (Shark® meters and the MP200TM metering sys-

tem) from the Real-Time Poll>Power Quality and Alarms menu. You will see the screen 

shown below.

•   This screen displays the status of the Limits set in the connected meter's Device 

Profile. Refer to the Limits programming section for your meter type:

• Section 8.3.1 for the Shark® 200/200S meter
• Section 9.1.5 for the Shark® 100/100S meter with V4
• Section 10.3.1 for the MP200TM metering system
• Section 11.3.1 for the Nexus® 1500/1500+ meter
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• Section 12.3.1 for the Nexus® 1262/1272 meter
• Section 13.3.1 for the Nexus® 1252 meter 
• Section 26.3.1 for the Shark® 270 meter
• Section 27.3.1 for the Nexus® 1450 meter
• Section 28.3.1 or the Shark® 250 meter
• Section 30.3.1 for the ST40 meter

•   The Item field lists the readings that were programmed with limits in the Limits 

setting screen; e.g. from the screen above, High Speed Volts AN.

•   The Value field lists the current reading of the item; e.g. from the example 

screen, 120.44.

•   The Status field lists:

• Status for Limits 1 and 2: “In” means that the current reading is within 

the limit range; “Out” means that the current reading is out-of-limits.

• Settings and Setpoint for Limits 1 and 2: “Above” or “Below” the setpoint 

reading, also directly from the Limits that were programmed.

• Combination Type and Status: taken from the Limits setting, the pro-

grammed combination field; e.g., OR and the Status “Out” for the first 

reading in the example screen. A combination type of OR means that if 

either Limit 1 or Limit 2 is out-of-limit based on the current value of the 

reading, the combined Status is OUT. If the combination type is AND, 

unless both Limit 1 and Limit 2 are out-of-limit based on the current 

value of the reading, the combination status in “In.” Refer to the pro-

gramming section for your meter type, given above, for the possible com-

bination settings.

•   The screen above is for a Nexus® meter, which has up to 32 limits. If you are 

connected to a different meter, you may see a smaller number of limits and differ-

ent fields. Consult the chapter for your meter to see details about its Limits capabil-

ities.

•   Use the scroll bar to view all of the data.

•   You can adjust the column width. To do so:

1. Position the cursor on a line between columns at the top of the screen. 
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2. When the cursor changes to a left/right arrow, hold down the left mouse but-

ton and drag the column border left or right. 

3. Release the button when the column is at the desired width.

5.4.8: Poll Nexus® ElectrologicTM Status

Nexus® meters allow users to set limits and trigger outputs under many desired 

conditions. These outputs can have logic associated with them that work to provide 

intelligence in the triggering designs. 

To view the status of Relay control for the currently connected Nexus® meter, select 

Nexus ElectroLogicTM Status from the Real-Time Poll>Power Quality and Alarms menu. 

You will see the screen shown below.

•   This screen shows the status of the relay control scheme that was set up through 

ElectroLogicTM Relay Control. See sections 11.3.2 (Nexus® 1500/1500+ meter), 

12.3.2 (Nexus® 1262/1272 meter), 13.3.2 (Nexus® 1252 meter), and 27.3.2 

(Nexus® 1450 meter) for detailed instructions for setting up ElectroLogicTM Relay 

Control.

1 2 3

4 5
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•   Click the drop-down menu to choose the Relay you want to view information for.

•   The fields shown are in the screen are:

1. Assigned Limit or Digital Input 

2. Open (0) or Closed/Shorted (1) state of the Input or within Limit (0) or out-of-

limit (1) condition for the Limit

3. Logic Gate, in this instance for the first two Limits/Digital Inputs: this deter-

mines how the logic tree handles the 0 or 1 result of the Limit/Digital Input; 

e.g., if the gate is AND, the results must both be 1 for the result of the logic 

gate to be 1; if the gate is OR, either result of 1 will make the logic gate result 

become 1. Refer to the section for your meter for all of the gate options.

4. The delay in seconds, programmed in the ElectroLogicTM Relay Logic setting 

screen.

5. The result of the entire logic tree - 0 or 1 - which will ultimately control the 

relay; depending on whether the relay is normally open, or normally closed/

shorted. 0 will leave the relay as is, and 1 will impose the opposite condition.

5.4.9: Poll Internal Digital Inputs

To view data for the internal High Speed inputs of the currently connected Nexus® 

meter or MP200TM Metering System, select Poll Internal Inputs from the Real-Time 

Poll>Power Quality and Alarms Menu. 
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You will see the screen shown on the left for Nexus® meters and the screen shown on 

the right for the MP200TM metering system. .

See the programming section for your meter type for details on the internal Digital 

Inputs: 10.5.2: Configuring Digital Input Settings, on page 10-3511.3.8: High Speed 

Inputs, on page 11-100 (Nexus® 1500/1500+ meter), 12.3.6: High Speed Inputs, on 

page 12-88 (Nexus® 1262/1272 meter), 13.3.7: High Speed Inputs, on page 13-67 

(Nexus® 1252 meter), or 27.3.6: Digital Inputs, on page 27-70 (Nexus® 1450 

meter).

5.4.10: Poll External Digital Inputs

To see the status of the external digital inputs for the connected Nexus® meter, the 

Option card digital inputs for Shark® 200 meter, or the embedded digital inputs for 

the MP200TM metering system, select Poll External Digital Inputs from the Real-Time 
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Poll>Poll Power Quality and Alarms menu. You will see the screen shown below if you 

are connected to a Nexus® meter.

•   This screen allows you to view State and Transition Counters data for the external 

digital inputs. These settings are programmed in the External Digital Inputs 

setting of the meter’s Device Profile; see the programming section for your meter 

type for details: 11.5.1: Configuring the Input/Output Modules, on page 11-113 

(Nexus® 1500/1500+ meter), 12.5.1: Configuring the Input/Output Modules, on 

page 12-98 (Nexus® 1262/1272 meter), 13.5.1: Configuring the Input/Output 

Modules, on page 13-77 (Nexus® 1252 meter), or 27.5.1: Configuring the Input/

Output Modules, on page 27-80 (Nexus 1450 meter).

•   To reset the counters, select the counters you want to reset from the pull-down 

menu and click Reset.

•   Use the scroll bars to view all of the data on the screen.
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If you are connected to a Shark® 2xx meter or an MP200TM metering system, you will 

the screens shown below. the screen on the left is for a Shark® 2xx meter, and the 

screen on the right is for an MP200TM metering system. 

This screens display the status (Open or Closed) of the Digital Inputs of:

•   Any Relay Output/Digital Input or Pulse Output/Digital Input Option card installed 

in a Shark® 2xx meter.

•   The Digital Inputs of the MP200TM metering system’s embedded Relay Output/Dig-

ital Input card.

These settings are programmed in the Digital Inputs setting of the meter’s Device 

Profile; see the programming section for your meter type for details: 8.5.3: Configur-

ing a Pulse Output/Digital Input Card, on page 8-46 and 8.5.3: Configuring a Pulse 

Output/Digital Input Card, on page 8-46 (Shark® 200 meter); 10.5.2: Configuring 

Digital Input Settings, on page 10-35 (MP200TM metering system); 28.5.2: Configur-

ing a Relay Output/Digital Input Card, on page 28-75 and 28.5.3: Configuring a Pulse 

Output/Digital Input Card, on page 28-81 (Shark® 250 meter); or 26.5.3: Configur-

ing a Digital Relay Card (RO1S), on page 26-98 and 26.5.4: Configuring a Digital 

Input/Pulse Output Card (PO1S), on page 26-108 (Shark® 270 meter).
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5.4.11: EN50160/IEC61000-4-30 Dynamic

The Nexus® 1500+ meter with Firmware V20 and above and the Nexus® 1450 meter 

have a polling screen with real time readings for its EN 50160 IEC 61000-4-30 fea-

ture. From the Real Time Poll menu, click EN 50160 / IEC 61000-4-30 Dynamic Read-

ings. The screen from the Nexus® 1500+ meter is shown below. 

•  Select the update rate you want to use from the pull-down menu.

•  The reading description and value are shown. Use the scroll bar to see additional 

readings.

The EN 50160 / IEC 61000-4-30 Dynamic Readings polling screen for the Nexus® 

1450 meter is shown on the next page. Note that it doesn’t have an update rate 

selection.
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5.4.12: 3 Second Updated Harmonics

The Nexus® 1450 meter has an additional Power Quality and Alarms polling screen 

which shows the three second updated harmonics for the meter. Click Power Quality 

and Alarms>3 Second Updated Harmonics to see the screen shown below.
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5.5: RTU Polling (Nexus® 1450/1500/1500+
          Meter)

The Nexus® 1450/1500/1500+ meter has the ability to function as an RTU. As such, 

it can poll Modbus readings from slave devices and take those readings into its mem-

ory for users to conduct actions with them. For the meter to act as an RTU, Port 2 

must be set as an RTU Master (see 11.5.2: RTU Settings, on page 11-119 [1500/

1500+] or 27.5.2: RTU Settings, on page 27-86 [1450] for instructions). 

The RTU Polling screen helps the user verify that their application is working correctly, 

by checking that the information they see on this screen is as expected/needed. 

Select RTU Polling Screen from the Real Time Poll menu. You will see the screen 

shown below.

The information shown on the screen is as follows:

•   Description of the reading

•   Nexus® 1500/1500+ meter’s Modbus starting register of the reading

•   The slave device’s Modbus starting register of the reading

•   The raw value of the reading in hexadecimal
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•   The translated value of the reading for the user’s application

•   The number of decimal places desired to set the degree of resolution needed

•   The format the data is needed in; dependent on whether this is for a SCADA or 

customized application

•   The Date and Time stamp of the data shown

•   Click Show Details to see more information: Device address; Starting register and 

number of registers; Data type, size in bytes, byte order; any Multipliers to scale 

the data; Group ID; Error code; and Data Valid field - either True (a connection was 

made and data was obtained) or False (no connection was made; no data was 

received). See the screen below.

•   Click Reset Error Counters if you had errors that you have now addressed.
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5.6: Poll Real Time Trends (Shark® 50/100/
          200Meters)

The Shark® 50/100/200 meters have an additional polling screen. Select Real Time 

Trends from the Real Time Poll menu. You will see the screen shown below.

     This screen lets you view trending for the selected parameters.

•   To view parameters on the graph:

1. Click the check box(es) next to the value(s) you want to display.  

2. The Poll Interval can be changed. Set this value to 0 to poll as quickly as 

possible. (When '0' has been entered, the field displays '****.')

3. To create a .csv (Comma Separated Value Excel file) containing a log of the 

polling values, enter a value greater than 0 in the AutoStore Interval field. The 

software will store in its directory all polling values (regardless of the selec-

tions on the screen) in the .csv file on the interval (in seconds) entered in the 

AutoStore Interval field. 
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NOTE: To perform manual storage, click the Store button at the bottom of the 

screen. 

4. Either: 

• Use the Min and Max Y Values fields to specify the Y Range for the graph.

• Check the Auto Scale box to let the software calculate the best Y Range 

values for the graph.

•   Click File Options to open the window shown below. 

• The field at the top shows where the file of this screen’s data will be 

stored. You can double-click in the field to open that directory. 

• The selections let you choose how you want the file to be named:

• Leave the default selection (first radio button) to save the file in the 

directory with the original file naming convention:

SHARK-Device Address-year, month, day-hour, minutes, seconds

NOTE: The original file naming convention should no longer be used 

since multiple Shark® meters on the same network will have the same 

device address and they could overwrite each other’s files.

• Click the second radio button to use the device’s serial number as a 

sub-folder in the directory, with the date and time as the file name:

Device Serial Number\year, month, day-hour, minutes, 2 seconds
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• Click OK to save your selections. When you click Store the file will be 

saved as you chose.

•   If your desktop is very small, the screen will be divided in half. Click View Graph to 

see the Graph portion of the screen; click View Settings to see the Settings portion 

of the screen.

•   Click Start to begin polling; click Stop to stop polling. 
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6: Meter Security

6.1: Overview

There are four aspects to the security offered by EIG meters through the Communica-

torPQA® software:

•   Password protection 

•   Sealing switch 

•   Security lock

•   Firmware signature

The Nexus® 12XX and 15XX meters (except for Nexus® 1500+ meters with firmware 

V20 and above) offer the first two features: see 6.2.1: Nexus® Meters’ Password 

Options, on page 6-2 through 6.10: View Sealing Switch Status (Nexus® Meters), on 

page 6-21. Nexus® 1500+ meters with firmware version 20 and above and V-

SwitchTM keys 4-6 offer all four features, with advanced security that includes role-

based user accounts and firmware encryption - see 6.13: Nexus® 1500+ Meter’s 

Advanced Security - Resilient Cyber SecurityTM and Firmware Integrity (Firmware V20 

and above with V4-V6), on page 6-50. The Shark® 250/270 meter offers password 

protection and a physical sealing switch on the meter; the Shark® 270 meter also has 

firmware authentication - see 6.11: Shark® 250/270 Meter’s Security, on page 6-21. 

The Nexus® 1450 meter offers all three features: see 6.12: Nexus® 1450 Meter’s 

Security Features, on page 6-33. Note that the other Shark® meters and the MP200TM 

metering system also offer password protection - see their individual programming 

chapters, 8-10, for instructions.

6.2: Password Overview

Meter password security is designed to protect the unit from unauthorized use. Since 

the meters are used for primary revenue and/or control functions, the password func-

tionality is designed to be very secure. Password feature usage is recommended if 

there are security concerns. Note that when using passwords, it is imperative that the 

password information is stored, to ensure access to the meter. It is also critical that 

passwords and usernames are stored in a secure location.
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The CommunicatorPQA® application’s password feature protects the following activi-

ties from unauthorized use:

•   Changes to an EIG Meter’s Device profile

•   Setting device date and time

•   Resetting Device information (Max/Min/Demand, Hour Counters, Logs and Time of 
Use (TOU))

•   Test Mode entry from software

•   Flash upgrades

•   Flicker start and stop

•   Pulse test

•   CT and PT Compensation

•   Relay control and I/O Utilities

•   TOU accumulations and changes to the TOU calendar settings

•   Retrieval of trending and Power Quality logs (for the Nexus® meters, with 
Extended Passwords only)

6.2.1: Nexus® Meters’ Password Options 

Depending on the meter model and firmware level, the Nexus® meters’ (other than 

the 1450 meter - see 6.12: Nexus® 1450 Meter’s Security Features, on page 6-33 

and the 1500+ meter with Firmware V20 and above - see 6.13: Nexus® 1500+ 

Meter’s Advanced Security - Resilient Cyber SecurityTM and Firmware Integrity (Firm-

ware V20 and above with V4-V6), on page 6-50) Password control consists of either 

Bi-level only or Bi-level and Extended password protection.  Each of these methods is 

explained below.

•   Bi-level passwords: 

•   Level 1 accesses Time-of-Use Accumulations only - these are Billing functions.

•   Level 2 accesses all password-protected functions. The Level 2 Password also 
allows a user to enable or disable the password function.

     NOTES: 

•   When the password feature is enabled, the CommunicatorPQA® software asks 

for the appropriate password each time a user attempts to perform a protected 

operation.
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•   The Bi-level password feature is on a two-minute timer: after exiting from a 

password-protected area, the user has two minutes to access another protected 

area without re-entering the password. If more than two-minutes elapse, the 

software asks for the appropriate password. 

•   Extended passwords:

•   This feature allows you to set up to eight different profiles controlled by pass-

words. This allows you to set up specific password profiles so that users can 

have limited access to certain meter features. Once you have enabled the Level 

2 password, you can then configure the Extended passwords for the meter. 

•   Specify which features are allowed or disallowed for each of the eight profiles, 

choosing from the following functions (as long as they are supported by the 

meter):

• Read TOU Calendars/Data – allows the user to view the time of Use 
Calendars and Registers.

• External Device Access – allows the user to access and program external 
devices.

• Modify Preset Energy – allows the user to access the preset energy capa-
bility.

• Modify CT/PT Compensation – allows the user to change the CT/PT 
compensation tables.

• Modify Date/Time – allows the user to set a new date and or time.

• Modify TOU Calendars – allows the user to modify existing calendars and 
upload new calendars.

• Update Firmware – allows the user to change the existing firmware in the 
meter.

• Modify Programmable Settings – allows the user to change existing 
programmable settings and program them to the meter.

• Retrieve PQ Logs – allows the user to retrieve the Power Quality logs: PQ, 
Waveform, Alarm, and Flicker.

• Retrieve Historical Logs – allows the user to retrieve non-PQ logs: Histor-
ical and Digital.

• Reset Demand – allows the user to reset the Demand Registers.
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• Reset PQ Logs – allows the user to reset the Power Quality logs: PQ, 
Waveform, Alarm, and Flicker.

• Reset Logs – allows the user to reset the non-PQ logs: Historical and 
Digital.

• Reset Energy – allows the user to reset the Energy Accumulators.

• External Relay Control – allows the user to manually fire the External 
Relays.

• Manual Waveform Capture – allows the user to send the Manual Wave-
form Capture command, if supported by the meter.

• Other – allows the user to use the Flicker function and any other Level 2 
function that is not defined above.

6.3: Enable Passwords (Nexus® Meters) 

1. From the Main screen’s Menu Bar, select Tools>Passwords>Enable/Disable.

NOTE: Passwords may contain up to 10 characters and may include the digits 0–9 

and/or the letters A–Z. Passwords are not case-sensitive.

2. Enter the following:

•   Password for Level 1 in Level 1 Password and Retype entry fields. The Level 1 

password allows viewing of Time of Use (TOU) data.

•   Password for Level 2 in Level 2 Password and Retype Entry fields. The Level 2 

password restricts user access to all password protected functions listed in 

Section 6.2. Only by logging in with the Level 2 password can you disable the 

bi-level password feature.
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   NOTE: You must enter both passwords. If you enter and retype only a Level 1 

   Password or a Level 2 Password and click OK, you will see an error message.

3. Click OK. You will see the message shown below.

4. Click Yes . The Bi-level Password function is now enabled. The computer status bar 

at the bottom of the screen now displays “Password: Enabled” and the following 

message screen is displayed (click OK to close the screen).

   NOTE: You can also check Password Status from the Tools menu: 

   click Tools>Passwords>Status to display the Protection Status screen shown above.

5. Now that you have enabled the Level 2 Password, click Tools>Passwords>Extended 

Passwords to configure the Extended passwords for a meter that supports 

Extended passwords. 
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NOTE: Only a user signed on with a Level 2 Password will be able to access this 

function.

6. Click Yes. You will see the following screen.

7. Enter the Level 2 password; (i.e., the administrator password) and click OK.

NOTE: For the Nexus® 1500+ meter, you can use either Admin or Administrator in 

the CommunicatorPQA® software, but if you are using FTP, a third-party software, 

or Modbus communication, you must use Admin as the username.
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8. The top portion of the screen lets you enable or disable the Extended password 

function: select the Enabled button to enable it.

9. Select the password profile you want to set up from the pull-down menu next to 

User Level. You can set up to eight additional profiles (the first profile is the Level 2 

administrator password you already set up): each profile can have a different selec-

tion of features and capabilities.
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10. In the security section enter the Username and password for this profile. Re-enter

 the password.

NOTE: Username is only displayed and used for the Nexus® 1500/1500+ meter.

11. Click any of the features in the Features and Capabilities section of the screen to

  enable them for the profile.

• Click Check All to select all of the features.

• Click Uncheck All to de-select all of the features.

    NOTE: The administrator user level (Level 2 password) is non-configurable. It has

    all of the features enabled for it. It is the only profile that can set up the other 

    profile levels.
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12. Click:

•   Update to save your changes

•   Cancel to exit the screen without saving any changes.

•   Report to create a .csv file listing the password profiles and their enabled 

features (passwords are not printed in the report). You can open the report in a 

spreadsheet application.

NOTES: 

•   When the Extended passwords

feature has been enabled for a 

Nexus®1500/15000+ meter, in order 

to retrieve logs over the Network you 

must use Connection Manager to 

connect to the meter with your User-

name and password. See the screen 

on the right. Refer to Chapter 3 for 

instructions on using Connection 

Manager.

•   You must also enter the Username and 

password to update firmware, for a 

Nexus® 1500/1500+ meter using 

Extended passwords.

Enter Username 
and Password
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6.4: Change Passwords (Nexus® Meters)

If you are going to use Passwords, it is a good idea to change them from time to time. 

•   If you have set up Extended password protection, you can use a Level 2/Adminis-

trator password profile to change the password profiles by opening the Extended 

Passwords setting screen; selecting the profile you want to change; and following 

the instructions already given for adding a new profile (steps 9-12 in the previous 

section). When you click Update you will be asked to confirm that you want to 

update the profile and then prompted to enter your Level 2/Administrator pass-

word.

•   If you want to change the Level 1 password, click Tools>Passwords>Change, enter 

the current password you want to change (either Level 1 or Level 2) and the new 

password. You are asked to confirm that you want to change the password and 

then are told the password has been changed.

6.5: Disable Passwords (Nexus® Meters)

NOTE: You must use the Level 2 Password to disable password protection.

1. If you have enabled the Extended password feature, you need to first disable it. 

Click Tools>Passwords>Enable/Disabled. The Extended Passwords screen opens - 

click the Disable button and click Update. You will see the following message.
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2. Click Yes. You will be prompted to enter your Level 2 password.

3. Click OK. You will see the message shown below.

4. Click Yes. The Log On screen (above) will show a message that the profile is being 

updated and then you will see the following screen. Click OK to close it.
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5. Disable the Bi-level password feature, click Tools>Passwords>Enable/Disable. You 

will now see the screen shown below. 

6. Enter the Level 2 Password and click OK. You will see the message shown below.

Note that for some meters the sealing switch status is not displayed in the message 

window.

7. Click OK. The Bi-level Password function is now disabled. The status bar at the 

bottom of your screen now displays: “Password: Disabled”.
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6.6: Log On and Off with Passwords(Nexus® Meters)

You can log on with a specific password, or log off from a specific password.

6.6.1: Log On/Off with Extended Passwords

When the Extended Passwords feature has been enabled for a meter, you will be 

prompted to log on with a password when you connect to the meter. See the screen 

shown below, from a Nexus® 1500/1500+ meter. 

1. Enter the Username and password for the profile for which you want to log on.

NOTE: For the other Nexus® meters, you will enter the user level and password, 

since they do not have the Username field.

2. Click OK. You will have access to the functions enabled by this password profile.

NOTES:

•   Click Cancel to exit the Log On screen without logging on. You will be connected 

to the meter, but at the lowest access level.

•   After three failed attempts to log on, the Log On window disappears and you are 

connected at the lowest access level.
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3. To log off, click Tools>Passwords>Log Off. You will a confirmation screen - click Yes 

to log off or click No to stay logged on.

4. If you click Yes, you will see the message shown below. Click OK to close the 

message window.

6.6.2: Log On/Off with Bi-level Passwords

NOTE: You will only be able to log on/off the Bi-level password if the Extended pass-

word feature is not enabled.

1. To log on, select Tools>Passwords>Log On.

2. Enter a Level 1 or 2 Password and click OK.

3. To log off, select Tools>Passwords>Log Off. You will see the following message.

4. Click OK. 
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6.7: View Protection Status (Nexus® Meters)

Click Tools>Passwords>Status. The screen you see depends on the protection status 

that is active. It displays the currently logged in profile, the security status of the 

meter, and the profile’s access permissions.

You will see the following screen if the Extended password protection is enabled. 

This is an example of the screen you would see if the Admin password is logged on.

You will see the following screen if only Bi-level password protection is enabled.
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6.8: Sealing Switch Overview (Nexus® Meters)

The Sealing Switch lets you set additional restriction to functions of the meter. The 

Sealing Switch acts as a physical barrier, requiring a button to be pressed to allow a 

user to enter a password and configure the meter. This is an added level of security, 

since the button is located under an area that can be secured with a physical seal, 

which would indicate tampering if removed. The Sealing Switch is enabled through the 

Tools menu. Once enabled, the switch must be activated at the meter. You activate 

the switch by breaking the physical seal and then:

•   Pressing and holding the button (Nexus® 1252/1500/1500+ meter) 

•   Pressing both the Reset Switch and Test Button at the same time (Nexus® 1262/

1272 meter)

You will then be able to perform the restricted function. The restricted functions are as 

follows:

•   Nexus® 1252/1262/1272 meters:

•   Reset Logs, Max/Min, Energy, TOU, and related features

•   Enable/Disable Passwords

•   Nexus® 1500/1500+ meter:

•   Reset Logs, Energy, TOU, Flicker, and related features

•   Modify TOU Calendars

•   Modify Programmable Settings

•   Calibrate DSP1

•   Calibrate DPS2 Waveform Capture

•   Modify Level 1 Password

•   Modify Level 2 Password

•   Enable/Disable Passwords 
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NOTES:

•   For the Nexus® 1500/1500+ meter, you must break the seal and open the reve-

nue lock on the bottom of the meter, and then press the Sealing Switch button 

located behind the revenue lock door. You have 30 minutes in which to perform the 

function once the sealing switch is enabled. You can press the button again to 

extend the time another 30 minutes.

•   For the Nexus® 1262/1272 meter, you must remove the front cover to access the 

Test button. Once you have pressed the two buttons for a few seconds, a message 

appears on the display telling you that the Sealing Switch is enabled. You have 30 

minutes to implement changes. If you want to re-set the Sealing Switch before the 

30 minutes is up, press the two buttons again.

•   For the Nexus® 1252 meter, you must hold down the button while performing the 

restricted functions.



     Doc#    E107707                                              6 - 18

                         6: Meter Security 

•   Refer to the diagrams below for hardware location.

Figure 6.1: Location of Sealing Switch Buttons

Nexus® 1262/1272 Meter Without Cover

   Nexus® 1500/1500+ Meter

1. Break Seal
    and Open
    Revenue Lock
2. Press 
    Button Inside

1. Break Seal and
    Open Cover
2. Press Test Button
    and Reset Switch 
    at Same Time
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6.8.1: Enable Sealing Switch

1. From the Tools Menu, select Sealing Switch>Enable/Disable. You will see the 

Enable Sealing Switch confirmation screen. 

2. Click Yes to enable the Sealing Switch.

3. The Protection Status screen appears, showing Password and Sealing Switch 

status. Click OK.

4. The status bar at the bottom of your screen now displays: “Sealing Switch: 

Enabled”. 

NOTE: The screen you see depends on the current status of the Sealing Switch. If the 

Switch is already enabled, you will see the screen shown in Section 6.9: in that case, 

click No to keep the Sealing Switch enabled.
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6.9: Disable Sealing Switch (Nexus® Meters)

1. From the Tools Menu, select Sealing Switch>Enable/Disable. You will see the 

Disable Sealing Switch confirmation screen. 

2. Click Yes to Disable the Sealing Switch, at the same time pressing the Sealing 

Switch button on the Nexus® 1500/1500+ meter.

3. The Protection Status screen appears, showing Password and Sealing Switch 

status. Click OK.

4. The status bar at the bottom of your screen now displays: “Sealing Switch: 

Disabled”.

NOTE: The screen you see depends on the current status of the Sealing Switch. If the 

Switch is already disabled, you will see the screen shown in Section 6.8: in that case, 

click No to keep the Sealing Switch disabled.
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6.10: View Sealing Switch Status (Nexus® Meters)

The Status Bar at the bottom of your screen displays Sealing Switch status. You can 

also view the status in the following way:

1. From the Tools Menu, select Sealing Switch>Status.

2. You will see the Protection Status screen (example screen shown below), telling 

you if the Sealing Switch is enabled or disabled.

3. Click OK to close the Protection Status screen.

6.11: Shark® 250/270 Meter’s Security

The Shark® 250/270 meter has enhanced security features to protect the meter’s 

data.

•  The meter’s password protection offers one Admin level password that has access 

to all meter functions, and up to 8 user passwords that can be customized for their 

access to meter features; for example, resetting logs or accumulators or reading 

TOU data. Both the username and password are encrypted when they are sent to 

the meter, to further enhance security. In addition, there is a lockout period of five 

seconds after an unsuccessful password entry, to prevent brute force hacking. 

•  Note that if a Shark® 250/270 meter is password protected, you won’t be able to 

log onto the meter unless you enter a correct password.

•  The Gen 2 Shark® 270 meter has firmware authentication.

•  The Shark® 270 meter with Firmware Version 5 and above offers a Sealing Switch. 

The Sealing Switch provides additional security for the meter, by requiring someone 

to perform an action at the meter itself before restricted functions can be per-

formed. The Sealing Switch is locked and unlocked using the Reset and Test but-
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tons on the front of the meter. Note that any change to the Sealing Switch state 

(enabled/disabled/locked/unlocked) is recorded in the System Events log. 

•  The Sealing Switch is enabled or disabled through CommunicatorPQA® software 

- see 6.11.4: Enabling/Disabling the Sealing Switch (Shark® 270 Meter), on 

page 6-31, for instructions. When the meter’s Sealing Switch is enabled, the 

Reset and Test buttons are used to lock and unlock the Sealing Switch:

• If the Sealing Switch is locked, press and hold the Reset and Test buttons 

for between two and five seconds. A message on the display will tell you 

the Sealing Switch is unlocked - release the buttons when the message 

appears.

• If the Sealing Switch is unlocked and you want to re-lock it, press and 

hold the Reset and Test buttons for between two and five seconds. A mes-

sage on the display will tell you the Sealing Switch is locked - release the 

buttons when the message appears.

NOTE: Don’t hold the buttons for less than two seconds or more than five 

seconds. 

•  Once the Sealing Switch is unlocked, the user has 30 minutes to perform the 

function. After the 30 minute timeout period, the Sealing Switch is automatically 

locked, again.

• As mentioned above, if you want to lock the Sealing Switch before the 30 

minutes is up, press the Reset and Test buttons for the required, time to 

lock it.

• If more time is needed, the Reset and Test buttons can be pressed for the 

required time once to lock the Sealing Switch, and then pressed for the 

required time to unlock the Sealing Switch for another 30 minutes. Note 

that if a file action, e.g., firmware update, is being performed, the Sealing 

Switch will remain unlocked until the action is completed, even if it takes 

over 30 minutes. 

•  When the Sealing Switch is enabled, the following actions are blocked until the 

Sealing Switch is unlocked:

• Reset logs
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• Reset Max/Min (demand)

• Reset energy (accumulators)

• Reset TOU (All)

• Enable/disable security (you can still create and modify users and assign 
privileges with Firmware version 0009 and above)

• Modify TOU calendars

• Modify programmable settings (except for the Com 2 port and communi-
cation option cards (4GLTE, RS1S, INP100S) settings which can be modi-
fied with Firmware version 0009 and above)

• Disable the Sealing Switch

• Modify DNP3 settings

• Reset Option card accumulators

• Reset Cumulative demands

• Manual change of meter’s clock time for firmware versions below 0009 
(the time may be manually changed with Firmware version 0009 and 
above - see 20.1.4: Set Device Time, on page 20-5)

• Edit LCD settings

• Write files to the unit

• Soft reset

• Enter Test Mode

• Preset energy

• Load new firmware

• Backup screen/firmware file

• Switch screen file (use a backup)

• Reset of energy or demand through DNP protocol

NOTE: If both password protection and the Sealing Switch are enabled, the user must 

be signed in though a password that allows the action to be performed and then the 

Reset and Test buttons must be pressed for the required time to unlock the Sealing 

Switch.
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6.11.1: Enable and Configure Security

To enable the password feature for the meter, follow these instructions. 

1. From the Tools Menu, select Security>Enable. 

2. Click Yes. 

•  If password protection is enabled and 

you want to disable it, select 

Tools>Security>Disable and click Yes 

in the confirmation message window. 

NOTE: You need to be signed in with 

the Admin password in order to 

disable security.
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3. You will see the Security Editor screen with a window in front of it. This window 
prompts you to enter a password for the admin user, and to retype the password to 
confirm it. Once you have done so, click OK to continue. Note that you can click the 
Show Password box if you want the actual password to be displayed as it is 
entered, rather than shown as a series of asterisks.

NOTE: Admin is the only security user that cannot have a customized username. 
Admin is the highest level of security and is the only level that can create other 
users and change or disable security. It is important to keep the Admin password 
secure, since it enables all password protected functions. It is also recommended 
that you change the Admin password and other passwords from time to time.
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4. You will see messages while security settings are being loaded and then you will 

see the screen shown below.

NOTE: To access this screen again, click Tools>Security>Configure (Admin only).

 

•  The Users field on the left lists the Admin level (0) and User levels 1-8. 

•  The Security Status is enabled. If you are the Admin, you can disable security by 

selecting Disabled and then clicking Update. 

The screen is then redisplayed with Security Status Disabled and no fields being 

shown. Click X to close the screen.

•  The Admin settings are shown in the main part of the screen. 

• To change the Admin password, enter the new password and then con-

firm it.
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• The Auto Log Out timer is disabled by default. If you want to automati-

cally log out the Admin after a number of minutes, uncheck the Disable 

box and select the number of minutes for the auto log out timer.

• The Inactivity Timer is enabled by default and set to 300 seconds. This 

means that after 5 minutes without security activity the system will auto-

matically sign out the Admin. You can increase or decrease the number of 

seconds in the inactivity timer; or you can disable it completely by check-

ing the Disable box.

5. To set up a user:

a. Click on one of the usernames in the Users field.      
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b. You can change the user-

name.

c. Enter and confirm a 

password for the user. 

The password can be up 

to 30 alphanumeric 

characters. You can click 

the checkbox to display the password.

d. Select the functions this user is allowed to perform by clicking in the box next to 

the function. The functions include: resetting individual logs, retrieving individ-

ual logs, resetting max/min, resetting accumulators, restarting the meter, 

uploading firmware, etc. There is also a Select All checkbox, which when 

selected gives the user permission to perform all of the listed functions. Once 

this user is saved, the user is able to perform any allowed functions, e.g., reset-

ting the Alarm log; but if the user attempts to perform a function not allowed for 

them, e.g., changing the V-SwitchTM key, an error message window will be 

shown and they will not be allowed to perform that function.

(The example screen is from a Shark® 250 meter. The Shark® 270 meter lists 

additional functions.)

e. The Shark® 250 meter has 

an additional setting - Front 

Panel User. This setting is 

used to create security for 

the meter’s front panel functions. You can set up one Front Panel user and pass-

word. To do so, check the Font Panel box and enter a username and a four digit 

password. Note that you will only be able to enter four numbers for the pass-

word.

f. Click Update User to save your changes. 

g. Repeat steps a-f to create another user.

6. When you are done, click Close Editor.
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6.11.2: Log On

When password protection is enabled, a login window is presented whenever anyone 

tries to connect to the meter through software, and also when certain restricted func-

tions are attempted. 

Enter username and password and click Login.

•  If the username and password are allowed access to the function, e.g., connecting 

to a meter, you will be able to continue. You will see the window shown below.
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•  If the username and/or password are incorrect, there will be a message that login 

failed and a 5 second timer will start counting down until you can attempt login in 

again. 

You can also login when the CommunicatorPQA® application is connected to the 

meter, for example, if you previously logged out. To do that, click Tools>Pass-

words>Log On.
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6.11.3: View Password Status

Click Tools>Passwords>Status to see if password protection is enabled, and who is 

logged in. See the example screen below.

6.11.4: Enabling/Disabling the Sealing Switch 
(Shark® 270 Meter)

The Sealing Switch adds another layer of security to the meter. When enabled, it 

blocks access to restricted functions until the Reset and Test buttons on the meter are 

pressed and held for between two and five seconds. Section 6.11: Shark® 250/270 

Meter’s Security, on page 6-21 contains detailed information on the meter’s Sealing 

Switch. 

CAUTION! Once the Sealing Switch is enabled, it cannot be disabled unless the Reset 

and Test buttons are pressed on the meter and, if Password security is enabled, a user 

with appropriate permissions is signed on. 

To enable the Sealing Switch, follow these instructions: 

1. From the Tools Menu, select Sealing Switch>Enable/Disable.
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2. If you are sure you want to enable the Sealing Switch, click Yes. Once the Sealing 

Switch is enabled, the Reset and Test buttons on the meter must be pressed in 

order to perform restricted functions. See 6.11: Shark® 250/270 Meter’s Security, 

on page 6-21, for details.

3. To disable the Sealing Switch:

a. If Password security is enabled, log on with a password that allows you to disable 

the Sealing Switch.

b. Press (or have someone at the meter press) the Reset and Test buttons for 

between two and five seconds.

c. Within 30 minutes, click Tools>Sealing Switch>Enable/Disable and click Yes in 

the message window, to disable the Sealing Switch.
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6.12: Nexus® 1450 Meter’s Security Features

The Nexus® 1450 meter’s security features include a physical sealing switch, a phys-

ical sealing lock and a Security feature that provides password control of meter capa-

bilities as well as the physical sealing switch and lock.

The meter’s Security allows setup of up to 12 users:

•  The Admin user has access to all of the meter’s features. This user is the only one 

that can enable/disable security and create other users. The Admin user is also the 

only one who can Reset the System Events log.

•  The Legacy user provides backward compatible support. The Legacy user is equiva-

lent to a level 2 user in the older Nexus® meter security system (see the instruc-

tions for bi-level passwords in 6.3: Enable Passwords (Nexus® Meters), on page 6-

4). The Legacy user is not allowed to perform any web actions, except for retrieving 

historical logs 1 and 2 and the System Events log.

•  Ten configurable users.

In addition to setting up users, the meter’s Security allows setup of Roles, which are a 

collection of permissions that can be configured and then assigned to one or more of 

the ten configurable users.

Another important feature of the meter’s Security is that usernames and passwords 

are encrypted when sent to the meter, both at login time and configuration time. For 

information on the meter’s Web server security, see 21.1: Overview, on page 21-1.

The Nexus 1450® meter with firmware version 5.0001 and above also offers firmware 

integrity through 256-bit digital firmware signature. See 6.13: Nexus® 1500+ Meter’s 

Advanced Security - Resilient Cyber SecurityTM and Firmware Integrity (Firmware V20 

and above with V4-V6), on page 6-50 for a description of digital firmware signature.
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6.12.1: Username and Password 

Following are the Nexus® 1450 meter’s Username and Password rules:

•  Admin user: 

•  Has a fixed username of “admin.”

•  Has the following password rules:

•  Password is configurable and can be up to 32 characters.

•  Password can contain any printable ASCII character.

•  Password may not contain the username.

•  Legacy user:

•  Has a fixed username of “legacy.”

•  Password is up to 10 characters. 

•  Password enables Level 2 access (see 6.3: Enable Passwords (Nexus® Meters), 

on page 6-4, for information on Level 2 passwords).

•  Access is restricted to backward compatible Modbus features, e.g., resetting 

energy, reading TOU, and retrieving logs, and cannot be used to log in via the 

CommunicatorPQA® application as it does not support newer features.

•  Ten configurable users:

•  Username is configurable and can be up to 32 characters.

•  Username must be unique and can contain any printable ASCII character.

•  Password rules are the same as for the Admin password.

•  May have one of four roles assigned, to control user permissions.
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6.12.2: Roles

Roles are sets of permissions that can be configured by the Admin user and assigned 

(one each) to the ten configurable users. A role can be assigned to multiple users, but 

each user can have only one role. All of the available permissions are shown in the 

roles setup screen - see 6.12.6: Setting up Roles, on page 6-40.

6.12.3: Enabling Security

To enable security:

1. From the Tools Menu, click Security>Enable. You will see this message.

2. Click Yes. You will be prompted to enter the Admin password.

3. Enter and confirm a password for the Admin user (see 6.12.1: Username and Pass-

word, on page 6-34, for password requirements). Note that you can click Show 

Password if you want to see the actual password rather than the placeholder aster-

isks.

4. Click OK. You will see the Security Editor screen, which is explained in 6.12.5: Set-

ting up Users, on page 6-37 and 6.12.6: Setting up Roles, on page 6-40.
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6.12.4: Disabling Security

As mentioned earlier, only the Admin user can disable security for the meter.

1. From the Tools Menu, click Security>Disable. You will see this message.

2. Click Yes. You will see status messages as security is being disabled, and then this 

message once the security has been disabled.

3. Click OK.
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6.12.5: Setting up Users

As mentioned earlier, only the Admin user can configure the other users.

1. When you first Enable security, after entering the Admin password, the Security 

Editor opens automatically. 

NOTE: To set up or edit users at another time, click Tools>Security>Configure.
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2. If this is the first time you are setting up security for the meter, the only enabled 

user will be Admin; if users have already been configured, they will be listed on the 

right side of the screen. For each configured user, the username, assigned (config-

ured) role, and timeout setting are displayed.

From this screen you can set up a legacy user, if needed, and ten additional users. 

You can also configure roles for the users and enable the sealing switch and secu-

rity lock.

3. To set up a user, click on a user in the list on the left side of the screen.
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4. You configure settings for the user on the right side of the screen. Enter:

•  Username

•  Password

See 6.12.1: Username and Password, on page 6-34 for details of password 

requirements. 

• If the password meets the minimum requirements, you will see a red 

check mark and the text “weak” to the right of the field; if it meets the 

recommended strength length of at least 16 characters, you will see a 

green check mark and the word “good” to the right of the field.

• If you want to see the password you are entering (rather than asterisk 

placeholders), click the eye icon to the right of the Password or Confirm 

Password fields.

5. Enter the password again in the Confirm Password field.

6. Select the Role for this user from the Role pull-down menu. You also set up roles; 

i.e., a collection of permissions, from the Security Editor screen - see 6.12.6: Set-

ting up Roles, on page 6-40, for instructions.

7. Select an inactivity timeout from the pull-down menu. This is the number of sec-

onds without security activity that the system will wait before automatically signing 

out the user.

8. Note that there is a message at the bottom of the screen that says “Settings 

changed.” Click Update User to save your settings and create the user, or Clear 

User to delete the user from the security setup. You will see a screen with update 

messages as your settings are being saved and then the Security Editor is redis-

played. When the user is saved successfully, there is a message at the bottom of 

the screen that says “Update Successful.”

NOTE: If the Update button isn’t selectable, make sure that the password and con-

firmation passwords match, and that the password doesn’t contain the username.

9. Continue to set up as many users as you need. Remember that the Legacy user is 

a special case that has unique password requirements - see 6.12.1: Username and 

Password, on page 6-34, for details.
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6.12.6: Setting up Roles

The Security Editor screen is also used to set up the roles, i.e., the set of permissions 

that will be assigned to users. You can only assign one role to a user, but multiple 

users can have the same role. Up to four roles can be configured.

1. Click on one of the roles on the left, under the Configure Roles heading.

2. The right side of the screen lists permissions. Use the scroll bar to view all of the 

available permissions. To assign a permission to a role, click in the Enabled check-

box next to the action, e.g., Read TOU data. 

NOTE: You can click on the group checkbox, e.g., Read Permissions, to select all of 

the items in that group - see the example above. You can also right-click in the 

screen and choose Select All or Select None.
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3. When you have finished assigning permissions to the roles, click Update Role. You 

will see a screen with update messages as the role is being saved and then the 

Security Editor is redisplayed. You can then assign that role to one or more users.



     Doc#    E107707    6 - 42

  6: Meter Security 

6.12.6.1: Viewing the Role and User Configuration

You can view all of the roles with their permissions, and the users to whom they are 

assigned by clicking on Configure Roles on the left side of the screen. You will see the 

Roles Overview screen, shown below.

You can also create a text file with the configured users and their permissions. Click 

Configure Users on the left side of the Security Editor and then click Generate Report 

on the bottom right. You will be prompted to enter a name and select a destination for 

the text file. An example text file is shown on the next page.

Scroll to see more
information

   

Each role has a unique color
Users have the 

same color as their role

 The permissions
for a user

are checked
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6.12.7: Security Actions
The Security Editor also lets you enable the meter’s sealing switch and security lock 

and disable security.

•, When the sealing switch is enabled, a user must physically break the meter seal 

and press the Reset button in order to perform any password protected meter 

actions.

• When security lock is enabled, passwords must be used to access any password

protected features.

   CAUTION! Once security lock is enabled, it cannot be turned off.

6.12.7.1: Enabling the Sealing Switch

To enable the sealing switch:

1. Under Security Actions on the left side of the screen, click Enable Sealing Switch.

The right side of the screen displays the settings for the sealing switch.
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IMPORTANT! Once you enable the sealing switch, the physical sealing switch, i.e., 

the meter’s Reset button must be pressed, in order to access any secure features. 

Pressing the Reset button gives you 30 minutes in which to perform the task. 

• Once 30 minutes have passed, you are no longer allowed to make config-

uration changes. However, if you press the Reset button again before the

30 minutes has elapsed, the countdown is restarted, giving you 30 min-

utes from the second time you pressed the Reset button.

2. Enter the word ENABLE in the Confirm field.

3. Click Continue.

NOTES: 

• The Admin user can also disable the sealing switch if it has been enabled. The

instructions are the same as for enabling the sealing switch, except that the text

under Security Actions will say Disable Sealing Switch and you will type the word

DISABLE in the Confirm field.

• You can also enable the sealing switch from the Tools menu. Once you have enabled

security, click Tools>Enable to enable the sealing switch. Note that you will not see

this menu item if security is not already enabled.
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6.12.7.2: Enabling Security Lock

The security lock feature prevents meter security from being disabled. 

   IMPORTANT! Make sure you want to implement this setting: Once you 

    enable the security lock, you CANNOT DISABLE Security, though you can

    still change users and passwords.

To enable the security lock:

1. Under Security Actions on the left side of the screen, click Enable Security Lock.

The right side of the screen displays the settings for the security lock.
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2. If you are sure you want to enable security lock, enter the word ENABLE in the

Confirm field.

3. Click Continue.

6.12.7.3: Disabling Security

To disable security:

1. Under Security Actions on the left side of the screen, click Disable Security. The

right side of the screen displays the settings for disabling security.

2. Only the Admin can disable security. To do so, enter DISABLE in the Confirm field

and then press Continue.

IMPORTANT! Once security is disabled, anyone will be able to access 

the meter until security is enabled again.
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6.12.8: Logging On and Off

When security is enabled, you will be prompted to enter a password (or press the 

sealing switch and then enter your password, if sealing switch is enabled) when you 

connect to the meter.

Enter your username and password and then press Login. Note that you can click the 

box next to Show Password if you want to see the characters you are entering, rather 

than the place holding asterisks. If the username and password are correct, you will 

be able to perform the action. If they are not correct, you will be prompted to enter a 

new username and password.

You are logged out of the meter when you disconnect.

Note that if click Cancel you will be disconnected from the meter.

NOTE: When the Device Profile of a Nexus® 1450 meter is updated, the meter 

reboots. If security was enabled when the meter rebooted, users may need to login 

again by disconnecting from the meter, reconnecting to it, and logging in again. This 

is true both for the user that updated the Device Profile and for any other users con-

nected to the meter when it is updated.
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6.12.9: Viewing Security Status

When you sign on with a password, you will see a security status screen like the one 

shown below.

You can also check Security status by clicking Tools>Security>Status. You will see a 

screen like the one shown below, showing details of the users that are logged in.
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6.13: Nexus® 1500+ Meter’s Advanced Security - 
          Resilient Cyber SecurityTM and Firmware Integrity
         (Firmware V20 and above with V4-V6)

The Nexus® 1500+ meter with Firmware V20 and above and V-SwitchTM keys 4-6 

offers both the bi-level and extended password protection described earlier in this 

chapter (see 6.2.1: Nexus® Meters’ Password Options, on page 6-2) and an 

advanced security option - Resilient Cyber SecurityTM, which enables role-based user 

accounts protected with an encryption key. Some of the features of Resilient Cyber 

SecurityTM are:

• An Admin user with full rights and a programmable password of up to 24 charac-
ters.

• Ten user IDs with passwords of up to 24 characters.

• Encrypted communication of sensitive data, such as passwords, usernames, roles,
and rights.

• Expiration programming of passwords by the Admin user.

• A security lock feature is available to prevent security from being disabled.

In addition to Resilient Cyber SecurityTM, V20 of the meter’s firmware provides secu-

rity to ensure firmware integrity. The Firmware is “signed” with a 512-bit digital signa-

ture embedded in the firmware file/package.

• The digital signature is an encryption of a hash value computed over the firm-

ware contents.

• The digital signature is decrypted by the firmware currently in the meter and the

hash value is compared to make sure it is as expected.

• Firmware is checked for integrity by the meter on startup and firmware update.

• On startup, if the firmware integrity check fails, the meter stays in Boot

mode, and a System Failure message is displayed on the meter’s screen

and in the meter’s status screen.

• In firmware update, if the firmware integrity check fails, the meter will

not accept the uploaded firmware file.
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6.13.1: Admin and User Accounts 

Resilient Cyber SecurityTM allows for one administrator account and up to ten role-

based user accounts. The administrator account is called Admin (this name can’t be 

changed). The Admin has all rights and is able to create and edit other users, 

set and change the Admin password, enable and disable security, and set expiration 

dates for passwords and/or the encryption key.

Usernames and passwords can be up to 24 characters in length. Passwords can con-

sist of any printable characters, except for a colon (:). There is a lockout period of up 

to 24 hours for incorrect username/password entry: after three failed login attempts, 

the user is locked out (prevented from signing on) for one minute. After each subse-

quent set of three failed attempts, the lockout time is doubled; the maximum lockout 

time is 24 hours. The lockout time is reset after a successful entry.

When Resilient Cyber SecurityTM is enabled, access to the following actions is 

restricted to either the Admin or a user whose assigned role gives them rights to the 

action. When security is disabled, all of the following actions are accessible. 

NOTE: Some actions may be dependent on others, and if the user’s role doesn’t allow 

the other action, the user won’t be able to perform the initial action, e.g., being able 

to set up Preset Energy depends on having Test Mode rights. The Admin should take 

this into account when setting up user roles.

• File access: read, write, delete, rename, change directory, list directory

• Read TOU data

• Retrieve logs file

• Set CT/PT compensation

• Preset energy

• Set date/time

• Set date/time format

• Set serial number

• Set V-SwitchTM key

• Reset max/min and demand

• Reset TOU

• Reset logs
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•  Reset energy 

•  Reset meter 

•  Modbus LDA access 

•  WEB access 

•  FTP access 

•  Update device profile file 

•  Update TOU profile file 

•  Update firmware file 

•  Update SCL file 

•  Update webpage file 

•  Update display file 

•  Access control for external device 

•  Access control relay 

•  Manual waveform capture 

•  Test mode 

•  Revenue and waveform calibration 

The ten user accounts can be assigned any combination of eight roles, which provide 

specific capabilities. See 6.13.2.3: Setting up Roles, on page 6-61, for details.
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6.13.2: Programming Resilient Cyber SecurityTM

The following sections explain the actions involved with implementing the Resilient 

Cyber Security feature.

6.13.2.1: Upgrading and Enabling Security

If your meter is in Legacy security mode, you first need to upgrade to Resilient Cyber 

SecurityTM mode:

1. If Password protection is enabled, disable it.

2.From the Tools Menu, click Passwords>Change Current Security Mode.

3. To change from the Legacy Mode to the Resilient Cyber SecurityTM Mode, click 

Change. (As the message notes, MV90 may not work as expected under the Resil-

ient Cyber SecurityTM Mode.) If the current security mode is Resilient Cyber 

SecurityTM, do not make any changes - click Cancel to close the screen.

4. You will see a Confirmation window - click Yes to close it. You next need to enable 

Resilient Cyber SecurityTM.
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5. Click Tools>Security>Enable and click Yes in the Confirmation window. 

6. Enter and confirm a password for the Admin user (see 6.13.1: Admin and User 

Accounts, on page 6-51, for password requirements). Note that you can click Show 

Password if you want to see the actual password rather than the placeholder aster-

isks.

7. Click OK. You will see the Security Editor screen, which is explained in 6.13.2.2: 

Setting up Users, on page 6-58 and 6.13.2.3: Setting up Roles, on page 6-61.
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6.13.2.1.1: Disabling Security

As mentioned earlier, only the Admin user can disable security for the meter. There 

are two ways to disable security: from the Security menu and from the Security Editor 

screen. 

•   To disable security from the Security menu:

1. Click Tools>Security>Disable and click Yes in the Confirmation window. 

- You will see status messages as security is being disabled, and then this

   message once the security has been disabled.

2. Click OK to close this window.

•   To disable security from the Security Editor:
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1. Click Disable Security on the bottom left side of the screen, under Security 

Actions. 
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2.The right side of the screen changes as shown below.

3. Enter DISABLE in the Confirm field and click Continue. Note that DISABLE 

must be entered in all caps.

4. You will see messages as security is being disabled.

NOTE: Even when disabled, the security mode, e.g., Resilient Cyber SecurityTM, is 

retained. If you re-enable security, that mode will be active again. 
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6.13.2.2: Setting up Users

As mentioned earlier, only the Admin user can configure the other users.

1. When you first Enable security, after entering the Admin password, the Security 

Editor screen opens automatically. 

NOTE: To set up or edit users at another time, click Tools>Security>Configure.

2. If this is the first time you are setting up security for the meter, the only enabled 

user will be Admin; if users have already been configured, they will be listed on the 

left side of the screen. 

From this screen the Admin can set up ten users and configure eight roles; disable 

security; and disable all users by clicking the Disable Users button and then clicking 

Yes in the confirmation window.

NOTE: Since you must assign role(s) to the user when setting a user up, you may 

want to set up roles first - see 6.13.2.3: Setting up Roles, on page 6-61.
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3. To set up a user, click on a user in the list on the left side of the screen.

4. You configure settings for the user on the right side of the screen. Enter:

•  Username

•  Password

See 6.13.1: Admin and User Accounts, on page 6-51 for details of password 

requirements. 

• If the password meets the minimum requirements, you will see a red 

check mark and the text “weak” to the right of the field; if it meets the 

recommended strength length of at least 16 characters, you will see a 

green check mark and the word “good” to the right of the field.
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• If you want to see the password you are entering (rather than asterisk 

placeholders), click the eye icon to the right of the Password or Confirm 

Password fields.

5. Enter the password again in the Confirm Password field.

6. Check the boxes of the roles you want to assign to the user. You also set up roles; 

i.e., a collection of permissions, from the Security Editor screen - see 6.13.2.3: 

Setting up Roles, on page 6-61, for instructions.

7. Note that there is a message at the bottom of the screen that says “Settings 

changed.” Click Update User to save your settings and create the user. You will see 

a screen with update messages as your settings are being saved and then the 

Security Editor is redisplayed. When the user is saved successfully, there is a mes-

sage at the bottom of the screen that says “Update Successful.”

NOTE: If the Update button isn’t selectable, make sure that the password and con-

firmation passwords match, and that the password doesn’t contain the username.

8. Repeat this process to set up additional users. 
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6.13.2.3: Setting up Roles

The Security Editor screen is also used to set up the roles, i.e., the set of permissions 

that will be assigned to users. You can assign more than one role to a user, and multi-

ple users can have the same role. Up to eight roles can be configured.

1. Click on one of the roles on the left, under the Configure Roles heading.

2. The right side of the screen lists permissions. Use the scroll bar to view all of the 

available permissions. To assign a permission to a role, click in the Enabled check-

box next to the action, e.g., Read TOU data. 

NOTE: You can click on the group checkbox, e.g., Read Permissions, to select all of 

the items in that group - see the example above. You can also right-click in the 

screen and choose Select All or Select None.
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3. When you have finished assigning permissions to the roles, click Update Role. You

will see a screen with update messages as the role is being saved and then the

Security Editor is redisplayed. You can then assign that role to one or more users.

6.13.2.4: Viewing the Role and User Configuration

You can view all of the roles with their permissions, and the users to whom they are 

assigned by clicking View Roles on the left side of the screen. You will see the Roles 

Overview screen, shown below.

Scroll to see more
information

   

Each role has a unique color

  The permissions
for a user

are checked
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You can view a summary of the users by clicking Configure Users from the left side of 

the Configure screen.

Click View Report from this screen to create a text file with the configured users and 

their permissions.
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You can also click View>Report from the top of the Configure screen to see this screen 

with users and roles information.
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6.13.2.5: Security Actions

The Security Editor lets the Admin disable security (see 6.13.2.1.1: Disabling Secu-

rity, on page 6-55) and displays instructions for enabling the meter’s security lock.

The security lock feature prevents meter security from being disabled. 

1. Click Enable Security Lock, Under Security Actions on the bottom left side of the

screen.

2. The right side of the screen displays information for the security lock.

As a safeguard against enabling the security lock unintentionally, you must enable

it at the meter, using the meter’s display. See Chapter 6 in the Nexus® 1500+

Meter User Manual for instructions.

IMPORTANT! Make sure you want to implement this setting: Once the

Security lock is enabled, security cannot be disabled.
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6.13.2.6: Configuring Password Expiration

You can enable password expiration and set an expiration time. Note that this applies 

to ALL passwords, even the Admin’s. Once a password expires, only the Admin can 

create new passwords for a user or for the Admin. If the Admin’s password has 

expired, the Admin will have a limited Admin capability, allowing the Admin to only 

update passwords and the encryption key).

1. Click Tools>Security>Configure the Password Expiration.

2. To enable password expiration, select Enable from the Password Expires pull-down

menu and click Update. You will see a message that the change was successful

(Pass) - click OK.

3. The default expiration time is 12 months. You can change that by selecting a differ-

ent number of months until expiration, from the Password Expires Every pull-down

menu, and then clicking Update. You will see a message that the change was suc-

cessful (Pass) - click OK.

NOTE: If you are enabling the password expiration and setting a password expira-

tion date, you can click Update All.

4. Click Close to close this screen.

NOTES:

• You can view the remaining time before expiration - see 6.13.3: Viewing

Security Lockout Status, on page 6-67.
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• Every time a password is changed, the countdown to expiration restarts,

i.e, if the default expiration of 12 months is used, and five months have

passed when the Admin changes a user’s password, the countdown to its

expiration will restart and the new password for this user will be valid for

12 months.

6.13.3: Viewing Security Lockout Status

You can view the number of days left until password and/or cryptographic key expira-

tion, and also any users in password lockout due to failed log in attempts.

1.Click Tools>Security>Security Lockout Status.

• If any users are in lockout mode, the amount of time left in minutes is shown for

the user in Remaining Password Lockout Time column. If the user is not in lockout

mode, 0 is shown in the field.

• If password expiration is enabled, the number of days left for the user’s password is

shown in the Password Expires In column. If there is no expiration time set, Never

is shown in the field.

• Remaining Key Lockout Time shows the amount of time in minutes that a user is

locked out due to repeated login attempts after the encryption key has expired.

• The amount of time left before the encryption key expires is shown toward the bot-

tom of the screen.

2. Click Close to close this screen.
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6.13.4: Viewing Security Status

When you sign on with a password, you will see a security status screen like the one 

shown below.

You can also check Security status by clicking Tools>Security>Status. You will see a 

screen like the one shown below, showing details of the users that are logged in.
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7: Configuring Your Meter: the Device Profile
      Screen

Once you have connected to your meter and closed the Device Status screen, you will 

use the Device Profile screen to configure settings for your meter.

7.1: Device Profile Screen

• The Device Profile screen is the place where most of the meter configuration takes

place. You open the meter’s Device Profile screen in one of the following ways:

• By clicking on the Profile icon in the Icon Bar when you are connected to a meter

• By clicking Tools>Edit Device Profile from the Menu Bar when you are connected

to a meter

• By clicking File>Open>Device Profile> from the Menu Bar and then choosing

one of the listed Device Profiles, to configure a stored Device Profile when you

are offline (not connected to a meter)

• This chapter explains the Device Profile screen and its features. The following

chapters explain the Device Profile settings for specific EIG meters:

• Chapter 8 has instructions for configuring the Shark® 200/200S meter.

• Chapter 9 has instructions for configuring the Shark® 50/100/100B/100S
meter.

• Chapter 10 has instructions for configuring the MP200 metering system.

• Chapter 11 has instructions for configuring the Nexus® 1500/1500+ meter.

• Chapter 12 has instructions for configuring the Nexus® 1262/1272 meter.

• Chapter 13 has instructions for configuring the Nexus® 1252 meter.

• Chapter 26 has instructions for configuring the Shark® 270 meter.

• Chapter 27 has instructions for configuring the Nexus® 1450 meter.

• Chapter 28 has instructions for configuring the Shark® 250 meter.

• Chapter 30 has instructions for configuring the ST 40 meter.



     Doc#    E107707                                                 7 - 2

                           7: Configuring Your Meter: the Device Profile Screen

•   The appearance of the Device Profile screen depends on the meter type you are 

connected to. Refer to the following example. 

•   All Device Profiles function basically in the same way. They each have a Tree Menu 

structure that expands to the specific setting desired. 

•   The Device Profile is organized by subject matter, so that navigating to a particular 

setting is intuitive.

•   All meters manufactured by EIG can be programmed with CommunicatorPQA® 

software through their Device Profile.

•   CommunicatorPQA® software also provides the ability to store Device Profiles and 

Load Profiles so that users can keep generic profiles that only need to be slightly 

modified for a particular use.

•   After you finish configuring any or all of the programmable settings (refer to chap-

ters 8-13, 27-28, and 30 for detailed configuration instructions for your meter 

Shark® 200/200S Meter Device Profile Screen

Click in 
the Tree 
Menu to 
Display 
the 
Settings 
Screen on 
the Right 
Side
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type), use the Buttons at the bottom of the screen to execute the tasks described 

in the following section.

•   The Device Profiles can be configured offline, allowing you to configure a meter 

when it is not connected, and then update it with the programmed settings at a 

later time.

7.2: Device Profile Screen Buttons
All of the meters’ Device Profile screens have the following buttons (though the 

appearance of the icons and the order in which they appear may vary): 

•   Update Device - this sends the new Device Profile to the connected meter. You 

must update the meter's Device Profile for any changes to the programma-

ble settings to take effect. When you click Update Device, the meter retrieves 

the programmable settings. For the Nexus® meters only, the following screen is 

displayed. 

1. Click on any item you do not want to change when the new Device Profile is 

sent. The purpose of this is if you wish to use a generic Device Profile to 

update the meter, these device-specific settings will not be over-written when 

the other programmable parameters are added.
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2. Click Continue to update and send the profile to the meter. You will see a prog-

ress screen while settings are updated. 

IMPORTANT! If you change the Communication settings for the meter, you 

will no longer be able to communicate with it. You will have to sign off and sign 

on again with the new settings.

NOTE: When the Device Profile of a Nexus® 1450 meter is updated, the 

meter reboots. If security was enabled when the meter rebooted, users may 

need to login again by disconnecting from the meter, reconnecting to it, and 

logging in again. This is true both for the user that updated the Device Profile 

and for any other users connected to the meter when it is updated.

•   Save/Save Profile - Click to save the Device Profile settings to a file. You will see 

the Save Programmable Settings window, shown below. Give a name to the 

Device Profile and click Save.

NOTE: Saving the profile does not update the meter.
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•   Load/Load Profile/Open: Click to load a previously saved Device Profile Settings 

file. You will see the Load Programmable Settings window, shown below. Select the 

saved Device Profile you want and click Open. The settings from that file will now 

appear in the Settings Screens; for example, the CT and PT Ratios will be those 

from the saved Device Profile, rather than from the currently connected meter. 

This feature is useful if you want to copy some or all of another meter’s settings to 

the currently connected meter. Be sure to give the meter a unique identifica-

tion - see the programming chapter for you meter (see chapters 8-13, 26-

28, and 30).

•   Exit/Exit Editor: Click to leave the Device Profile Editor. You will be asked to 

confirm that you want to exit - click Yes to exit. 
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7.2.1: Device Profile Report

Click Report/View Report to view the Device Profile or print a copy of it. 

•   For the Nexus® meters, message windows open while the report is being 

compiled and then you see the following screen.

•   Use the Page arrows to select a page to view.

•   Use the Zoom field to adjust the viewing magnification.

•   Use the Print Range and Print Pages fields to specify the pages you want printed.
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•   Use the Copies field to specify number of reports.

•   Use the Print button to print the report. You will see a Print Setup screen where 

you can select printer, properties, paper, and orientation. 

•   Use the Save button to save the Device Profile report. A window opens, allowing 

you to specify a location for the saved report.

•   Use the Done button to exit the screen and return to the Device Profile screen.

•   For the Shark® 200/250/270 meter. ST40 meter, and the MP200TM metering 

system, the View Report button opens a Notepad window containing the meter's 

Device Profile settings in a text file. See the example window, shown below. 

•   Print the text file by selecting File>Print from the Notepad Menu Bar.
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•   Save the text file by selecting File>Save from the Notepad Menu Bar.

•   For the Shark® 100 meter, the View Report button opens the following window.

3. You have two choices:

•To view the report on the PC, click Yes. Notepad will open with the report 

as a text file (see the example on the previous page). 

• Print the text file by selecting File>Print from the Notepad Menu Bar.

• Save the text file by selecting File>Save from the Notepad Menu Bar.

•To print the report without first viewing it, click No. A screen opens that 

lets you select the printer you want to use.
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7.2.2: Shark® 200 Meter/MP200TM Metering System Device 
            Profile Additional Features

The Device Profile screens for the Shark® 200 meter and the MP200TM metering sys-

tem have some additional features. Three items in the Menu Bar - File, Tools, View - 

open menus that let you perform functions. These menus and functions are described 

below. 

NOTE: When you click Help from the Menu bar a PDF file of this manual opens, with 

instructions for the Device Profile Setting that is active at the current time. For 

example, if you are on the Display Configuration screen and you click User Manual, 

the instructions for setting Display Configuration are shown. 

•   Click File from the Menu Bar to see the menu shown below. The File menu lets you 

perform functions that can also be performed using the screen Buttons, described 

on the previous page: Save Profile, Load Profile, Report, and Exit Profile Editor. 

•   Click Tools from the Menu bar to see the menu shown below. 

The Tools menu gives you the following options: 

•   Update Device - performs the same function as the Update Device button at the 

bottom of the screen: it send the Device Profile settings to the currently con-

nected meter.
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•   Verify Profile - click to perform a verification of the current Device Profile 

settings. You will see a window like the one shown below if there are no errors.  

NOTE: If there are any errors as you program the profile, the error message 

shown below will display. 
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When you click OK, the Error Output Log will open under whatever settings 

screen you are currently viewing. See the example screen, shown below. 

• The Error Output log lists the Time the setting error was made, the Loca-

tion - the setting the error is in, and the description of the error. You will 

not be able to save the Device Profile with the error.

• The bottom of the Device Profile screen also displays information about 

the error: the location and description of the error. 

• You can resize the display by clicking and dragging on the line above the 

Errors display. 

• Click View Output Log>Errors to remove the Errors Output Log display 

from the screen.

•   Load from Device - click to load the Settings fields with values from the currently 

connected meter. This will override any changes you’ve made locally. 

The Error Output Log
     is shown here
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CAUTION! If you have made changes to the settings and have not saved them 

to a file or updated the device, the changes will be lost.

•   Click View from the Menu bar to see the menu shown below. 

•   View Last Update Information - click to view update information for this Device 

Profile. See the example screen below.

• This window displays the time and date of the last update, and the total 

number of updates, for this Device Profile.

• Click OK to close the window.
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7.2.3: Shark® 250/270/ST40 Meter Device Profile 
                Additional Features

The Shark® 250/270/ST40 meter has Device Profile icons that look different from 

those of the other EIG meters. Most of the icons perform the same function as with 

the other device profile screens, e.g., the Update Device icon does the same thing as 

the Update Device button - it sends the new device profile settings to the connected 

meter. 

Following are the unique device profile features for this meter:

•  Click the Help icon to open instructions for the currently active setting.

•  Click the i icon to view version information for the device profile software.

•  Click the Retrieve icon to load the settings from the currently connected meter.

•  Click the Compare icon to display the original settings and any new settings for the 

device profile.

The settings in red/pink have been changed from the original settings, and the 

settings in blue have not been changed. 

•  Click Show Differences Only to display just the changed settings.
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•  Click the Export setting to save the information in the screen as an Excel file. You 

will be prompted to give the file a name.

•  Click Compare Text File to open a text file containing the information.

•  Click the View Screens icon (Shark® 270 meter - other meters won’t show this 

icon) to display the screens in the currently loaded Screen Profile.

• Use the right arrow to view screens for the next Mode, and the left arrow 

to view screens for the previous Mode.

• Use the top arrow to view the next screen in the current Mode, and the 

bottom arrow to view the previous screen in the current Mode.

• Check the Move with main screen button to cause the Meter Faceplate 

Screen to move in tandem with the Device Profile screen.

• See , on page 26-117, for information on the meter’s Screen Profiles.
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7.3: Device Profile Offline Settings

You can configure a device profile without being connected to a meter. Follow these 

steps. 

1. Open the CommunicatorPQA® application, and from the Main screen’s Menu Bar, 

click File>Open>Device Profile. You will see this menu: 

2. Click on the device profile you want to configure:

•  Nexus Series Device Profile for the Nexus® 1252/1262/1272/1450/1500/1500+ 
meters.

•  Nexus Programmable Display Profile when you also want to modify the Nexus® 
1262/1272’s LCD display.

•  Futura Device Profile for the legacy device Futura+/CPU1000.

•  Shark Series Device Profile for the Shark® 50/50B/100/100B/100T/100S/200/
200T/200S meters.

•  Shark 250 Device Profile.

•  Shark 270 Device Profile for the original Shark® 270 meter.

•  Shark 270 Screen Designer Profile when you also want to modify the embedded 
display’s programmable settings.

•  Shark 270 Gen 2 Device Profile for the Shark® 270 meter Gen 2.

•  Shark 270 Gen 2 Screen Designer Profile when you also want to modify the 
embedded display’s programmable settings.

•  MP200 Device Profile for the MP200-Y or MP200-S metering system.

•  ST40 Device Profile.
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•  Nexus External I/O Module Settings Profile for the external I/O modules (see 
Chapter 14 for details on configuring the external I/O modules).

3. A window opens that lets you browse for the Device Profile you want to configure. 

You can open an existing Device Profile, or one of the default device profiles that 

come with the software. See the example below.
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4. Click on the type of the folder with the Device Profile you want to configure, e.g., 

Shark® 200 meter. A window will open that lets you narrow down your choice - see 

the example below.
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5. Click on whichever Device Profile you want: 1 Amp or 5 Amp. You will see a screen 

like the one shown below.

6. Either click on the file name and click Open, or double-click on the file name. You 

will see a screen like the one shown below.
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•   Depending on the meter type, you may have choices in the Device field. In this 

example, you can choose either Shark® 200 or Shark® 200S.

•   Use the V-SwitchTM field to choose the V-SwitchTM key. Depending on the meter 

type, the V-SwitchTM key enables specific settings. In this example, V-SwitchTM 

key 5 or 6 will enable PQ/Waveform setting for a Shark® 200 meter’s Device 

Profile.

•   Use the Calibration Frequency field to select 50 Hz or 60 Hz. 

7. Click Continue to open a Device Profile screen that matches your selections. Follow 

the instructions in the meter type programming chapters 8-13. 

8. Note that for a Shark® 200/250/270 meter, you can edit the I/O Option cards as 

well as the other settings, when offline. To do so, double-click on Option Card 1 or 

Option Card 2 in the Device Profile screen Tree menu to see this display:
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9. Select the Option card you want from the pull-down menu. The Option card’s set-

tings will now be listed in the Tree menu, for you to configure. See the example 

screen, below. 

Network Card selected

Network Card settings
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8: Shark® 200/200S Meter
This chapter explains how to configure a Shark® 200/200S meter's programmable 

settings, which are stored in the unit's Device Profile. Chapter 7 contains detailed 

information on how to use the Device Profile.

8.1: Device Profile General Settings

1. From the Tree Menu on the left side of the Shark® 200/200S meter’s Device Profile 

screen, double-click on the General Settings line or click on the + button next to it. 

All of the settings in the General Settings group are listed.
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8.1.1: Configuring CT, PT Ratios and System
            Hookup

The first screen you see is the CT, PT Ratios and System Hookup screen, shown on the 

previous page (to return to this screen from another screen, click General 

Settings>CT, PT Ratios and Hookup). Use this setting to configure Current Trans-

former and Potential Transformer ratios and to select the System Hookup. 

Functional Overview of CT and PT Ratios:

Current and Potential Transformers are used mainly for the following reasons:

•   To insulate, and as a result isolate, the meter from high-voltage circuits.

•   To change the primary voltage and current to standard values and sizes that the 

meter can measure.

The CT and PT transformers deliver fractions of the primary voltage and current to the 

meter. With properly set ratios and multipliers, the readings of the meter can be used 

to determine the primary energy, voltage, current, or power of the system. 

IMPORTANT! You have two options for entering the CT and PT settings. You can 

either enter CT/PT Numerator, Denominator, and Multiplier manually (see instructions 

below), or you can enter the Ratios for CT/PT Numerator and Denominator and click 

the Update CT/Update PT buttons to let the software calculate the Numerator, 

Denominator, and Multiplier for you. You can then empty the Ratio fields and click the 

Update Ratio buttons to confirm the calculated settings: you will see the same ratios 

you initially entered.

NOTE: Some ratios cannot be represented in the Shark® 200 meter. The software 

will try to find the closest value, in that case.

1. For manual entry, make these settings:

•   CT Ratios

• CT Numerator (Primary): 1 - 9999

• CT Denominator (Secondary): 5 or 1 Amp 

 NOTE: This field is display only. The meter is ordered as a 5 Amp or 1 

Amp Current Secondary.
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• EITHER CT Multiplier (Scaling): 1, 10 or 100 

Multiplies the CT Numerator by this scale. The display can only read 4 

digits, or 9999. Above that range the number must be multiplied to have 

it read K or M values.

• OR Ratio: the ratio to be applied, and click Update CT 

• Current Full Scale: (display only) this shows the scale that has been 

entered, as it relates to the 5 A or 1 A secondary input. 

•   PT Ratios

• PT Numerator (Primary): 1 - 9999

• PT Denominator (Secondary): 1 - 9999

• PT Multiplier (Scaling): 1, 10, 100, or 1000

• Voltage Full Scale: (display only) this shows the scale that has been 

entered. 

•   System Wiring

• 3 Element Wye; 2.5 Element Wye; 2 CT Delta

This value must be set properly for the meter to calculate readings 

correctly.

Example Settings:

For a CT of 2000/5A, set the following CT Ratios in the entry fields:

CT Numerator (Primary)           2000

CT Denominator (Secondary)    5

CT Multiplier                            1

The Current Full Scale field will read 2000. 

For a system that has 14400V primary with a 120V secondary line to neutral (PT Ratio 

of 120:1), set the following PT Ratios in the entry fields:

PT Numerator (Primary)  1440
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PT Denominator (Secondary) 120

PT Multiplier    10

The Voltage Full Scale field will read 14.4k.

2. Use the box at the bottom of the screen to enter the minimum voltage threshold, 

which is a percentage of the voltage full scale. This setting adjusts the pick up 

threshold for the voltage. You set a percentage of the PT primary (PT numerator X 

PT multiplier) up to 12.7 in the entry field. This allows a user to configure when the 

meter will start readings values above 0 voltage. The minimum primary voltage 

based on the percentage you entered is displayed at the bottom of the screen.

3. To implement any changes, click the Update Device button to send the new 

profile to the meter.
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8.1.2: Configuring Time Settings

Use this setting to enable or disable Daylight Savings Time for the meter, to set the 

beginning and ending times for Daylight Savings Time, and to set up Time Zone infor-

mation and clock synchronization information.

1. From the Tree Menu, click General Settings>Time Settings. 

2. Check the box to Enable Daylight Savings time, or un-check it to Disable Daylight 

Savings Time.

3. Use the entry fields to set the start and end times for the Daylight Savings Time 

feature, if enabled. Select the values you want from the Month, Week, Day of the 

Week, and Hour fields. 

    NOTE: The Hour field uses a 24-Hour clock.
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4. You can choose clock synchronization for the meter. If your meter has a Network 

Option card, you can use it to access a Network Time Protocol (NTP) Server** for 

time synchronization. You can also select Line Sync for clock synchronization. Use 

these fields to set up clock synchronization:

•   Time Zone: Zone Descriptor - Select the hour and minute of your time zone in 

relation to Greenwich Mean Time. For example, if your time zone is Eastern 

Standard time, you would select -5 from the pull-down Hour menu and leave the 

Minutes field at 0.

•   Clock Sync - To enable clock synchronization, select:

•  Yes from the Enable pull-down menu

•  Line (line synchronization) or NTP** from the Method pull-down menu

•  For line synchronization, select 50Hz or 60Hz from the Line Frequency 

pull-down menu; for NTP select either Option Card in Slot 1 or Option 

Card in Slot 2 from the Interface pull-down menu.

Line synchronization uses the frequency zero crossings to provide a time 

reference for the meter. This is the most common method to synchronize 

a meter’s clock. EIG recommends that you always select this method 

unless there is a specific reason not to select it. If the meter is not syn-

chronized to line frequency or NTP, it will default to internal crystal. Dif-

ferent meters differ in terms of drift, but typically meters with 20 ppm 

crystals will drift 30 seconds per month when set to internal crystal.

         **IMPORTANT! You also need to set up the NTP server information for the 

         Network card. See 8.5.6: Configuring a Network Card, on page 8-56 for 

         instructions.

5. To implement any changes, click the Update Device button to send the new 

profile to the meter.
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8.1.3: Configuring System Settings

Use the system settings to set password protection and a meter ID. You can enable or 

disable a Password for Resetting (Reset Max/Min Energy Settings, Energy Accumula-

tors, and the Individual Logs) and Configuration (Device Profile) in the Systems Set-

tings screen. 

Once password protection is enabled for the meter and the Device Profile is updated, 

anyone who attempts to make a change that is under password protection is 

prompted to enter the password. If the correct Password is not entered, the change 

doesn’t take place.

NOTE: If you enable a Password for Resetting, you must also enable it for Configura-

tion.

1. From the Tree Menu, click General Settings>System Settings. 
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2. From this screen, you can do the following:

•   Enable or Disable Password for Resetting and/or Configuration: click the radio 

button next to Yes or No. Enabling Password protection prevents unauthorized 

tampering with devices. 

IMPORTANT! You must set up a password before enabling Password Protection. Click 

the Change button next to Change Password if you have not already set up a 

password. 

•  Change the Password: click the Change button. 

•  Change the Device Designation: input a new designation into this field.

3. When you click the Change button next to Change Password in the Settings screen, 

you will see the Enter the New Password screen.

a. Type in the new password (0 -9999).

b. Retype the password.

c. Click Change. The new password is saved and you see the following mes-

sage window.

NOTES: If Password Protection has already been enabled for configuration and you 

attempt to change the password, you will see the Enter Password screen after you 

click Change. Enter the old password and click OK to proceed with the password 

change.

4. To implement any changes, click the Update Device button to send the new 

profile to the meter.



     Doc#    E107707                                              8 - 9

8: Shark® 200/200S Meter

8.1.4: Configuring Communication Settings

Use this screen to enter communication settings for the meter's two on-board ports: 

the IrDA Port (COM 1) and RS485 Port (COM 2).

IMPORTANT! The settings on this screen are the current settings for communication. 

Any changes you make may affect communication between the Shark® meter and 

your PC. If your meter is a 200S with the Ethernet option, keep the RS485 settings 

shown below.

1. From the Tree Menu, click General Settings>Communications. 

2. The screen fields and acceptable entries are as follows:

•  COM 1 (IrDA)

• Response Delay: 0 - 750 (50msec increments)

•  COM 2 (RS-485)
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• Address:1 - 247 (Modbus); 1-65520 (DNP)

• Protocol:Modbus RTU, Modbus ASCII or DNP3

• Baud Rate: 1200, 2400, 4800, 9600, 19200, 38400, 57600 (For the Baud 

Rates below 9600 your meter must have Runtime Firmware version 26 or 

higher.)

• Response Delay: 0 - 750 (50 msec increments)

Response Delay is the delay the meter should use before responding to 

queries. If your connecting device requires a delay before receiving infor-

mation, use response delay to program the time to wait before the meter 

starts responding to queries.

• Parity: Odd, Even, or None (For Parity setting your meter must have Run-

time Firmware version 26 or higher.)

•   DNP Options for Voltage, Current, and Power:

These fields allow you to choose Primary or Secondary units for DNP, and to set 

custom scaling if you choose Primary. The Scaling fields appear after you click 

the Primary radio button (see partial screen capture, below).

 

Scaling is used with Primary readings so that you can ensure that your readings 

will not go beyond the DNP range before they reach Full Scale. The valid range 

DNP Primary Units
Scaling Fields 

Click for Optimal 
Scaling by 
Software
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for DNP Object 30 is -32768 to +32767. If the scaling you enter will cause the 

values to fall outside the DNP range, the values will be shown in bold or red in 

the DNP Value at Full Scale fields.

Click the Optimal Scaling button to have the software choose a divisor for volt-

age, current, and power, that will not result in an over/under-range.

NOTE: You must set the DNP polling software to multiply by the divisor amount 

before showing the final value.

3. To implement any changes, click the Update Device button to send the new profile 

to the meter.
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8.1.5: Setting Display Configuration

Some users may want to lock the meter to a particular faceplate display or series of 

displays. For example, if you would like the meter to act only as a Volt meter, or only 

as an ammeter, the meter can be configured to display only the relevant screen. Use 

this setting to lock the display of the Shark® 200/200S meter's faceplate to the 

specific combination you want. Refer to the meter’s Installation and Operation Manual 

for additional information on the faceplate.

1. From the Tree Menu, click General Settings>Display Configuration.

2. The screen fields and acceptable entries are as follows:

•   Phases Displayed: A; A and B; A, B, and C. This field determines which phases 

display on the faceplate. For example, if you select A and B, only those two 

phases will be displayed on the faceplate.   
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•   Auto Scroll Display: Yes or No. This field enables/disables the scrolling of 

selected readings on the faceplate. If enabled, the readings scroll every 5 

seconds.

•   Enable on Face Plate of Display: Check the boxes of the Readings you want dis-

played on the faceplate of the meter. If you make no selection, Amps are dis-

played by default.

•   Power Direction: View as Load or View as Generator; this controls how energy is 

accumulated in the Shark® meter. View as Load means the energy readings are 

accumulated as Whrs Received, View as Generator means the energy readings 

are accumulated as Whrs Delivered.

•   Flip Power Factor Sign: Yes or No.

•   Current (I) Display Autoscale: On to apply scaling to the current display or Off 

(No decimal places).

•   Display Voltage in Secondary: Yes or No.
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•  Use IEEE/IEC Power Coordinate System: Yes or No. Select Yes to use the IEEE/

IEC system shown in the charts below. Select No if you want to use the legacy 

system shown in the charts on the next page.
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•   Load Bar Custom Configuration: This allows the meter to display load with an 

analog representation. This way the user can get a visual presentation of the 

loading of the circuit. To enter scaling for the Load Bar:

a. Click the Load Bar Custom Configuration checkbox. Fields display on the 

screen that allow you to enter a Scaling factor for the display. See the 

figure below

b. Enter the scaling factor you want in the Current Scale field. This field is 

multiplied by the CT Multiplier set in the CT, PT Ratios, and System Hookup 

screen (see 8.1.1: Configuring CT, PT Ratios and System Hookup, on 

page 8-2) to arrive at the Primary Full Scale. Make sure you set the CT 

multiplier correctly.

•   Enable Fixed Scale for Voltage Display: To enter a scaling factor for the Voltage 

display:

a. Click the checkbox next to Enable Fixed Scale for Voltage Display. The 

screen changes - see the figure below.

b. Select the scaling you want to use from the pull-down menu. The options 

are: 0-9999V, 100.0kV-999.9kV, 10.00kV-99.99kV, or 0kV-9.999kV.

3. To implement any changes, click the Update Device button to send the new profile 

to the meter.
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8.2: Revenue and Energy Settings

From the Tree Menu on the left side of the Shark 200/200S meter’s Device Profile 

screen, double-click on the Revenue and Energy Settings line or click on the + button 

next to it. The settings in the Revenue and Energy Settings group are listed.

8.2.1: Configuring Energy, Power Scaling, and Averaging Method

From the Tree Menu, click Revenue & Energy Settings> Energy, Power Scaling, and 

Averaging Method (see the screen above). Use this setting to configure: 

•   The display and storage of Energy registers in the meter

•   The display of Power data in the meter 

•   The method of VA computation
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•   The interval over which Average values are computed, as well as the Interval 

Energy 

Functional Overview of Energy Settings, VA Computation, and Averaging:

•   Energy Scaling

Energy Setting includes:

Digits (the number of digits in the reading)

Decimals (the number of decimal places in the reading)

Energy Scale: the scale of the reading - unit; kilo (number times 1000); Mega 

(number times 1 million)

Energy settings allow you to balance the resolution (or accuracy) of the energy 

stored, with the interval over which energy rollover occurs. For example, the 

maximum resolution for a k scale reading is: 99999.999k.

To calculate the speed at which the energy will rollover, you must know the Power 

Full Scale, which is computed from the CT and PT Full Scale values (see 8.1.1: Con-

figuring CT, PT Ratios and System Hookup, on page 8-2). The formula for calculat-

ing Power Full Scale is:

Wye system: CT Full Scale x PT Full Scale x 3 

Delta system: CT Full Scale x PT Full Scale x 3 x 

For example, for a CT Full Scale of 2000, PT Full Scale of 14400, Wye system:

2000 x 14400 x 3=86400000

In this example, the energy will increment at 86400000 Watts per hour, or 24000 

Watts per second.

This value allows you to determine the number of digits, decimal places, and 

energy scale you want to configure for the Energy settings, when you take into 

account the rollover time. 

To determine the number of hours before rollover, use this formula:

[Max Resolution]/[Full Scale] = #Hours, where Max Resolution = maximum digits 

and decimals for the Energy scale in use. 

Using the example from above, with an energy scale of Mega, the formula would 

3
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be:

99999.999 M/86.4 M = 1157.4074 hours or about 48 days until rollover. 

NOTE: To increase the number of days until rollover, you can increase the number 

of digits (to 8), decrease the number of decimal places (to 0), or increase the 

Energy Scale (to M).

•   Apparent Power (VA) Computation:

     There are two optional methods of VA Computation:

      Arithmetic Sum - the formula for this calculation is:

      Vector Sum - the formula for this calculation is: 

       Generally, the superior method for calculating VA is to use the Vectoral method;

       however, both methods are provided. 

•   Demand Averaging 

Demand is the average rate of energy use over time. The Shark® 200 meter 

supports two types of demand averaging: Block demand and Rolling demand.

Block demand records the average demand for time intervals that you define (

usually 5, 15, 30, or 60 minutes). 

Rolling demand functions like multiple, overlapping Block demands. You define the 

subintervals at which an average of demand is calculated. An example of Rolling 

demand would be a 15-minute Demand block using 5-minute subintervals, thus 

providing a new demand reading every 5 minutes, based on the last 15 minutes.

1. The screen fields and acceptable entries are as follows:

•   Energy Settings

• Energy Digits: 5; 6; 7; 8

• Energy Decimal Places: 0 - 6

VA VA VA VAT a b c= + +

VA W VART T T= +2 2
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• Energy Scale: unit; kilo (K); Mega (M)

For example: a reading for Digits: 8; Decimals: 3; Scale: K would be 

formatted: 00123.456k

       NOTES: 

• Your selection in the Energy Settings fields determines the precision of 

energy stored for display and polling. Refer to the Functional Overview at 

the beginning of this section for more information.

• If you are changing the energy settings, we recommend you first reset 

the Energy Accumulators, in order to prevent erroneous counts. See 

20.1.7: Reset Device Information, on page 20-7, for instructions on 

resetting the Shark® 200/200S meter's Energy Accumulators.

•   Power Settings

• Power Scale: Auto; unit; kilo (K); Mega (M)

• Apparent Power (VA) Calculation Method: Arithmetic Sum; Vector Sum 

(See explanation on the previous page.)

•   Demand Averaging

• Type: Block or Rolling

• Interval (Block demand) or Sub-Interval (Rolling demand): 5; 15; 30; 60

• Number of Subintervals: 1; 2; 3; 4

• Interval Window: This field is display only. It is the product of the values 

entered in the Sub-Interval and Number of Subintervals fields.

        NOTES: 

• You will only see the Number of Subintervals and Interval Window fields if 

you select Rolling demand.

• If you have set an Input to trigger EOI demand averaging (using either a 

Relay Output/Digital Input or Pulse Output/Digital Input Option card) any 

entry you make in the Demand Averaging field will be ignored. A message 
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to that effect appears on the screen. See 8.5.2: Configuring a Relay Out-

put/Digital Input Card, on page 8-41 and 8.5.3: Configuring a Pulse Out-

put/Digital Input Card, on page 8-46, for instructions on setting EOI pulse 

for demand averaging.  

2. To implement any changes, click the Update Device button to send the new profile 

to the meter.

8.2.2: Transformer/Line Loss Compensation

Transformer losses are power used by the transformer while working. The more load 

on the transformer, the higher the transformer losses. There are two types of trans-

former losses:

•   No load losses - these are the fixed losses that keep the transformer up and 

running.

•   Load losses - these vary with changes in the load.

When the meter is located on the secondary side of a customer’s transformer, a utility 

will want to add the transformer losses into the energy usage calculation. However, 

this practice is regulated by local jurisdiction and regulations. The meter has the 

capability to add in or subtract out these transformer losses, depending on the user’s 

specific needs.

Line losses are similar to transformer losses, except that they are used to compensate 

for loss incurred on wires, such as transmission lines.

Transformer/Line Loss Compensation allows you to add or subtract transformer and/

or line losses to meter registration.
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1. From the Tree Menu, click Revenue & Energy Settings>Transformer/Line Loss 

Compensation.

2. This screen displays the current values for the meter's Transformer Loss Compen-

sation. The screen fields and acceptable entries are as follows

•   Percent Loss of Watts due to Iron and Copper/Positive Watts and Negative Watts

•   Percent Loss of VARS due to Iron and Copper/Positive and Negative Watts

•   Drop-down menu #1. Choose from: Disabled, Fe Only, Cu Only, Both Fe and Cu.

•   Drop-down menu #2. Choose from: Add to Watts and VAR; Add to Watts and 

Subtract from VAR; Subtract from Watts and Add to VAR; Add to Watts and VAR; 

Subtract from Watts and VAR.

3. Click TLC Calculator to find the values to enter into the Percent Loss fields. The TLC 

Calculator button launches the TLC Calculator that makes the calculations for you 
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once you enter the required data.   

NOTE: Appendix A contains a screen captures of the TLC Calculator with example 

numbers, and an explanation of Loss Compensation considerations.

4. Enter the percent Loss of Watts and VARS for copper and iron in the appropriate 

fields.    

5. To implement any changes, click the Update Device button to send the new profile 

to the meter.

8.3: Power Quality and Alarm Settings

Note that in this area you will find a difference between the Shark® 200 meter and 

the Shark® 200S meter. Even though they share Device Profiles, the Shark® 200S 

meter is a submeter, and does not have the option to have Waveform/PQ functions. 

These features are only for the Shark® 200 meter.

From the Tree Menu on the left side of the Shark® 200/200S meter’s Device Profile 

screen, double-click on the Power Quality and Alarm Settings line or click on the + 
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button next to it. All of the settings in the Power Quality and Alarm Settings group are 

listed.
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8.3.1: Configuring Limits 

1. From the Tree Menu, click Power Quality and Alarm Set-

tings>Limits (see the screen on the previous page). The current settings for Limits 

are shown in the screen. Use this screen to assign Limits for the Shark® 200/200S 

meter. 

Functional Overview for Limits:

Limits are transition points used to divide acceptable and unacceptable measure-

ments. When a value goes above or below the limit, an out-of-limit condition 

occurs. You can set and configure up to eight Limits for the Shark® 200 meter.

Once they are configured, you can view the out-of-Limits (or Alarm) conditions in 

the Limits Log (see 19.3.6: Out of Limit Log, on page 19-29) or Limits Polling 

screen (see 5.4.7: Poll Alarm/Limits Status, on page 5-74). You can also use Limits 

to trigger relays.

You can assign the eight limits to readings from three groups of parameters: 

•   Readings (Instantaneous Voltage; Instantaneous Current; Total and Per Phase 

Power and Power Factor; Frequency; Neutral Current; Symmetrical Components 

and Voltage Imbalances)

•   Demand (Current; Per Phase, Total Power and Power Factor)

•   THD (For Voltage and Current)

2. The bottom of the screen shows the Full Scale values for:

•   Voltage

•   Current

•   Frequency

•   Power

•   Power Total

•   Power Factor
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•   THD

3. To set or change a Limit:

a. Select a limit by double-clicking on the Assigned Channel field.

b. You will see the screen shown below. 

c. Select a Group and an Item for the Limit.

d. Click OK. The Limit you selected will now appear in the Limits screen.

3. To configure a Limit, double-click on the following fields to set their values:

•   Above and Below Set Point: Percent of Full Scale (the point at which the reading 

goes out of limit: see figure on the next page).

For example: 

100% of 120V Full Scale = 120 V

90% of 120V Full Scale = 108 V
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•   Above and Below Return Hysteresis (the point at which the limit’s status 

changes from out of limit to within limit: see figure below).

For example, with a 120 V Full Scale: 

• Above Set Point = 110% of Full Scale (Out of Limit above 132 V)   

• Below Set Point = 90% of Full Scale (Out of Limit below 108 V)

• Above Return Hysteresis = 105% of Full Scale (Stay Out of Limit until 
below 126 V)

• Below Return Hysteresis = 95% of Full Scale (Stay Out of Limit until 
above 114 V)

    NOTES: 

•   The Primary fields are display only. They show what the set point and return 

Hysteresis value are for each limit.

•   If the Above Return Hysteresis is greater than the Above Set Point, the Above 

Limit is Disabled; if the Below Return Hysteresis is less than the Below Set Point, 

the Below Limit is Disabled. You may want to use this feature to disable either 

the Above Limit or Below Limit condition for a reading.

•   If you are entering negative limits, be aware that the negative value affects the 

way the above and below limits function, since negative numbers are processed 

as signed values.

4. To implement any changes, click the Update Device button to send the new profile 

to the meter.

TIME

Above Limit 
condition

Below Limit 
condition

Above Limit Trigger point

Return point from Above Limit  condition

Below Limit Trigger point

Return point from Below Limit  condition

HYSTERESIS

HYSTERESIS

- MEASURED VALUE
(if applicable)

+ MEASURED VALUE

0
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8.3.2: Configuring Waveform/PQ (Shark® 200 Meter Only, with
            V-Switch™ Key 5 and Higher)

The Shark® 200 meter is V-SwitchTM key upgradeable. If you have purchased V-

SwitchTM keys 5 or 6, the waveform recording feature will be available with your 

meter. The Waveform/PQ capability allows the meter to act as a high-speed waveform 

recorder to record any anomaly that occurs within a cycle of duration. This provides a 

user with advanced waveform analysis including pre- and post- waveform recording. 

The meter has the capability to record both surges and sags of the measured signals. 

A voltage surge is any event that increases the RMS voltage for one cycle, calculated 

every half cycle. A voltage sag is a dip in the RMS of one cycle of voltage, calculated 

every half cycle. A current fault (or surge) is also calculated in the same manner. 

When the RMS value of any of these triggers exceeds the threshold settings, the 

meter will trigger a waveform capture.

This setting determines at what point the meter executes a waveform capture and/or 

records a power quality event. See Chapter 19 for instructions on viewing Waveform 

and PQ logs. See 8.4.2: Configuring Historical Log Sectors, on page 8-35 for instruc-

tions on configuring the log sectors for the Shark® 200 meter.

NOTE: PQ and Waveform Thresholds are given as a percentage of the Full Scales ( 

Full Scale fields). Full Scales are based on the CT and PT Ratios set in the CT, PT 

Ratios and System Hookup setting. Before programming the Waveform/PQ Thresh-

olds, set the CT and PT ratios. See 8.1.1: Configuring CT, PT Ratios and System 

Hookup, on page 8-2, for instructions. 
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1. From the Tree Menu, click Power Quality and Alarm Settings>Waveform/PQ. The 

current settings, if any, are shown in the screen.

2. Set the Surge and Sag Setpoints (in percent of Full Scale), for Voltage, and the 

Surge Setpoint for Current. When you enter the percentage for a reading, the pri-

mary value is displayed in the Primary field. The bottom of the screen displays the 

Full Scales for Voltage and Current.

3. Click the checkbox under PQ to enable PQ recording when the programmed thresh-

old is exceeded.

4. Click the checkbox under Waveform to enable Waveform recording when the pro-

grammed threshold is exceeded.
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5. Select the sampling rate from the Capture Sample Rate pull-down menu. The 

options are: 

•  For V-Switch™ key 5: 32, 64

•  For V-Switch™ key 6: 32, 64, 128, 256, 512.

6. From the Pre-trigger pull-down menu, select the number of cycles of waveform 

data prior to the triggering event, that you want to be included in the waveform 

capture. The options are 2 to 63.

NOTE: Increasing the number of pre-cycles will decrease the number of cycles of 

data recorded after the event.

7. To implement any changes, click the Update Device button to send the new 

profile to the meter.
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8.4: Trending Profiles Settings

From the Tree Menu on the left side of the Shark® 200/200S meter’s Device Profile 

screen, double-click on the Trending Profiles Settings line or click on the + button next 

to it. All of the settings in the Trending Profiles Settings group are listed.

8.4.1: Configuring Historical Logs

Use this setting to select the parameters to be stored in each of the Shark® 200/

200S meter's three Historical Logs. For additional information on logs, including using 

the HHF Converter, see Chapters 16 and 19.

Functional Overview of Historical Logs:

The Shark® 200/200S meter allows a user to set up 3 separate historical profile logs 

that can log up to 64 parameters. Each of these logs can log at different time frames. 

For example, one log can be set for one minute intervals to record voltage; while 

another log can be set for 15 minute intervals for energy consumption logging.
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Having three historical logs additionally affords you the flexibility of programming 

each log with unique parameters. For example, you might program Historical Log 1 to 

record Power Quality parameters (for example, THD - Shark® 200 meter only), Log 2 

to record Demand parameters, and Log 3 to record Energy parameters. 

Historical Log parameters can be selected from eleven groups:

•  Measured Values (Instantaneous Voltage; Instantaneous Current; Total and Per 

Phase Power and Power Factor; Frequency; Neutral Current; Symmetrical Compo-

nents and Voltage Unbalances)

•  Demand (Current; Per Phase, Total Power and Power Factor)

•  Maximums (Maximum values for all of the readings listed above, including THD 

voltage and currents)

•  Minimums (Minimum values for all of the readings listed above, including THD volt-

age and currents)

•  Energy (Watt-hours, VA-hours, VAR-hours, Energy in the Interval)

•  Accumulators (Input and Output Accumulator values)

•  Short Term Min (Min value within the Demand Interval)

•  Short Term Max (Max value within the Demand Interval)

•  Uncompensated (Watt-hours, VA-hours, VAR-hours, Total Power, PF)

•  THD (For voltage and current) - Shark® 200 meter only

•  Harmonic Magnitudes (For voltage and current up to the 40th order) - Shark® 200 

meter only

•  Harmonic Phase Angles

•  Rollover Counters

•  Phase Angles
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1. From the Tree Menu, click Trending Profiles>Historical Log Profile (1-3). 

This screen allows you to select items to be stored in the historical log you selected. 

The Group field determines the items that are available for selection.

2. Select a Group. The possible selections are: Measured Values, Demand, Maxi-

mums, Minimums, Energy, Energy in the Interval, Accumulators, Short Term Min, 

Short Term Max, Uncompensated, THD (Shark® 200 meter only), Harmonic Magni-

tudes (Shark® 200 meter only), Harmonic Phase Angles (Shark® 200 meter only), 

Rollover Counters, and Phase Angles. (See 8.5.2: Configuring a Relay Output/Digi-

tal Input Card, on page 8-41 and 8.5.3: Configuring a Pulse Output/Digital Input 

Card, on page 8-46, for information on Accumulators). 

    NOTE: If you select Harmonic Magnitudes, another field opens on the screen allow-

    ing you to select one of the following for Harmonic Magnitude: Volts A; Volts B;

    Volts C; I A; I B; I C. 
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3. Select items for your log:

a. Highlight the item(s) you want in the Selectable Items box.

b. Click Add. The item(s) are added to the Selected Items box.

c. To remove item(s), highlight them in the Selected Items box and click 

Remove.

4. Set the Logging Interval (Minutes). The available choices are: 1, 3, 5, 10, 15, 30, 

60, EOI (End of Interval) Pulse (Shark® 200 meter only). The Logging Interval 

determines when the meter takes a snapshot.

IMPORTANT! If you are trending Energy in the Interval, the Logging interval must 

be the same as the Demand interval.

    NOTES: 

•   Only one of the following can be set for the EOI pulse feature: 

• EITHER 1 Option card input can be set to receive an EOI pulse from 

another device

• OR 1 Option card output can be set to trigger an EOI pulse

•   The maximum rate for EOI Pulse used to trigger a log is once per minute.

•   When you choose EOI Pulse, the meter takes a snapshot when the pulse is 

either received or generated (depending on whether the EOI pulse is assigned to 

an input or output), rather than on a time interval. 

NOTE: There are two display fields at the bottom of the Historical Log Profile screen. 

They show the Total Bytes Used and the Bytes Remaining for this historical log. These 

fields are updated as you make selections on the screen. The total number of bytes 

available per log record is approximately 234.

5. To implement any changes, click the Update Device button to send the new 

profile to the meter.
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8.4.2: Configuring Historical Log Sectors 

The Shark® 200/200S meter allows a user to configure the amount of memory allo-

cated for each log, so you can optimize the number of records stored for each log.

•  For V-Switch™ keys 2 and above, use this setting to increase or decrease the 

amount of records each of the Shark® 200/200S meter's three Historical logs can 

store, and the duration each log can run, before becoming filled. This allows a user 

to set the amount of memory allocated per log for the amount of recording days 

desired before the memory fills and gets rolled over.

•  For V-Switch™ keys 5 and 6 (Shark® 200 meter only), use this setting to set the 

allocation for the Waveform and Power Quality (PQ) logs, as well as for the Histori-

cal logs.

1. From the Tree Menu, click Trending Profiles>Historical Log Sectors.



     Doc#    E107707                                              8 - 36

8: Shark® 200/200S Meter

     If your Shark® 200 meter is equipped with V-Switch™ Key 2-4, or the standard

     Shark® 200S V-Switch™ key, you will see the screen shown on the previous page.

     If it is a Shark® 200 meter equipped with V-Switch™ Keys 5 or 6, you will see the

     screen shown below. Both screens are color-coded for ease of use. The color key is

     shown in the box(es) labeled Historical Logs and Waveform/PQ Logs.

•  The first screen shows the current space allocation for the Shark® 200/200S 

meter's three Historical logs, including:

•  The number of bytes allocated to each log

•  The number of records available for each log

•  The duration of each log.

•  The second screen shows the same information, along with the current space 

allocation for the Waveform/PQ Logs, including:

•  The number of bytes allocated to each log
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•  The number of captures that can be made before the log rolls over and 

data is rewritten

•  The number of sectors allocated to the log.

2. To change the current allocation for a log:

a. Click on one of the double yellow lines dividing the individual logs. 

b. You will see a line with arrows on each side. Drag the line in either direction 

to increase or decrease the log allocation. The display fields for the logs will 

reflect any changes you make to the allocation.

  NOTES: 

•  The Waveform log must have at least 3 sectors allocated to it.

•  When EOI Pulse is set as the Logging Interval for a Historical log (see 8.4.1: Con-

figuring Historical Logs, on page 8-31), the Log Duration field for that log will be 

blank.

3. To implement any changes, click the Update Device button to send the new profile 

to the meter.
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8.5: Configuring Option Cards (Shark 200® Meter Only)

The Shark® 200 meter automatically detects the presence of any Option cards 

installed in it. You will see the installed card(s) listed in the Tree Menu (see the figure 

below). Up to two Option cards can be installed in the Shark® 200 meter. Refer to the 

meter’s Installation and Operation Manual for additional information concerning 

Option cards, including installation procedures. The Shark® 200S form does not 

accommodate these Option cards.

You must configure an Option card before using it. The following sections give   

instructions for configuring each of the Option cards. 

NOTE: You can configure settings for an Option card when you are not connected to a 

meter. Click Option Card 1 or 2 from the Shark® 200 meter's Device Profile screen. 

The drop-down menu on the displayed screen allows you to select your Option card. 

The available selections are: Fiber Optic, Network, Digital Relay, Pulse Output, Analog 

Output (0-1mA), Analog Output (4-20mA), Network IEC61850 (INP300S), None. Click 

Apply. The Option card you chose is now listed in the menu. Refer to the instructions 

for configuring the card.

From the Tree Menu on the left side of the Shark 200 meter’s Device Profile screen, 

double-click on the Option Card 1 or Option Card 2 line or click on the + 

button next to it. The settings for the option card(s) installed in your meter are 

shown.
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Option Card Screens:

The type of Option card installed in the meter determines the settings you need to 

configure, and so, the screens you see. Click on the selectable lines under your Option 

card in the Shark® meter's Device Profile menu. See the example below. 

NOTE: The Option card settings for your meter will only show the option cards 

currently installed in your meter.

8.5.1: Configuring a Fiber Optic Card

The Fiber Optic Option Card is a Communication card that provides a standard, serial 

communication port over a fiber optic application. For technical specifications and 

hardware installation, refer to the meter’s Installation and Operation Manual.

Example:

An example use of the optional Fiber Optic card is in a daisy chain topology, using the 

Echo switch on the Fiber Optic Card to allow messages to bypass the unit.

Type of 
Option 
card

Card 

Card
Name

Card
Settings
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1. From the Option Card menu, click Comm>Fiber Optic.

2. The screen fields and acceptable entries are as follows:

•   Address: 1 - 247 (Modbus); 1-65520 (DNP)

•   Protocol: Modbus RTU; Modbus ASCII; DNP subset 2; DNP subset 3

•   Baud Rate: 9600; 19200; 38400; 57600

•   Data Bits: 5; 6; 7; 8

•   Parity: None, Odd, Even

•   Stop Bits: 1 or 2

•   Response Delay (msec): the suggested delay is 50 msec, but you can increase 

the delay, if necessary.
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3. To implement any changes, click the Update Device button to send the new 

profile to the meter.

8.5.2: Configuring a Relay Output/Digital Input Card

The Relay Output/Digital Input card is used for a few purposes. The relay portion is 

used to send a control output when a limit is exceeded. The input portion can be used 

to either count KYZ pulse or detect the status of a circuit.

The Relay Output/Digital Input Option Card has:

•  Two relay contact outputs for load switching 

•  Two wet/dry contact sensing digital inputs. 

Accumulators in the CommunicatorPQA® software count the transitions of the Inputs 

and Outputs. For technical specifications and hardware installation, refer to the 

meter’s Installation and Operation Manual.

NOTE: When installing a Relay Output/Digital Input card, we recommend you reset 

the accumulators for the card, in order to prevent erroneous counts. See Chapter 20 

for instructions on using the Reset Shark Information screen to reset card accumula-

tors.
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Example:

An example use of the optional Relay Card is in monitoring the status of circuit break-

ers or relays in your electrical system. The two status inputs could be used to monitor 

two circuit breakers, and the two relay outputs could be used to sound an alarm upon 

the occurrence of a programmed out of limit condition.

1. From the Option Card menu, click Relay Output and Digital Input>Relay Assign-

ments to set the limits/alarm conditions and logging options for the card's Relay 

Outputs. 

2. From the Relay Assignments screen, you can:

•  Configure up to 8 output conditions for the two Relay Outputs. Note that the 

Limits used are configured in Power Quality and Alarm Settings>Limits.

•  Set a Delay and Reset Delay for the Outputs.
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•  Choose to log Status Changes for each Relay Output.

•  Assign each Output an Output Label, Open Label, and Closed Label, which are 

used when viewing the Relay Status Log.

•  Assign an Accumulation Compression Factor for each output. 

IMPORTANT! First use the Limits screen to set up the limits you want to assign to an 

Output. See 8.3.1: Configuring Limits, on page 8-25 for instructions.

3. The available Limits appear in the Limit ID column. To assign a limit to an Output 

relay:

a. Select the output condition from the pull-down menu next to the Limit ID. 

The options are: Above Limit (the Output is triggered when the Above Limit 

condition occurs) and Below Limit (the Output is triggered when the Below 

Limit condition occurs). 

b. You can assign the limit to one or both (or neither) of the Relay Outputs.

NOTE: A Relay changes its state when any one assigned Limit is tripped, 

and stays in the Set condition as long as one Limit is in the Alarm state.

4. You can enter Set Delay and/or Reset Delay. These values are the delay before the 

Output is changed: Set is when the common is shorted to Normal Open (this is the 

Set Condition), Reset is when the Output is shorted (closed).

5. Check the box next to Log Status Change for if you want to log output status 

changes for either or both Relay. See Chapter 19 for information on the I/O Change 

Log.

6. The current Output Labels are displayed in the screen. These labels are used for 

Logging. To change the Output labels, click in the Labels field you want to change, 

and enter a new label. The fields that can be changed are:

•  Output Label - Label ID

•  Open Label - Open state ID

•  Closed Label - Closed state ID
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7. You can specify an Accumulation Compression Factor. The Compression Factor is 

used to adjust how high an accumulator will go before rolling over. Because of this, 

it is useful in delaying rollover. For example, if you select a Compression Factor of 

10, each time 10 Pulse/State changes occur, the accumulator count increments by 

1. The available Compression Factors are: 1, 10, 100, 1000, 10000, and 100000. 

The default Compression Factor is 1.

8. To configure the Digital Inputs: 

a. From the Option Card menu, click Relay Output and Digital Input>Digital 

Input Settings. Use this screen to assign labels and functions to the Inputs. 

b. Make a selection in the Assigned to field. The available selections are: 

• Status Only - select this to use the digital inputs just to indicate if the 

state is open or closed.
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• Accumulator - select this to use the digital input as a pulse counter.

• Digital Input Log - select this to use the digital input to trigger an entry in 

the I/O change log.

• EOI Pulse - only one Input can be set to receive an EOI pulse.

NOTES on End of Interval (EOI): 

• EOI is triggered in a device when the programmed condition is met. 

Only one Option Card input can be set to receive an EOI pulse. EOI is 

used for the following:

• As a trigger for demand averaging: the received EOI pulse delin-

eates an interval that results in demand averaging being performed. 

The minimum interval between received EOI Pulses used to trigger 

demand averaging should be 5 minutes. An EOI pulse allows the 

meter to be synchronized with an installed revenue meter, so that 

both meters are calculating Demand at the same time. When an 

Input is assigned to EOI, the demand interval is now the time 

between two received pulses.

• For historical logging: when the EOI pulse is received, it causes any 

log that has been configured for EOI Pulse interval to capture a 

record. Refer to 8.4.1: Configuring Historical Logs, on page 8-31, for 

additional information on EOI Pulse and logging.

c. Select Trigger from the pull-down menu. The Trigger you select depends on 

your Assigned to selection:

•  For Status Only, select None.

•  For Accumulator, select from Closing, Opening, High Speed Closing or 

High Speed Opening. 

NOTE: Only one accumulator can be assigned to a High Speed Trigger.

•  For Digital Input Log, select Change.

•  For EOI Pulse, select from Closing, Opening, or Change.
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d. Enter Units/Count. The Units/Count is the output ratio from the device that 

is being input into the Shark® 200 meter. For example, if you have a KYZ 

module that is outputting a pulse every 1.8 kWh, with the input set to 

Accumulator, Increment on Contact Opening, you would set the Units/

Count to be the value of the KYZ; in this case either 1.8 or a ratio of that 

number.

e. Enter Compression. The Compression Factor is used to adjust how high an 

accumulator will go before rolling over. For example, if you select a Com-

pression Factor of 10, each time 10 Pulse/State changes occur, the accu-

mulator count increments by 1. The available Compression Factors are: 1, 

10, 100, 1000, 10000, and 100000. The default Compression Factor is 1.

f. Enter a Label for the Accumulator.

g. The current Input Labels are displayed in the screen. To change the Input 

Labels, click in the Labels field you want to change, and enter a new label. 

The fields that can be changed are:

•  Input Label - Input ID

•  Open Label - Open state ID

•  Closed Label - Closed state ID

9. To implement any changes to the Relay Output/Digital Input card settings, click the 

Update Device button to send the new profile to the meter.

8.5.3: Configuring a Pulse Output/Digital Input Card

The Pulse Output/Digital Input card is similar to the Relay Output/Digital Input card 

except that the card contains 4 pulse output contacts (Form A, closing) instead of 

relay control outputs. These solid state output contacts can be configured to have the 

meter pulse out for user-assigned energy values. The Pulse Output/Digital Input 

Option Card has:

•  Four Pulse Outputs via solid state contacts

•  Four wet/dry contact sensing digital inputs.
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Accumulators in the CommunicatorPQA® software count the pulses of Inputs and 

Outputs. For technical specifications and hardware installation, refer to the meter’s 

Installation and Operation Manual.

NOTE: When installing a Pulse Output/Digital Input card, we recommend you reset 

the accumulators for the card, in order to prevent erroneous counts. See Chapter 20 

for instructions on using the Reset Shark Information screen to reset card accumula-

tors.

Example:

An example use of the Pulse Output/Digital Input Card is in a sub-metering applica-

tion where a pulse output is needed. The Input Accumulator allows you to count the 

pulses from another device, for example, a KYZ module or another meter. The Output 

Accumulators allow you to count the pulses being output by the card.

The Pulse Output and Digital Input Card has two screens for configuration: the Pulse 

Output Settings screen and the Digital Input Settings screen. 
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1. From the Option card menu, click Pulse Output and Digital Input>Pulse Output 

Settings. 

2. You can set up to four Output IDs for your Card. Each Output has a Label, an 

Assigned Channel, and a Unit/Count. Double-click an Assigned Channel field to add 

or edit an Output ID. You will see the window shown below.

3. Select the Counter Type. The available selections are:
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•  Energy, All Phases 

•  End of Interval Event - this counter is triggered by a Demand Averaging Interval

•  Energy, Phase A

•  Energy, Phase B

•  Energy, Phase C

•  None. 

NOTE: If you select one of the Energy Counter Types, you will see the Energy 

Counter field. The available selections are: Total Watt Hour; Positive Watt Hour; 

Negative Watt Hour; Total VAR Hour; Positive VAR Hour; Negative VAR Hour; VA 

Hour; Received Watt Hour; Delivered Watt Hour; Inductive VAR Hour; Capacitive 

VAR Hour.

IMPORTANT! The values are based on one toggle instance, when the output changes 

from open to closed or from closed to open state.

4. Click OK. The Counter Type you selected displays in the Assigned Channel field of 

the Pulse Output Settings screen.

5. When you select the Assigned Channel, a value is entered for it in the Units/Count 

field. You can edit this field by double-clicking in it. The Units/Count is determined 

by the Secondary (the readings in the meter). For example, if you have a three-

phase meter with 600 Watts per element, for a total of 1800 Watts, the Units/Count 

field will be 1.8. That means that every 1.8 Watt-hours, the count will accumulate 

by 1, and each count will represent 1.8 Watt-hours. If you are using CTs that have 

a ratio of 1000 to 1, for example, the count will still increment every 1.8 Watt-

hours, but the count in that case will represent 1.8 Watt-hours times 1000, or 1800 

Watt-hours.

6. The current Output Labels are displayed on the screen. To change the Output 

labels, click in the Labels field you want to change, and enter a new label. 
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7. From the Option card menu, click Pulse Output and Digital Input>Digital Input 

Settings. Use this screen to assign labels and functions to the Inputs 

8.  Make a selection in the Assigned to field. The available selections are: 

•   Status Only - select this to use the digital inputs just to indicate if the state is 

open or closed.

•   Accumulator - select this to use the digital input as a pulse counter.

•   Digital Input Log - select this to use the digital input to trigger an entry in the 

I/O change log.
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•  EOI Pulse - only one Input can be set to receive an EOI pulse.

NOTES on End of Interval (EOI): 

• EOI is triggered in a device when the programmed condition is met. Only 

one Option Card input can be set to receive an EOI pulse. EOI is used for 

the following:

• As a trigger for demand averaging: the received EOI pulse delineates 

an interval that results in demand averaging being performed. The 

minimum interval between received EOI Pulses used to trigger demand 

averaging should be 5 minutes. An EOI pulse allows the meter to be 

synchronized with an installed revenue meter, so that both meters are 

calculating Demand at the same time.

• For historical logging: when the EOI pulse is received, it causes any 

log that has been configured for EOI Pulse interval to capture a record. 

Refer to 8.4.1: Configuring Historical Logs, on page 8-31, for additional 

information on EOI Pulse and logging.

9. Select Trigger from the pull-down menu. The Trigger you select depends on your 

Assigned to selection:

•   For Status Only, select None.

•   For Accumulator, select from Closing, Opening, High Speed Closing or High 

Speed Opening.

NOTES: 

• Only one accumulator can be assigned to a High Speed Trigger.

• High speed opening and closing would be used when monitoring pulses 

from water meters that can be pulsing very quickly. 

•  For Digital Input Log, select Change.

•  For EOI Pulse, select from Closing, Opening, or Change.
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10. Enter Units/Count. The Units/Count is the output ratio from the device that is

  being input into the Shark® 200 meter. For example, if you have a KYZ module

  that is outputting a pulse every 1.8 kWh, with the input set to Accumulator, Incre-

  ment on Contact Opening, you would set the Units/Count to be the value of the

  KYZ; in this case either 1.8 or a ratio of that number.

11. Enter Compression. The Compression Factor is a divider used to adjust how high

  an accumulator will go before rolling over. For example, if you select a 

 Compression Factor of 10, each time 10 Pulse/State changes occur, the accumula-

 tor count increments by 1. The available Compression Factors are: 1, 10, 100,

 1000, 10000, and 100000. The default Compression Factor is 1.

12. Enter a Label for the Accumulator.

13. The current Input Labels are displayed in the screen. To change the Input Labels,

  click in the Labels field you want to change, and enter a new label. The fields that

  can be changed are:

•  Input Label - Input ID

•  Open Label - Open state ID

•  Closed Label - Closed state ID

14. To implement any changes to the Pulse Output/Digital Input card settings, click

  the Update Device button to send the new profile to the meter.

8.5.4: Configuring a 0-1 mA Output Card

The 0-1mA Output Option Card is an analog output card, which transmits a standard, 

bidirectional 0-1 milliamp signal proportional to the value selected. This card mimics 

an analog transducer. With the Shark® design, the user can select any measured 

parameter to output on an analog transducer signal. For technical specifications and 

hardware installation, refer to the meter’s Installation and Operation Manual.

Example:

An example use of the optional 0-1mA Output Card is in enabling the Shark® 200 

meter to communicate with an RTU. 
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1. From the Option card menu, click Analog I/O>0-1 mA Output.

    You can set up to four Output IDs for your Output Card. 

2. Double-click an Assigned Channel field to add or edit an Output ID. You will see the 

window shown below.

3. Select Group for your Output Channel. The available selections are as follows:

•  Readings
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•  Demand 

•  MAximums

•  Minimums

•  Phase Angles

•  THD

•  Energy

4. Select Item for your Output Channel. The items are the available readings for the 

group you selected. For example, as shown in the window above, Volts A-N is an 

item you can select when you have selected Readings as the Group.

5. Click OK. The Output Channel you selected is displayed in the Assigned Channel 

field. 

6. Enter Low End and High End for the channel. 

NOTE: For the Item selected for the Assigned Channel, the Output Card takes the 

value in the meter and outputs a DC current within its range. The Low End is the 

lowest value, and the High End is the highest value. For example, for VOLTS A-N 

and Bidirectional Mode, at Nominal of 120V, the Low End is set to 115V and the 

High End is set to 125V. The Analog Output Card will output -1 mA when the read-

ing is 115V, 0 mA when the reading is 120V, and 1 mA when the reading is 125V. 

The analog card can output below -1mA and above +1mA, proportionally to VOLTS 

A-N. For limiting values refer to the meter’s Installation and Operation Manual's 

applicable section.

7. You can select either Unidirectional or Bidirectional for Mode. Unidirectional mode is 

used for unsigned data, e.g., voltage; and bi-directional mode is used with signed 

data, e.g., Watts.

8. To implement any changes to the 0-1mA Output card settings, click the Update 

Device button to send the new profile to the meter.
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8.5.5: Configuring a 4-20 mA Output Card 

The 4-20mA Output Option Card is an analog communication card, which transmits a 

standard, unidirectional 4-20 milliamp signal. For technical specifications and hard-

ware installation, refer to the meter’s Installation and Operation Manual.

Example:

An example use of the optional 4-20mA Output Card is in enabling the Shark® 200/

200S meter to communicate with an RTU. 

1. From the Option card menu, click Analog I/O>4-20mA Output. 

2. Follow the instructions for configuring the 0-1 mA Card. The configuration of a 4-20 

mA Card is the same as a 0-1 mA Card, except that this card can only be unidirec-

tional, so there is no Mode setting.
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8.5.6: Configuring a Network Card 

The optional Network Card (INP100S) enables 10/100BaseT Ethernet communica-

tions. It also acts as a Web server, allowing the meter’s data to be viewed on a stan-

dard web browser. For technical specifications, hardware installation, and additional 

information on the Web server, refer to the meter’s Installation and Operation Manual.

NOTE: For information on configuring the Shark® 200S meter’s WiFi settings, see the 

Shark® 200S Meter Installation and Operation Manual.

Note that there are two versions of the INP100S card - a legacy version (Gen 1) and 

the Gen 2 version. You can tell which version your meter has by clicking Tools>Option 

Card Status from the CommunicatorPQA® Main screen - the Card Name field will say 

Network Card G2 for the Gen 2 card. See the example below. 

•  The settings for both versions of the cards are almost identical.
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1. From the Option Card 1 or Option Card 2 menu, click Comm>Network>IP Address 

and DNS.   

This screen lets you configure the IP Address, DNS, and Network Time Protocol 

Server for the card.

2. Enter the following information:

•  Computer Name: for the Gen 2 INP100S card, valid characters for computer 

name/hostname are ASCII(7) letters from a to z, the digits from 0 to 9, and the 

hyphen (-).

•  Either click the DHCP box to enable a DHCP server to assign the IP address for 

your network card or enter the following for the network card:

•  IP Address

•  Subnet Mask
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•  Default Gateway

NOTE: If no mask is entered (blank) or 0.0.0.0 is used, the network card 

will use an automatic mask based on the network address class, or will 

not apply a mask, according to the following table:                 

•  Domain Name Server Address(es): enter any system DNS addresses.

•  Server Name/IP Address: enter the server URL or IP address of the NTP server 

you are using. 

NOTE: The Network Time Protocol server is used for clock synchronization. It 

can be either a device with a real-time clock that is networked with your meter, 

or an NTP server on the Internet. 

IMPORTANT! You must also enable Clock Synchronization in the Time Settings 

screen (see 8.1.2: Configuring Time Settings, on page 8-5).

Network Class Address range Mask used

Class A 1.0.0.0-127.x.x.x 255.0.0.0

Class B 128.0.0.0-191.x.x.x 255.255.0.0

Class C 192.0.0.0-223.x.x.x 255.255.255.0

Other classes No masking will be applied
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3. Click Comm>Network>Services & Security. 

•  You will see the screen shown below if your Network card’s Firmware version is 

3.42 or lower.
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•  If your Gen 1 Network card’s Firmware version is 3.43 or higher or if you have a 

Gen 2 Network card, you will see the screen shown below:

4. This screen allows you to disable certain features of the meter’s Ethernet connec-

tion, for security purposes: 

•   The HTTP Web Server can be disabled, or its default port can be changed. 

•   The Modbus TCP server can be shut down, or its default port can be changed. 

•   The Alarm Email and Notification feature of the Network card can be disabled. 

Note that the network card’s firmware must support alarm and notification email 

for this feature to be available. The settings for the alarm/notification email 

feature are made using the card’s Web server. See the Shark 200 Meter Installa-

tion and Operation Manual for instructions.

• If the port entered is less than “10,” the standard port is used: 80 for 

Web Server and 502 for Modbus TCP Server. 

• To disable one of the servers, uncheck the box next to it.
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•  When the Security feature “Silent Mode” is enabled, the meter will totally ignore 

incoming connections, in such a way that not even TCP/IP Reset packets will be 

sent. When “Silent Mode” is disabled, the meter follows standard TCP/IP proce-

dures for incoming connections to unused ports. This feature is useful in pre-

venting hacking (attempted security intrusions).

•  Network Firmware version 3.43 and higher supports the Exclusive Client feature.

• For the Gen 1 INP100S card, this feature lets you prioritize an IP and/or 

MAC address. When that address is used to connect to the meter, all 

other network communication with the meter, through the same Network 

card, is suspended. This ensures that anything being done, e.g., updating 

programmable settings, while the prioritize address is being used to com-

municate with the meter, is secure. 

• For the Gen 2 INP100S card, the IP and/or MAC address entered in the 

Exclusive Client fields is the only address that will be allowed to communi-

cate through this network card.

a. Enter the IP address or MAC address you want to establish as the Exclusive 

Client.

NOTE: To disable the exclusive Client feature, set the IP address and MAC 

address to all zeros.

        NOTES: 

• If you do not know this information, contact your Systems Administrator.

• See Chapter 25 for instructions on updating the Network card's firmware.
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5. Click Comm>Network>DNP Support if you want to set up DNP over Ethernet for 

the Network Card. You will see the screen shown below.

This screen lets you set up a DNP Server gateway for the Network Option card. This 

gateway enables DNP3 protocol communication over Ethernet, for the meter. 
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6. Make the following settings:

a.  Enable DNP Support: by default the DNP server support is disabled. Check 

the box to enable it. Once it is enabled, the other parameters can be 

entered.

b.  DNP Server Port: this is the TCP/IP port where the meter’s Network card 

unit will be listening for incoming connections via the DNP protocol. Valid 

numbers are from 10 to 65534. We recommend that you set a value over 

1024, because most of the lower numbers are reserved, or are already 

allocated to other popular services. If you set a port number of less than 

10, the network card will set the port to its default, which is 20000.

c.  DNP Device Address: this is the meter’s configured address; currently, this 

setting should be 1.

d.  IP Address Start/End: this setting implements Internet security by letting 

you specify a range of IP addresses that are authorized to connect to the 

DNP port. Any requester with an IP address outside of this range will be 

rejected. Enter the range in the start and end fields. To disable the IP range 

restriction, write 0.0.0.0 in the start field and 255.255.255.255 in the end 

field. 

An example of a range is 172.20.167.100 in the start field and 

172.20.167.150 in the end field. That would authorize connection to the 

DNP port for any IP address from 172.20.167.100 up to and including 

172.20.167.150.

e.  TCP/IP Port Start/End: you can also use this setting to implement Internet 

security through specifying a range of authorized ports. Any requester 

originating the connection from a port outside of this range will be rejected. 

Enter the range in the start and end fields (valid port ranges are from 0 to 

65535). Set the start port to 0 and the end port to 65535 to disable the 

port range restriction.

7. To implement any changes to the Network card settings, click the Update Device 

button to send the new profile to the meter.
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8.5.7: Configuring an IEC 61850 Network Card 

The optional IEC 61850 Network Card (INP300S) enables both 10/100BaseT Ethernet 

communication and communication in an IEC 61850 substation automation applica-

tion. It also acts as a Web server, allowing the meter’s data to be viewed on a stan-

dard web browser. For technical specifications, hardware installation, and additional 

information on the Web server, refer to the meter’s Installation and Operation Manual.

1. From the Option Card menu, click Comm>Network>IP Address and DNS. You will 

see the screen shown below. It allows you to configure the IP Address, DNS, and 

Network Time Protocol Server for the card.
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2. Enter the following information:

•  Computer Name: Either click the DHCP box to enable a DHCP server to assign 

the IP address for your network card or enter the following for the network card:

•  IP Address

•  Subnet Mask

•  Default Gateway

NOTE: If no mask is entered (blank) or 0.0.0.0 is used, the network card 

will use an automatic mask based on the network address class, or will 

not apply a mask, according to the following table:                 

•  Domain Name Server Address(es)

•  URL address of a Network Time Protocol server if you are using one. 

NOTE: The Network Time Protocol server is used for clock synchronization. It 

can be either a device with a real-time clock that is networked with your meter, 

or an NTP server on the Internet. 

IMPORTANT! You must also enable Clock Synchronization in the Time Settings 

screen (see 8.1.2: Configuring Time Settings, on page 8-5).

Network Class Address range Mask used

Class A 1.0.0.0-127.x.x.x 255.0.0.0

Class B 128.0.0.0-191.x.x.x 255.255.0.0

Class C 192.0.0.0-223.x.x.x 255.255.255.0

Other classes No masking will be applied
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3. From the Option Card menu, click Comm>Network>Services & Security. You will 

see the screen shown below.

 This screen allows you to enable/disable certain features of the meter’s Ethernet

 connection, for security purposes: 

•   The HTTP Web Server can be disabled, or its default port can be changed. 

•   The Modbus TCP server can be shut down, or its default port can be changed. 

•   To enable IEC 61850 protocol communication, make sure that option is checked. 

If you want all energy values to be represented as positive, check that box as 

well.

•   To disable one of the servers, uncheck the box next to it.

•   When the Security feature “Silent Mode” is enabled, the meter will totally ignore 

incoming connections, in such a way that not even TCP/IP Reset packets will be 

sent. When “Silent Mode” is disabled, the meter follows standard TCP/IP proce-
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dures for incoming connections to unused ports. This feature is useful in pre-

venting hacking (attempted security intrusions).

3. To implement any changes to the Network card settings, click the Update Device 

button to send the new profile to the meter.
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This chapter explains how to configure a Shark® 100/100B/100S/50 meter's 

programmable settings, which are stored in the unit's Device Profile. Chapter 7 

contains detailed information on how to use the Device Profile.

9.1: Device Profile Settings

All of the Shark® 100/100B/100S/50 meter's Device Profile settings are accessed 

from the tabs at the top of the Device Profile screen.
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9.1.1: Configuring Scaling Settings

The first screen you see is the CT, PT Ratios and System Wiring screen, shown on the 

previous page (to return to this screen from another screen, click the Scaling tab). 

Use this setting to configure Current Transformer and Potential Transformer ratios and 

to select the System Hookup. 

Functional Overview of CT and PT Ratios:

Current and Potential Transformers are used mainly for the following reasons:

•  To insulate, and as a result isolate, the meter from high-voltage circuits.

•  To change the primary voltage and current to standard values and sizes that the 

meter can measure.

The CT and PT transformers deliver fractions of the primary voltage and current to the 

meter. With properly set ratios and multipliers, the readings of the meter can be used 

to determine the energy, voltage, current, or power of the system. 

to determine the energy, voltage, current, or power of the system. 

IMPORTANT! You have two options for entering the CT and PT settings. You can 

either enter CT/PT Numerator, Denominator, and Multiplier manually (see instructions 

below), or you can enter the Ratios for CT/PT Numerator and Denominator and click 

the Update CT/Update PT buttons to let the software calculate the Numerator, 

Denominator, and Multiplier for you. You can then empty the Ratio fields and click the 

Update Ratio buttons to confirm the calculated settings: you will see the same ratios 

you initially entered.

NOTE: Some ratios cannot be represented in the Shark® 100 meter. The software 

will try to find the closest value, in that case.

1. For manual entry, make these settings:

•   CT Ratios

• CT Numerator (Primary): 1 - 9999

• CT Denominator (Secondary): 5 or 1 Amp 

 NOTE: This field is display only. The meter is ordered as a 5 Amp or 1 

Amp Current Secondary.
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• EITHER CT Multiplier (Scaling): 1, 10 or 100 

Multiplies the CT Numerator by this scale. The display can only read 4 

digits, or 9999. Above that range the number must be multiplied to have 

it read K or M values.

• OR Ratio: the ratio to be applied, and click Update CT 

• Current Full Scale: Display only 

•   PT Ratios

• PT Numerator (Primary): 1 - 9999

• PT Denominator (Secondary): 1 - 9999

• PT Multiplier (Scaling): 1, 10, 100, or 1000

• Voltage Full Scale: Display only 

•   System Wiring

• 3 Element Wye; 2.5 Element Wye; 2 CT Delta

This value must be set properly for the meter to calculate readings 

correctly.

•   Phases Displayed - this field determines which phases display on the faceplate. 

For example, if you select AB, only those two phases will be displayed on the 

faceplate. 

• ABC; A; AB

Example Settings:

For a CT of 2000/5A, set the following CT Ratios in the entry fields:

CT Numerator (Primary)           2000

CT Denominator (Secondary)    5

CT Multiplier                            1

The Current Full Scale field will read 2000. 

For a system that has 14400V primary with a 120V secondary line to neutral (PT Ratio 

of 120:1), set the following PT Ratios in the entry fields:
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PT Numerator (Primary)  1440

PT Denominator (Secondary) 120

PT Multiplier    10

The Voltage Full Scale field will read 14.4k.

2. To implement any changes, click the Update button to send the new profile to the 

meter.

9.1.2: Configuring Energy and Display Settings

Use this setting to configure: 

•   The display and storage of Energy registers in the meter

•   The display of Power data in the meter 

•   The interval over which Average values are computed, as well as the Interval 

Energy 

•   Auto Scrolling and Display Configuration

Functional Overview of Energy Settings and Averaging:

•   Energy Scaling

Energy Setting includes:

Digits (the number of digits in the reading)

Decimals (the number of decimal places in the reading)

Energy Scale: the scale of the reading - unit; kilo (number times 1000); Mega 

(number times 1 million)

Energy settings allow you to balance the resolution (or accuracy) of the energy 

stored, with the interval over which energy rollover occurs. For example, the 

maximum resolution for a k scale reading is: 99999.999k.

To calculate the speed at which the energy will rollover, you must know the Power 

Full Scale, which is computed from the CT and PT Full Scale values (see Section 

5.3.3.1). The formula for calculating Power Full Scale is:

Wye system: CT Full Scale x PT Full Scale x 3 
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Delta system: CT Full Scale x PT Full Scale x 3 x 

For example, for a CT Full Scale of 2000, PT Full Scale of 14400, Wye system:

2000 x 14400 x 3=86400000

In this example, the energy will increment at 86400000 Watts per hour, or 24000 

Watts per second.

This value allows you to determine the number of digits, decimal places, and 

energy scale you want to configure for the Energy settings, when you take into 

account the rollover time. 

To determine the number of hours before rollover, use this formula:

[Max Resolution]/[Full Scale] = #Hours, where Max Resolution = maximum digits 

and decimals for the Energy scale in use. 

Using the example from above, with an energy scale of Mega, the formula would 

be:

99999.999 M/86.4 M = 1157.4074 hours or about 48 days until rollover. 

NOTE: To increase the number of days until rollover, you can increase the number 

of digits (to 8), decrease the number of decimal places (to 0), or increase the 

Energy Scale (to M).

•   Demand Averaging 

Demand is the average rate of energy use over time. The Shark® meter supports 

two types of demand averaging: Block demand and Rolling demand.

Block demand records the average demand for time intervals that you define (

usually 5, 15 or 30 minutes). 

Rolling demand functions like multiple, overlapping Block demands. You define the 

subintervals at which an average of demand is calculated. An example of Rolling 

demand would be a 15-minute Demand block using 5-minute subintervals, thus 

providing a new demand reading every 5 minutes, based on the last 15 minutes.

3
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1. From the Device Profile screen, click the Energy and Display tab.

2. This screen displays the current settings for Power and Energy Format, Demand 

Averaging, Auto Scrolling and Display Configuration. The screen fields and accept-

able entries are as follows:

•   Power and Energy Format

• Power Scale: Unit, kilo (k), Mega (M), Auto 

• Power Direction: View as Load or View as Generator; this controls how 

energy is accumulated in the Shark® meter. View as Load means the 

energy readings are accumulated as Whrs Received, View as Generator 

means the energy readings are accumulated as Whrs Delivered.

• Energy Decimal Places: 0 - 6

• Energy Scale: Unit, kilo (k), Mega (M)

• Example: Shows an example with the selected settings applied. Click the 

Recalculate button if you make changes and want to see an example.
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• Energy Digits: 5, 6, 7, 8

         NOTES: 

• The Energy Digits, Scale and Decimal Places settings determine how 

energy values are displayed. Refer to the Functional Overview at the 

beginning of this section for more information.

• If invalid values are entered, you will see the following warning 

message: "Warning: Current CT, PT and Energy Settings may cause

invalid energy accumulator values." Once you correct the values and

click the Recalculate button, this message goes away.

NOTE: Typically, this means that the energy rollover point is too low. Try 

increasing the number of energy digits, or changing to a higher scale.

• If you are changing the energy digits, decimal places, or energy scale,

we recommend you first reset the Energy Accumulators, in order to 

prevent erroneous counts. See Chapter 20 for instructions on resetting

the Shark® meter’s Energy Accumulators.

•   Demand Averaging (Refer to the Functional Overview at the beginning of this 

section for more information.)

• Average Method: Block or Rolling;   

• Interval: 5, 15, 30 or 60 Minutes

• Subinterval: 1, 2, 3 or 4

         NOTE: Block Average cannot have a Subinterval.

•   Auto Scroll Display

• Click the checkbox to turn auto-scrolling On and Off. Auto-scrolling 

controls the display of selected parameters on the meter's faceplate. 

Refer to the meter’s Meter Installation and Operations Manual for more 

information.

•   Display Configuration

• Some users may want to lock the meter to a particular faceplate display 

or series of displays. For example, if you would like the meter to act only 
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as a Volt meter, or only as an ammeter, the meter can be configured to 

display only the relevant screen. Use this setting to lock the display of the 

meter's faceplate to the specific combination you want. Refer to the 

meter’s Installation and Operation Manual for additional information on 

the faceplate.

• Check the boxes of the Readings you want displayed on the faceplate of 

the meter. If you make no selection, Amps are displayed by default.

        NOTE: The Auto Scroll Display and Display Configuration settings can be

        ignored for the Shark®100T/100BT transducer, since it doesn't have a display.

3. To implement any changes, click the Update button to send the new profile to the 

meter.

9.1.3: Configuring Communications Settings

Use this screen to enter communication settings for the meter's two on-board ports: 

the IrDA Port (COM 1) and RS485 Port (COM 2). Note that the Shark® 50 meter has 

an RS485 port, but no IrDA port, and the Shark® 100B meter has an IrDA port, but 

no RS485 port. The Shark® 100 and 100S meters have both the IrDA port and the 

RS485 port.

IMPORTANT! The settings on this screen are the current settings for communication. 

Any changes you make may affect communication between the Shark® meter and 

your PC.
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1. From the Device Profile menu, click the Communications tab.

2.The screen fields and acceptable entries are as follows:

•   COM 1 (IrDA)

• Response Delay: 0 - 750 (50msec increments)

•   COM 2 (RS-485)

• Address:1 - 247 (Modbus); 1-65520 (DNP)

• Protocol:Modbus RTU, Modbus ASCII or DNP3 (DNP3 protocol is only 

available with the Shark® 100 meter’s V-Switch key 3 or 4)

• Baud Rate: 9600, 19200, 38400, 57600 

• Response Delay: 0 - 750 (50 msec increments)

NOTE: Response Delay is the delay the meter should use before respond-

ing to queries. If your connecting device requires a delay before receiving 

information, use response delay to program the time to wait before the 

meter starts responding to queries.
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IMPORTANT! If your meter is a 100S with the Ethernet option, keep the 

RS485 factory settings shown in the screen capture.

•  The Set Com2 to Default button is used to restore the RS485 settings to their 

default values if necessary. The default settings are:

• Baud Rate:          57600

• Address:             001

• Protocol:             Modbus RTU

3. To implement any changes, click the Update button to send the new profile to the 

meter.

NOTE: For information on configuring the Shark® 100S meter’s WiFi settings, see the 

Shark® 100S Meter Installation and Operation Manual; for information on configuring 

the Shark® 100 meter’s optional Ethernet settings, see the Shark® 100/100T/100B/

50 Meters Installation and Operation Manual.

9.1.4: Configuring Settings

Use the Settings tab to set password protection, set up a meter ID, and change the 

meter’s V-SwitchTM key. 

You can enable or disable a Password for Resetting (Reset Max/Min Energy Settings, 

Energy Accumulators, and the Individual Logs) and Configuration (Device Profile) in 

the Systems Settings screen. 

Once password protection is enabled for the meter and the Device Profile is updated, 

anyone who attempts to make a change that is under password protection is 

prompted to enter the password. If the correct Password is not entered, the change 

doesn’t take place.

NOTE: If you enable a Password for Resetting, you must also enable it for Configura-

tion.
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1. From the Device Profile screen, click the Settings tab.

2. From this screen, you can do the following:

•   Enable or Disable Password for Reset and/or Configuration: click the checkbox 

next to the option. The Off changes to On and the box is checked. Enabling Pass-

word protection prevents unauthorized tampering with devices. 

        IMPORTANT! You must set up a password before enabling Password Protection.

       Click the Change button next to Change Password if you have not already set up

        a password. 

•   Change the Password: click the Change button. 

•   Change the V-SwitchTM key - see Chapter 20 for instructions.

•   Enter/change the Device Designation: input a new designation into this field.
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3. When you click the Change button next to Change Password in the Settings screen, 

you will see the Enter the New Password screen.

a. Type in the new password (0 -9999).

b. Retype the password.

c. Click Change. The new password is saved and you see the following mes-

sage window.

NOTE: If Password Protection has already been enabled for configuration and you 

attempt to change the password, you will see the Enter Password screen after you 

click Change. Enter the old password and click OK to proceed with the password 

change.

4. To implement any changes, click the Update button to send the new profile to the 

meter.
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9.1.5: Configuring Limit Settings (Shark® 100 or 100S, V4 Only)

 Use this screen to assign Limits for the Shark® 100/100S meter with V-SwitchTM key 

4. 

Functional Overview for Limits:

Limits are transition points used to divide acceptable and unacceptable measure-

ments. When a value goes above or below the limit, an out-of-limit condition occurs. 

You can set and configure up to eight Limits for the meter.

Once they are configured, you can view the out-of-Limits (or Alarm) conditions in the 

Limits Log (see Chapter 19) or Limits Polling screen (see Chapter 5). 

1. From the Device Profile screen, click the Limits tab.

2. Select the Limit you want to set from the pull-down menu. You can set up to eight 

limits.

Click to select a 
Limit
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3. Click the Change button to select a reading value for the limit.

4. A small window opens at the top of the screen. Click on the pull-down menu to 

select the reading you want to set the limit for - e.g., voltage a-n. The address field 

changes to contain the Modbus address of the reading you select, and the Full Scale 

field changes to contain the full scale value for the reading. (When you first display 

this screen, all of the limits have “meter name” as their default; the address field 

displays 1, which is the Modbus address of the meter name field; and the Full Scale 

field displays 0.)

•   The available readings are:

• Off (no limit is set)

• Volts phase to phase and phase to reference

• Amps A, B, C

• Total Watts, VAR, and VA

• Power Factor Total

2. Click to select
    the reading 

1. Click to select 
    a reading for
    the Limit
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• Frequency

• Whrs Received, Delivered, Net, and Total

• VARhrs Positive, Negative, Net, and Total

• VAhrs Total

• Amps per Phase Average/Minimum Average/

• + and - Watts and VARs Average

• VA Average

• + and - Power Factor Average

• Volts Phase to Phase and Phase to Reference Minimum/Maximum

• Amps per Phase Minimum Average/Maximum Average

• + and - Watts and VARs Minimum Average/Maximum Average

• VA Minimum Average/Maximum Average

• + and - Power Factor Minimum Average/Maximum Average

• Frequency Minimum/Maximum

• Current per Phase A, B, C

• Voltage Angles a-b, b-c, c-a

• Neutral Current

5. To configure the Limit, double-click in the following fields to set their values:

•   Above and Below Set Point: of Full Scale (the point at which the reading goes 

out of limit: see figure on the next page)

For example: 

100 of 120V Full Scale = 120V

90 of 120V Full Scale = 108V
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•  Above and Below Return Hysteresis (the point at which the limit’s status 

changes from out of limit to within limit: see figure below)

For example: 

Above Set Point = 110Below Set Point = 90

(Out of Limit above 132V)(Out of Limit below 108V)

Above Return Hysteresis = 105Below Return Hysteresis = 95

(Stay Out of Limit until below 126V)  (Stay Out of Limit until above 114V)

     NOTES: 

•   If the Above Return Hysteresis is greater than the Above Set Point, the Above 

Limit is Disabled; if the Below Return Hysteresis is less than the Below Set Point, 

the Below Limit is Disabled. You may want to use this feature to disable either 

the Above Limit or Below Limit condition for a reading.

•   If you are entering negative limits, be aware that the negative value affects the 

way the above and below limits function, since negative numbers are processed 

as signed values.

6. To implement any changes, click the Update Device button to send the new profile 

to the meter.

TIME

Above Limit 
condition

Below Limit 
condition

Above Limit Trigger point

Return point from Above Limit  condition

Below Limit Trigger point

Return point from Below Limit  condition

HYSTERESIS

HYSTERESIS

- MEASURED VALUE
(if applicable)

+ MEASURED VALUE

0
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10: Shark® MP200TM Metering System

This chapter explains how to configure a Shark® MP200TM metering system's pro-

grammable settings, which are stored in the unit's Device Profile. Chapter 7 contains 

detailed information on the Device Profile.

10.1: Device Profile General Settings

1. From the Tree Menu on the left side of the MP200TM metering system’s Device Pro-

file screen, double-click on the General Settings line or click on the + button next to 

it. All of the settings in the General Settings group are listed.

The MP200TM metering system comes in two types:

•   The MP200-Y - this version has eight three phase connections and provides an 

output for eight three phase meters.

•   The MP200-S - this version acts as a single phase meter providing an output for 

all 24 single phase circuits.
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NOTE: Many of the settings differ between the MP200-Y three phase configuration 

and the MP200-S single phase configuration. Instructions for both configurations are 

given when there are differences. 

Since the MP200-Y is a three phase meter, there are only eight sets of CT settings: 

one for each of the CTs needed for a single three phase circuit.

MP200 Unit with Three Phase Configuration - MP200-Y
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With the MP200-S there are 24 individual circuits being measured, and since the CTs 

can be different on all of them, each of the 24 CTs can be configured individually. 

    MP200 Unit with Single Phase Configuration - MP200-S
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10.1.1: Configuring CT, PT Ratios and System Hookup 

The first screen you see is the CT, PT Ratios and System Hookup screen, shown on the 

previous two pages (to return to this screen from another screen, click General 

Settings>CT, PT Ratios and System Hookup). Use this setting to configure Current 

Transformer and Potential Transformer ratios and to select the System Hookup. 

Functional Overview of CT and PT Ratios:

Current and Potential Transformers are used mainly for the following reasons:

• To insulate, and as a result isolate, the meter from high-voltage circuits.

• To change the primary voltage and current to standard values and sizes that the

meter can measure.

The CT and PT transformers deliver fractions of the primary voltage and current to the 

meter. With properly set ratios and multipliers, the readings of the meter can be used 

to determine the energy, voltage, current, or power of the system. 

1. Make your settings in the following fields:

• PT Ratios

• PT Numerator (Primary): 1 - 99999999

• PT Denominator (Secondary): 1 - 65535

• System Wiring

• 3 Element Wye; 2.5 Element Wye; 2 CT Delta

This value must be set properly for the meter to calculate readings 

correctly.

• CT Ratios

• CT Numerator (Primary): 1 - 65535

NOTE: This field is different for the MP200-Y and MP200-S: there are 8 

CT Numerator fields for the MP200-Y and 24 CT numerator fields for the 

MP200-S; in each case, one for each circuit.
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• CT Denominator (Secondary): 5 or 1 Amp

NOTE: This field is display only. The meter is ordered as a 5 Amp or 1

Amp Current Secondary.

2. To implement any changes, click the Update Device button to send the new

profile to the meter.
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10.1.2: Configuring Time Settings

Use this setting to enable or disable Daylight Savings Time for the meter and to set 

the beginning and ending times for Daylight Savings Time. This screen is the same 

whether you are connected to an MP200-Y or an MP200-S.

1. From the Tree Menu, click General Settings>Time Settings. 

2. Check the box to Enable Daylight Savings time, or un-check it to Disable Daylight 

Savings Time.

3. Use the entry fields to set the start and end times for the Daylight Savings Time 

feature, if enabled. Select the values you want from the Month, Week, Day of the 

Week, and Hour fields. You can click USA Daylight Savings to fill the fields with the 

current DST settings for the United States.

    NOTE: The Hour field uses a 24-Hour clock.
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4. To implement any changes, click the Update Device button to send the new 

profile to the meter.

10.1.3: Configuring System Settings

Use the system settings to set password protection and a meter ID. You can enable or 

disable a Password for Resetting (Reset Max/Min Energy Settings, Energy Accumula-

tors (three phase configuration only), and the Individual Logs) and Configuration 

(Device Profile) in the Systems Settings screen. This screen differs between the 

MP200-Y and MP200-S: the number of meter name fields is different (see the screens 

on the next two pages).

Once password protection is enabled for the meter and the Device Profile is updated, 

anyone who attempts to make a change that is under password protection is 

prompted to enter the password. If the correct Password is not entered, the change 

doesn’t take place.

NOTE: If you enable a Password for Resetting, you must also enable it for Configura-

tion.
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1. From the Tree Menu, click General Settings>System Settings. 

                           MP200-Y System Settings Screen
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2. From this screen, you can do the following:

•   Enable or Disable Password for Resetting and/or Configuration: click the radio 

button next to Yes or No. Enabling Password protection prevents unauthorized 

tampering with devices. 

IMPORTANT! You must set up a password before enabling Password Protection. Click 

the Change button next to Change Password if you have not already set up a 

password. 

•  Change the Password: click the Change button. 

                                           MP200-S System Settings Screen
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•   Enter or change the CPU Identifier: input a new designation into this field. This 

identification is the name given to the main metering module - it is not the name 

of the metering locations.

•   Enter a name for each of the meters: 8 for the MP200-Y and 24 for the MP200-

S. These names are used to identify the meters in logging and polling screens 

and are also used in the naming of the log files.

For example, if you have a shopping mall with 8 stores, each having a three 

phase system that is attached to the MP200-Y, you can name the meters Store 1 

- Store 8, to identify each meter with its store. Then when you look at the polling 

screens or logging screens, you can easily identify each store’s data, without 

needing to check the circuit configuration. 

3. When you click the Change button next to Change Password in the Settings screen, 

you will see the Enter the New Password screen.

a. Type in the new password (0 -9999).

b. Retype the password.

c. Click Change. The new password is saved and you see the following mes-

sage window.

NOTES: If Password Protection has already been enabled for configuration and you 

attempt to change the password, you will see the Enter Password screen after you 

click Change. Enter the old password and click OK to proceed with the password 

change.

4. To implement any changes, click the Update Device button to send the new 

profile to the meter.
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10.1.4: Configuring Communication Settings

Use this screen to enter communication settings for the MP200TM unit’s Communica-

tion ports. This screen is the same for the MP200-Y and MP200-S.

IMPORTANT! The settings on this screen are the current settings for communication. 

Any changes you make may affect communication between the MP200TM unit and your 

PC. 

1. From the Tree Menu, click General Settings>Communications. 

2. Valid Communication Settings are as follows: 

•   COM 1: RS485/ Ethernet/WIFI (optional)

• Address: 1-247

• Baud Rate: 9600, 19200, 38400, 57600 (For WiFi/Ethernet, only 57600)
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• Protocol: Modbus RTU/ASCII (For WiFi/Ethernet, only Modbus RTU)

• Response Delay: 0-750 ms

NOTE: Response Delay is the delay the meter should use before respond-

ing to queries. If your connecting device requires a delay before receiving 

information, use response delay to program the time to wait before the 

meter starts responding to queries.

• Parity: Odd, Even or None

•   COM 2: USB port: The USB port settings are fixed, i.e., they cannot be changed.

• Address: 1

• Protocol: MODBUS ASCII 

• Baud Rate: 57600

• Response Delay: 0-750 ms: see the note on response delay, above.

•   COM 3: RS485/Display Port 

• Address: 1-247

• Protocol: Modbus RTU/ASCII

• Baud Rate: 9600, 19200, 38400, 57600

• Response Delay: 0-750 ms: see the note on response delay, above.

3. You can click the (1)Default to Ethernet or (2)Default to Display button to return 

either the (1)Ethernet settings for COM1 or (2)Display settings for COM3, to their 

default values.

4. To implement any changes, click the Update Device button to send the new profile 

to the meter.

NOTE: For information on configuring the MP200TM metering system’s optional WiFi 

and Ethernet settings, see the MP200TM Metering System Installation and Operation 

Manual.
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10.2: Energy Settings

From the Tree Menu on the left side of the MP200TM metering system’s Device Profile 

screen, double-click on the Energy Settings line or click on the + button next to it. 

The setting in the Energy Settings group is listed.
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10.2.1: Configuring Energy, Power Scaling, and Averaging

Use this setting to configure: 

•   The display and storage of Energy data in the metering module (CPU)

•   The display of Power data in the metering module (CPU) and the method of VA 

computation

•   The interval over which Average values are computed 

This screen is the same for the MP200-Y and MP200-S units. Note that these settings 

are consistent for all of the metering points.

Functional Overview of Energy Settings, VA Computation, and Averaging:

•  Energy Scaling

Energy Setting includes:

Digits (the number of digits in the reading)

Decimals (the number of decimal places in the reading)

Energy Scale: the scale of the reading - unit; kilo (number times 1000); Mega 

(number times 1 million)

Energy settings allow you to balance the resolution (or accuracy) of the energy 

stored, with the interval over which energy rollover occurs. For example, the 

maximum resolution for a k scale reading is: 99999.999k.

To calculate the speed at which the energy will rollover, you must know the Energy 

Full Scale, which is computed from the CT and PT Full Scale values (see Section 

5.3.3.1). The formula for calculating Energy Full Scale is:

Wye system: CT Full Scale x PT Full Scale x 3 

Delta system: CT Full Scale x PT Full Scale x 3 x 

For example, for a CT Full Scale of 2000, PT Full Scale of 14400, Wye system:

2000 x 14400 x 3=86400000

In this example, the energy will increment at 86400000 Watts per hour, or 24000 

Watts per second.

3
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This value allows you to determine the number of digits, decimal places, and 

energy scale you want to configure for the Energy settings, when you take into 

account the rollover time. 

To determine the number of hours before rollover, use this formula:

[Max Resolution]/[Full Scale] = #Hours, where Max Resolution = maximum digits 

and decimals for the Energy scale in use. 

Using the example from above, with an energy scale of Mega, the formula would 

be:

99999.999 M/86.4 M = 1157.4074 hours or about 48 days until rollover. 

NOTE: To increase the number of days until rollover, you can increase the number 

of digits (to 8), decrease the number of decimal places (to 0), or increase the 

Energy Scale (to M).

•   Apparent Power (VA) Computation:

     There are two optional methods of VA Computation:

      Arithmetic Sum - the formula for this calculation is:

      Vector Sum - the formula for this calculation is: 

       Generally, the superior method for calculating VA is to use the Vectoral method;

       however, both methods are provided. 

•  Demand Averaging 

Demand is the average rate of energy use over time. The MP200TM metering system 

supports two types of demand averaging: Block demand and Rolling demand.

Block demand records the average demand for time intervals that you define (

usually 5, 15 or 30 minutes). 

Rolling demand functions like multiple, overlapping Block demands. You define the 

subintervals at which an average of demand is calculated. An example of Rolling 

VA VA VA VAT a b c= + +

VA W VART T T= +2 2
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demand would be a 15-minute Demand block using 5-minute subintervals, thus 

providing a new demand reading every 5 minutes, based on the last 15 minutes.

1. From the Tree Menu, click Energy Settings> Energy, Power Scaling, and Averaging.

2. The screen fields and acceptable entries are as follows:

•  Energy Settings

• Energy Digits: 5; 6; 7; 8

• Energy Decimal Places: 0 - 6

• Energy Scale: unit; kilo (K); Mega (M)

For example: a reading for Digits: 8; Decimals: 3; Scale: K would be 

formatted: 00123.456k
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       NOTES: 

• Your selection in the Energy Settings fields determines the precision of 

energy stored for display and polling. Refer to the Functional Overview at 

the beginning of this section for more information.

• If you are changing the energy settings, we recommend you first reset 

the Energy Accumulators, in order to prevent erroneous counts. See 

Chapter 20 for instructions on resetting the MP200TM metering system’s 

Energy Accumulators.

•  Power Settings

• Apparent Power (VA) Calculation Method: Arithmetic Sum; Vector Sum 

(See explanation on page 10-15.)

• Power Direction: View as Load or View as Generator

• Flip Power Factor Sign: No or Yes.

• Watts Direction: Unidirectional or Bidirectional.

•  Demand Averaging

• Type: Block or Rolling

• Interval (Block demand) or Sub-Interval (Rolling demand): 5; 15; 30; 60

• Number of Subintervals: 1; 2; 3; 4

• Interval Window: This field is display only. It is the product of the values 

entered in the Sub-Interval and Number of Subintervals fields.

        NOTES: 

• You will only see the Number of Subintervals and Interval Window fields if 

you select Rolling demand.
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• As the message on the screen states, the energy settings you make apply 

to all of the meters in the CPU (8 for the MP200-Y and 24 for the MP200-

S).

3. To implement any changes, click the Update Device button to send the new profile 

to the meter.

10.3: Alarm Settings 

From the Tree Menu on the left side of the MP200TM metering system’s Device Profile 

screen, double-click on the Alarm Settings line or click on the + button next to it. The 

setting in the Alarm Settings group is listed.
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10.3.1: Configuring Limits

Use this screen to assign Limits for the MP200TM metering system. This screen differs 

for the MP200-Y and MP200-S units. 

Functional Overview for Limits:

Limits are transition points used to divide acceptable and unacceptable measure-

ments. When a value goes above or below the limit, an out-of-limit condition occurs. 

You can set and configure up to eight Limits for the MP200TM metering system.

Once they are configured, you can view the out-of-Limits (or Alarm) conditions in the 

Limits Log (see Chapter 19) or Limits Polling screen (see Chapter 5). You can also use 

Limits to trigger relays.

1. From the Tree Menu, click Alarm Settings>Limits. The current settings for Limits 

are shown in the screen.  

                                                   MP200-Y Limits Screen
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                                                      MP200-S Limits Screen

2. To set or change a Limit:

a. Select a limit by double-clicking on the Assigned Limit field.
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b. You will see the screen shown below.

 

c. This screen lets you configure the limits. The settings you can make depend 

on your MP200TM unit’s configuration:

• For an MP200-Y three phase configuration, you can set up limits from the 

Readings group’s items for all meters or any individual meter (select from 

the Meter pull-down menu). 

The items you can select for Readings limits for All Meters are: Phase to 

Neutral voltage, Phase to Phase Voltage, and Frequency. 

The items you can select for Reading limits for individual meters are: Cur-

rent phases A, B, and C, Total Watts, Total VAR, Total VA, Total PF, Current 

Neutral, Watts per Phase, VAR per Phase, VA per Phase, and PF per 

Phase.

The Demand group (select from the Group pull-down menu) can only 

have limits set for individual meters (not All Meters). 

The items you can select for Demand limits are: Current phases A, B, and 

C, Current Neutral, Total +Watts, Total +VAR, Total -Watts, Total -VAR, 

Total VA, Total +PF, Total -PF, +Watts per Phase, -Watts per Phase, +VAR 

per Phase, -VAR per Phase, VA per Phase, + PF per Phase, and -PF per 

Phase.

Select All Meters or Individual Meter Select Readings or Demand

Select Item to use for Limit
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• For an MP200-S single phase configuration, you can set up limits from the 

Readings group’s items for All meters or any individual meter (select from 

the Meter pull-down menu). 

The Items you can select for Readings limits for All Meters are: Voltage 

and Frequency. 

The items you can select for Reading limits for individual meters are: Cur-

rent, Watts, VAR, VA, and PF.

The Demand group (select from the Group pull-down menu) can only 

have limits set for individual meters (not All Meters). 

The items you can select for Demand limits are: Current, +Watts, +VAR, 

-Watts, -VAR, VA, +PF, and -PF.

d. Click OK. The Limit you selected will now appear in the Limits screen.

3. To configure a Limit, double-click on the following fields to set their values:

•  Above and Below Set Point: of Full Scale (the point at which the reading goes 

out of limit: see figure on the next page)

For example: 

100 of 120V Full Scale = 120V

90 of 120V Full Scale = 108V

•  Above and Below Return Hysteresis (the point at which the limit’s status 

changes from out of limit to within limit: see figure on the next page)

For example: 

Above Set Point = 110Below Set Point = 90

(Out of Limit above 132V)(Out of Limit below 108V)

Above Return Hysteresis = 105Below Return Hysteresis = 95

(Stay Out of Limit until below 126V)  (Stay Out of Limit until above 114V)
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NOTES: 

•  If the Above Return Hysteresis is greater than the Above Set Point, the Above 

Limit is Disabled; if the Below Return Hysteresis is less than the Below Set Point, 

the Below Limit is Disabled. You may want to use this feature to disable either 

the Above Limit or Below Limit condition for a reading.

•  If you are entering negative limits, be aware that the negative value affects the 

way the above and below limits function, since negative numbers are processed 

as signed values.

4. To implement any changes, click the Update Device button to send the new profile 

to the meter.

TIME

Above Limit 
condition

Below Limit 
condition

Above Limit Trigger point

Return point from Above Limit  condition

Below Limit Trigger point

Return point from Below Limit  condition

HYSTERESIS

HYSTERESIS

- MEASURED VALUE
(if applicable)

+ MEASURED VALUE

0
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10.4: Trending Profiles Settings

An MP200TM unit with V-Switch key 2 or 3 has memory for logging. From the Tree 

Menu on the left side of the MP200TM metering system’s Device Profile screen, double-

click on the Trending Profiles line or click on the + button next to it. All of the settings 

in the Trending Profiles settings group are listed.
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10.4.1: Configuring Historical Logs

1. From the Tree Menu, click Trending Profiles>Historical Log Profile 1-3 (depending 

on your MP200TM unit’s circuit configuration), to display a screen that lets you select 

the data channels you want to log for Historical log 1, and the logging interval for 

the historical log you selected. Historical logs 1 and 2 are used for the MP200-Y 

three phase configuration; Historical logs 1 and 3 are used for the MP200-S single 

phase configuration. 

NOTE: Historical log 1 is configurable. Historical logs 2 and 3 are pre-configured to 

log specific readings: Historical log 2 logs Energy in the Interval for the 8 three 

phase circuits, and Historical log 3 logs Energy in the Interval for each phase of the 

24 single phase circuits.   

                                        MP200-Y/MP200-S Historical Log 1 Screen
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2. To program the data channels for Historical log 1, first select All Meters or an indi-

vidual meter from the Meters field. For individual meters, you can select from Meter 

1 - Meter 8 for the MP200-Y, or from Meter 1 - Meter 24 for the MP200-S. 

3. Next select a Group. The possible selections are: Measured Values, Demand, Maxi-

mums, Minimums, Energy, Phase Angles, and Accumulators. When you select a 

Group, all of the data channels for the Group are displayed in the Logged Data 

Items field, on the left. 

4. To select the data channel(s) you want, click on it in the Logged Data Items field 

and click the Add button to copy it to the Selected Items field. If you need to 

remove a data channel you selected, click on it in the Selected Items field and click 

the Remove button. You can select multiple data channels at one time using either 

the Ctrl button or the Shift button - follow standard usage.

5. Select the logging interval. The available choices are: 1, 3, 5, 10, 15, 30, or 60 

minutes, or EOI (End of Interval) Pulse. The Logging Interval determines when the 

MP200TM unit takes a snapshot of the data values being trended.

Note that the Logging Interval is the only change you can make in the Historical log 

2 and Historical log 3 screens, as the other fields are pre-configured. See the 

example screens on the next two pages.
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                                         MP200-Y Historical Log 2 Screen
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                                             MP200-S Historical Log 3 Screen 

    

        IMPORTANT! If you are trending Energy in the Interval (Historical logs 2 and

        3), the Logging interval must be the same as the Demand interval.

NOTES: 

• Only one Relay Output/Digital Input card input or output can be set to 

trigger an EOI pulse.

• The maximum rate for EOI Pulse used to trigger a log is once per 

minute.
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• When you choose EOI Pulse, the MP200TM unit takes a snapshot on the 

End of Interval Pulse condition, rather than on a time interval. Following 

are two examples of using EOI Pulse for log recording.

         Examples of EOI Pulse Recording:

• The Relay Output/Digital Input card installed in your MP200TM unit is set 

to trigger on a state change. You can use EOI pulse to take a snapshot 

upon that state change. 

• An MP200TM unit is connected on each side of a load. You want to take a 

snapshot of both sides of the load at the same time. You can do this by 

connecting the Relay Output/Digital Input card in each of the MP200TM 

units to a device that will trigger them. Then set the EOI pulse to take a 

snapshot when the devices are triggered.

For more information, see 10.5.1: Configuring Relay Assignments, on 

page 10-33. 

6. The Time Available field lets you know how much time is left before the log is full.

7. To implement any changes, click the Update Device button to send the new 

profile to the meter.
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10.4.2: Configuring Historical Log Sectors

The MP200TM metering system with V-Switch™ keys 2 and above allows a user to 

configure the amount of memory allocated for each log, so you can optimize the 

number of records stored for each log. Use this setting to increase or decrease the 

amount of records each of the MP200 unit's Historical logs can store, and the duration 

each log can run, before becoming filled. 

1. From the Tree Menu, click Trending Profiles>Historical Log Sectors to display the 

screen shown below.

NOTES: The screen above is for a three phase circuit configuration; if you are 

connected to an MP200TM unit with a single phase circuit configuration you will see 

Historical Logs 1 and 3. 
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2. The Historical logs are color-coded for ease of use. The color key is shown in the 

box(es) labeled Historical Log 1 and Historical Log 2 or 3. To change the color 

assigned to each log:

a. Click in the Color field. A small box with three dots will appear. 

b. Click in the box to open a screen that lets you choose an alternate color. 

c. Click on the color you want and then click OK to select the new color and close 

the color selection screen. The new color will now be used for the Historical log. 

3. The screen shows the current space allocation for the MP200TM unit's Historical 

logs, including:

•   The number of bytes allocated to each log

•   The number of records available for each log

•   The duration of each log

4. To change the current allocation for a log:

a. Click on the double yellow line dividing the logs. 

b. You will see a line with arrows on each side. Drag the line in either direction to 

increase or decrease the log allocation. The display fields for the logs will reflect 

any changes you make to the allocation.
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5. To implement any changes, click the Update Device button to send the new 

profile to the meter.

NOTE: When EOI Pulse is set as the Logging Interval for a Historical log (see previous 

section, 10.4.1), the Log Duration field for that log will be blank.

10.5: Digital I/O Settings

From the Tree Menu on the left side of the MP200TM metering system’s Device Profile 

screen, double-click on the Digital I/O line or click on the + button next to it. The 

settings in the Digital I/O settings group are listed.

The MP200TM unit has an embedded Relay Output/Digital Input card. This card is used 

for a few purposes. The relay portion is used to send a control output when a limit is 

exceeded. The input portion can be used to either count KYZ pulse or detect the 

status of a circuit. Accumulators in the CommunicatorPQA® software count the tran-

sitions of the Inputs and Outputs. For technical specifications and hardware installa-

tion, refer to the MP200TM Metering System’s Installation and Operation Manual.
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10.5.1: Configuring Relay Assignments

An example use of the Relay Card is in monitoring the status of circuit breakers or 

relays in your electrical system. The two status inputs could be used to monitor two 

circuit breakers, and the two relay outputs could be used to sound an alarm upon the 

occurrence of a programmed out of limit condition.

1. From the Tree menu, click Option Card>Digital I/O>Relay Output and Digital 

Input>Relay Assignments to open the screen shown below. This screen is the same 

for the MP200-Y and MP200-S units. 

2. From the Relay Assignments screen, you can:

•   Configure up to 8 limits for each of the two Relay Outputs

•   Set a Delay and Reset Delay for the Outputs

•   Choose to log Status Changes for each Relay Output
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•   Assign each Output an Output Label, Open Label, and Closed Label, which are 

used when viewing the Relay Status Log

•   Select the Pulse Scaler Ratio 

IMPORTANT! First use the Limits screen to set up the limits you want to assign to an 

Output. See Section 10.3.1 for instructions.

3. The available Limits appear in the Limit ID column. To Assign a Limit to an Output 

Relay:

a. Select the Alarm trigger from the pull-down menu next to the Limit ID. The 

options are: Above Limit (the Output is triggered when the Above Limit 

condition occurs) and Below Limit (the Output is triggered when the Below 

Limit condition occurs). You can assign the limit to one or both (or neither) 

of the Relay Outputs.

NOTE: A Relay operates when any one assigned Limit is tripped, and stays 

in the Set condition as long as one Limit is in the Alarm state.

b. You can enter Set Delay and/or Reset Delay. These values are the delay 

before the Output is changed: Set is when the common is shorted to Nor-

mal Open (this is the Set Condition).

c. Check the box next to Log Status Change for if you want to log output sta-

tus changes for either or both Relay. See Chapter 19 for information on the 

I/O Change Log.

4. The current Output Labels are displayed in the screen. These labels are used for 

Logging. To change the Output labels, click in the Labels field you want to change, 

and enter a new label. The fields that can be changed are:

•   Output Label - Label ID

•   Open Label - Open state ID

•   Closed Label - Closed state ID

5. Select the Pulse Scaler Ratio. The available ratios are from 1:1 to 10000000:1 (the 

default setting is 1:1). The ratio is used to adjust how high an accumulator will go 

before rolling over. Because of this, it is useful in delaying rollover. For example, if 
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you select a ratio of 10:1, each time 10 Pulse/State changes occur, the accumulator 

count increments by 1. 

6. To implement any changes, click the Update Device button to send the new 

profile to the meter.

10.5.2: Configuring Digital Input Settings

1. From the Tree menu, click Digital I/O>Relay Output and Digital Input>Digital Input 

Settings. Use this screen to assign labels and functions to the Relay Output/Digital 

Input card’s Inputs. This screen is the same for the MP200-Y and MP200-S units.

2. Make a selection in the Assigned to field. The available selections are: 

•   Status Only

•   Accumulator 
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•   Digital Input Log

•   EOI Pulse - only one Input can be set as EOI pulse.

NOTES on End of Interval (EOI): 

• An EOI pulse allows the meter to be synchronized with an installed reve-

nue meter so that both meters are calculating Demand at the same time.

• EOI is triggered when the selected condition is met. Only one Option Card 

input or output can be set to trigger an EOI pulse. EOI is used for the 

following:

• As a trigger for demand averaging: when the selected condition is 

met, the EOI delineates an interval that results in demand averaging 

being performed. The minimum interval between EOI Pulses used to 

trigger demand averaging should be 5 minutes.

• For historical logging: when the selected condition is met, EOI causes 

any log that has been configured for EOI Pulse interval to capture a 

record. Refer to Section 10.4.1 for additional information on EOI Pulse 

and logging.

3. Select Trigger from the pull-down menu. The Trigger options depend on your 

Assigned to selection:

•   For Status Only, select None.

•   For Accumulator, select from Closing or Opening. 

•   For Digital Input Log, select Change.

•   For EOI Pulse, select from Closing, Opening, or Change.

4. Use the Scaling Factor fields as follows (you can only set these fields if the input is 

set as accumulator; otherwise these fields are not used):

a. The Pulse Scaler Ratio sets the number of pulses needed before the accu-

mulator count increments by 1. The available ratios are from 1:1 to 

10000000:1 (the default setting is 1:1). The ratio is used to adjust how 

high an accumulator will go before rolling over. Because of this, it is useful 
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in delaying rollover. For example, if you select a ratio of 10:1, each time 10 

Pulse/State changes occur, the accumulator count increments by 1. 

b. The Scaled Pulses Unit Value is used to adjust the accumulator count to a 

value you need. The Scaled Pulses Unit Value is multiplied by the accumu-

lator count, so you enter the value that you want the accumulator count 

multiplied by.

For example, if you have a KYZ module that is outputting a pulse every 1.8 

kWh, with the input set to Accumulator, Increment on Contact Opening, 

and you have set the Pulse Scaler Ratio to be 10:1, you would set this field 

to 18.

5. Enter a Label for the Accumulator (only used if the input is set as Accumulator).

6. The current Input Labels are displayed in the screen. To change the Input Labels, 

click in the Labels field you want to change, and enter a new label. The fields that 

can be changed are:

•   Input Label - Input ID

•   Open Label - Open state ID

•   Closed Label - Closed state ID

7. To implement any changes, click the Update Device button to send the new 

profile to the meter.
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11: Nexus® 1500/1500+ Meter
This chapter explains how to configure a Nexus® 1500/1500+ meter's programmable 

settings, which are stored in the unit's Device Profile. Chapter 7 contains detailed 

information on how to use the Device Profile. Note that some of the Nexus® 1500+ 

meter settings are not available for the Nexus® 1500 meter.

11.1: Device Profile General Settings

1. From the Device Profile screen, double-click on the General Settings line or click on 

the + button next to it. All of the settings in the General Settings group are listed.

2. Click on the programmable setting you want to modify. The following sections 

explain the settings in the order in which they appear in the General Settings 

menu.
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11.1.1: CT and PT Ratios and System Hookup

Functional Overview of CT and PT Ratios:

Current and Potential Transformers are used mainly for the following reasons:

•   To insulate, and as a result isolate, the meter from high-voltage circuits.

•   To change the primary voltage and current to standard values and sizes that the 

meter can measure.

The CT and PT transformers deliver fractions of the primary voltage and current to the 

meter. With properly set ratios and multipliers, the readings of the meter can be used 

to determine the energy, voltage, current, or power of the system. 

NOTE: For the Nexus® 1500+ meter, be sure to make these settings before config-

uring EN 50160 reporting.

1. From the General Settings menu, click the + button next to CT, PT Ratios and 

System Hookup. You will see the submenu shown below.

This submenu displays the current Device Profile's settings for CT, PT ratios, 

connection type, and Operational Frequency range. The values shown here are the 

default meter settings.
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2. Double-click on any of the settings. You will see the CT and PT Ratios screen. 

3. Make changes to this screen according to your application requirements.

When you change a PT or CT Ratio, CommunicatorPQA® software updates the cor-

responding Full Scale value entered in the Limit and Waveform Full Scales setting. 

When you click OK on this screen, CommunicatorPQA® software opens the Limit & 

Waveform Full Scales screen so that you can verify the settings (see Section 

11.1.2).  

•  Enter Primary and Secondary Current, Voltage, and VAux.

•  Using the pull-down menu, choose the Hookup mode that matches the connec-

tion you have to the Nexus® 1500/1500+ meter. Choose from the following: 

• Wye

• Delta 3 CTs

• Delta 2 CTs

• 2.5 Element Wye
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• 4 Wire Delta 

This value must be set properly for the meter to calculate readings 

correctly.

See the Nexus® 1500 (or) 1500+ Meter Installation and Operation 

Manual for connection diagrams.

•   The Operational Frequency Range for the meter is 45Hz to 69Hz: this field is 

display only. 

•   Total VA/VAh Computation Method (not displayed if Hookup is Delta): choose the 

VA/VAh computation you want used: Arithmetic Sum or Vector Sum, from the 

pull-down menu.

         Arithmetic Sum - the formula for this calculation is:

          Vector Sum - the formula for this calculation is: 

       Generally, the superior method for calculation is the Vectoral method;

       however, both methods are available.

4. Click OK. If changes have been made, a message window opens asking you to 

verify that the Limit Full Scales are correct. 

5. Click OK. The Limit and Waveform Full Scales screen opens (see Section 11.1.2). 

6. To implement any changes, click the Update Device button to send the new profile 

to the meter. 

You will see a warning message that logs will be reset, and you will be given the 

opportunity to retrieve the logs before they are cleared. Resetting the logs 

prepares the meter for placement in a new installation or change of the meter 

Transformers.

11.1.2: Limit and Waveform Full Scales

All Limit and Waveform settings (see Sections 11.1.1 and 11.3.5, respectively) are 

based on a percentage of the Full Scale. Full Scales are based on the CT and PT ratios 

(see Section 11.1.1). The % of Full Scale is defaulted based on the CT and PT ratio. If 

the user wants, the Full Scales can be adjusted to the actual power system condition, 

to optimize the triggering conditions.

VA VA VA VAT a b c= + +

VA W VART T T= +2 2
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Set the CT and PT ratios first; CommunicatorPQA® software automatically 

recalculates the Full Scales every time the CT and PT ratios change and presents them 

for your verification. 

1. From the General Settings menu, click on the + button beside Limit and Waveform 

Full Scales or double-click on the Limit and Waveform Full Scales line. You will see 

the submenu shown below.

This submenu displays the current Device Profile's settings for the Limit and Wave-

form Full Scales. The values shown here are the default meter settings.

•   Frequency and Voltage values are nominal values. The Power Phase is 

computed using nominal Voltage and rated maximum current. In most cases the 

software automatically computes the proper value - you will not need to change it.

•   Also note that in almost all cases VAE is the same Full Scale setting as VAN. VAE is 

voltage to earth ground, while VAN is voltage to the neutral connection.
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2. Double-click any of the settings. You will see the Limit and Waveform Full Scales 

screen.

3. Enter the Full Scale for each parameter.

NOTES:

•   The Limits and Waveform settings (Sections 11.1.1 and 11.3.5, respectively) are 

based on a percentage of the Full Scales entered here. 

•   The software and meter use secondary readings internally, and set Limits on a 

percentage of Full Scale. The purpose of this is to allow the units to be 

programmed using standard profiles, so that meters can be managed on a large 

group basis.

•   Communicator PQATM software automatically recalculates the Full Scale Volt-

ages, currents and power every time the CT and PT ratios change. However, 

frequency is not changed, even if the operational frequency range is changed. 

Frequency can only be changed on this screen.

•   Power Phase is the amount of power per each phase; Power Total is the power of 

all phases combined.
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4. When all changes are entered, click OK to return to the main Device Profile screen. 

For any changes to take effect, you must click the Update Device button to send 

the new profile to the meter. 

11.1.3: Time Settings

To edit the Device Profile's Time settings:

1. From the General Settings menu, double-click on the Time Settings line. You will 

see the submenu shown below. DST stands for Daylight Savings Time.

2. Double-click on any of the programmable settings; you will see the Time Settings 

screen.

3. Make changes to this screen according to your application requirements.
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•   Zone Descriptor: A Zone Descriptor sets the time zone for the meter. 0 = Green-

wich Mean Time. Consult the following chart to find the Zone Descriptor for your 

time zone.

•   Daylight Savings Information:

• Disabled: Disables an automatic adjustment for Daylight Savings Time.

• Auto DST: Sets Daylight Savings Time automatically to the pre-2007 

standard for the United States: the time changes automatically occur at 

2:00 AM (your local time), on the first Sunday in April and the last 

Sunday in October.

• Auto DST U.S. EPA 2005: Sets Daylight Savings Time automatically to 

the 2007 standard for the United States: the time changes automatically 

occur at 2:00 AM (your local time), on the second Sunday in March and 

the first Sunday in November.

GMT Greenwich Mean Time Table (Dublin, London)

-1.00   Azores +1.00   Brussels, Paris, Warsaw

-2.00   Mid-Atlantic +2.00   Athens, Cairo, Helsinki

-3.00   Buenos Aires, Georgetown +3.00   Baghdad, Kuwait, Moscow, 
Tehran

-4.00   Atlantic Time (Canada), Santiago +4.00   Kabul, Baku

-5.00   Eastern Time (USA and Canada), 
Lima

+5.00   Karachi

-6.00   Central Time (USA and Canada), 
Mexico City

+6.00   Dhaka

-7.00   Mountain Time (USA and 
Canada)

+7.00   Bangkok, Hanoi, Jakarta

-8.00   Pacific Time (USA and Canada), 
Tijuana

+8.00   Beijing, Hong Kong, Singapore

-9.00   Alaska +9.00   Osaka, Sapporo, Seoul

-10.00 Hawaii +10.00 Brisbane, Melbourne, Guam, 
Hobart

-11.00 Midway Island +11.00 Magadan, Solomon Islands

-12.00 Eniwetok +12.00 Auckland, Fiji
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• User Defined: Allows you to set the Daylight Savings Time start and end 

times manually. Fields open that let you set the beginning and ending 

dates for Daylight Savings Time.

•   Select the Clock Synchronization Source from the pull-down menu: IRIG-B, 

SNTP (Simple Network time Protocol), IEEE 1588 PTP, or Line Sync (Line Fre-

quency Synchronization). 

• If you are using IRIG-B as your time synchronization source, select it 

from the pull-down menu. IRIG-B is one of two clock synchronization 

sources you can choose if you will be suing the meter’s synchrophasors 

feature. See Appendix E and Appendix F in the Nexus® 1500+ meter’s 

User Manual for detailed information on the synchrophasors feature.

• With SNTP you access a Network Time Protocol (NTP) Server for time 

synchronization. The NTP server can be either a device with a real-time 

clock that is networked with your meter, or an NTP server on the Internet. 

To use SNTP, select it from the pull-down menu. 

a.The screen changes to include a Configure SNTP button: click this 

button to set up SNTP. 

b. The Advanced Network Options screen opens. 
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c. Click in the Network Time Sync field and select one of these options: 

 - SNTP Card 1 to use the first network card for SNTP clock synchroni-

    zation.

 - SNTP Card 2 to use the second network card for SNTP clock 

    synchronization.

 - SNTP Auto to use whichever network card is available for SNTP clock

    synchronization.
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d. Click the SNTP tab.

e. Enter:

• SNTP Mode: the only choice is Client Unicast, which is already 

selected. 

• In Client Unicast mode, the meter connects to the specified SNTP 

0server using the configured SNTP IP address(es). First, the 

meter synchronizes with the SNTP server. After that, the meter 

periodically sends time requests to the SNTP server. 

• If Configured Clock Sync Source is not SNTP, close the Advanced Net-

work Option Settings screen to redisplay the Time Settings screen, 

and choose SNTP for time synchronization. This situation can occur if 

you previously selected a different time sync method and are now 

setting up SNTP directly through the Advanced Network Settings 

screen (Chapter 21 explains the options in the Advanced Network 

Settings screen).

Note that if SNTP is already displayed in the Configured Clock Sync 

field, you do not need to do anything.
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• The Sync Rate in minutes: this is how often the meter checks the 

SNTP server for time updates. EIG recommends that the sync rate be 

set to other than the logging interval, if possible; for example, if the 

logging interval is every 15 minutes, set the sync rate to every seven 

minutes. This is done to prevent erroneous time stamps in the log.

• The Sync Process Timeout in seconds: this is how long to wait for the 

server to respond. Typical timeout should be set for 30 seconds.

• At least one NTP server url address. You can enter a second NTP 

server url address if you wish.

f. Click OK.

•  If you want to use IEEE 1588 PTP (Precision Time Protocol) as the time synchro-

nization method for the meter’s PMU synchrophasors feature, see the instruc-

tions for setting up the PMU in Appendix F of the Nexus® 1500+ meter’s User 

Manual (download the manual at https://www.electroind.com/products/nexus-

1500-power-quality-meter-with-phasor-measurement-unit/: click Down-

loads>Tech Documents>User Manual from the right side of the webpage).

•   If you want to use Line Sync, you must also select the Line Frequency from the 

Frequency pull-down menu: 50Hz or 60Hz. The selection should be based on the 

nominal frequency in the jurisdiction where the meter is located. 

https://www.electroind.com/products/nexus-1500-power-quality-meter-with-phasor-measurement-unit/
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• Line synchronization uses the frequency zero crossings to provide a time 

reference for the meter. The basic function of Line Frequency Clock Syn-

chronization is to adjust the real time clock to track the time based on the 

power line frequency. For this purpose, Phase A voltage only is used.

• This is the most common method to synchronize a meter’s clock. EIG 

recommends that you always select this method unless there is a specific 

reason not to select it. If the meter is not synchronized to line frequency, 

SNTP, or IRIG-B, it will default to internal crystal. Meters differ in terms of 

drift, but typically meters with 20 ppm crystals will drift 30 seconds per 

month when set to internal crystal. The Nexus® 1500+ meter has a clock 

accuracy of 3.5 ppm, which gives it a drift of less than 10 seconds per 

month.

• Line Sync is disabled if an IRIG-B signal is present. If the signal is lost, 

the unit defaults to its internal crystal for a time synchronizing reference.

• How Time is Adjusted

After the clock is synced to the line, the meter periodically checks the 

cumulative difference between the real time clock in seconds and the line 

cycle count. If the absolute difference between the two accumulations is 

more than 1 second or 60 (50) cycles, the clock is adjusted + / - 1 second 

accordingly.

7. To set the meter's on-board clock manually, use Set Device Time from the Tools 

Menu (see 20.1: Tools Menu, on page 20-1).

8. When all changes are entered, click OK to return to the main Device Profile screen. 

For any changes to take effect, you must click the Update Device button to send 

the new profile to the meter.
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11.1.4: Labels

Labels are user-defined names for the Nexus® 1500/1500+ meter, the Auxiliary Volt-

age terminal, and the I N Measured terminal. You also use the Labels screen to select 

the power direction, and the power factor display.

It is important to label the meter (under "Meter Designation") with a unique name 

because that label becomes the file name of any logs retrieved from that meter. See 

Chapter 19 for more details on logs.

1. From the General Settings menu, double-click on the Labels line. You will see the 

submenu shown below.
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2. Double-click on any of the parameters; you will see the Labels screen.

3. Enter labels in the appropriate fields.

•   Meter Designation must be set for log retrieval. You can use any character 

allowed by the Windows® operating system. 

•  In English versions the following characters don’t work: 

 \ / : * ? " < > | 

• For meters used internationally by multilingual users, we recommend you 

use only alphanumeric characters allowed by your operating system.

•   For V Aux (auxiliary voltage input) and IN Measured (measured neutral current) 

enter the label you want to use for these readings.

•   Your selection in Power Direction determines which quadrants of Watt-hours are 

considered Received and Delivered.

•   Your selection in Power Factor Display determines the display of Quadrants in 

the Power Factor screen.
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•   The Memo field is used to enter notes about the meter, such as the location, or 

other relevant details.

•   The Phase Angle representation determines how the voltage phase angles are 

represented. 90 of users will use the default, which is the first radio button: 

“Positive angle for events after the reference and negative angle for events prior 

to the reference”; however, you can choose the opposite display by selecting the 

second radio button, if you wish.

4. When all changes are entered, click OK to return to the main Device Profile screen. 

For any changes to take effect, you must click the Update Device button to send 

the new profile to the meter.
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11.1.5: Communications 

1. From the General Settings menu, double-click on the Communications line. You will 

see the submenu shown below.

2. Double-click on any of the settings (e.g., "Optical Port 1"); you will see the 

Communications Settings screen. 

This screen displays the current Device Profile settings for the Nexus® 1500/

1500+ meter's Communications ports: address, baud rate, data bits, parity, stop 
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bits, Tx (Transmit) delay, (communication) protocol, and mode. You can also use 

the meter’s touch screen display to see the current baud rate, address and commu-

nication protocol of each of the Nexus® 1500/1500+ meter's ports. See the 

Nexus® 1500 (or) 1500+ Meter Installation and Operation Manual for details. 

NOTES: 

•   Only some of the Optical port settings can be changed. Those that can't be 

changed appear grayed out and are not selectable.

•   RS485 ports 1 and 2 are the meter's optional RS485 ports. The appropriate card 

must be ordered for the physical ports to be available. This card can be installed 

at a later time so that the meter can be upgraded.

•   If the meter does not have the optional Network card 2, you will only see 

settings for the standard Network card 1.

3. Make changes to this screen according to your application requirements by clicking 

on the box or pull-down menu of any of the following settings:

•   Address: assign the address that each port will respond to. Multiple Nexus® 

meters on an RS485 bus must each have a unique address set for the port that 

is connected to the bus - if they share the RS485 bus with the same address, the 

communication will not work.

•   Baud Rate: from the pull-down menu, select 1200, 2400, 4800, 9600, 19200, 

38400, 57600, or 115200. The baud rate entered in this field must match the 

baud rate of the device connected to the Nexus® 1500/1500+ meter at this 

port. Use 9600 for modem connections. 

•   Data Bits: use the pull-down menu to select from: 5, 6, 7 or 8. For Modbus RTU 

and ASCII, leave the data bits at 8.

•   Parity: use the pull-down menu to select from: None, Even, Odd, Mark or Space. 

For Modbus RTU and ASCII, leave the parity at None.

•   Stop Bits: use the pull-down menu to select from: 1, 1.5 or 2. For Modbus RTU 

and ASCII, leave the stop bits at 1. 
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•   TxDelay (Transmit Delay): use the pull-down menu to select from: 0ms, 10ms, 

20ms, 30ms, 40ms, 50ms, 60ms, or 70ms. Leave the Tx delay at 50ms for 

RS485 communication.

•   Protocol: use the pull-down menu to select from Modbus RTU and Modbus 

ASCII. Direct connections made through CommunicatorPQA® software must use 

either Modbus RTU or Modbus ASCII protocol (we recommend Modbus RTU). 

Modem connections made through CommunicatorPQA® software must use Mod-

bus ASCII only. See Chapter 3 for details.

•   Mode field selections depend on the port: 

• Optical port - select the Receiving mode, either Inverted (for use with the 

Smart Coupler or A7Z Optical Probes) or Non-inverted.

• Port 2 - depending on how you will be using this RS485 port select either 

Slave, Master (I/O Modules), RTU Master, or Ethernet Gateway. 

• Slave: This mode is used when the port will be polled by a Master 

device.

• Master (I/O Modules): This mode is used when the port will be polling 

I/O modules.

• RTU Master: This mode is used when the port will be used to poll 

other (slave) devices.

• Ethernet Gateway: This mode is used when the port will be used by 

other devices to access an Ethernet network.

•   For Network Card Settings, enter:

• IP Address - the IP address that should be used to connect to this port.

• Subnet Mask - the subnet mask controls the IP addresses this card will 

respond to.

• Default Gateway - A default gateway is the node on the computer net-

work that the network software uses when an IP address does not match 

any other routes in the routing table. You can enter a default gateway for 

the port to use in this field, if you wish. 
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        NOTES: 

• Click the Advanced Settings button to open a screen that lets you set 

Network card features, including enabling the IEC 61850 Protocol server. 

See Chapter 21 for details.

• See your Network Administrator for the correct settings. 

4. When all communication settings are entered, click OK to return to the main Device 

Profile screen. For any changes to take effect, you must click the Update Device 

button to send the new profile to the meter. 

IMPORTANT! In order to prevent communications problems, be careful when making 

changes in the Communications Settings screen. For example, if you change the baud 

rate of the port connected to a computer, be sure to make the same change to the 

computer port's baud rate. 

11.1.6: DNP3 Custom Class Map

The DNP Custom Class Map lets you set up DNP communication for the meter. From 

the General Settings menu, double-click on the DNP Custom Classes Map line and the 

DNP Level 2 line. You will see the screen shown below. 

 For details on programming the DNP Level 2 settings, see Chapter 22.
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11.1.7: Custom Modbus Map

The custom Modbus map for the Nexus® 1500/1500+ meter can position up to 256 

meter data points in a block of 2048 registers (4096 bytes), to readily provide the 

functionality you want from your meter. In addition, you can customize selected val-

ues for format type, Scaling, byte order, data size, etc. This allows a user to optimize 

Modbus registers by putting them in a particular order and/or format to make the 

SCADA poll more quickly and efficiently.

1. From the General Settings menu, double-click on the Custom Modbus Map line. You 

will see the screen shown below.

Data entry is straightforward. Each entry field is described below. Note that not all 

selections appear on the screen at the same time. Use the scroll buttons to view 

additional data/entry fields on the screen. Certain entries (such as Format, Data 

Size, etc.) have different allowable selections depending on the data point used. 

The pull-down menu adjusts to provide the appropriate selections for each data 

point.

•   Data Point Selection: there are two different ways to select a data point:

a. Refer to the Nexus® 1500/1500+ meter’s Modbus map and find the associ-

ated line and point for the value you want. When you enter those values 

into the screen table, the software displays the associated group and chan-

nel.

• The Nexus® 1500/1500+ meter’s Modbus map can be downloaded from 

the EIG website: http://www.electroind.com/downloads/nexus-meters/. 

http://www.electroind.com/downloads/nexus-meters/
http://www.electroind.com/downloads/nexus-meters/
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b. Double-click the Group field. From the pull-down menus, select a group and 

its associated channel value. The software displays the map and line 

values.

•   Number of Registers: this field is display only. The software computes the 

number in this field based on the data size selected in the Data Size column.

•   Start Register: this field is display only. The software assigns and adjusts Start 

register numbers to take into account previous entries and data sizes. The Start 

register is the number of the first register used in polling. The Start registers are 

shown as 4x to describe them as holding registers, for SCADA applications.

•   Format: from the pull-down menu, select a format type for a value, such as 

Signed Integer, Unsigned Integer, and 4 Byte IEEE Float.

•   Data Size: from the pull-down menu, select the number of bytes you want to 

represent the data point: 2 or 4.

•   Unit: if the polled value is viewed as an integer, the Unit field tells the software 

where to place the decimal point. 

Examples 

• If you select .01, a polling value 1,800.92883 is interpreted as 

180,092.883.

• If you select 100, a polling value 1234 is interpreted as 123400.

•   Primary/Secondary: the meter normally computes values in secondary units. 

Where applicable, you may select primary or secondary. If Primary is selected, 

the value is multiplied by the appropriate CT and/or PT values.

•   Absolute Value: where appropriate, you may have the option of having the data 

point computed as a signed or absolute value. Select either:

• No: to have the data point computed as a signed value.

• Yes: to have the data point computed as an absolute value.
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•   Byte Order: for most of the data points, you can select the polling order of the 

registers/bytes to match what the SCADA system needs. The choices are: MSR, 

MSB (most significant register, most significant byte); MSR, LSB (most signifi-

cant register, least significant byte); LSR, MSB (least significant register, most 

significant byte); and LSR, LSB (least significant register, least significant byte). 

EIG meters store data as MSR, MSB, whereas most SCADA systems use LSR, 

LSB. You can either select an alternate order here, for example, LSR, LSB, or 

you can leave the data as is and then have your SCADA system change the 

order after the data is polled. 

•   Display/Modulo/Offset: depending on the data point, select one or more 

additional options with appropriate sub-selections.

• Display: for certain data points, interpretation and display options are 

offered. 

Example: For “AN Angle” values, you can represent and display as 0 to 

360 degrees or -180 to +180 degrees, etc. Selections appear in a pull-

down menu for the associated point. You may want to select -180 to 

+180 degrees if you ant to know if a phase angle is positive or negative in 

relation to the reference.

• Modulo: Certain values are cumulative and can roll over and start 

recounting from zero. For those values, where required, you can enter a 

point at which the rollover will occur.

• Offset: Where allowed, you can enter a value (offset) that will be added 

to the data point when it is computed.

2. When all changes are entered, click OK to return to the main Device Profile screen. 

For any changes to take effect, you must click the Update Device button to send 

the new profile to the meter. 
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11.1.8: Configure Log Sizes

The Configure Log Sizes setting allows you to set the size (amount of memory) 

allocated for each log, so you can optimize the number of records stored for each log. 

1. From the General Settings menu, double-click on the Configure Log Sizes line. You 

will see the screen shown below.

This screen lists the logs and the assigned blocks/memory/total percent of log 

memory/ for each, along with the approximate time span and approximate number 

of records based on the log’s size; the bottom of the screen lists the remaining 

blocks/memory.

2. Click in the Blocks field of any log that you want to configure and enter the amount 

of blocks you want that log to use: 1 Block = 1 MegaByte of memory.
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The software limitation of the log sizes is shown in the table below. However, the 

V-Switch key of your meter may restrict these sizes - see the NOTES below.

3. Click OK to save your changes and exit the screen. For any changes to take effect, 

you must click the Update Device button to send the new profile to the meter.

NOTES: 

•   The amount of memory available for logging depends on the meter's model and 

V-Switch™ key:

• V1: 

• 128 MB memory for logging for the Nexus® 1500 meter

• 512 MB memory for logging for the Nexus® 1500+ meter

• V2: 1 GB memory for logging for both the Nexus® 1500 meter and the 

Nexus® 1500+ meter

• V3:

• 1 GB memory for logging for the Nexus® 1500 meter

• 4 GB memory for logging for the Nexus® 1500+ meter

•   Memory size allocations can change. See the Nexus® 1500 (or) 1500+ Meter 

Installation and Operation Manual for specific memory sizes. 

Log Min Size Max Size

System Events 1 1

Historical Log 1 0 8

Historical Log 2 0 8

Historical Log 3-8 0 60

All other logs 0 All remaining unused log memory 
at current V-Switch key level
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11.1.9: Configure High Speed Value Update Rate - Nexus® 1500+
              Meter

The Configure High Speed Value Update Rate setting lets you configure the update 

rate for the meter's High Speed Inputs. You can set between two and 20 cycles. This 

number determines how often any values assigned to the High Speed Inputs are 

updated.

1. From the General Settings menu, double-click on the Configure High Speed Value 

Update Rate line. You will see the screen shown below.

2. Enter the number of cycles you want before an update is performed: enter a 

number between 2 and 20.

3. Click OK to save your changes and exit the screen. For any changes to take effect, 

you must click the Update Device button to send the new profile to the meter.
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11.2: Revenue and Energy Settings

Revenue and Energy Settings are the second group of settings in the Device Profile. 

They are used to configure the meter settings for parameters that are useful in 

energy measurement applications.

1. From the Device Profile screen, click on the + button next to Revenue and Energy 

Settings or double-click on the Revenue and Energy Settings line. All of the settings 

in the Revenue and Energy Settings group are listed. Not that you will only see the 

last two settings: Test Mode Configuration and Time of Use: Enabled/Disabled, if 

you are connected to a Nexus® 1500+ meter. 

2. Click on the programmable setting you want to modify. The following sections 

explain the settings in the order in which they appear in the Revenue and Energy 

Settings menu.
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11.2.1: Energy Scaling

Energy scaling is the amount of digits and the decimal point position that will be seen 

on the meter display. Each energy parameter can be specifically set up for its desired 

scaling. 

1. From the Revenue and Energy Settings menu, click on the + button next to Energy 

Scaling or double-click on the Energy Scaling line. You will see the Energy Scale 

Settings screen. 

•   This screen has multiple tabs that allow you to access all of the Energy Scaling 

options. Using the Energy Scale Settings screens you can select the number of 

digits, decimal point placement and Energy unit for displayed readings. 

NOTE: This also affects the resolution of logged energy values and affects the 

rollover.

•   The Example field shows you the scaling choices you made applied to an exam-

ple reading.

To configure scaling for a reading, enter:
1. Number of Digits, 2. Number of Decimal Places, 
3.Unit of Measurement; 4. Example of the resultant scaling is shown here
                             1                 2   3                        4
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•   You click on the tabs to navigate between screens, except for Global settings - 

you click on the Global Settings button to access that screen.     

    Global Settings

NOTE: Because there are many energy settings, Global Settings conveniently allows 

you to set these similar energy reading settings all at once.

2. Click the Global Settings button to see the screen shown above. This screen lets 

you set the scale for all of the Energy Readings.

a. Click in the Digits field and select the number of digits for the value from the 

pull-down menu. You can choose between 2 and 9 digits.

b. Click in the Decimal Places field and select the number of decimal places for the 

value from the pull-down menu. You can choose between 0 and 7 decimal 

places, depending on the number of digits you selected. For example, if you 

chose 3 digits, you can only choose up to 2 decimal places.

c. Click in the Units field to select the unit of measurement for the value. You can 

select blank (or leave the field blank), k, or M. 

The example field changes as you make selections, to show you how the value 

would appear with the settings you made.

3. When all changes are entered, click Apply to return to the main Energy Scale 

Settings screen. You can now use the tabs to modify the scale for specific readings. 

For example, you might have set the scale for the Internal Input Accumulators as 5 
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digits, 2 decimal places, and M unit, but you may want one of the accumulators to 

have a different scale. You would click the Pulse Accumulations and Aggregations 

tab and change the scale for that accumulator. The following sections show the tab 

screens where you can make individual scaling changes. You set the Digits, Deci-

mals, and Units fields in the same way as in the Global Settings screen.

Energy Tab

    This is the initial screen view. Click on the Watt Hour, VA Hour, and VAR Hour tabs

    to configure scaling for those readings.

The meter has the ability to measure and display energy readings for many different 

purposes. These readings can each be scaled separately.

Click to set Watt Hour 
readings scaling (this is 
the initial tab view)

Click to set VA Hour 
readings scaling

Click to set VAR Hour 
readings scaling
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    Uncompensated Energy Tab

    Uncompensated energy is the energy log that does not have the transformer/line

    loss compensation attached to it.

    Click on the Uncompensated Energy tab to configure specific VA, Watt and VAR

     readings not adjusted by Transformer Loss Compensation. 

     This meter has the ability to collect both compensated and uncompensated energy

     data, simultaneously. This is useful in jurisdictions in which multiple entities need

     to receive data, if some of the entities require compensated data, and others

     require uncompensated data. 
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    Pulse Accumulations and Aggregation Tab

    Pulse accumulations allow the meter to be used as a pulse counter and pulse

    totalizer. This is useful when you want to add additional metered parameters, such

    as water, condensate (steam), gas, or any other desired energy commodity. 

    

    Click on the Pulse and Aggregations tab and then click on the Accumulators and

    Aggregators tabs to configure scaling for those readings.

Click to set scaling for Accumulator read-
ings (this is the initial tab view)

Click to set scaling for Aggregator read-
ings 



     Doc#    E107707                                              11 - 33

11: Nexus® 1500/1500+ Meter

    I and V Squared T Readings Tab

    Click on the I and V Squared Readings tab to configure scaling for specific I2T 

    readings (data will not accumulate until current reaches the programmed level)

    and V2T readings (data stops accumulating when Voltage falls below the 

    programmed level).
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    Q Hours Tab

    Click on the Q Hours tab to configure scaling for +QH and -QH readings.   

4. When you are done, click OK to return to the main Device Profile screen. For these 

changes to take effect, you must click the Update Device button to send the new 

profile to the meter.
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11.2.2: Demand Integration Intervals

See the Nexus® 1500 (or) 1500+ Meter Installation and Operation Manual for details 

on Demand intervals.

1. From the Revenue and Energy Settings menu, click on the + button next to 

Demand Integration Intervals or double-click on the Demand Integration Intervals 

line. You will see the submenu shown below.

2. Double-click on any of the settings. You will see the screen shown below.
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3. Click on the tabs at the top of the screen to navigate from one setting to another. 

Make changes to the settings according to your application requirements. Following 

is a brief description of each setting and its function:

•   Thermal Averaging (tab shown on previous page): use to set hours and minutes 

for a precise thermal window of demand data.

• Traditional analog Watt-hour meters use heat-sensitive elements to 

measure temperature rises produced by an increase in current flowing 

through the meter. A pointer moves in proportion to the temperature 

change, providing a record of demand. The pointer remains at peak level 

until a subsequent increase in demand moves it again, or until it is manu-

ally reset. 

The Nexus® 1500/1500+ meter mimics traditional meters to provide 

Thermal Demand readings. Electronic thermal demand emulation is the 

logarithmic average of the power used, with a more recent load being 

weighted more heavily than a less recent load, (approximated exponen-

tially). Each second, as a new power level is computed, a recurrence rela-

tion formula is applied. This formula recomputes the thermal demand by 

averaging a small portion of the new power value with a large portion of 

the previous thermal demand value. The occurrence of the proportioning 

of new to previous is programmable, set by the averaging interval. The 

averaging interval represents a 90 change in thermal demand to a step 

change in power. So, for example, with a 15 minute set interval, the 

meter will record 90 of a change in load in 15 minutes, 99 in 30 minutes, 

and 99.9 in 45 minutes. 

Because thermal demand emulation is the logarithmic average, the 

demand is not set to zero on a demand reset. On a demand reset, pres-

ent demand becomes the new maximum demand.

• The Max/Min Thermal Average Block Interval fields are used if you 

want to track the maximum and minimum Demand in more than one 

interval, e.g., the Max and Min Demand in a 10 minute (First Interval) 

and a 15 minute interval (Second Interval).
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•   Block Averaging Time: use to set the length of the block interval used for 

Demand calculations and other interval-based functions; also used to set End of 

Interval pulse. Block averaging is also known as fixed window averaging. A 

window is the user set time range, e.g., 15 minutes. Computation is performed 

on that 15 minute interval, and after that, a new set of computations will be 

started. For example, Window 1 will be from 0 to 15 minutes, Window 2 will be 

from 16 to 30 minutes, and so on. 

a. Use the Hours and Minutes fields to set the length of the Block Interval.

b. If you want to generate a pulse at the end of the set interval, click the box 

next to the Generate End of Interval Pulse field and select the number of 

the internal relay (1-4) you want to use and the pulse width (600 - 530 

milliseconds).

NOTE: The Block Window Sync field indicates whether the meter is being       

synchronized with pulses from a High Speed input. This option is set in the 

Input Type field of the High Speed Inputs screen (see Section 11.3.8).
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•   Rolling Averages: also known as a sliding window, functions like multiple, over-

lapping Block averages. You define the subintervals at which an average of 

Demand is calculated. A window duration is the user set time, such as 15 min-

utes, but it moves, so that, for example, Window 1 is 0 to 15, Window 2 is 1 to 

16, Window 3 is 2 to 17, and so on.

a. Set the Hours and Minutes fields under Rolling Averaging Sub-Interval 

Window.

b. Rolling Sub-Intervals: set the number of rolling windows you want to 

"string together."

c. Predictive Rolling Window Average: you won’t see Predictive Rolling Window 

Average if you are connected to a Nexus® 1500+ meter. For a Nexus® 

1500 meter, the meter gives you the programmed (field) prediction of your 

demands. If you are using Demand as a Limit, such that you will perform 

certain actions when you hit a certain Demand level, e.g., turning off 

motors, you may want to give yourself a “buffer.” This field accomplishes 

that by letting you choose to over-predict the Rolling Window Demand - 

e.g., if you enter 110, the meter will predict Demand at a 10 higher rate 

than the actual Demand, so that you will trigger a Limit alarm earlier than 

if you were using 100 Predictive Demand. 
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•   Reset: Allows you to specify a Time of Use read whenever Maximum Demand is 

reset.

• Check the box to perform the TOU read. By selecting this, the meter will 

place all of the TOU values in the previous month’s registers. Otherwise, 

the meter will default to self read based on a date set in the meter.

• Leave the box unchecked if you don't want to perform a TOU read.

4. When all changes are entered, click OK to return to the main Device Profile screen. 

For these changes to take effect, you must click the Update Device button to send 

the new profile to the meter.
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11.2.3: Internal KYZ Outputs 

The Internal KYZ Outputs setting lets you assign channels to the KYZ outputs and to 

the test LEDs. The channel selection sets the type of pulse that will be generated. For 

example, the Pulse 1 LED can generate Energy Pulses for conventional testing or 

Reactive (VARh) Pulses for complex testing and approvals. This setting also allows you 

to determine the frequency and duration of the pulse for each output and LED.  

1. From the Revenue and Energy Settings menu, click on the + button next to 

Internal KYZ Settings or double-click on the Internal KYZ Settings line. You will see 

the screen shown below.

2. To make selections on this screen:

a. Select the assigned channel for the pulse/output. This is the demand that will be 

output as a pulse. 

b. Enter Watt hour per pulse, pulse width, mode and form for each pulse/output.

   NOTES:  

•  Form A = Pulse; Form C = Transition

•  No more than one Pulse Output can be assigned as an Operation Status Output.
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3. When all changes are entered, click OK to return to the main Device Profile screen. 

For these changes to take effect, you must click the Update Device button to send 

the new profile to the meter.

Considerations on Setting KYZ Outputs

KYZ Pulses are produced at a rate proportional to the rate of energy accumulation, a 

feature that makes them useful for accuracy testing. Decreasing the value of the Watt 

Hour per Pulse field increases the pulse rate, improving the moment-to-moment 

precision of the output. The increased pulse rate means that the pulses are of shorter 

duration. Most equipment for detecting and counting pulses has a minimum detection 

time, so pulses that occur too rapidly might not be detected and counted. 

The value in the Pulse Width field is used to force the meter to generate minimum 

width pulses in situations where proportional width pulses would occur too quickly to 

be measured. A pulse width setting that does not match appropriately with the input 

level and Watt hour per pulse setting will result in output that, in the short term, will 

not verify correctly.

For proper operation of this feature, the pulse width should be set to a value that is 

longer than the detection time required by the monitoring equipment, and shorter 

than the pulse period that the inputs and Watt hour per pulse setting would produce. 

The formula for the second quantity is:

3600 x -   

   

Watt hr per pulse

Total Power
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Some example cases are shown in the table below. For proper operation the pulse 

width should be set to a value that is less than the computed value of seconds per 

pulse.     

   Voltage
Phase to

Neutral/Phase

Volts         Volts

Current            

Amps     Watts

Total Power 
Wh/Pulse

Wh

Pulses/Hour

Pulses

Seconds/Pulse

Seconds

69.28 120.00 1 207.85 1.8000000 115.47 31.18

69.28 120.00 1 207.85 0.2078461 1000.00 3.60

69.28 120.00 5 1039.23 1.8000000 577.35 6.24

69.28 120.00 5 1039.23 1.0392305 1000.00 3.60

120.00 207.85 1 360.00 1.8000000 200.00 18.00

120.00 207.85 1 360.00 0.3600000 1000.00 3.60

120.00 207.85 5 1800.00 1.8000000 1000.00 3.60

277.13 480.00 1 831.38 1.8000000 461.88 7.79

277.13 480.00 1 831.38 0.8313844 1000.00 3.60

277.13 480.00 5 4156.92 1.8000000 2309.40 1.56

277.13 480.00 5 4156.92 4.15629219 1000.00 3.60
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11.2.4: CT and PT Compensation

1. From the Revenue and Energy Settings menu, click on the + button next to CT and 

PT Compensation or double-click on the CT and PT Compensation line.

2. Check the Enable box to enable CT and PT Compensation; leave the box unchecked 

to keep it disabled.

3. Click OK to close the screen and return to the main Device Profile screen. For these 

changes to take effect, you must click the Update Device button to send the new 

profile to the meter. 

11.2.5: Transformer / Line Loss Compensation

Transformer losses are power used by the transformer while working. The more load 

on the transformer, the higher the transformer losses. There are two types of trans-

former losses:

•   No load losses - these are the fixed losses that keep the transformer up and 

running.

•   Load losses - these vary with changes in the load.

When the meter is located on the secondary side of a customer’s transformer, a utility 

will want to add the transformer losses into the energy usage calculation. However, 

this practice is regulated by local jurisdiction and regulations. The meter has the 

capability to add in or subtract out these transformer losses, depending on the user’s 

specific needs.

Line losses are similar to transformer losses, except that they are used to compensate 

for loss incurred on wires, such as transmission lines.
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1. From the Revenue and Energy Settings menu, click on the + button next to 

Transformer/Line Loss Compensation or double-click on the Transformer/Line Loss 

Compensation line. You will see the submenu shown below.

2. The menu displays the current values for the meter's Transformer Loss Compensa-

tion.

•  LWFE = percent loss of Watts due to iron

•  LVFE = percent loss of Vars due to iron

•  LWCU = percent loss of Watts due to copper  

•  LVCU = percent loss of Vars due to copper
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3. Double-click on any of the loss values. You will see the screen shown below.

4. Click on TLC Calculator to find the values to enter into the Percent Loss fields. The 

TLC Calculator button launches the TLC Calculator that performs the calculations 

for you once the required data is entered.  

NOTE: Appendix A contains screen caps of the TLC Calculator with example num-

bers, and an explanation of Loss Compensation considerations.

5. Enter the percent loss of Watts and VARS for copper and iron in the appropriate 

fields. 

6. Enable or Disable Transformer Loss Compensation with the first pull-down menu at 

the bottom of the screen. The optional selections are:

•   Disabled

•   Iron (Fe) Only 

•   Copper (Cu) Only

•   Both Iron and Copper (Fe and Cu)
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7. With the second pull-down menu, select from the following options:

•   Add to Watts and Subtract from VAR

•   Subtract from Watts and Add to VAR

•   Add to Watts and VAR

•   Subtract from Watts and VAR

8. With the third pull-down menu, apply the loss based on the power flow direction by 

selecting one of the following options:

•   Both +Watts and -Watts 

•   -Watts only

•   +Watts only 

9. If you want to disable TLC if the current is zero, check the box.

10.When all settings are complete, click OK to return to the main Device Profile 

screen. For any changes to take effect, you must click the Update Device button to 

send the new profile to the meter.

11.2.6: Cold Load Pickup 

Cold Load Pickup is used to manage Demand in the event of a power outage. You set 

the amount of time (in seconds) power is off to identify a power outage that is the 

responsibility of the utility (as opposed to a very short term loss of power that is not 

their responsibility); then you set the amount of time (in minutes) you want to wait 

before Demand starts again. This time should correspond to the “grace” period the 

utility applies to avoid charging for motor startup, etc. after a power outage. 

1. From the Revenue and Energy menu, click on the + button next to Cold Load 

Pickup or double-click on the Cold Load Pickup line. You will see the submenu 

shown below.
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2. Double-click on one of the parameters to open the screen shown below.

3. Make the following selections in accordance with your application needs:

•   Time after control power is restored to start demand - can be 1 to 60 minutes, 

or Disabled. 

•   Minimum time control power must be off before using Cold Load Pickup - can be 

from 0 to 255 seconds.

4. When all changes are entered, click OK to return to the main Device Profile screen. 

For these changes to take effect, you must click the Update Device button to send 

the new profile to the meter.

11.2.7: Cumulative Demand Type and Time of Use Demand Type

The Nexus® 1500 meter lets you set the Cumulative Demand Type; the Nexus® 

1500+ also lets you set the Time of Use Demand Type (both cumulative and TOU 

must be the same demand type). 

•   Cumulative demand is a counter of max demand that the meter keeps. It can help 

you determine if there has been tampering with the meter, i.e., unauthorized reset-

ting of demand. Whenever demand is reset, the current max demand is added to 

the cumulative demand. By analyzing the data in the counter you can see if the 

demand is being reset more often than intended. You can choose to use either 

Block Window Demand or Rolling Window Demand for the cumulative demand.
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•   Time of Use demand type can also be set for the Nexus 1500+ meter. Either Block 

Window or Rolling Window demand averaging can be chosen. This setting is used to 

accumulate time of use energy readings. See Chapter 15 for detailed information 

on time of use for the Nexus® 1500+ meter. Note that the same demand type 

must be used for both cumulative demand and Time of Use demand.

1. From the Revenue and Energy Settings menu, click on the + button next to 

Cumulative Demand Type and Time of Use Demand Type or double-click on the 

Cumulative Demand Type and Time of Use Demand Type line. You will see the 

submenu shown below. It tells you the type of demand currently selected.

2. Click the Type line to open the screen shown below. 

3. Click the radio button in front of Rolling Window (sliding) or Block Window (fixed) to 

select cumulative Demand and TOU Demand type.

4. Click OK to exit the screen and return to the main Device Profile screen. For a 

change to take effect, you must click the Update Device button to send the new 

profile to the meter.
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11.2.8: Energy, Pulses and Accumulations in the Interval

Energy in the interval is the energy that is accumulated within a load profiling 

interval. This is often the preferred method for logging because it is a summation of 

only that particular period of energy. The Interval setting you make creates the 

sub-accumulation field within the general Energy accumulation. An advantage of this 

setting is that the sub-accumulation takes up less space and is processed more 

quickly then the larger accumulation. 

1. From the Revenue and Energy Settings menu, click on the + button next to Energy, 

Pulses and Accumulations in the Interval or double-click on the Energy, Pulses and 

Accumulations in the Interval line. You will see the submenu shown below.

2. The current Interval setting is displayed. Click on the Interval setting to open the 

screen shown below.

3. Set the number of minutes for the Energy interval. Note that Energy in the Interval 

should always match the Demand Interval timing.

3. Click OK to close the window and return to the main Device Profile screen. For any 

change to take effect, you must click the Update Device button to send the new 

profile to the meter.
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11.2.9: Pulse Accumulations

Pulse accumulators are used to count and/or aggregate pulse information from exter-

nal devices, using the digital high speed inputs. These devices may be gas, water, or 

electricity meters; energy management systems; SCADA devices; or any pulse-gen-

erating device. 

This section of the Device Profile displays a series of eight running totals available on 

the Nexus® 1500/1500+ meter. Each total can be added to (or subtracted from) 

other totals. This allows you to set the High Speed inputs located directly on the 

meter to accumulate pulses. 

NOTE: If you use these inputs for pulse accumulations, do not set them to record 

waveforms - if you do, you will record endless waveforms.

1. From the Revenue and Energy Settings menu, double-click on the Pulse Accumula-

tions line..

2. High Speed inputs 1-8 are listed in order under Source. Enter the following 

information or use the pull-down menus to select:
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•   Units/Count - this is the scale factor that normalizes the pulses so that they can 

be aggregated. Pulses are stored in primary values.

•   Aggregator - this allows you to place the pulse register into a separate accumu-

lation register that can aggregate (add) or net (subtract) values.

•   User Assigned Label - this window allows you to enter a label designation for the 

source. 

•   Mode - you can set Pulse or Transition. A transition means from open to shorted/

closed or from shorted/closed to open; a pulse contains 2 transitions, open to 

shorted/closed, followed by shorted/closed to open. 

•   Average Full Scale - for Nexus® meters, in order to set a limit on a reading it 

needs a Full Scale value as the 100 reference. You can set a limit on the 

average number of pulses per interval.

•   Device Hour Reading and Aggregator - source device is the meter you are 

connected to. The Hour reading is either Quadrant 1 and 4 Watt-hour or Quad-

rant 2 and 3 Watt-hour. The Aggregators indicate whether the count should be 

added to, or subtracted from, Aggregators 1-4. You can choose None if you don’t 

want the count to affect any of the Aggregators.

•   Aggregators: The “buckets,” or Totalizer fields where pulse counts from the High 

Speed inputs and from the Watt-Hour counters can be totaled. The user can 

assign a label to each of the Aggregators. See the Average Full Scale description 

above for an explanation of this field - it has the same use here, except for the 

Aggregators. 

3. When all data has been entered, click OK to return to the main Device Profile 

screen. For any changes to take effect, you must click the Update Device button to 

send the new profile to the meter.
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11.2.10: Test Mode Configuration (Nexus® 1500+ Meter)

The Nexus® 1500+ meter offers a Test Mode that is used to verify the meter’s accu-

racy. This setting lets you configure a time for the Test Mode to time out and for the 

meter to return to Normal Mode, if there is no testing activity. It also lets you restrict 

Test Mode access for either or both of the Ethernet ports. See Chapter 20 for addi-

tional Test Mode settings, and the Nexus® 1500+ Meter Installation and Operation 

Manual for more information on the meter’s Test Mode function.

1. From the Revenue and Energy Settings menu, double-click on Test Mode Configura-

tion. You will see the screen shown below.

2. Select the timeout period from the pull-down menu. The options are 0-60 minutes. 

This will be the time the meter waits before returning to Normal Mode from Test 

Mode, once there is no more testing activity.

3. If you want to restrict Test Mode from being entered through either or both of the 

Ethernet ports, click the appropriate buttons. Card 1 refers to Network card port 

#1, and Card 2 refers to the optional Network card port #2.

4. Click OK to save your changes and return to the main Device Profile screen. For any 

changes to take effect, you must click the Update Device button to send the new 

profile to the meter.
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11.2.11: Time of Use Enable/Disable (Nexus® 1500+ Meter)

The Nexus® 1500+ meter has a setting that lets you enable or disable the meter’s 

Time of Use (TOU) (see Chapter 15 for detailed information on the Nexus® 1500+ 

meter’s TOU). This is useful if you need to reset TOU, since TOU can only be reset if it 

is not active, i.e., disabled. Once TOU has been reset, use this screen to enable TOU, 

again.

NOTE: You will also use this screen to enable TOU for the first time, once you have 

set up the TOU Profile, since the meter’s default is TOU disabled.

1.From the Revenue and Energy Settings menu, double-click on Time of Use. You will 

see the screen shown below.

2. When there is a check in the box, TOU is enabled; if the box is blank, TOU is 

disabled. Clicking in the box toggles it between being checked and being 

unchecked.

3. Click OK to save your changes and return to the main Device Profile screen. For any 

changes to take effect, you must click the Update Device button to send the new 

profile to the meter.
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11.3: Power Quality and Alarm Settings

Power Quality and Alarm Settings are the third group of settings in the Device Profile.

1. From the Device Profile screen, click on the + button next to Power Quality and 

Alarm Settings or double-click on the Power Quality and Alarm Settings line. All of 

the settings in this group are listed.

2. Click on the programmable setting you want to modify. The following sections 

explain the settings in the order in which they appear in the Power Quality and 

Alarm Settings menu.

11.3.1: Limits

Limits are threshold settings that can be set by a user to trigger a record in a log 

when an alarm condition is met. Utilizing the limits, the user can then control a relay 

or send a warning email on that alarm.

Limit settings are based on a percentage of the Full Scale (% of FS), which is set in 

the Limit and Waveform Full Scales setting (Section 19.4.2). Full Scale is based on CT 

and PT ratios set in the CT, PT Ratios and System Hookup setting (Section 19.4.1).

Limits are based on a percent of Full Scale settings so that the same settings can be 

used no matter what the CT and PT Ratio needed.
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Before programming limits, set the CT and PT ratios. Then, set the Limit and Wave-

form Full Scales if you want to change to automatic configuration. In most cases the 

software will configure the Full Scale optimally. 

NOTE: The software automatically updates the Full Scale; however, you can set it 

separately from the CT and PT Ratios.

1. From the Power Quality and Alarm Settings menu, click on the + button next to 

Limits or double-click on the Limits line. You will see the submenu shown below.

This submenu displays the current Device Profile Limit settings. Not all limits are 

shown in the figure above: there are 32 Limit ID fields.
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2. Double-click on any of the settings (Limit ID 01, for example). You will see the 

Limits screen, shown below.

•   This screen can be expanded to show all of the limits. Click on the top or 

bottom of the screen to display sizing arrows you can click on and drag to 

expand the screen.

•   Percentage of Full Scale settings ( of FS): The limits are set in % of Full Scale so 

that when you create a profile, you can keep your settings. This is true, even 

though the CT and PT ratios change when the meter (or a new meter) is placed 

in a different location. Changing the CT and PT ratios does not affect the % of 

Full Scale limits previously set. This is useful when you are using large numbers 

of meters because one profile can be used with a common set of limit settings no 

matter what the CT and PT ratio. Full Scale reference information is available in 

the lower left box.

3. Make changes to this screen according to your application requirements.

•   To set the type of limit and the channel assigned to it:
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a. Double-click in either the Limit ID or Assigned Item column. You will see 

the screen shown below.

b. From the pop-up menus, choose the desired settings and click OK. Follow-

ing is a list of the available Groups, Sub Groups, and Items.

Group: Measured Values

Sub Group: High Speed Updated

Item: Voltage A-N

         Voltage B-N

         Voltage C-N

         Voltage Aux

         Current A

         Current B

         Current C

         Current N Measured

         Voltage A-B

         Voltage B-C

         Voltage C-A

         VA A

         VA B

         VA C

         VA Total

         VAR A

         VAR B

         VAR C

         VAR Total

         Watt A
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         Watt B

         Watt C

         Watt Total

         Frequency

         Power Factor A

         Power Factor B

         Power Factor C

         Power Factor Total

         Volts A-Aux Phase Angle

         Current N Calculated

         Aux Frequency

Sub Group: One second updated

Item: Voltage A-N

         Voltage B-N

         Voltage C-N

         Voltage Aux

         Current A

         Current B

         Current C

         Current N Measured

         Current N Calculated

         Voltage A-B

         Voltage B-C

         Voltage C-A

         VA A

         VA B

         VA C

         VA Total

         VAR A

         VAR B

         VAR C

         VAR Total

         Watt A

         Watt B

         Watt C

         Watt Total
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         Frequency

         Power Factor A

         Power Factor B

         Power Factor C

         Power Factor Total

         Voltage Imbalance

         Current Imbalance

         Uncompensated VA A

         Uncompensated VA B

         Uncompensated VA C

         Uncompensated VA Total

         Uncompensated VAR A

         Uncompensated VAR B

         Uncompensated VAR C

         Uncompensated VAR Total

         Uncompensated Watt A

         Uncompensated Watt B

         Uncompensated Watt C

         Uncompensated Watt Total

         THD Volts A

         THD Volts B

         THD Volts C

         THD Current A

         THD Current B

         THD Current C

         K Factor Current A

         K Factor Current B

         K Factor Current C

         Internal Temperature

         Aux Frequency

Sub Group: Harmonic Values

Item: 0 - 127th Harmonic on selectable Harmonic Magnitude

         (Voltage Phases A, B, and C; Current Phases A, B, and C)

Sub Group: Internal Inputs, States

Item: Internal Inputs 1-8

Sub Group: Phase Angles



     Doc#    E107707                                              11 - 60

11: Nexus® 1500/1500+ Meter

Item: Phase A-N Voltage

         Phase B-N Voltage

         Phase C-N Voltage

         Phase A Current

         Phase B Current

         Phase C Current

         Phase A-B Voltage

         Phase B-C Voltage

         Phase C-A Voltage

         Volts A-Aux Phase Angle

         Voltage Phase Sequence

Sub Group: Flicker

Item: Flicker: PInst Volts A

         Flicker: PInst Volts B

         Flicker: PInst Volts C

         Flicker: PST Volts A

         Flicker: PST Volts B

         Flicker: PST Volts C

         Flicker: PLT Volts A

         Flicker: PLT Volts B

         Flicker: PLT Volts C

Sub Group: Ten Second Updated

Item: Vaux Frequency

Sub Group: Meter Status

Item: General Health Indication

Sub Group: Fundamental Readings

Item: Watts - A/B/C/Total

          VAR A/B/C/Total

          VA A/B/C/Total

          Power Factor A/B/C/Total 

Group: Averages

Sub Group: Thermal Average

Item: Voltage A-N

         Voltage B-N

         Voltage C-N

         Voltage Aux
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         Current A

         Current B

         Current C

         Current N Measured

         Current N Calculated

         Voltage A-B

         Voltage B-C

         Voltage C-A

         VA A

         VA B

         VA C

         VA Total

         VAR A

         VAR B

         VAR C

         VAR Total

         Watt A

         Watt B

         Watt C

         Watt Total

         Frequency

         Power Factor A

         Power Factor B

         Power Factor C

         Power Factor Total

         Voltage Imbalance

         Aux Frequency

Sub Group: Block Window Average

Item: VA

         VAR

         Watt

Sub Group: Pulse Accumulation/Aggregation Block Window Average

Item: Internal Inputs #1 - #8

         Aggregators #1 - #4

Sub Group: Rolling Window Average

Item: VA
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         VAR

         Watt

Sub Group: Voltage and Current Means

Item: Volts PN

         Current P

         Volts PP

Group: External I/O Devices

Sub Group: Analog Input Modules

Item: Module 1: Analog Input 1 - Analog Input 8

         Module 2: Analog Input 1 - Analog Input 8

         Module 3: Analog Input 1 - Analog Input 8

         Module 4: Analog Input 1 - Analog Input 8

•   To designate the limit as either above or below a percentage of the Full Scale, 

click once in each Settings column and select the desired setting from the pull-

down menu.

•   To set the percentage of the Full Scale that will trip the limit, enter the value in 

the % of FS column. CommunicatorPQA® software automatically calculates the 

Primary value.

•   Combination Limit 3 is the logical combination of Limit 1's state and Limit 2's 

state.

Example 1

Limit I D

Type: 1 Second Readings

Channel: Volts AN

Limit 1 Setting: Limit exceeded if Volts AN is below 120 F.S.

Limit 2 Setting: Limit exceeded if Volts AN is above 80 F.S.

Combination Limit 3 Setting: AND 

If Limit 1 AND Limit 2 are tripped (e.g., the reading is 100 F.S.), then Limit 3 is 

tripped.

Example 2

Limit I D

Type: 1 Second Readings
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Channel: Volts AN

Limit 1 Setting: Limit exceeded if Volts AN is above 120 F.S.

Limit 2 Setting: Limit exceeded if Volts AN is below 80 F.S.

Combination Limit 3 Setting: OR 

If either Limit 1 OR Limit 2 is tripped (e.g., the reading is 75), then Limit 3 is 

tripped.

•   Full Scales settings are shown in the lower left of the screen. These values are 

set in the Limits and Waveform Full Scales section of the Device Profile (Section 

11.1.2).

4. Power Factor is broken into four quadrants. Selecting the Full Scale value brings up 

a screen that lets you set a limit in two of the four quadrants.

•   To set the power factor limits, double click on any of the power factor settings in 

the Limit 1 or Limit 2 columns. You will see the Power Factor screen.

•   To set a limit: from the pull-down menus, select a quadrant and Less Than or 

Greater Than (Full Scales). Enter the power factor number. The graph will 
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illustrate your selections by shading the out of limit bands. The area of the

graph not covered by shading is within normal operational range.  

NOTE: Whether you see method 1 Quadrants (Q1  +Lag, Q2  -Lag, Q3  -Lead, 

Q4  +Lead) or method 2 Quadrants (Q1  +Lag, Q2  -Lead, Q3  +Lag, Q4  -Lead) 

depends on the setting in the Power Factor Display field of the Labels setting 

(see Section 11.4.4).

    NOTE: The Nexus® 1500/1500+ device is a four-quadrant meter. Therefore, limits

    can be set for capacitive and inductive PF when generating or consuming power.

5. When all settings are complete, click OK to return to the main Device Profile 

screen. For any changes to take effect, you must click the Update Device button to 

send the new profile to the meter. 

11.3.2: ElectrologicTM Relay Control

1. From the Power Quality and Alarm Settings menu, double-click on the Electro-

Logic™ Relay Control line. You will see the screen shown below.

ElectroLogicTM Relay Control lets you set up a logic tree to control the meter’s 

2           3                                                  1           

4
4a

4b

5a

5b

6
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optional relays. Each relay can be programmed individually. The end result of the 

logic tree is to set, or not set, a relay, with an optional programmed Set Delay and/

or Reset Delay. The initial inputs to the logic tree are chosen from among the 32 

Limits and 40 Digital Inputs (both internal and external inputs). The gates, in 

several stages, perform logical combinations (AND, OR, etc) on pairs of inputs 

(either initial inputs or the outputs of earlier gates), and in combination produce an 

ultimate "true" or "false" state to drive the relay open or closed.

 For example, one of the gates is AND. For data to pass an AND gate, both pieces of 

data must be “true.” For a Limit to be true, the data must be in the Out-of-Limit 

condition on either Limit 1, Limit 2, or both (you decide which). For a Digital Input 

to be true, it must be in the condition you specify - either Open or Shorted. 

The gates in ElectroLogicTM Relay Control are used as follows:

OR: If either or both of the two conditions are true, the gate is passed

AND: If both of the conditions are true, the gate is passed

Hysteresis: For Limits only, the if the Limit is within the programmed hysteresis 

value, the gate is passed

XOR: If either of the two conditions are true, but not both, the gate is passed

NOR: If either of the two conditions are true, the gate is not passed

NAND: If both of the two conditions are true, the gate is not passed

NHysteresis: For limits only, if the Limit is within the programmed hysteresis value, 

the gate is not passed

NXOR: If either of the two conditions are true, but not both, the gate is not passed

NOTE: See Example of an ElectroLogicTM Relay Logic Tree:, on page 11-67.

2. To assign an item to the Relay Logic tree:

a. Select the relay card/module from the pull-down menu - see number 1 in the 

screen on the previous page.

b. Select an input for the tree by clicking on a radio button next to numbers 1 

through 8 - see number 2 in the screen on the previous page.

c. Choose Limits or Digital Inputs by clicking on the radio button in front of the 

word - see number 3 in the screen on the previous page. 



     Doc#    E107707                                              11 - 66

11: Nexus® 1500/1500+ Meter

d. From the pull-down menus, select the limit (Limit ID) or input (Input ID) you 

want to assign to this Relay Logic tree input (step b) - see number 4 in the 

screen on the previous page. 

• For a limit, use the second pull-down menu to select Limit 1, Limit 2, or 

Combination - see number 4a in the screen on the previous page.

• For an input, use the second pull-down menu to select Shorted or Open - 

see number 4b in the screen on the previous page.

e. Press Set to confirm your selection. The software places the selection in the 

appropriate field in the screen.

3. After you assign all the Relay Logic inputs, select the gates that will be used to 

combine the logic to trigger the relay. To select a gate type, either: 

•   Click on the gate (yellow fields) - see number 5a in the screen on page 11-65. 

•   Choose a gate type from the pull-down menu below the gate - see number 5b in 

the screen on page 11-65.

4. If you want, select Set Delay and Reset Delay from the pull-down menus. You can 

choose between 0 and 255 seconds. Use these fields if you want to program a delay 

before the relay is set, or before it is reset - see number 6 in the screen on page 

11-65.

5. To change items on the Relay Logic tree, follow the previous steps.

•   To clear an item from the Relay tree, click on that item and click the Clear 

button.

•   To clear all items from the Relay Tree, click the Clear Assigned Items button.

6. When all settings are complete, click OK to return to the main Device Profile 

screen. For any changes to take effect, you must click the Update Device 

button to send the new profile to the meter. 

NOTE: In order to use this screen, you must have purchased at least one Relay 

Option card or one External Relay Output module. For more details on external Output 

modules, see Chapter 14.
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Example of an ElectroLogicTM Relay Logic Tree:

Inputs 1 through 8 are set to High Speed Volts AN Limit 1, High Speed Amps A Limit 

1, High Speed Volts BN Limit 1, High Speed Amps B Limit 1, High Speed Volts CN Limit 

1, High Speed Amps C Limit 1, Not Set and Not Set. The four first gates are AND 

gates, and the remaining three gates are OR gates.

Each first level gate looks at the state of the two limits, and the result is "true" if and 

only if both the inputs (Voltage Limit and Current Limit) are "true" (Out-of-Limit Con-

dition). The second and third level gates look at the state of the earlier gates, and 

their results are "true" if either one (or both) of the previous gates are "true". The end 

result is a relay that is energized if one or more of the three phases (A, B, and/or C) is 

currently Out-of-Limit on both its voltage and current Limit 1 tests.

 Items 
 1-8

Gates 1-4
Gates 5 and 6 Final Gate
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11.3.3: PQ Thresholds (Waveform Recording)

The PQ Thresholds/Waveform Recording capability allows the meter to act as a high-

speed waveform recorder to record any anomaly that occurs within a cycle of dura-

tion. This provides a user with advanced waveform analysis including pre- and post- 

waveform recording. 

The meter has the capability to record both surges and sags of the measured signals. 

A voltage surge is any event that increases the RMS voltage for one cycle, calculated 

every half cycle. A voltage sag is a dip in the RMS of one cycle of voltage, calculated 

every half cycle. A current fault (or surge) is also calculated in the same manner. The 

Nexus® 1500/1500+ meter can also be set to record a waveform when voltage tran-

sients are found. When the RMS value of any of these triggers exceeds the threshold 

settings, the meter will trigger a waveform capture. In addition, you can set a voltage 

interruption to trigger IEC 61000-4-30 Class A reporting. The Nexus® 1500+ meter 

can also capture a waveform is response to an IEC 61850 Protocol GOOSE message.

The Power Quality (PQ) and Waveform Thresholds setting determines at what point 

the Nexus® 1500/1500+ meter executes a waveform capture and/or records a power 

quality event. 

See Chapter 19 for instructions on viewing Waveform and PQ logs. 

PQ and Waveform Thresholds are given as a percentage of the Full Scales (% of FS) 

or a sliding reference voltage if the load voltage is known to be fluctuating (using the 

USR setting, explained in the following instructions). Set the Full Scales in the Limits 

and Waveform Full Scales setting of the Device Profile (see Section 11.1.2). Full 

Scales are based on the CT and PT ratios set in the CT, PT Ratios and System Hookup 

setting of the Device Profile (see Section 11.1.1).

Before programming the PQ and Waveform Thresholds, set the CT and PT ratios and 

the Limits and Waveform Full Scales.

Note on Sampling Rate: A higher sampling rate allows for transients to be 

monitored. Generally, the meter is set to take 1024 samples per cycle for this pur-

pose. Lower sampling rates have advantages, however, because they allow you to 

record more cycles of information per event screen. Therefore, low sampling rates are 

better for long duration events, like motor starts or distribution faults. The meter 
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enables you to tailor its recording for both these applications. For more information on 

sampling rate, see the table on page 11-76.

The Nexus® 1500/1500+ meter has a transient feature which combines high speed 

and low speed sampling. The high sampling records the Mega Hertz speed and the low 

speed can be recorded at any desired sampling rate. When a high speed transient is 

found, the meter converts the low speed sample closest to the magnitude of the high 

speed capture. Additionally, the instrument provides the exact time of the high speed 

event. This provides the benefit of high speed data acquisition with a captured event 

that comprises only the data that is needed for analysis.

1. From the Power Quality and Alarm Settings menu, double-click on the PQ 

Thresholds (Waveform Recording) line. You will see the screen shown below.

2. This screen allows you to set the voltage RMS triggers, the current RMS triggers, 

and the voltage transients triggers for waveform recording. It also allows you to set 

the voltage interruption settings for IEC61000-4-30 Class A recording. Use the tabs 
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at the top of the screen to navigate between the voltage, current, and voltage tran-

sient and interruption settings. 

NOTES:

•   The Waveform clipping threshold for the Nexus® 1500/1500+ meter is 66.7A 

RMS and 1140V RMS on the secondary side of all channels.

•   The High Speed Inputs field allows you to see which High Speed input is enabled 

for Waveform recording. You assign the High Speed input to its trigger in the 

High Speed Inputs screen (see Section 11.3.9).

•   Voltage and current Full Scale values are shown in the lower left corner of the 

screen. 

3. The Voltage setpoints are used to record voltage type events, such as voltage 

surges and sags. To set the Voltage RMS triggers for a PQ event and waveform 

capture (Voltage RMS Triggers tab):

a. Select either Fixed RMS or USR (radio buttons). 

NOTE on USR Setting: The USR setting lets you configure waveform capture 

thresholds based on sliding reference voltage rather than Full Scale (see instruc-

tions on the next page). This is useful if you know your line voltage will be vary-

ing and you want the voltage reference to be adjusted accordingly.

The formula used is as follows:

Usrn = 0.9967 x Usr (n-1) + 0.0033 x U(10/12)rms

where 

Usrn is the present value of the sliding reference voltage;

Usr (n-1) is the previous value of the sliding reference voltage; and

U(10/12)rms is the most recent 10/12-cycle RMS value.

When the measurement is started, the initial value of the sliding reference volt-

age is set to the programmed input voltage. The sliding reference voltage is com-

puted every 10/12-cycles. If a 10/12-cycle is flagged as being out-of-limits, that 

voltage is not used - the previous sliding reference voltage is used instead.
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b. If you select Fixed RMS:

i. Enter the desired percentage of Full Scale in the Value() column of the 

Above setpoints and Below setpoints sections. After you make an entry, 

the Primary field (display only) adjusts accordingly. When the RMS value 

crosses the setpoint, a capture is taken.

ii.Enter the desired percentage for Return Hysteresis for the Above and 

Below setpoints. After you make an entry, the Primary field (display only) 

adjusts accordingly. Hysteresis is the value that must be met for the out 

of limit condition to be considered ended. Hysteresis is useful in prevent-

ing excessive out of limit conditions when the readings are hovering 

around a setpoint, since it dictates that the readings must recover to a 

certain level before dropping again in order for them to be considered out 

of limit. 

iii.Click the box(es) to enable Waveform Recording (Waveform Enable box) 

and/or PQ Recording (PQ Enable box). 

c. If you have a load with slowly changing voltage, you probably do not want to use 

Full Scale as your reference point. In that case, you can use the USR function to 

set up a sliding reference voltage rather than a Full Scale voltage reference. 

Follow these instructions:

i. If you don’t see the USR button on the screen next to the RMS button, 

then EN 50160/IEC 61000-4-30 logging is enabled, and you will need to 

disable it. From the Device Profile screen, double-click on the EN 50160/

IEC 61000-4-30 line, click the Enable PQ/Waveform, Logs 7 and 8 button, 

and click OK (see following Section 11.3.6 for detailed instructions). 
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ii.Go back to the PQ Waveform Recording screen and click the USR button. 

The top of the screen changes as seen in the example below.

iii. Enter the desired percentage of the sliding reference voltage in the 

Value() column of the Above setpoints and Below setpoints sections. 

iv.Click the box(es) to enable Waveform Recording (Waveform Enable box) 

and/or PQ Recording (PQ Enable box) when the setpoints are crossed. 
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3. To set the current RMS triggers for a PQ event and waveform capture (Current RMS 

Triggers tab - see the example screen below):

a. Enter the desired percentage of Full Scale in the Value() column of the Above 

setpoints and Below setpoints sections. After you make an entry, the Primary 

field (display only) adjusts accordingly.

b. Enter the desired percentage for Return Hysteresis for the Above and Below 

setpoints. After you make an entry, the Primary field (display only) adjusts 

accordingly. Hysteresis is the value that must be met for the out of limit condi-

tion to be considered ended. Hysteresis is useful in preventing excessive out of 

limit conditions when the readings are hovering around a setpoint, since it dic-

tates that the readings must recover to a certain level before dropping again in 

order for them to be considered out of limit.



     Doc#    E107707                                              11 - 74

11: Nexus® 1500/1500+ Meter

c. Click the box(es) to enable Waveform Recording (Enable box) and/or PQ Record-

ing (PQ Enable box). 

NOTE: The current setpoints are used to record faults on the line or in-rush 

currents from devices such as motors. Typically, to catch these events, set the 

limit to above 200 of Full Scale. As a general rule you do not want to set either:

1. Any below current thresholds because that will trigger waveforms when the 

    current drops 

2. Any above current thresholds within possible current load 

Either of these settings will constantly trigger waveforms. 

4. To set the Voltage transients trigger for a waveform capture and Voltage 

interruptions trigger for IEC61000-4-30 recording (Voltage Transients and 

Interruptions tab - see the example screen below):



     Doc#    E107707                                              11 - 75

11: Nexus® 1500/1500+ Meter

a. Enter the desired percentage of the Voltage Peak Full Scales (shown in the 

center of the screen) in the Value() column of the Voltage Transients Above Set-

points section (there are no Below setpoints for Voltage transients). After you 

make an entry, the Primary field (display only) adjusts accordingly. 

b. Click the box(es) to enable transient capture (Enable box) and/or Waveform 

(Trigger Waveform on Transient box). You might want to record a waveform at 

the time of transient capture in order to obtain more information about the tran-

sient event. 

c. Enter the desired percentage of Full Scale in the Value () field and in the Return 

Hysteresis field in the IEC 61000-4-30 Voltage Interruptions section. After you 

make an entry, the Primary field (display only) adjusts accordingly. This setting 

relates only to the reporting of voltage interruptions: it sets an internal flag for 

IEC 61000-4-30 reporting.

5. Select the number of samples per cycle to be recorded from the Sampling Rate 

field's pull- down menu. Choose from 16, 32, 64, 128, 256, 512 or 1024 samples 

per cycle. The number of samples per cycle you choose above 128 samples per 

cycle affects the number of cycles per capture. 

•   The following table shows the effects of sampling rate on the number of cycles 

captured. Increasing the sampling rate increases waveform resolution; but for     

higher sampling rates, reduces the length of the observed window. The approxi-     

mate length of the observed window is shown in the last column.
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       NOTES: 

• The table shows sampling data for 60 Hz systems.

• The table shows values for one waveform capture window. If you have 

more than one waveform capture window, the maximum time per 

capture increases. 

* Each Window contains the number of cycles listed but multiple windows are 

supported so that the total number of cycles captured is only limited by the memory 

allocated.

6. You can select Frequency - either 60Hz or 50Hz - from the pull-down menu. This is 

only to help you decide what options to select - it does not affect the meter.

7. From the Pre-Trigger Cycles and Post-Trigger Cycles fields' pull-down menus, select 

the number of cycles you want to record before and/or after the triggered 

recording. The maximum total number of pre and post-trigger cycles is one less 

than the maximum number of cycles per capture. See the table above for the 

maximum cycles per capture for each sampling rate.

8. You can select total waveform capture windows per event. You can set between 1 

and 65536 windows per event. You may want more than 1 window to get data for a 

longer time period. Also, selecting multiple windows allows you to make full use of 

the pre-trigger cycles to have extended recording of events. You always need 1 

post-trigger cycle, but can choose multiple pre-trigger cycles. As the sampling rate 

is reduced, the number of possible pre-trigger windows increases. In this way, you 

Nexus 1500/1500+ Sampling Rate Chart (at 60Hz)

Samples per 
Cycle Channels Samples per 

Channel

Cycles per 
Channel per 

Window*

Time 
(approx.)

Analog pts Digital Inputs
16 6 8 2880 180 3 sec

32 6 8 5760 180 3 sec

64 6 8 11520 180 3 sec

128 6 8 23040 180 3 sec

256 6 8 30720 120 2 sec

512 6 8 30720 60 1 sec

1024 6 8 40960 40 0.6 sec
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may choose less resolution, but more information about the conditions before a 

waveform capture.

NOTE: When you select more than one window per event, the Post-Trigger Cycles 

field cannot be changed. It will be fixed as the maximum number of cycles per 

capture minus the number of pre-trigger cycles. See the table on the previous page 

for the maximum cycles per capture for each sampling rate.

Note on CBEMA (PQ Recording): CBEMA plotting is a power quality standard 

known worldwide for recording the amount of damage Voltage transient conditions 

have done to the equipment being monitored. The meter automatically records this 

information. For CBEMA purposes, program internal set points for Voltage below 90 

and above 110 of Full Scale (+/- 10 from the nominal Voltage). These set points 

are defined by the ITI (CBEMA) specification. The ITI (CBEMA) Curve is published 

by Information Technology Industry Council (ITI) and is available online. You can 

set a recording with tighter Voltage limits to trigger a waveform recording. How-

ever, CBEMA plotting is based only on the limits internally set.

9. When all changes are entered, click OK to return to the main Device Profile screen. 

For any changes to take effect, you must click the Update Device button to send 

the new profile to the meter.
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11.3.4: EN 50160/IEC 61000-4-30 Class A Reporting 

The Nexus® 1500/1500+ meter can record power quality reporting values in two 

independent logs. When EN 50160/IEC 61000-4-30 reporting is enabled, entries are 

made into the logs when the associated values occur. All values can be downloaded to 

the Log Viewer where they are available for graphing or export to another program, 

such as a spreadsheet. Refer to Chapter 19 for additional information on viewing logs.

NOTE: The meter is calculating its Flicker based upon the EN 61000-4-15 standard 

which is referenced in the EN 61000-4-30 standard. The accuracy requirements for 

this instrument are within the Class A standards for Flicker measurements. Refer to 

Chapter 23 for additional information on Flicker standards. 

The Nexus® 1500+ meter offers customization of EN 50160/IEC 61000-4-30 report-

ing so that the user can meet specific jurisdictional or regional requirements. Section 

11.3.4.1 details the Nexus® 1500+ meter’s settings; see Section 11.3.4.2 for the 

Nexus® 1500 meter’s settings. Note that you should program the CT/PT Ratio and 

System Hookup settings for the Nexus® 1500+ meter before programming the EN 

50160 reporting - see 11.1.1: CT and PT Ratios and System Hookup, on page 11-2, 

for instructions.

IMPORTANT! Since the EN 50160/IEC 61000-4-30 reporting has specific require-

ments for programming, EIG recommends that you refer to the IEC 61000-4-30 2008 

standard before making changes to the default settings of the meter.

The meter’s Runtime Firmware version 15.2 and above support Edition 3 of IEC 

61000-4-30 standard.
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11.3.4.1: EN 50160/IEC 61000-4-30 Setting for the Nexus® 1500+

                 Meter

1. From the Power Quality and Alarm Settings menu, double-click on the EN 50160/

IEC 61000-4-30 line. You will see the screen shown below. It has multiple tabs that 

let you make all the settings for the meter’s EN 50160/IEC 61000-4-30 implemen-

tation.

2. The first tab is the Frequency tab, which lets you set acceptable frequency ranges 

and pass/fail thresholds:

•  Frequency Distribution: enter below and above percentages for four frequency 

ranges, increasing from 1-4; e.g., range 1: -1 below to 1 above; range 2: 

-2 below to 2 above, etc.
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•  Trigger Pass/Fail Limit Report on Particular Set Range: for each of the two avail-

able triggers, select the set range (1-4).

•  Pass/Fail Threshold: enter the percentage pass rate per period to that will trigger 

frequency failure reporting.

3. Click the Flicker tab. The flicker settings let you set passing value and percent 

thresholds and times for the short-term (PST) and longterm (PLT) flicker tests.

•  Set Thresholds: enter flicker value and test pass for both PST and PLT.

•  IEC 61000-4-30 Flicker: select time for the short term and long term tests from 

the pull-down menus.
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4. Click the Mains Signaling tab. This screen lets you make settings for the Mains 

Signaling voltage, which is a burst of signals (often at a non-harmonic frequency) 

that remotely control industrial equipment, revenue meters, and other devices. In 

this tab you will set the acceptable thresholds for the Mains signaling voltage.

•  Set Thresholds: set the thresholds for percentage of the fundamental voltage 

and for test passing. Settings of less than 1% are allowable for Edition 3 of IEC 

61000-4-30.

•  Set Interharmonic Frequency: enter the interharmonic frequency for the test 

when this interharmonic exceeds the detection threshold reporting is made. See 

the IEC 61000-4-30 standard’s Section 5.10.1 for more details on this setting.

•  Recording Interval (seconds): if your meter supports IEC 61000-4-30 Edition 3 

(Runtime Firmware version 15.2 or higher), you can select an interval (from 1 to 

120 seconds) for recording.
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5. Click the Rapid Voltage Changes tab. Rapid voltage changes consist of a series of 

sudden variations or cyclic variations of the nominal value of the voltage between 

two consecutive levels. Usually rapid voltage changes are caused by load changes 

or system switching. In this tab, you will set thresholds for the voltage changes, 

and the acceptable number of changes, for your reporting. Note that the Additional 

Settings at the bottom of the screen are only visible for meters with Runtime Firm-

ware versions 15.2 or higher - these additional settings are supported in IEC 

61000-4-30 Edition 3.

•  Set Threshold 1 and 2: enter the percentage change in signal from one reading 

to the next that will trigger reporting.

•  Allowed Changes per Day: defines the amount of fluctuations per day before 

reporting a fail, e.g., if you enter 5, then only the 6th change and later will be 

reported as failed.



     Doc#    E107707                                              11 - 83

11: Nexus® 1500/1500+ Meter

•  Voltage Trigger RMS Base Calculation: 10/12 cycle update is the recommended 

setting.

•  IEC 61000-4-30 Rapid Voltage Change Additional Settings: for meters that sup-

port Edition 3 (Runtime Firmware versions 15.2 and higher), you can set a 

Threshold (the % of the voltage Full Scale for each channel) and Return Hyster-

esis (the % of the voltage Full Scale for each channel) per phase AN/AB, BN/BC, 

and CN/CA.

NOTES: 

• The default for the Threshold value is 3% and the default for the Hyster-

esis Value is 1.5%.

• Make sure that the Threshold setting does not exceed the Dip/Swell 

threshold settings; and that the Hysteresis does not exceed the Threshold 

settings.
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6. Click the Supply Voltage Unbalance tab. Voltage unbalance occurs when the phase 

angles between consecutive line voltages are not equal. The degree of the inequal-

ity is usually expressed as the ratios of the negative- and zero-sequence compo-

nents to the positive-sequence component. 

In this tab, enter:

•  Set Threshold 1 and 2: enter the percentage change that will trigger reporting.

•  Source: select the update time for the data used - the choices are 10 minutes 

and 2 hours.

•  Test Pass Threshold: enter the percentage of the threshold that will cause the 

data to be considered passing, i.e., acceptable.

•  Upper Limit: select Set 1 or Set 2 as the upper limit for reporting.
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7. Click the Supply Voltage Variations tab. In this tab, you set up acceptable variations 

for the supply voltage.

•  Set Threshold 1 and 2: enter the percentage range of the nominal voltage that 

will trigger reporting.

•  Test Pass Thresholds: enter the percentage of the threshold for sets 1 and 2 that 

will cause the data to be considered passing, i.e., acceptable.
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8. Click the Ten Minute THD tab. In this tab, you set thresholds for the mean supply 

voltage THD and the average supply voltage THD. You also set the percentage for 

test failure for the mean and average THD.

•  Mean THD: enter the threshold percentage for acceptable  THD (Threshold field) 

and the percentage of the mean THD that will be considered a fail (Test Fail 

Threshold field). For example, the default Threshold is 8, and the default Test 

Fail Threshold is 95. This means that a mean THD reading of over 8 will be con-

sidered as a fail, and when more than 95 of the mean  THD readings are failed, 

the mean THD is reported as a fail.

•  Average  THD: for each harmonic magnitude from 1-25, enter the threshold per-

centage (Threshold field) and the test fail percentage (Test Fail Threshold) based 

on the average THD readings. For example, if the default average THD Threshold 

for harmonic magnitude 2 is 2, and the Test Fail Threshold is 95, then the aver-
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age THD for magnitude 2 is considered failed if over 2, and if over 95 of the 

average THD readings are failed, then the average THD for harmonic magnitude 

2 will be reported as failed.

9. Click the Voltage Durations tab. In this tab, you make settings for the duration of 

dips and swell in voltages.

•  Voltage Dips and Swells: enter the duration in milliseconds for dips and swells for 

6 levels of voltage interruptions.

•  Short Interruption Duration: select the level that will be considered a short inter-

ruption.

•  Long Interruption Duration: select the level that will be considered a long inter-

ruption.
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•  Allowed Long Interruptions in a Year: select the number of long interruptions that 

are acceptable per year.

10. Click the Voltage Sub Thresholds Tab. In this tab, you set up levels for the magni-

  tude of voltage dips and swells.

•  Voltage Dips and Swells: enter 10 levels of magnitude for voltage dips and 2 

levels of magnitude for voltage swell.

•  Interruption Threshold: select the voltage dip level that will be considered an

interruption.

•  Voltage Dip Concern: select the level that will prompt a warning before a dip 

interruption occurs.
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11. Click the General Settings tab. In this tab, you set general information for the

  report.

•  IEC 61000-4-30 Class A:

• Nominal Voltage in Secondary - enter the value for your system.

• Frequency - select the nominal frequency of your system.

•  EN 50160:

• Synchronous Connection - select Yes or No, depending on whether or not 

the system is Synchronous. This setting is only used for information 

purposes, and appears on the power quality report. Consult the IEC 

61000-4-30 2008 standard for information on how the synchronous/non-

synchronous affects how the frequency test should be conducted.

• First Day of Week - select the day you want the report to start.
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•  Temporary Power Frequency Overvoltages:

• Phase Conductor and Threshold - enter the threshold for the temporary 

power frequency overvoltage for Phase to Earth, and for Neutral to Earth. 

This number is a percentage; e.g., 170.00% over normal voltage level. 

Note that since systems can require different thresholds, the EN 

50160:2010 specification should be consulted for information on deter-

mining this setting.

• Duration - enter 2 levels of temporary power frequency overvoltages, in 

seconds; e.g., level 1: 5 seconds; level 2: 10 seconds.

12. Click the Report tab. In this tab, you can enable PQ/Waveform settings, and EN

  50160/IEC 61000-4-30 related information being trended in historical logs 7 and

  8.
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•  Click Auto-Configure to set up PQ/Waveform settings, and EN 50160/IEC 61000-

4-30 related information being recorded in historical logs 7 and 8. The two logs

will have historical trending information related to the EN 50160 report. Note 

that the EN 50160 report itself is a separate report. See Chapter 23 for informa-

tion on it. You will see the following confirmation screen.

13. Click Yes to enable the PQ/Waveform set up and recording in historical logs 7 and

  8. The screen changes as shown below.
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14. To disable EN 50160/IEC 61000-4-30 related information being recorded in histor-

  ical logs 7 and 8 and the PQ/Waveform override setup, click Enable PQ/ Wave-

  form, Logs 7 and 8. You will see this confirmation screen.

15. Click Yes - this will disable the EN 50160/IEC 61000-4-30 related information 

  being recorded in historical logs 7 and 8.

IMPORTANT! The EN 50160/IEC 61000-4-30 logs will no longer be correct, and 

the reports will be invalid.

16. When all changes are entered, click OK to return to the main Device Profile

  screen. For any changes to take effect, you must click the Update Device button to

  send the new profile to the meter.

NOTE: You can return all of the EN 50160/ IEC 61000-4-30 settings to their default 

values by clicking the Set to Defaults button.

11.3.4.2: EN 51060/IEC 61000-4-30 Setting for the Nexus® 1500

                 Meter

You must set up several parameters to properly configure flicker logging. 

1. From the Power Quality and Alarm Settings menu, double-click on the EN 50160/

IEC 61000-4-30 line. Depending on your current setting, you will see one of the 

following screens.
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2. The Nexus® 1500 meter can use Historical logs 7 and 8 to record the results of 

flicker testing: you will see the first screen if EN 50160/IEC 61000-4-30 logging has 

not been selected for the meter; you will see the second screen if it has already 

been selected. 

• If you see the first screen, click Auto-Configure. You will see this confir-

mation screen.

Click Yes - Historical logs 7 and 8 will now be used for EN 50160/IEC 

61000-4-30 logging, only. Additionally, PQ and Waveform will be config-

ured for the report.

NOTE: It takes a week for the meter to collect all the necessary data for 

the analysis.

• If EN 50160/IEC 61000-4-30 recording is already active and you want to 

disable it, click Enable PQ/Waveform Logs 7 and 8. You will see this con-

firmation screen.

Click Yes - this will disable the EN 50160/IEC 61000-4-30 logging in 

Historical logs 7 and 8. 

IMPORTANT! The EN 50160/IEC 61000-4-30 log will no longer be 

correct, and the Dip/Interruption reports will be invalid. 
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3. To make settings for EN 50160, configure the following fields (see Chapter 23 for a 

description of the EN 51060 settings):

•   Select the number of allowed rapid Voltage changes per day (1- 50).

•   Select the synchronous connection status (Yes or No: yes for a system with a 

synchronous connection to another system, no if there is no such synchronous 

connection).

•   Select the number of allowed long interruptions (0-100). 

•   Select how often RMS is updated for rapid Voltage data source (1 cycle or 10/12 

cycles).

•   Select the upper limit for the supply Voltage unbalance (less than or equal to 2 

or 3).

•   Select the Voltage dip concern threshold (greater than or equal to 10-85).

•   Select the first day of the week (Sunday or Monday).

•   Enter the Mains signaling threshold.

•   Enter the Mains signaling Interharmonic frequency.

•   Enter the Phase Conductors to Earth Thresholds in percentage of Full Scale:

• Enter the value for A-E, B-E, and C-E.

• Enter the value for N-E.
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4. To change settings for IEC 61000-4-30, first click the IEC 61000-4-30 tab.

5. Configure the following fields: 

• Enter the nominal Voltage in secondary (range from 40V to 600V). By 

supplying the nominal voltage, this field is used to calculate under and 

over deviations.

• Select the frequency (50 or 60Hz). This field is used to calculate the 

harmonics and interharmonics associated with the set fundamental 

frequency.

• Select the short term test time (1-10 minutes, in minute increments). 

PST is defined over a ten minute interval. Standard IEC 61000-4-15 

requires 10 minutes for PST.
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• Select the long term test time (10-240 minutes, in ten minute 

 increments). The standard requires 120 minutes, and is calculated from 

the PLT values. 

6. When all changes are entered, click OK to return to the main Device Profile screen. 

For any changes to take effect, you must click the Update Device button to send 

the new profile to the meter.

11.3.5: IEC 61000-4-30 Harmonic & Interharmonic Thresholds

             (Nexus® 1500+ Meter)

Use this setting to set the group and subgroup harmonic and interharmonic thresh-

olds that will be applied to the IEC 61000-4-30 reporting for the meter.

1. From the Power Quality and Alarm Settings menu, double-click on the IEC 61000-

4-30 Harmonic & Interharmonic line. You will see the screen shown below.

2. For each of the Harmonic and Interharmonic subgroup levels 0-51, you can enter a 

threshold percentage value. Use the scroll bars to view all of the levels.

3. When all changes are entered, click OK to return to the Main Device Profile screen.

4. For any changes to take effect, you must click the Update Device button to send 

the new profile to the meter.
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11.3.6: I Squared T and V Squared T Thresholds

With the I Squared T and V Squared T Thresholds screen, you can set the point at 

which the meter accumulates current and Voltage. This feature is used to calculate 

wear on circuit breaker contacts.

1. From the Power Quality and Alarm Settings menu, click on the + button next to I 

Squared T and V Squared T Thresholds or double-click on that line. You will see the 

submenu shown below, which shows the current settings for the meter.

2. Double-click one of the settings to open the I Squared T and V Squared T 

Thresholds screen, shown below.

3. Enter the thresholds in the I Squared T and V Squared T fields. 

4. Click OK to exit the screen and return to the main Device Profile screen. For any 

changes to take effect, you must click the Update Device button to send the new 

profile to the meter. 
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11.3.7: TDD Maximum Demand Reference Values

This setting of the Device Profile allows you to set the maximum value for voltage and

current, which is used for the TDD (Total Demand Distortion) calculation. TDD and 

THD (Total Harmonic Distortion) are both indices used to measure harmonics. TDD is 

defined in the IEEE 519 Standard, “Recommended Practices and Requirements for 

Harmonic Control in Electrical Power Systems” as “the total root-sum-square 

harmonic current distortion in percent of the maximum load current.” It gives a better 

indication of the impact of distortion on Demand than THD which analyzes the 

harmonic distortion relative to the fundamental, without consideration of load.

1. From the Power Quality and Alarm Settings menu, double-click on the TDD 

Maximum Demand Reference Values. You will see the screen below.

2. Enter the maximum values for voltage and current. 

•   You can find these values in the Poll Max and Min Readings polling screen (see 

Section 5.2.2 for details). 

•   You can view the TDD values in the Harmonics polling screen (see Section 5.4.2 

for details).

3. Click OK to exit the screen and return to the main Device Profile screen. For any 

changes to take effect, you must click the Update Device button to send the new 

profile to the meter.
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11.3.8: High Speed Inputs

The Nexus® 1500/1500+ meter’s built-in High Speed Inputs can be used in two 

ways:

•   Attaching status contacts from relays, breakers or other devices for status or 

waveform initiation

•   Attaching the KYZ pulse outputs from other meters for pulse counting and totaliz-

ing

Even though these inputs are capable of being used as high speed digital fault record-

ing inputs, they serve a dual purpose as KYZ counters and totalizers. The function in 

use is programmable in this setting of the Device Profile, which lets you label the eight 

High Speed inputs and to specify their status. 

•   Labeling the inputs allows you to determine the source of status change when data 

is later analyzed. 

•   This feature lets you set the High Speed Inputs’ status as a KYZ input, a trigger for 

waveform capture or PQ recording, a trigger for logging, or a means of synchroniz-

ing the meter. 

•   In the Pulse Accumulations setting (Section 11.2.10), you can assign the High 

Speed Inputs’ counts to be accumulated in one of four internal Aggregators of the 

meter.



     Doc#    E107707                                              11 - 101

11: Nexus® 1500/1500+ Meter

1. From the Power Quality and Alarm Settings menu, double-click on the High Speed 

Inputs line or click on the + button next to it. You will see the submenu shown 

below.

2. Double-click any of the Input lines. You will see the screen below.

3. Double-click a field to enter the following:

•   Name 

•   Open Label

•   Shorted Label
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•   Normal Condition

4. Click on the Input Type field to select an option from the pull-down menu. The 

available selections are:

•   KYZ Input - select this option to designate the input as a pulse (KYZ) input.

•   Waveform/PQ Trigger - select this option if you want the input to trigger a 

waveform/PQ recording (see Section 11.3.3).

•   Block Window Sync Pulse - select this option if you want to synchronize the 

meter with pulses from the input (see Section 11.2.2).

•   Event Triggered Log - select this option if you want the input to trigger logging. 

Logging occurs when the input's state changes from Open to Closed. Only one 

High Speed input at a time can be set for Event Triggered logging. You must also 

set the length of logging and the parameters to be logged (see sections 19.4.1 

and 19.4.2).

5. When you have finished making your selections, click OK to exit the screen and 

return to the main Device Profile screen. For any changes to take effect, you must 

click the Update Device button to send the new profile to the meter.
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11.3.9: Operational Status Output

This setting of the Device Profile lets you assign a relay to indicate that the meter is 

operational, i.e., when it enters Runtime. When the meter is first started up, the indi-

cator will be off, and once the meter is ready for operation, the indicator will be on. 

The relay can be monitored either by another connected device, or, if the operational 

status is assigned to one of the two LED relays, operational status will be indicated on 

the front of the meter - the LED will light up once the meter is operational.

1. From the Power Quality and Alarm Settings menu, double-click on the Operational 

Status Output line. You will see the screen shown below.

2. Click the checkbox to enable this feature and select the relay you want to assign 

from the pull-down menu. 
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3. When you finish making your selections, click OK to exit the screen and return to 

the main Device Profile screen. For any changes to take effect, you must click the 

Update Device button to send the new profile to the meter.

Note that your selection will now be reflected in the Internal KYZ screen; see the 

example screen below and refer to 11.2.3: Internal KYZ Outputs, on page 11-40.
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11.3.10: Voltage Short Term Maximum, Minimum and Average 

                Interval

This feature allows a user to capture short term high and low readings on voltage that 

would normally be missed by a 15 minute voltage snapshot log. With this feature the 

user can see the highest and lowest anomaly on the line to be able to trend voltage 

quality over a long period of time. This setting of the Device Profile lets you assign a 

voltage reading type and Historical log (Trending log) for the maximum, minimum, 

and average readings in the interval.

1. From the Power Quality and Alarm Settings menu, double-click on the Short Term 

Maximum, Minimum and Average Interval line. You will see the screen shown 

below.

2. From the pull-down menus, select:

•   Voltage reading type - can be 1 cycle updated, 10/12 cycle updated, 3 second 

updated or 10 minute updated. The voltage reading type defines which reading 

to compare for the max/min/average values. 

•   Trending log - can be Historical logs 3 - 8. The interval programmed for each log 

(see Section 11.4.1) is also displayed. The Trending log setting defines which log 

to synchronize Averaging interval to. You must still manually enter these items 

into the logs if you wish to use them for that purpose. 

3. When you finish making your selections, click OK to exit the screen and return to 

the main Device Profile screen. For any changes to take effect, you must click the 

Update Device button to send the new profile to the meter.
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11.4: Trending Profile Settings

Trending profiles allow you to set up which parameters you wish to trend in the 

meter’s historical memory. Virtually any reading that the meter measures can be 

stored in the meter’s memory to be logged for later download to the host software. 

This section of the Device Profile enables you to configure parameters for the Nexus® 

1500/1500+ meter's eight historical logs and the Event Triggered log.

1. From the Device Profile screen, click on the + button next to Trending Profile

 Settings or double-click on the Trending Profile Settings line. You will see the menu 

shown below.

2. Double-click on one of the Trending lines to access the programming screens.

NOTE on Load Profile Recording: Load Profile recording is a subset of the Nexus® 

meter's more general logging and trending capability. The same screens are used for 

setup, but Load Profile recording only deals with accumulated values; Energy (Wh), 

reactive Energy (VARh) and apparent power (VAh).

Historically, Load Profile recording referred to recording of quadrant 1 Energy (Wh) 

because electromechanical meters only measured energy and were designed to 

prevent reverse rotation outside of quadrant 1.

NOTE: When using MV90, you must set up your load profile in Log 1 and Log 2. The 

MV90 TIM will only read from the first two logs. The additional logs can be used to 

bring additional data down via the CommunicatorPQA® application.

11.4.1: Programming the Trending Log Time Intervals

The Trending Log Time Intervals setting determines the interval at which the 

Historical logs take a "snapshot" of data, and the length of time logging continues for 

the Event Triggered log (see Section 11.3.8 for information on setting the Event 

Triggered log). To set the parameters for the logs, see Section 11.4.2. See Chapter 16 

for information on retrieving logs and Chapter 19 for information on viewing logs.
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1. From the Trending Profile Settings menu, double-click Trending Log Time Intervals 

or click the + button next to it. You will see the submenu shown below. The 

submenu shows both the intervals set for logs 1 through 8, and the length of 

logging for any Event Triggered log. It will also show if Logs 7 and 8 are enabled for 

EN 50160/IEC 61000-4-30 logging. 

•   To change the interval for a Historical log, double-click on one of the log 

numbers.

•   To change logging time for an Event Triggered log, double-click on the Event 

Triggered log.

NOTE: You can also access the Interval setting screens from the Trending Setup 

screens (see Section 11.4.2).

2. Depending on your selection, follow instructions in step a or b.
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a. If you click on Logs 1-8, you will see the screen shown below. 

b. This screen lets you set the interval for the Historical (Trending) logs. The 

interval cannot be greater than one hour. Enter either:

• 1 Hour 

               or either or both of the following:

• Minutes

• Seconds



     Doc#    E107707                                              11 - 109

11: Nexus® 1500/1500+ Meter

c. If you click on Event Triggered Log, you will see the screen shown below. It 

displays the High Speed input that is assigned to the Event Triggered log (see 

Section 11.3.8) and the amount of time (in seconds) that logging continues after 

the trigger, i.e., when the High Speed input assigned to the log goes from an 

open state to a closed state. 

Select the amount of time for logging from the pull-down menu. You can select 

from 1 to 60 seconds.

NOTE: You enable the Event Triggered log in the High Speed Inputs setting (see 

Section 11.3.8).

4. Click OK to save your changes. For any changes to take effect, you must click the 

Update Device button to send the new profile to the meter.
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11.4.2: Programming the Trending Setup 

The Trending Setup controls the channel assignments for Historical logs 1 - 8 and the 

Event Triggered log. See Chapter 16 for instructions on retrieving logs, including using 

the HHF Converter.

1. From the Trending Profile Settings menu, click on the + button next to Trending 

Setup or double-click on the Trending Setup line. You will see the submenu shown 

below.

2. Double-click on the log whose settings you want to configure. You will see the 

Trending Log Profile screen for the log you selected. An example screen is shown on 

the next page.
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3. Make changes to this screen according to your application requirements. The 

screen fields are:

•   Group - using the pull-down menu, select the type of snapshot. The options are: 

Measured Values, Averages, Accumulators, Interval Accumulators, External I/O 

Devices, RTU Master Items, Option Cards, and Input Registers. 

•   Sub-Group - using the pull-down menu, select a channel for the snapshot. The 

options you see depend on the Group you selected.
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•   Sub-Group 2 - with some selections, a second sub-group field will be shown 

underneath the first one. 

•   Highlight items in the Selectable Items(s) box and click Add to include the 

selections in the Log. The items are copied to the Selected Item(s) box. To 

remove an item from the log, highlight the item in the Selected Item(s) box and 

click Remove or double-click the item. The item is removed from the Selected 

Item(s) box. 

NOTES: 

•To select multiple items, hold Ctrl while highlighting the items.

•To select a range of items, click the first item, hold Shift, and click the last 

item

•Move the cursor to the lower left corner of an item, or group of items, to

view its size in bytes.

•   The Total Bytes Used and Bytes Remaining fields display the amount of memory 

used for each record of the log. The meter assumes 256 bytes of memory for 

each record. Total memory is determined by V-SwitchTM key and configured log 

size (see Section 11.1.8).

•   Click Set Interval to open the Interval Log Setting screen (see Section 11.4.1).

4. When all changes have been entered, click OK to return to the main Device Profile 

screen. For any changes to take effect, you must click the Update Device button to 

send the new profile to the meter.
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11.5: External I/O Modules

The Nexus® 1500/1500+ meter has the ability to have its I/O expanded using exter-

nal I/O modules. These modules add both analog and digital inputs and outputs to the 

meter to greatly expand the capability of the instrument. The meter also has two 

internal slots to mount expansion digital I/O, including 6 relay outputs and 16 digital 

inputs - see Section 11.6 for information on the internal I/O options.

This setting of the Device Profile allows you to set up the meter’s optional external 

Input/Output modules (see Chapter 14 for more information on the I/O modules) and 

RTU Master settings. I/O modules work as Modbus slave devices. The meter polls 

these modules to get the data from them. I/O modules generally have default RS485 

Modbus addresses. So, they don’t have to be configured. Once you set up which 

module you want, put in the default address and start with the basic configuration of 

readings you desire to gather.

11.5.1: Configuring the Input/Output Modules

1. From the Device Profile screen, double-click on the External I/O Modules icon. You 

will see the screen shown below.
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2. Click in the Type column and use the pull-down menu to select the specific module 

you want to add. The Assigned Address, Nexus® settings, and Module settings you 

can make depend on the module you are configuring. The modules and settings are 

as follows:

* The Assigned address on this screen is the address the meter uses to identify the

    I/O module. The default is the factory set address, which you can change by

    clicking in the field and choosing a new address from the pull-down menu. This

    address is not the actual I/O module address. You set that from the I/O Devices

    menu; see Chapter 14 for instructions. 

Module Assigned
Address* Nexus® Setting** Module Setting

4PO1 - KYZ Output 160* Click to Edit Relay Accumula-
tions

Click to enter Transmit Delay and 
configure KYZ outputs’ Watt/pulse, 
rollover and minimum pulse width.

20mAON4 - Analog 
Transducer Signal 
Outputs, 4 channels, 
4-20 mA

132* Click to Assign Items to and 
configure the Analog Outputs

Click to enter Transmit Delay and 
configure Channel settings 

20mAON8- Analog 
Transducer Signal 
Outputs, 8 channels, 
4-20 mA

132* Click to Assign Items to and 
configure the Analog Outputs

Click to enter Transmit Delay and 
configure Channel settings 

1mAON4 - Analog 
Transducer Signal 
Outputs, 4 channels, 
0-1 mA

128* Click to Assign Items to and 
configure the Analog Outputs

Click to enter Transmit Delay and 
configure Channel settings 

1mAON8 - Analog 
Transducer Signal 
Outputs, 8 channels, 
0-1 mA

128* Click to Assign Items to and 
configure the Analog Outputs

Click to enter Transmit Delay and 
configure Channel settings 

4RO1 - Digital Output 156* Click to configure Relays Click to enter Transmit Delay

8AI1 - Analog Input 
Module, 0-1 mA

247* Click to configure Analog 
Outputs

Click to enter Transmit Delay and 
configure Channel settings

8AI2- Analog Input 
Module, 0-20 mA

247* Click to configure Analog 
Outputs

Click to enter Transmit Delay and 
configure Channel settings

8AI3 - Analog Input 
Module, 0-5 VDC

247* Click to configure Analog 
Outputs

Click to enter Transmit Delay and 
configure Channel settings

8AI4 - Analog Input 
Module, 0-10 VDC

247* Click to configure Analog 
Outputs

Click to enter Transmit Delay and 
configure Channel settings



     Doc#    E107707                                              11 - 115

11: Nexus® 1500/1500+ Meter

**When you click in this field you see an Edit button. Click the button to open a

    screen that lets you edit that module. See the following example screens.

                                         4PO1 Screen - Pulse Output module

This screen allows you to assign a KYZ output to an accumulator. Click on the pull-

down menu to select accumulation configuration for each of the 4 relays. The 

options are: 

•   Disabled

•   Quad (1+4) Watthr

•   Quad (2+3) Watthr

•   Quad (1+2) VARhr

•   Quad (3+4) VARhr

•   Quad (1+2+3+4) VAhr

•   Quad 1 Watthr

•   Quad 2 Watthr

•   Quad 3 Watthr

•   Quad4 Watthr

•   Quad 1 VARhr

•   Quad 2 VARhr

•   Quad 3 VARhr

•   Quad 4 VARhr
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•   Quad 1 VAhr

•   Quad 2 VAhr

•   Quad 3 VAhr

•   Quad 4 VAhr

•   +Qh Total

•   -Qh Total

•   Internal Input (#1-8) Totals

•   Accumulation (#1-4) Totals

•   External Digital Input Modules (1-4) Inputs (#1-8)

•   I Squared T (A, B, C)

•   V Squared T (A,B,C)
                                      20mAON4 Screen: 4 channel Analog Output 
                                      module, 4-20 mA

   Click in Output channels 1-4 to assign them to a parameter. The other Analog 

   Output Modules - 20mAON8, 1mAON4, and 1mAON8 have similar setting screens,

   except for the number of channels you can program. 

•   The analog outputs are used to send a variable current dependent on the 

programmed reading. This screen lets you select the readings to output.
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                                           4RO1 Screen- Relay Output module

Click in the Relay fields 1-4 to enter relay label, common shorted to N.C., com-

mon shorted to N.O., and check the box to lock the relay to manual control. 

When a relay is locked to manual control, it cannot be used in ElectroLogic Relay 

Control (see Section 11.3.2 for information on ElectroLogic Relay Control).

                                       8AI2- Analog Input Module, 4-20 mA

    Click in Input Channels 1-8 to assign a label and a High and Low Value for each of

    the analog inputs. 

•   The two analog input module’s settings are the same, except for the Inputs’ high 

and low range.
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•   The High and Low Value fields let you map the inputs’ high and low range to 

values that are appropriate for the parameters you are measuring. For example, 

in the screen above, the first input is measuring temperature. The high value for 

the input is set to 100, and the low value is set to 0. An input reading of 12mA 

will translate to 50 for the temperature.

The Analog Input modules can be trended in the historical logs, and the data can 

be viewed and graphed in Log Viewer (see Chapter 19 for details). The readings 

shown in the logs and graphs will use the setting range programmed in the 

screen above, i.e., the results will be reported as 0 through 100.   

3. Click OK to return to the main Device Profile screen. For any changes to take effect, 

you must click the Update Device button to send the new profile to the meter. 
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11.5.2: RTU Settings

The Nexus® 1500/1500+ meter provides a feature that allows it to act as a simple 

Remote Terminal Unit (RTU). It can poll Modbus registers from downstream devices 

and bring that data into its memory for logging. This is very useful when trying to 

integrate data from existing, simpler, legacy Modbus devices. This section of the 

Device Profile enables you to configure RTU Master settings. This feature is used when 

you want to have the meter act as an RTU, polling data from other Modbus-based 

devices, such as lower end meters.

1. From the Device Profile screen, click on the + button next to the External I/O Mod-

ules line. You will see the menu option shown below.

2. Double-click on RTU Settings. You will see the screen shown below.

Use this screen to configure the settings when Port 2 is set as an RTU Master (see 

Section 11.1.5).
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3. The first view you see is the Group Main tab (shown on the previous page). This 

screen lets you set up the RTU Master groups, i.e. the devices the Nexus® 1500/

1500+ meter is polling. You can enter up to 16 groups. You have the following 

options:

•   Click Add to add a Master group. Fill in the Description, Device Address, Starting 

Register, and Number of Registers; click Save to save your entries.

•   Click on a group and click Edit to change data for the group; click Save to save 

your changes.

•   Click on a group and click Remove to delete the group.

•   Click on a group and click Up or Down to change the position of the group.

4. Click the Group Details tab to set up the readings for the devices. See the example 

screen shown below.

You have the following options:
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•   Click Add to add a reading to the group. Fill in the Data Type, Size in Bytes, Byte 

Order, Multiplier Information, and Slave Starting Register (the Master Starting 

Register is read-only); click Save to save your entries.

NOTE: The readings in the group must have consecutive register numbers. If 

necessary you can break the readings into two or more groups.

•   Click on a reading and click Edit to change data for the reading; click Save to 

save your changes.

•   Click on a reading and click Remove to delete the reading from the group.

•   Click on the Selected Group pull-down menu to select and display details for 

another group.

5. Click OK to return to the main Device Profile screen. For any changes to take   

effect, you must click the Update Device button to send the new profile to the 

meter. 

NOTE: For more details on I/O Modules, see Chapter 14.

You can then use the polled data in the following ways:

•   Access the data using Modbus protocol: Modbus registers, starting at #define 

MB_REG_NEXUS_MASTER_DATABASE 0x03800;

#define MB_REG_NEXUS_MASTER_DATABASE_LEN 0x00080. 

You can see the Nexus® 1500/1500+ meter’s full Modbus map in the Nexus® 1500 

(or) 1500+ Meter Modbus User Manual. 
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•   Log the data by selecting Master RTU Items for the group in the Trending Profiles 

screen: see the example screen, below. 

http://www.electroind.com/products/Nexus_1500/pdf/manuals/E154703_Nx_1500_Modbus_Man.pdf
http://www.electroind.com/products/Nexus_1500/pdf/manuals/E154703_Nx_1500_Modbus_Man.pdf
http://www.electroind.com/products/Nexus_1500/pdf/manuals/E154703_Nx_1500_Modbus_Man.pdf
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11.6: Internally Mounted Option Cards (Nexus® 1500+ Meter)

The Nexus® 1500+ meter has two internal slots to mount expansion digital I/O. The 

options include 6 relay outputs and 16 digital inputs. In addition to the internal I/O, 

there are also a large variety of externally mounted I/O modules that can also be 

added (see Section 11.5). The last Nexus® 1500+ meter’s Device Profile settings let 

you program the Relay Output and Digital Input Option cards. You can install up to 

two of these internally mounted Option cards in a meter. Refer to the meter’s Installa-

tion and Operation Manual for additional information on these and other Nexus® 

1500+ meter Option cards.

1. From the Device Profile screen, click on the + button next to the Option Cards line. 

You will see the menu option shown below.

2. To set relay assignments for the Relay Output Option card, continue to Section 

11.6.1; to set digital inputs for the Digital Input Option card, go to Section 11.6.2.
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11.6.1: Relay Assignments (Relay Output Option Card)

This setting allows you to label relays and their states and to set manual control of 

relays. 

1. From the Power Quality and Alarm Settings menu, click on the + button next to 

Relay Assignments or double-click on the Relay Assignments line. You will see the 

submenu shown below (the number of Relay Out cards you see depends on your 

meter’s configuration).

2. Click the Relay card you want to configure. You will see the screen shown below.

3. You can enter a label for the:

• Relay, which can be used to describe what the relay is used for, attached 

to, its function, or its purpose

• Common shorted to N.C condition, which can be used to describe the 

condition or state when the relay’s common connection is shorted to the 

N.C. connection 
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• Common shorted to N.O. condition, which can be used to describe the 

condition or state when the relay’s common connection is shorted to the 

N.O. connection

4. If you want to set any of the relays so that they can only be controlled manually, 

click the Lock to Manual Control checkbox. Then use the Relay Control feature (see 

Tools menu information in Section 20.1 for instructions) to manually change the 

state of the relay.

5. When all settings are complete, click OK to return to the main Device Profile 

screen. For any changes to take effect, you must click the Update Device button to 

send the new profile to the meter. 
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11.6.2: Digital Inputs (Digital Inputs Option Card)

The Digital Inputs Option card can be used to either count pulses, for example, from a 

KYZ module or another meter, or to monitor the status of a circuit or equipment, e.g., 

breakers or transformers. Up to two cards can be entered into a meter. This setting 

allows you to configure the Digital Inputs Option card(s). 

1. From the Power Quality and Alarm Settings menu, click on the + button next to 

Digital Inputs or double-click on the Digital Inputs line. You will see the submenu 

shown below (the number of Digital Input cards you see depends on your meter’s 

configuration).

2. Click the Digital Input card you want to configure. You will see the screen shown 

below.
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3. For each of the 16 inputs, you can enter a label for the:

•   Channel, which can be used to describe its function or its purpose

•   Open condition 

•   Closed condition

4. For each of the inputs, select the Normal state from the pull-down menu.

5. The rollover value tells when each of the state counters will roll over. Enter a 

number between one and 4294967295.

NOTE: You can click Initialize to have the software automatically set up the 

card’s settings to the values shown in the screen above.

6. When all settings are complete, click OK to return to the main Device Profile 

screen. For any changes to take effect, you must click the Update Device button to 

send the new profile to the meter. 
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12: Nexus® 1262/1272 Meter
This chapter explains how to configure a Nexus® 1262/1272 meter's programmable 

settings, which are stored in the unit's Device Profile. Chapter 7 contains detailed 

information on the Device Profile. 

The settings screens shown in this chapter are for the Nexus® 1272 meter. The 

programming screens you see vary slightly, depending on the options ordered with 

your meter. The Nexus® 1262 meter has most of the same settings, though there are 

be slight differences due to different capabilities. See Section 2.1: Meter Comparisons 

on page 2-1 for more information. 

12.1: Device Profile General Settings

1. From the Device Profile screen, double-click on the General Settings line or click on 

the + button next to it. All of the settings in the General Settings group are listed.

2. Click on the programmable setting you want to modify. The following sections 

explain the settings in the order in which they appear in the General Settings 

menu.

If you are connected to a Nexus®1262 meter, the second setting will say: Limit Full 

Scales.
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12.1.1: CT and PT Ratios and System Hookup

Functional Overview of CT and PT Ratios:

Current and Potential Transformers are used mainly for the following reasons:

•   To insulate, and as a result isolate, the meter from high-voltage circuits.

•   To change the primary voltage and current to standard values and sizes that the 

meter can measure.

The CT and PT transformers deliver fractions of the primary voltage and current to the 

meter. With properly set ratios and multipliers, the readings of the meter can be used 

to determine the energy, voltage, current, or power of the system. 

1. From the General Settings menu, click the + button next to CT, PT Ratios and 

System Hookup. You will see the submenu shown below.

This submenu displays the current Device Profile's settings for CT, PT ratios, 

connection type, and Operational Frequency range. 
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2. Double-click on any of the settings. You will see the CT and PT Ratios screen. 

3. Make changes to this screen according to your application requirements.

When you change a PT or CT Ratio, CommunicatorPQA® software updates the cor-

responding Full Scale value entered in the Limit and Waveform Full Scales setting. 

When you click OK on this screen, CommunicatorPQA® software opens the Limit & 

Waveform Full Scales screen so that you can verify the settings (see Section 

12.1.2: Limit and Waveform Full Scales on page 12-4). 

•   Enter Primary and Secondary Current and Voltage.

•   Using the pull-down menu, choose the Hookup mode that matches the connec-

tion you have to the Nexus®1262/1272 meter. Choose from the following: 

• Wye (No PTs or 3 PTs, 3 CTs)

• Delta (No PTs, 2 PTs or 3 PTs, 3 CTs)

• Delta (No PT or 2 PTs, 2 CTs)
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• 2.5 Element Wye (No PTs or 2 PTs, 3 CTs) 

This value must be set properly for the meter to calculate readings 

correctly.

See the Nexus® 1262/1272 Meter Installation and Operation Manual for 

connection diagrams.

•   Using the pull-down menu, select Operational Frequency Range: 

• 20Hz to 65Hz

• 350Hz to 500Hz

• 20Hz to 500Hz    

4. Click OK. If changes have been made, a message window opens asking you to 

verify that the Limit Full Scales are correct. 

5. Click OK. The Limit and Waveform Full Scales screen opens (see Section 12.1.2: 

Limit and Waveform Full Scales on page 12-4). 

6. To implement any changes, click the Update Device button to send the new 

profile to the meter. 

You will see a warning message that logs will be reset, and you will be given the 

opportunity to retrieve the logs before they are cleared. Resetting the logs 

prepares the meter for placement in a new installation or change of the meter 

Transformers.

12.1.2: Limit and Waveform Full Scales

All Limit and Waveform settings (see Section 12.3.1: Limits on page 12-67 and

Section 12.3.3: PQ Thresholds (Waveform Recording: Nexus® 1272 Meter Only) on 

page 12-82) are based on a percentage of the Full Scale. Full Scales are based on the 

CT and PT ratios (see Section 12.1.1: CT and PT Ratios and System Hookup on 

page 12-2). The % of Full Scale is defaulted based on the CT and PT ratio. If the user 

wants, the Full Scales can be adjusted to the actual power system condition, to opti-

mize the triggering conditions.

For the Nexus® 1262 meter, this screen is called Limit Full Scales, since the 1262 

does not support Waveform recording.
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Set the CT and PT ratios first; CommunicatorPQA® software automatically recalcu-

lates the Full Scales every time the CT and PT ratios change and presents them for 

your verification. 

1. From the General Settings menu, click on the + button beside Limit and Waveform 

Full Scales or double-click on the Limit and Waveform Full Scales line. You will see 

the submenu shown below.

This submenu displays the current Device Profile's settings for the Limit and 

Waveform Full Scales. The values shown here are the default meter settings.

Frequency and Voltage values are nominal values. The Power Phase is computed using 

nominal Voltage and rated maximum current. In most cases the software automati-

cally computes the proper value - you will not need to change it.
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2. Double-click any of the settings. You will see the Limit and Waveform Full Scales 

screen.

3. Enter the Full Scale for each parameter.

NOTES:

•   The Limits and Waveform settings (Sections 12.1.1 and 12.3.5, respectively) are 

based on a percentage of the Full Scales entered here.

•   CommunicatorPQA® software automatically recalculates the Full Scale Voltages, 

currents and power every time the CT and PT ratios change. However, 

frequency is not changed, even if the operational frequency range is changed. 

Frequency can only be changed on this screen.

•   Power Phase is the amount of power per each phase; Power Total is the power of 

all phases combined.

4. When all changes are entered, click OK to return to the main Device Profile screen. 

For any changes to take effect, you must click the Update Device button to send 

the new profile to the meter. 
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12.1.3: Time Settings

To edit a Device Profile's Time settings:

1. From the General Settings menu, double-click on the Time Settings line. You will 

see the submenu shown below. DST stands for Daylight Savings Time.

2. Double-click on any of the programmable settings; you will see the Time Settings 

screen.

3. Make changes to this screen according to your application requirements.



     Doc#    E107707                                             12 - 8

12: Nexus® 1262/1272 Meter

•   Zone Descriptor: A Zone Descriptor sets the time zone for the meter. 0 = Green-

wich Mean Time. Consult the chart below to find the Zone Descriptor for your 

time zone.

•  Daylight Savings Information:

• Disabled: Disables an automatic adjustment for Daylight Savings Time.

• Auto DST: Sets Daylight Savings Time automatically to the pre-2007 

standard for the United States: the time changes automatically occur at 

2:00 AM (your local time), on the first Sunday in April and the last 

Sunday in October.

• Auto DST U.S. EPA 2005: Sets Daylight Savings Time automatically to 

the 2007 standard for the United States: the time changes automatically 

occur at 2:00 AM (your local time), on the second Sunday in March and 

the first Sunday in November.

GMT Greenwich Mean Time Table (Dublin, London)

-1.00   Azores +1.00   Brussels, Paris, Warsaw

-2.00   Mid-Atlantic +2.00   Athens, Cairo, Helsinki

-3.00   Buenos Aires, Georgetown +3.00   Baghdad, Kuwait, Moscow, 
Tehran

-4.00   Atlantic Time (Canada), Santiago +4.00   Kabul, Baku

-5.00   Eastern Time (USA and Canada), 
Lima

+5.00   Karachi

-6.00   Central Time (USA and Canada), 
Mexico City

+6.00   Dhaka

-7.00   Mountain Time (USA and 
Canada)

+7.00   Bangkok, Hanoi, Jakarta

-8.00   Pacific Time (USA and Canada), 
Tijuana

+8.00   Beijing, Hong Kong, Singapore

-9.00   Alaska +9.00   Osaka, Sapporo, Seoul

-10.00  Hawaii +10.00  Brisbane, Melbourne, Guam, 
Hobart

-11.00  Midway Island +11.00  Magadan, Solomon Islands

-12.00  Eniwetok +12.00  Auckland, Fiji
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• User Defined: Allows you to set the Daylight Savings Time start and end 

times manually. Fields open that let you set the beginning and ending 

dates for Daylight Savings Time.

•   Line Synchronization: set Enable or Disable and Frequency. 

• Line synchronization uses the frequency zero crossings to provide a time 

reference for the meter. The basic function of Line Frequency Clock 

Synchronization is to adjust the real time clock to track the time based on 

the power line frequency. For this purpose, Phase A voltage only is used.

• This is the most common method to synchronize a meter’s clock. EIG 

recommends that you always select this method unless there is a specific 

reason not to select it. If the meter is not synchronized to line frequency 

or IRIG-B, it will default to internal crystal. Different meters differ in 

terms of drift, but typically meters with 20 ppm crystals will drift 30 sec-

onds per month when set to internal crystal.

• Line Sync is disabled if an IRIG-B signal is detected. In that case, the unit 

synchronizes to the IRIG-B signal and doesn’t rely on the internal signal 

unless the IRIG-B signal is lost.

• How Time is Adjusted

After the clock is synced to the line, the meter periodically checks the 

cumulative difference between the real time clock in seconds and the line 

cycle count. If the absolute difference between the two accumulations is 

more than 1 second or 60 (50) cycles, the clock is adjusted + / - 1 second 

accordingly.

4. To set the meter's on-board clock, use Set Device Time from the Tools Menu (see 

Section 20.1: Tools Menu on page 20-1).

5. When all changes are entered, click OK to return to the main Device Profile screen. 

For any changes to take effect, you must click the Update Device button to send 

the new profile to the meter.



     Doc#    E107707                                             12 - 10

12: Nexus® 1262/1272 Meter

12.1.4: Labels

Labels are user-defined names for the Nexus® 1262/1272 meter and the 

I N Measured terminal. You also use the Labels screen to select the power direction, 

and the power factor display.

It is important to label the meter (under "Meter Designation") with a unique name 

because that label becomes the file name of any logs retrieved from that meter. Dupli-

cate meter designations interfere with retrieved log databases. See Chapter 19 for 

more details on logs.

1. From the General Settings menu, double-click on the Labels line. You will see the 

submenu shown below.
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2. Double-click on any of the parameters; you will see the Labels screen.

3. Enter labels in the appropriate fields.

•   Meter Designation must be set for partial log retrieval. You can use any charac-

ter allowed by the Windows® operating system. 

• In English versions the following characters don’t work: 

 \ / : * ? " < > | 

• For meters used internationally by multilingual users, we recommend you 

use only alphanumeric characters allowed by your operating system.

•   Your selection in Power Direction determines which quadrants of Watt-hours are 

considered Received and Delivered.

•   Your selection in Power Factor Display determines the display of Quadrants in 

the Power Factor screen.

•   The Memo field is used to enter notes about the meter, such as the location, or 

other relevant details.
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•   The Phase Angle representation determines how the voltage phase angles are 

represented. 90 of users will use the default, which is the first radio button: 

“Positive angle for events after the reference and negative angle for events prior 

to the reference’; however, you can choose the opposite display by selecting the 

second radio button, if you wish.

4. When all changes are entered, click OK to return to the main Device Profile screen. 

For any changes to take effect, you must click the Update Device button to send 

the new profile to the meter.
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12.1.5: Communications 

1. From the General Settings menu, double-click on the Communications line. You will 

see the submenu shown below.
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2. Double-click on any of the settings (e.g., "Optical Port"): you will see the 

Communications Settings screen. 

NOTE: You may use the onboard display or one of the Nexus® External Displays to 

learn the current baud rate, address and communication protocol of each meter 

port. See the Nexus® 1262/1272 Meter Installation and Operation Manual for 

details. 

3. Make changes to this screen according to your application requirements by clicking 

on the box or pull-down menu of any of the following settings:

•   Address: assign an address to each port to communicate with other devices. 

Multiple Nexus® meters on an RS485 bus must each have a unique address set 

for the port that is connected to the bus. 

•   Baud Rate: from the pull-down menu, select 4800, 9600, 19200, 38400, 57600, 

or 115200. The baud rate entered in this field must match the baud rate of the 
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device connected to the Nexus® 1262/1272 meter at this port. Use 9600 for 

modem connections. 

•   Data Bits: use the pull-down menu to select from: 5, 6, 7 or 8. For Modbus RTU 

and ASCII, leave the data bits at 8.

•   Parity: use the pull-down menu to select from: None, Even, Odd, Mark or Space. 

For Modbus RTU and ASCII, leave the parity at None.

•   Stop Bits: use the pull-down menu to select from: 1, 1.5 or 2. For Modbus RTU 

and ASCII, leave the stop bits at 1. 

•   TxDelay (Transmit Delay): use the pull-down menu to select from: 0 ms to 2550 

ms. Leave the Tx delay at 0ms unless you are using equipment that requires a 

delay in the response time, such as a radio modem.

•   Protocol: use the pull-down menu to select from Modbus RTU, Modbus 

ASCII, or DNP3. Direct connections made through CommunicatorPQA® software 

must use either Modbus RTU or Modbus ASCII protocol (we recommend Modbus 

RTU). Modem connections made through CommunicatorPQA® software must 

use Modbus ASCII only. See Chapter 2 for details.

•   Mode (Port 4 only): If you are using Output modules, set this port to Master 

(I/O modules) mode. Set the port to operate at 57600 baud.   

•   Internal Network Option: If your meter has the Internal Network Option 

(INP100/INP200), see your Network Administrator for the correct settings to 

enter into the Network Settings fields. Settings will vary from network to 

network. 

•   If your meter has the INP100/INP200/ INP102/INP202 Option (10/100BaseT 

and Combo Card), you will see the Advanced Settings button: click it to open a 

screen that lets you set Network card features; see Chapter 21 for details.

•   Internal Modem Settings: If your meter has this option: 

a. Set the number of Rings to Answer from the pull-down menu. 

b. Set the Baud Rate to match your system's baud rate. 
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c. Click Dial-Out Profile to access the Modem Programming screen: see Chap-

ter 24 for instructions on using the Modem Dial In/Dial Out Function. 

4. When all changes are entered, click OK to return to the main Device Profile screen. 

For these changes to take effect, you must click the Update Device button. This 

sends the new profile to the meter. 

IMPORTANT! 

•   In order to prevent communications problems, be careful when making changes in 

the Communications Settings screen. For example, if you change the baud rate of 

the port connected to a computer, be sure to make the same change to the com-

puter port's baud rate. If you change a port's address, be sure to update the 

address settings of any device that communicates with the port. 

•   The baud rate of the port used by the Nexus® External Display should always be 

set to 9600 and the address set to 1.
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12.1.6: DNP Custom Class Map

The DNP Custom Class Map lets you set up DNP communication for the meter. From 

the General Settings menu, double-click on the DNP Custom Classes Map line and on 

the DNP Level 2 line. You will see the screen shown below. 

 For details on programming the DNP Level 2 settings, see Chapter 22.
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12.1.7: Custom Modbus Map

The custom Modbus map for the Nexus® 1262/1272 meter can position up to 256 

Registers (or the equivalent of 2K, whichever is lower) to readily provide the function-

ality you want from your meter. In addition, you can customize selected values for 

format type, Scaling, byte order, data size, etc. This allows a user to optimize Modbus 

registers by putting them in a particular order and/or format to make the SCADA poll 

more quickly and efficiently.

1. From the General Settings menu, double-click on the Custom Modbus Map line. You 

will see the screen shown below.

Data entry is straightforward. Each entry field is described below. Note that not all 

selections appear on the screen at the same time. Use the scroll buttons to view 

additional data/entry fields on the screen. Certain entries (such as Format, Data 

Size, etc.) have different allowable selections depending on the data point used. 

The pull-down menu adjusts to provide the appropriate selections for each data 

point.

•   Data Point Selection: there are two different ways to select a data point:

a. Refer to the Nexus® 1262/1272 meter’s Modbus map and find the associ-

ated line and point for the value you want. When you enter those values 

into the screen table, the software displays the associated group and chan-

nel.

•The Nexus® 1262/1272 meter’s Modbus map can be downloaded from 

the EIG website:http://www.electroind.com/pdf/modbus2.pdf

http://www.electroind.com/pdf/modbus2.pdf
http://www.electroind.com/pdf/modbus2.pdf
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b. Double-click the Group field. From the pull-down menus, select a group and 

its associated channel value. The software displays the map and line 

values.

•   Number of Registers: this field is display only. The software computes the 

number in this field based on the data size selected in the Data Size column.

•   Start Register: this field is display only. The software assigns and adjusts Start 

register numbers to take into account previous entries and data sizes. The Start 

register is the number of the first register used in polling. The Start registers are 

shown as 4x to describe them as holding registers, for SCADA applications.

•   Format: from the pull-down menu, select a format type for a value, such as 

Signed Integer, Unsigned Integer, and 4 Byte IEEE Float.

•   Data Size: from the pull-down menu, select the number of bytes you want to 

represent the data point: 2 or 4.

•   Unit: if the polled value is viewed as an integer, the Unit field tells the software 

where to place the decimal point. 

Examples 

• If you select .01, a polling value 1234 is interpreted as 12.34.

• If you select 100, a polling value 1234 is interpreted as 123400.

•   Primary/Secondary: the meter normally computes values in secondary units. 

Where applicable, you may select primary or secondary. If Primary is selected, 

the value is multiplied by the appropriate CT and/or PT values.

•   Absolute Value: where appropriate, you may have the option of having the data 

point computed as a signed or absolute value. Select either:

• No: to have the data point computed as a signed value.

• Yes: to have the data point computed as an absolute value.
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•   Byte Order: for most of the data points, you can select the polling order of the 

registers/bytes to match what the SCADA system needs. The choices are: MSR, 

MSB (most significant register, most significant byte); MSR, LSB (most signifi-

cant register, least significant byte); LSR, MSB (least significant register, most 

significant byte); and LSR, LSB (least significant register, least significant byte). 

EIG meters store data as MSR, MSB, whereas most SCADA systems use LSR, 

LSB. You can either select an alternate order here, for example, LSR, LSB, or 

you can leave the data as is and then have your SCADA system change the 

order after the data is polled. 

•   Display/Modulo/Offset: depending on the data point, select one or more 

additional options with appropriate sub-selections.

• Display: This setting supplies a modifier for phase angles and power

factor that translates the value into something usable by the SCADA 

system.

Example: For Volts AN phase angle values, you can represent the value 

as 0 to 360 degrees or -180 to +180 degrees, etc. Selections appear in a 

pull-down menu for the associated point.You may want to select -180 to 

+180 degrees if you ant to know if a phase angle is positive or negative in 

relation to the reference.

• Modulo: Certain values are cumulative and can roll over and start 

recounting from zero. For those values, where required, you can enter a 

point at which the rollover will occur. 

• Offset: Where allowed, you can enter a value (offset) that will be added 

to the data point when it is computed.

2. When all changes are entered, click OK to return to the main Device Profile screen. 

For any changes to take effect, you must click the Update Device button to send 

the new profile to the meter. 
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12.2: Revenue and Energy Settings

Revenue and Energy Settings are the second group of settings in the Device Profile.

1. From the Device Profile screen, click on the + button next to Revenue and Energy 

Settings or double-click on the Revenue and Energy Settings line. All of the settings 

in the Revenue and Energy Settings group are listed. 

2. Click on the programmable setting you want to modify. The following sections 

explain the settings in the order in which they appear in the Revenue and Energy 

Settings menu.
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12.2.1: Energy Scaling

1. From the Revenue and Energy Settings menu, click on the + button next to Energy 

Scaling or double-click on the Energy Scaling line. You will see the Energy Scale 

Settings screen. 

•   This screen has multiple tabs that allow you to access all of the Energy Scaling 

options. Using the Energy Scale Settings screens you can select the number of 

digits, decimal point placement and Energy unit for displayed readings. 

•   The Example field shows you the scaling choices you made applied to an exam-

ple reading.

•   You click on the tabs to navigate between screens, except for Global settings - 

you click on the Global Settings button to access that screen.     

To configure scaling for a reading, enter:
1. Number of Digits, 2. Number of Decimal Places, 
3.Unit of Measurement; 4. Example of the resultant scaling is shown here
                             1                 2   3                        4
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    Global Settings

NOTE: Because there are many energy settings, Global Settings conveniently allows 

you to set these similar energy reading settings all at once.

2. Click the Global Settings button to see the screen shown above. This screen lets 

you set the scale for all of the Energy Readings.

a. Click in the Digits field and select the number of digits for the value from the 

pull-down menu. You can choose between 2 and 9 digits.

b. Click in the Decimal Places field and select the number of decimal places for the 

value from the pull-down menu. You can choose between 0 and 7 decimal 

places, depending on the number of digits you selected. For example, if you 

chose 3 digits, you can only choose up to 2 decimal places.

c. Click in the Units field to select the unit of measurement for the value. You can 

select k or M. 

The example field changes as you make selections, to show you how the value 

would appear with the settings you made.

3. When all changes are entered, click Apply to return to the main Energy Scale 

Settings screen. You can now use the tabs to modify the scale for specific readings. 

For example, you might have set the scale for the Internal Input Accumulators as 5 

digits, 2 decimal places, and M unit, but you may want one of the accumulators to 

have a different scale. You would click the Pulse Accumulations and Aggregations 
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tab and change the scale for that accumulator. The following sections show the tab 

screens where you can make individual scaling changes. You set the Digits, Deci-

mals, and Units fields in the same way as in the Global Settings screen.

Energy Tab

    This is the initial screen view. Click on the Watt Hour, VA Hour, and VAR Hour tabs

    to configure scaling for those readings.

Click to set Watt Hour 
readings scaling (this is 
the initial tab view)

Click to set VA Hour 
readings scaling

Click to set VAR Hour 
readings scaling
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    Uncompensated Energy Tab

    Click on the Uncompensated Energy tab to configure specific VA, Watt and VAR

     readings not adjusted by Transformer Loss Compensation. 
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    Pulse Accumulations and Aggregation Tab

    Click on the Pulse and Aggregations tab and then click on the Accumulators and

    Aggregators tabs to configure scaling for those readings.

Click to set scaling for Accumulator read-
ings (this is the initial tab view)

Click to set scaling for Aggregator read-
ings 
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    I and V Squared T Readings Tab

    Click on the I and V Squared Readings tab to configure scaling for specific I2T 

    readings (data will not accumulate until current reaches the programmed level)

    and V2T readings (data stops accumulating when Voltage falls below the 

    programmed level).
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    Q Hours Tab

    Click on the Q Hours tab to configure scaling for +QH and -QH readings.   

    Test Mode Tab

    Click on the Test Mode Energy tab to configure scaling for Test mode energy 

    readings - Wh, VAh, and VARh - click tabs to configure each.

4. When you are done, click OK to return to the main Device Profile screen. For these 

changes to take effect, you must click the Update Device button to send the new 

profile to the meter.
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12.2.2: Demand Integration Intervals

See the Nexus® 1262/1272 Meter Installation and Operation Manual for details on 

Demand intervals.

1. From the Revenue and Energy Settings menu, click on the + button next to 

Demand Integration Intervals or double-click on the Demand Integration Intervals 

line. You will see the submenu shown below.

2. Double-click on any of the settings. You will see the screen shown below.
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3. Click on the tabs at the top of the screen to navigate from one setting to another. 

Make changes to the settings according to your application requirements. Following 

is a brief description of each setting and its function:

•   Thermal Averaging (tab shown on previous page): use to set hours, minutes and 

seconds for a precise thermal window of demand data.

• Traditional analog Watt-hour meters use heat-sensitive elements to 

measure temperature rises produced by an increase in current flowing 

through the meter. A pointer moves in proportion to the temperature 

change, providing a record of demand. The pointer remains at peak level 

until a subsequent increase in demand moves it again, or until it is manu-

ally reset. 

The Nexus® 1500 meter mimics traditional meters to provide Thermal 

Demand readings. Electronic thermal demand emulation is the logarith-

mic average of the power used, with a more recent load being weighted 

more heavily than a less recent load, (approximated exponentially). Each 

second, as a new power level is computed, a recurrence relation formula 

is applied. This formula recomputes the thermal demand by averaging a 

small portion of the new power value with a large portion of the previous 

thermal demand value. The occurrence of the proportioning of new to 

previous is programmable, set by the averaging interval. The averaging 

interval represents a 90 change in thermal demand to a step change in 

power. So, for example, with a 15 minute set interval, the meter will 

record 90 of a change in load in 15 minutes, 99 in 30 minutes, and 99.9 

in 45 minutes. 

Because thermal demand emulation is the logarithmic average, the 

demand is not set to zero on a demand reset. On a demand reset, pres-

ent demand becomes the new maximum demand.

• The Max/Min Thermal Average Block Interval fields are used if you 

want to track the maximum and minimum Demand in more than one 

interval, e.g., the Max and Min Demand in a 10 minute (First Interval) 

and a 15 minute interval (Second Interval).
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•   Block Averaging Time: use to set the length of the block interval used for 

Demand calculations and other interval-based functions; also used to set End of 

Interval pulse. Block averaging is also known as fixed window averaging. A 

window is the user set time range, e.g., 15 minutes. Computation is performed 

on that 15 minute interval, and after that, a new set of computations will be 

started. For example, Window 1 will be from 0 to 15 minutes, Window 2 will be 

from 16 to 30 minutes, and so on. 

a. Use the Hours, Minutes, and Seconds fields to set the length of the Block 

Interval.

b. If you want to generate a pulse at the end of the set interval, click the box 

next to the Generate End of Interval Pulse field and select the number of 

the internal relay (1-4) you want to use and the pulse width (5 - 635 milli-

seconds).

NOTE: The Block Window Sync field indicates whether the meter is being       

synchronized with pulses from a High Speed input. This option is set in the 

Input Type field of the High Speed Inputs screen (see Section 12.3.6: High 

Speed Inputs on page 12-88).
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•   Rolling Averages: also known as a sliding window, functions like multiple, over-

lapping Block averages. You define the subintervals at which an average of 

Demand is calculated. A window duration is the user set time, such as 15 

minutes, but it moves, so that, for example, Window 1 is 0 to 15, Window 2 is 1 

to 16, Window 3 is 2 to 17, and so on.

a. Set the Hours, Minutes, and Seconds fields under Rolling Averaging Sub-

Interval Window.

b. Rolling Sub-Intervals: set the number of rolling windows you want to 

"string together."

c. Predictive Rolling Window Average: the meter gives you the programmed ( 

field) prediction of your demands. If you are using Demand as a Limit, such 

that you will perform certain actions when you hit a certain Demand level, 

e.g., turning off motors, you may want to give yourself a “buffer.” This field 

accomplishes that by letting you choose to over-predict the Rolling Window 

Demand - e.g., if you enter 110, the meter will predict Demand at a 10 

higher rate than the actual Demand, so that you will trigger a Limit alarm 

earlier than if you were using 100 Predictive Demand.
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•   Reset: Allows you to specify a Time of Use read whenever Maximum Demand is 

reset.

• Check the box to perform the TOU read. By selecting this, the meter will 

place all of the TOU values in the previous month’s registers. Otherwise, 

the meter will default to self read based on a date set in the meter.

• Leave the box unchecked if you don't want to perform a TOU read.

4. When all changes are entered, click OK to return to the main Device Profile screen. 

For these changes to take effect, you must click the Update Device button to send 

the new profile to the meter.
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12.2.3: Internal KYZ Outputs 

The Internal KYZ Outputs setting lets you assign channels to the KYZ outputs and to 

the test LEDs. The channel selection sets the type of pulse that will be generated. For 

example, the Pulse 1 LED can generate Energy Pulses for conventional testing or 

Reactive (VARh) Pulses for complex testing and approvals. This setting also allows you 

to determine the frequency and duration of the pulse for each output and LED.  

1. From the Revenue and Energy Settings menu, click on the + button next to 

Internal KYZ Settings or double-click on the Internal KYZ Settings line. You will see 

the screen shown below.

2. To make selections on this screen:

a. Select the assigned channel for the pulse/output. This is the demand that will be 

output as a pulse.  

b. Enter Watt hour per pulse, pulse width, mode and form for each pulse/output.

   NOTES: 

•   Form A = Pulse; Form C = Transition

•   No more than one Pulse Output can be assigned as an Operation Status Output.
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3. When all changes are entered, click OK to return to the main Device Profile screen. 

For these changes to take effect, you must click the Update Device button to send 

the new profile to the meter.

Considerations on Setting KYZ Outputs

KYZ Pulses are produced at a rate proportional to the rate of energy accumulation, a 

feature that makes them useful for accuracy testing. Decreasing the value of the Watt 

Hour per Pulse field increases the pulse rate, improving the moment-to-moment 

precision of the output. The increased pulse rate means that the pulses are of shorter 

duration. Most equipment for detecting and counting pulses has a minimum detection 

time, so pulses that occur too rapidly might not be detected and counted. 

The value in the Pulse Width field is used to force the meter to generate minimum 

width pulses in situations where proportional width pulses would occur too quickly to 

be measured. A pulse width setting that does not match appropriately with the input 

level and Watt hour per pulse setting will result in output that, in the short term, will 

not verify correctly.

For proper operation of this feature, the pulse width should be set to a value that is 

longer than the detection time required by the monitoring equipment, and shorter 

than the pulse period that the inputs and Watt hour per pulse setting would produce. 

The formula for the second quantity is:

3600 x -   

   

Watt hr per pulse

Total Power
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Some example cases are shown in the table below. For proper operation the pulse 

width should be set to a value that is less than the computed value of seconds per 

pulse.     

   Voltage
Phase to

Neutral/Phase

Volts         Volts

Current            

Amps     Watts

Total Power 
Wh/Pulse

Wh

Pulses/Hour

Pulses

Seconds/Pulse

Seconds

69.28 120.00 1 207.85 1.8000000 115.47 31.18

69.28 120.00 1 207.85 0.2078461 1000.00 3.60

69.28 120.00 5 1039.23 1.8000000 577.35 6.24

69.28 120.00 5 1039.23 1.0392305 1000.00 3.60

120.00 207.85 1 360.00 1.8000000 200.00 18.00

120.00 207.85 1 360.00 0.3600000 1000.00 3.60

120.00 207.85 5 1800.00 1.8000000 1000.00 3.60

277.13 480.00 1 831.38 1.8000000 461.88 7.79

277.13 480.00 1 831.38 0.8313844 1000.00 3.60

277.13 480.00 5 4156.92 1.8000000 2309.40 1.56

277.13 480.00 5 4156.92 4.15629219 1000.00 3.60
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12.2.4: Display Configuration

The Nexus® 1262/1272 meter with appropriate firmware (User Programmable LCD 

Display Run Time Firmware version 100, LCD Display Boot version 30, Base meter's 

COM run Time 624; or higher) gives you the Display Configurator. This feature lets 

you customize the meter's LCD screens to display any measured readings. The 

Display Configurator features the same three View Modes as the base programmable 

display but has memory for up to 75 screens, distributed however you want among 

the three View Modes. 

The settings shown in this section are for a Nexus® 1262/1272 meter with the 

Display Configurator. If you have an earlier version of firmware that does not support 

the Display Configurator (Runtime Firmware version less than 100 and LCD Display 

Boot version less than 30), you will see a different Screen Assignments tab: see 

Section 12.2.4.1 for instructions on using that tab. The other Display Configuration 

settings are the same, irrespective of hardware version. The Firmware versions are 

shown on the bottom portion of the Device Display Programmable Settings screen - 

see the screen on the next page. 
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1. From the Revenue and Energy Settings menu, click on the + button next to Display 

Configuration or double-click on the Display Configuration line. You will see the 

screen shown below.

2. Click the tabs at the top of the screens to access the different settings. 

•   Meter Display Mode Names Tab (screen shown above; this screen is used by all 

firmware versions, and is the initial tab view):

a. Enter a Label for each of the three View Modes.

b. Enter a Description for each View Mode using the Line 1 and 2 Description 

windows.

Firmware 
version is 
shown here



     Doc#    E107707                                             12 - 39

12: Nexus® 1262/1272 Meter

•   Power and Energy Display Tab: (this screen is used by all firmware versions)

a. For Primary Power (right side of screen), set Digits and Decimal Point. 

These settings apply to VA-hours, Watt-hours (+/-), VAR-hours (+/-) and 

VAR-hours (quadrants) in the meter. Previews appear at the bottom of the 

screen.

NOTE: Care should be taken to match the Primary Power values on the dis-

play with those in the historical logs, since these values are stored in the 

meter. 

b. The Primary Energy fields are used to modify the display, only. They are not 

stored in the meter. Select a value for the Multiply by Constant field, 

located in the Energy Display box, from the pull-down menu. This value is 

used to modify the display. 

For example: if the multiple you select is 100 and the value is 7835, 78.35 

will be displayed.
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c. If you want the Multiply by Constant to be applied to Demand as well as 

energy, click the checkbox next to the Apply to the Demand Registers as 

Well field.

•   Miscellaneous Tab: (this screen is used by all firmware versions)

         Use this screen to Set Screen Settings, Optical Port and User Inactivity Time

         Outs. The Screen Settings replace Adjustments Mode in the default profile.

a. Screen Settings: set Back Light Level (brightness), Back Light Time (when 

Back Light shuts off), Contrast level, Scroll Stop (Enabled or Disabled), 

Phasor Diagram Rotation (Clockwise or Counter Clockwise), Demand 

Shown (Cumulative - running total or Continuous - running total + current 

max/min), Time of Use Demand (Block/Rolling or Cumulative) Date Format 

(Month-Day-Year or Day-Month-Year), Dwell Time While Scrolling (the 

amount of time each screen is displayed when Scroll mode is selected), 

and how many Voltage Phasors to show in Delta (2 or 3).  



     Doc#    E107707                                             12 - 41

12: Nexus® 1262/1272 Meter

b. Optical Port: Set Baud Rate and Optical Receive (Non-Inverted or Inverted) 

Inverted Operation is used with the Smart Coupler or A7Z optical readers.

c. User Inactivity Time Outs: (number of minutes since last user action when 

Mode reverts to View Mode 1). Settings are from 5 - 60 minutes.

• Leave Test Mode After _ Minutes: Reverts with or without energy accu-
mulation.

• Leave View Mode 2 or 3 After _ Minutes: Reverts automatically.

•   Screen Assignments Tab (for Runtime Firmware Version 100 or higher and LCD 

Display Boot version 30 or higher: see Section 12.2.4.1 for earlier firmware)

1. Click the Screen Assignments tab. You will see the screen shown below.

 Display screens that are 
available for assignment 
to View Modes 

 Right-click 
on a 
screen to 
assign it to 
a View 
Mode or to 
copy it 

 Buttons that let you: Create 
custom Display screens, Edit 
Display screens, or Remove 
Display screens from the 
available screens list  

 Buttons that let you: change 
the order of Display screens in 
a View Mode, or Remove 
Display sc reens from a View 
Mode 

 V iew 
Mode 

Note that there will be no screens listed until you retrieve them from the connected meter.

*

*
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2. Use the buttons on the bottom of the screen to:

• Retrieve display settings from the connected meter by clicking Retrieve 

from Display. The display screens set up in the meter are shown.

• Update the connected 1262/1272 meter's display settings by clicking 

Update Display. The meter will reboot, and you will get a message on the 

PC screen: Device LCD Display Programmable Settings Updated. 

• Save any changes you have made to display settings by clicking Save.

• Load a previously saved LCD Display file by clicking Load and select the 

file you want to load into this screen (it is a .nds2 file).

• Return to the previous screen without saving any changes by clicking 

Cancel.

• View online instructions for using this screen by clicking Help.

3. The leftmost column lists all of the Available display screens. Before you've 

used the Display Configurator, you will only see the pre-programmed display 

screens in the list. Once you have created customized screens, you will see 

those in the list as well. 

The other three columns list the display screens that are assigned to each of 

the three View Modes. Use the scroll bars to display all of the items in the 

columns.
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4. To assign one of the screens to a View Mode or to create a new screen based 

on it:

a. Click on the screen in the list and right-click. You will see the pop-up menu 

shown below.

•To add the screen to one of the modes, or to all modes, click on that item 

in the menu.

•To create a new screen based on the screen, click on the last item in the 

menu.

5. To change the position of screens in one of the View modes, or to remove the 

screen from the mode:

a. Click on the screen in the View Mode column and then either:

2.Click to add screen to View Mode(s)
                      OR
2.Click to create a new screen based 
on this one

   1.Right click
    on a screen 
   to open this 
     menu
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• Click on a screen and then click Move Up or Move Down to change the 

position of the screen within that View Mode. The position of the screens 

determines the scrolling order in the LCD Display.

• Click on a screen and then click Remove to remove the screen from that 

View Mode.

6. To remove a screen from the list of available screens, click on the screen in the 

Available Screens column list and then click Remove. The screen will no longer 

be displayed in the list of available screens, and cannot be assigned to any 

View Mode. It will also be removed from any View Modes it has already been 

assigned to. 

7. To edit a screen, click on the screen in the Available Screens column list and 

then click Edit. 

8. To create a new screen based on an existing screen, right-click on the screen 

in the Available Screens column list and select Create New Screen Based on 

Selected Screen from the pop-up menu. 

9. To create a new custom Display screen, click Create in the Available Screens 

column.
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10. The screen above is displayed if you are creating a new screen or editing an

  existing screen.

• When you are creating a new screen, the User Screen Number field 

displays the next screen number in sequence (e.g., if there are already 25 

screens, the number will be 26). 

• When you are editing an existing screen, or creating a new screen based 

on an existing screen, the screen number and data will be shown for the 

screen you selected. 

a. There are three types of screens:

• Predefined - the default screens for the meter; you can edit some of 

these screens - go to step 10-l for instructions
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• Predefined with Custom Labeling - a new screen based on a predefined 

screen; you can change some fields to make the screen unique - go to 

step 10-l for instructions

• User Defined - a new custom designed screen - the instructions follow

b. To create a custom screen: click the User Defined button in the Screen Type 

box. The screen changes to allow you to set up the new Display screen. 

NOTE: The instructions for editing a custom screen are the same as for 

creating a new custom screen, except that since the screen is already be in

the Available Screens list, you click on it and then click Edit. You will see 

the screen shown above.

c. The number you see in the User Screen Number field can be changed. The 

Screen number field accepts any number up to three digits in length. Use 

numbers between 1 and 999 if you want the number to display on the LCD 

Display screen; use numbers between 1000 and 1999 if you don't want the 

You can change this number

Select 
number of 
items OR
1 Demand, 
1 Time-
stamp

These fields 
are for 
Modbus 
information

These fields 
are for 
Multiplier 
setup

These fields 
are for 
Scaling setup

The fields 
in Screen 
Layout are 
based on 
the 
number of 
items you
select 

Item entry fields - 
click here to enter 
the Modbus Register 
containing the Item
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number to display. 

NOTE: The Harmonics, Phasors, and Line Segment screens never display 

their number on the LCD Display screen.

d. Use the Layout Arrangement field to choose what fields you want the LCD 

screen to display. Choose either:

•The number of items you want the LCD screen to display: click one of the 

Item buttons.

• Display Demand and Timestamp fields: click the 1 Demand, 1 Timestamp 

button.

e. After you make your selection, the left side of the screen will change to dis-

play entry fields for the Item(s) (see the screen on the previous page) or 

Demand and Time Stamp information: see the example screen below.

f. The top field in the Screen Layout section is for the Display screen label 

(Title). Depending on the number of items you've selected, you will have 

between 0 to 2 lines for a screen label:

The information 
for these fields 
comes from the 
meter’s 
Modbus Map
This is where you 
can specify a 
multiplier for 
your data

These fields let 
you specify 
Scaling and data 
display

Demand Field
Timestamp
Status Field - 
does not dis-
play on the LCD 
screen

Display Screen 
Label Fields
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• If you have selected 1-3 items or 1 Demand, 1 Timestamp, you will have 

two entry lines. 

• If you have selected 4 items you will have one entry line.

• If you have selected 5 items, you will not have any entry fields for a 

Display screen label (there won't be room on the screen for a label).

g. The Item entry fields allow you to specify the data you want to display on 

the LCD screen. You can also enter a prefix (optional) for each line item 

and a suffix (optional) for all of the items on the display screen. 

Example: a screen containing phase to phase voltages might have a single 

title  (Volts P-P), 3 lines of data with prefixes (Vab, Vbc, Vca), and the 

same suffix (MV) on all 3 lines.

h. The 1 Demand, 1 Timestamp entry fields allow you to specify the demand, 

the timestamp, and an optional status register. The status register is not 

displayed on the LCD screen.

i. To enter an item: 

i.Click on the Item label box. 

ii.Fields open underneath the item, which allow you to enter the starting 

value of the Modbus Register containing the data for the item. Use the 

Decimal value of the register. See the screen on the next page. Refer to 

the Nexus® 1252/1262/1272 Meter Modbus Manual for the 1272 meter's 

Modbus Register Map. The manual can be downloaded from the Down-

loads page of EIG's website: www.electroind.com/dl_page_nexus-

meters.html.

IMPORTANT! All of the data items you select must be the same Modbus 

type, for example F3. The Modbus type is listed in the Modbus map. See 

the following example.

http://www.electroind.com/dl_page_nexus-meters.html
http://www.electroind.com/dl_page_nexus-meters.html
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Example:

                   To select 1 Cycle Phase A-N voltage, find the starting register for the field

                  in the Modbus manual. See the figure below:

iii.Click Update to save the item's starting register address.

iv.Enter any additional items in the same way. 

j. When you have finished entering items, use the entry fields in the right 

portion of the screen to enter details for the items' Modbus type, and to 

enter scaling, multiplier, and data display settings. 

The Modbus type information is found in Chapter 3 of the Nexus® 1252/

1262/1272 Meter Modbus Manual. See the example below.

Example:

The item in the example above was Modbus type F5. Any additional items 

must be the same Modbus type. Type F5 is described in Chapter 3, page 3-

3 of the 1272 meter's Modbus manual, as shown on the next page. Use the 

Modbus type information as shown.

Decimal Starting Register    Item you are selecting                                                                               F Type
is 01521
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In the example here, you would find the number of registers per item, the 

fact that the data is unsigned, and scaling information from the Modbus 

type information. 

The fields underneath the Multiply by fields, let you set up how the data will 

be displayed, for example, specifying if the data is a number or some other 

value; whether you want the sign to display for signed data; whether you 

want the data scaled, the number of digits and decimal places in the field.        

Click the drop-down menus to see alternate choices for the fields. The 

entries you make affect all of the items on the screen. The table on the 

next page shows the fields and the valid entries for them.
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k. Once you have finished your entries, click OK to return to the Screen 

Assignments tab. The new screen will be listed in the leftmost column. 

Click on it and then right-click to assign it to one or all of the View Modes.

Entry fields Possible entries

Registers per item 1 - 8

Register contents Binary, BCD, Text, Scaled Energy

Data Signed, Unsigned

Divide contents by 1, 100, 65536

Multiply by User multiplier (enter in blank field), 
PT Ratio, CT Ratio

Data format Number, Text, Power factor, Time, 
Date, Time & Date, Status indicator

Numerical sign Auto, Forced negative, Forced positive

Show sign No, Yes

Scale Auto, None, kilo (k), Mega (M), Giga 
(G)

Total digits 1-10

Digits to the right of the decimal place 0-8
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l. To edit a predefined screen or create a new screen from a predefined 

screen: either click Edit after selecting a predefined screen in the Available 

Screens list, or right-click on a predefined screen and select Create a new 

screen based on selected screen from the pop-up menu.

You have the following options for editing predefined screens:

• You can edit the screen number. 

• You can create a new screen based on the predefined screen, but you will 

only be able to change the screen number and/or screen label (title). 

                 NOTE: Some of the predefined screens cannot be customized as described

                above. The following table below lists those predefined screens and tells

                what can be changed on them.
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i.Click the button for one of these screen types:

• Predefined - you can only change the screen number. 

• Predefined with custom labeling - you can change the title as well as the 

number of the screen. Refer to the table above for editing limitations.

                NOTES: 

• The Screen number field is a three digit numeric field. Use numbers 

between 1 and 999 to display the number on the LCD Display screen; use 

numbers between 1000 and 1999 to not display the number on the LCD 

display screen. 

• The Harmonics, Phasors, and Line Segment screens never display their 

number on the LCD Display screen.

• Depending on the predefined screen, you will have between 0 - 3 lines for 

screen label (title) entry. Screen labels can be up to 16 characters per 

line.

Predefined LCD Screen 
Number (Default Value)

Description Editing Options

18 Phasors None

20 VAR, PF, & Frequency Title

21 - 26 Harmonics Title

60 Segment check None

64 Optical Port Settings Title

65 Comm Ports Title

66 Nexus Status Title

67 Firmware Versions Title

68 Nexus Info Title

76 - 77 Rolling/Block Demand Title

80 - 89 TOU Energy Title

90 - 93 TOU Demand Title

94 - 95 TOU +/- VARh Title
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ii.Below is the LCD Screen Selection screen with the Predefined with 

custom labeling option selected. You can enter a new screen title in the 

Screen Layout fields. 

iii.After you have made your entries, click OK. You will return to the previ-

ous screen (Screen Assignments tab). 

11. When you have finished programming the LCD Display, click:

•  Save to save the LCD Programmable Settings to a .nds2 file.

•  Upload to upload the LCD Programmable Settings to the connected 1262/1272 

meter.

•  Cancel to exit the screen WITHOUT SAVING ANY CHANGES.

12. Click Update Display to save any changes and return to the main Communica-

  torPQATM application screen.
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NOTE: See the Nexus® 1262/1272 Meter Installation and Operation Manual for 

further details.

12.2.4.1: Using the Screen Assignments Tab
                 (Earlier Firmware Version Only) 

NOTE: The screen shown here is only seen if your meter's Display Run Time 

firmware version is earlier than 100: see Section 12.2.4: Display Configuration on 

page 12-37, for instructions on using the Screen Assignments tab for later Firmware 

versions. 
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1. Your Label for each View Mode appears at the top of each column. 

2. Enter up to 16 screens for each View Mode clicking in one of the 48 entry fields on 

the screen and selecting the screen you want to assign, from the pull-down menu. 

Use the scroll bars to display all of the screen selections. 

3. When you have finished your settings, click:

•  Save to save the LCD Programmable Settings to a .nds2 file.

•  Upload to upload the LCD Programmable Settings to the connected 1262/1272 

meter.

•  Cancel to exit the screen WITHOUT SAVING ANY CHANGES.

4. Click Update Display to save any changes and return to the main Communica-

torPQATM screen.

Select Screen 
to Assign to 
Mode from the 
pull-down menu
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12.2.5: CT and PT Compensation

1. From the Revenue and Energy Settings menu, click on the + button next to CT and 

PT Compensation or double-click on the CT and PT Compensation line.

2. Check the Enable box to enable CT and PT Compensation; leave the box unchecked 

to keep it disabled.

3. Click OK to close the screen and return to the main Device Profile screen. For these 

changes to take effect, you must click the Update Device button to send the new 

profile to the meter.

12.2.6: Transformer / Line Loss Compensation

Transformer losses are power used by the transformer while working. The more load 

on the transformer, the higher the transformer losses. There are two types of trans-

former losses:

•   No load losses - these are the fixed losses that keep the transformer up and 

running.

•   Load losses - these vary with changes in the load.

When the meter is located on the secondary side of a customer’s transformer, a utility 

will want to add the transformer losses into the energy usage calculation. However, 

this practice is regulated by local jurisdiction and regulations. The meter has the 

capability to add in or subtract out these transformer losses, depending on the user’s 

specific needs.

Line losses are similar to transformer losses, except that they are used to compensate 

for loss incurred on wires, such as transmission lines.
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1. From the Revenue and Energy Settings menu, click on the + button next to 

Transformer/Line Loss Compensation or double-click on the Transformer/Line Loss 

Compensation line. You will see the submenu shown below.

2. The menu displays the current values for the meter's Transformer Loss Compensa-

tion.

•  LWFE = percent loss of Watts due to iron

•  LVFE = percent loss of Vars due to iron

•  LWCU = percent loss of Watts due to copper  

•  LVCU = percent loss of Vars due to copper
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3. Double-click on any of the loss values. You will see the screen shown below.

4. Click on TLC Calculator to find the values to enter into the Percent Loss fields. The 

TLC Calculator button launches the TLC Calculator that performs the calculations 

for you once the required data is entered. 

NOTE: Appendix A contains screen captures of the TLC Calculator with example 

numbers, and an explanation of Loss Compensation considerations.

5. Enter the percent loss of Watts and VARS for copper and iron in the appropriate 

fields. 

6. Click in the first pull-down menu. The optional selections are:

•  Disabled - disable TLC.

•  Iron (Fe) Only 

•  Copper (Cu) Only

•  Both Iron and Copper (Fe and Cu)

7. With the second pull-down menu, select from the following options:
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•  Add to Watts and Subtract from VAR

•  Subtract from Watts and Add to VAR

•  Add to Watts and VAR

•  Subtract from Watts and VAR

8. With the third pull-down menu, apply the loss based on the power flow direction by 

selecting one of the following options:

•  Both +Watts and -Watts 

•  -Watts only

•  +Watts only 

3. When all settings are complete, click OK to return to the main Device Profile 

screen. For any changes to take effect, you must click the Update Device button to 

send the new profile to the meter.

12.2.7: Cold Load Pickup 

Cold Load Pickup is used to manage Demand in the event of a power outage. You set 

the amount of time (in seconds) power is off to identify a power outage that is the 

responsibility of the utility (as opposed to a very short term loss of power that is not 

their responsibility); then you set the amount of time (in minutes) you want to wait 

before Demand starts again. This time should correspond to the “grace” period the 

utility applies to avoid charging for motor startup, etc. after a power outage. 

1. From the Revenue and Energy menu, click on the + button next to Cold Load 

Pickup or double-click on the Cold Load Pickup line. You will see the submenu 

shown below.
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2. Double-click on one of the parameters to open the screen shown below.

3. Make the following selections in accordance with your application needs:

•   Time after control power is restored to start demand - can be 1 to 60 minutes, 

or Disabled. 

•   Minimum time control power must be off before using Cold Load Pickup - can be 

from 0 to 255 seconds.

4. When all changes are entered, click OK to return to the main Device Profile screen. 

For these changes to take effect, you must click the Update Device button to send 

the new profile to the meter.

12.2.8: Cumulative Demand Type

Cumulative Demand is a counter of Max Demand that the meter keeps. It can help 

you determine if there has been tampering with the meter, i.e., unauthorized resetting 

of Demand. Whenever Demand is reset, the current Max Demand is added to the 

Cumulative Demand. By analyzing the data in the counter you can see if the Demand 

is being reset more often than intended. You can choose to use either Block Window 

Demand or Rolling Window Demand for the Cumulative Demand. 

1. From the Revenue and Energy Settings menu, click on the + button next to 

Cumulative Demand Type or double-click on the Cumulative Demand Type line.        
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You will see the submenu shown below. It tells you the type of Demand currently 

selected.

2. Click the Type line to open the screen shown below. 

3. Click the radio button in front of Rolling Window (sliding) or Block Window (fixed) to 

select cumulative Demand type.

4. Click OK to exit the screen and return to the main Device Profile screen. For a 

change to take effect, you must click the Update Device button to send the new 

profile to the meter.
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12.2.9: Energy, Pulses and Accumulations in the Interval

Energy in the interval is the energy that is accumulated within a load profiling 

interval. This is often the preferred method for logging because it is a summation of 

only that particular period of energy. The Interval setting you make creates the 

sub-accumulation field within the general Energy accumulation. An advantage of this 

setting is that the sub-accumulation takes up less space and is processed more 

quickly then the larger accumulation. 

1. From the Revenue and Energy Settings menu, click on the + button next to Energy, 

Pulses and Accumulations in the Interval or double-click on the Energy, Pulses and 

Accumulations in the Interval line. You will see the submenu shown below.

2. The current Interval setting is displayed. Click on the Interval setting to open the 

screen shown below.

3. Set the number of minutes for the Energy interval. 

3. Click OK to close the window and return to the main Device Profile screen. For any 

change to take effect, you must click the Update Device button to send the new 

profile to the meter.
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12.2.10: Pulse Accumulations

Pulse accumulators are used to count and/or aggregate pulse information from exter-

nal devices, using the High Speed inputs. These devices may be gas, water, or elec-

tricity meters; energy management systems; SCADA devices; or any pulse-

generating device. 

This section of the Device Profile displays a series of eight running totals available on 

the Nexus® 1262/1272 meter. Each total can be added to (or subtracted from) other 

totals. This allows you to set the High Speed inputs located directly on the meter to 

accumulate pulses. 

NOTE: If you use these inputs for pulse accumulations, do not set them to record 

waveforms - if you do, you will record endless waveforms.

1. From the Revenue and Energy Settings menu, click on the + button next to Pulse 

Accumulations or double-click on the Pulse Accumulations line. You will see the 

screen shown below.

2. High Speed inputs 1-8 are listed in order under Source. Enter the following 

information or use the pull-down menus to select:



     Doc#    E107707                                             12 - 65

12: Nexus® 1262/1272 Meter

•   Units/Count - this is the scale factor that normalizes the pulses so that they can 

be aggregated. Pulses are stored in primary values.

•   Aggregator - this allows you to place the pulse register into a separate accumu-

lation register that can aggregate (add) or net (subtract) values.

•   User Assigned Label - this window allows you to enter a label designation for the 

source.

•   Mode - you can set Pulse or Transition. A transition means from open to shorted/

closed or from shorted/closed to open; a pulse contains 2 transitions, open to 

shorted/closed, followed by shorted/closed to open. 

•   Average Full Scale - for Nexus® meters, in order to set a limit on a reading it 

needs a Full Scale value as the 100 reference. You can set a limit on the 

average number of pulses per interval.

•   Device Hour Reading and Aggregator - source device is the meter you are 

connected to. The Hour reading is either Quadrant 1 and 4 Watt-hour or Quad-

rant 2 and 3 Watt-hour. The Aggregators indicate whether the count should be 

added to, or subtracted from, Aggregators 1-4. You can choose None if you don’t 

want the count to affect any of the Aggregators.

•   Aggregators: The “buckets,” or Totalizer fields where pulse counts from the High 

Speed inputs and from the Watt-Hour counters can be totaled. The user can 

assign a label to each of the Aggregators. See the Average Full Scale description 

above for an explanation of this field - it has the same use here, except for the 

Aggregators.

3. When all data has been entered, click OK to return to the main Device Profile 

screen. For any changes to take effect, you must click the Update Device button to 

send the new profile to the meter.
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12.3: Power Quality and Alarm Settings

Power Quality and Alarm Settings are the third group of settings in the Device Profile.

1. From the Device Profile screen, click on the + button next to Power Quality and 

Alarm Settings or double-click on the Power Quality and Alarm Settings line. All of 

the settings in this group are listed.

2. Click on the programmable setting you want to modify. The following sections 

explain the settings in the order in which they appear in the Power Quality and 

Alarm Settings menu.
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12.3.1: Limits

Limits are threshold settings that can be set by a user to trigger a record in a log 

when an alarm condition is met. Utilizing the limits, the user can then control a relay 

or send a warning email on that alarm.

Limit settings are based on a percentage of the Full Scale (% of FS), which is set in 

the Limit and Waveform Full Scales setting (Section 12.1.2) (Limit Full Scales setting 

for the Nexus® 1262 meter). Full Scale is based on CT and PT ratios set in the CT, PT 

Ratios and System Hookup setting (Section 12.1.1).

Limits are based on a percent of Full Scale settings so that the same settings can be 

used no matter what the CT and PT Ratio needed.

Before programming limits, set the CT and PT ratios. Then, set the Limit and Wave-

form Full Scales if you want to change to automatic configuration. In most cases the 

software will configure the Full Scale optimally. 

NOTE: The software automatically updates the Full Scale; however, you can set it 

separately from the CT and PT Ratios.
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1. From the Power Quality and Alarm Settings menu, click on the + button next to 

Limits or double-click on the Limits line. You will see the submenu shown below.

This submenu displays the current Device Profile Limit settings. Not all limits are 

shown in the figure above: there are 32 Limit ID fields.
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2. Double-click on any of the settings (Limit ID 01, for example). You will see the 

Limits screen, shown below.

•   This screen can be expanded to show all of the limits. Click on the top or 

bottom of the screen to display sizing arrows you can click on and drag to 

expand the screen.

•   Percentage of Full Scale settings (% of FS): The limits are set in % of Full Scale 

so that when you create a profile, you can keep your settings. This is true, even 

though the CT and PT ratios change when the meter (or a new meter) is placed 

in a different location. Changing the CT and PT ratios does not affect the % of 

Full Scale limits previously set. This is useful when you are using large numbers 

of meters because one profile can be used with a common set of limit settings no 

matter what the CT and PT ratio. Full Scale reference information is available in 

the lower left box.

3. Make changes to this screen according to your application requirements.

•   To set the type of limit and the channel assigned to it:
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a. Double-click in either the Limit ID or Assigned Item column. You will see 

the screen shown below.

b. From the pop-up menus, choose the desired settings and click OK. Follow-

ing is a list of the available Groups, Sub Groups, and Items.

Group: Measured Values

Sub Group: High Speed Updated

Item: Voltage A-N

         Voltage B-N

         Voltage C-N

         Voltage Aux

         Current A

         Current B

         Current C

         Current N Measured

         Voltage A-B

         Voltage B-C

         Voltage C-A

         VA A

         VA B

         VA C

         VA Total

         VAR A

         VAR B

         VAR C

         VAR Total

         Watt A
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         Watt B

         Watt C

         Watt Total

         Frequency

         Power Factor A

         Power Factor B

         Power Factor C

         Power Factor Total

         Volts A-Aux Phase Angle

         Current N Calculated

Sub Group: One second updated

Item: Voltage A-N

         Voltage B-N

         Voltage C-N

         Voltage Aux

         Current A

         Current B

         Current C

         Current N Measured

         Current N Calculated

         Voltage A-B

         Voltage B-C

         Voltage C-A

         VA A

         VA B

         VA C

         VA Total

         VAR A

         VAR B

         VAR C

         VAR Total

         Watt A

         Watt B

         Watt C

         Watt Total

         Frequency
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         Power Factor A

         Power Factor B

         Power Factor C

         Power Factor Total

         Voltage Imbalance

         Current Imbalance

         Uncompensated VA A

         Uncompensated VA B

         Uncompensated VA C

         Uncompensated VA Total

         Uncompensated VAR A

         Uncompensated VAR B

         Uncompensated VAR C

         Uncompensated VAR Total

         Uncompensated Watt A

         Uncompensated Watt B

         Uncompensated Watt C

         Uncompensated Watt Total

         THD Volts A

         THD Volts B

         THD Volts C

         THD Current A

         THD Current B

         THD Current C

         K Factor Current A

         K Factor Current B

         K Factor Current C

         Internal Temperature

         Maximum TDD Phase A-N/Phase A-B Voltage

         Maximum TDD Phase B-N/Phase B-C Voltage

         Maximum TDD Phase C-N/Phase C-A Voltage

         Maximum TDD Phase A Current Timestamp

         Maximum TDD Phase B Current Timestamp

         Maximum TDD Phase C Current Timestamp

         Minimum TDD Phase A-N/Phase A-B Voltage

         Minimum TDD Phase B-N/Phase B-C Voltage
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         Minimum TDD Phase C-N/Phase C-A Voltage

         Minimum TDD Phase A Current Timestamp

         Minimum TDD Phase B Current Timestamp

         Minimum TDD Phase C Current Timestamp

Sub Group: Harmonic Values

Item: 0 - 127th Harmonic on selectable Harmonic Magnitude

         (Voltage Phases A, B, and C; Current Phases A, B, and C)

Sub Group: Internal Inputs, States

Item: Internal Inputs 1-8

Sub Group: Phase Angles

Item: Phase A-N Voltage

         Phase B-N Voltage

         Phase C-N Voltage

         Phase A Current

         Phase B Current

         Phase C Current

         Phase A-B Voltage

         Phase B-C Voltage

         Phase C-A Voltage

         Volts A-Aux Phase Angle

         Voltage Phase Sequence

Sub Group: Flicker

Item: Flicker: PInst Volts A

         Flicker: PInst Volts B

         Flicker: PInst Volts C

         Flicker: PST Volts A

         Flicker: PST Volts B

         Flicker: PST Volts C

         Flicker: PLT Volts A

         Flicker: PLT Volts B

         Flicker: PLT Volts C

Group: Averages

Sub Group: Thermal Average

Item: Voltage A-N

         Voltage B-N

         Voltage C-N
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         Voltage Aux

         Current A

         Current B

         Current C

         Current N Measured

         Current N Calculated

         Voltage A-B

         Voltage B-C

         Voltage C-A

         VA A

         VA B

         VA C

         VA Total

         VAR A

         VAR B

         VAR C

         VAR Total

         Watt A

         Watt B

         Watt C

         Watt Total

         Frequency

         Power Factor A

         Power Factor B

         Power Factor C

         Power Factor Total

         Voltage Imbalance

         Current Imbalance

Sub Group: Block Window Average

Item: VA

         VAR

         Watt

Sub Group: Pulse Accumulation/Aggregation Block Window Average

Item: Internal Inputs #1 - #8

         Aggregators #1 - #4

Sub Group: Rolling Window Average
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Item: Predictive VA

         Predictive VAR

         Predictive Watt

         VA

         VAR

         Watt

Sub Group: Voltage and Current Means

Item: Volts PN

         Current P

         Volts PP

Group: External I/O Devices

Sub Group: Analog Input Modules

Item: Module 1: Analog Input 1 - Analog Input 8

         Module 2: Analog Input 1 - Analog Input 8

         Module 3: Analog Input 1 - Analog Input 8

         Module 4: Analog Input 1 - Analog Input 8

•   To designate the limit as either above or below a percentage of the Full Scale, 

click once in each Settings column and select the desired setting from the pull-

down menu.

•   To set the percentage of the Full Scale that will trip the limit, enter the value in 

the % of FS column. CommunicatorPQATM software automatically calculates the 

Primary value.

•   Combination Limit 3 is the logical combination of Limit 1's state and Limit 2's 

state.

Example 1

Limit I D

Type: 1 Second Readings

Channel: Volts AN

Limit 1 Setting: Limit exceeded if Volts AN is below 120 F.S.

Limit 2 Setting: Limit exceeded if Volts AN is above 80 F.S.

Combination Limit 3 Setting: AND 

If Limit 1 AND Limit 2 are tripped (e.g., the reading is 100F.S.), then Limit 3 is 

tripped.
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Example 2

Limit I D

Type: 1 Second Readings

Channel: Volts AN

Limit 1 Setting: Limit exceeded if Volts AN is above 120 F.S.

Limit 2 Setting: Limit exceeded if Volts AN is below 80 F.S.

Combination Limit 3 Setting: OR 

If either Limit 1 OR Limit 2 is tripped (e.g., the reading is 75), then Limit 3 is 

tripped.

•   Full Scales settings are shown in the lower left of the screen. These values are 

set in the Limits and Waveform Full Scales section of the Device Profile (Section 

12.1.2).

3.   Power Factor is broken into four quadrants. Selecting the Full Scale value brings 

up a screen that lets you set a limit in two of the four quadrants.
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•   To set the power factor limits, double click on any of the power factor settings in 

the Limit 1 or Limit 2 columns. You will see the Power Factor screen.

•   To set a limit: from the pull-down menus, select a quadrant and Less Than or 

Greater Than (Full Scales). Enter the power factor number. The graph will 

illustrate your selections by shading the out of limit bands. The area of the

graph not covered by shading is within normal operational range.  

NOTE: Whether you see method 1 Quadrants (Q1  +Lag, Q2  -Lag, Q3  -Lead, 

Q4  +Lead) or method 2 Quadrants (Q1  +Lag, Q2  -Lead, Q3  +Lag, Q4  -Lead) 

depends on the setting in the Power Factor Display field of the Labels setting 

(see Section 12.1.4: Labels on page 12-10).

    NOTE: The Nexus® 1262/1272 device is a four-quadrant meter. Therefore, limits

    can be set for capacitive and inductive PF when generating or consuming power.

3. When all settings are complete, click OK to return to the main Device Profile 

screen. For any changes to take effect, you must click the Update Device button to 

send the new profile to the meter.  
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12.3.2: ElectrologicTM Relay Control

1. From the Power Quality and Alarm Settings menu, double-click on the Electro-

Logic™ Relay Control line. You will see the screen shown below.

ElectroLogicTM Relay Control lets you set up a logic tree to control the meter’s 

optional relays. Each relay can be programmed individually. The end result of the 

logic tree is to set, or not set, a relay, with an optional programmed Set Delay and/

or Reset Delay. The initial inputs to the logic tree are chosen from among the 32 

Limits and 40 Digital Inputs (both internal and external inputs). The gates, in 

several stages, perform logical combinations (AND, OR, etc) on pairs of inputs 

(either initial inputs or the outputs of earlier gates), and in combination produce an 

ultimate "true" or "false" state to drive the relay open or closed.

 For example, one of the gates is AND. For data to pass an AND gate, both pieces of 

data must be “true.” For a Limit to be true, the data must be in the Out-of-Limit 

condition on either Limit 1, Limit 2, or both (you decide which). For a Digital Input 

to be true, it must be in the condition you specify - either Open or Shorted. 

2           3                                                  1           

4
4a

4b

5a

5b

6
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The gates used in ElectroLogicTM Relay Control are used as follows:

OR: If either or both of the two conditions are true, the gate is passed

AND: If both of the conditions are true, the gate is passed

Hysteresis: For Limits only, the if the Limit is within the programmed hysteresis 

value, the gate is passed

XOR: If either of the two conditions are true, but not both, the gate is passed

NOR: If either of the two conditions are true, the gate is not passed

NAND: If both of the two conditions are true, the gate is not passed

NHysteresis: For limits only, if the Limit is within the programmed hysteresis value, 

the gate is not passed

NXOR: If either of the two conditions are true, but not both, the gate is not passed

NOTE: See Example settings on page 12-80.

2. To assign an item to the Relay Logic tree:

a. Select the relay card/module from the pull-down menu - see number 1 in the 

screen on the previous page.

b. Select an input for the tree by clicking on a radio button next to numbers 1 

through 8 - see number 2 in the screen on the previous page.

c. Choose Limits or Digital Inputs by clicking on the radio button in front of the 

word - see number 3 in the screen on the previous page. 

d. From the pull-down menus, select the limit (Limit ID) or input (Input ID) you 

want to assign to this Relay Logic tree input (step b) - see number 4 in the 

screen on the previous page. 

• For a limit, use the second pull-down menu to select Limit 1, Limit 2, or 

Combination - see number 4a in the screen on the previous page.

• For an input, use the second pull-down menu to select Shorted or Open - 

see number 4b in the screen on the previous page.

e. Press Set to confirm your selection. The software places the selection in the 

appropriate field in the screen.

3. After you assign all the Relay Logic inputs, select the gates that will be used to 

combine the logic to trigger the relay. To select a gate type, either: 
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•   Click on the gate (yellow fields) - see number 5a in the screen on page 12-77. 

•   Choose a gate type from the pull-down menu below the gate - see number 5b in 

the screen on page 12-77.

4. If you want, select Set Delay and Reset Delay from the pull-down menus. You can 

choose between 0 and 255 seconds. Use these fields if you want to program a delay 

before the relay is set, or before it is reset - see number 6 in the screen on page 

12-77.

5. To change items on the Relay Logic tree, follow the previous steps.

•   To clear an item from the Relay tree, click on that item and click the Clear 

button.

•   To clear all items from the Relay Tree, click the Clear Assigned Items button.

6. When all settings are complete, click OK to return to the main Device Profile 

screen. For any changes to take effect, you must click the Update Device 

button to send the new profile to the meter. 

NOTE: In order to use this screen, you must have purchased at least one External 

Relay Output module. For more details on external Output modules, see Chapter 14.
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Example of an ElectroLogicTM Relay Logic Tree:

Inputs 1 through 8 are set to High Speed Volts AN Limit 1, High Speed Amps A Limit 

1, High Speed Volts BN Limit 1, High Speed Amps B Limit 1, High Speed Volts CN Limit 

1, High Speed Amps C Limit 1, Not Set and Not Set. The four first gates are AND 

gates, and the remaining three gates are OR gates.

Each first level gate looks at the state of the two limits, and the result is "true" if and 

only if both the inputs (Voltage Limit and Current Limit) are "true" (Out-of-Limit Con-

dition). The second and third level gates look at the state of the earlier gates, and 

their results are "true" if either one (or both) of the previous gates are "true". The end 

result is a relay that is energized if one or more of the three phases (A, B, and/or C) is 

currently Out-of-Limit on both its voltage and current Limit 1 tests.

 Items 
 1-8

Gates 1-4
Gates 5 and 6 Final Gate



     Doc#    E107707                                             12 - 82

12: Nexus® 1262/1272 Meter

12.3.3: PQ Thresholds (Waveform Recording: Nexus®
              1272 Meter Only)

The PQ Thresholds/Waveform Recording capability allows the meter to act as a high-

speed waveform recorder to record any anomaly that occurs within a cycle of dura-

tion. This provides a user with advanced waveform analysis including pre- and post- 

waveform recording. 

The meter has the capability to record both surges and sags of the measured signals. 

A voltage surge is any event that increases the RMS voltage for one cycle, calculated 

every half cycle. A voltage sag is a dip in the RMS of one cycle of voltage, calculated 

every half cycle. A current fault (or surge) is also calculated in the same manner. 

When the RMS value of any of these triggers exceeds the threshold settings, the 

meter will trigger a waveform capture. 

The Power Quality (PQ) and Waveform Thresholds setting determines at what point 

the Nexus® 1272 meter executes a waveform capture and/or records a power 

quality event. 

See Chapter 19 for instructions on viewing Waveform and PQ logs. 

PQ and Waveform Thresholds are given as a percentage of the Full Scales (% of FS). 

Set the Full Scales in the Limits and Waveform Full Scales setting of the Device Profile 

(see Section 12.1.2: Limit and Waveform Full Scales on page 12-4). Full Scales are 

based on the CT and PT ratios set in the CT, PT Ratios and System Hookup setting of 

the Device Profile (see Section 12.1.1: CT and PT Ratios and System Hookup on 

page 12-2).

Before programming the PQ and Waveform Thresholds, set the CT and PT ratios and 

the Limits and Waveform Full Scales.

Note on Sampling Rate: A higher sampling rate allows for transients to be 

monitored. Generally, the meter is set to take 1024 samples per cycle for this pur-

pose. Lower sampling rates have advantages, however, because they allow you to 

record more cycles of information per event screen. Therefore, low sampling rates are 

better for long duration events, like motor starts or distribution faults. The meter 

enables you to tailor its recording for both these applications. For more information on 

sampling rate, see the table on page 12-84.
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1. From the Power Quality and Alarm Settings menu, double-click on the PQ 

Thresholds (Waveform Recording) line. You will see the screen shown below

2. To set the threshold for a PQ event and waveform capture, enter the desired 

percentage of Full Scale in the Value() column of the Above Setpoint and Below 

Setpoint sections. Full Scales are shown in the lower right corner of the screen.

NOTE ON CBEMA: The CBEMA plotting is a power quality standard known worldwide 

for recording the amount of damage voltage transient conditions have done to the 

equipment being monitored. The meter automatically records this information. For 

CBEMA purposes, program internal setpoints for voltage below 90 and above 110 of 

full scale (+/- 10 from the nominal voltage). These setpoints are defined by the ITI 

(CBEMA) specification. The ITI (CBEMA) Curve is published by Information Technology 

Industry Council (ITI). You can set a recording with tighter voltage limits to trigger a 

waveform recording. However, CBEMA plotting will be based only on the 

limits internally set.

NOTE ON SETTING THE METER TO RECORD CURRENT FAULTS: The voltage 

setpoints are used to record voltage type events, such as voltage surges, sags and 

transients. The current settings are used to record faults on the line or in-rush 
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currents from devices such as motors. Typically, to catch these events, set the limit to 

above 200 of full scale.

•   Current Waveform Clipping Thresholds: Nexus® 1272 Meter; Class 20A - ±90A 

Peak before clipping; Class 2A - ±18A Peak before clipping

•   Voltage Waveform Clipping Thresholds: Nexus® 1272 Meter SE, S, DE Hardware - 

±800V Peak before clipping; LV Hardware - ±200V Peak before clipping

•   High Speed Inputs: The High Speed Inputs field allows you to see which High 

Speed Inputs are enabled for Waveform recording. 

IMPORTANT! You assign the High Speed Input to its trigger in the High Speed 

Inputs screen (see Section 12.3.6: High Speed Inputs on page 12-88).

•   Samples per Cycle: To choose the Samples per Cycle to be recorded at 60 Hz, click 

on the Sampling Rate pull-down menu. Choose from 16, 32, 64, 128, 256 and 512 

samples per cycle. The number of samples per cycle you choose will inversely affect 

the number of cycles per capture. 

•   If you select 256, a Capture Only pop-up screen will ask you to select Volts A, B, 

C or I A, B, C.

•   If you select 512, a Capture Only pop-up screen will ask you to select one of the 

individual channels.
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   The following table illustrates the effects of sampling rate on the number of cycles 

   captured. Increasing the Sampling Rate increases Waveform definition, but reduces

   the length of the observed window. The approximate length of the observed window

   is shown in the last column.

    For example, for observed events of approximately ½ second, a sampling rate of

    32 samples per Cycle, or less, should be used.

    

    NOTE ON WAVEFORM EVENT CAPTURES: A screen of data is one capture. If

    you set Total Captures to 3 and you are recording at 16 samples per cycle, you will

    record:

    16 Samples3     x     64 = 192 cycles of recorded waveforms

    128 Samples3     x     8 = 24 cycles of recorded waveforms

     With the 2 Megabyte module, you have a total of 64 captures; with the 4 Megabyte

     module, you have a total of 96 captures. You can partition the memory in any

     fashion required by your application. There is no limitation on the amount of

     cycles that can be recorded per event.

3. To choose the total amount of captures, click on the Total Captures pull-down 

menu. Select from 0 to 96 captures. The higher the number, the more information 

you will be "stringing together."

Effects of Sampling Rate

Samples 
Per Cycle

Channels  Samples 
Per Channel

 Cycles Per 
Capture

Time 
(Approx)

Analog HSI

16 7 8 1024 64 1 Second

32 7 8 1024 32 ½ Second

64 7 8 1024 16 ¼ Second

128 7 8 1024 8 1/8 Second

256 3 8 2048 8 1/8 Second

512 1 8 4096 8 1/8 Second



     Doc#    E107707                                             12 - 86

12: Nexus® 1262/1272 Meter

4. When all changes are entered, click OK to return to the main Device Profile screen. 

For changes to take effect, you must click the Update Device button. This sends the 

new profile to the meter.

12.3.4: EN 50160/IEC 61000-4-30 Flicker 

With the EN 50160/IEC 61000-4-30 Flicker screen, you can set the test times for the 

Flicker function.

1. From the Device Profile screen double-click on the EN50160/IEC61000-4-30 Flicker 

line. You will see the screen shown below.

2. From the pull-down menus, select: 

•   Frequency (50 or 60Hz) - this field is used to calculate the harmonics and interhar-

monics associated with the set fundamental frequency.

•   Short Term Test Time (1-10 minutes, in minute increments) - PST is defined over a 

ten minute interval. Standard IEC 61000-4-15 requires 10 minutes for PST.

•   Long Term Test Time (10-240 minutes, in ten minute increments) - the standard 

requires 120 minutes, and is calculated from the PLT values. 

3. When all changes have been entered, click OK to return to the main Device Profile 

screen. For any changes to take effect, you must click the Update Device button to 

send the new profile to the meter.

NOTE: Flicker is discussed in detail in Chapter 23.
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12.3.5: I Squared T and V Squared T Thresholds

With the I Squared T and V Squared T Thresholds screen, you can set the point at 

which the meter accumulates current and Voltage. This feature is used to calculate 

wear on circuit breaker contacts.

1. From the Power Quality and Alarm Settings menu, click on the + button next to I 

Squared T and V Squared T Thresholds or double-click on that line. You will see the 

submenu shown below, which shows the current settings for the meter.

2. Double-click one of the settings to open the I Squared T and V Squared T 

Thresholds screen, shown below.

3. Enter the thresholds in the I Squared T and V Squared T fields.  

4. Click OK to exit the screen and return to the main Device Profile screen. For any 

changes to take effect, you must click the Update Device button to send the new 

profile to the meter. 
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12.3.6: High Speed Inputs

The Nexus® 1262/1272 meter’s built-in High Speed Inputs can be used in two ways:

•   Attaching status contacts from relays, breakers or other devices for status or 

waveform initiation

•   Attaching the KYZ pulse outputs from other meters for pulse counting and totaliz-

ing

Even though these inputs are capable of being used as high speed digital fault record-

ing inputs, they serve a dual purpose as KYZ counters and totalizers. The function in 

use is programmable in this setting of the Device Profile, which lets you label the eight 

High Speed inputs and to specify their status. 

•   Labeling the inputs allows you to determine the source of status change when data 

is later analyzed. 

•   This feature lets you set the High Speed Inputs’ status as a KYZ input, a trigger for 

waveform capture or PQ recording, or as a means of synchronizing the meter. 

•   In the Pulse Accumulations setting (Section 12.2.10), you can assign the High 

Speed Inputs’ counts to be accumulated in one of four internal Aggregators of the 

meter.
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1. From the Power Quality and Alarm Settings menu, double-click on the High Speed 

Inputs line or click on the + button next to it. You will see the submenu shown 

below.

2. Double-click any of the Input lines. You will see the screen below.

3. Double-click a field to enter the following:

•   Name 

•   Open Label

•   Shorted Label
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•   Normal Condition

4. Click on the Input Type field to select an option from the pull-down menu. The 

available selections are:

•   KYZ Input - select this option to designate the input as a pulse (KYZ) input.

•   Waveform/PQ Trigger - select this option if you want the input to trigger a 

waveform/PQ recording (see Section 12.3.3: PQ Thresholds (Waveform Record-

ing: Nexus® 1272 Meter Only) on page 12-82).

•   Block Window Sync Pulse - select this option if you want to synchronize the 

meter with pulses from the input (see Section 12.2.2: Demand Integration 

Intervals on page 12-29).

5. When you have finished making your selections, click OK to exit the screen and 

return to the main Device Profile screen. For any changes to take effect, you must 

click the Update Device button to send the new profile to the meter.
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12.3.7: Operational Status Output

This setting of the Device Profile lets you assign a relay to the operational status of 

the meter. The relay can then be monitored by another connected device.

1. From the Power Quality and Alarm Settings menu, double-click on the Operational 

Status Output line. You will see the screen shown below.

2. Select the relay you want to assign from the pull-down menu and click the check-

box.

3. When you finish making your selections, click OK to exit the screen and return to 

the main Device Profile screen. For any changes to take effect, you must click the 

Update Device button to send the new profile to the meter.
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12.4: Trending Profile Settings

This section of the Device Profile enables you to configure parameters for the Nexus® 

1262/1272 meter’s two historical logs.

1. From the Device Profile screen, click on the + button next to Trending Profile

 Settings or double-click on the Trending Profile Settings line. You will see the menu 

shown below.

2. Double-click on one of the Trending lines to access the programming screens.

NOTE on Load Profile Recording: Load Profile recording is a subset of the Nexus® 

meter's more general logging and trending capability. The same screens are used for 

setup, but Load Profile recording only deals with accumulated values; Energy (Wh), 

reactive Energy (VARh) and apparent power (VAh).

Historically, Load Profile recording referred to recording of quadrant 1 Energy (Wh) 

because electromechanical meters only measured energy and were designed to 

prevent reverse rotation outside of quadrant 1.

12.4.1: Programming the Trending Log Time Intervals

The Trending Log Time Intervals setting determines the interval at which the 

Historical logs take a "snapshot" of data. To set the parameters for the logs, see 

Section 12.4.2: Programming the Trending Setup on page 12-94. See Chapter 16 for 

information on retrieving logs and Chapter 19 for information on viewing logs.
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1. From the Trending Profile Settings menu, double-click Trending Log Time Intervals 

or click the + button next to it. You will see the submenu shown below. The 

submenu shows the interval set for both Historical logs.

2. To change the interval for a Historical log, double-click on one of the logs.

NOTE: You can also access the Interval setting screens from the Trending Setup 

screens (see Section 12.4.2: Programming the Trending Setup on page 12-94).

2. You will see the screen shown below. Enter the interval you want.

3. Click OK to save your changes. For any changes to take effect, you must click the 

Update Device button to send the new profile to the meter.
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12.4.2: Programming the Trending Setup 

The Trending Setup controls the channel assignments for the Historical logs. See 

Chapter 16 for instructions on retrieving logs.

1. From the Trending Profile Settings menu, click on the + button next to Trending 

Setup or double-click on the Trending Setup line. You will see the submenu shown 

below.
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1. Double-click on the log whose settings you want to configure. You will see the 

Trending Log Profile screen for the log you selected. An example screen is shown 

below.

2. Make changes to this screen according to your application requirements. 

a. Group: Using the pull-down menu, select the type of snapshot. The options are: 

Measured Values, Averages, Accumulators, Interval Accumulators, External 

Output Devices, TOU Cumulative Dmd.
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b. Sub-Group: Using the pull-down menu, select a channel for the snapshot. The 

options are: Fifty Millisecond Updated; One Second Updated; Harmonic Values; 

Internal Inputs, States; Phase Angles; Flicker.

c. Sub-Group 2: With some selections, a second sub-group field will be shown 

underneath the first one. Select a value for this field from the pull-down menu. 

d. Highlight items in the Selectable Items(s) box and click Add to include the selec-

tions in the Log. The items will be copied to the Selected Item(s) box. To remove 

an item from the log, highlight the item in the Selected Item(s) box and click 

Remove or double-click the item. The item will be removed from the Selected 

Item(s) box. 

NOTES: 

• To select multiple items, hold Control while highlighting the items.

• To select a range of items, click the first item, hold Shift, and click the last 

item.

• Move the cursor to the lower left corner of an item, or group of items, to 

view its size in bytes.

e. Click HHF if you want to convert files to HHF format for use with MV-90. 

See Chapter 16 for details.

f. Click Check HHF if you want to check if current settings are compatible with the 

HHF Converter.

NOTE: You will not see the HHF options unless you have enabled the HHF 

converter using the Options menu. See Chapter 20 for instructions.

g. The Total bytes used and Bytes remaining fields display the amount of memory 

used for each record of the log. The meter assumes 256 bytes of memory for 

each record. Total memory is determined at time of purchase. 

h. The Estimated Log Timespan field displays the length of the time between the 

first and last records in the log when it is full.



     Doc#    E107707                                             12 - 97

12: Nexus® 1262/1272 Meter

i. The Total Records field displays the total number of records that will be in the log 

when it is full.

j. Click Set Interval to open the Interval Log Setting screen (see Section 12.4.1: 

Programming the Trending Log Time Intervals on page 12-92).

4. When all changes have been entered, click OK to return to the main Device Profile 

screen. For any changes to take effect, you must click the Update Device button to 

send the new profile to the meter.



     Doc#    E107707                                             12 - 98

12: Nexus® 1262/1272 Meter

12.5: External I/O Modules

This setting of the Device Profile allows you to set up the meter’s optional external 

Input/Output modules (see Chapter 14 for more information on the I/O modules). I/O 

modules work as Modbus slave devices. The meter polls these modules to get the 

data from them. I/O modules generally have default RS485 Modbus addresses. So, 

they don’t have to be configured. Once you set up which module you want, put in the 

default address and start with the basic configuration of readings you desire to gather.

12.5.1: Configuring the Input/Output Modules

1. From the Device Profile screen, double-click on the External I/O Modules icon. You 

will see the screen shown below.
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2. Click in the Type column and use the pull-down menu to select the specific module 

you want to add. The Assigned Address, Nexus settings®, and Module settings you 

can make depend on the module you are configuring. The modules and settings are 

as follows:

* The Assigned address on this screen is the address the meter uses to identify the

    I/O module. The default is the factory set address, which you can change by

    clicking in the field and choosing a new address from the pull-down menu. This

    address is not the actual I/O module address. You set that from the I/O Devices

    menu; see Chapter 14 for instructions. 

**When you click in this field you see an Edit button. Click the button to open a

    screen that lets you edit that module. See the following example screens.

Module Assigned
Address* Nexus® Setting** Module Setting

4PO1 - KYZ Output 160* Click to Edit Relay Accumula-
tions

Click to enter Transmit Delay and 
configure KYZ outputs’ Watt/pulse, 
rollover and minimum pulse width.

20mAON4 132* Click to Assign Items to and 
configure the Analog Outputs

Click to enter Transmit Delay and 
configure Channel settings 

20mAON8 132* Click to Assign Items to and 
configure the Analog Outputs

Click to enter Transmit Delay and 
configure Channel settings 

1mAON4 128* Click to Assign Items to and 
configure the Analog Outputs

Click to enter Transmit Delay and 
configure Channel settings 

1mAON8 128* Click to Assign Items to and 
configure the Analog Outputs

Click to enter Transmit Delay and 
configure Channel settings 

4RO1 - Digital Output 156* Click to configure Relays Click to enter Transmit Delay

8AI1 - Analog Input 
Module

247* Click to configure Analog 
Outputs

Click to enter Transmit Delay and 
configure Channel settings

8AI2- Analog Input 
Module

247* Click to configure Analog 
Outputs

Click to enter Transmit Delay and 
configure Channel settings

8AI3 - Analog Input 
Module

247* Click to configure Analog 
Outputs

Click to enter Transmit Delay and 
configure Channel settings

8AI4 - Analog Input 
Module

247* Click to configure Analog 
Outputs

Click to enter Transmit Delay and 
configure Channel settings

8DI1 - Digital Status 
Input Module

164* Click to configure Digital 
Inputs

Click to enter Transmit Delay and 
configure Channel settings
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                                         4PO1 Screen

This screen allows you to assign a KYZ output to an accumulator. Click on the pull-

down menu to select accumulation configuration for each of the 4 relays. The 

options are: 

•   Disabled

•   Quad (1+4) Watthr

•   Quad (2+3) Watthr

•   Quad (1+2) VARhr

•   Quad (3+4) VARhr

•   Quad (1+2+3+4) VAhr

•   Quad 1 Watthr

•   Quad 2 Watthr

•   Quad 3 Watthr

•   Quad4 Watthr

•   Quad 1 VARhr

•   Quad 2 VARhr

•   Quad 3 VARhr

•   Quad 4 VARhr

•   Quad 1 VAhr

•   Quad 2 VAhr
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•   Quad 3 VAhr

•   Quad 4 VAhr

•   +Qh Total

•   -Qh Total

•   Internal Input (#1-8) Totals

•   Accumulation (#1-4) Totals

•   External Digital Input Modules (1-4) Inputs (#1-8)

•   I Squared T (A, B, C)

   V Squared T (A,B,C)

                                      20mAON4 Screen

Click in Output channels 1-4 to assign them to a parameter. The other Analog Output 

Modules - 20mAON8, 1mAON4, and 1mAON8 have similar setting screens, except for 

the number of channels you can program. 

•   The analog outputs are used to send a variable current dependent on the 

programmed reading. This screen lets you select the readings to output.
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                                           4RO1 Screen

Click in the Relay fields 1-4 to enter relay label, common shorted to N.C., com-

mon shorted to N.O., and check the box to lock the relay to manual control. 

When a relay is locked to manual control, it cannot be used in ElectroLogic Relay 

Control (see Section 12.3.2 for information on ElectroLogic Relay Control).

                                       Analog Input Screen

    Click in Input Channels 1-8 to assign a label and a High and Low Value. 

•   The two analog input module’s settings are the same, except for the Inputs’ high 

and low range.
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•   The High and Low Value fields let you map the inputs’ high and low range to 

values that are appropriate for the parameters you are measuring. For example, 

in the screen above, the first input is measuring temperature. The high value for 

the input is set to 100, and the low value is set to 0. An input reading of 12mA 

will translate to 50 for the temperature.

The Analog Input modules can be trended in the historical logs, and the data can 

be viewed and graphed in Log Viewer (see Chapter 19 for details). The readings 

shown in the logs and graphs will use the setting range programmed in the 

screen above, i.e., the results will be reported as 0 through 100.

                                        Digital Input Screen

   Click in Channel Label’s 1-8 to assign a Channel label, Open and Closed label,

   and Normal State (Open or Shorted) for each of the digital inputs.

   NOTES:

•   The Assigned Address, Nexus® settings, and Module settings you can make 

depend on the module you are configuring. The modules and settings are 

explained fully in the Nexus® 1262/1272 Installation and Operation Manual.

•   Port 4 is the only available port for the modules. 
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•   Log/Limit ID is a display only field. It shows the ID CommunicatorPQATM soft-

ware generates to identify this module in the Log Viewer and Limits functions.

3. Click OK to return to the main Device Profile screen. For any changes to take effect, 

you must click the Update Device button to send the new profile to the meter. 



     Doc#    E107707                                             13 - 1

13: Nexus® 1252 Meter

13: Nexus® 1252 Meter
This chapter explains how to configure a Nexus® 1252 meter's programmable 

settings, which are stored in the unit's Device Profile. Chapter 7 contains detailed 

information on the Device Profile. 

13.1: Device Profile General Settings

1. From the Device Profile screen, double-click on the General Settings line or click on 

the + button next to it. All of the settings in the General Settings group are listed.

2. Click on the programmable setting you want to modify. The following sections 

explain the settings in the order in which they appear in the General Settings 

menu.
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13.1.1: CT and PT Ratios and System Hookup

Functional Overview of CT and PT Ratios:

Current and Potential Transformers are used mainly for the following reasons:

•   To insulate, and as a result isolate, the meter from high-voltage circuits.

•   To change the primary voltage and current to standard values and sizes that the 

meter can measure.

The CT and PT transformers deliver fractions of the primary voltage and current to the 

meter. With properly set ratios and multipliers, the readings of the meter can be used 

to determine the energy, voltage, current, or power of the system. 

1. From the General Settings menu, click the + button next to CT, PT Ratios and 

System Hookup. You will see the submenu shown below.

This submenu displays the current Device Profile's settings for CT, PT ratios, 

connection type, and Operational Frequency range. 
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2. Double-click on any of the settings. You will see the CT and PT Ratios screen. 

3. Make changes to this screen according to your application requirements.

When you change a PT or CT Ratio, CommunicatorPQA® software updates the cor-

responding Full Scale value entered in the Limit and Waveform Full Scales setting. 

When you click OK on this screen, CommunicatorPQA® software opens the Limit & 

Waveform Full Scales screen so that you can verify the settings (see Section 

13.1.2). 

•   Enter Primary and Secondary Current and Voltage.

•   Using the pull-down menu, choose the Hookup mode that matches the connec-

tion you have to the Nexus®1252 meter. Choose from the following: 

• Wye

• Delta 3 CTs

• Delta 2 CTs
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• 2.5 Element Wye

• 4 Wire Delta 

This value must be set properly for the meter to calculate readings 

correctly.

See the Nexus® 1252 Meter Installation and Operation Manual for 

connection diagrams.

•   Using the pull-down menu, select Operational Frequency Range: 

• 20Hz to 65Hz

• 350Hz to 500Hz

• 20Hz to 500Hz    

4. Click OK. If changes have been made, a message window opens asking you to 

verify that the Limit Full Scales are correct. 

5. Click OK. The Limit and Waveform Full Scales screen opens (see Section 13.1.2). 

6. To implement any changes, click the Update Device button to send the new 

profile to the meter. 

You will see a warning message that logs will be reset, and you will be given the 

opportunity to retrieve the logs before they are cleared. Resetting the logs 

prepares the meter for placement in a new installation or change of the meter 

Transformers.

13.1.2: Limit and Waveform Full Scales

All Limit and Waveform settings (see Sections 13.1.1 and 13.3.5, respectively) are 

based on a percentage of the Full Scale. Full Scales are based on the CT and PT ratios 

(see Section 13.1.1). The % of Full Scale is defaulted based on the CT and PT ratio. If 

the user wants, the Full Scales can be adjusted to the actual power system condition, 

to optimize the triggering conditions.

Set the CT and PT ratios first; CommunicatorPQA® software automatically recalcu-

lates the Full Scales every time the CT and PT ratios change and presents them for 

your verification. 
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1. From the General Settings menu, click on the + button beside Limit and Waveform 

Full Scales or double-click on the Limit and Waveform Full Scales line. You will see 

the submenu shown below.

This submenu displays the current Device Profile's settings for the Limit and 

Waveform Full Scales. The values shown here are the default meter settings.

Frequency and Voltage values are nominal values. The Power Phase is computed using 

nominal Voltage and rated maximum current. In most cases the software automati-

cally computes the proper value - you will not need to change it.
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2. Double-click any of the settings. You will see the Limit and Waveform Full Scales 

screen.

3. Enter the Full Scale for each parameter.

NOTES:

•   The Limits and Waveform settings (Sections 13.1.1 and 13.3.5, respectively) are 

based on a percentage of the Full Scales entered here.

•   CommunicatorPQA® software automatically recalculates the Full Scale Voltages, 

currents and power every time the CT and PT ratios change. However, frequency 

is not changed, even if the operational frequency range is changed. Frequency 

can only be changed on this screen.

•   Power Phase is the amount of power per each phase; Power Total is the power of 

all phases combined.

4. When all changes are entered, click OK to return to the main Device Profile screen. 

For any changes to take effect, you must click the Update Device button to send 

the new profile to the meter. 



     Doc#    E107707                                             13 - 7

13: Nexus® 1252 Meter

13.1.3: Time Settings

To edit a Device Profile's Time settings:

1. From the General Settings menu, double-click on the Time Settings line. You will 

see the submenu shown below. DST stands for Daylight Savings Time.

2. Double-click on any of the programmable settings; you will see the Time Settings 

screen.

3. Make changes to this screen according to your application requirements.
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•   Zone Descriptor: A Zone Descriptor sets the time zone for the meter. 0 = Green-

wich Mean Time. Consult the chart below to find the Zone Descriptor for your 

time zone.

•  Daylight Savings Information:

• Disabled: Disables an automatic adjustment for Daylight Savings Time.

• Auto DST: Sets Daylight Savings Time automatically to the pre-2007 

standard for the United States: the time changes automatically occur at 

2:00 AM (your local time), on the first Sunday in April and the last 

Sunday in October.

• Auto DST U.S. EPA 2005: Sets Daylight Savings Time automatically to 

the 2007 standard for the United States: the time changes automatically 

occur at 2:00 AM (your local time), on the second Sunday in March and 

the first Sunday in November.

GMT Greenwich Mean Time Table (Dublin, London)

-1.00   Azores +1.00   Brussels, Paris, Warsaw

-2.00   Mid-Atlantic +2.00   Athens, Cairo, Helsinki

-3.00   Buenos Aires, Georgetown +3.00   Baghdad, Kuwait, Moscow, 
Tehran

-4.00   Atlantic Time (Canada), Santiago +4.00   Kabul, Baku

-5.00   Eastern Time (USA and Canada), 
Lima

+5.00   Karachi

-6.00   Central Time (USA and Canada), 
Mexico City

+6.00   Dhaka

-7.00   Mountain Time (USA and 
Canada)

+7.00   Bangkok, Hanoi, Jakarta

-8.00   Pacific Time (USA and Canada), 
Tijuana

+8.00   Beijing, Hong Kong, Singapore

-9.00   Alaska +9.00   Osaka, Sapporo, Seoul

-10.00  Hawaii +10.00  Brisbane, Melbourne, Guam, 
Hobart

-11.00  Midway Island +11.00  Magadan, Solomon Islands

-12.00  Eniwetok +12.00  Auckland, Fiji
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• User Defined: Allows you to set the Daylight Savings Time start and end 

times manually. Fields open that let you set the beginning and ending 

dates for Daylight Savings Time.

•   Line Synchronization: set Enable or Disable and Frequency. 

• Line synchronization uses the frequency zero crossings to provide a time 

reference for the meter. The basic function of Line Frequency Clock Syn-

chronization is to adjust the real time clock to track the time based on the 

power line frequency. For this purpose, Phase A voltage only is used.

• This is the most common method to synchronize a meter’s clock. EIG 

recommends that you always select this method unless there is a specific 

reason not to select it. If the meter is not synchronized to line frequency 

or IRIG-B, it will default to internal crystal. Different meters differ in 

terms of drift, but typically meters with 20 ppm crystals will drift 30 sec-

onds per month when set to internal crystal.

• Line Sync is disabled if an IRIG-B signal is present. If the signal is lost, 

the unit defaults to its internal crystal for a time synchronizing reference.

• How Time is Adjusted

After the clock is synced to the line, the meter periodically checks the 

cumulative difference between the real time clock in seconds and the line 

cycle count. If the absolute difference between the two accumulations is 

more than 1 second or 60 (50) cycles, the clock is adjusted + / - 1 second 

accordingly.

4. To set the meter's on-board clock, use Set Device Time from the Tools Menu (see 

Section 20.1).

5. When all changes are entered, click OK to return to the main Device Profile screen. 

For any changes to take effect, you must click the Update Device button to send 

the new profile to the meter.
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13.1.4: Labels

Labels are user-defined names for the Nexus® 1252 meter and the I N Measured 

terminal. You also use the Labels screen to select the power direction, and the power 

factor display.

It is important to label the meter (under "Meter Designation") with a unique name 

because that label becomes the file name of any logs retrieved from that meter. Dupli-

cate meter designations interfere with retrieved log databases. See Chapters 16 and 

19 for more details on logs.

1. From the General Settings menu, double-click on the Labels line. You will see the 

submenu shown below.
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2. Double-click on any of the parameters; you will see the Labels screen.

3. Enter labels in the appropriate fields.

•   Meter Designation must be set for partial log retrieval. You can use any charac-

ter allowed by the Windows® operating system. 

• In English versions the following characters don’t work: 

 \ / : * ? " < > | 

• For meters used internationally by multilingual users, we recommend you 

use only alphanumeric characters allowed by your operating system.

•   For V Aux (auxiliary voltage input) and IN Measured (measured neutral current) 

enter the label you want to use for these readings. 

•   Your selection in Power Direction determines which quadrants of Watt-hours are 

considered Received and Delivered.

•   Your selection in Power Factor Display determines the display of Quadrants in 

the Power Factor screen.
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•   The Memo field is used to enter notes about the meter, such as the location, or 

other relevant details.

•   The Phase Angle representation determines how the voltage phase angles are 

represented. 90 of users will use the default, which is the first radio button: 

“Positive angle for events after the reference and negative angle for events prior 

to the reference’; however, you can choose the opposite display by selecting the 

second radio button, if you wish.

4. When all changes are entered, click OK to return to the main Device Profile screen. 

For any changes to take effect, you must click the Update Device button to send 

the new profile to the meter.
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13.1.5: Communications 

1. From the General Settings menu, double-click on the Communications line. You will 

see the submenu shown below.

2. Double-click on any of the settings (e.g., "Serial Port 1"): you will see the 

Communications Settings screen. 
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This screen displays the current Device Profile settings for the Nexus®1252 meter's 

4 Communications ports: address, baud rate, data bits, parity, stop bits, Tx (Trans-

mit) delay, (communication) protocol, and mode. You may use one of the Nexus® 

External Displays to learn the current baud rate, address and communication proto-

col of each meter port. See the Nexus® 1252 Meter Installation and Operation 

Manual for details. 

NOTES: 

•   When a Nexus® 1252 meter has the Internal Network option (INP100/INP102/ 

INP200/202) Port 2 is unavailable and any settings in the Port 2 fields are 

ignored. 

•   Port 2 settings are ignored when the Internal Modem option (INP2) is installed 

and the address is set to 1. 

•   Port 3 is factory set to the Nexus® External Display's baud rate of 9600. The 

External Display only communicates at Address 1. You must use Port 3 or Port 4 

to connect any external devices, such as a Nexus® External I/O module. 

•   Port 3 and Port 4 are Master (I/O modules)/Slave selectable. If you use Port 3 as 

an I/O Module port, you can use one of the other ports for the display (change 

the baud rate to 9600 and set address to 1). For all External I/O Devices, set the 

Communication Protocol to Modbus RTU.

3. Make changes to this screen according to your application requirements by clicking 

on the box or pull-down menu of any of the following settings:

•   Address: assign an address to each port to communicate with other devices. 

Multiple Nexus® meters on an RS485 bus must each have a unique address set 

for the port that is connected to the bus. 

•   Baud Rate: from the pull-down menu, select 4800, 9600, 19200, 38400, 57600, 

or 115200. The baud rate entered in this field must match the baud rate of the 

device connected to the Nexus® 1252 meter at this port. Use 9600 for modem 

connections. 

•   Data Bits: use the pull-down menu to select from: 5, 6, 7 or 8. For Modbus RTU 

and ASCII, leave the data bits at 8.
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•   Parity: use the pull-down menu to select from: None, Even, Odd, Mark or Space. 

For Modbus RTU and ASCII, leave the parity at None.

•   Stop Bits: use the pull-down menu to select from: 1, 1.5 or 2. For Modbus RTU 

and ASCII, leave the stop bits at 1. 

•   TxDelay (Transmit Delay): use the pull-down menu to select from (0-12750) ms. 

Leave the Tx delay at 0ms unless you are using equipment that requires a delay 

in the response time, such as a radio modem.

•   Protocol: use the pull-down menu to select from Modbus RTU, Modbus ASCII, 

and DNP3. See Chapter 3 for connection details.

•   Mode (Port 4 only): If you are using Output modules, set this port to Master 

(I/O modules) mode. Set the port to operate at 57600 baud.   

•   Internal Network Option: If your meter has the Internal Network Option 

(INP100/INP200), see your Network Administrator for the correct settings to 

enter into the Network Settings fields. Settings will vary from network to 

network. 

•   If your meter has the INP100/INP200/ INP102/INP202 Option (10/100BaseT 

and Combo Card), you will see the Advanced Settings button: click it to open a 

screen that lets you set Network card features; see Chapter 21 for details.

•   Internal Modem Settings: If your meter has this option: 

a. Set the number of Rings to Answer from the pull-down menu. 

b. Set the Baud Rate to 57600, or to match your system's baud rate. 

c. Click Dial-Out Profile to access the Modem Programming screen: see Chap-

ter 24 for instructions on using the Modem Dial In/Dial Out Function. 
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4. When all changes are entered, click OK to return to the main Device Profile screen. 

For these changes to take effect, you must click the Update Device button. This 

sends the new profile to the meter. 

IMPORTANT! 

•   In order to prevent communications problems, be careful when making changes in 

the Communications Settings screen. For example, if you change the baud rate of 

the port connected to a computer, be sure to make the same change to the com-

puter port's baud rate. If you change a port's address, be sure to update the 

address settings of any device that communicates with the port. 

•   The baud rate of the port used by the Nexus® External Display should always be 

set to 9600 and the address set to 1.
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13.1.6: DNP Custom Class Map

The DNP Custom Class Map lets you set up DNP communication for the meter. From 

the General Settings menu, double-click on the DNP Custom Classes Map line and on 

the DNP Level 2 line. You will see the screen shown below. 

 For details on programming the DNP Level 2 settings, see Chapter 22.
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13.1.7: Custom Modbus Map

The custom Modbus map for the Nexus® 1252 meter can position up to 256 unique 

items (or the equivalent of 2048 registers, whichever you reach first) to readily pro-

vide the functionality you want from your meter. In addition, you can customize 

selected values for format type, Scaling, byte order, data size, etc. This allows a user 

to optimize Modbus registers by putting them in a particular order and/or format to 

make the SCADA poll more quickly and efficiently.

1. From the General Settings menu, double-click on the Custom Modbus Map line. You 

will see the screen shown below.

Data entry is straightforward. Each entry field is described below. Note that not all 

selections appear on the screen at the same time. Use the scroll buttons to view 

additional data/entry fields on the screen. Certain entries (such as Format, Data 

Size, etc.) have different allowable selections depending on the data point used. 

The pull-down menu adjusts to provide the appropriate selections for each data 

point.

•   Data Point Selection: there are two different ways to select a data point:

a. Refer to the Nexus® 1252 meter’s Modbus map and find the associated line 

and point for the value you want. When you enter those values into the 

screen table, the software displays the associated group and channel.

•The Nexus® 1252 meter’s Modbus map can be downloaded from the EIG 

website: http://www.electroind.com/pdf/modbus2.pdf

http://www.electroind.com/pdf/modbus2.pdf
http://www.electroind.com/pdf/modbus2.pdf
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b. Double-click the Group field. From the pull-down menus, select a group and 

its associated channel value. The software displays the map and line 

values.

•   Number of Registers: this field is display only. The software computes the 

number in this field based on the data size selected in the Data Size column.

•   Start Register: this field is display only. The software assigns and adjusts Start 

register numbers to take into account previous entries and data sizes. The Start 

register is the number of the first register used in polling. The Start registers are 

shown as 4x to describe them as holding registers, for SCADA applications.

•   Format: from the pull-down menu, select a format type for a value, such as 

Signed Integer, Unsigned Integer, and 4 Byte IEEE Float.

•   Data Size: from the pull-down menu, select the number of bytes you want to 

represent the data point: 2 or 4.

•   Unit: if the polled value is viewed as an integer, the Unit field tells the software 

where to place the decimal point. 

Examples 

• If you select .01, a polling value 1234 is interpreted as 12.34.

• If you select 100, a polling value 1234 is interpreted as 123400.

•   Primary/Secondary: the meter normally computes values in secondary units. 

Where applicable, you may select primary or secondary. If Primary is selected, 

the value is multiplied by the appropriate CT and/or PT values.

•   Absolute Value: where appropriate, you may have the option of having the data 

point computed as a signed or absolute value. Select either:

• No: to have the data point computed as a signed value.

• Yes: to have the data point computed as an absolute value.
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•   Byte Order: for most of the data points, you can select the polling order of the 

registers/bytes to match what the SCADA system needs. The choices are: MSR, 

MSB (most significant register, most significant byte); MSR, LSB (most signifi-

cant register, least significant byte); LSR, MSB (least significant register, most 

significant byte); and LSR, LSB (least significant register, least significant byte). 

EIG meters store data as MSR, MSB, whereas most SCADA systems use LSR, 

LSB. You can either select an alternate order here, for example, LSR, LSB, or 

you can leave the data as is and then have your SCADA system change the 

order after the data is polled. 

•   Display/Modulo/Offset: depending on the data point, select one or more 

additional options with appropriate sub-selections.

• Display: for certain data points, interpretation and display options are 

offered. 

Example: For Volts AN phase angle values, you can represent and 

display as 0 to 360 degrees or -180 to +180 degrees, etc. Selections 

appear in a pull-down menu for the associated point. You may want to 

select -180 to +180 degrees if you ant to know if a phase angle is positive 

or negative in relation to the reference.

• Modulo: Certain values are cumulative and can roll over and start 

recounting from zero. For those values, where required, you can enter a 

point at which the rollover will occur.

• Offset: Where allowed, you can enter a value (offset) that will be added 

to the data point when it is computed.

2. When all changes are entered, click OK to return to the main Device Profile screen. 

For any changes to take effect, you must click the Update Device button to send 

the new profile to the meter. 
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13.2: Revenue and Energy Settings

Revenue and Energy Settings are the second group of settings in the Device Profile.

1. From the Device Profile screen, click on the + button next to Revenue and Energy 

Settings or double-click on the Revenue and Energy Settings line. All of the settings 

in the Revenue and Energy Settings group are listed. 

2. Click on the programmable setting you want to modify. The following sections 

explain the settings in the order in which they appear in the Revenue and Energy 

Settings menu.
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13.2.1: Energy Scaling

1. From the Revenue and Energy Settings menu, click on the + button next to Energy 

Scaling or double-click on the Energy Scaling line. You will see the Energy Scale 

Settings screen. 

•   This screen has multiple tabs that allow you to access all of the Energy Scaling 

options. Using the Energy Scale Settings screens you can select the number of 

digits, decimal point placement and Energy unit for displayed readings. 

•   The Example field shows you the scaling choices you made applied to an exam-

ple reading.

•   You click on the tabs to navigate between screens, except for Global settings - 

you click on the Global Settings button to access that screen.     

To configure scaling for a reading, enter:
1. Number of Digits, 2. Number of Decimal Places, 
3.Unit of Measurement; 4. Example of the resultant scaling is shown here
                             1                 2   3                        4
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    Global Settings

NOTE: Because there are many energy settings, Global Settings conveniently allows 

you to set these similar energy reading settings all at once.

2. Click the Global Settings button to see the screen shown above. This screen lets 

you set the scale for all of the Energy Readings.

a. Click in the Digits field and select the number of digits for the value from the 

pull-down menu. You can choose between 2 and 9 digits.

b. Click in the Decimal Places field and select the number of decimal places for the 

value from the pull-down menu. You can choose between 0 and 7 decimal 

places, depending on the number of digits you selected. For example, if you 

chose 3 digits, you can only choose up to 2 decimal places.

c. Click in the Units field to select the unit of measurement for the value. You can 

select k or M or leave the field blank. 

The example field changes as you make selections, to show you how the value 

would appear with the settings you made.

3. When all changes are entered, click Apply to return to the main Energy Scale 

Settings screen. You can now use the tabs to modify the scale for specific readings. 

For example, you might have set the scale for the Internal Input Accumulators as 5 

digits, 2 decimal places, and M unit, but you may want one of the accumulators to 

have a different scale. You would click the Pulse Accumulations and Aggregations 
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tab and change the scale for that accumulator. The following sections show the tab 

screens where you can make individual scaling changes. You set the Digits, Deci-

mals, and Units fields in the same way as in the Global Settings screen.

Energy Tab

    This is the initial screen view. Click on the Watt Hour, VA Hour, and VAR Hour tabs

    to configure scaling for those readings.

Click to set Watt Hour 
readings scaling (this is 
the initial tab view)

Click to set VA Hour 
readings scaling

Click to set VAR Hour 
readings scaling
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    Uncompensated Energy Tab

    Click on the Uncompensated Energy tab to configure specific VA, Watt and VAR

     readings not adjusted by Transformer Loss Compensation. 
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    Pulse Accumulations and Aggregation Tab

    Click on the Pulse and Aggregations tab and then click on the Accumulators and

    Aggregators tabs to configure scaling for those readings.

Click to set scaling for Accumulator read-
ings (this is the initial tab view)

Click to set scaling for Aggregator read-
ings 
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    I and V Squared T Readings Tab

    Click on the I and V Squared Readings tab to configure scaling for specific I2T 

    readings (data will not accumulate until current reaches the programmed level)

    and V2T readings (data stops accumulating when Voltage falls below the 

    programmed level).
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    Q Hours Tab

    Click on the Q Hours tab to configure scaling for +QH and -QH readings.   

4. When you are done, click OK to return to the main Device Profile screen. For these 

changes to take effect, you must click the Update Device button to send the new 

profile to the meter.
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13.2.2: Demand Integration Intervals

See the Nexus® 1252 Meter Installation and Operation Manual for details on Demand 

intervals.

1. From the Revenue and Energy Settings menu, click on the + button next to 

Demand Integration Intervals or double-click on the Demand Integration Intervals 

line. You will see the submenu shown below.

2. Double-click on any of the settings. You will see the screen shown below.

3. Click on the tabs at the top of the screen to navigate from one setting to another. 

Make changes to the settings according to your application requirements. Following 

is a brief description of each setting and its function:
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•   Thermal Averaging (tab shown on previous page): use to set hours, minutes and 

seconds for a precise thermal window of demand data.

Thermal Averaging (tab shown on previous page): use to set hours, minutes and 

seconds for a precise thermal window of demand data.

• Traditional analog Watt-hour meters use heat-sensitive elements to 

measure temperature rises produced by an increase in current flowing 

through the meter. A pointer moves in proportion to the temperature 

change, providing a record of demand. The pointer remains at peak level 

until a subsequent increase in demand moves it again, or until it is manu-

ally reset. 

The Nexus® 1500 meter mimics traditional meters to provide Thermal 

Demand readings. Electronic thermal demand emulation is the logarith-

mic average of the power used, with a more recent load being weighted 

more heavily than a less recent load, (approximated exponentially). Each 

second, as a new power level is computed, a recurrence relation formula 

is applied. This formula recomputes the thermal demand by averaging a 

small portion of the new power value with a large portion of the previous 

thermal demand value. The occurrence of the proportioning of new to 

previous is programmable, set by the averaging interval. The averaging 

interval represents a 90 change in thermal demand to a step change in 

power. So, for example, with a 15 minute set interval, the meter will 

record 90 of a change in load in 15 minutes, 99 in 30 minutes, and 99.9 

in 45 minutes. 

Because thermal demand emulation is the logarithmic average, the 

demand is not set to zero on a demand reset. On a demand reset, pres-

ent demand becomes the new maximum demand.

• The Max/Min Thermal Average Block Interval fields are used if you 

want to track the maximum and minimum Demand in more than one 

interval, e.g., the Max and Min Demand in a 10 minute (First Interval) 

and a 15 minute interval (Second Interval).

•   Block Averaging Time: use to set the length of the block interval used for 

Demand calculations and other interval-based functions; also used to set End of 

Interval pulse. Block averaging is also known as fixed window averaging. A 
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window is the user set time range, e.g., 15 minutes. Computation is performed 

on that 15 minute interval, and after that, a new set of computations will be 

started. For example, Window 1 will be from 0 to 15 minutes, Window 2 will be 

from 16 to 30 minutes, and so on. 

a. Use the Hours, Minutes, and Seconds fields to set the length of the Block 

Interval.

NOTE: The Block Window Sync field indicates whether the meter is being       

synchronized with pulses from a High Speed input. This option is set in the 

Input Type field of the High Speed Inputs screen (see 13.3.7: High Speed 

Inputs on page 13-67).

•   Rolling Averages: also known as a sliding window, functions like multiple, over-

lapping Block averages. You define the subintervals at which an average of 

Demand is calculated. A window duration is the user set time, such as 15 min-
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utes, but it moves, so that, for example, Window 1 is 0 to 15, Window 2 is 1 to 

16, Window 3 is 2 to 17, and so on.

a. Set the Hours, Minutes, and Seconds fields under Rolling Averaging Sub-

Interval Window.

b. Rolling Sub-Intervals: set the number of rolling windows you want to 

"string together."

c. Predictive Rolling Window Average: the meter gives you the programmed ( 

field) prediction of your demands. If you are using Demand as a Limit, such 

that you will perform certain actions when you hit a certain Demand level, 

e.g., turning off motors, you may want to give yourself a “buffer.” This field 

accomplishes that by letting you choose to over-predict the Rolling Window 

Demand - e.g., if you enter 110, the meter will predict Demand at a 10 

higher rate than the actual Demand, so that you will trigger a Limit alarm 

earlier than if you were using 100 Predictive Demand.
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•   Reset: Allows you to specify a Time of Use read whenever Maximum Demand is 

reset.

• Check the box to perform the TOU read. By selecting this, the meter will 

place all of the TOU values in the previous month’s registers. Otherwise, 

the meter will default to self read based on a date set in the meter.

• Leave the box unchecked if you don't want to perform a TOU read.

4. When all changes are entered, click OK to return to the main Device Profile screen. 

For these changes to take effect, you must click the Update Device button to send 

the new profile to the meter.
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13.2.3: Internal KYZ Outputs 

The Nexus® 1252 meter has no internal KYZ outputs. The Internal KYZ Outputs 

setting allows you to assign a channel and determine other settings for the Heartbeat 

LED which the meter does have. 

1. From the Revenue and Energy Settings menu, click on the + button next to 

Internal KYZ Settings or double-click on the Internal KYZ Settings line. You will see 

the screen shown below.

2. Using the pull-down menu next to HB LED (Heartbeat LED):

a. Assign a channel to the LED.

b. Enter Watt Hour per Pulse, Pulse Width, Mode and Form for the HB LED.

NOTE ON FORM: Form A = Pulse; Form C = Transition.

3. When all changes are entered, click OK to return to the main Device Profile screen. 

For these changes to take effect, you must click the Update Device button to send 

the new profile to the meter.
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13.2.4: External Display Options

Many utility companies want to read secondary Volts and primary power readings. 

This setting configures a P40N/P40N+ external display to read either primary or sec-

ondary Volts. All other readings will be in the primary, regardless of this setting.

1. From the Revenue and Energy Settings menu, double-click on the External Display 

Options line. You will see the screen below.

2. Use the pull-down menu to select either primary or secondary units for Voltage.

3. Click OK to return to the main Device Profile screen. For these changes to take 

effect, you must click the Update Device button to send the new profile to the 

meter.

13.2.5: CT and PT Compensation

1. From the Revenue and Energy Settings menu, click on the + button next to CT and 

PT Compensation or double-click on the CT and PT Compensation line.

2. Check the Enable box to enable CT and PT Compensation; leave the box unchecked 

to keep it disabled.

3. Click OK to close the screen and return to the main Device Profile screen. For these 

changes to take effect, you must click the Update Device button to send the new 

profile to the meter. 
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13.2.6: Transformer / Line Loss Compensation

Transformer losses are power used by the transformer while working. The more load 

on the transformer, the higher the transformer losses. There are two types of trans-

former losses:

•   No load losses - these are the fixed losses that keep the transformer up and 

running.

•   Load losses - these vary with changes in the load.

When the meter is located on the secondary side of a customer’s transformer, a utility 

will want to add the transformer losses into the energy usage calculation. However, 

this practice is regulated by local jurisdiction and regulations. The meter has the 

capability to add in or subtract out these transformer losses, depending on the user’s 

specific needs.

Line losses are similar to transformer losses, except that they are used to compensate 

for loss incurred on wires, such as transmission lines.

1. From the Revenue and Energy Settings menu, click on the + button next to 

Transformer/Line Loss Compensation or double-click on the Transformer/Line Loss 

Compensation line. You will see the submenu shown below.

2. The menu displays the current values for the meter's Transformer Loss Compensa-

tion.

•  LWFE = percent loss of Watts due to iron

•  LVFE = percent loss of Vars due to iron
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•  LWCU = percent loss of Watts due to copper  

•  LVCU = percent loss of Vars due to copper

3. Double-click on any of the loss values. You will see the screen shown below.

4. Click on TLC Calculator to find the values to enter into the Percent Loss fields. The 

TLC Calculator button launches the TLC Calculator that performs the calculations 

for you once the required data is entered.  

NOTE: Appendix A contains screen captures of the TLC Calculator with example 

numbers, and an explanation of Loss Compensation considerations.

5. Enter the percent loss of Watts and VARS for copper and iron in the appropriate 

fields. 

6. Enable or Disable Transformer Loss Compensation with the first pull-down menu at 

the bottom of the screen. The optional selections are:

•   Disabled

•   Iron (Fe) Only 

•   Copper (Cu) Only
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•   Both Iron and Copper (Fe and Cu)

7. With the second pull-down menu, select from the following options:

•   Add to Watts and Subtract from VAR

•   Subtract from Watts and Add to VAR

•   Add to Watts and VAR

•   Subtract from Watts and VAR

8. With the third pull-down menu, apply the loss based on the power flow direction by 

selecting one of the following options:

•   Both +Watts and -Watts 

•   -Watts only

•   +Watts only 

3. When all settings are complete, click OK to return to the main Device Profile 

screen. For any changes to take effect, you must click the Update Device button to 

send the new profile to the meter.

13.2.7: Cold Load Pickup 

Cold Load Pickup is used to manage Demand in the event of a power outage. You set 

the amount of time (in seconds) power is off to identify a power outage that is the 

responsibility of the utility (as opposed to a very short term loss of power that is not 

their responsibility); then you set the amount of time (in minutes) you want to wait 

before Demand starts again. This time should correspond to the “grace” period the 

utility applies to avoid charging for motor startup, etc. after a power outage. 

1. From the Revenue and Energy menu, click on the + button next to Cold Load 

Pickup or double-click on the Cold Load Pickup line. You will see the submenu 

shown below.
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2. Double-click on one of the parameters to open the screen shown below.

3. Make the following selections in accordance with your application needs:

•   Time after control power is restored to start demand - can be 1 to 60 minutes, 

or Disabled. 

•   Minimum time control power must be off before using Cold Load Pickup - can be 

from 0 to 255 seconds.

4. When all changes are entered, click OK to return to the main Device Profile screen. 

For these changes to take effect, you must click the Update Device button to send 

the new profile to the meter.

13.2.8: Cumulative Demand Type

Cumulative Demand is a counter of Max Demand that the meter keeps. It can help 

you determine if there has been tampering with the meter, i.e., unauthorized resetting 

of Demand. Whenever Demand is reset, the current Max Demand is added to the 

Cumulative Demand. By analyzing the data in the counter you can see if the Demand 

is being reset more often than intended. You can choose to use either Block Window 

Demand or Rolling Window Demand for the Cumulative Demand. 

1. From the Revenue and Energy Settings menu, click on the + button next to 

Cumulative Demand Type or double-click on the Cumulative Demand Type line.        
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You will see the submenu shown below. It tells you the type of Demand currently 

selected.

2. Click the Type line to open the screen shown below. 

3. Click the radio button in front of Rolling Window (sliding) or Block Window (fixed) to 

select cumulative Demand type.

4. Click OK to exit the screen and return to the main Device Profile screen. For a 

change to take effect, you must click the Update Device button to send the new 

profile to the meter.
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13.2.9: Energy, Pulses and Accumulations in the Interval

Energy in the interval is the energy that is accumulated within a load profiling 

interval. This is often the preferred method for logging because it is a summation of 

only that particular period of energy. The Interval setting you make creates the 

sub-accumulation field within the general Energy accumulation. An advantage of this 

setting is that the sub-accumulation takes up less space and is processed more 

quickly then the larger accumulation. 

1. From the Revenue and Energy Settings menu, click on the + button next to Energy, 

Pulses and Accumulations in the Interval or double-click on the Energy, Pulses and 

Accumulations in the Interval line. You will see the submenu shown below.

2. The current Interval setting is displayed. Click on the Interval setting to open the 

screen shown below.

3. Set the number of minutes for the Energy interval. 

3. Click OK to close the window and return to the main Device Profile screen. For any 

change to take effect, you must click the Update Device button to send the new 

profile to the meter.
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13.2.10: Pulse Accumulations

Pulse accumulators are used to count and/or aggregate pulse information from exter-

nal devices, using the High Speed inputs. These devices may be gas, water, or elec-

tricity meters; energy management systems; SCADA devices; or any pulse-

generating device. 

This section of the Device Profile displays a series of eight running totals available on 

the Nexus® 1252 meter. Each total can be added to (or subtracted from) other totals. 

This allows you to set the High Speed inputs located directly on the meter to accumu-

late pulses. 

NOTE: If you use these inputs for pulse accumulations, do not set them to record 

waveforms - if you do, you will record endless waveforms.

1. From the Revenue and Energy Settings menu, click on the + button next to Pulse 

Accumulations or double-click on the Pulse Accumulations line. You will see the 

screen shown below.

2. High Speed inputs 1-8 are listed in order under Source. Enter the following 

information or use the pull-down menus to select:
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•   Units/Count - this is the scale factor that normalizes the pulses so that they can 

be aggregated. Pulses are stored in primary values.

•   Aggregator - this allows you to place the pulse register into a separate accumu-

lation register that can aggregate (add) or net (subtract) values.

•   User Assigned Label - this window allows you to enter a label designation for the 

source.

•   Mode - you can set Pulse or Transition. A transition means from open to shorted/

closed or from shorted/closed to open; a pulse contains 2 transitions, open to 

shorted/closed, followed by shorted/closed to open. 

•   Average Full Scale - for Nexus® meters, in order to set a limit on a reading it 

needs a Full Scale value as the 100 reference. You can set a limit on the 

average number of pulses per interval.

•   Device Hour Reading and Aggregator - source device is the meter you are 

connected to. The Hour reading is either Quadrant 1 and 4 Watt-hour or Quad-

rant 2 and 3 Watt-hour. The Aggregators indicate whether the count should be 

added to, or subtracted from, Aggregators 1-4. You can choose None if you don’t 

want the count to affect any of the Aggregators.

•   Aggregators: The “buckets,” or Totalizer fields where pulse counts from the High 

Speed inputs and from the Watt-Hour counters can be totaled. The user can 

assign a label to each of the Aggregators. See the Average Full Scale description 

above for an explanation of this field - it has the same use here, except for the 

Aggregators.

3. When all data has been entered, click OK to return to the main Device Profile 

screen. For any changes to take effect, you must click the Update Device button to 

send the new profile to the meter.
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13.3: Power Quality and Alarm Settings

Power Quality and Alarm Settings are the third group of settings in the Device Profile.

1. From the Device Profile screen, click on the + button next to Power Quality and 

Alarm Settings or double-click on the Power Quality and Alarm Settings line. All of 

the settings in this group are listed.

2. Click on the programmable setting you want to modify. The following sections 

explain the settings in the order in which they appear in the Power Quality and 

Alarm Settings menu.
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13.3.1: Limits

Limits are threshold settings that can be set by a user to trigger a record in a log 

when an alarm condition is met. Utilizing the limits, the user can then control a relay 

or send a warning email on that alarm.

Limit settings are based on a percentage of the Full Scale (% of FS), which is set in 

the Limit and Waveform Full Scales setting (Section 13.1.2). Full Scale is based on CT 

and PT ratios set in the CT, PT Ratios and System Hookup setting (Section 13.1.1).

Limits are based on a percent of Full Scale settings so that the same settings can be 

used no matter what the CT and PT Ratio needed.

Before programming limits, set the CT and PT ratios. Then, set the Limit and Wave-

form Full Scales if you want to change to automatic configuration. In most cases the 

software will configure the Full Scale optimally. 

NOTE: The software automatically updates the Full Scale; however, you can set it 

separately from the CT and PT Ratios.
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1. From the Power Quality and Alarm Settings menu, click on the + button next to 

Limits or double-click on the Limits line. You will see the submenu shown below.

This submenu displays the current Device Profile Limit settings. Not all limits are 

shown in the figure above: there are 32 Limit ID fields.



     Doc#    E107707                                             13 - 47

13: Nexus® 1252 Meter

2. Double-click on any of the settings (Limit ID 01, for example). You will see the 

Limits screen, shown below.

•   This screen can be expanded to show all of the limits. Click on the top or 

bottom of the screen to display sizing arrows you can click on and drag to 

expand the screen.

•   Percentage of Full Scale settings (% of FS): The limits are set in % of Full Scale 

so that when you create a profile, you can keep your settings. This is true, even 

though the CT and PT ratios change when the meter (or a new meter) is placed 

in a different location. Changing the CT and PT ratios does not affect the % of 

Full Scale limits previously set. This is useful when you are using large numbers 

of meters because one profile can be used with a common set of limit settings no 

matter what the CT and PT ratio. Full Scale reference information is available in 

the lower left box.

3. Make changes to this screen according to your application requirements.

•   To set the type of limit and the channel assigned to it:
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a. Double-click in either the Limit ID or Assigned Item column. You will see 

the screen shown below.

b. From the pop-up menus, choose the desired settings and click OK. Follow-

ing is a list of the available Groups, Sub Groups, and Items.

Group: Measured Values

Sub Group: High Speed Updated

Item: Voltage A-N

         Voltage B-N

         Voltage C-N

         Voltage Aux

         Current A

         Current B

         Current C

         Current N Measured

         Voltage A-B

         Voltage B-C

         Voltage C-A

         VA A

         VA B

         VA C

         VA Total

         VAR A

         VAR B

         VAR C

         VAR Total

         Watt A
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         Watt B

         Watt C

         Watt Total

         Frequency

         Power Factor A

         Power Factor B

         Power Factor C

         Power Factor Total

         Volts A-Aux Phase Angle

         Current N Calculated

Sub Group: One second updated

Item: Voltage A-N

         Voltage B-N

         Voltage C-N

         Voltage Aux

         Current A

         Current B

         Current C

         Current N Measured

         Current N Calculated

         Voltage A-B

         Voltage B-C

         Voltage C-A

         VA A

         VA B

         VA C

         VA Total

         VAR A

         VAR B

         VAR C

         VAR Total

         Watt A

         Watt B

         Watt C

         Watt Total

         Frequency
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         Power Factor A

         Power Factor B

         Power Factor C

         Power Factor Total

         Voltage Imbalance

         Current Imbalance

         Uncompensated VA A

         Uncompensated VA B

         Uncompensated VA C

         Uncompensated VA Total

         Uncompensated VAR A

         Uncompensated VAR B

         Uncompensated VAR C

         Uncompensated VAR Total

         Uncompensated Watt A

         Uncompensated Watt B

         Uncompensated Watt C

         Uncompensated Watt Total

         THD Volts A

         THD Volts B

         THD Volts C

         THD Current A

         THD Current B

         THD Current C

         K Factor Current A

         K Factor Current B

         K Factor Current C

         Internal Temperature

         TDD Volts A

         TDD Volts B

         TDD Volts C

         TDD Current A

         TDD Current B

         TDD Current C

         Maximum TDD Phase A-N/Phase A-B Voltage

         Maximum TDD Phase B-N/Phase B-C Voltage
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         Maximum TDD Phase C-N/Phase C-A Voltage

         Maximum TDD Phase A Current Timestamp

         Maximum TDD Phase B Current Timestamp

         Maximum TDD Phase C Current Timestamp

         Minimum TDD Phase A-N/Phase A-B Voltage

         Minimum TDD Phase B-N/Phase B-C Voltage

         Minimum TDD Phase C-N/Phase C-A Voltage

         Minimum TDD Phase A Current Timestamp

         Minimum TDD Phase B Current Timestamp

         Minimum TDD Phase C Current Timestamp

Sub Group: Harmonic Values

Item: 0 - 127th Harmonic on selectable Harmonic Magnitude

         (Voltage Phases A, B, and C; Current Phases A, B, and C)

Sub Group: Internal Inputs, States

Item: Internal Inputs 1-8

Sub Group: Phase Angles

Item: Phase A-N Voltage

         Phase B-N Voltage

         Phase C-N Voltage

         Phase A Current

         Phase B Current

         Phase C Current

         Phase A-B Voltage

         Phase B-C Voltage

         Phase C-A Voltage

         Volts A-Aux Phase Angle

         Voltage Phase Sequence

Sub Group: Flicker

Item: Flicker: PInst Volts A

         Flicker: PInst Volts B

         Flicker: PInst Volts C

         Flicker: PST Volts A

         Flicker: PST Volts B

         Flicker: PST Volts C

         Flicker: PLT Volts A

         Flicker: PLT Volts B
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         Flicker: PLT Volts C

Group: Averages

Sub Group: Thermal Average

Item: Voltage A-N

         Voltage B-N

         Voltage C-N

         Voltage Aux

         Current A

         Current B

         Current C

         Current N Measured

         Current N Calculated

         Voltage A-B

         Voltage B-C

         Voltage C-A

         VA A

         VA B

         VA C

         VA Total

         VAR A

         VAR B

         VAR C

         VAR Total

         Watt A

         Watt B

         Watt C

         Watt Total

         Frequency

         Power Factor A

         Power Factor B

         Power Factor C

         Power Factor Total

         Voltage Imbalance

         Current Imbalance

Sub Group: Block Window Average

Item: VA
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         VAR

         Watt

Sub Group: Pulse Accumulation/Aggregation Block Window Average

Item: Internal Inputs #1 - #8

         Aggregators #1 - #4

Sub Group: Rolling Window Average

Item: Predictive VA

         Predictive VAR

         Predictive Watt

         VA

         VAR

         Watt

Sub Group: Voltage and Current Means

Item: Volts PN

         Current P

         Volts PP

Group: External I/O Devices

Sub Group: Analog Input Modules

Item: Module 1: Analog Input 1 - Analog Input 8

         Module 2: Analog Input 1 - Analog Input 8

         Module 3: Analog Input 1 - Analog Input 8

         Module 4: Analog Input 1 - Analog Input 8

•   To designate the limit as either above or below a percentage of the Full Scale, 

click once in each Settings column and select the desired setting from the pull-

down menu.

•   To set the percentage of the Full Scale that will trip the limit, enter the value in 

the % of FS column. CommunicatorPQATM software automatically calculates the 

Primary value.

•   Combination Limit 3 is the logical combination of Limit 1's state and Limit 2's 

state.

Example 1

Limit I D

Type: 1 Second Readings
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Channel: Volts AN

Limit 1 Setting: Limit exceeded if Volts AN is below 120 F.S.

Limit 2 Setting: Limit exceeded if Volts AN is above 80 F.S.

Combination Limit 3 Setting: AND 

If Limit 1 AND Limit 2 are tripped (e.g., the reading is 100F.S.), then Limit 3 is 

tripped.

Example 2

Limit I D

Type: 1 Second Readings

Channel: Volts AN

Limit 1 Setting: Limit exceeded if Volts AN is above 120 F.S.

Limit 2 Setting: Limit exceeded if Volts AN is below 80 F.S.

Combination Limit 3 Setting: OR 

If either Limit 1 OR Limit 2 is tripped (e.g., the reading is 75), then Limit 3 is 

tripped. 

•   Full Scales settings are shown in the lower left of the screen. These values are 

set in the Limits and Waveform Full Scales section of the Device Profile (Section 

13.1.2).

4. Power Factor is broken into four quadrants. Selecting the Full Scale value brings up 

a screen that lets you set a limit in two of the four quadrants.
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•   To set the power factor limits, double click on any of the power factor settings in 

the Limit 1 or Limit 2 columns. You will see the Power Factor screen.

•   To set a limit: from the pull-down menus, select a quadrant and Less Than or 

Greater Than (Full Scales). Enter the power factor number. The graph will 

illustrate your selections by shading the out of limit bands. The area of the

graph not covered by shading is within normal operational range.  

NOTE: Whether you see method 1 Quadrants (Q1  +Lag, Q2  -Lag, Q3  -Lead, 

Q4  +Lead) or method 2 Quadrants (Q1  +Lag, Q2  -Lead, Q3  +Lag, Q4  -Lead) 

depends on the setting in the Power Factor Display field of the Labels setting 

(see 13.1.4: Labels on page 13-10).

    NOTE: The Nexus® 1252 device is a four-quadrant meter. Therefore, limits

    can be set for capacitive and inductive PF when generating or consuming power.

3. When all settings are complete, click OK to return to the main Device Profile 

screen. For any changes to take effect, you must click the Update Device button to 

send the new profile to the meter. 
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13.3.2: ElectrologicTM Relay Control

1. From the Power Quality and Alarm Settings menu, double-click on the Electro-

Logic™ Relay Control line. You will see the screen shown below.

ElectroLogicTM Relay Control lets you set up a logic tree to control the meter’s 

optional relays. Each relay can be programmed individually. The end result of the 

logic tree is to set, or not set, a relay, with an optional programmed Set Delay and/

or Reset Delay. The initial inputs to the logic tree are chosen from among the 32 

Limits and 40 Digital Inputs (both internal and external inputs). The gates, in 

several stages, perform logical combinations (AND, OR, etc) on pairs of inputs 

(either initial inputs or the outputs of earlier gates), and in combination produce an 

ultimate "true" or "false" state to drive the relay open or closed.

 For example, one of the gates is AND. For data to pass an AND gate, both pieces of 

data must be “true.” For a Limit to be true, the data must be in the Out-of-Limit 

condition on either Limit 1, Limit 2, or both (you decide which). For a Digital Input 

to be true, it must be in the condition you specify - either Open or Shorted. 

2           3                                                  1           

4
4a

4b

5a

5b

6
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The gates used in ElectroLogicTM Relay Control are used as follows:

OR: If either or both of the two conditions are true, the gate is passed

AND: If both of the conditions are true, the gate is passed

Hysteresis: For Limits only, the if the Limit is within the programmed hysteresis 

value, the gate is passed

XOR: If either of the two conditions are true, but not both, the gate is passed

NOR: If either of the two conditions are true, the gate is not passed

NAND: If both of the two conditions are true, the gate is not passed

NHysteresis: For limits only, if the Limit is within the programmed hysteresis value, 

the gate is not passed

NXOR: If either of the two conditions are true, but not both, the gate is not passed

NOTE: See Example settings on page 13-58.

2. To assign an item to the Relay Logic tree:

a. Select the relay card/module from the pull-down menu - see number 1 in the 

screen on the previous page.

b. Select an input for the tree by clicking on a radio button next to numbers 1 

through 8 - see number 2 in the screen on the previous page.

c. Choose Limits or Digital Inputs by clicking on the radio button in front of the 

word - see number 4 in the screen on the previous page. 

d. From the pull-down menus, select the limit (Limit ID) or input (Input ID) you 

want to assign to this Relay Logic tree input (step b) - see number 4 in the 

screen on the previous page. 

• For a limit, use the second pull-down menu to select Limit 1, Limit 2, or 

Combination - see number 4a in the screen on the previous page.

• For an input, use the second pull-down menu to select Shorted or Open - 

see number 4b in the screen on the previous page.

e. Press Set to confirm your selection. The software places the selection in the 

appropriate field in the screen.

3. After you assign all the Relay Logic inputs, select the gates that will be used to 

combine the logic to trigger the relay. To select a gate type, either: 
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•   Click on the gate (yellow fields) - see number 5a in the screen on page 13-55. 

•   Choose a gate type from the pull-down menu below the gate - see number 5b in 

the screen on page 13-55.

4. If you want, select Set Delay and Reset Delay from the pull-down menus. You can 

choose between 0 and 255 seconds. Use these fields if you want to program a delay 

before the relay is set, or before it is reset - see number 6 in the screen on page 

13-55.

5. To change items on the Relay Logic tree, follow the previous steps.

•   To clear an item from the Relay tree, click on that item and click the Clear 

button.

•   To clear all items from the Relay Tree, click the Clear Assigned Items button.

6. When all settings are complete, click OK to return to the main Device Profile 

screen. For any changes to take effect, you must click the Update Device 

button to send the new profile to the meter. 

NOTE: In order to use this screen, you must have purchased at least one External 

Relay Output module. For more details on external Output modules, see Chapter 14.



     Doc#    E107707                                             13 - 59

13: Nexus® 1252 Meter

Example of an ElectroLogicTM Relay Logic Tree:

Inputs 1 through 8 are set to High Speed Volts AN Limit 1, High Speed Amps A Limit 

1, High Speed Volts BN Limit 1, High Speed Amps B Limit 1, High Speed Volts CN Limit 

1, High Speed Amps C Limit 1, Not Set and Not Set. The four first gates are AND 

gates, and the remaining three gates are OR gates.

Each first level gate looks at the state of the two limits, and the result is "true" if and 

only if both the inputs (Voltage Limit and Current Limit) are "true" (Out-of-Limit Con-

dition). The second and third level gates look at the state of the earlier gates, and 

their results are "true" if either one (or both) of the previous gates are "true". The end 

result is a relay that is energized if one or more of the three phases (A, B, and/or C) is 

currently Out-of-Limit on both its voltage and current Limit 1 tests.

 Items 
 1-8

Gates 1-4
Gates 5 and 6 Final Gate

Digital Output Module:1 Relay: 1
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13.3.3: PQ Thresholds (Waveform Recording)

The PQ Thresholds/Waveform Recording capability allows the meter to act as a high-

speed waveform recorder to record any anomaly that occurs within a cycle of dura-

tion. This provides a user with advanced waveform analysis including pre- and post- 

waveform recording. 

The meter has the capability to record both surges and sags of the measured signals. 

A voltage surge is any event that increases the RMS voltage for one cycle, calculated 

every half cycle. A voltage sag is a dip in the RMS of one cycle of voltage, calculated 

every half cycle. A current fault (or surge) is also calculated in the same manner. 

When the RMS value of any of these triggers exceeds the threshold settings, the 

meter will trigger a waveform capture.

The Power Quality (PQ) and Waveform Thresholds setting determines at what point 

the Nexus® 1252 meter executes a waveform capture and/or records a power quality 

event. 

See Chapter 19 for instructions on viewing Waveform and PQ logs. 

PQ and Waveform Thresholds are given as a percentage of the Full Scales (% of FS). 

Set the Full Scales in the Limits and Waveform Full Scales setting of the Device Profile 

(see Section 13.1.2). Full Scales are based on the CT and PT ratios set in the CT, PT 

Ratios and System Hookup setting of the Device Profile (see Section 13.1.1).

Before programming the PQ and Waveform Thresholds, set the CT and PT ratios and 

the Limits and Waveform Full Scales.

Note on Sampling Rate: A higher sampling rate allows for transients to be 

monitored. Generally, the meter is set to take 1024 samples per cycle for this pur-

pose. Lower sampling rates have advantages, however, because they allow you to 

record more cycles of information per event screen. Therefore, low sampling rates are 

better for long duration events, like motor starts or distribution faults. The meter 

enables you to tailor its recording for both these applications. For more information on 

sampling rate, see the table on page 13-62.
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1. From the Power Quality and Alarm Settings menu, double-click on the PQ 

Thresholds (Waveform Recording) line. You will see the screen shown below

2. To set the threshold for a PQ event and waveform capture, enter the desired 

percentage of Full Scale in the Value() column of the Above Setpoint and Below 

Setpoint sections. Full Scales are shown in the lower right corner of the screen.

NOTE ON CBEMA: The CBEMA plotting is a power quality standard known worldwide 

for recording the amount of damage voltage transient conditions have done to the 

equipment being monitored. The meter automatically records this information. For 

CBEMA purposes, program internal setpoints for voltage below 90 and above 110 of 

full scale (+/- 10 from the nominal voltage). These setpoints are defined by the ITI 

(CBEMA) specification. The ITI (CBEMA) Curve is published by Information Technology 

Industry Council (ITI). You can set a recording with tighter voltage limits to trigger a 

waveform recording. However, CBEMA plotting will be based only on the 

limits internally set.
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NOTE ON SETTING THE METER TO RECORD CURRENT FAULTS: The voltage 

setpoints are used to record voltage type events, such as voltage surges, sags and 

transients. The current settings are used to record faults on the line or in-rush 

currents from devices such as motors. Typically, to catch these events, set the limit to 

above 200 of full scale.

•   Waveform Clipping Threshold: Nexus® 1252 Meter 5 Amp Standard Hardware - 

±60A Peak before clipping; Nexus® 1252 Meter 1 Amp Hardware - ±12A Peak 

before clipping.

•   Voltage Waveform Clipping Thresholds: Nexus® 1252 Meter Standard Hardware - 

±200V Peak before clipping; Nexus® 1252 Meter -G Hardware - ±400V Peak 

before clipping.

•   High Speed Inputs: The High Speed Inputs field allows you to see which High 

Speed Inputs are enabled for Waveform recording. 

IMPORTANT! You assign the High Speed Input to its trigger in the High Speed 

Inputs screen (see Section 13.3.7).

•   Samples per Cycle: To choose the Samples per Cycle to be recorded at 60 Hz, click 

on the Sampling Rate pull-down menu. Choose from 16, 32, 64, 128, 256 and 512 

samples per cycle. The number of samples per cycle you choose will inversely affect 

the number of cycles per capture. 

•   If you select 256, a Capture Only pop-up screen will ask you to select Volts A, B, 

C or I A, B, C.

•   If you select 512, a Capture Only pop-up screen will ask you to select one of the 

individual channels.

   The following table illustrates the effects of sampling rate on the number of cycles 

   captured. Increasing the Sampling Rate increases Waveform definition, but reduces

   the length of the observed window. The approximate length of the observed window

   is shown in the last column.
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    For example, for observed events of approximately ½ second, a sampling rate of

    32 samples per Cycle, or less, should be used.

    

    NOTE ON WAVEFORM EVENT CAPTURES: A screen of data is one capture. If

    you set Total Captures to 3 and you are recording at 16 samples per cycle, you will

    record:

    16 Samples3     x     64 = 192 cycles of recorded waveforms

    128 Samples3     x       8 = 24 cycles of recorded waveforms

     With the 2 Megabyte module, you have a total of 64 captures; with the 4 Megabyte

     module, you have a total of 96 captures. You can partition the memory in any

     fashion required by your application. There is no limitation on the amount of

     cycles that can be recorded per event.

3. To choose the total amount of captures, click on the Total Captures pull-down 

menu. Select from 0 to 96 captures. The higher the number, the more information 

you will be "stringing together."

4. When all changes are entered, click OK to return to the main Device Profile screen. 

For changes to take effect, you must click the Update Device button. This sends the 

new profile to the meter.

Effects of Sampling Rate

Samples 
Per Cycle

Channels  Samples 
Per Channel

 Cycles Per 
Capture

Time 
(Approx)

Analog HSI

16 7 8 1024 64 1 Second

32 7 8 1024 32 ½ Second

64 7 8 1024 16 ¼ Second

128 7 8 1024 8 1/8 Second

256 3 8 2048 8 1/8 Second

512 1 8 4096 8 1/8 Second
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13.3.4: EN 50160/IEC 61000-4-30 Flicker 

With the EN 50160/IEC 61000-4-30 Flicker screen, you can set the test times for the 

Flicker function.

1. From the Device Profile screen double-click on the EN50160/IEC61000-4-30 Flicker 

line. You will see the screen shown below.

2. From the pull-down menus, select: 

•   Frequency (50 or 60Hz) - this field is used to calculate the harmonics and interhar-

monics associated with the set fundamental frequency.

•   Short Term Test Time (1-10 minutes, in minute increments) - PST is defined over a 

ten minute interval. Standard IEC 61000-4-15 requires 10 minutes for PST.

•   Long Term Test Time (10-240 minutes, in ten minute increments) - the standard 

requires 120 minutes, and is calculated from the PLT values. 

3. When all changes have been entered, click OK to return to the main Device Profile 

screen. For any changes to take effect, you must click the Update Device button to 

send the new profile to the meter.

NOTE: Flicker is discussed in detail in Chapter 23.
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13.3.5: I Squared T and V Squared T Thresholds

With the I Squared T and V Squared T Thresholds screen, you can set the point at 

which the meter accumulates current and Voltage. This feature is used to calculate 

wear on circuit breaker contacts.

1. From the Power Quality and Alarm Settings menu, click on the + button next to I 

Squared T and V Squared T Thresholds or double-click on that line. You will see the 

submenu shown below, which shows the current settings for the meter.

2. Double-click one of the settings to open the I Squared T and V Squared T 

Thresholds screen, shown below.

3. Enter the thresholds in the I Squared T and V Squared T fields.  

4. Click OK to exit the screen and return to the main Device Profile screen. For any 

changes to take effect, you must click the Update Device button to send the new 

profile to the meter. 
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13.3.6: TDD Maximum Demand Reference Values

This setting of the Device Profile allows you to set the maximum value for voltage and

current, which is used when the meter calculates TDD (Total Demand Distortion). TDD 

and THD (Total Harmonic Distortion) are both indices used to measure harmonics. 

TDD is defined in the IEEE 519 Standard, “Recommended Practices and Requirements 

for Harmonic Control in Electrical Power Systems” as “the total root-sum-square har-

monic current distortion in percent of the maximum load current.” It gives a better 

indication of the impact of distortion on Demand than THD which analyzes the har-

monic distortion relative to the fundamental, without consideration of load.

1. From the Power Quality and Alarm Settings menu, double-click on the TDD 

Maximum Demand Reference Values. You will see the screen below.

2. Enter the maximum values for voltage and current. 

•   You can find these values in the Poll Max and Min Readings polling screen (see 

Section 5.2.2 for details). 

•   You can view the TDD values in the Harmonics polling screen (see Section 5.4.2 

for details).

3. Click OK to exit the screen and return to the main Device Profile screen. For any 

changes to take effect, you must click the Update Device button to send the new 

profile to the meter.
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13.3.7: High Speed Inputs

The Nexus® 1252 meter’s built-in High Speed Inputs can be used in two ways:

•   Attaching status contacts from relays, breakers or other devices for status or 

waveform initiation

•   Attaching the KYZ pulse outputs from other meters for pulse counting and totaliz-

ing

Even though these inputs are capable of being used as high speed digital fault record-

ing inputs, they serve a dual purpose as KYZ counters and totalizers. The function in 

use is programmable in this setting of the Device Profile, which lets you label the eight 

High Speed inputs and to specify their status. 

•   Labeling the inputs allows you to determine the source of status change when data 

is later analyzed. 

•   This feature lets you set the High Speed Inputs’ status as a KYZ input, a trigger for 

waveform capture or PQ recording, a trigger for logging, or a means of synchroniz-

ing the meter. 

•   In the Pulse Accumulations setting (Section 13.2.10), you can assign the High 

Speed Inputs’ counts to be accumulated in one of four internal Aggregators of the 

meter.
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1. From the Power Quality and Alarm Settings menu, double-click on the High Speed 

Inputs line or click on the + button next to it. You will see the submenu shown 

below.

2. Double-click any of the Input lines. You will see the screen below.

3. Double-click a field to enter the following:

•   Name 

•   Open Label
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•   Shorted Label

•   Normal Condition

4. Click on the Input Type field to select an option from the pull-down menu. The 

available selections are:

•   KYZ Input - select this option to designate the input as a pulse (KYZ) input.

•   Waveform/PQ Trigger - select this option if you want the input to trigger a 

waveform/PQ recording (see Section 13.3.3).

•   Block Window Sync Pulse - select this option if you want to synchronize the 

meter with pulses from the input (see Section 13.2.2).

•  Historical Log 2 Trigger - select this option to use this input to trigger logging in 

Historical log 2 upon a change in its state (see 13.4.1: Programming the Trend-

ing Log Time Intervals on page 13-71).

5. When you have finished making your selections, click OK to exit the screen and 

return to the main Device Profile screen. For any changes to take effect, you must 

click the Update Device button to send the new profile to the meter.
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13.3.8: Operational Status Output

This setting of the Device Profile lets you assign a relay to the operational status of 

the meter. The relay can then be monitored by another connected device.

1. From the Power Quality and Alarm Settings menu, double-click on the Operational 

Status Output line. You will see the screen shown below.

2. Select the relay you want to assign from the pull-down menu and click the check-

box.

3. When you finish making your selections, click OK to exit the screen and return to 

the main Device Profile screen. For any changes to take effect, you must click the 

Update Device button to send the new profile to the meter.



     Doc#    E107707                                             13 - 71

13: Nexus® 1252 Meter

13.4: Trending Profile Settings

This section of the Device Profile enables you to configure parameters for the Nexus® 

1252 meter’s two historical logs.

1. From the Device Profile screen, click on the + button next to Trending Profile

 Settings or double-click on the Trending Profile Settings line. You will see the menu 

shown below.

2. Double-click on one of the Trending lines to access the programming screens.

NOTE on Load Profile Recording: Load Profile recording is a subset of the Nexus® 

meter's more general logging and trending capability. The same screens are used for 

setup, but Load Profile recording only deals with accumulated values; Energy (Wh), 

reactive Energy (VARh) and apparent power (VAh).

Historically, Load Profile recording referred to recording of quadrant 1 Energy (Wh) 

because electromechanical meters only measured energy and were designed to 

prevent reverse rotation outside of quadrant 1.

13.4.1: Programming the Trending Log Time Intervals

The Trending Log Time Intervals setting determines the interval at which the 

Historical logs take a "snapshot" of data, and the length of time logging continues 

when Historical log 2 recording is triggered by changes in the state of an input (see 

13.3.7: High Speed Inputs on page 13-67). To set the parameters for the logs, see 

Section 13.4.2. See Chapter 16 for information on retrieving logs and Chapter 19 for 

information on viewing logs.
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1. From the Trending Profile Settings menu, double-click Trending Log Time Intervals 

or click the + button next to it. You will see the submenu shown below. The 

submenu shows the interval set for both Historical logs.

2. To change the interval for a Historical log, double-click on one of the logs.

NOTES: 

•  You can also access the Interval setting screens from the Trending Setup screens 

(see Section 13.4.2).

•  If Historical log 2 has been configured to log the changes in state of an input, the 

menu shown above will indicate that.

3. You will see the screen shown below. Enter the interval you want. 

Note that if Historical log 2 recording is being triggered by the change of state of an 

input, the Input number will be displayed and the selection for Log 2 will consist of 
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the number of seconds after which logging should stop. See the example screen, 

below. Select the number of seconds from the pull-down menu.

4. Click OK to save your changes. For any changes to take effect, you must click the 

Update Device button to send the new profile to the meter.

13.4.2: Programming the Trending Setup 

The Trending Setup controls the channel assignments for the Historical logs. See 

Chapter 16 for instructions on retrieving logs.

1. From the Trending Profile Settings menu, click on the + button next to Trending 

Setup or double-click on the Trending Setup line. You will see the submenu shown 

below.
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2. Double-click on the log whose settings you want to configure. You will see the 

Trending Log Profile screen for the log you selected. An example screen is shown 

below.

3. Make changes to this screen according to your application requirements. 

a. Group: Using the pull-down menu, select the type of snapshot. The options are: 

Measured Values, Averages, Accumulators, Interval Accumulators, External 

Output Devices, TOU Cumulative Dmd.
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b. Sub-Group: Using the pull-down menu, select a channel for the snapshot. The 

sub-group options vary depending on the selected group.

c. Sub-Group 2: With some selections, a second sub-group field will be shown 

underneath the first one. Select a value for this field from the pull-down menu. 

d. Highlight items in the Selectable Items(s) box and click Add to include the selec-

tions in the Log. The items will be copied to the Selected Item(s) box. To remove 

an item from the log, highlight the item in the Selected Item(s) box and click 

Remove or double-click the item. The item will be removed from the Selected 

Item(s) box. 

NOTES: 

• To select multiple items, hold Control while highlighting the items.

• To select a range of items, click the first item, hold Shift, and click the last 

item.

• Move the cursor to the lower left corner of an item, or group of items, to 

view its size in bytes.

e. Click HHF if you want to convert files to HHF format for use with MV-90. 

See Chapter 16 for details.

f. Click Check HHF if you want to check if current settings are compatible with the 

HHF Converter.

NOTE: You will not see the HHF options unless you have enabled the HHF 

converter using the Options menu. See Chapter 20 for instructions.

g. The Total bytes used and Bytes remaining fields display the amount of memory 

used for each record of the log. The meter assumes 256 bytes of memory for 

each record. Total memory is determined at time of purchase. 

h. The Estimated Log Timespan field displays the length of the time between the 

first and last records in the log when it is full.
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i. The Total Records field displays the total number of records that will be in the log 

when it is full.

j. Click Set Interval to open the Interval Log Setting screen (see Section 13.4.1).

4. When all changes have been entered, click OK to return to the main Device Profile 

screen. For any changes to take effect, you must click the Update Device button to 

send the new profile to the meter.

13.5: External I/O Modules

This setting of the Device Profile allows you to set up the meter’s optional external 

Input/Output modules (see Chapter 14 for more information on the I/O modules). I/O 

modules work as Modbus slave devices. The meter polls these modules to get the 

data from them. I/O modules generally have default RS485 Modbus addresses. So, 

they don’t have to be configured. Once you set up which module you want, put in the 

default address and start with the basic configuration of readings you desire to gather.
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13.5.1: Configuring the Input/Output Modules

1. From the Device Profile screen, double-click on the External I/O Modules icon. You 

will see the screen shown below.
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2. Click in the Type column and use the pull-down menu to select the specific module 

you want to add. The Assigned Address, Nexus settings®, and Module settings you 

can make depend on the module you are configuring. The modules and settings are 

as follows:

* The Assigned address on this screen is the address the meter uses to identify the

    I/O module. The default is the factory set address, which you can change by

    clicking in the field and choosing a new address from the pull-down menu. This

    address is not the actual I/O module address. You set that from the I/O Devices

    menu; see Chapter 14 for instructions. 

**When you click in this field you see an Edit button. Click the button to open a

    screen that lets you edit that module. See the following example screens.

Module Assigned
Address* Nexus® Setting** Module Setting

4PO1 - KYZ Output 160* Click to Edit Relay Accumula-
tions

Click to enter Transmit Delay and 
configure KYZ outputs’ Watt/pulse, 
rollover and minimum pulse width.

20mAON4 132* Click to Assign Items to and 
configure the Analog Outputs

Click to enter Transmit Delay and 
configure Channel settings 

20mAON8 132* Click to Assign Items to and 
configure the Analog Outputs

Click to enter Transmit Delay and 
configure Channel settings 

1mAON4 128* Click to Assign Items to and 
configure the Analog Outputs

Click to enter Transmit Delay and 
configure Channel settings 

1mAON8 128* Click to Assign Items to and 
configure the Analog Outputs

Click to enter Transmit Delay and 
configure Channel settings 

4RO1 - Digital Output 156* Click to configure Relays Click to enter Transmit Delay

8AI1 - Analog Input 
Module

247* Click to configure Analog 
Outputs

Click to enter Transmit Delay and 
configure Channel settings

8AI2- Analog Input 
Module

247* Click to configure Analog 
Outputs

Click to enter Transmit Delay and 
configure Channel settings

8AI3 - Analog Input 
Module

247* Click to configure Analog 
Outputs

Click to enter Transmit Delay and 
configure Channel settings

8AI4 - Analog Input 
Module

247* Click to configure Analog 
Outputs

Click to enter Transmit Delay and 
configure Channel settings

8DI1 - Digital Status 
Input Module

164* Click to configure Digital 
Inputs

Click to enter Transmit Delay and 
configure Channel settings
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                                         4PO1 Screen

This screen allows you to assign a KYZ output to an accumulator. Click on the pull-

down menu to select accumulation configuration for each of the 4 relays. The 

options are: 

•   Disabled

•   Quad (1+4) Watthr

•   Quad (2+3) Watthr

•   Quad (1+2) VARhr

•   Quad (3+4) VARhr

•   Quad (1+2+3+4) VAhr

•   Quad 1 Watthr

•   Quad 2 Watthr

•   Quad 3 Watthr

•   Quad4 Watthr

•   Quad 1 VARhr

•   Quad 2 VARhr

•   Quad 3 VARhr

•   Quad 4 VARhr

•   Quad 1 VAhr

•   Quad 2 VAhr
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•   Quad 3 VAhr

•   Quad 4 VAhr

•   +Qh Total

•   -Qh Total

•   Internal Input (#1-8) Totals

•   Accumulation (#1-4) Totals

•   External Digital Input Modules (1-4) Inputs (#1-8)

•   I Squared T (A, B, C)

   V Squared T (A,B,C)

                                      20mAON4 Screen

Click in Output channels 1-4 to assign them to a parameter. The other Analog Output 

Modules - 20mAON8, 1mAON4, and 1mAON8 have similar setting screens, except for 

the number of channels you can program. 

•   The analog outputs are used to send a variable current dependent on the 

programmed reading. This screen lets you select the readings to output.
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                                           4RO1 Screen

Click in the Relay fields 1-4 to enter relay label, common shorted to N.C., com-

mon shorted to N.O., and check the box to lock the relay to manual control. 

When a relay is locked to manual control, it cannot be used in ElectroLogic Relay 

Control (see Section 13.3.2 for information on ElectroLogic Relay Control).

                                       Analog Input Screen

    Click in Input Channels 1-8 to assign a label and a High and Low Value. 

•   The two analog input module’s settings are the same, except for the Inputs’ high 

and low range.

•   The High and Low Value fields let you map the inputs’ high and low range to 

values that are appropriate for the parameters you are measuring. For example, 
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in the screen above, the first input is measuring temperature. The high value for 

the input is set to 100, and the low value is set to 0. An input reading of 12mA 

will translate to 50 for the temperature.

The Analog Input modules can be trended in the historical logs, and the data can 

be viewed and graphed in Log Viewer (see Chapter 19 for details). The readings 

shown in the logs and graphs will use the setting range programmed in the 

screen above, i.e., the results will be reported as 0 through 100.

                                        Digital Input Screen

   Click in Channel Label’s 1-8 to assign a Channel label, Open and Closed label,

   and Normal State (Open or Shorted) for each of the digital inputs.

NOTES:

•   The Assigned Address, Nexus® settings, and Module settings you can make 

depend on the module you are configuring. The modules and settings are 

explained fully in the Nexus® 1252 Installation and Operation Manual.

•   Port 4 is the only available port for the modules. 

•   Log/Limit ID is a display only field. It shows the ID CommunicatorPQATM soft-

ware generates to identify this module in the Log Viewer and Limits functions.

3. Click OK to return to the main Device Profile screen. For any changes to take effect, 

you must click the Update Device button to send the new profile to the meter. 
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14: External I/O Modules

14.1: Overview

The Nexus® 1500+, 1262/1272, 1450, and 1252 meters have optional external I/O 

modules. Refer to your meter’s Installation and Operation manual for the options 

offered and physical installation instructions, any necessary power supplies, and 

related hardware considerations. 

The external I/O devices are programmed through the meter’s Device Profile (refer to 

the Communications and External I/O Devices settings instructions for your meter in 

chapters 11-13). There are additional software options available through the I/O 

Devices menu, which is accessed from the Main screen’s Menu Bar. 

This chapter explains these software options. 

14.1.1: Information About the External I/O Modules

•   Depending on the Nexus® meter you are configuring, the external I/O devices use 

the following RS485 Com ports:

•   Nexus® 1500+ meter’s optional Port 2

•   Nexus® 1262/1272 meter’s Port 4

•   Nexus® 1450/1252 meter’s Port 3 or 4

IMPORTANT! You must use the correct port. Be sure ports are set to operate at 

the same baud rate as the I/O modules. The ports must also be configured as 

Output Modules. See chapters 11 (Nexus® 1500+ meter), 12 (Nexus® 1262/
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1272 meter), 13 (Nexus® 1252 meter), and 27 (Nexus® 1450 meter) for port 

configuration instructions.

•   The External I/O Modules setting of the Nexus® meter’s Device Profile (Chapters 

11 - 13), tells the meter which I/O Modules are connected to it at which addresses. 

This profile must reflect what is physically attached to the meter. 

•   Revise the Nexus® meter’s Device Profile each time an I/O module is added, 

removed or configured.

•   Each type of I/O module is shipped with a factory-set address (see sections 11.5, 

12.5, and 13.5 for details and the table of factory-set addresses for each of the I/O 

modules). If you plan to use more than one I/O module of the same type (such as 

three KYZ modules), you must change the address of each module individually 

before connecting the group to the Nexus® meter. See Section 14.3 for instructions 

on changing a module’s address and baud rate.

14.2: Query I/O Module

Though the I/O modules are shipped with default addresses (shown in the tables in 

sections 11.5, 12.5, and 13.5), in the case that you have changed the address and 

don’t know it, you can use the Query I/O Module option to locate a module with an 

unknown address and baud rate.

NOTES: This utility requires you to press the I/O module’s Reset button. If you are 

off-site, or cannot access the Reset button, use the Locator Utility option described in 

Section 14.7, instead.
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1. From the Menu Bar, select I/O Devices>Query I/O Module. See the example 

screen, shown below.

2. Select the port the module is connected to from the pull-down menu and click 

Continue. You will see the screen shown below.

3. Use an instrument with a fine point to depress the I/O module’s Reset button. Hold 

it in for at least three seconds. This resets the I/O module to address 247 at 57600 

baud for thirty seconds, allowing the CommunicatorPQA® application to retrieve 

the stored address and baud rate.

4. Click Continue. The software begins looking for the device at the temporary 

address of 247. When the I/O’s programmable information is located, the following 
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screen opens (the specific screen you see will be for the type of External I/O 

Module you are connected to).

5. Write down the address and baud rate.

6. Click Exit to close the screen.

14.3: Assign Addresses and Baud Rates to an I/O Module

As mentioned previously, the external I/O modules are shipped with a factory-set 

default address and baud rate. If you have more than one of a particular type of I/O 

module, you’ll have to change the address of the additional module(s), since each I/O 

module must have a unique address. This feature lets you change the address of an 

I/O module. You can also change the baud rate of the module with this feature, if you 

wish. 

NOTES: 

•   The utility described here requires the I/O module to be connected to the meter’s 

I/O port - Port 2 of the Nexus® 1500 meter, Port 4 of the Nexus® 1262/1272 

meter, or ports 3 or 4 of the Nexus® 1252 meter. To configure an I/O module by 



     Doc#    E107707                                               14 - 5

    14: External I/O Modules

connecting it directly to your computer rather than to the meter, use the Stand 

Alone Programmer utility: see Section 14.5 for instructions.

•   You must know the current address and baud rate of the I/O you want to change. 

See 14.2: Query I/O Module, on page 14-2 and 14.7: Locator Utility, on page 14-

15, if the address and/or baud rate has been changed or is no longer known. When 

you have determined the current address and baud rate, proceed with the steps 

listed below.

1. Make sure the Nexus® meter’s port is configured to communicate with the external 

I/O module. See the Communications setting instruction in your meter’s program-

ming chapter.

2. Connect the external I/O module to the meter’s port.

NOTE: You may connect a group of I/O modules to the Nexus® meter to make 

address/baud rate changes only if each I/O already has a unique address. If the 

I/O modules have the same address - such as three new KYZ modules—you must 

connect and change their addresses individually. 

3. Select I/O Devices>Change I/O Module Address/Baud Rate. You will see the screen 

shown below.

4. From the pull-down menus:

a. Select the port the I/O module is connected to.

b. Enter the module’s current address and baud rate. 
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c. Enter the new address (1 - 247)and/or baud rate(4800, 9600, 19,200, 

57600). Make sure that the address is not already assigned to an external 

I/O module you will be using.

d. Click Make Change. A confirmation screen appears after the module has 

been updated. If there are multiple I/O modules in this group, repeat the 

procedure for all of the I/O modules.

5. Write down the module’s new address and baud rate.

6. Enter the information in the meter’s External I/O settings screen. Refer to the 

programming chapter for your meter.
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14.4: Nexus® I/O Device Status

This utility lets you view a list of all the modules that have been entered (“registered”) 

in the Nexus® meter’s Device Profile.

1. From the Menu Bar, select I/O Devices>Nexus I/O Device Status. Communica-

torPQA® software searches for all entered I/O modules. You will see a status 

screen while the I/O modules are being located. See the example screen below.

2. When the external I/O modules are all located you will see the following screen.
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3. To view the current programmable settings of a particular module, select it and 

click Query. You will see the status screens shown below. 
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4. When the information is all found, you will see a screen like the one shown below.

5. Click Print to select a printer and then print a copy of this screen.

6. Click Exit to return to the I/O Module Status screen.

7. Click Refresh to initiate a new search and listing of connected I/O modules; click OK 

to close the screen.

14.5: Stand Alone Programmer

The Stand Alone programmer lets you configure all parameters of an I/O module or 

group of I/O modules by connecting the I/O modules directly to the computer.

NOTE: If you plan to connect the I/O module(s) to a Nexus® meter in the future, you 

must still enter it in the External I/O Devices setting of the Nexus® meter’s Device 

Profile. 

To use the Stand Alone Programmer, you will need the following:

•   RS232 Cable or USB Cable

•   EIG’s Unicom 2500 (or similar RS232/RS485 converter) or an USB to RS485 

 converter
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•   An RS485 cable with power wires separated from communication wires; see dia-

gram below.

•   A 15–20V DC at 50–200mA power source for the I/O module, such as EIG model 

PSIO; you may also use any port on a Nexus® 1252 meter as a power source 

(12VA max combined).

1. Wire the Unicom or other converter, I/O module(s) and computer as shown:

2. Either connect a USB to RS485 cable into your computer, or use an RS232 cable to 

connect the Unicom 2500 and your computer:

•   Set the Unicom to operate at 57600 baud rate.

•   Set the Unicom to DCE and HD.

3. Click the Connect icon in the Main screen’s Icon Bar, or select Connect>Quick 

Connect from the Menu Bar. You will see the screen shown below.

a. In the Device Address field, enter the current address of one of the I/O 

modules in the group. If you do not know the address, use the Stand Alone 

Locator utility (see 14.7: Locator Utility, on page 14-15).
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b. In the Baud Rate field, enter a baud rate that matches the baud rate of the 

I/O modules - 57600 is recommended. If you do not know the baud rate, 

use the Stand Alone Locator utility (see 14.7: Locator Utility, on page 14-

15).

c. In the Serial Port field, enter the computer’s communication port into which 

the RS232 cable is inserted.

d. Leave the Protocol field set to Modbus RTU.

4. Click Connect. The software searches for a module at the specified baud rate and 

address.

5. When it has located the external I/O(s) modules, you will see the following screen.

NOTE: The software will find a group of external I/O modules if they have been added 

together on the Connection Manager screen (see Chapter 3).

6. Click OK to close the Status screen. 

7. From the Menu Bar, select I/O Devices>Stand Alone Programmer. The Communica-

torPQA® software retrieves the current settings from the I/O module and 

displays them in the Module Programmer screen. The contents of this screen will 

vary, depending on the type of module in use. The example below shows the Digital 

Output Module Programmer screen. See the instructions for programming the 
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external I/O modules in the External I/O Devices settings section of your meters 

programming chapter (chapters 11-13).

8. When you have finished configuring the address, baud rate and other programma-

ble settings, click Send to send the new settings to the I/O module.

9. If you have connected a group of I/O modules to the computer, click Retrieve. 

10. At the prompt, enter the address of the next module you wish to program. Click

  OK; the software will retrieve the programmable settings of that device.

11. When you have finished programming all of the external I/O modules, click Exit.

IMPORTANT! Be sure to enter any external I/O modules in the External I/O Devices 

setting of your meter’s Device Profile when you connect them to the meter. See the 

instructions for programming the external I/O modules in the External I/O Devices 

settings section of your meters programming chapter (chapters 11-13).
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14.6: Relay Control

1. Be sure each module has a unique address, is entered in the Nexus® meter’s 

Device Profile, and is connected to the meter’s I/O port at the same baud rate. 

2. From the Menu Bar, select I/O Devices>Relay Control. You will see the screen 

shown below if you are connected to a Nexus® 1252/1262/1272/1450 meter, and 

the screen on the next page you are connected to a Nexus® 1500 meter.
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3. The relays for each installed I/O module are shown in the screen. To change the 

state of one or more relays, click the box next to the relay(s) you want to change.

NOTE: The first 12 slots in the Nexus 1500/1500+ meter screen are for the two 

optional Relay Output Cards, and slots 13-16 are for the external Relay Output 

module. See Chapter 20 for information on Relay Control for the optional Relay 

Output cards.

4. Use the pull down menu next to Select New State to assign a “Lock Common to 

N.C.”, “Lock Common to N.O.” or an “Unlock” state to the relay(s).

5. Click the Apply button to send the new setting to one or more relays of one or more 

modules.

6. Click OK to close the screen when you have finished configuring all Relay Outputs.
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14.7: Locator Utility

Use the Locator Utility to find an external I/O module’s address and baud rate if you 

do not have access to the module’s Reset button; if you can press the Reset button, 

use the Query I/O function. The Locator Utility has two options:

•   Stand Alone - this option allows you to search for an external I/O module’s address 

and baud rate by connecting the I/O module directly to the computer.

•   Through Nexus - this option searches each address in succession only at the baud 

rate at which the computer and the Nexus® meter are connected.

14.7.1: Locator through Stand Alone Mode

The Stand Alone Locator utility searches for any I/O device connected directly to your 

computer (it is not for use with remote connections). The search criteria is a program-

mable range of baud rates and addresses. When a device is found, Locator displays its 

name, baud rate and address.

To make a Stand Alone connection you will need the same connections as described in 

14.5: Stand Alone Programmer, on page 14-9. Follow the information given for con-

necting the meter and external I/O module and the software connection steps 

through step 4.

1. CommunicatorPQA® software will be unable to locate the device - after a few sec-

onds a No Device Found At This Location dialogue box will appear: click OK.
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2. From the Menu Bar, select I/O Devices>Locator Utility>Stand Alone. You will see 

the screen shown below.

3. Set the address and baud rate ranges for the search. CommunicatorPQA® software 

will begin at the start address and baud rate, searching every address up to and 

including the End Address; then it will begin the same address search at the next 

baud rate in the range.

    NOTE: If you include all baud rates, the Device Locator will take about 12 hours to

    complete the search. If you know the baud rate of the device (external I/O 

    module usually have a baud rate of 57600), just look for addresses in that baud

    rate - the search will take minutes instead of hours.

4. Click Start. The Device Locator begins searching for devices within the specified 

baud rate and address range.

5. The Device Locator will continue to search for devices until it reaches the end of the 

specified criteria or until you click Stop. Write down the address and baud rate.

6. Click Exit to close the Device Locator screen.
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14.7.2: Locator through Nexus® Mode

This option locates an external I/O module by searching each address in succession 

only at the baud rate at which the computer and the Nexus® meter are connected.

1. Connect the module to the Nexus® meter’s I/O modules port.

2. Establish a connection between the computer and the Nexus® meter. The baud 

rate at which the computer and the Nexus® meter are connected is the baud rate 

Locator will use to search for the I/O module’s address.

3. From the Menu bar, select I/O Devices>Locator Utility>Through Nexus. You will see 

the following screen.

4. Select the port the external I/O Module is attached to

5. Set the address range for the search in the Start and End Address fields. Set the 

address range as small as possible to limit the time of the search.

6. Click Start. CommunicatorPQA® software will begin at the Start Address, searching 

every address up to and including the End Address.
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7. The Through Device Locator screen opens, listing any devices found, as shown in 

the example screen below.

8. The software will continue to search for devices until it reaches the end of the 

address range for the port or until you click Stop.

9. Click Exit to close the Through Device Locator screen.
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15: Time of Use
15.1: Overview

In Time of Use (TOU) metering, the meter is set up to automatically segment usage 

data based on the time it is used. The most common reason for this is to track On 

Peak and Off Peak energy consumption, so that customers can be charged more for 

On Peak times when energy is more expensive for the utility to produce. The TOU 

feature is important in rate jurisdictions that use the TOU method of billing. 

When a user sets up TOU in a meter, the user is setting up the accumulation bins, for 

example, On Peak, and setting the rules for when energy usage is added to the bins, 

for example, from 9-5 on weekdays. For maximum flexibility, a TOU system lets the 

user set up multiple seasons, billing periods (these are usually months), types of days 

(weekday, weekend, holidays), and the time periods that are assigned to each bin. In 

advanced TOU systems, the user can also define which energy or other accumulators 

should be segmented. 

The figure on the next page provides a graphical representation of TOU. 
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Figure 15.1: Time of Use

To set up the bins (that is, the rates), you can use:

  Seasons 1-4

           Months 1-12

                         Type of Days (Weekend/Weekday/Holiday)

                              Time of Day Bins (Rates)
 
                                    For Example: Off-Peak=Lowest Energy Usage Cost

On-Peak=Highest Energy Usage Cost
Shoulder Peak=Middle Energy Usage Cost

                         TOU example: Season One, Month 1

                                    Weekdays

                                    Weekends

                                    Holidays

                                    Monday: the day’s usage is binned as shown below:

Energy Used: 12am-7:59 am      8am-5:59pm   6pm-7:59pm      8pm-11:59pm

Usage Bins
  (Rates)

                     Off Peak                                  On Peak                              Shoulder Peak

Off Peak 12 am-7:59am
On Peak 8 am - 5:59pm 
Shoulder Peak 6 pm - 7:59 pm 
Off Peak 8 pm-11:59pm

Off Peak 12 am-11:59pm

Off Peak 12 am-11:59pm

Energy use is binned according to the time it is used, so that it can be billed for appropriately.

Time of Use
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15.1.1: TOU in EIG Meters

TOU functions are found in many EIG meters. See the User Manual for your meter, for 

more information on your meter’s TOU function. See  5.3.8: Poll Time of Use Regis-

ters, on page 5-42 for information on the TOU Polling screen. 

The Nexus® 1252/1262/1272/1500 meters use a fixed 20 year calendar. With this 

implementation, each day must be configured. See  15.2: TOU for the Nexus® 12xx 

meters and the Nexus® 1500 Meter, on page 15-6.

The Nexus® 1450/1500+ and the Shark® 250/270 meters use EIG’s advanced 

perpetual calendar to automatically calculate days based on event algorithms, so the 

user does not have to program each year. Following is a high-level summary of the 

TOU implementation - the specifics of the settings are explained in 15.3: Nexus® 

1450/1500+/Shark® 250/270 Meter’s TOU Settings, on page 15-45.

•  Feature Enable/Disable: TOU is enabled or disabled in the meter’s Device profile

•  Demand Type and Interval: set in the meter’s Device profile

•  Block Window type

•  Rolling Window type

•  TOU Read modes

•  Self Read - TOU is automatically read based on the user’s programming

•  Manual Read - TOU is read manually by the user

•  Months

•  Up to 12 billing month periods

•  Configurable time of day for self read

•  Seasons

•  Up to 4 season periods

•  A season can be configured as any length
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•  Configurable time of day for self read

•  Weekly and Daily

•  Seasons can be set up for weekly self read or daily self read

•  Configurable starting day of the week for weekly self read

•  Configurable time of day for self read

•  Calendar

•  Perpetual calendar

•  Flexible methods to specify dates for month, season and holiday

• Recurring - month/day

• Floating - nth day-of-week in month

• Specific - month/day/year

• Repeating - every n days beginning with month/day/year

• Special - Easter and Good Friday

• Configurable Date Occurs On

• This day only

• The following day only

• The day and the following day

• Only when this day falls on a weekday

• This day only, unless this day falls on Saturday, then apply to the 

 Friday before this day

• This day only, unless this day falls on Sunday, then apply to the 

 Monday after this day
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•  Holidays

•  Up to 31 calendar entries for holiday dates

•  Rates

•  Up to 5 rates - one fixed totalizer rate and up to 4 individual user configurable 

rates, such as On Peak, Off Peak, Shoulder Peak, etc.

•  Day Types

•  Holiday type

•  Up to 3 additional user configurable types, such as Weekday, Saturday, and 

Sunday

•  Schedules

•  Up to 16 daily schedules

•  Rate changes may occur on any demand interval boundary

•  Up to 50 rate changes are available for all schedules combined

•  Monitored Data Sets

•  Up to 16 data sets are available

•  Choose from 38 -61 accumulator demand values (number is dependent on meter 

model) 

•  Choose from 12 -32 coincident demand values (number is dependent on meter 

model) 

•  Each set includes

• Accumulator

• Peak demand with time stamp

• Cumulative demand with continuous option

• Coincident demand 
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15.2: TOU for the Nexus® 12xx meters and the 
            Nexus® 1500 Meter

For the Nexus® 12xx meters and the Nexus® 1500 (not 1500+) meter, you have two 

options:

•  Program an individual year calendar - allows a user to program a meter for just a 

particular year. The meters can store 20 individual years.

•  Program a “perpetual” calendar - allows a user to program the meter for 20 years 

based on changing events that the meter automatically calculates.

In either of these cases, there are basic steps for programming the TOU calendar:

1. From the Tool Bar, select either:

•  TOU Calendar>Calendar Settings to set up an individual year’s calendar

•  TOU>Perpetual Calendar to create a perpetual calendar

2. Create the TOU calendar profile.

3. Send the TOU calendar profile to the connected meter. You can also send multiple 

TOU calendars to the meter at one time (TOU Calendar>Multi Calendar Update). 

4. View, print or export the TOU calendar.

5. Reset the TOU accumulations at any time by selecting Reset Meter Information 

from the Tools Menu (see  20.1.7: Reset Device Information, on page 20-7). Reset-

ting clears all accumulations of the current month or season and causes the accu-

mulations to use the present date as the start date and accumulate to the next new 

end date, which is taken from the new calendar.

NOTES: 

•  To use Daylight Savings Time, you must enable it in the meter’s Device Profile Time 

Settings screen (see the Time settings section of your meter’s programming chap-

ter).

•  If GPS Time (IRIG-B) is connected, you must set the appropriate time zone. Date 

and time settings (except year) are overridden by GPS Time.

NOTE: An IRIG-B signal-generating device connected to the GPS satellite system 



     Doc#    E107707                                               15 - 7

    15: Time of Use

will synchronize meters located at different geographic locations. See the Installa-

tion and Operation Manual for your meter, for installation instructions.

NOTE on Time Sync: If you are not using an external time sync method like NTP 

or IRIG-B, it is recommended that you enable line frequency sync for highest time 

accuracy.

15.2.1: Creating a TOU Calendar Profile - Yearly Profile

The TOU calendar profile sets the parameters for TOU data accumulation. You may 

store up to 20 individual calendars in the meter. 

•   To create a new individual calendar, follow the steps listed below. To edit an exist-

ing individual calendar, see  15.2.2: Edit a TOU Calendar Profile, on page 15-22.

•   To create or edit a perpetual calendar (all 20 years at one time), see  15.2.4: Using 

the TOU Perpetual Calendar Configurator, on page 15-25.

•   To load multiple calendars to a meter, see  15.2.3: Multi Calendar Update, on 

page 15-24.

1. From the TOU Calendar menu, select Calendar Settings. You will see the screen 

shown below.

2. From the pull-down menu, choose the year for which you would like to create a 

TOU usage structure.
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3. Click New Calendar. You will see the screen shown below.

4. Click TOU Registers. You will see the screen shown below.
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5. A register is a type of rate structure, for example “Peak”, “Off-Peak” or “Shoulder 

Peak.” You will assign one register to each fifteen-minute interval of the day when 

you set up the TOU schedule (instructions on page 15-11). In this setting you will 

assign a name to any new registers. The default registers are Peak and Off-Peak.

•   Enter a name for each different register (up to eight).

•   Click OK to return to the main Edit Calendar screen.

6. Click Averaging. You will see the screen shown below.
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7. Demand is the average rate of energy used over time. Select the type of Demand 

Averaging to be applied to the TOU accumulations: Block Demand or Rolling 

Window Demand. The Demand type you select should be the Demand needed for 

your specific jurisdiction. Most users rely on a Block Demand, however, a Rolling 

Demand is also available. The Demand Integration interval is usually 15 minutes, 

but it is programmable, and is configured in the meter’s Device Profile.

8. Click OK to return to the main Edit Calendar screen.

9. Click on Monthly Bill Date. You will see the screen shown below.

 The billing date delineates the self read. When the billing date is reached, the 

 meter shifts the current month views to the previous month views. Since billing 

 dates can differ, the user can program the day for each read. 

10.To program a specific Bill Date for each month, use the pull-down menus. If you do

 not select a specific billing date for a given month, accumulations will continue

 until the next monthly billing date is reached or December 31, if there is no next

 year spanning calendar. 

11. When you have entered all Monthly Bill Dates, click OK to return to the main Edit

 Calendar screen.
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12.To set the Freeze values for Time of Use Polling, click Period Selection. You will see

 the screen shown below. 

13.The four Freeze Period options are Seasonal, Weekly, Daily, and Hourly. Click on 

the Freeze Period pull-down menu to select the option you want. The Freeze period 

specifies when TOU data will be copied to a Freeze register for later reading.

a. Seasonal Freeze Period lets you set up to four seasons (time periods), for 

which values are frozen (accumulations of data are stopped) for Time of 

Use Polling. Select Hour of Day to Freeze from the pull-down menu next to 

this option. The Hour of Day specifies the time on the season start date 

that the season changes and the values are frozen. 
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                Click one of the Season Start windows to specify the start date for

                the season. You will see the screen shown below. Enter a start date for

                 each season field or double-click to retrieve a calendar from which you can

                choose a Month and Day. 

                Click OK to return to the Adjustable Self Period Selection screen.

       NOTE: The date format you use here should be the same as the date format set

       for your computer. To change or view your computer’s date settings: open the

       Control Panel and select Clock, Language, and Region>Change the date, time, or

       number format. 
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b. Weekly Freeze Period lets you set the day and hour each week at which val-

ues are frozen for Time of Use Polling. Select the Day of Week to Freeze 

and Hour to Freeze from the pull-down menus next to these options, in the 

Adjustable Self Period Selection screen.

c. Daily Freeze Period lets you set the hour each day at which values are 

frozen for Time of Use Polling. Select Hour of Day to Freeze from the pull-

down menu next to this option, in the Adjustable Self Period Selection 

screen.
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d. Hourly Freeze Period freezes the values for Time of Use Polling each hour.

13.Click OK in the Adjustable Self Period Selection screen to save your selections and

 return to the main Edit Calendar screen; click Cancel to exit the screen without

 saving any changes.
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14.Click Method in the Register Accumulation section of the Edit Calendar window.

 You will see the screen shown below.

15.Click the radio button for the type of Accumulations you require and click OK:

•   Click Accumulations in Registers start at zero when new period starts if you want 

accumulations to begin anew once the last period’s values are frozen.

•   Click Accumulations in Registers continue where Prior Month and Frozen Regis-

ters left off to add the new accumulations to the prior frozen ones. 

• In almost all cases, this will be a user’s selection, so that the TOU regis-

ters continue to accumulate.
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16. Click TOU Schedules. You will see the screen shown below.

•   The first column lists each fifteen-minute block of a 24-hour day.

•   The individual Registers named in Step 5 will be applied to each fifteen-minute 

block.

•   A schedule is the type of accumulation structure you will apply to individual 

days. You may program up to 16 different schedules (use the scroll bars to view 

all of the data in the screen).

•   This screen sets up the bucketing so that TOU registers will be accumulated in 

different buckets at certain times of the day. See the example graphic on the 

next page.
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Figure 15.2: TOU Example

         The Nexus® meter will switch accumulating to different registers based on the

         time of day to capture energy usage at these different rate structures.

17.Double-click on one of the Schedule Headings—for example: “Schedule_1”. You

 will see the following screen.

18.Enter a Name for the schedule, such as “Weekday,” “Weekend” or “Holiday.” Click

 OK. Note that all the names used here are just examples. They can be custom 

named to whatever you require.

Time of Use Example: Weekday

Off-Peak              On-Peak        Shoulder Peak      Off-Peak

00:00 am - 8:59 am 9:00 am - 4:59 pm 5:00 pm - 6:59 pm 7:00 pm - 11:59 pm

Off-Peak=Lowest Energy Usage Cost
On-Peak=Highest Energy Usage Cost
Shoulder Peak=Middle Energy Usage Cost
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19.Double-click on one of the fifteen-minute blocks in the schedule. You will see the

 following screen.

20. From the pull-down menu, select the Register Name you would like to apply to

 this fifteen-minute block. Click OK.

21. Repeat the above procedure until all fifteen-minute blocks in the schedule(s) are

 assigned registers.

22.When all schedules are formatted, click OK to return to the main Edit Calendar

 screen.
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23.Click Calendar Assignments. You will see the screen shown below.

With the use of color, the screen delineates how the day is described as a rate 

structure. The user must enter each holiday individually.

24.The schedules created in steps 16–21 are shown beneath the calendar. Each

 schedule is color-coded. Assign a schedule to each day by clicking on the day. You

 will see the screen shown below.



     Doc#    E107707                                               15 - 20

    15: Time of Use

25. From the pull-down menu, select the Schedule you would like to apply to this day.

26. Click OK to return to the calendar.

27. To apply a Schedule to a Range of Dates or to selected days of the week, click

  Multi Date. You will see the screen shown below.

NOTE: With the Multi Date button, you can quickly program a whole year (For 

Example, 2014) by selecting, for instance, all the weekdays (Mon - Fri) and in the 

Date Range type 01/01/14 to 12/31/14. Do the same for the weekend days. Fill in 

holidays and vacations for each month.

a. Enter a Date Range. 

b. Select the Schedule from the pull-down menu.

c. If you want, choose a Day of the Week. 

d. Click OK.

28.Use the color-coded key below the calendar to review which Schedules have been

 applied to the month. Click Next Month and repeat the process for the year.

29.When the calendar settings are complete, click OK to return to the main Edit 

 Calendar screen.
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30.You may now:

•   Click Save to File to send the calendar to the computer for future use. See 

 15.2.2: Edit a TOU Calendar Profile, on page 15-22 for instructions on editing a 

previously saved calendar. You will see a screen similar to the one shown below, 

which allows you to name and save the TOU file.

•   Click Update Device to send the calendar to the meter. You will see a screen that 

prompts you to the year the calendar will be applied to. Select the radio button 

of the year you want to use and click Send. A message window will tell you that 

the calendar was received. Click OK. The meter will use the calendar for the des-

ignated year, based on the date settings of your computer.

NOTE: Do not enter more than one calendar for the same year (i.e., do not store 

two calendars for 2014). If you do, the meter uses the first calendar entered.
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15.2.2: Edit a TOU Calendar Profile

1. From the Time of Use menu, select Calendar Settings. You will see the same screen 

as shown in  15.2.1: Creating a TOU Calendar Profile - Yearly Profile, on page 15-7. 

Click Edit Calendar. You will see the screen shown below.

•   To edit a calendar saved on the computer’s hard drive, click Load From File. A 

screen opens that lets you to locate the calendar. After the calendar has loaded, 

see  15.2.1: Creating a TOU Calendar Profile - Yearly Profile, on page 15-7,for 

details on programming the calendar.
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•   To edit one of the calendars stored in the meter, click Load from Device. You will 

see the following screen.

2. Select the calendar year you would like to edit and click Retrieve. After the calendar 

has been retrieved, see  15.2.1: Creating a TOU Calendar Profile - Yearly Profile, on 

page 15-7, for details on programming the calendar.
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15.2.3: Multi Calendar Update

Use this feature to send multiple individual year TOU calendars to the meter at one 

time.

1. From the TOU Calendar menu, select Multi Calendar Update. You will see the screen 

shown below. 

2. You can select up to 20 calendars, using the tabs at the top of the screen. 

•   To upload a calendar, click Select to select it from the Calendar Settings direc-

tory.

•   If your calendar(s) are saved in a different directory, click Select Directory and 

locate the files.

•   If a calendar is not loading correctly, you can increase the Inter Calendar Delay 

time to give the meter more time to process the data. If you are not having a 

problem, leave this field as it is.
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3. Click Update to send the calendars to the meter; select Abort to cancel the update; 

select Close to close the window.

15.2.4: Using the TOU Perpetual Calendar Configurator

The TOU Perpetual Calendar configurator will automatically configure the meter for all 

20 years. The structure of this feature is different, and rule-based. In an effort to sim-

plify the TOU programming process, EIG developed this utility that configures the 

Nexus® 20 year calendars using a perpetual TOU calendar setup concept. This new 

form uses an event-based algorithm to configure all 20 years based on one setting 

from the user. It is much easier and faster and less prone to mistakes. However, if you 

wish to edit a specific year, you must use the individual edit calendar function dis-

cussed previously. 

Note that the Nexus® 1450/1500+ meter uses a perpetual TOU calendar built into 

the meter’s firmware (i.e., the software that runs the meter). The other Nexus® 

meters rely on this software-based perpetual calendar.

There are benefits to having the meters calculate the perpetual calendars internally. 

One of the main benefits is that the algorithms can be retrieved by the meter, at a 

later time, for analysis. With the PC software-based TOU, the meter will only provide 

the individual days of the year it has stored.
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1. From the TOU Calendar menu, select Perpetual Calendar. You will see the screen 

shown below. 

2. The TOU Perpetual Calendar screen has tabs that let you access all of its settings:

•   Seasons - use this tab to set up to 4 seasons for the calendar. 

•   Weekdays - use this tab to set days as weekends or weekdays.

•   Schedule Names - use this tab to label the TOU schedules you set up.

•   Custom Days - use this tab to set up holidays, for example, Christmas.

•   Time of Use Labels - use this tab to set up names for TOU that will be used in 

addition to the two Default labels: On Peak and Off Peak.
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•   Time of Use Schedules - use this tab to set the hourly time range for the TOU 

schedules.

•   Description - use this tab to enter any descriptive information about the Perpet-

ual Calendar.

3. The first tab is the Seasons tab (see previous page and screen below). The default 

setting is two seasons. Click in the pull-down menu to select between one and four 

seasons. Depending on what you select, you will see one to four fields that let you 

select the start date for the seasons. Select the month and day for the season start 

date from the pull-down menus.
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4. Click the Weekdays tab - you will see the screen shown below.

You can change a day of the week to a weekend or weekday by clicking on one of 

the radio buttons next to it. The default values are Monday - Friday as weekdays, 

and Saturday and Sunday as weekends.
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5. Click the Schedule Names tab - you will see the screen shown below.

The default Schedule names are Weekday, Weekend, and Holiday. 

•   To add a new schedule name, click the Add a Name button. You will see an 

empty line where you can add the new name. After you enter a name, press 

Enter or click anywhere in the screen. A number will appear next to the new 

Schedule name.

•   To edit an existing name, click on the name and click the Edit Selected Name 

button. You can then change the name. After you change the name, press Enter 

or click anywhere in the screen.

•   To remove a name you added, click on the name and click the Remove Selected 

Name button. Note that you won’t be able to remove the default Schedule 

names (Weekday, Weekend, and Holiday).
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6. Click the Custom Days tab - you will see the screen shown below.

Use this screen to set up holidays. A holiday is a day that would normally be a 

regular “on peak” day but because of a special event, it is fully off peak. The best 

example is Christmas, since December 25th is almost always an off peak day. 

People are not working that day and there are no peak charges. In this section, the 

user enters all these dates, as defined by the Utility rate structure.
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•   To add a Custom day, click the Add a New Day button. You will see the screen 

shown below.

a. Enter a name for the holiday, e.g., Columbus Day.

b. Select the Calendar Modifier from the pull-down menu. You can select:

• Fixed Date - the holiday always falls on the same date each year, e.g., 

New Year’s Day, which is always January 1st

• Occurs on the Next Day - the holiday always occurs on the day after, e.g., 

a holiday that begins at sundown of the previous day.

• Spans to the Next Day - it is a two-day holiday, e.g., Thanksgiving and 

the day after.

• Weekday Only - Nearest Weekday - if the date falls on a weekend, the 

holiday moves to the nearest weekday; e.g., if the holiday falls on Satur-

day, the holiday moves to Friday, but if the holiday falls on Sunday, it 

moves to Monday.

• Weekday Only - Nearest Weekday After - if the date falls on a weekend, 

the holiday moves to the nearest weekday after the set date; e.g., if the 

holiday falls on either a Saturday or Sunday, it moves to Monday.
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• Weekday Only - Nearest Weekday Prior - if the date falls on a weekend, 

the holiday moves to the nearest weekday before the set date; e.g., if the 

holiday falls on either a Saturday or Sunday, it moves to Friday.

c. Configure the custom day’s date. You can select Week, Day, of Month (for 

example, the First Monday of September for U.S. Labor Day); a specific 

day (for example December 25th for Christmas), or Special Day (Easter).

d. Click OK to save the custom day’s settings. Once the holiday rules are set 

up, the software will apply them to all 20 years.

•   To edit a Custom day, click on the date in the list and click the Edit the Selected 

Day button. You will see the screen shown above. Change the settings as you 

want and click OK.

•   To remove a Custom day, click on the date in the list and click the Remove the 

Selected Day button.
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7. Click the Time of Use Labels tab - you will see the screen shown below.

The default TOU labels are On Peak and Off Peak. 

•   To add a new Time of Use label, click the Add a Label button. You will see an 

empty line where you can add the new label. After you enter a label, press Enter 

or click anywhere in the screen. A number will appear next to the new Time of 

Use label.

•   To edit an existing Time of Use label, click on the label and click the Edit the 

Selected Label button. You can then change the label. After you change the 

label, press Enter or click anywhere in the screen. 

•   To remove a Time of Use label you added, click on the label and click the 

Remove the Selected Label button. Note that you won’t be able to remove the 

default TOU labels.



     Doc#    E107707                                               15 - 34

    15: Time of Use

8. Click the Time of Use Schedules tab - you will see the screen shown below.

•   Use this screen to set the time range for the existing Schedules. The Schedules 

consist of the default Schedules - Weekday, Weekend, and Holiday, and any 

Schedules you created using the Schedule Names tab. There is one default time 

range with a Start Time of 00:00 and an End time of 24:00 for the Off Peak TOU 

label. This feature uses a 24 hour clock, so that 12PM - 12AM is 13:00-24:00.

•   This feature works like a timer. Use it to set up when the meter will switch to the 

next bucket of energy accumulation. The meter will run these rules in the order 

they appear.
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•   To add a time range to a schedule, select the Schedule from the pull-down menu 

and click the Add a Time Range button. You will see the screen shown below. 

Select the start time and the TOU label from the pull-down menus and click OK. 

The End time will be updated automatically (see the following example).

•   To edit a Schedule’s time range, select the Schedule from the pull-down list, 

click on the Register name (TOU label) in the list and click the Edit a Selected 

Time Range button. You will see the TOU Time Range screen shown on the previ-

ous page. Change the settings as you want and click OK.

•    To remove a Schedule’s time range, select the Schedule from the pull-down list, 

click on the Register name (TOU label) in the list and click the Remove a 

Selected Time Range button.

•   Example of Time Range Setting

Let’s say you are setting up the Weekday Schedule’s Off Peak and On Peak Time 

Range. The first Off Peak range is already set in the default setting. But it is set 

for the whole day - 00:00 Start Time and 24:00 End Time. So the first step is to 

set the beginning time for the On Peak range. Once you do that, the End Time 

for the first Off Peak period will be adjusted accordingly.
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a. From the TOU Schedules tab screen, select Weekday from the Schedule 

Name pull-down menu and click the Add a Time Range button.

b. Select the start time for the On Peak period for a Weekday schedule. The 

example below uses 9:00 AM. Make sure that the Register (TOU Label) is 

On Peak. Click OK.

1. Select a weekday

      2. Click Add a 
          Time Range

1. Click to enter Start Time

2. Click to select
    On Peak

3. Click OK
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c. The Time of Use Schedules screen redisplays, now listing the On Peak time 

range as well as the default Off Peak time range. Note that the Off Peak 

time range’s end time is now the same as the start time of the On Peak 

time range, and that the On Peak time range’s End time is 24:00 (end of 

the day). 

d. To set up the second Off Peak period, click the Add a Time Range button. 

Enter the start time for the second Weekday’s Off Peak period. The exam-

ple below uses 6 PM (18:00). Make sure that the Register (TOU Label) is 

Off Peak. Click OK.
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e. The Time of Use Schedules screen redisplays, now listing the new Off Peak 

time range as well as the other two time ranges. Note that the On Peak 

time range’s end time is now the same as the start time of the second Off 

Peak time range, and that the second Off Peak time range’s End time is 

24:00 (end of the day). So now you have a Weekday schedule of Off Peak 

from 12 AM to 9 AM, On peak from 9 AM to 6 PM, and Off Peak from 6 PM 

to midnight.   
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9. Click the Description tab. You will see the screen shown below.

You can use this tab to enter a description or notes for this perpetual calendar.
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10. To save the Perpetual Calendar, click the Save icon at the top of the screen or click

  File>Save Profile or File>Save Profile As.

11. You also have the following options:

•   To create a new Perpetual Calendar, click the New icon or click File>New Profile.

•   To open a previously saved Perpetual Calendar, click the Open icon or click 

File>Open Profile.

•   To export the Perpetual Calendar (and create up to 20 years of calendars based 

on it), click the Export icon or click: File>Export>Nexus TOU Calendar File. See 

the instructions in  15.2.3: Multi Calendar Update, on page 15-24.

Save

New

Open
Export
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• To view a report, click File>View a Report. You will be prompted to save 

the perpetual calendar. Then the Calendar report will open in a text 

window. See the example report below.

12. To exit the Perpetual Calendar setup, click File>Exit or click the X in the screen’s

  Menu Bar. You will be asked to confirm that you want to close the software - click

  Yes to exit the Perpetual Calendar setup screen.
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15.2.5: Exporting a Perpetual Calendar to a Nexus® TOU
             Calendar File 

Use this function to create a Nexus® TOU Calendar file from a perpetual calendar 

configuration. You can use this feature to create calendars for multiple years from one 

perpetual calendar. You can then import the TOU files into the CommunicatorPQA® 

application when you configure TOU Calendars. See  15.2.3: Multi Calendar Update, 

on page 15-24, and  15.2.4: Using the TOU Perpetual Calendar Configurator, on 

page 15-25. 

1. Save the perpetual calendar you want to export. 

2. From the Perpetual Calendar screen, click the Export icon or click File> Export> 

Nexus TOU Calendar File. (You will be prompted to save the perpetual calendar.) 

3. You will see the Export Options screen, shown below. 

4. Enter the following information:

•   The year for which the new, exported calendar will be used. If you are creating a 

calendar for more than one year, this should be the first year for which the cal-

endar will be used.

•   The number of years that calendars should be created from the exported calen-

dar. You can select up to 30 years. For example, if this field is set to 3 and the 
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Calendar Year is set to 2014, 3 exported TOU Calendar files will be created: one 

for each of the years 2014, 2015 and 2016.

•   The File Name and Export Path. These fields are used to specify the base file-

name of the exported file and the location where the exported file(s) will be 

saved.

• The calendar year is added to the end of the file name you enter. For 

example, if the filename is NXTOU, the exported file for year 2014 will be 

named “NXTOU2014.TOU.”

• You can click the Browse button to select another location to save the 

calendar file, other than the default location listed on the screen.

5. Use the Nexus TOU Specific Settings tab to configure the Demand Averaging Win-

dow and/or the Register Accumulation Method for the exported file(s).

•   Select the Demand Average Window method: Block Window or Rolling Window.

•   Select the Register Accumulation method: “Accumulations in Registers starts at 

0 when new period starts” or “Accumulations in Registers continues where Prior 

Month and Frozen Registers left off.”

6. Click OK to save your Export settings.
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7. Click OK on the Export screen. The software creates calendars for the number of 

years you selected, based on the Perpetual calendar, and exports them to the 

meter. You will see a message window when the files have been exported - see the 

example below.



     Doc#    E107707                                               15 - 45

    15: Time of Use

15.3: Nexus® 1450/1500+/Shark® 250/270 Meter’s
           TOU Settings

As explained earlier in this chapter, TOU bins energy use into time periods, so that 

utilities can bill customers correctly for Peak and Off Peak usage. The Nexus® 1450/

1500+ and Shark® 250/270 meters use a perpetual TOU schedule called the TOU 

Profile, configured and stored in the meter’s firmware, that you only need to set up 

once. 

To program the TOU Profile, you:

•   Set up the number of seasons per year - up to four seasons are allowed. You can 

also set up the seasons for weekly or daily TOU accumulations.

•   Set up the billing periods, e.g., January 1st, February 1st, etc - up to 12 billing 

periods are allowed.

•   Set up the days designated as holidays.

•   Set up day types, e.g., weekday - up to four day types are allowed, including the 

default day type “holidays.”

•   Set up rates, which are accumulators for usage from different times, e.g., peak 

usage which is accumulated from times designated as peak - up to four rates plus a 

default total accumulations rate are allowed.

•   Set up schedules that specify when rate changes occur during a day; e.g., Sched-

ule 1 consists of Off-Peak at 12 AM, On-Peak at 7 AM, and Off-Peak again at 6 PM; 

the result of this is that the usage from 12 AM to 6:59 AM is applied to the Off-Peak 

Rate, the usage from 7 AM to 5:59 PM is applied to the On-Peak Rate, and the 

usage from 6 PM to 11:59 PM is applied to the Off-Peak Rate.

•   Assign schedules to day type (weekday, weekend, holiday, etc.) for each of the 

configured seasons (or weekly/daily accumulations); e.g., assign Schedule 1 to 

Weekdays for Season 1.

•   Set up the values that will be accumulated.
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Usage data is automatically accumulated in the appropriate counters at the TOU 

demand interval set in the meter’s Device Profile (see  11.2.7: Cumulative Demand 

Type and Time of Use Demand Type, on page 11-47 for the Nexus® 1500+ meter,  

27.2.2: Demand Integration Intervals, on page 27-26 for the Nexus® 1450 meter,  

28.2.1: Configuring Energy, Power Scaling, and Averaging, on page 28-36 for the 

Shark® 250 meter, or 26.2.1: Configuring Energy, Power Scaling, and Averaging 

Method, on page 26-41 for the Shark® 270 meter, for instructions); for example, 

every 15 minutes. 

An exception to this interval accumulation occurs for the Shark® 250/270 meter, 

when an external digital input has been configured as end of interval (EOI). In that 

case, TOU will perform automatic data usage accumulation and calendar actions (rate 

change, day type change, season/billing month self reads) based on the EOI input 

trigger. This can result in shorter or longer interval periods, depending on the EOI 

input timing, so the rate/day type/calendar actions may differ from what is expected.

NOTE: When the meter is set up for automatic (self read) TOU, there are restrictions 

on resets for the Nexus® 1450 and 1500+ meters. See the screen capture below and 

additional information in  20.1.7: Reset Device Information, on page 20-7.

NOTES:

•  If you need to reset TOU, use the TOU Enable/Disable setting in the Device Profile. 

See 11.2.11: Time of Use Enable/Disable (Nexus® 1500+ Meter), on page 11-53 

for instructions, 26.2.7: Time of Use Setting, on page 26-66 (Shark® 270 meter),  
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27.2.8: Time of Use, on page 27-40 (Nexus® 1450 meter), or 28.2.6: Time of Use 

Setting, on page 28-53 (Shark® 250 meter), 

•  When resetting the non-TOU energy in the meter, the TOU energy must be also 

initialized, in order to keep the TOU module synchronized correctly.

•  If you are manually reading TOU, you do not have these reset restrictions. 

•  Detailed instructions for programming a TOU profile begin in 15.3.1: Creating a 

New TOU Profile, on page 15-47. For an example of programming a TOU profile, 

see 15.3.6: Example of Programming a TOU Profile, on page 15-78.

15.3.1: Creating a New TOU Profile 
When setting up TOU for the Nexus® 1450/1500+ or Shark® 250/270 meter, these 

are the recommended steps:

1. Program the meter’s Device profile settings needed for TOU: enabling TOU (see 

11.2.11: Time of Use Enable/Disable (Nexus® 1500+ Meter), on page 11-53, 

28.2.6: Time of Use Setting, on page 28-53 (Shark® 250 meter), or  26.2.7: Time 

of Use Setting, on page 26-66 (Shark® 270 meter)), demand averaging type: 

block window or sliding window (see 11.2.7: Cumulative Demand Type and Time of 

Use Demand Type, on page 11-47 for the Nexus® 1500+ meter,  27.2.2: Demand 

Integration Intervals, on page 27-26 for the Nexus® 1450 meter,  28.2.1: Config-

uring Energy, Power Scaling, and Averaging, on page 28-36 for the Shark® 250 

meter, or 26.2.1: Configuring Energy, Power Scaling, and Averaging Method, on 

page 26-41 for the Shark® 270 meter), demand interval (see  11.2.2: Demand 

Integration Intervals, on page 11-35 for the Nexus® 1500+ meter,  27.2.2: 

Demand Integration Intervals, on page 27-26 for the Nexus® 1450 meter,  28.2.1: 

Configuring Energy, Power Scaling, and Averaging, on page 28-36 for the Shark® 

250 meter, or  26.2.1: Configuring Energy, Power Scaling, and Averaging Method, 

on page 26-41 for the Shark® 270 meter), scaled energy formats (see  11.2.1: 

Energy Scaling, on page 11-28 for the Nexus® 1500+ meter,  27.2.1: Energy Scal-

ing, on page 27-25 for the Nexus® 1450 meter,  28.2.1: Configuring Energy, Power 

Scaling, and Averaging, on page 28-36 for the Shark® 250 meter, or 26.2.1: Con-

figuring Energy, Power Scaling, and Averaging Method, on page 26-41 for the 

Shark® 270 meter), and which scaled energy accumulators will be available in the 

meter (see  11.2.9: Pulse Accumulations, on page 11-50 for the Nexus® 1500+ 

meter or  27.2.6: Pulse Accumulations, on page 27-37 for the Nexus® 1450 

meter).
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2. Program the TOU profile: instructions begin on the next page.

3. Program additional meter profile settings: apply available TOU data-set items from 

the TOU profile to the DNP map (see 11.1.6: DNP3 Custom Class Map, on page 11-

20 for the Nexus® 1500+ meter) and to interval logs ( 11.4: Trending Profile Set-

tings, on page 11-106 for the Nexus® 1500+ meter,  27.4: Trending Profile Set-

tings, on page 27-73 for the Nexus® 1450 meter,  28.4.2: Trending Profiles - 

Configuring Historical Logs, on page 28-68 for the Shark® 250 meter, or 26.4.2: 

Configuring Historical Logs, on page 26-82 for the Shark® 270 meter), to get the 

TOU from either DNP or meter logs.

Instructions follow:

1. From the Main screen’s File menu, click TOU Calendar>TOU Rate Configurator 

 
 2. Click to choose number of seasons

   
 3. Enter season names

 
 4. Select the date the season  will start

 
 5. Click to select a time other than 12 AM for the seasons’ self read

6. Click to set
    up daily or
    weekly 
    accumula-
    tions
    (optional)

 
 1. Click the Self Read Mode 
     button for automatic TOU, or
     the Manual Read Mode 
     button if the meter will be
     manually read
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2. You will use the screen shown above to set up the information for the TOU Profile. 

The normal order of tasks is shown in the example screen. The tabs let you navi-

gate between the different settings. 

   Note that there are two options at the top of the screen in the Icon bar: Reload 

   Settings From Device - will load the settings from the currently connected meter;

   and Update Device - will send the currently open TOU Profile settings to the meter.

3. Click the Self Read Mode button if the meter will be performing TOU reads auto-

matically, based on the TOU Profile settings. 

•  If the meter will be read manually, click the Manual Read Mode. In the case of 

manual TOU reading of the meter, you will not set up Seasons or Billing Periods. 

15.3.1.1: Seasons (or Weekly/Daily)

The first tab is used to set up the number of seasons you want for your TOU Profile. 

The Seasons setting lets you assign different rates to days, based on when in the year 

the day falls - for example, setting a higher On Peak rate in the summer than in the 

spring, since there the higher energy usage caused by air conditioning is more expen-

sive for the utility to produce. You can set up to four seasons. 

1. Select the number of seasons - 1 to 4 - from the pull-down menu.

2. Enter names for each of the seasons.

3. Enter the date that the season will begin.

4. The default for the seasons’ self read is 12 AM (midnight) - if you want to use a dif-

ferent time of day, select it.

•  This tab also lets you set up weekly or daily TOU accumulations. To do so, click 

the Customized Season checkbox. The screen changes as shown on the next 

page.
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a. Enter a label for the season.

b. Click one of the following to set when the TOU accumulations will be read:

• Weekly - select the day of the week that the TOU accumulations will be 

read.

• Daily - select if you want the TOU accumulations to be read daily.

c. The Self Read Time of Day setting is the same as described in step 4 of the 

previous page.
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15.3.1.2: Billing Periods

1. Click the Billing Periods tab.

2. Billing periods are the time periods in which the usage is stored, e.g., January 1, 

February 1, March 1,etc. You can set up to 12 billing periods. At the end of a billing 

period, the meter moves the accumulations into the Prior month and season bucket 

and resets Demand to 0.

•  Billing periods can coincide with a month, be less than a month, or be multiple 

months, depending on what your application requires.

 Click to add a billing period
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a. Click the Add button to add a new billing period. You will see the screen shown 

below. 

b. Enter a name for the billing period, e.g., Summer.

c. To set the start date for the billing period, click in the Recurring and Starts on 

field and select the date from the pull-down menu. 

d. Click OK to save your selection and return to the Billing Period tab.

e. The default for the months’ self read is 12 AM (midnight) - if you want to use a 

different time of day, select it.

Note that in the Shark® 250/270 meter’s Billing Periods screen, the self-read 

setting is located to the right of the Set Billing Periods box.
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15.3.1.3: Holidays

1. Click the Holidays tab.

2. Holidays are days in which Off Peak billing is usually applied to the entire day. Use 

this screen to set up the days that are considered holidays in your TOU Profile. 

 Click to add a holiday
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a. Click the Add button to add a new holiday. You will see the screen shown below. 

b. Enter a name for the holiday, e.g., President’s Day.

c. This screen gives you many options for setting up the holiday. To set up the 

holiday’s date, select from the following:

• Recurring - select the month and day for the holiday, e.g., December 25, 

if the holiday is always on the same date every year

• The (Order), (Day of the Week) of (Month), e.g., Fourth Thursday in 

November, if the holiday always takes place on a specific day of the week 

in a specific month. You can also enter the order and day of the week and 

select Every Month, e.g., the first Monday of every month.

• Specific Day - select the day, month, and year, e.g., Wednesday, March 4, 

2015, to set the holiday for only that day, if the holiday only takes place 

on one specific day and is non-recurring

• Special Days - to choose either Good Friday or Easter for the holiday
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• Occurs - this field gives you added flexibility for setting the date of the 

holiday. You can leave the default setting of “this day only”; but you can 

select one of the following options:

• “The following day only” to designate the holiday as the day after the 

date you set up

• “This day and the following day” to set the holiday to begin on this day 

and extend to the next day; for example to set a holiday for U.S. 

Thanksgiving and the day after

• “Only when this day falls on a weekday” to only designate the day as a 

holiday if the set day is a weekday 

• “This day only, unless this day falls on Saturday, then apply to the 

Friday before this day” to designate the Friday before a Saturday as 

the holiday when the set day is a Saturday

• “This day only, unless this day falls on Sunday, then apply to the 

Monday after this day” to designate the Monday after a Sunday as the 

holiday when the set day is a Sunday

d. Click OK to save your selection and return to the Holiday tab.
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15.3.1.4: Day Type Assignments

1. Click the Day Type Assignments tab.

2. Use the screen above to set up to three day types and to assign one of the three 

day types to each day of the week, i.e, Sunday - Saturday. You do this in order to 

apply Off Peak and On Peak rates to a day. 

•  For example: you set up a Weekend day type that will be Off Peak for the entire 

day, and a Weekday day type that will be On Peak 9-5 and Off Peak the rest of 

the day. Then you apply the Weekend day type to Saturday and Sunday, and the 

Weekday day type to Monday - Friday.

a. Enter a name for the day types. 

•To change a day type name, click in the name field and click the Edit 

Selected Name button. You can then change the name.
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b. For each of the days listed (Sunday type through Saturday type), select the day 

type for it from the pull-down menu. In the example screen on the previous 

page, the Weekend day type is assigned to Saturday and Sunday, and the Week-

day day type is assigned to Monday - Friday. Make the proper settings for your 

jurisdiction.

15.3.1.5: Rate Names

1. Click the Rate Names tab. 

2. This screen is used to set up rates. A rate is the type of charge that is applied to a 

TOU time period - for example, On Peak, Off Peak, Shoulder Peak. The Total rate 

keeps a cumulative total of usage. Use the screen above to set up to four rates and 

the Total rate. 

3. Enter a name for each rate, e.g., On Peak. 

•  To change a rate name, click in the name field and click the Edit Selected Name 

button. You can then change the name.
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15.3.1.6: Schedules

1. Click the Schedules tab. 

2. This screen lets you set up TOU schedules. The schedules define what time of the 

day the rates are applied, for example Off Peak from 9-5 and On Peak the rest of 

the day. The schedules you set up are then applied to the day types (Weekend, 

Weekday, Holiday, etc.) for each of the seasons (or weekly/daily TOU accumula-

tions). You can set up to 16 schedules.
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a. Click the Add Schedule button to add a new schedule. 

b. The schedules are automatically numbered consecutively. Select the start time 

for the first rate and select the rate from the pull-down menus. For example, 

select 12:00 AM and Off Peak to set up the Off Peak rate for the beginning of the 

day for this schedule.

c. Click OK. You return to the Schedules tab.

d. Click Add Rate Change to add another Rate to the schedule. This lets you set up 

a different rate for part of the day
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e. Select the start time and rate from the pull-down menus; then click OK. For 

example, to set up a schedule that can be applied to a Weekday, select 9:00 AM 

and On Peak. Repeat this step until all of the rate changes for the schedule are 

entered.

• For example: to make a schedule that you will apply to a weekday, in 

which 9 AM-5 PM is Peak usage and all other hours are Off Peak usage, 

you would create the schedule and 1. apply the Off Peak Rate to begin at 

12 AM, 2. apply the On Peak Rate to begin at 9 AM, and 3. apply the Off 

Peak Rate to begin at 5 PM. This will ensure that the usage will be accu-

mulated correctly.

NOTES: 

•  You can delete a schedule by highlighting it in the schedule list and clicking 

Delete the Schedule. Note that if you delete a schedule, the schedules after it 

are renumbered by subtracting 1, i.e., if you have schedules 1-4 and you delete 

schedule 2, the schedule that was schedule 3 will be renumbered schedule 2; 

and the schedule that was schedule 4 will be renumbered schedule 3. Be sure to 

readjust the Annual Profile tab, accordingly - see  15.3.1.7: Annual Profile, on 

page 15-61.

•  You can edit a Rate change by highlighting the Rate in the list and selecting Edit 

the Rate Change.

•  You can delete a Rate change by highlighting the Rate in the list and selecting 

Delete the Rate Change.
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15.3.1.7: Annual Profile

1. Click the Annual Profile tab.

2. The Annual Profile is the assignment of the schedules you set up in the previous 

step to the day types you set up earlier. You can assign different schedules for each 

of the day types and for each of the seasons (or weekly/daily TOU accumulations). 

•  For example: (as shown in the above example screen) 

• You have set up Weekend and Weekday day types, in addition to the 

default Holiday day type. 

• Then you set up Schedule 1 which has On Peak hours 9-5 and Off-Peak 

the rest of the day; Schedule 2 which is Off Peak all day, and Schedule 3 

which is On-Peak 9-5, Shoulder Peak 5-7, and Off-Peak the rest of the 

day. 
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• Here in the Annual Profile setting, you could set Seasons 1, 2, and 4 with 

Schedule 1 for Weekday, and Schedule 2 for Weekend and Holiday; and 

Season 3 with Schedule 3 for Weekday, and Schedule 2 for Weekend and 

Holiday. (Day Type 3 is not used in this example Annual Profile.)

• This way the whole year is set up for the proper TOU accumulations and 

billing.

a. Click on a season and click Configure Selected Season.

b. For each of the day types, select the schedule to apply to it from the pull-down 

menu.

c. Click OK. You will return to the Annual Profile tab. 

d. Repeat for each of the seasons.
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15.3.1.8: Monitored Data Sets

1. Click the Monitored Data Sets button. 

2. The Monitored Data Sets setting lets you decide what accumulators, in addition to 

the Energy and Demand readings, that you want to save when TOU is performed. 

In many cases you will leave the default setup as it has been configured to be most 

useful for accumulating TOU data. However, the Nexus® 1450/1500+/Shark® 

250/270 meter’s TOU implementation gives you the flexibility to perform TOU on 

many different readings. There are 38 channels of data that can be accumulated for 

TOU, as follows:

•  Total VAh (Quadrants 1+2+3+4) 

•  Positive VARh (Quadrants 1+2)/Negative VARh (Quadrants 3+4) 

•  Positive Wh (Quadrants 1+4)/Negative Wh (Quadrants 2+3) 
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•  Quadrant 1 VAh/Quadrant 1 VARh

•  Quadrant 2 VAh/Quadrant 2 VARh 

•  Quadrant 3 VAh/Quadrant 3 VARh 

•  Quadrant 4 VAh/Quadrant 4 VARh 

•  I2t Phase A/I2t Phase B/I2t Phase C 

•  V2t Phase A/V2t Phase B/V2t Phase C 

•  Quadrant 1 Wh/Quadrant 2 Wh/Quadrant 3 Wh/Quadrant 4 Wh 

•  Uncompensated Total VAh/Uncompensated +VARh/Uncompensated -VARh /

Uncompensated +Wh/Uncompensated -Wh 

•  +Q/-Q 

•  Pulse Accumulation Inputs 1-8

•  In addition, the following coincident demand values can be selected:

• VAR Q12/VAR Q34

• VAR Q1/Q2/Q3/Q4

• VA Q1/Q2/Q3/Q4

• PF

• +PF/-PF

• Uncompensated PF
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a. Click Add Data Set to add new monitored data. 

b. Select the reading you want to accumulate from the pull-down menu next to 

“Select Accumulator.” The accumulator you select will also be listed in the TOU 

Data Set Label field. Note that the peak demand is based on the selected accu-

mulator.

c. Coincident Demand Association lets you accumulate another reading at the time 

of peak demand accumulation. For example, you may want to track Power Factor 

(PF) or VARs at the time of peak demand, to identify the number of capacitors 

needed, peak inefficiencies, etc. To enable this, select the required coincident 

demand reading from the pull-down menu.
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d. Cumulative demand is the sum of peak demand. There are two cumulative 

demand blocks: current and prior. At the start of a period, the TOU cumulative 

demand is carried forward to the current period data block from the prior period 

data block. At the end of a period, TOU cumulative demand is the sum of the 

cumulative demand value and the peak demand from the current period. Then 

the meter moves the current data into the prior data block, and carries forward 

the updated cumulative demand into the next period’s current data block. Select 

Enabled from the pull-down menu to activate cumulative demand. Refer to 

Figure 15.3 for a graphical representation of Cumulative Demand processing.

15.3: Cumulative Demand Processing

Cumulative Demand

Current Cumulative Demand Prior Cumulative Demand

At End of Period

Peak Demand for the Period is Added to Current Cumulative Demand and
Current Cumulative Demand is Added to Prior Cumulative Demand

Peak Demand for Period
e.g., 35

At Beginning of Period

Current Cumulative Demand Prior Cumulative Demand

Prior Cumulative Demand Value is Moved to Current Cumulative Demand

e.g., 400
Prior Cumulative Demand

This value is 400This value becomes 400

Peak Demand for Period, e.g., 35
added to Prior Cumulative Demand

This value becomes 435
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e. Continuous cumulative demand means that the current cumulative peak demand 

is updated continuously throughout the period. At the start of a period, the TOU 

cumulative demand is carried forward to the current period from the prior 

period. During the period, TOU current cumulative demand is the sum of the 

cumulative demand value and the current peak demand from the current period. 

At the end of the period, the meter moves the current cumulative demand data 

into the prior cumulative demand data block, and carries forward the updated 

cumulative demand into the next period. Click the checkbox to enable cumula-

tive demand accumulation. Note that selecting continuous cumulative demand 

doesn’t affect the prior cumulative demand field, which will still be added to at 

the end of the period. Refer to Figure 15.4 for a graphical representation of Con-

tinuous Cumulative Demand processing.
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Figure 15.4: Continuous Cumulative Demand Processing

Continuous Cumulative Demand

Current Cumulative Demand Prior Cumulative Demand

   

At End of Period 

The highest Peak Demand for the period is 
added to the Prior Cumulative Demand 

Whenever there is a new (i.e., higher) Peak Demand, 
it is added to the Current Cumulative Demand, 
replacing the value that was in there before

During the Period

              Current Cumulative Demand             Prior Cumulative Demand

Peak Demand #1    Peak Demand #2   Peak Demand #3
e.g., 20                  e.g., 25                 e.g., 35

At Beginning of Period

Current Cumulative Demand    Prior Cumulative Demand

Prior Cumulative Demand Value is Moved to Current Cumulative Demand

e.g., 400
Prior Cumulative Demand

This value is still 400

This value is 400This value becomes 400

This value is 400 + whatever the current peak demand is

This value is 400 + whatever the current peak demand is
e.g., 400 + 35

Highest peak demand (e.g., 35)
added to Prior Cumulative Demand

This value becomes 435
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f. Click OK to save your monitored data set.

15.3.1.9: Accumulation Method

1. Click the Accumulation Method tab.

2. This setting lets you specify what happens to the TOU accumulators when a new 

billing period and a new season begin: 

•  You can select to either continue TOU accumulations where the previous billing 

period/season left off or start the TOU accumulators from zero. 

•  Click the settings you want to use.   

3. When you have made all the TOU settings:

•   Click File>Save Rate Profile As to save the TOU Profile as a .cal file. You will be 

prompted to save the file.
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•   Click View As Report to see a report of the TOU Profile settings. 

NOTE: If you aren’t currently connected to a meter., you will see the following 

screens.

4. Click OK.    

5. This information is for reference only and is saved by the software as part of the 

TOU profile. Click OK to proceed with the save or report options.
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15.3.2: Editing an Existing TOU Profile

To edit an existing TOU Profile, you first need to import it either from the connected 

meter or from a saved calendar file. 

For the Nexus® 1450/1500+ meter:

•  To edit the current device’s TOU Profile, click TOU Calendar>Nexus 1500+ TOU Cal-

endar Settings>Edit Current Device Rate Profile. The application will load the 

meter’s TOU Rate Profile and open it in the Rate Configurator. You can then follow 

the instructions given in  15.3.1: Creating a New TOU Profile, on page 15-47 to edit 

the profile and then save it. See  15.3.3: Importing a TOU Profile to the Meter, on 

page 15-72 for instructions on importing it back into the meter.

•  To edit a TOU Profile for other than the connected device, click TOU Calendar> 

Open Rate Profile. A screen opens letting you select the profile file, which is a Time 

of Use Configurator file - with the file extension .cal. The file will open in the Rate 

Configurator and you can follow the instructions in  15.3.1: Creating a New TOU 

Profile, on page 15-47 to edit and save it.

For the Shark® 250/270 meter, click TOU Calendar>TOU Rate Configurator. The 

connected meter’s TOU Profile is loaded, if there is one. 

To edit another TOU Profile, click File>Open Rate Profile. A screen opens that shows 

all TOU Profile files. Select the one you want and click Open. The TOU Profile you 

selected will open in the TOU Rate Configurator screen. 



     Doc#    E107707                                               15 - 72

    15: Time of Use

15.3.3: Importing a TOU Profile to the Meter

When you have saved a TOU Profile as a Time of Use Configurator file, you can copy it 

to any other Nexus® 1450/1500+/Shark® 250/270 meter, for example, if you are 

replacing an existing meter or setting up another meter with the same TOU settings. 

This way you do not need to enter the settings again. The procedure is slightly differ-

ent for the two meters.

15.3.3.1: Importing a Nexus® 1450/1500+ Meter TOU
                 Profile 

1. To import a new or edited Time of Use Configurator file to the meter, click TOU 

Calendar>Nexus 1500+ TOU Calendar Settings>TOU Calendar Utility.

2. Using this screen, you can either read a TOU file from the meter or write a file to 

the meter using this screen. To write a file to the meter:

a. Click the Browse button to locate the file you want. It will be a file with the .cal 

extension.
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b. Click the Write to Device button. You will see messages in the screen as the 

meter is being updated. Note that the TOU module will automatically perform a 

self read and then restart, after each TOU profile update.

3. Click Close when the update is complete.

4. Enable TOU in the meter’s Device Profile - see  11.2.11: Time of Use Enable/Dis-

able (Nexus® 1500+ Meter), on page 11-53 for instructions.

15.3.3.2: Importing a Shark® 250/270 Meter TOU
                   Profile 

 For the Shark® 250/270 meter you select the TOU Profile you want and then upload 

it to the meter:

1. Click TOU Calendar>Upload TOU Rate Settings.

2. A screen opens that shows all TOU Profile files. Select the one you want and click 

Open.

3. You will see a message window as the TOU Profile is being uploaded to the meter, 

and another message window will tell you when the file has finished uploading. 
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15.3.4: Saving a Device’s TOU Profile to a File
              (Nexus® 1450/1500+ Meter)

As explained in  15.3.2: Editing an Existing TOU Profile, on page 15-71, you can use 

the Edit Current Device Rate Profile option to open the device’s configuration file and 

then make changes to it and save it as a file. If you want to save the device’s configu-

ration file as a file, but do not want to make any changes to it, the simplest way is to 

use the TOU Calendar Utility screen shown in  15.3.3: Importing a TOU Profile to the 

Meter, on page 15-72. Follow these instructions.

1. Click TOU Calendar>Nexus 1500+ TOU Calendar Settings>TOU Calendar 

Utility.

2. Click the Read From Device tab.
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3. Click Browse. You will see the screen shown below.
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4. Give a name to the file and click Save. The file and its path will be listed on the 

screen shown below.

5. Click the Read From Device button. You will see messages while the file is being 

saved.

6. Click Close once the messages stop (the file will be saved). 
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15.3.5: Performing a TOU Read through the Modbus Map

To perform a TOU read through the Modbus map, you need to poll the appropriate 

registers. The TOU data is located in Modbus input registers 0xD037H- 0xEF16H for 

the Nexus® 1500+ meter and 41000-48918 for the Shark® 250/270 meter. Data 

includes current billing month/season and previous billing month/season. 

IMPORTANT! 

•  Refer to the Nexus® 1500+ Meter Modbus User Manual, the Shark® 250 Meter 

Modbus Application Guide, or the Shark® 270 Meter Modbus Application Guide for 

detailed Modbus Map information.

•  For Manual Read mode, or for a TOU profile configured with weekly or daily self 

reads, the user should not read the initial and final parts of the current and prior 

month blocks. These are used for regular Self Read mode. The parts that should 

not be read are:

•  For all current month/season/weekly/daily blocks, energy scaling information is 

in the meter’s Device Profile. Coincident demand data identifiers are in the 

Current TOU profile.

•  For all prior month/season/weekly/daily blocks, energy scaling and coincident 

demand data identifiers are in Modbus input registers EF1BH to EF6EH.

•  The TOU registers contain scaled readings, based on the scaling set up in the 

meter’s Device Profile (see  11.2.1: Energy Scaling, on page 11-28, for the Nexus® 

1500+ meter;  28.2.1: Configuring Energy, Power Scaling, and Averaging, on 

page 28-36 for the Shark® 250 meter; or  26.2.1: Configuring Energy, Power Scal-

ing, and Averaging Method, on page 26-41, for the Shark® 270 meter). If you are 

making changes to the meter’s scaling, follow these steps before doing so:

1. Perform a read before applying the new meter profile.

2. Update the meter’s Device Profile. See Chapter 11 for instructions for the 

Nexus® 1500+ meter, Chapter 26 for instructions for the Shark® 270 

meter, and Chapter 28 for instructions for the Shark® 250 meter.

3. Perform a reset of all meter energy, accumulations and TOU readings (see  

20.1.7: Reset Device Information, on page 20-7, for reset instructions.
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 15.3.6: Example of Programming a TOU Profile

Following is an example of programming a TOU Profile, with these settings:

•  Self Read mode

•  12 months: 1/15, 2/15, 3/15, 4/15, 5/15, 6/15, 7/15, 8/15, 9/15, 10/15, 11/15, 

12/15 

•  Four seasons: 3/15(Spring), 6/15(Summer), 9/15(Autumn), 12/15 (Winter)

•  Holiday: 1/1

•  Day Types: Saturday, Sunday, and Weekday

•  Rate Names: On Peak, Off Peak, Holiday

•  Day Type Assignments: Weekday (Monday - Friday), Saturday, Sunday

•  Schedules: Schedule 1 (8 am On Peak rate, 6 pm Off-Peak rate) Schedule 2 (12 am 

Off Peak rate), Schedule 3 (12 am Holiday rate)

•  Annual Profile: 

•  Spring (Holidays - Schedule 3; Weekdays - Schedule 1; Saturdays - Schedule 2; 

Sundays - Schedule 2)

•  Summer (Holidays - Schedule 3; Weekdays - Schedule 1; Saturdays - Schedule 

2; Sundays - Schedule 2)

•  Autumn (Holidays - Schedule 3; Weekdays - Schedule 1; Saturdays - Schedule 

2; Sundays - Schedule 2)

•  Winter (Holidays - Schedule 3; Weekdays - Schedule 1; Saturdays - Schedule 2; 

Sundays - Schedule 2)

•  Monitored Data Sets: Wh Q1+4, Wh Q2+3, -Varh, + Varh
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1. Seasons tab: Self Read Mode; Four Seasons set up, with programmed transition 

dates.
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2. Monthly Billing Periods set to the 15th of every month.
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3. New Year’s Day set as a holiday.
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4. Day types set and all three assigned - as Saturday, Sunday, and Weekday (Mon-

Fri).
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5. Rates set up (named) - On-Peak, Off-Peak, and Holiday.
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6. Three schedules set up: Schedule 1 On-Peak at 8 am, Off-Peak at 6 pm; Schedule 

2 Off-Peak at 12 am (and all day); Schedule 3 Holiday at 12 am (and all day).
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7. Annual Profile set up as: for Spring/Summer/Autumn/Winter seasons - Schedule 3 

applied to holidays, Schedule 1 applied to weekdays, and Schedule 2 applied to 

Saturday and Sunday.
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8. Monitored data sets of Wh in Quadrants 1 and 4 and 2 and 3; and + and - VARh 

accumulators, set up for TOU accumulations.
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9. Accumulation Method set to continue from the previous billing period and start at 

zero for a new season.
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16: Databases and Log Data

16.1: Overview

The CommunicatorPQA® application accesses meter readings and stores the informa-

tion in databases. The Polling screens and the meter logs use these databases to dis-

play the meter data. The Polling screens are described in Chapter 5, and the logs and 

LogViewerPQA are described in Chapter 19. This chapter explains the retrieval of log 

data.

16.2: Retrieving Log Data

There are two methods for retrieving log data from the CommunicatorPQA® applica-

tion database:

•  Retrieve logs manually - you use the CommunicatorPQA® application to retrieve 

the log data; this process is described in this chapter.

•  Retrieve logs using the MeterManagerPQA® application - you set up the MeterMan-

agerPQA® application to automatically retrieve log data from your meters. See 

Chapter 18 for complete instructions on using the MeterManagerPQA® application 

to retrieve log data.

NOTE: Nexus® 12xx meters allow only one Ethernet connection at a time to down-

load logs.



     Doc#    E107707                                               16 - 2

16: Databases and Log Data

16.2.1: Manual Log Retrieval

If your meter has memory for logging, you can retrieve the logs manually in the 

following way:

1. Connect to your meter (see Chapter 3 for instructions).

2. From the CommunicatorPQA® application’s Main screen, click either the Ret Log 

(retrieve logs) icon or Logs>Retrieve Log(s) from Device. You will see the Log 

Status screen for the meter, which lists the available logs and information about 

them. The screen varies depending on the meter type and the logs available for it. 

See the example screen, below, from a Shark® 200 meter. 

3. The pull-down menu for Retrieval Mode allows you to select one of two options:

•   Partial Retrieval - this is the default Retrieval Mode. In Partial Retrieval mode, 

only the newest records are retrieved for any logs you select. This increases 

retrieval speed, since records that have previously been retrieved are ignored. 

When the log is full, it will roll over. Partial Retrieval mode should be used for 

billing and continuous logging.

•   Time Range Retrieval (Use Time Range) - the Time Range Retrieval mode is 

useful if you want to retrieve specific events. If you select Use Time Range from 

the pull-down menu, date range fields will display, allowing you to select the 

Select Retrieval 
Mode from the 
pull-down 
menu
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time range for data retrieval. Only records (within the specified time range) that 

are newer than the latest records in the log database can be retrieved for any 

selected logs. For this reason, Time Range Retrieval should not be used for bill-

ing or continuous logging purposes. The only way to retrieve earlier records 

using Time Range Retrieval is to delete the existing log database(s) before 

retrieving the log(s). See the example screen, below.

NOTE: The Nexus® 1450/1500/1500+ meter does not have a time range 

option. It always performs a partial log retrieval when possible.

Use these fields to 
specify time range
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4. The Log Status screen tells you which logs are available for retrieval. Follow the 

instructions for your meter type.

IMPORTANT! Only one person at a time can download a log. If someone else is 

downloading a log, it will be unavailable until the download is complete.

Shark® 200 meter, MP200TM metering system, and ST40 meter

To select a log or logs for retrieval, 1. click in the Retrieve Log box next to the 

log(s), 2. select your Retrieval Mode and 3. Click Retrieve (see following screens). 

Shark® 200 Meter Log Status Screen

1.Click the box of logs 
you want to retrieve

2. Select Retrieval mode 3. Click Retrieve
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MP200-S Metering System Log Status Screen

MP200-Y Metering System Log Status Screen

1.Click the box of logs 
you want to retrieve

2. Select Retrieval mode 3. Click Retrieve

1.Click the box of logs 
you want to retrieve

2. Select Retrieval mode 3. Click Retrieve
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     Nexus® 1500/1500+ Meter

     To select a log or logs for retrieval, 1. click in the Select box next to the log(s)

     and 2. click Start (see screen below).

Nexus® 1500 Meter Log Retrieval Screen

     The Nexus® 1500/1500+ meter does not have partial or time range log retrieval

     options, but it has another option. You can choose to perform a manual waveform

     capture to add a record (or records) to the Waveform log before you download it.

     This is useful if you want to analyze the current power quality. Click in the pull-

     down menu to select Manual Waveform Capture. When you select Start, the appli-

     cation performs a Waveform capture, and the number of records in the Waveform

     log field increases by one (see screen capture on the next page).

1.Click the box of logs 
you want to retrieve

2.Click Start
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     When you are ready to view the Waveform log, 1. select Retrieve Selected log(s)

     from the pull-down menu, 2. select the Waveform log and 3. click Start to retrieve

     it. 

2.Click Start to 
capture the 
waveform

3. The waveform is added 
to the Waveform log 1.Select Manual Waveform 

Capture from the pull-down 
menu
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 Nexus® 1450 Meter

The Log Status screen for the Nexus® 1450 meter is shown below.

•  To select a log or logs for retrieval, 1. click in the Select box next to the log(s); 2. if 

you are using an HTTP port other than 80 for log retrieval, click the Settings icon to 

enter the HTTP port; and 3. click Start.

•  Click Trigger Waveform Capture to perform a manual waveform capture.

•  Once the log status has been retrieved for all of the logs, status retrieval stops. To 

see updated log status information, click Refresh.

NOTE: For backwards compatibility, if you are 

using the serial port to download logs, you 

must select Logs>Legacy Retrieval. You will 

only be able to download historical logs 1 and 

2 through the serial port.

1. Click the box of any 
log(s) you want to retrieve.

3. Click Start

2. Click to open a window that lets you enter 
    the HTTP port for log retrieval.     
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     Nexus® 1252/1262/1272 Meter

     To select a log or logs for retrieval, 1. click in the Retrieve field next to the log(s) -

     the No will change to Yes; 2. select your Retrieval Mode and 3. click Start (see 

     following screens).

Nexus® 1262/1272 Meter Log Retrieval Screen

1.Click on the logs 
you want to retrieve

2.Select 
Retrieval 
mode

3. Click Start
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Nexus® 1252 Meter Log Retrieval Screen

     NOTE: The Nexus® 1252 meter’s Log Status screen doesn’t list the System

     Events log, but it is retrieved every time you perform a log retrieval.

5. Click Cancel or Close (Nexus® 1500/1500+ meter only) to close the Log Status 

screen.

6. You will see progress messages as the logs are being retrieved. See the following 

example screen from a Nexus® 1500 meter. 

1.Click on the logs 
you want to retrieve

2.Select 
Retrieval 
mode

3. Click Start
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The messages show you what logs are currently being retrieved. Note that for the 

Shark® 250/270 and Nexus® 1450 meters, you can customize the colors shown in 

the log retrieval screen - see 20.2.3: Log Retrieval, on page 20-65.

7. The Log Viewer opens. Refer to Chapter 19 for instructions on opening the logs and 

using LogViewerPQA to view them. 
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17: Script & Scheduler
NOTE: Script & Scheduler has been deprecated in CommunicatorPQA software’s 

version 6. If you are using a previous version of the software and want to use Script & 

Scheduler to schedule log downloads, refer to the manual embedded in that software 

version (click Help>Contents from the Title Bar).
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18: MeterManagerPQA® Application  

18.1: Overview

The MeterManagerPQA® application is the CommunicatorPQA® software’s automa-

tion and meter management module. It automatically locates and collects energy 

data from all installed meters within your power system. The MeterManagerPQA® 

application performs its location and collection actions autonomously, so that even 

novice users can get the full benefits of the application. 

The MeterManagerPQA® application also acts as a launchpad and automation engine 

for the CommunicatorPQA® application by letting you perform many tasks for all the 

meters in your network, and providing a central location for you to:

•  View meter status - Online or Offline - and check meter connections.

•  App launcher - launch any of the EIG meter applications, like EnergyPQA.com®*, 
CommunicatorPQA®, Log Viewer, or the EnergyReporterPQATM appplication’s Dash-
board Viewer to view real time or stored data.

•  Connect to the meter to perform meter configuration and other tasks using 
CommunicatorPQA® software.

•  View meters’ real time readings.

•  Retrieve and view meter logs, such as historical or waveform fault records.

•  Set up automatic log retrieval.

•  Access the EnergyReporterPQATM application to generate and view usage reporting 
and billing data.

•  Update meter firmware.

•  Search for newly installed meters on the network. When locating network meters, 
MeterManagerPQA® software puts them into groups for maximum control and effi-
ciency. 

* MeterManagerPQA® software supports the Cloud-based EnergyPQA.com® system 

in multiple ways. See the EnergyPQA.com AI Driven Energy Management System 

Setup Guide for specific instructions related to the EnergyPQA.com® system (click 

Downloads>Tech Documents from this webpage: 

https://www.electroind.com/products/energypqa-com-energy-management-system/ 

to download the Setup Guide). Only instructions related to the CommunicatorPQA® 

application are given in this chapter.

https://www.electroind.com/products/energypqa-com-energy-management-system/
https://www.electroind.com/products/energypqa-com-energy-management-system/
https://www.electroind.com/products/energypqa-com-energy-management-system/
https://www.electroind.com/products/energypqa-com-energy-management-system
https://www.electroind.com/products/energypqa-com-energy-management-system
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In addition, the MeterManagerPQA® application features an easy-to-use automatic 

report generator, Report Exporter, that lets you create custom spreadsheet reports on 

all aspects of electrical usage, such as energy consumption, voltage deviation, watt/

VAR distribution and many other parameters. The MeterManagerPQA® application 

enables you to email these reports, on a regular programmable interval, to the 

needed parties, upload them to an FTP location, and/or save them in various file for-

mats for additional processing (see 18.6: Report Exporter, on page 18-58). 

Additional important features of the MeterManagerPQA® application are as follows:

•  The MeterManagerPQA® application lets you set up scripts to automatically down-
load meter logs, and export them to the EnergyReporterPQATM application, which 
uses the log data to generate usage and billing reports and analysis. Once acti-
vated, scripts run even if no one is signed onto the computer. In this way, the 
MeterManagerPQA® application can retrieve logs from multiple meters automati-
cally, according to the script’s schedule, without your having to do anything once 
the script is set up. For more information on the EnergyReporterPQATM application, 
see the EnergyReporterPQATM Application User Manual.

•  You can synchronize time for a group of meters or an individual meter. This is useful 
when a meter doesn’t have other means of time synchronization, like NTP.

•  You can be alerted when a meter goes offline, to minimize meter downtime.

•  You can set up automatic archiving of meter log data, reducing the amount of data 
stored in the meter log databases. See 18.11.1: System Options, on page 18-142 
for details on archiving. Note that meter log data archiving is new in MeterMana-
gerPQA version 6; the old version 5 log archiving has been deprecated. 

•  The MeterManagerPQA® application a security feature in which a unique Post-
greSQL database password is assigned to each new install. 

•  For secure access, the MeterManagerPQA® application offers login capability. The 

login feature is initially disabled; to enable it requires user activation and setting up 

of an administrator password. The administrator user has full access to all features 

of both the MeterManagerPQA® application and the EnergyReporterPQATM applica-

tion. The password is set up when security is enabled for the first time. Once set, 

only the administrator can change the admin (administrator) password or disable 

security.

•  The MeterManagerPQA® application facilitates the EnergyPQA.com® Cloud system 

by building a list of meters and automatically uploading meter log data for use in 
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the EnergyPQA.com® system. See specific instructions in the EnergyPQA.com® AI 

Driven Energy Management System Setup Guide.

Because of the MeterManagerPQA® application’s extensive organizational capabilities, 

you may choose to use it as the Base application and access the other applications, 

such as CommunicatorPQA® software, through it. 

To open the MeterManagerPQA® application, click Start>All Programs>Electro Indus-

tries>Meter Manager>Meter Manager Viewer to open the MeterManager Monitor 

screen. The MeterManager Monitor screen has two main screen views: Meter List and 

Scripts Status. These are explained in the following sections. 

NOTE: See 1.2: Installation Requirements, on page 1-3 for important storage and 

database information.

18.2: Setting up Security

To assure only authorized users can configure the MeterManagerPQA® application 

settings, start by enabling security and setting an administrative password. The 

administrative user has access to all the MeterManagerPQA® application features and 

can create and assign single or multiple roles to sub users. See the User Roles and 

Permissions Table for level of access for each role.

1.To enable security, Configure>Security>Enable from the top of the MeterManager-

PQA® application screen.
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2. Enter the Admin password you want to use two times in the screen below and click 

OK. 

•  The software will check that the password is correct and that the Confirm pass-

word is the same as the Password. If not, you will see an error message.

•  You can click on the eye icon to display the password rather than asterisks.

3. You will see the following Login screen: enter admin as the username and the 

admin password and click OK.

4. Now that security is enabled, you can set up users, Click Configure>Security>Edit 

Security.

IMPORTANT! Make sure to store the password since it cannot be reset once it is 

set up.
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5. You will see the MeterManager Security Editor, shown below. 

Using this screen, you (the admin) can:

•  Change the administrator password.

•  Add, update, or disable a user. 

•  Assign roles to a user (the roles control what software features the user can 

access).

•  Disable security.

To change the administrative password:

6.Type the new password, and type it again to confirm. When the passwords match, 

click Update User to save the new password. Note that if the passwords don’t 

match, you will see a yellow warning triangle next to the confirmation password.
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To add a user:

1. Click on New User in the box on the left of the screen.

2. Enter a name for the user, and enter a password for the user twice. Note that user-

names and passwords are case-sensitive.

3. Check the Permissions box(es) of the role(s) you want to assign to this user. See 

the table on the next page for the specific actions that the permissions allow.

NOTE: If you select Configure System or Control Operation permissions, both the 

Read Information and Write Information are automatically added, since they are 

necessary for the Configure and Operate actions.

4. Click Create User. The new user will be displayed in the box on the left of the 

screen.

Enter and 
confirm a
password
for the user

Give the user a name

Select permissions 
for the user
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To update a user:

1. Click on the username in the box on the left. The user’s information will be shown 

in the screen.

2. You can edit the following:

•  Create a new password by entering it in the Password and Confirm Password 

fields and clicking Update User.

•  Assign new roles to the user by checking or unchecking the Permissions boxes 

and clicking Update User.

•  Disable the user by unchecking all of the Permissions boxes and clicking Update 

User.

Select the 
user to
update

Enter new
password
(optional)

Check/uncheck
permissions

Delete this user                   Update this user
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To delete a user:

Follow step 1 of the “To edit a user” instructions and then click Delete User.

To disable security (Admin only):

1. From the left side of the screen, select Disable Security, under Security Actions.

2. Enter the Admin password and click Continue.

Permissions and their specific allowed actions:

See the table on the next page for the allowable actions for the Administrative, Read 

Information, Write Information, Configure System, and Control Operation permis-

sions.
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Allowable Actions Permissions
Admin
only

Read
Information

Write
Information

Configure
System

Control
Operation

Configure Security 

Meter List     
Auto Scan  
Script Status     
Configure Meter Scripts  (view) (view) (view)
Configure Group Scripts (view) (view) (view)
Manual Connect   

View History   

View Meter Logs   

Add Groups   

Meter Discovery   

Email Reporting   

Retrieve Meter Logs   

System Options   

Energy Reporter Integration   

Cloud Options   

Test Meter Issues   

Report Exporter   

Report Exporter Options   

Test All Connection   

Import Connections   

Generate Connection List   

Remove offline connections   

View Communication Quality
of Service Analysis

  

Refresh all statuses   
Update Monitor   
Poller Status   
Command Console   
Disable all Meter Scripts   
Language   
Search Meters   
Remove meter   
Move to Group   
Group Favorite   
View Webpage   
CommPQA Connect to Meter   
CommPQA Real time readings   
CommPQA Show Phasor   
CommPQA Configure Meter
Profile

  

CommPQA Update Meter
Firmware
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18.3: Meter List

The Meter List is the main launchpad that gives you a central location where you can 

add and group your meters so that you do not need to connect to each meter individ-

ually to perform tasks, such as: 

•  Viewing meter status

•  Configuring and enabling security and setting up user accounts and access

•  Configuring meters and groups of meters

•  Connecting to a meter to view real time data

•  Viewing meter logs, waveforms, or events 

•  Configuring automatic reporting

•  View communication status/history for network and meters

Note that the MeterManagerPQA® application also has a feature that lets you perform 

actions on multiple meters at one time. See 18.13: Search Meters, on page 18-163 

for an explanation of Meter Search and its features.
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The first screen you see when you open the MeterManagerPQA® application is the 

Meter List screen. (To return to the screen from another screen, click the Meter List 

icon.)

•   If you have already added meters to the list, they are displayed in the middle of 

the screen, in the groups to which they have been assigned; or if they are not 

assigned to a group, then in the Unassigned group.

•   You can move a group to the top of 

the meter list by right-clicking on the 

group name and selecting Favorite 

Group (a) from the sub-menu. The 

group will move to the top of the list 

and display a star next to its name.

•   You can remove a group by right-clicking on the group name and selecting 

Remove Group (b) from the sub-menu.

     

(a)
(b)
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•   For each meter in the screen, information is displayed in the screen columns. 

The columns that display when you first start the application are the default 

selections. You can change the fields that are displayed by right-clicking in the 

Title field where Meter Name, Meter Type, etc., are written and clicking on 

“Select Columns to Show.” You will see this menu.

• The fields already showing are highlighted in blue. Click on any fields that 

are white to display them in the Meter List screen. If you want to remove 

a field that is already showing, click on it. The line will change from blue 

to white.

• When you are done, click outside of the menu to close it. 

• You can move the columns around by clicking on the title and moving 

them left or right.

• You can resize the columns by clicking on the lines dividing them and 

pulling out or in with your cursor.

• The available fields are:

• Meter Name - the name assigned to the meter during Device Profile   

configuration.

• Meter Type - the meter’s type, e.g., Shark.

• Online Status - whether the meter is Online or Offline.
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• Next Action - whether a script for the meter is running, or if not 

running, when the next script action for the meter is scheduled.

• Connection - the IP address at which the application is connecting to the 

meter.

• Meter Notes - any notes that have been entered for the meter (see 

18.3.1.2: Add Meters to Meter List Manually, on page 18-28, for instruc-

tions on adding meter notes).

• Serial - the meter’s serial number.

• Cloud Expiration - for meters that have been activated in the Ener-

gyPQA.com® system, this column shows the date their activation will 

expire.

• V-Switch - the meter’s current V-SwitchTM key (this can help you easily 

locate meters that need to be updated to a higher key).

• Firmware - the current firmware version (this can help you easily locate 

meters that need to be updated to a later firmware).

NOTE: This column shows the most “important” firmware for the meter, 

which is also more likely to have newer versions. There are other, spe-

cific firmware columns you can choose to view (e.g., Boot Firmware, 

DSP Run firmware) which can be chosen if those are more relevant to 

you.

• You can choose to sort a group of meters by one of the columns, by left-

clicking the column header. This lets you sort through large groups of 

meters more quickly. For example, to find all meters within a group that 

are offline, left-click in the Online Status column to sort the meters by 

their status, and allow you to easily see which meters are offline. 
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•   The Status Bar, located on the bottom left of the screen, tells you the number of 

meters offline/online and the number of meter warnings (1), how many scripts 

are active and if there are any script errors (2), and if an Auto Scan is active, the 

IP Address that is being currently searched for a meter(3).

•  A group or meter that has one or more report templates configured displays a 

"Report" icon next to the group or meter name. If a group or meter has a report 

template configured and the group or meter configuration was modified after the 

report template was created (for example, a group may have one or more meters 

added or removed), a "Broken Report" icon is displayed. See 18.6: Report Exporter, 

on page 18-58, for information on report templates.

•  Meters that have been activated in the EnergyPQA.com system display a Cloud icon 

next to the meter name.

}
}
}

1

2

3

Broken Report Icon

Report Icon
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• MeterManagerPQA® software performs meter setup verification. If there 

is a possible problem with a meter, i.e., it is offline or there is a possibility 

of a wiring issue, an exclamation point is displayed next to the meter in 

the Meter List. As shown in the screen below, if you move the cursor over 

the exclamation point next to the meter, you will see a message about the 

possible problem, and if you move the cursor over the exclamation point 

in the Status Bar, you will see a display of all of the possible problems for 

the meters (note that the red, dashed lines are shown here for clarity - 

they won’t appear on the screen). 

NOTES:

• Meter setup verification doesn’t provide a list of all problems that 

meters encounter. Specifically, it provides static issues, not transitory 

issues, i.e., if a meter is offline (a continuous problem) or there are wir-

ing problems (which won't change until fixed) they can be reported, but 

bad timestamps detected in a meter’s log (an issue with a specific 

record), for example, won’t be reported.

• Meters that are connected to a serial port are displayed as Offline. 
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•  If you click on an exclamation point, a screen showing possible problems is dis-

played. NOTE: You can also click the Meter Issues icon toward the top of the 

screen to display the possible problems screen. 

• The meters with possible problems are shown in the list on the right. For 

each meter, the Group, Serial Number, Issues (Offline or Wiring), the time 

the possible problem was detected, and the description of the possible 

problem are shown. 

- “Offline” means that the software is not able to communicate with the

   meter. 

- “Wiring” indicates that the voltage and current hookups may not be 

   correct or the CTs may be reversed. The specific hookups that can be

   validated by the MeterManagerPQA® application are 3 Element Wye

   and 2 CT Delta.

- The meters that are supported for meter verification are: Shark® 100/

   200/250/270, MP200, and Nexus® 1272/1450/1500/1500+ meters.

•  You can filter the possible problems you see by type (Filter Type - Wiring

  or Offline) and/or Date Range (Last Week, Last 2 Weeks, Last Month).

• If you right-click on a possible problem in the list, you can choose to

 retest the issue, clear the issue from the list (note that the issue will be

 shown again if the list is recreated by a Refresh command or if the

  MeterManagerPQA® application restarts), or show the Phasor diagram 



     Doc#    E107707                                               18-17

            18: MeterManagerPQA® Application

to analyze the issue. Note that the Phasor diagram is shown in Communi-

catorPQA® software, and is only available if the meter is online.

• Click Refresh to reload the possible problems list.

• Click Rescan to rescan all of the possible problems in the list. 

• Click Report to display the possible problems in a spreadsheet. The fields 

shown are Meter Name, Serial Number, Connection, Issue Type, and 

Description.

• Click Scan All to scan all of the meters in the system and generate a new 

possible problems list.

• The table below shows the possible warning messages.

Message Meaning

General

OK Both voltage and current are correctly wired.

Not supported Supports 3 Element Wye and 2 CT Delta, only.

Unable to communicate with meter Meter is offline.

Voltage Low - One or more of the voltage phases has too low 
of an RMS value.

Below 5 V secondary

Current Low - One or more of the current phases has too low 
of an RMS value.

Below 0.05 A secondary

Phase A CT Reversal - A current phase may be reversed. Current phase 180°± 45 of the voltage phase.

Phase B CT Reversal - B current phase may be reversed. Current phase 180°± 45 of the voltage phase.

Phase C CT Reversal - C current phase may be reversed. Current phase 180°± 45 of the voltage phase.

3 Element Wye

Current Out of Phase - The current phases may be incorrect. Current phase ±45° from corresponding voltage.

Voltage Out of Phase - The voltage phases may be incorrect. Voltage phase 120°± 5 apart.

2 CT Delta

Voltage Phases A-C Swapped - Two of the voltage phases may 
be swapped.

Vab 60°± 5 from Vcb

Voltage Phases B-C Swapped - Two of the voltage phases may 
be swapped.

Vcb 60°± 5 from Vab

Voltage Phase C may be incorrect. Vcb 60°± 5 from Vab

Current Phase A Bad may be incorrect. Ia must be -30°±45° from Vab.

Current Phase C Bad may be incorrect. Ic phase must be +30°±45° from Vcb.
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18.3.1: Set Up a Meter List

You add meters to the Meter List in one of two ways:

•  Automatic Connect Using Auto Discovery - This is the simplest method. In this 

mode the software searches out and locates any meters on the network. Once the 

meters are found, they can be automatically added to groups (based on the meter 

type), and the software can automatically begin to download stored meter data. 

•  Manual Connect (Manually adding meters) - In this mode, you manually connect to 

the meter using its IP address. Once the address is entered, the software adds it to 

a group (based on the meter type), and automatically begins to collect stored 

meter data for that meter.

18.3.1.1: Add Meters to the Meter List Using Auto Discovery

There are four methods to configure Auto Discovery. Use whichever one best suits 

your needs.

•  Auto Scan - searches an IP range you enter for network meters and adds them to 

the Meter List. This is the most common meter search method.

•  Meter Discovery Configuration - gives you access to additional settings for custom-

izing scanning for meters.

•  Network Scan - use this feature to perform parallel network scans for meters - see 

18.12.5: Manual Network Scan, on page 18-161, for instructions. This feature 

scans large groups of Network IP ranges for high-speed discovery of meters.

•  Manual Entry - manually signing on to the meter automatically puts the meter on to 

the Meter List.
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Add Meters Using Auto Scan

When you use Auto Scan, the application looks for and adds Network meters in the IP 

address range you enter. Note that his is not a fast process. The software intentionally 

runs rather slowly, in order to not use up network resources. It may take up to one 

hour, or longer, to find all of the meters within the IP range. You have the option of 

putting the meters into groups based on meter type, e.g., Shark® meters.

NOTE: The first time you start the Meter Manager Monitor after installation, you are 

asked if you want to enable Auto Scan. EIG recommends that you do enable Auto 

Scan.

1. Click the Auto Scan icon at the top of the screen. 

2. In the Automatic Scan Configuration screen, you set:

•   The IP range in which you want the application to search for meters: the starting 

and ending IP addresses. 

NOTE: EIG meters natively use Modbus for communication, which defaults to 

Port 502. However, if you have changed the Modbus port on the meter, or are 

using a network device that changes the port mapping, you can specify the port 

range to scan by adding ":[port]" after the IP address. 

For example, range 192.168.0.1:503 to 192.168.0.255:505 will scan all IP 

addresses from 192.168.0.1 to 192.168.0.255, and attempt to connect to those 

IP addresses via ports 503, 504, and 505.

Enter IP
address range 
for meter 
discovery here

Click Save to begin scan with selected settings

Check this box if 
you want meters 
put in groups by 
meter model, e.g, 
Shark

Unless this 
computer is the 
Log Collection 
server, leave 
this box checked  
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•   Whether or not meters are grouped by meter model. Leave the checkbox 

selected to group any discovered meters this way, for example, into Shark® or 

Nexus® groups. Groups are used to perform tasks on multiple meters at one 

time. See 18.4: Meter Groups, on page 18-31, for information on groups. 

NOTE: Any combination of groups can be created, and the user can assign any 

of the meters to any group. Though the default grouping is by meter type, so 

that it is easier to locate meters within the meter list once they are found, the 

meters in a group do not need to be the same meter type.

•   Disable automatic log retrieval - the default of this screen is that automatic log 

retrieval is disabled for the computer (the box is checked). That is because only 

one computer in the network - the server, should be enabled for automatic log 

retrieval. 

• If this computer is not the Log Collection server, leave the box checked. 

• If this computer is the Log Collection server, click on the box to uncheck it 
- the screen will change as shown below. 

• Now that you have enabled automatic log retrieval for the computer, you 
can set the log retrieval interval. The default is every 12 hours, which is 
the recommended setting. If you want to change the interval, click the 
Configure button and then enter the new interval. See the example 
screen on the next page.

Click to set up a log retrieval 
interval of other than every 
12 hours (not generally
recommended)
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                      Changing Log Retrieval Interval screen

 

i. If you select Multi-Time for Type, you will see the screen shown above. It 

lets you set specific times for log retrieval: either on a daily schedule, 

weekly on a specific day, or monthly on a specific day. This setting can be 

used if you want to retrieve logs more often at certain times or days than 

on other times or days, e.g, retrieving logs every hour during the night and 

every eight hours during the day. To add a time, enter it in the time field 

Click to select: Interval - to set up 
interval log retrieval; Time* - to set 
a specific log retrieval time; Manual 
- to perform a manual log retrieval, 
e.g., to test the system; or Multi-
Time - see instructions below. 

Click to set interval 
for log retrieval

Click Apply to 
save the new 
interval

Click Configure to open this screen

Enter time here

Add button
Remove button

List of log 
retrieval times

Frequency
can be
Daily, Weekly on a 
specific day, or
Monthly on a 
specific day



     Doc#    E107707                                               18-22

            18: MeterManagerPQA® Application

and click the Add button. To remove a time, click on it in the list of log 

retrieval times and click the Remove button.

2.Click Save to begin the automatic scan for meters with these settings. In the 

Searching IP Address field of the Status section, the Meter List screen will show the 

IP addresses as the application searches for meters. When searching is complete, 

the discovered meters will be shown in the Meters List.

•  Note that any IP address that is in the Scan Block List will not show up in the 

auto search (see page 18-27 for information on the Scan Block List).
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Add Meters Using Meter Discovery Configuration

Meter Discovery is a more advanced method of finding meters. It allows the user to 

specify multiple IP ranges and to block ranges that should not be scanned. Meter 

Discovery configuration gives you added flexibility compared to Auto Scan, since you 

can specify this additional criteria for Auto Discovery.

1. From the MeterManager Monitor’s Menu bar, click Configure>Meter Discovery.
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2. The entry fields are:

•   Enable Scan - click the checkbox to toggle between enabling and disabling Auto 

Discovery - when the box is checked Auto Discovery is enabled; when it is 

empty, Auto Discovery is disabled. Note that Auto Discovery must be enabled for 

automatic Time Sync (18.5.2: Time Sync, on page 18-39) to work.

•   Network Scan Interval - this setting determines how often the network is 

scanned for new devices. Because new devices are not added frequently, and a 

scan can take time to complete, this interval should be kept at not less than 4 

hours. Click on the underlined field (Every Four Hours) to open a screen that lets 

you adjust the time (see the screen beneath the Online Check Interval explana-

tion, below). 

•   Online Check Interval - this setting determines how often meters which have 

already been discovered are checked to see if they are still online. This feature 

acts as a supervisor, checking the integrity of the metering system. With this 

feature, a user knows immediately if there is a communication problem with the 

meter. Click on the underlined field (Every Ten Minutes) to open a screen that 

lets you adjust the time. 

a. Choose type from the pull-down menu. The choices are:

• Interval - this is the default. Use the up and down arrows in the time field 

to set the hours and minute values you want.
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• Time - select this if you want to set a specific time of the day, week, or 

month for the scan or online check. Fields open which let you specify the 

time you want the scan or online check to occur.

• Manual - select this to force a scan or online check right away.

b. Click Apply to implement your settings. 

•   Automatically assign newly found meters to groups based on meter type - only 

uncheck this box if you don’t want meters assigned to meter type groups, when 

they are discovered. If that is the case, the software will assign all meters to one 

location, regardless of their type.

•   Override scan settings - The default of this setting is disabled (the setting check-

box is empty/unchecked). 

IMPORTANT! EIG recommends that you keep the default of this setting, i.e., 

don’t check the box. The reason for this is that even though changing the set-

tings in this section may improve scan speed, if settings are too fast they can be 

seen by some anti-virus systems as a malicious attack.

If you are sure you want to use this setting, check the Override Scan Settings 

box and refer to the following instructions (up until Address Range bullet on the 

next page).

• Min Sleep Time - this setting determines the minimum time between 

each action taken by the scanner, in milliseconds.
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• Ping Interval - this setting determines the minimum time between each 

IP address to be tested, in milliseconds. Do not set this value to less than 

5 seconds.

• Store Status Interval - this is an internal setting that updates the status 

of the meter search. There is no reason to edit this value.

• Query Gateway Modbus Devices - by default, the Discovery Scan only 

finds meters attached to the network. If you have meters behind a 

Modbus Gateway, enabling this setting can be used to find these meters. 

However, as this greatly slows down the scan, EIG recommends that 

gateway devices be manually added through the CommunicatorPQA® 

application. When you connect to a meter via the CommunicatorPQA® 

application's Quick Connect (see 3.2: Connecting Directly to Your Meter, 

on page 3-6, for instructions), a successful connection will be added to 

the Meter List. If the meter is new, it will be listed under the "Unconfig-

ured" group. Otherwise, the connection last active will be updated for the 

meter. 

•   Address Range - this setting specifies the range of IP addresses to scan. 

• The Manually Configure Meter Discovery Address box is checked by 

default. Manually configure one or more IP address ranges to scan. Note 

that if you don’t specify a range, the scan won’t take place. 

a. To add a range to the table, press the green plus icon (+) on the 

right of the table; to remove a range from the table, press the red 

minus icon (-) on the right of the table.

b. Click in the first field on the left to choose either range or mask. 

 -   Using a range is the simplest way to specify a scan address. You

     enter a start and end IP address for each range.

 -   To use a mask for the scan, you specify a base IP address and a
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      network mask, to specify the range of accessible IP addresses.

      The scan will look for all meters within the network mask, 

      beginning with the base IP address.

•  Scan Block List - this setting lets you eliminate (block) certain IP addresses from 

meter discovery. Once configured, the block list is used by both the Manual 

Network scan and the Automatic Network Discovery. Each address in the block 

list ranges will be ignored.

• To add an IP address range to the block list, enter the start and end IP 

addresses, and click the plus button. The IP address range is added to the 

Block List box on the right.

• To remove an IP address range from the block list, select the IP address 

range in the Block List box and click the minus button.

• To clear the Block List box, click the Clear Block List button (x).

3. Click Update to save your settings. When the Discovery Scan is next run, any new 

meters will be added to the Meter List.

Clear Block List Button Block List Box
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18.3.1.2: Add Meters to Meter List Manually

When you enter meters manually, you assign the meter to a group at the time you 

enter its data. Note that this method does not use the Blacklist, so you can use it to 

discover meters that are blacklisted from the auto scan.

1. From the Meter List screen, click Manual Connect on the left side of the screen. You 

will see the screen shown below.

 

2. Enter these settings:

•   Connection Type is Network or Serial. 

•   Enter the meter’s IP address if the connection is Network.

•   Enter the serial port, or leave the default port 502 (for Network connection).

•   Protocol is Modbus TCP for a Network connection; or Modbus RTU or Modbus 

ASCII for a Serial connection.

1. Enter meter’s
    connection data, 
     e.g., IP address, port, 
    Modbus® TCP, and
    Modbus® address for 
    Network connection

2. Click Connect to add meter
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•   Enter the Modbus address using the Up and Down arrows: valid addresses are 

between 1 - 247.

3. Click Connect. 

4.The screen now:

•   Gives you information about the meter in the Test Connection Results box: 

meter name, serial number, type, and firmware versions.

•   Lets you assign the meter to a group in the Connection Options (New Device) 

box: click the pull-down menu and select from one of the already created 

groups, create a new group for the meter, or assign the meter to the Unassigned 

group if you are not ready to assign it to a group, yet (see 18.4: Meter Groups, 

on page 18-31, for an explanation of, and instructions for, grouping meters).

•   Lets you open the meter connection in the CommunicatorPQA® application, to 

configure meter settings, see polling screens, etc.

•   Lets you add notes for the meter: click the Set Meter Notes button a screen 

where you can type notes for the meter. You can use this option to record infor-

Click to add 
meter notes

Gives more 
information 
about the meter

Click to assign meter to a group
Click to connect to this meter in 
CommunicatorPQA® software
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mation about the meter, e.g., location. The notes are saved with the meter and 

can be accessed later.

5. Click Meter List or use the green back button at the top of the screen to return to 

the Meter List screen.
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18.4: Meter Groups

The MeterManagerPQA® application groups meters together, which lets you perform 

tasks on multiple meters at a time, e.g., downloading logs for all of the meters in the 

group. The default method is grouping them by meter type. Once they are in a group, 

they are all managed on a group basis. It is common for a user to decide to change 

the grouping to something more useful, for example, grouping by substation, loca-

tion, or function. This is up to the user. Whether you want to re-assign a meter to 

another group, or to assign an Unassigned meter to a group, follow these instructions. 

Scripts such as log retrieval work on a particular group of meters at once.

1. From the Meter List screen, right-click on the meter you want to assign (a). 

2. You will see a sub-menu that lets you perform actions for the meter. Move your 

cursor to the line Move Meter to Group (b).

(a)

(b)
(c)
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3. Another sub-menu opens. Click on a previously created group to move the meter to 

that group (c).

4. The Meter List screen will display the meter in its new assignment. 

To create a new group:

1. Click Add Groups on the left side of the screen (a).

2. Enter a name for the group (b) and click OK (c). You can then assign meters to the 

new group.

(a) (b)

(c)
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18.5: Additional Meter Tasks

This section gives information about other tasks you can perform for the meters in the 

Meter List. 

18.5.1: Configure Meter Scripts

The configure meter scripts feature is used to provide information about a specific 

meter, and to set security passwords to that meter, so that the MeterManagerPQA® 

application can successfully download data from the meter. Note that this feature is 

not used for general meter configuration (profile programming) - see your meter’s 

chapter for instructions on Device Profile configuration. You can view information 

about the meter settings and connections, see any problems with the meter, and set 

security and log retrieval options through the Configure Meter Scripts screen. You can 

also enable time synchronization for the meter, and you can override group log 

archiving settings for a specific meter.

1. Click on a meter in the Meter List and either:

•  Right -click and select Configure Meter Scripts from the menu.

•  Click the Configure Meter Scripts icon at the top of the screen.
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2. The top of the Configure Meter Scripts screen lists the meter name, serial number, 

and type, as well as an image of the meter type. The screen has three tab views: 

Meter Settings, Script Settings, and Meter Config.

•  Meter Settings - this is the first tab you see when the screen opens. This screen 

gives you information on the settings history - firmware versions and log direc-

tory path, and connections for the meter, and the time each connection was last 

active, etc. Click on a firmware (e.g., run) to display history of its updates. You 

can also set the time sync for individual meters from this tab. See 18.5.2: Time 

Sync, on page 18-39, for Time Sync explanation and instructions.

•  Script Settings - this tab lets you set security settings and log retrieval. 

a. If the meter requires the user to log in to retrieve logs, click the checkbox 

and enter the Username and Password. For meters which do not require 

user names, such as the Nexus® 12xx meter's, you can enter anything in 
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the Username field. Note that security is also used by the software time 

sync, and should be configured if software time sync is enabled.

b. You can uncheck the box next to any logs you don’t want to retrieve, or 

uncheck the Log Retrieval Enabled box to disable all retrieving of the meter 

logs. The default MeterManagerPQA® application settings will download all 

data to the host server. This setting lets you limit that data. This is very 

important when collecting data from devices with large amounts of mem-

ory, such as the Nexus® 1500/1500+ meter, from which you may not want 

to archive all data on the host server. You can configure this for all meters 

in a group using the Configure Group Scripts screen (see 18.10: Scripts, on 

page 18-112). 



     Doc#    E107707                                               18-36

            18: MeterManagerPQA® Application

•  Meter issues. Click this tab to see any warnings or meter problems. See the 

example screen, in which the message tells us that logs weren’t retrieved for the 

meter.
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•  Meter Config - this tab lets you change the web interface port of the meter. The 

default setting is TCP port 80, most often used by Hypertext Transfer Protocol, 

but if you are using a different port, select it here. 

This section of the Meter Config tab is
used to set up the Landis+Gyr custom
reports. This features is explained in 
Appendix F.
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•  Log Status - this tab shows you the status of meter logs. 

•  If you have changed anything in the Configure Meter Scripts tabs, click the Save 

button. 

3. You will return to the Meter List screen.
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18.5.2: Time Sync

As explained previously, Time Sync is available from the Meter Settings tab. The Time 

Sync feature allows for tracking the time difference of meters from the MeterMana-

gerPQA® application server. When Time Sync is enabled, it also sets the meter's time 

when it drifts beyond a configured threshold. Meters which have software time sync 

enabled will be shown with a clock icon in the Meter List. Scanning the meter times is 

done automatically at one hour intervals - no configuration is required. 

NOTE: For Time Sync to work automatically, the online scan must be enabled by 

checking the Enable Scan box in the Meter Discovery Configuration screen- see Add 

Meters Using Meter Discovery Configuration, on page 18-23 for instructions.

To enable software time sync on a meter:

a. Scroll to the bottom of the Meter Settings tab. 

b. In the Time Synchronization section, the most recently scanned meter time dif-

ference is displayed. It will be marked in red if this time is too far different.

c. Select Enable software time synchronization.
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d. Select the Timezone offset from UTC, which is Coordinated Universal Time (UTC 

is the mean solar time at 0° longitude; and is the main time standard used 

worldwide to regulate clocks and time); or leave the Default, which is the same 

as the group setting (see 18.10.1: Script Status, on page 18-119 for instructions 

on setting Time Sync for a group). 

 

The purpose of adding a UTC Zone descriptor is that the meter may not be 

located in the same timezone as the server. Thus, the server needs to know 

what the connect synchronizing time should be. 

The current timezone offset is listed, along with the adjustment factor (timezone 

difference), to assist in configuring the time. The Timezone Offset works by off-

setting the PC time being compared against the meter.

NOTES: 

• The UTC offset specified should be current daylight savings offset, if 

applicable. For example, for the eastern timezone of the United States, 

EST is -5:00, EDT is -4:00. If you are currently in Daylight Savings, 

specify -4, otherwise -5.

• The Allowed Time Drift is set in the System Options screen. See 
18.11.1: System Options, on page 18-142 for instructions. 

PC Time Meter Time PC Timezone Meter 
Timezone Difference

2015/04/28 
01:00

2015/04/28 
01:01

-4 -4 00:01

2015/04/28 
01:00

2015/04/27 
23:01

-4 -6 00:01

2015/04/28 
01:00

2015/04/27 
23:01

-4 0 -05:59

2015/04/28 
01:00

2015/04/28 
05:01

-4 0 00:01

2015/04/28 
01:00

2015/04/27 
23:01

-4 disabled -01:59
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• Only use Time Sync when other time synchronization options are not 
being used. For example, if you are using NTP or IRIG-B, do not allow 
time sync through this method.

• Time Sync is especially useful with Shark® 200S meters, which do not 
offer time sync through NTP. Shark® 200 meters equipped with an 
INP100S card, on the other hand, offer NTP time sync.

• Time Sync will be disabled for 12 hours before and after the DST transi-
tion time for the PC's current regional settings, in order to prevent 
updating the meter's time while it is automatically updating for its own 
internal DST transition times.

• If security is enabled in the meter, you may need to enter login informa-
tion.
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18.5.3: Connect to a Meter

From the Meter List, you can connect directly to a meter in the CommunicatorPQA® 

application, for example, to view real time data like power and energy use, alarms, 

max/min, the status of inputs, etc. and/or to configure the meter’s Device Profile and 

other settings. Using Meter Search you can connect to multiple meters at one time - 

see 18.13: Search Meters, on page 18-163, for instructions.

Either double-click or right-click on the meter in the Meter List screen, and select 

Connect to Meter. 

The CommunicatorPQA® application connects to the meter and opens at the Main 

screen. Refer the rest of this manual for instructions on the tasks you can perform 

with the software. Clicking Help>Contents opens this manual online.

If you want to go directly to the poll real time readings screen to view power and 

energy readings, double-click to the Real Time Readings in the menu list. See the 
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example screen below (from a Nexus 1500+ meter), and see 5.2.1: Instantaneous 

Polling, on page 5-3, for a detailed explanation of the screen. 
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18.5.4: View Meter Logs

Meter logs are the log data stored in the meter that was automatically collected and 

brought into the software. They allow you to view historical log data, alarm data, and 

power quality fault and surge/sag waveform data.

To view, copy, or print retrieved logs for a meter directly from the Meter List, double-

click or right-click on the meter in the Meter List screen and select View Meter Logs. 

Note that the View Meter Logs button will be disabled if logs have not been retrieved 

or if the meter does not support logs. 
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LogViewerPQA opens, letting you view any logs for the meter. 

Refer to Chapter 19: Viewing Logs, on page 19-1, for detailed information on using 

LogViewerPQA.

NOTE: LogViewerPQA allows you to analyze, chart and graph, and view all data col-

lected from stored memory in deployed EIG metering systems. This is a very com-

monly used application module; it allows you to conduct deep engineering analysis on 

your power distribution system. 
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18.5.5: View EnergyReporterPQATM Dashboard

The EnergyReporterPQATM application provides automatic energy reporting, energy 

dashboards and customer energy billing. A user can access this data for the particular 

metering point, here, directly from a meter in the Meter List. Double-click or right-

click on a meter in the Meter List screen and select View EnergyReporter Dashboard. 

The EnergyReporterPQATM application’s Dashboard Viewer opens.
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The Dashboard Viewer gives you multiple options for viewing the meter’s usage data. 

For complete information, see the EnergyReporterPQATM Application User Manual.

18.5.6: Retrieve Meter Logs

The MeterManagerPQA® application is designed to automatically retrieve all stored 

data in a meter on a scheduled interval. However, if a user desires to view stored data 

at the current moment, that can be accomplished here, directly from the Meter List. 

This is useful if a user wishes to look at an event that just occurred, rather than wait-

ing for the next log retrieval to capture the event, since the usual log retrieval interval 

is one hour. Double-click or right-click on a meter in the Meter List screen and select 

Retrieve Meter Logs to start the script that will retrieve logs for the meter (see 18.6: 

Report Exporter, on page 18-58, for information on scripts).

NOTES: 

•  The log retrieval history is not saved for individual meter log retrievals. If viewing 

this history is necessary, add the meter to a group and use the Group Retrieve Log 

Script (see 18.5.7: Move Meter to Group, on page 18-49, and 18.5.15: Groups 

Menu, on page 18-56).

•  The MeterManagerPQA® application provides logging capability for meters without 

logs, i.e., the Shark® 50 and Shark® 100 meters. See 18.11.1: System Options, 

on page 18-142, for instructions.
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In the Next Action field of the Meter List screen you will see the log retrieval progress 

(see the example below).

The software will give feedback on the download status of each log being retrieved. 

Once the downloads have completed you can view any data you want. 

NOTE: See 18.11.1: System Options, on page 18-142 for additional log retrieval 

options.
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18.5.7: Move Meter to Group

See 18.4: Meter Groups, on page 18-31 for instructions.

18.5.8: Configure Meter Scripts Option

Configure meter scripts lets a user configure the data retrieval server to optimize log 

data and security for the automated download process. Double-click or right-click on a 

meter in the Meter List screen and select Configure Meter.

The Configure Meter screen opens - see 18.5.1: Configure Meter Scripts, on page 18-

33, for instructions.

NOTE: Configure Meter Scripts is used for setting up custom scripts. Configure Meter 

Profile is used to make a change to the meter’s device profile configuration.
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18.5.9: Remove Meter

Double-click or right-click on a meter in the Meter List and select Remove Meter.

You will see the following message window.

Click Yes to remove the meter from the list or click No to keep the meter on the list. 

You can use the Search Meters feature to remove multiple meters at one time. See 

18.13: Search Meters, on page 18-163 for instructions.

Note, that deleting the meters from the Meter List does not delete the meter’s log 

data. If you add the meter back into the Meter List at a later date, the meter’s log 

data will still be available.
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18.5.10: Test Meter Connection

Test Meter Connection will verify that the system is able to communicate successfully 

with the installed remote meter.

You can right-click on a meter in the Meter List screen and select Test Meter 

Connection to make sure you are able to connect to the meter. 

You will see an error message if you are not able to connect to the meter. If you get 

an error message, check to make sure that the meter’s connection information - IP 

address, etc., is correct. You can test connections for multiple meters at one time 

using the Search Meters feature - see 18.13: Search Meters, on page 18-163, for 

instructions.

NOTE: The system periodically self-tests its connection to the meter. The Test Meter 

Connection option is used if a user wants to test the meter connection on demand.
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18.5.11: Test Meter Issues

Test Meter Issues will perform meter setup verification on the selected meter (see pp. 

18-16 - 18-17 for details).

Right-click on a meter in the Meter List screen and select Test Meter Issues. 

The software performs meter setup verification and then displays the Meter Issues 

screen, showing the meter you selected on the top of the list, if any possible meter 

issues are found.
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18.5.12: Real Time Readings

Real Time Readings allows a user to view electrical parameters as they are happening. 

For example, the user can view real time voltage, harmonics, power, and current flow.

Double-click or right-click on a meter in the Meter List screen and select Real Time 

Readings. 

The CommunicatorPQA® application opens and displays the real time polling screen 

for the meter (see 5.2: Real Time Readings, on page 5-2, for details on this polling 

screen). You can view Real Time readings for multiple meters using the Search Meters 

feature - see 18.13: Search Meters, on page 18-163 for instructions.
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18.5.13: Configure Meter Profile

Configure Meter Profile allows a user to edit the actual configuration settings stored in 

the meter.

Double-click or right-click on a meter in the Meter List screen and select Configure 

Meter Profile.

The CommunicatorPQA® application opens and displays the Device Profile screen for 

the meter (see Chapter 7: Configuring Your Meter: the Device Profile Screen, on 

page 7-1, for details on this screen). You can program multiple meters, consecutively, 

using the Search Meters feature - see 18.13: Search Meters, on page 18-163 for 

instructions.
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18.5.14: Update Meter Firmware

This feature to used to update the meter’s firmware and activate the advanced 

features, directly from the Meter List. 

1. Double-click or right-click on a meter in the Meter List screen and select Update 

Meter Firmware.

2. The CommunicatorPQA® application opens and displays the Firmware Update 

screen for the meter (see Chapter 25: Firmware Updating, on page 25-1 for details 

on this screen). You can update firmware for multiple meters, consecutively, using 

the Search Meters feature - see 18.13: Search Meters, on page 18-163 for instruc-

tions.
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18.5.15: Groups Menu

Double-click or right-click on a group name in the Meter List screen to see the sub- 

menu shown below.

•  Click Report Exporter to set up automatic reporting for the group meters. See 18.6: 

Report Exporter, on page 18-58 for instructions.

•  Click Trigger Retrieve Logs to start log retrieval for all meters in the group automat-

ically. Note that automatic log retrieval must be enabled in order to retrieve logs for 

a group. If automatic retrieval is disabled, and you still want to retrieve the logs, 

trigger retrieval for the meters individually. See 18.5.1: Configure Meter Scripts, on 

page 18-33 for instructions.

•  Click Configure Group Scripts to open the screen that lets you set up scripts. See 

18.10: Scripts, on page 18-112 for instructions.

•  Click Test Meter Issues to perform meter setup verification for the meters in the 

group. See pages 18-8 - 18-10 for details.

•  Click Favorite Group to mark this group as a favorite. When a group is selected as a 

favorite, the software moves the group to the top of the Meter List. This lets a user 

move the most often viewed groups to the top of the list.
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•  Click Remove Group to remove this group. You will see the following confirmation 

message. 

Click Yes to remove the group and move all of its meters to the Unassigned group 

or click No if you do not want to do that.

•  Click Rename Group to give a new name to the group. In the screen shown below, 

enter the name and click OK. 

•  Click Transfer Contents to Group if you want to move the group meters into another 

group, e.g., if you want to combine groups. In the screen shown below, select from 

the pull-down menu, the group into which you want to move the meters.
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18.6: Report Exporter

The MeterManagerPQA® application’s Report Exporter feature lets you easily create 

report templates and then automatically generate and distribute the reports on a con-

figured schedule. Report Exporter is a software product that allows a user to set up 

custom reports that generate a spreadsheet-type tabular data format. This allows a 

user to customize a report for the specific fields of energy consumption they need. 

The Report Exporter is designed to not only create the report, but also to send that 

data out to the user automatically. A user can select which report and the frequency 

of the report they wish to send. Features of Report Exporter include:

•  Provide tabular format of differing values for one or more meters in a spreadsheet 

format report.

•  Create formulas to automatically calculate derivative values on the data in the 

report.

•  Report files are automatically sent to a selected folder, which is specified when the 

report template is created. This can be a folder on the local computer or on the 

network.

•  Reports can be sent as email attachments.

•  Reports can be uploaded to an FTP server for availability to multiple users.

There are five types of scheduled reports:

•  Hourly Reports, which begin at HH:00:00 and end at HH:59:59 each hour.

•  Multi-Hour Reports, of between 2 and 23 hours, can be configured. 

•  Daily Reports, which begin at 12:00:00 AM and end at 11:59:59 PM each day.

•  Weekly Reports, which start on any day of the week at 12:00:00 AM and end at 

11:59:59 PM on the 7th day (e.g., if a weekly report started on Monday at 

12:00:00 AM, it would end the next Sunday at 11:59:59 PM).

•  Monthly Reports, which begin at 12:00:00 AM on the selected day of the month 

(any day from 1 to 28) and end at 11:59:59 PM a month later (e.g., a monthly 

report beginning on June 6 at 12:00:00 AM will end July 5 at 11:59:59 PM).
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Note that scheduled reports need to have available historical log data in order to run:

•  A report is exported only if there is data available for the next scheduled report 

period. If there is incomplete data for the report at the time the export is triggered, 

a message will be added to the system log to that effect, and the export will be 

attempted again on the next scheduled export cycle.

•  If there is historical log data with a time stamp greater than the next scheduled 

period end time, but there is no data for the scheduled report period, an empty 

report is generated. The report period will then be incremented to the next report 

period. For example, if a Daily Report was configured and the power went down for 

a day and then resumed the next day, an empty report would be exported for the 

day the power was out. 

•  The scheduled report period will only advance to the next report period when there 

has been a successful export for the period. For example, if an hourly report has 

been scheduled but the Historical Logs have not been retrieved for a day or more, 

all hourly reports up to the latest data will be generated after the logs have been 

retrieved and the next export schedule is executed.

Additional information about Report Exporter is as follows:

•  In addition to the scheduled reports, reports may be generated manually at any 

time. Manual reports offer a great deal of flexibility:

•  Report Exporter offers multiple styling options for manual reports.

•  User-defined date ranges and formulas may be added to manual reports.

•  You can create multiple manual reports for the same meter group or meter, 

which gives you flexibility in data analysis.

•  Reports may be saved as one of two file types (.xlsx which can be opened by 

Microsoft® Excel or Open Office, which is an open source application, or. csv files, 

which can be imported into many applications) and/or printed. 

•  Report Exporter scheduled export activities are logged and can be reviewed in the 

MeterManagerPQA® application’s Script Status logs (see 18.10.2: View Script Logs, 

on page 18-124).



     Doc#    E107707                                               18-60

            18: MeterManagerPQA® Application

•  Reports may not include multiple meter groups or individual meters from multiple 

meter groups, but if your data requirements need this capability, you can create a 

group containing the set of meters desired for a report. When a meter group is 

selected for a report, only the set of data points (channels) common to all of the 

meters in the group are displayed for selection for inclusion in a report.

•  Reports will not be exported when scheduled for groups or meter whose configura-

tion was modified after the report template was created - this includes adding or 

removing meters from a group, or changing the logged items configured in the 

meters. The report template must be edited or replaced for scheduled exports to 

resume for that group or meter. In this situation, a "Broken Report" icon is 

displayed in the Meter Manager Meter List, a warning message is displayed when 

opening the report template for editing, and a warning message is logged when a 

scheduled export cycle is run.

•  Report Exporter can only be run from the computer that is the server, since that is 

the only computer that controls log retrieval. However, multiple users can have 

access to the report files through email, saving to shared locations, and/or FTP.

•  Automatic log retrieval must be enabled for Report Exporter to be configured. See 

18.3.1.1: Add Meters to the Meter List Using Auto Discovery, on page 18-18, for 

instructions on enabling automatic log retrieval. In addition, if you are creating a 

report template for a group of meters or a meter that belongs to a group, auto-

matic log retrieval must be enabled for the group. See 18.10: Scripts, on page 18-

112 for instructions on enabling automatic log retrieval for groups of meters. Note 

that you will see a warning message when you try to select Report Exporter if auto-

matic log retrieval is not enabled.

•  Report Exporter uses the PC's default system time format to display the time 

stamps in the report. If you need to override this setting, for example, if you are 

using a report internationally, you can customize your Report Exporter’s date time 

format. See 18.6.2: Report Preview Feature, on page 18-81, for instructions.

•  See 18.6.3: Report Exporter Example, on page 18-97, for an example report cre-

ation.

•  See 18.6.4: Report Exporter Troubleshooting, on page 18-101, for information on 

any possible Report Exporter errors and their resolutions.
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1. Right-click on a meter and select Report Exporter. (You can also right-click on a 

group name and select Report Exporter). 

2. You will see the Report Exporter screen. 

(a)

(b)

(c)

(d)

(e)

(a) Saved report templates are listed in the pull-down menu.
(b) Report settings are made in this section.
(c) This is the export location for the report
(d) These are the channels that can be selected.
(e) These are the application commands.
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•  The example screen is for an individual meter. If you are using the Report 

Exporter for a group of meters, the screen and settings will be the same, except 

that the default report and header names will be based on the name of the 

group, and the Channels section will only contain data points common to all of 

the meters.

•  Note that if there is already a report template for this meter or group of meters, 

you will be asked to confirm that you want to edit the report. 

• If you click Yes, the Report Exporter screen opens with the settings for 

the existing report template, which you can change if you wish. Once you 

have made changes you can Save the report template, which will write 

over the previous version.

• If you click No, the Report Exporter opens, letting you set up a new 

report template.

• If you click Cancel, the message window closes and the Report Exporter 

does not open.
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•  Use the middle of the screen to set up information for the template: 

•  Report Frequency - your choices are Hourly, Multi-Hour, Daily, Weekly, or 

Monthly. Note that Report Exporter will suggest an appropriate starting 

date and time for the report, based on the stored data, but you can set 

the report to start at any date or time you want. To edit the date, click on 

the up/down arrows in the date field. To edit the hour, click on the num-

ber and use the up and down arrows; to set AM or PM, click on the AM/PM 

and click the up or down arrow.

NOTE: The report data starts at the first interval after the start of the 

report period. Similarly, the last value in the report will include the end of 

the report period. For example, a daily report for 15 minute interval data, 

would contain values from 12:15 AM to 12:00 AM the next day. Since 

data is time stamped at the end of the logging interval, this is done to 

ensure the data reported is for the data within the day, month, or other-

wise, included by the report period.

• Hourly reports - the report period starts at the top of the hour and goes

 to the last second, for example, from 8:00:00 to 8:59:59. Then the

 next hourly report would be from 9:00:00 to 9:59:59.

• Multi-Hour reports - the report period starts at the top of the hour and 

ends at NN:59:59, where N is the number of hours selected in the Hours 

field, minus 1. For example, if you select 6 Hours, a report starting at 

midnight will go from 12:00:00 AM to 5:59:59 AM; the next Multi-Hour 

Set Start Hour

The date and time here are determined by the report frequency, the start time, and, in the 
case of the Multi-Hour report, by the number of hours in the Hours field.

Set Date
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report will go from 6:00:00 AM to 11:59:59 AM; the third for 12:00:00 

PM to 5:59:59 PM, etc. You can select between 2 and 23 hours for the 

Multi-Hour report.

• Daily - the report period starts at the hour you select and goes for 24 

hours. For example, if you choose to start the report at 6 AM, the daily 

report will begin at 6 A.M and go until 6 A.M the following day. 

• Weekly - the report period starts on Sunday at the hour you set and 

goes until that same time a week later; e.g., Sunday at 5 AM until the 

next Sunday at 5 AM.

• Monthly - the report period starts at the hour you set on the selected 

day of the month (1 to 28) and goes until the hour you set a month 

later; e.g., from March 4 at 12 PM to April 4 at 12 PM).

• Hours - the number of hours to be included in a Multi-Hour report.

• Date the next report period starts. This is determined by the current date 

and type of report; e.g., Weekly reports start on Sunday, while an Hourly 

report would start on the current day.

• Time the next report period starts - This setting was discussed earlier, in 

relation to the Report Frequency. Note that normally reports will start to 

be generated automatically at the time set, after the report has been con-

figured. If you want to generate reports starting at an earlier date, (or 

generate new reports for old data), set this field to when the report gen-

eration should start. All possible reports from that date will be generated.

• Report Template name - the default is the meter name followed by the 

type of report, i.e., Hourly, Daily, Weekly, or Monthly. You can change this 

name if you wish, but you should select the Report Frequency first so that 

your chosen name is not overwritten.
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• Format for the exported report file - the choices are Excel file (*.xlsx), or 

CSV file (*.csv). What you choose depends on how you want to use the 

data, for example, if you will be using Microsoft® Excel or Open Office 

applications, choose .xlsx, if you are using another application, choose 

.csv, since .csv files are compatible with multiple applications.

• Date the next report period ends - this field is display only and is deter-

mined by the report frequency setting and report starting time. For exam-

ple if the report frequency is daily, and the starting time is 6 AM, the date 

the next period ends is 6 AM of the of the next day. This lets you deter-

mine what data the next report generated will contain, given the config-

ured settings and the data stored in the meters’ logs.

• Report Heading - this heading displays on the first line of the report. The 

default is the same as the default report template name, but you can 

enter another heading if you wish. You should select the Report Fre-

quency first, so that your chosen heading is not overwritten.

• Scheduling - this field lets you set up how reports with missing data are 

handled. Select from the pull-down menu:

• None (the default) - nothing different occurs.

• Time - a time selection field opens and a screen message says that 

reports without data won’t be generated until the time you enter.

• Missing Days - an Allowed Missing Days field opens and a screen mes-

sage says that reports without data will be generated after the number 

of days you select. 

• Exported report file name and path - the default path is shown. Click on 

the [...] button to choose another name and/or location if you wish. You 

should select the Report Frequency before changing the file name, so that 

your chosen name is not overwritten. When the file is exported a time 

stamp is added at the end of the file name. The time stamp is formatted 

YYYYMMDDHHMM (Year, Month, Day, Hour (0 - 23), Minute).
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•  The bottom of the screen displays the available data points from the historical file 

(for a group report template, only the data points shared by all of the meters are 

displayed). 

•To include a data point in the report, click on it in the left column and click 

the right arrow. (To remove a data point from the report, click on it in the 

right column and click the left arrow.) 

NOTE: There is a maximum of 256 channels across all meters, per 

report.

• You can add a computed channel in this way: To include a data point that 

will be calculated across a time frame, click on the data point in the left 

column and click on the round, green button on the right. (To remove that 

data point, click on the data point in the right column and then click on 

the round, red button on the left.)

NOTES: 

- The data point you selected will be copied to the column on the right,

  with “Computed_XX” next to its name XX. 

- Any computed data points are displayed in green in the column on the

  right, to distinguish them easily from “regular” data points.

- The data point you selected will still be listed in the column on the left

  and can be selected, so that you can have a data point and also a 

  computation for that data point in the report.
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• Once the data point for the computed channel is listed in the right 

column, right-click on it and select “Define Computed Settings for [the 

data point name].”

• You can compute the channel data by either a value or over an interval 

of time.

• To compute the channel data by a value: under cell calculations, select 

Multiply or Divide for Operation and enter a number in Value; e.g., Mul-

tiply and 2 to multiply the channel data by 2.

• To compute the channel data over an interval of time: select the compu-

tation Formula: SUM, AVG, MAX, or MIN; select the computation Inter-

val: 15 (minutes), 30 (minutes), 60 (minutes), or Daily.

• Click OK. (See 18.6.2: Report Preview Feature, on page 18-81 for an 

example of a report using computed channels.)

• To move a data point higher or lower in the list, use the up/down arrows.

• To move all of the data points from one column to the other, use the 

double arrow symbols.
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•  The right side of the screen contains the Report Exporter commands:

• Save Template- click to save the template - the name will be displayed in 

the Saved Templates field at the top of the screen.

• Clone - click to make a copy of this report template with a new name. 

This allows you to easily create multiple reports for the meter or group.

• Delete - click to delete the currently selected template - you will see a 

confirmation message window - click Yes to delete or No/Cancel to not 

delete.

• Exit - click to close the Report Exporter screen once you have finished 

setting up and saving the report template.

• The other options: Email/FTP Server and Preview, are explained in the 

following sections.
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18.6.1: Email/FTP Feature

Once automatic reports are generated, it is important to get the reports to the appro-

priate people, as they are needed. Use the Email/FTP feature to send all of the reports 

generated by the Report Exporter software to an email or file location on a regular 

schedule. This fully automates the process of getting reports to the proper person or 

entity, so they can make informed energy management and business decisions. 

1. Click Email FTP from the right side of the screen.

2. To set up report email:

•  In the User Email Settings section:

a. Click the Enable Email Notification checkbox.

b. To send the report as an email attachment, click the Attach Report to Email 

checkbox.

c. Enter the person sending the email’s name in the Email User Name field.

d. Enter the email password in the Email User Password field. The password 

will be stored in an encrypted method, for security.

e. Enter the person sending the email’s email address in the Email From field.
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f. Enter the person receiving the email’s email address in the Email To field; 

multiple recipients can be configured by separating the addresses with 

semi-colon, as shown in the example above.

•  In the Host Email Settings section:

a. Enter the Email Host Server Fully Qualified Domain Name (FQDN) or IP 

Address name in the Email Host field.

NOTE: If you are using Gmail as your host server, there are additional 

considerations. See For Users of Gmail, on page 18-71.

b. Select the Email port number from the pull-down menu. Most email servers 

use Port 25 for SMTP (Simple Mail Transfer Protocol).

c. Select the number or retries for the email from the pull-down menu.

d. Select the retry timeout (in milliseconds) from the pull-down menu.

e. If the Email Server requires SSL security, click the checkbox next to the 

option.

f. Click OK to save your changes or continue to the FTP instructions.

•  Note that you can send a test email to confirm that the setup is working:

a. Click Test E-Mail.

b. Any messages related to the test email will be shown in the Test E-Mail 

Results box.

3. An FTP server provides a centralized network file storage location. Setting up an 

FTP server for makes it easy for multiple users to access the reports over an inter-

nal company network or an Internet-facing FTP server. For security reasons, we 

recommend that you don’t use an anonymous public FTP server. Access to an FTP 

Server and the proper credentials (i.e., username and password) for file upload and 

download are required to use this feature. The default FTP Port is Port 21. Please 

consult your IT department for the correct port and access credentials for your FTP 

server.
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• To set up an FTP server (IMPORTANT - this is not an SFTP server) for report 

access, in the FTP settings section:

a. Click the Enable FTP checkbox.

b. Enter the host name in the FTP Host field.

c. Select the FTP port number from the pull-down menu. 

d. Enter the FTP path in the FTP Folder Path field. Note that this field is case-

sensitive and the FTP folder name must be entered exactly the same as 

used for the destination FTP server. In addition, don’t use a forward slash 

at the beginning or ending of the path. See the following examples:

CORRECT PATH: agftp/reports

INCORRECT PATHS: 

              /agftp/reports

               agftp/reports/

             /agftp/reports/

e. Enter the log in name in the FTP Login Name field.

f. Enter the password for accessing FTP in the FTP Password field. The pass-

word will be stored in an encrypted method, for security.

g. Click OK to save your settings.

For Users of Gmail

Because of changes made to Gmail functionality, there are additional settings needed 

to use a Gmail account as the Host account in MeterManagerPQA® software.

You will need to set up an app password to use google authentication. Follow these 

steps:

1. Log in to your google account by entering https://myaccount.google.com/ in your 

browser.
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2.Click Security. 

3. Scroll to the section shown below. If you haven’t yet set up 2-factor authentication 

for your google account, click on 2-Step Verification. If you have set it up already, 

proceed to step 10.
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4. Click Get Started.
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5. You will be prompted to enter your google password again. Then click Next.



     Doc#    E107707                                               18-75

            18: MeterManagerPQA® Application

6. Select the phone you want to receive the verification code and click Continue.
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7. Enter a backup phone number, select to receive Text or a phone call, and click 

Send.
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8. Enter the verification code you receive and click Next.
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9. Click Turn On to finish setting up 2-factor authentication. Then use the back arrow 

next to the screen title to return to the Security webpage. 

10. Once 2-factor authentication is set up, you will see App Passwords under the two-

  step authentication setting. Click on the arrow to continue to the next webpage.
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11. You will be prompted to sign into your google account, again, and then will see

  the webpage shown below.

12. Select Other from the app pull-down menu and enter a name for this password. 

You can name it whatever you wish. It will be used to enable the gmail account as 

your host email account in MeterManagerPQA® software. Then click Generate.
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13. You will see the webpage shown below. 

14. Enter the password in the MeterManagerPQA® software’s Email Options setup 

screen, as shown below.
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18.6.2: Report Preview Feature

Use the Report Preview feature to: see what the report will look like before it is gener-

ated; add mathematical formulas to manipulate the data as needed, for example to 

get a total of energy use for a day; save the report to a file; copy the report data; 

generate a one-time, manual report.

NOTE: Report Exporter uses the PC's default system time format to display the time 

stamps in the report. If you need to override this setting, for example, if you are using 

a report internationally, you can customize your Report Exporter’s date time 

format. Follow these instructions:

1. From the Meter Manager Monitor, click >Configure>Report Exporter Options.

2. Check the box next to Override report date format and choose the date and time 

format you want to use for the report from the pull-down menus.

3.Click OK.
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1. To use the Report Preview feature, click Preview from the right side of the screen to 

open the Report Preview screen. See the example below. 

2. The icons at the top of the screen let you save, print, copy selected parts of the 

report to the clipboard, add formulas to the report, or change the date range of the 

report to generate a manual report. The options are:

•  (a) Export File (save).

•  (b) Print Report.

•  (c) Copy Selection.

•  (d) Formula.

•  (e) Report Dates.

•  (f) 

(a) (b) (c) (d) (e) (f)
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• Click the Export File icon to save a copy of this report.

• The path that is shown is the default path for the reports, but you can

 change that if you wish. 

• You can save the file as a .xlsx file or select .csv file type from the 

 pull-down menu.

• Click Save to save the file.
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• Click the Print Report icon to open a print preview of the report. See the example 

below.

• Click the Printer icon from the Print Preview screen to send the           

report to your default printer.

• Click the Zoom icon to expand the report display.

• Click the other icons to choose how to display the report preview, i.e., 

from one page to six pages.

• Click the Close button to close this print preview screen.



     Doc#    E107707                                               18-85

            18: MeterManagerPQA® Application

• To add a formula to the report, click the fx icon. You will see the Formula Builder 

screen, shown below. This screen lets you add formulas to a report template or a 

manually generated report.

• You can add two types of formulas: a column formula or a row formula, 

depending on the type of information you want for your report. The tabs 

at the top of the screen let you select Column Formulas or Row Formulas.

• The column formula takes data in one meter data channel (e.g., Volts A-

N) and performs a function (e.g., totaling) on all of the values in the 

column. 

For example, if this is a daily report, and you select the function AVER-

AGE, all of the hourly values for Volts A-N would be averaged to get the 
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result, which will be displayed at the bottom of that column in the 

report. 

• The row formula performs mathematical operations (e.g., add) on 

selected meter data channels (e.g., Volts A-N and Volts B-N) and/or 

constant values (e.g., 1).

• To add a column formula:

a. Click the Column Formula tab (this is the initial tab when the 

screen opens). Note that if column formulas have already been 

created, they will be shown on this screen.

b. Click the Add Expression button.

(a)

(b)

(c)

(d)
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c. The screen you see lets you build a new column formula. To create 

the formula, enter:

- Name (a): give the formula a name. This name will be used in

  the report.

- Function (b): select from the pull-down menu. The available

  functions for a Column formula are:

• SUM: total of the values in the column.

• AVERAGE: average value for the column.

• MIN(IMUM): smallest value in the column.

• MAX(IMUM): largest value in the column.

• STDEV (Standard Deviation): the standard deviation for the

 data in the column, which is a measure of the amount of 

 variation in the data in the column.

                             - Meter Channel (c): select the channel to perform the function on.

                               You can create a column formula for as many meter data channels

                               as are available, but you can only use one function per meter data

                             channel; i.e., you cannot add some of the Wh values, and take an

                             average of others.
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d. When you have entered your formula, click Add to accept it.

- Click Clear if you want to remove the entries you have made.

- Click Cancel if you want to return to the Stored Column Formulas

   screen without saving anything entered in the Build New 

   Formula screen.
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- You will see the Stored Column Formulas screen, showing your

   new formula. 

- Click the Add to Total box next to any formula whose result you

  want to add to a Columns total. See the example below.

   Note that the above fields are the same value because there is

   only one column formula in this report example.

Result of Column
Formula

Total of Result 
Columns
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- If you want to delete a formula, highlight it in the list and click

   Delete.

e. Repeat steps b-e to add additional column formulas.

f. If you want to add a Row Formula, continue to the next section. 

Otherwise, click Save to save the column formula(s) and see the 

Preview screen with the new fields displayed.

• To add a row formula:

a. Click the Row Formula tab.

b. Click the Add Expression button.
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c. With a row formula, you can perform multiple operations; for 

example, you can add two columns of meter data channels, add a 

constant value, and then subtract a third column of a meter data 

channel. The formula is applied across each data row of the 

selected columns in the report and the result is displayed in the 

rightmost columns in the report. To create the formula, enter:

- Name (a): give the formula a name. This name will be used in

  the report, for the new column.

- Type (b): click in this field and select Column or Constant from

  the pull-down menu.

- Meter Channel or Constant (c): depending on your type entry,

  either enter the constant you want to use or click in the field to

  select the column you want to use for the formula, from the

  pull-down menu.

(a)

(b) (c)

(d)

(e)
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- Operator (d): use the scroll bar to display this field and select the

   operator you want to use, from the pull-down menu. The 

   operations available for a row formula are:

• “+”: addition.

• “-”: subtraction.

• “*”: multiplication.

• “/”: division. 

d. Repeat selecting Type, Meter Channel or Constant value, and 

Operator until you have built the formula you want. Note that you 

cannot end a formula with an operator - the last line of the 

formula must have the Operator field blank. 

e. When you have finished entering the formula, click Add (e) to 

accept it. You will see the Stored Row Formulas screen with your 

new row formula listed.

- Click Clear if you want to remove the entries you have made.

- Click Cancel if you want to return to the Stored Row Formula

   screen without saving anything entered in the Build New 

   Formula screen.

f. When you have finished adding Row formulas, click Save to save all 

the column and row formulas you entered. The formula calcula-

tions will be performed and displayed in the report preview screen.

Note that the ability to save the report in a variety of formats allows you to perform 

additional calculations using the report data. For example, saving the report as an 

.xlsx file lets you add additional mathematical functions.

 Also, after a row formula has been added, the column that is generated with the cal-

culation becomes a new column that can be used in another row formula. 
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For example, the “Total Wh” row formula is set up to add the Interval Accumulators 

Wh Q1+4 and Wh Q 2+3.
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Then another row formula - “Total kWh,” is added to calculate the total kWh using the 

Total Wh column divided by 1000.

The example of the Report Preview screen is shown on the next page. The new row 

formulas are shown in the two rightmost columns.
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• Click the Report Dates icon to set the date range for a manual report.

       - You can either use the From and To date and time fields to choose

          the date range, or you can select one of the options listed on the

          screen, e.g., Last Week to Now, to select that range for the report.
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       - Click OK to implement your selection. The report will re-process and

         display the results for the new date range. You can then save the

         file and/or print the manual report.

3. Click the X in the upper right-hand corner of the screen to close the Report Preview 

screen.



     Doc#    E107707                                               18-97

            18: MeterManagerPQA® Application

18.6.3: Report Exporter Example

This section gives an example using:

•  A meter group containing two meters.

•  A Report Exporter script set up for a one hour interval.

•  Historical logs retrieved for the meter group.

1. Open the MeterManagerPQA® application.

2. From the Meter List screen, right-click on the meter group you want to create a 

report for, and select Report Exporter.
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3. Report Exporter opens.

NOTE: Common channels are stored measurements that are available for all the 

meters in the group.

a. Select report frequency, in this case, Monthly.

Note that the report Template Name and 

Heading fields change to reflect your choice.

b. Select the Export File Format, in this case 

Excel File (*.xlsx).
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c. Enter the Report Template Name, which is 

used for saving the report template, and 

the Report Heading, which will appear at 

the top of the report. 

d. The application suggests a starting 

date and time for the report. You 

can click on the up/down arrows 

next to the date and time to 

change the starting date/time. 

The Next Report Period Ends date display only, and is based on the starting date, 

time, and the report frequency. 

Note that you can set the starting date for the initial report period to any date 

for which there is available data. 



     Doc#    E107707                                               18-100

            18: MeterManagerPQA® Application

e. Available data points for the report are listed in the bottom, left of the screen. 

When you select a data point for the report, it is moved to the Selected Data 

Points list on the right. In this example, “Interval Accumulators: Wh Q1” and 

“Interval Accumulators: Wh Q4’ have been moved to the selected list.

f. Once the report is generated, it is saved in the folder shown in the Report 

Exporter screen, in the Exported Report File Name and Path field. You can also 

set up emailing and/or uploading of the report file to a network FTP server. To do 

so, click Email FTP on the right side of the screen. See 18.6.1: Email/FTP Fea-

ture, on page 18-69, for detailed instructions for this screen. 

g. You can use the Report Preview screen to add any formulas to the data. See 

18.6.2: Report Preview Feature, on page 18-81, for detailed instructions. 
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18.6.4: Report Exporter Troubleshooting

Following is a list of possible Report Exporter messages and steps to resolve any error 

conditions:

•  “Automatic Log Retrieval is Disabled for all Groups. Enable "Automatic Log 

Retrieval" in "System Options" for automated report generation”: since Automatic 

Log Retrieval is turned off for all meters, you cannot create a report with Report 

Exporter. To remedy this, click Tools>Configure>System>System Options from the 

MeterManagerPQA® application screen, un-check the Disable Automatic Log 

Retrieval checkbox, and click Save.

•  “Automatic Log Retrieval is Disabled for the Group: Group Name. Enable Automatic 

Log Retrieval in Configure Group Scripts for automated report generation”: since 

Automatic Log Retrieval is turned off for the selected group of meters, you cannot 

create a report for that group with Report Exporter. To remedy this, click Configure 

Group Scripts, select the desired group from the pull-down list at the top of the 

screen, check the "Retrieve Logs for this group" checkbox, select each log to be 

retrieved in the list below the checkbox, and click Save.

•  “No Historical Log data is available for the Meter: Meter Name. Retrieve the Meter 

Name Logs now?”: before you can create a report template, there must be histori-

cal log data for the selected meter. Click Yes to retrieve the logs from the meter.

•  “No Historical log data is available for: Meter: Meter Name; Group: Group Name. 

Retrieve "Meter Name" logs now?”: before a report template can be created to 

automatically generate reports, there must be historical log data for all of the 

meters in a meter group. This will be either the meter selected to create a report, 

or the first meter in a group of meters, for which there is no historical log data. 

Click Yes to retrieve the logs for that meter.

•  “WARNING! Group: Group Name; Report: Report Template Name. Group configura-

tion has been modified since report creation! Be advised report data may not match 

meters contained in the group. Edit this Report?”: note that a broken report icon 

This error occurs when the group that the report was originally created for has 

been modified in some manner since the report template was created. For exam-

ple, a meter was added to the group, or a channel was removed from one of the 
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logs. Click Yes to edit the report as needed, and then save the modified report 

template.

•  “Group: Group Name is included in the Report: Report Template Name. Edit this 

Report?”: you will see this message when a group of meters already has a report 

template configured for it. Click Yes to edit the existing report template; or, click No 

to create a new, additional report template for this group of meters. For example, 

you may need both weekly and monthly reports for the same meter or group of 

meters. 

•  “Group: Group Name; Meter: Meter Name is included in the report: Report Tem-

plate Name. Edit the Report for this Meter?”: you will see this message when a  

meter you are trying to create a report for is already included in a group’s report 

template. Click Yes to edit the existing report template that contains the meter; or, 

click No to create a new report template for this meter.  
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18.7: View Communications Quality of Service Analysis

This feature lets you analyze the quality of communications for the network and 

meters. You can use it to identify any problems occurring within the system’s commu-

nication infrastructure and with individual meters. 

•  The start and end of each connection session is logged, along with any communica-

tion and framework errors detected during the session.

•  Events are stored in rolling day files by connection, allowing logs to be quickly 

cleaned up based on connection or age. Note that only the previous 30 days of 

events are saved.

1. Double-click or right-click on a meter in the Meter List screen and select View 

Communications Quality of Service Analysis.

Note that you can also access the Communication Quality of Service Analysis 

screen by clicking Connections>View Communications Quality of Service Analysis.
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2. The screen shown below opens. From this screen you can get a quick overview of 

meters that are having communication problems, see how reliable the connection 

is, and view information showing how the software communicates with the meter. 

•  The grid in the middle of the screen (a) displays a list of all the meters in the sys-

tem, along with their group, an analysis of how good their communication is, 

and information about each connection session, including:

• Last Status: the current status of the meter, as of the last update for the 

current day. This can be one of Online, Offline, or Unknown.

• Reliability: an indication of how reliable communication with the meter is.

- Good: no problems found.

- Comm Issues: connections to the meter are successful, but errors

   were detected while communicating to it.

- Intermittent: while some connections failed, later attempts 

   succeeded.

- Offline: the meter is currently offline, and has been for multiple

   attempts to connect.

(a)

(b)

(c)
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• Online %: a percentage of how often connections with the meter 

succeed. 100% indicates the meter was able to connect 100% of the 

time.

• Sessions: the number of connection sessions recorded.

• Errors: the number of connection sessions which contain an error of one 

sort or another.

• Failed connections: the number of connection sessions which failed to 

connect to the meter.

• Communication Errors: the number of connection sessions which had a 

communication error after connecting.

• Session Events: the total number of communication events recorded 

across all connection sessions.

• Log Ret Window Retries: the number of times the log retrieval windows 

were retried due to an error.

• Log Ret Kbps Avg: the average kilobytes per second of data transfer 

during log retrieval; measured from the transferred log retrieval windows. 

•  Right-click on a meter in the list to see these options: 

• View Analysis File: this opens the connection analysis file for this meter.

• View Raw Events: this opens the Connection Session Viewer which shows 

the raw session events for this meter.

• Copy: copies the currently selected cells to the clipboard.

• Copy All: copies all the displayed cells to the clipboard.

•  The bottom of the screen (b) shows:

•Top 5 Offline: this view displays the five meters which have the worst 

online %.

•Top Communications Issues: this view displays the five meters which have 

the most communication issues.
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•Unknown Connections: this view lists all connections which failed to 

respond, or responded with an unknown device, and the last time they 

were tested.

• The top of the screen (c) gives you the following opti0ons:

• Refresh (the blue arrow on the top left): the Communication Analysis 

data is refreshed in the background, so clicking Refresh can reload the 

most recent data.

• Email Reporting - opens a screen you can use to set up emails of meter 

status and issues. See 18.11.4: Email Reporting Configuration, on 

page 18-156.

• Filters - lets you add additional data to the meter table, by displaying a 

menu with two options:

• Show Comm Counts - this view also shows Modbus communication

counts, such as which types of requests are made, in the grid.

• Show Error Counts - this view also shows the raw communication error 

counts in the grid.

• View Sessions: this opens the Connection Session Viewer to display the 

raw session events for the meters. When the Connection Session Viewer 

is opened, it may take a while to load all of the events. A progress bar is 

displayed while events are being loaded. If you select Cancel, all of the 

connection sessions loaded so far will be displayed. See the example 

screen below.

• Once loaded, all of the meters and connections found are displayed. The 

number of events found and a count of the errors that occurred during 

those sessions is displayed for each connection.
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• You can click the plus sign next to a meter to view a list of connections
 for the meter by initial connect date, along with the computed
 duration of the event, and the number of events and errors found in the 
 session. 

• You can click on one of the connections to view the list of events for that
 session, flagging any errors. See the example screen, below.

• Additional commands/options for this screen are: 

- Refresh (blue arrow): this reloads the Communication logs.

- Filters: the Filters menu is shown here:

      - Devices Only: this selection shows only connections which

         have a matching discovered device. Un-checking this option will

         show unknown devices, which can be useful for debugging invalid
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         connections.

      - Errors Only: this selection shows only sessions which contain

         errors. See the example screen below. You can narrow down your

         selection to specific TCP errors, Modbus errors, Dev(ice) errors, or

         all errors.

     - Search Box on the right performs an exact string search on the

        meter name, connection, context, action, code, and data fields.

        This option is useful for rapidly finding specific errors, or all meters

         in a specific subnet. Press enter to start the search, and clear the

         box to remove the search filter.

       For example:

        _REJECT will show all sessions which the TCP connection has

        rejected.

        172.20.166 will show all meters in the 172.20.166 subnet.  

        tcp.read will show all sessions which had errors reading from the

        TCP interface.
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• Some common connection errors are shown in the table, below.

3. To view communication analysis for a specific meter, click on the meter name in the 

Communication Quality of Service Analysis screen. 

•  The bottom portion of the screen changes to show data for the meter you chose:

• Percent Online: this summarizes the number of Connection Sessions 

which were Good (Online), Failed to Connect (Offline), or contained com-

munications issues (Errors).

• Comms Issues: this summarizes the count of communications issues in 

the categories of TCP Errors, Modbus Errors, and Device Errors.

Context Action Code Data Description

tcp.connect CONN_CONNECT TCP_CONNECT_TIMEOUT No response during connect.

tcp.connect CONN_CONNECT TCP_CONNECT_REJECTED The meter rejected the connection.

tcp.connect CONN_CONNECT TCP_INVALID Host not known The computer doesn't know how to reach 
the destination address. Verify that it is a 
valid address.

tcp.read MSG_READ TCP_OTHER WSAETIMEDOUT Connect was successful, but a read request 
timed out waiting for a response.

tcp.read MSG_READ TCP_CONNECT_TERMINATED The connection was terminated while trying 
to read from the device.

SCAN_KNOWN DEV_LOOKUP DEV_UNEXPECTED_DEV (id) When querying the device id at the specified 
connection, the device found did not match 
what is recorded in the MeterManagerPQA® 
application.
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• Last 5 Issues: this displays a summary of the last five issues detected for 

this meter, and when they occurred.

•  If you click View Sessions in this part of the screen, you will see session informa-

tion for just this meter.

4. Close the Communication Quality of Service Analysis to see the screen youwere on 

when you opened it.

18.8: Show Phasor

CommunicatorPQA® software has a polling screen that shows Phasor information.

1. Double-click or right-click on a meter in the Meter List screen and select 

Show Phasor.

2. The Phasor polling screen opens. See 5.4.1: Poll Phasors, on page 5-56, for infor-

mation on the Phasors screen.
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18.9: View Webpage

EIG meters with Ethernet communication offer a web server application that lets you 

view meter readings a standard Internet browser.

1. Double-click or right-click on a meter in the Meter List screen and select 

View Webpage.

2. The meter’s webpage opens in your computer’s browser. Note that the webpage 

uses the port configured in the Meter Configure Scripts screen. See 18.5.1: Config-

ure Meter Scripts, on page 18-33 for instructions, if the port being used is other 

then port 80. See the meter’s User Manual for more information on the meter’s web 

server.
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18.10: Scripts

The MeterManagerPQA® application runs automated scripts for meter discovery. It 

also lets you set up scripts that automate log retrieval for a group of meters or an 

individual meter. This makes it easy to manage trending for large groups of meters, 

by eliminating the need for manual retrieval of logs.

Another use of automated log retrieval is to easily build the EnergyReporterPQATM 

application’s usage database, which is used for usage reporting and analysis. For 

more information on the EnergyReporterPQATM application, see the EnergyReporter-

PQATM Application User Manual.

Note that when a meter's log database gets too large, archiving it makes room for 

new data. The MeterManagerPQA® application can automatically compress and 

archive the log database before retrieving logs, so that the database only contains 

new data. See 18.11.1: System Options, on page 18-142 to learn how to configure 

log archiving.
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1. Click Configure Group Scripts from the top of the Meters List screen.

2. Select a group from the pull-down menu (a). The meters in that group are dis-
played in the box on the left (b) (see example screen above).

3. Make sure the box next to Retrieve logs for this group is checked (c). The Retrieve 
Log box also tells you the frequency of log retrieval. The default log retrieval 
interval is every 12 hours. You can set the log retrieval interval to any time you 
want, from every hour to once every 30 days. EIG recommends every 12 hours as 
optimal, unless you require a more frequent update.

•  Check the Retrieve from Meters One at a Time box if you want logs to be 

retrieved serially from meters, rather than in parallel from all meters. This 

option is ideal for working with meters on a daisy chain.

(a)

(b)

(c)
(d)

(e)

(f)

(g)

Meter

Connection

Detail
    of
Connections
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a. To change the log retrieval interval click the Configure button in the Retrieve 

Logs (d) box. The screen shown below will open. 

b. Make sure the boxes are checked next to any of the logs you want to retrieve for 

the group (e).

4. The Resets section (f) is used to schedule a download of peak Demand and/or 

usage values and then to set the values back to 0. The values are downloaded into 

a .csv file located in:

 C:\Users\Public\Documents\Electro Industries\Communicator_Ext\Retrieved 

Logs>Reset_Logs; the filename is <meter_serial>_<meter name>.processed.csv. 

Each time a reset occurs, another line is added to the file, along with a timestamp.

a. You can select to enable Max/Min reset by checking the box. 

Click to select: Interval - to set up interval log 
retrieval; Time* - to set a specific log retrieval 
time; Manual - to perform a manual log 
retrieval, e.g., to test the system; or Multi-Time 
- see Changing Log Retrieval Interval screen, on 
page 18-21, for instructions.

Click to set interval 
for log retrieval.

Click Apply to 
save the new 
interval.



     Doc#    E107707                                               18-115

            18: MeterManagerPQA® Application

b. The download/reset frequency default is every first of the month, but you can 

configure a new time or interval by clicking the Configure button. The window 

shown below will open.

• To download/reset at a specific time: select Time from the Type pull-

down menu; select the Frequency - Monthly, Weekly, or Daily, and the 

time of day for the download/reset.

- If you selected Monthly, you will see the additional settings shown

  above. Select either “Every” and the day of the month (for example,

  Every 1st of the month) or “The” and number and day (for example, 

  The last Thursday (of the month).

- If you selected Weekly, there will be a pull-down menu that lets you

  select the day of the week to perform the download/reset.

- If you selected Daily, you just need to enter the time of day.

• To download/reset at a specific Interval: select Interval from the Type 

pull-down menu and select the hour and minute interval (for example, 

06:00 to perform the download/reset every 6 hours.

• To download/reset manually, select Manual from the Type pull-down 

menu. Note that you must also set up the download/reset with either a 

Time or Interval setting. Manual allows you to perform the download/

reset at will, rather than waiting for the programmed time/interval.

c. When you have made your selections, click Apply.
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d. The download/reset will take place as scheduled. If you selected a manual down-

load/reset, go to the Scripts Status screen, right-click on the Scheduled Resets 

script, and select Manually Run Script Now to perform the download/reset 

immediately. 

e. You can override the Reset settings for a meter within a group. to do so, go to 

Configure Meter Scripts for the meter and scroll to the Resets section of the 

screen.

i. Check the Override Group Setting box.

ii. If you are overriding the download/reset completely, you don’t need to select 

   anything else. To override the Group setting and select one or both of the Min/

   Max and Demand download/resets, check the appropriate boxes. 

iii. Click the Save button.

NOTE: All meters in the group will adhere to the same schedule for download/

reset that was configured in step b.
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5. Software Time Synchronization (g) is used to set up Time Sync for all of the meters 

in a group. The Time Sync feature allows for tracking the time difference of meters 

from the MeterManagerPQA® application server. When Time Sync is enabled, it 

also sets the meter’s time when it drifts beyond a configured threshold. Scanning 

the meters’ times is done automatically - no configuration is required. Note that if a 

meter is configured individually for Time Sync, that will take precedence over the 

group setting (see 18.5.1: Configure Meter Scripts, on page 18-33). 

NOTE: For Time Sync to work automatically, the online scan must be enabled by 

checking the Enable Scan box in the Meter Discovery Configuration screen- see Add 

Meters Using Meter Discovery Configuration, on page 18-23 for instructions.

a. Check Enable software time synchronization to enable time sync for all 

meters in the group.

b. Select the Timezone Offset from UTC (Coordinated Universal Time). This 

will be applied to all meters in the group, unless they already have a time-

zone offset specified. 

c. The current timezone offset is listed, along with the adjustment factor 

(timezone difference), to assist in configuring the time. The Timezone Off-

set works by offsetting the PC time being compared against the meter.

PC Time Meter Time PC Timezone Meter 
Timezone Difference

2015/04/28 01:00 2015/04/28 01:01 -4 -4 00:01

2015/04/28 01:00 2015/04/27 23:01 -4 -6 00:01

2015/04/28 01:00 2015/04/27 23:01 -4 0 -05:59

2015/04/28 01:00 2015/04/28 05:01 -4 0 00:01

2015/04/28 01:00 2015/04/27 23:01 -4 disabled -01:59



     Doc#    E107707                                               18-118

            18: MeterManagerPQA® Application

                NOTES: 

• The UTC offset specified should be current daylight savings offset, if 

applicable. For example, for the eastern timezone of the United States, 

EST is -5:00, EDT is -4:00. If you are currently in Daylight Savings, 

specify -4, otherwise -5.

• The Allowed Time Drift is set in the System Options screen. See 

18.11.1: System Options, on page 18-142, for instructions. 

• Time Sync will be disabled for 12 hours before and after the DST transi-

tion time for the PC's current regional settings, in order to prevent 

updating the meter's time while it is automatically updating for its own 

internal DST transition times.

7. If you have changed anything on the screen, “Settings Changed” will be displayed 

underneath the Device Type, on the upper right of the screen. Click Save to imple-

ment any new settings.
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18.10.1: Script Status

The MeterManagerPQA® application gives you two ways to view the status of the 

configured scripts. 

•  You can view script status in the Meter List screen, where any meters with active 

scripts display “Running” in the Next Action field; and those with scripts scheduled 

to run display the time they will run in the Next Action field (see example screen, 

below).

•   You can view detailed status information of group scripts is in the Scripts 

Status screen, which is the MeterManager Monitor’s second main screen view (the 

first being the Meter List screen). 

1. To see the Script Status screen view, click the Script Status icon from the top of the 

Meter List screen view.

 

The time 
script will 
next run

Running Script

Script Status icon 
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2. You will see all script actions, as shown in the example screen, below.

  The screen shows all group script activity (script activity is not shown for meters not

  assigned to a group), including all configured meter log retrieval scripts; EnergyRe-

  porterPQATM application activity, such as Importing and Reporting; and the Meter-

  ManagerPQATM application system activity, such as Discovery Scan and Runlog

  Archiving.

•   The right side of the screen (a) lists the following information for each script:

• Script name, e.g., Online Scan

• Interval the script runs, e.g., 12:00:00 - every 12 hours

• The date and time the script last ran

• The script status, i.e., Running, or the date and time the script will next 

run

(a)

(b)
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• The progress of a running script.

•   The left side of the screen (b) gives you additional viewing options. Click on a 

script in the list to select it, and then click one of the following buttons:

• View Completed - click to view all log history for the script (see 18.10.2: 

View Script Logs, on page 18-124).

• View Errors - click to view all errors for the script (see 18.10.4: View 

Script Errors, on page 18-132).

• Acknowledge Errors - click to acknowledge all of the errors for all of the 

scripts - this will remove them from being displayed when View Errors is 

selected.

• Filter In-Progress - click to view only currently running scripts. The Filter 

In-Progress button changes to Show All scripts - click the button to return 

to the total scripts display.

• Show Meter Scripts - click to view only the configured meter scripts. The 

button changes to Show All scripts - click to return to the total scripts 

display.

• Pause Server - click to pause the server and stop all scripts. The button 

changes to Start Server - click to restart the server and continue running 

the scripts. 

•   The possible scripts are as follows:

• Runlog Archiving [internal.update.runlog.archive]: this script is used to 

clean up old logs by collecting the runlogs and archiving them to zip files 

if they are older than the configured number of days. If the feature is 

enabled, older runlog archives will be deleted after the configured number 

of days.

• Runlog Analysis [internal.update.runlog.analysis]: this script scans the 

runlog for errors, which, if found, are reported to the user when a script is 

completed.

• Updates Check [internal.update.check]: this script contacts the Updates 

server once a day to check if there are any available software updates. If 
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any are found, the user is notified the next time the Monitor software is 

opened.

• Report Exporter [report.exporter]: this script performs the automated 

generation of Report Exporter reports. It generates a report for every 

available period from the current report start date to the last available 

data retrieved from the meter.

• Online Scan [scan.known]: this script runs through all known meters and 

checks if the meter is offline or online by attempting to connect to it. If a 

meter is offline, the status is reported in the log, and if email notification 

is configured, a notification email is sent out.

• Meter Time Sync [meter.time_sync]: this script performs a software time 

synchronization for meters without a built-in time sync feature, such as 

IRIG-B or NTP. If the configured meter is more than 15 seconds off from 

the server’s PC time, the script attempts to synchronize the meter’s time 

with the PC’s time. The Meter Time Sync script works with the Online 

Scan script. The Online Scan script first determines if the time is off, and 

then Meter Time Sync updates any meters whose time is off.

• EnergyReporter Reporting [ebilling.reportgen]: this script automatically 

generates all the bills, executive summary usage reports, and custom 

usage reports for the EnergyReporterPQATM application. Note that reports 

will automatically be generated when new data is imported to the Ener-

gyReporterPQATM database.

• Energy Reporter Importing [ebilling.import]: this script automatically 

imports retrieved logs into the EnergyReporterPQATM database. Note that 

imports will automatically occur when a meter's logs are retrieved.

• Weather Import [ebilling.import.weather]: this script automatically reads 

the weather information from a weather service and logs it into the Ener-

gyReporterPQATM database.

• Discovery Scan [scan.ping]: this script automatically scans your network 

for new meters to add to the Meter List. You can configure the range the 
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script scans via Auto Scan and Tools>Configure>System>Meter Discov-

ery.

• Retrieve Logs [loc.{group}.retrieve.logs]: this script performs the auto-

matic log retrieval for each group. Note that Automatic Log Retrieval must 

be enabled globally, i.e., for the entire application, for this script to per-

form the log retrieval.

• Scheduled Resets [resets]: schedule a download of Peak Demand and/or 

usage values and then to set the values back to 0. 

•   Right-click on a script in the list to select from these script actions: 

NOTE: Not all actions are available for all scripts.

Click to run the script before the next programmed interval

Same result as View Completed button (18.5.1: Configure 
Meter Scripts, on page 18-33)
Stop a currently running script
Acknowledge and remove all errors for this script from the 
scripts log

Prevent this script from running 

Remove this script from the script’s list
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18.10.2: View Script Logs

1. To view script logs, either:

•   Click on a script and then click the View Completed button from the Script 

Status screen. 

•   Right-click on a script and select View Script Logs from the sub-menu. 

2. You see a screen that gives you access to detailed information.

•  The left side of the screen (a) lists:

• The time the script ran (Run Time).

• The amount of time the script took to run (Duration).

• The number of Errors, if any.

• A code related to the script results (Results) - you may need to scroll to 

see the entire Results column.

(c) (b)

(a)

(d)
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•The result code is unique to each script. For example: The EnergyRepor-

terPQATM script normally returns a 0; but if it had a problem during 

import, and failed to connect to the database, it might store 1 as its 

result code, 2 if there were errors in the data, or 3 if it failed to read the 

data.

•  The right side of the screen (b) shows details about the script (click on a script in 

the list on the left of the screen to view its details), and has two tabs:

• Overview tab (shown in the screen on the previous page): shows an 

overview of the script, with details of any errors: this is the first tab you’ll 

see on the screen. The right top of the screen view shows: 

•The internal Run ID number of the script.

•The script name.

•The time the script began running.

•The amount of time the script ran (Duration field).

•The number of events in the script run, which are steps in a script’s main 

actions, e.g., importing a log from an individual meter; you can click on 

the underlined number of events to see the Event Tree screen view (see 

the Event Tree and Raw Events tab descriptions for more information).

•The number of Main actions, which are the actions composed of events, 

e.g., Log retrieval for all meters in a group.

•The number of errors in the script run (see 18.10.4: View Script Errors, 

on page 18-132 for a description of script errors).

•Version of script, if applicable.

•Internal codes, such Results, Exit, and Warnings.
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•  Raw Events tab (shown below): 

The Raw Events screen view shows every event which occurred during 

the running of the script. Each event is timestamped, and may have one 

of the following types:

• Log - a log of occurrences during the running of the script.

• Info - displays information about what is taking place during the run-

ning of the script. You may disregard this field unless you are investigat-

ing a specific issue.

• Warning - displays problems which may have occurred during the 

running of the script, but which may be common (i.e., not something 

you need to address), such as retries on reading files, or an action that 

was attempted, but which is not supported.

• Error- displays problems which prevent the operation of the script, such 

as the meter being offline, unable to retrieve logs at this time, or bad 

values, such as invalid timestamps, being found in the log.
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•  The three icons at the top of the screen (c), from left to right, let you:

• Export All logs - click to save the script logs to a 

file. You will be prompted to name the file and 

choose a location for it. Note that the Document 

icon (d) in the right side of the screen lets you save the currently selected 

script log to a file.

• Filter by Errors - click to view only the errors in this log - see 18.10.4: 

View Script Errors, on page 18-132.

• Clear All Script Logs - click to clear the script log files for this script. 

WARNING! Clear All Script Logs will delete the script’s history. 

NOTE: The Clear All Logs function can be automated from Tools>Config-

ure>System>System Options - see 18.11.1: System Options, on 

page 18-142.

In general, most of the information on the right side of the Script Logs screens is 

diagnostic. For example:

•  The online scan will tell you when devices go offline, and when meters are con-

firmed to be online

•  Log Retrieval may tell you problems with the connection, or errors in the logs, or 

problems with the meter

•  The issues list will inform you of problems with the script, such as:

•  Meter offline.

•  Problem retrieving logs.

•  Errors in the log records.

•  Software locking up.
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18.10.3: View Import/Report Script Status

You can access information on the Energy Reporter Import and Energy Reporter 

Reporting scripts from the Scripts Status screen.

Double-click on the Import script or the Reporting script to see additional information. 

The screen you see will list current status and history of the script. See the example 

screen, below. 

•  The Import History screen shows: 

•  Import Status provides information about the imports currently being processed:

• Queue: number of currently pending imports.

• Status: the action being performed by the current import.
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• Device: if the meter being imported is connected to the Meter List, the 

device will be listed here.

• Meter: the meter currently being imported.

• Time Start: when the import started.

•  Import History provides information about the last 1000 imports that have been 

performed (this history will be reset when the MeterManagerPQA® application 

service is restarted):

• Import Start: starting date and time of the import.

• Device: same as above.

• Meter: same as above.

• Duration: the amount of time the import took to run.

• Data Start: the first timestamp of the data being imported.

• Data End: the last timestamp of the data being imported.

• Error#: any errors that occurred during importing are listed here.
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•  The Reporting History screen shows:

•  Report Status provides information about the reports currently being generated:

• Queue: number of currently pending reports.

• Status: the action being performed by the current report generation.

• Report Type: the type of report being generated: Bill, Usage Report, or 

Custom Report.

• ID: the customer or location the report is being generated for.

• Date Range: the range of data to be included in the report.

• Time Start: when the report generation started.

•  Report History provides information about the last 1000 reports that have been 

generated (this history will be reset when the MeterManagerPQA® application 

service is restarted):

• Generation Start: when the report generation started.

• ID: same as above.

• Report Type: same as above.
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• Report Scope: Specific Period, which means the report is being generated 

for a specific time range.

• Gen Duration: the amount of time the reporting generation ran.

• Report Period: the period this report was generated for. 

• Error#: any errors that occurred while generating the report are listed 

here. If there is more then one error, hover over the history item with 

your mouse to see the list of errors.

Some common errors are: 

• Generate Usage Report Failed [NOT_FOUND] - There is not enough data 

in the month to generate the Executive Summary Usage Report.

• Generate Bill Failed [MISSING_VALUE] - There is not enough data in the 

month to generate the Bill Report.
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18.10.4: View Script Errors

1. To view script errors, either:

•   Click the Filter by Errors button in the View Script Logs screen (see previous sec-

tion for instructions) 

•   Click on a script and then click the View Errors button from the Script Status 

screen 

2. You see the Script Logs screen described in the previous section (18.10.2: View 

Script Logs, on page 18-124). The only difference is that this screen only displays 

script error information.

3. To view an error, click on it in the left column of the screen (a). The right side of the 

screen will show details for the error in the Overview (b) and Raw Events screen 

views, as described in 18.10.2: View Script Logs, on page 18-124. 

•  Some possible script errors and their recovery information is as follows:

•   Updates Check [internal.update.check]: 

• “Failed to retrieve current version info from server [FAILED]”: this error 

is usually caused by being unable to connect to the server. Verify that 

the computer has access to the Internet, and is not behind a proxy 

server.

(a)

(b)
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•   Report Exporter [report.exporter]:

• “No Data for Period”: this error occurs when there is a gap in data for a 

meter or group. The may be caused by the meter being offline, or by the 

meter’s device profile being changed and the data channel no longer 

being available. Verify that the meter still has the channel configured in 

its device profile and that the data is available in the logs, via Log 

Viewer. Note that this error is not caused by the retrieval of logs from 

this meter not being “caught up,” since reports are only generated if 

there is newer data than that of the period of the report being gener-

ated.

•   Online Scan [scan.known]:

• “Device Offline”: this error occurs when the online scan tried to connect 

to a meter previously connected to, and failed. Check the following 

items:

- Check to see if the meter has gone offline: make sure the meter is

  operational and the connection is OK.

- If multiple meters have gone offline, check to see if their segment of

  the network is operational.

- If the server loses network connections, you may see all of the meters

  go offline, since the server can no longer contact the meters. 

- If there are meters that go offline frequently, they may have unreliable

  network connections, such as wireless connections. Verify that the

  connection is stable and reliable, and does not drop communication

  packets.

•   Meter Time Sync [meter.time_sync]: 

• “Device described by connection does not match Device Info, not updat-

ing”: this error occurs when time sync finds a different meter than it 

expected. Verify that the meter at the specified connection is the correct 

one, and that the network does not have multiple meters with the same 

IP address. Note that this message is informational only, the error will 

be corrected by the Online Scan script.
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• Meter time not updating: if the meter’s time doesn’t seem to be updat-

ing even though time sync is configured, and the runlog says that time 

update is being attempted, verify the following:

- That the meter doesn’t require login to set time, and if it does, that the

  correct username and password have been entered.

- That the meter doesn’t have any other time sync protocol connected,

  since multiple time synchronization methods cause problems in the

  meter time.

- That Online Scan is enabled (this is necessary for Meter Time Sync).

•  Weather Import [ebilling.import.weather]:

• “Failed to query weather info. SocketException: A connection attempt 

failed because the connected party did not properly respond after a 

period of time”: this error means that the application failed to connect to 

the weather service; try connecting, again, later.

• “Failed to query weather info. XmlException: Data at the root level is 

invalid”: this error means that the data returned from the weather ser-

vice is not valid; try connecting, again, later.

• “Failed to query weather info. WebException: The remote name could 

not be resolved”: this error means that the DNS lookup could not find 

the weather service URL; verify that your DNS or Firewall is not blocking 

the URL.

• “Failed to query weather info. Bad Gateway”: this error means that the 

network gateway on the machine was invalid; verify that the computer’s 

network connection is configured correctly.

•   Discovery Scan [scan.ping]

• Meters not found: if the Discovery Scan does not detect a meter that 

you know should be there, use one of the following options: 
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- Make sure the meter can be pinged. The Discovery Scan pings the IP

  address before attempting to connect, and if it gets no response, it will

  not try to connect to the meter.

- Manually connect to the meter. If this fails, make sure the meter is

  actually online.

•  Retrieve Logs [loc.{group}.retrieve.logs]:

• The script runs, but no logs are retrieved; verify that Automatic Log 

Retrieval is enabled.

• “Connection Failed to: {connstr}”: this error indicates the meter may 

not be online; verify that you are able to connect to the meter.

• “Failed to create log retrieval session [CONNECTION_TIMEOUT]”: this 

error indicates the meter may not be online; verify that you are able to 

connect to the meter.

• “Failed to create log retrieval session [INVALID_TYPE]”: this error indi-

cates that log retrieval is not valid for this meter. If the meter doesn’t 

support logging, disable Automatic Log Retrieval for the meter.

• “Failed to create log retrieval session [CE_CNORESP]”: this error indi-

cates the meter may not be online, or may not be responding to Mod-

bus; verify that you are able to connect to the meter.

• “Failed to open location [CONNECTION_LOGIN_FAILED] {connstr}”: 

this error indicates a Nexus® 1500/1500+ meter may not be online; 

verify that you are able to connect to the meter.

• “Connection failed, unable to login with user ‘’”: this error indicates a 

Nexus® 1500/1500+ meter requires a username and password to 

retrieve logs, but none was supplied. Go to Configure Meter Scripts > 

Scripts Settings, enable security, and specify the username and pass-

word (see 18.5.1: Configure Meter Scripts, on page 18-33).

• “Connection failed, unable to login with user ‘user’”: this error indicates 

the username or password specified for a Nexus® 1500/1500+ meter is 
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invalid, and the software was unable to log in. Go to Configure Meter 

Scripts > Scripts Settings, and verify that the correct username and 

password is entered (see 18.5.1: Configure Meter Scripts, on page 18-

33).

• “Invalid record (#) timestamp: {time}”: this error indicates that Log-

Converter detected that there was a problem with one of the time-

stamps recorded in the meter.

• “Unable to retrieve log [#], port # is already retrieving a log”: Shark® 

200 meters and MP200TM metering systems allow only one user at a 

time to retrieve logs. Since the meter has multiple ports, this error indi-

cates that another software may already be retrieving logs from the 

meter; in this case, you can try again, later. If the message itself is in 

error, and there is no other software retrieving logs from the meter, ver-

ify that there are no other MeterManagerPQA® applications installed on 

your network.

• “Unable to engage log, log failed to engage after 10000ms”: Shark® 

200 meters and MP200TM metering systems allow only one user at a 

time to retrieve logs. This error indicates that another software may 

already be retrieving logs from the meter on the same network connec-

tion; in this case, you can try again, later. If the message itself is in 

error, and there is no other software retrieving logs from the meter, ver-

ify that there are no other MeterManagerPQA® applications installed on 

your network.

• “Username and password not specified, unable to login”: the Shark® 

250/270 meter requires a username and password to retrieve logs. this 

error indicates that the username and password were not supplied. Go 

to Configure Meter Scripts > Scripts Settings, enable security, and spec-

ify the username and password (see 18.5.1: Configure Meter Scripts, on 

page 18-33).
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• “Retries exceeded setting waveform record window: NOT_READY”: or  

“Currently engaged log {log1} is not the one desired {log2}”: the 

Shark® 250/270 meter allows only one user at a time to retrieve logs. 

Since the meter has multiple ports, this error indicates that another 

software may already be retrieving logs from the meter, and you can try 

again, later. If the message itself is in error, and there is no other soft-

ware retrieving logs from the meter, verify that there are no other 

MeterManagerPQA® applications installed on your network.

• “Bad record crc bit set in timestamp”: this error indicates that LogRe-

trieval detected that there was a problem with one of the timestamps 

recorded in a Shark® 250/270 meter.

• “Invalid timestamp found while scanning for partial records [#]": in 

order to perform partial log retrieval for the Shark® meters, the soft-

ware must search for the last record retrieved. If it finds an invalid time-

stamp during this process, it must retrieve all the records.

•“OutOfMemoryException,” “Out of Memory,” “Error # 7,” or “Log Con-

verter: Not enough memory to run; quitting”: this error indicates that 

too many applications are running for the server to handle. Either 

decrease the number of applications, or increase the server memory.
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18.10.5: Manually Run Scripts

You have the ability to force a script to run. You might want to do this in order to test 

the script.

1. From the Script Status screen, right-click on a script and select Manually Run Script 

Now.

2. The Script’s status will change to Running and its Progress will be shown.

18.10.6: Acknowledge Script Errors

Errors remain in the script logs even after they are acknowledged, but the red high-

lighting and exclamation point are no longer shown in the Script Status screen, and 

the errors are highlighted in pink, rather than red, in the Script Logs screen (see the 

example below). For this reason you may not want to acknowledge the errors even 

after you’ve viewed them, e.g., if you want someone else to see them before they are 

acknowledged. 
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If you have viewed script errors and do want to indicate that you have viewed them, 

you have two options: 

•   Acknowledge all script errors:

a. Click Acknowledge Errors from the left side of the Script Status screen (a). 

b. You are asked to confirm your choice (b): click Yes to acknowledge all of the 

errors; click No to leave the errors unacknowledged. 

   

(a)

(b)
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•   Acknowledge errors for a specific script:

a. Right-click on the script in the Script Status screen and select Acknowledge all 

Errors. 

b. You will be asked to confirm that you want to acknowledge the errors. Click Yes 

to acknowledge the errors for this script; click No to leave the errors unacknowl-

edged. 
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18.11: Configuration Tasks

From the top of Meter Manager Monitor, click Configure in the Menu Bar. You will see 

this sub-menu.

•  Meter Discovery is explained in 18.3.1.1: Add Meters to the Meter List Using Auto 

Discovery, on page 18-18. 

•  Security is explained in 18.2: Setting up Security, on page 18-3.

•  Landis + Gyr Report Templates are explained in Appendix F: Landis + Gyr Custom 

Reports, on page F-1.

The other options are explained in the following sections.
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18.11.1: System Options

The System Options screen allows a user to configure base settings for the MeterMan-

agerPQA® application as a whole.

1. Click Configure>>System Options.

2. System Options has five tabs: Configurations, Paths, Polling, Log Retrieval, and Log 

Archive. 

3. The first tab lets you set up Script configurations. Make the following settings:

•  Minimum Trigger Interval - click the arrows to set a minimum log retrieval inter-

val time. This prevents any user from setting log retrieval to be more frequent 

than this value, e.g., four hours (04:00). Click in the hours field to set hours, 

and in the minutes field to set minutes.

•  Max Concurrent Downloads - click the arrows to set the largest number of down-

loads that can be made at one time by currently running scripts. Use this setting 

to make adjustments for your computer’s capacity. For example, for a computer 

that has lower resources you might want to set this to 1, so as to not overload 
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the server. On a powerful machine, this can be set higher; however do not set it 

any higher than 10.

•  Disable Automatic Log Retrieval - unless this computer is the Log Collection 

server, leave this box checked (see 18.3.1.1: Add Meters to the Meter List Using 

Auto Discovery, on page 18-18).

•  Delete Old Script Run Logs - when you click this checkbox a field opens that lets 

you select the number of days to keep script logs before they are deleted.

WARNING! Deleting the script logs will delete the history of the script.

•  Disable Update Check Script- check this box to disable automatic update of the 

software.

•  Meter Configurations: Allowed time drift - select the amount of time, in 

seconds, that will be considered an acceptable time difference for meters using 

the Time Sync feature - see 18.5.1: Configure Meter Scripts, on page 18-33 and 

18.10: Scripts, on page 18-112 for details on Time Sync. Anything greater than 

this time will be corrected. 

IMPORTANT! This value should not be set less then 5 seconds, as it may result 

in the accuracy of the meter's time being made worse.
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4. Click the Paths tab to enter the directory paths for the CommunicatorPQA® appli-

cation, the LogViewerPQA application, and the Archived Logs files. This only needs 

to be changed if the CommunicatorPQA® application was installed in a non-default 

location. 

You can also use this setting to map a drive that can be used to store retrieved logs 

on a network drive. This lets you free space on the drive where the MeterManager-

PQA® application is located. To map a drive, make these settings:

•  Select the mapped drive from the pull-down menu and enter the path in the 

“mapped to” field (the default of this setting is Disable).

•  If the mapped drive is secured with a username and password, enter them. Note 

that due to operating system limitations, passwords cannot be more than 14 

characters.

•  Override existing drives - if this box is checked, if the MeterManagerPQA® appli-

cation tries to connect to the mapped drive and the drive has already been 

mapped, but to a different path than the one you have configured, the Meter-

ManagerPQA® application forces a connection with the (new) mapped drive.
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•  Click Map Drive to immediately map the drive. If the drive is unavailable, the 
message at the bottom of the screen will indicated that. Otherwise, the message 
says that the mapped drive is connected.

•  Click Unmap Drive to immediately un-map the drive.

•  Once the drive settings are saved, the MeterManagerPQA® application automat-
ically reconnects the mapped drive whenever the PC is rebooted. In addition, the 
MeterManagerPQA® application periodically checks if the mapped drive is con-
nected, and reconnects to it, if necessary. 

5. Click the Polling tab to enable data polling for the Shark® 50 and Shark® 100 

meters. 

•  To enable polling, check the box. The data polled will be available for the EnergyRe-

porterPQATM application and viewable in the Log Viewer - see 18.5.4: View Meter 

Logs, on page 18-44.

•  Once enabled, the Software Poller will log the following readings every 15 minutes:

•  Voltage A-N/B-N/C-N
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•  Voltage A-B/B-C/C-A

•  Current A/B/C

•  Frequency

•  Voltage A/B/C THD%

•  Current A/B/C THD%

•  Voltage A/B/C Phase

• Current A/B/C Phase

•  W/VAR/VA Total

•  Wh (Q1+4)/(Q2+3)

•  VARh (Q1+2)/(Q3+4)

•  VAh (Q1+2+3+4)

NOTES: 

•  IMPORTANT! The Software Poller polls and logs the values as quickly as it can, so 

that values are polled as closely as possible to the 15 minute interval. Under noisy 

conditions or with many meters, there can be a significant delay between the inter-

val and the time that the value is actually polled: in some cases the delay can be 

more than a minute. Because of this, the Software Poller cannot guarantee the 

same level of data integrity as a meter with logging, and should not be used for 

critical systems, such as Billing.

•  The MeterManagerPQA® application offers a diagnostic screen that shows the sta-

tus of the software polling process. To access the screen, click Help>Tech 

Tools>>Poller Status. This screen is most helpful for technical support purposes.
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6. Click the Log Retrieval tab to configure specific settings for log retrieval and file 

output. 

•  Check the first box (a) to enable retries when an error is detected that has blocked 

log retrieval and select a time after which log retrieval will be retried from the drop-

down menu. When enabled, Retry Log Retrievals on Errors causes the MeterMana-

gerPQA® application to scan the runlogs of Log Retrieval scripts after they have 

completed. If it finds an indication that retrieval was blocked, such as another log 

retrieval session was already in progress, that meter (and only that meter) will be 

marked for retrying log retrieval at a later time.

NOTE: This feature only detects retrieval issues with the Shark® 200 meter at the 

current time.

•  Normally, the log retrieval limits are applied to retrievals within any one group. 

Check the second box (b) to apply the log retrieval limits to all retrievals across the 

entire MeterManagerPQA® system.

•  Check the third box (c) to enable Split Log Retrieval, which causes all log retrievals 

to be performed in a separate process from the MeterManagerPQA® service. While 

(a)

(b)

(c)
(d)

(e)
(f)

(g)
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this setting takes a small amount of extra system resources, it ensures that the log 

retrieval is isolated from the MeterManagerPQA® service, and will not impact it. 

Note that this is automatically configured for the Nexus® 1450/1500/1500+ 

meters, regardless of whether or not the box is checked.

•  Check the fourth box (d) to display a popup screen during a manual retrieval. The 

screen allows you to configure the range of data and the specific logs to retrieve.

•  When the settings in the Output section are enabled by checking the box next to 

Override Defaults (e), CSV and Replay files are created as part of log retrieval. 

•  Check the box to enable the CSV output (f) if you are automating integration 

with another system.

•  Check the box to enable Replay output files (g) if you need them for debugging 

or conversion at a later date. 

• Note that these files can use up a lot of disk space, so make sure to set 

the Delete After option.
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7. Click Log Archive to enable automatic archiving of meter data logs. This ensures 

that only recent data is stored in the meter log database. When the data is 

archived, it is compressed and sorted at the configured Archived Path location set 

in the Paths tab. While this data cannot be used with exporter softwares, it will still 

be accessible from the LogViewerPQA application. 

•  Check the Enable Log Data Archiving box.

•  Set the number of months that log data will remain before it is archived. 

•  Once this option is enabled, the group’s log archiving limits set up here will auto-

matically be checked after log retrieval. Any data which is older than the configured 

range will be archived to a compressed file in the Archived Logs folder configured in 

the System Options screen’s Paths tab, explained earlier.
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•  The file will be named for the range of data it contains:

[metername]__[meterserial]\[metername]__[meterserial].[oldestdate]_[newest-

date].zip

For example, if the MeterName was 1800ShamesDr, the Serial# was 0123995130, 

and the database contained log data from 2023/01/08 to 2023/08/25, the archive 

might be:

C:\Users\Public\Documents\Electro Industries\Communicator_Ext\Retrieved 

Logs\log_archive\1800ShamesDr__0123995130\1800Shames-

Dr__0123995130.20230108_20230825.zip

•  A record of the archive will be entered in the Retrieve Logs Script runlog for that 

group.

8. Click Save.
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18.11.2: Language Tasks

This feature allows you to select the language the software will use. It also lets you 

create a new language file for the software. Note that the only embedded language is 

English.

1. Click Configure>Language from the Meter Manager Monitor screen’s Menu bar.

2. Select one of the available languages from the pull-down menu. You can click 

Language File Information to view details of the selected Language file.

3. To add a new translation, click the Create New Language button.
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4. Enter the language name and click OK.

5. Use the screen shown above to enter the translations. You enter the translation in 

the Translation column for each term in the Phrase column. See the example screen 

on the next page.
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6. When you have finished entering the translations, click Save Changes to save the 

language file.
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7. The Language screen is redisplayed. Select the language you want to use from the 

pull-down menu and click OK. You will see the following confirmation window. 

8. Click Yes. The software will shut down. Open it again to display the translated appli-

cation.
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18.11.3: ReportExporter Options

ReportExporter Options lets you perform a global change to the date and time format-

ting for all ReportExporter-generated reports.

1. Click Configure>ReportExporter Options from the Meter Manager Monitor screen’s 

Menu bar.

2. Check the Override report date format box and select the date and time format you 

want to use for all of the reports from the pull-down menus.

3. Click OK to implement your new date and time settings for ReportExporter-gener-

ated reports.
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18.11.4: Email Reporting Configuration

It is important to be notified if there is a script error or if a meter goes offline. The 

MeterManagerPQA® application lets you generate an email whenever there is a script 

error and/or whenever a meter goes offline. This feature alerts you to problems when 

they arise, so that you can respond to them quickly.

1. To set up email for MeterManagerPQA® software problems, click Tools>Configure>

System>Email Reporting.

2. Enter:

•  The Host (Server) email settings: Host, Port, User, Password.

NOTE: For gmail host server settings, see For Users of Gmail, on page 18-71.

•  SSL: if the email server you are using requires SSL security, check this box.

•  The From and To Email Addresses 

•  Reporting options: check the boxes next to the following options to implement 

those selections:

• Enable Email Reporting of Script Errors - an email will be sent if a script 

encounters an error, e.g., if an error occurred while trying to convert a 

meter's logs, or it failed to retrieve a meter’s logs.
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• Enable Email Reporting When Meters Go Offline - an email will be sent if 

connection to a meter is lost.

• Enable Email on Time Synchronization - an email will be sent when time 

is synchronized for a meter.

•  Enable Email Reporting When Meter is Offline for a Period.

•  Enable Email Reporting When There’s New Software Update. 

3. Click Test to send a test email.

4. Click Save to save your settings.

18.12: Connections Tasks 

Click Connections to see this sub-menu.

•  Manually Connect is explained in 18.3.1.2: Add Meters to Meter List Manually, on 

page 18-28).

•  View Communications Quality of Service Analysis is explained in 18.7: View Com-

munications Quality of Service Analysis, on page 18-103.

The other options are explained in the following sections.
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18.12.1: Test All Connections

Click to test all of the meters to see if they are active. You will see the screen shown 

below as this process takes place. 

Click this 
button to 
stop the 
testing
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18.12.2: Import Connections

A window will open prompting you to find the .csv connections file that you want to 

import. See the next section - Generate Connections List. for more information.

•  During import, only the Group, Connection Str, and Meter Notes columns are used. 

All other fields will be automatically queried from the meter during meter discovery.

•  In fact, the import file only needs to contain the "Connection Str" column. All other 

columns are optional.

NOTES: 

•  The new file format requires that the header be included, and thus will not work 

with any older imported files that were created with an

 earlier version of the MeterManagerPQA® application.

•  The network connection string must be prefixed with "mn://", which

 indicates that a Modbus network connection is being specified. A

 serial connection can be specified with "ms://", such as 

 "ms://COM29:57600,8,N,1".

18.12.3: Generate Connection List

Click to save a list of the meter connections to a .csv file. You will be prompted to 

select a location for the file. The file will contain the following fields:

•  Serial Number - the unique identifier of the meter

•  Display Name - the meter designation programmed in the meter

•  Device Type - the type of the meter, e.g., Shark® meter

•  Connection Str - the connection information used to connect to the meter. Note that 

a single meter may have multiple connection entries

•  Connection Status - the current status of the connection

•  Last Active - the last time the software successfully connected to the meter

•  Last Updated - the last time the software tried to connect to the meter
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Once you have exported the list, you can make changes to it and then use the Import 

Connections feature (previous section) to import it back into the application.

18.12.4: Remove All Offline Connections

 Remove All Offline Connections - click to remove connections to meters that are 

offline. Since this will also remove the meters, you will be asked to confirm. 

Click Yes to remove the offline connections and meters; click No to leave them.
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18.12.5: Manual Network Scan

This feature is used to perform a parallel network meter scan. While the recom-

mended method of meter discovery has already been explained (see 18.2.1.1: Add 

Meters to the Meter List Using Auto Discovery, on page 18-12), this method may be 

preferred for very large networks with many meters to discover, as it is discovers 

meters more quickly due to: 1. the scan being run in parallel mode, and 2. there 

being no speed limiter, as with Auto Discovery. It also has the advantages of being 

manually begun whenever you want and allowing you to see the progress of meter 

discovery. Note that this will only detect meters at address 1, listening on Modbus TCP 

Port 502.

1. Click Connections>Manual Network Scan.
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2. Enter the IP range to scan in start/end address and click the Plus button to add 

them to the scan list.

3. Select the number of parallel worker scans to use. This lets you scan multiple sep-

arate ranges of IP addresses. The example uses ten scans.

4. Scan Type is either Ping or TcpConnect:

•  Ping: a ping is first performed to make sure that a device is there to connect to. 

This method of scanning is faster than TcpConnect, but it may not work if the 

device or network doesn't allow pinging. You have the option of increasing the 

ping timeout to accomodate discovery of slow devices, but this will slow down 

the scanning time, significantly.

•  TcpConnect: this scan is performed by opening a TCP connection to port 502. 

This is a very slow method, as each connection must wait the full 30 seconds 

(minimum) TCP timeout before giving up.

5. Click Start to begin the scan. 

•  Each scan displays its current status on the top right of the screen. 

•  Discovered meters are displayed on the bottom of the screen.

•  The scan progress is displayed next to the cancel button. 

•  Click the cancel button at any time to abort the scan. Note, if the software is 

attempting to connect to a meter at that time, the scan may continue for a short 

time after you click the Cancel button.

•  All discovered meters will automatically be added to the Meter List, in the Unas-

signed Group.

6. When you are done, click the X in the upper right-hand corner of the screen, to 

close it.
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18.13: Search Meters

The Search Meters feature lets you perform functions on multiple meters at one time, 

as well as to find specific meters in a large list of meters. To open the Meter Search 

screen, press Ctrl+F from anywhere in the Meter Manager Monitor.

1. This screen gives you the following search options:

•  The bar at the top of the screen is a string comparison against all meter fields, 

including meter name, serial, group, connection, meter type, and notes. You can 

enter any value in it that you want to search on.

•  Serial - enter part or all of a serial number.

•  Name - enter part or all of a meter name.

•  Meter Type - select the meter type from the pull-down menu.

•  Online status - select Online, Offline, or Inactive (if the meter’s last connection 

activity is more than a day ago, it is considered inactive) from the pull-down 

menu.
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2. Click Search. When meter(s) are found that match the search criteria, they are 

displayed in the lower portion of the screen.

•  The filters restrict the results to only those fields that match. A blank in a search 

field will bring up all results for that field. However, if you specify no search crite-

ria, you will get no results.

3. From the list of found meters, you can perform all actions that are available from 

the main screen, including connecting, viewing logs, and moving meters to a group, 

for either one meter or a group of meters.

•  To perform actions on one meter, right-click on the meter in the list and select 

the action from the pull-down menu.

•  To perform actions on multiple meters, hold down Ctrl while clicking meter 

entries. When you right-click and select an action from the pull-down menu, the 

action will apply to all selected meters. You can select a range of meters by hold-

ing Shift while selecting the first and last meter in the range.

4. Click outside of the Search Meters screen to close it. When you open it again, the 

last search options will be displayed.
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18.14: Service Control

The Service Control functions: Restart Service, Stop Service, Kill All, Kill Processes, all 

require admin permission to execute. Following is a description of the functions:

•  Restart Service: This will restart the MeterManagerPQA® application Scheduler.

•  Stop Service: This will stop the MeterManagerPQA® application Scheduler. 

WARNING! This will prevent the MeterManagerPQA® application from working. 

NOTE: The MeterManagerPQA® application Service will automatically restart the 

next time you reset your PC.

•  Kill All: This will “kill” all processes related to the MeterManagerPQA® application, 

including the CommunicatorPQA® application, Log Retrieval, Log Converter, and 

the MeterManagerPQA® application Scheduler. 

WARNING! This will prevent the MeterManagerPQA® application from working. 

NOTE: The MeterManagerPQA® application Service will automatically restart the 

next time you reset your PC.

•  Kill Processes: This will kill all processes which are launched by the MeterManager-

PQA® application, including the CommunicatorPQA® application, Log Retrieval, 

and Log Converter.
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19: Viewing Logs

19.1: Overview

Most EIG meters have the ability to store in internal memory information about the 

circuit they are monitoring.There are multiple types of logs that are created in meter 

memory that store this data along with its timestamp. The meters have a variety of 

different logs.These logs are designed to provide data about a specific aspect of the 

electrical circuit being measured.

LogViewerPQA is the charting and graphing application that comes with the 

CommunicatorPQA® V6 Sofsoftware. This application is database driven, and it nor-

malizes data that comes from any meter, so that LogViewerPQA displays the data in a 

concise easy-to-understand presentation.

Chapter 16 explained the CommunicatorPQA® application’s databases and log data, 

log retrieval, and log archiving; Chapter 17 explained using Script & Scheduler to 

automate log retrieval; and Chapter 18 explained using the MeterManagerPQA® 

application to automate log retrieval. This chapter explains how to use the LogViewer-

PQA application to view the meter’s data logs, and gives details on the available logs.

NOTE: Software versions earlier than V6 have the legacy Log Viewer. If you are not 

upgrading to V6 yet, see the software manual in the earlier versions (click Help>Con-

tents from the software’s Main screen to open the manual) for instructions on using 

LogViewerPQA.

19.1.1: Available Logs

•   Historical Trends logs:

•  These logs are collections of timestamped records (or “snapshots”) used to track 

any parameter over time. Each record or snapshot can contain multiple data 

items, which are recorded at specific intervals and stamped with the time of 

recording. The following programmable criteria determine when the meter will 

take a snapshot:

• The user-specified time interval.

• A parameter’s exceeding of a limit or a return to within limits.

• An I/O event (a change in a relay or high-speed input).

• EN 50160/IEC 61000-4-30 data.
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•  The Nexus® 1252/1262/1272 meters have two historical logs; the Shark® 200/

200S meters have three historical logs; the Shark® 250/270 meters have six 

historical logs; the MP200-Y/MP200-S metering system has two historical logs; 

the Nexus® 1500/1500+ meters have eight historical logs; and the Nexus® 

1450 meter has eight historical logs and a CORETM log that automatically records 

readings for 172 parameters at the programmed logging interval.

NOTES:

• End of Interval (EOI) Demand settings will not trigger an entry into a 

historical log. Historical logs record only on the programmed interval. If 

you have configured EOI triggered Demand calculation, the computed 

value closest to the time the log is recorded will be saved in the log. 

• Historical logs are recorded sequentially for all logs with the same record-

ing interval, i.e., Log 1, then Log 2, and so on. For this reason, if you 

record the same channel reading in multiple logs, the values of the read-

ings may not be the same.

•  Out of Limit (Limits) Log: the log retrieves independent out-of-limit information, 

creating a sequence of events for any occurrence.

•  (Event-Triggered) Waveform log: the event-triggered Waveform log records a 

waveform when a user-programmable value goes out of limit and when the value 

returns to normal. All information is timestamped to the nearest 1 ms. A new 

feature for interharmonic analysis observes further frequencies.

•  Power Quality (CBEMA) log: this log records magnitude and duration of voltage and 

current surges and sags for every power quality (PQ) event. 

•  Status Change (Input) log: this log displays the inputs change status for a selected 

meter file and time range.

•  Control Output (Relay) log: this log displays the relay change status for a selected 

meter file and time range. 

•  System Events log: the System Events log provides data for security and anti-tam-

pering. It contains information on instances of the following: power up/power 

down, password access/modification, change of programmable settings, change of 

a run time, change of clock time by communication (Modbus or DNP), Test Mode 

usage, and meter resets (Logs, Max/Min, Energy).
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•  Flicker log: the log records Flicker information for a selected meter and time range 

(only available for Nexus® meters).

•  EN 50160.: for the EIG meters that support EN 50160, this log is the EN 50160 

report.

19.1.2: Log Procedure Sequence

The following is the general sequence for working with all meter logs:

1. Program parameters specific to each log in the meter’s Device Profile (see the 

programming chapter for your meter type). Logs run automatically on the 

programmed interval/criteria. 

2. Retrieve the logs manually from the meter; or retrieve logs automatically using the 

the MeterManagerPQA® application or the Script & Scheduler application. See 

chapters 16, 17, and 18 for details.

3. View and analyze log data using LogViewerPQA (explained in 19.2: LogViewerPQA, 

on page 19-4).

4. Diagnose PQ Events from meter logs; create comprehensive reports; use the 

EnergyReporterPQATM application to generate usage reports and billing.
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19.2: LogViewerPQA

The CommunicatorPQA® application’s LogViewerPQA displays retrieved logs in a 

variety of formats. 

1. You can access LogViewerPQA in one of two ways:

•  Right-click on the meter in the MeterManagerPQA software’s Meter List and select 

View Meter Logs. Go to step 2.

OR

•  Click the Open Log icon in the Icon bar of the CommunicatorPQA® V6 software’s 

Main screen.  

a. Click on the meter whose log you want to view and click Select.

NOTE: The location of the log is displayed at the bottom of the screen. If 

you want to select another, specific log, click Select Log to open the 

Retrieved Logs directory, from which you can locate the downloaded file 

you want to view.
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Note that if you are in Lite mode, the CommunicatorPQA® application will 

open the Retrieved Logs directory, prompting you to pick a previously 

stored log file

2. LogViewerPQA opens.

2. The main LogViewerPQA screen displays:

•  The meter you selected (a). 

• To remove the meter, click the X to the right of its name.

(a)(b) (c)

(d)

(e)
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• To select another meter, click the meter icon to the left of the meter 

name (a). You will see this screen.

• Click on the name of the meter whose logs you want to view.

• You can click Enter Meter Serial to select a meter by entering the serial 

number. You will see this screen.

• Enter the meter’s serial number and click Enter. 

• The new meter will be displayed in the LogViewerPQA’s main screen.



     Doc#    E107707                                                19 - 7

             19: Viewing Logs

•  The Log Status icon (b). Click this icon to display the meter’s log history.

•  The Time Range icon lets you set the time range for the log’s data display. Click 

the icon to specify the time range you want.

• Select from 7 days, 30 days, 90 days, or click Custom Range to edit the 

Date From and Date To fields.

Time Range
     Icon Click the Calendar icon

to easily select the 
dates you want
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• Check the Use Achived Data as Source to view only archived data rather 

than more recent data. 

•  The logs are listed on the bottom of the screen (d).You click the Log’s button to 

view the data for that log. The buttons of unavailable logs are grayed out and 

unselectable.

•  The bottom of the LogViewerPQA’s main screen contains links to the Communica-

torPQA® and MeterManagerPQA® Software User Manual (? Help), details of the 

LogViewerPQA application (About), Data and Graph display settings (Settings), 

Meter ID, and time range of data display.

3. Click on the icon of the log you want to view.

19.3: LogViewerPQA Log Screens

The following sections explain the available LogViewerPQA screens. Note that not all 

logs are available for all meters.

19.3.1: General LogViewerPQA Instructions

Following is an explanation for general commands for the log screens.

•  You can copy all the log data to the clip-

board by right-clicking in the column title. 

Click Copy to Clipboard to copy only the 

data. Click Copy to Clipboard with Header 

to copy the column headings as well.

•  You can sort the log data in the columns 

between ascending and descending order by clicking next to the column title. 

You will see an up or down arrow, which you can use to change the data display 

to ascending or descending order.

•  Some of the LogViewerPQA screens have a Filter button that lets you select 

specific data to view.

This message 
shows the
programmed
Archive period. 

The selection here will return data older than 12 months.
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•  You can export the log data to a CSV file, by clicking the Export button at the top 

of a log screen. You will be prompted to give the file a name and save it to the 

location you want. 

•  Click the Back arrow to return to the main LogViewerPQA screen.
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19.3.2: System Events Log

The System Event Log records and timestamps a variety of events, including the 

following:

•  Download started or ended for one of the meter logs.

•  Run Time is active, started or stopped.

•  Firmware has been changed.

To view the System Event log, click the System Events button.         

The screen fields are as follows:

(a) Event timestamp.

(b) Event type, e.g., Log Activity.

(c) Description of the event.

(d) Time Range icon.

  (a)                    (b)                                       (c)

(d)                   (e)       (f)
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(e) Export icon.

(f) Filter icon.

•  To filter the events that are listed, click the Filter icon.

This Filter screen lets you select which Event Type you want to see. All event types 

in the System Events log for the time range you selected will be listed. Check the 

box of the events you want to see and leave the box unchecked for any event types 

you want to exclude from the display.
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19.3.3: Historical Trends Log

1. From LogViewerPQA’s main screen, click the Historical Trends button.The Channel 

Selection screen opens, displaying available channels from the Historical logs. 

2. Click and Add individual items with the +Add button or click Add All. The selected 

items are copied to the Selected Channels box.

•  You can use the Shift button to highlight a range of channels and then click Add 

to add them all to the Selected Channels box.
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3. Click OK. The Historical Trending screen opens, displaying information for the 

selected channels based on the time range selected.

4. The screen displays the timestamp of the data and the selected channel readings. 

•  You can select different data channels to view by clicking Settings.
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•  Click Graph to see the historical log data in a graph format. See the example 

below.          

• Click Grid (a) to return to the Historical Trends log list of data records.

• Click View (b) to set a time range for the data in the graph.

• Use the Nav (c) forward and back arrow buttons to see all of the graph 

data. You can also scroll up and down in the screen using your mouse.

(a)

(b)           (c)              (d)        (e)
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• Click Scale (d) to scale the data. You will see the screen shown below.

• Use the up and down arrows to set the vertical scaling you want to use 

for the graph.

• Click OK to apply your changes or Restore to set the scaling back to its 

default. You will see the display change as you adjust the scaling.

• Click Max/Min (e) to display a screen with the timestamped maximum, 

minimum, and average values for the selected Historical Trends log data 

channels.

• Click Close when you are finished with the Historical Max/Min screen.
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19.3.4: Power Quality Log

From LogViewerPQA’s main screen, click the Power Quality button. LogViewerPQA will 

display power quality information for the selected time range.
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•  Click Filter to restrict the data records that are shown. 

•  You can specify a channel, trigger. duration, % (of) Fullscale, Value, and whether 

or not the record has a waveform.

•  Click Apply to apply the filters you selected. Click Cancel if you want to cancel 

filtering.

•  Note that a 1500+ meter with runtime firmware version 15.2 or higher has an addi-

tional column called Reference Usr. If the USR setting has been used for the wave-

form rather than the Full Scale setting, the value used is shown here and the % of 

Full Scale column says % of Usr. See 11.3.3: PQ Thresholds (Waveform Recording), 

on page 11-68, for information on the USR setting.
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•  To view a graph of any PQ record, click on the record and then click the Graph 

button. The first graph is the CBEMA Curve graph.

•  To see the SEMI F47 graph, click on CBEMA at the top of the 

screen to change it to SEMI F47.
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•  This diagram meets the standards of the Specification for Semiconductor Pro-

cessing Equipment Voltage Sag Immunity.
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19.3.5: Waveform Log

From LogViewerPQA’s main screen, click the Waveform button. LogViewerPQA will dis-

play waveform information for the selected time range.
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•  Filter will let you select the channel, trigger type, and duration you want to apply. 

Only the data records matching the selections you make will be shown in the list.
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•  To view a waveform, click on one of the data records.

NOTE Regarding Transients:

Transients are voltage spikes that lasts less than one cycle. A transient can be either 

“impulsive,” i.e., a single, high impulse event, such as that caused by a lightning 

strike, or “oscillatory,” i.e., oscillating at the natural system frequency and dying down 

within a cycle. Oscillatory transients (also known as switching transients) can occur 

when an inductive or capacitive load, such as a motor or capacitor bank, is turned off. 

Since transients can damage equipment, it is important to measure and analyze 

them.

To view the transient log data, use the Filter to select “Positive Transient” or “Negative 

Transient” in the Trigger Type field. Then click on one of the waveforms in the list and 

click Graph to view the transient’s waveform.
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•  To view the Waveform Settings, click Settings at the top of the screen.

•  To overlay two or more waveforms check the boxes to the right of the waveforms 

and then click Overlay at the top of the screen.

Place your cursor in
the middle of the 
screen and scroll 
to see all of the data



     Doc#    E107707                                                19 - 24

             19: Viewing Logs

•  To see detailed information for a waveform click the Single View button to the right 

of the waveform. Note that you can also double-click on one of the waveform 

cycles.

•  The single cycle waveform viewer shows the RMS readings and Harmonic values 

for the waveform.
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•  Click Interharmonics from the top of the screen to view the screen shown below.

NOTES on Interharmonic Analyisis: 

Interharmonic analysis is only supported for Nexus® meters, and only for voltage 

(VA, VB, VC) and current channels (IA, IB, IC, IAUX). The IEC-1000-2-1 [1] standard 

states, “Between the harmonics of the power frequency voltage and current, further 

frequencies can be observed which are not an integer multiple of the fundamental. 

They can appear as discrete frequencies or as a wide-band spectrum.”

To perform the interharmonic analysis, there must be a waveform record with a 200 

ms duration. For a 50 Hz system, the waveform is 10 cycles; for a 60 Hz system, the 

waveform is 12 cycles. By default, the starting point for interharmonic analysis of a 

waveform is its first point. But a user can set a starting point (place the mark) any-

where in the waveform, assuming that there will be enough sample points available 
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after the starting point. If there are not enough points in this waveform capture, the 

software will check the next waveform record(s) stored in the database. If it is contig-

uous, additional points up to 200 ms will be retrieved for analysis. 

•   For a waveform with a sampling rate equal to or less than 64, the software will only 

check the next contiguous record.

•   For a waveform with a sampling rate equal to or greater than 128, the software will 

check the next two contiguous records. 

Resetting the mark will set the starting point back to the waveform’s first point.

Measurement: IEC 61000-4-7 (First Edition) establishes a well disciplined measure-

ment method for harmonics which utilizes 10 (50 Hz systems) or 12 cycle (60 Hz sys-

tems) sample windows upon which to perform the Fourier transform. The result is a 

spectrum with 5 Hz resolution for both 50 Hz and 60 Hz systems. The standard fur-

ther defines ways of combining individual 5 Hz bins to produce various groupings and 

components for referenced limits and guidelines.

The IEC Measurement Method defines interharmonic groups. These indices are the 

RMS values of the interharmonic components between adjacent harmonic compo-

nents. The frequency bins directly adjacent to the harmonic bins are omitted. 
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•  Click Annotate at the top of the single cycle waveform viewer screen to add 

range markers and/or notes to the waveform.

•  To add ranges, place your cursor where you want to start the range and then 

click the Add range button. You can repeat this process to mark the end of the 

range. The range duration is shown in a list on the right of the screen. 

Dashed lines show the range added                       Range duration
                                                                                  is shown here
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•  To add notes, click in the waveform where you want to add the note and then 

click the Add Note button.

The note is added to the waveform record.

Enter your text here and then click Create.
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19.3.6: Out of Limit Log

From LogViewerPQA’s main screen click the Out of Limits button. LogViewerPQA dis-

plays limit information for the selected log file(s) based on the selected time range.

•  Click the bar next to Show Limit Settings to display the limits’ setpoints.
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19.3.7: Status Change Log 

The Status Change Log (Input Log) displays the input change status for the selected 

time range. From the main LogViewerPQA screen, click the Status Change button

•  Usually, if a record being displayed in the grid box has a start date/time and an end 

date/time, the state being displayed is out of normal state.

•  You can use Filter to narrow down the display by selecting input number, duration, 

initial state, and/or end state.

NOTE: Module Name 0 refers to HSI Internal Meter Inputs.
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19.3.8: Control Output Log

The Control Output Log (Relay Log) displays the relay change status for the selected 

time range. From the main LogViewerPQA screen, click the Control Output button.

•  The Start Date/Time is when the trigger occurred.

•  The End/Date Time is when the relay returned to its initial state.

•  The Duration is the amount of time the relay stayed in its triggered state in ms.

•  The Module Name and Output Name identify the relay.

•  The number is the number of the relay.

•  The Initial State is the relay state at the time of the trigger. 

•  The End State is the relay state after the relay returns to its normal state. 
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19.3.9: Flicker Log

From LogViewerPQA’s main screen, click the Flicker button.

•  The screen displays the 10 minute average PLT and 10 minute average PST for VA, 

VB, and VC for each tmestamp. 

•  Click the Max/Min box toward the top right of the screen to display Max/Min infor-

mation for the Flicker readings. See the example below.

•  The Min/Max screen displays the Max and Min PST and PLT for VA, VB, VC, with the 

timestamp of their occurrence.
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19.3.10: EN 50160 Log

From the main LogViewPQA page, click EN 50160 to see a list of EN 50160 data for 

the selected time range. 

•  See Chapter 23: EN 50160 / IEC 61000-4-30 Power Quality Analysis, on page 23-1 

for full details concerning the EN 50160 report and its settings.
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19.3.11: PQDIF 

When you click PQDIF from the main LogViewerPQA screen, the Log Retrieval folder 

opens so you can select the PQDIF file. Power Quality Data Interchange Format 

(PQDIF) is a tagged, compressible binary file format which offers a platform-neutral, 

flexible means of exchanging power quality data between instruments and data man-

agement and analysis software. PQDIF is currently under adoption by EPRI as the 

standard file format for power quality data and under consideration by IEEE as its 

standard file format. The CommunicatorPQA® application offers a PQDIF converter, 

referred to as PQDIF Exporter.

When the PQDIF Exporter is enabled in the CommunicatorPQA® application, it will 

automatically generate PQDIF files after retrieving any Waveform, PQ, and Historical 

logs, as long as the meter/log support PQDIF (see 19.3.11.4: Supported Files and 

Meters, on page 19-39, for more information on supported meters and log items). 

The PQDIF Exporter provides a reliable way to access a meter's log data from applica-

tions other than the CommunicatorPQA® application. 
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19.3.11.1: Configuring the PQDIF Exporter 

1. From the Options screen, click the PQDIF and COMTRADE tab and enable PQDIF file 

automatic creation when the logs are retrieved from the meter, by clicking the box 

to check it. 

2. Click Apply to save the setting.

19.3.11.2: Using the Command Line Interface

In addition to the automated exports that PQDIF Exporter performs, you can perform 

manual exports on a given PERIOD_INTERVAL, using the Command Line Interface. 

This may be necessary if you need to utilize PQDIF files/data with other software 

applications. 

NOTES: 

•  All command line arguments must be preceded by -- (e.g., --PERIOD_INTERVAL 

“day”).

•  All command line arguments are optional; running the program without arguments 

will show the screen (see 19.3.11.3: Using the PQDIF Exporter, on page 19-38).
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These are the command line arguments for manual PQDIF exports:

•  DATABASE "FILE" - Path to the log data. 

•  EXPORT_PATH "PATH" - Path to export the PQDIF data to. 

•  TIME_START "yyyy/mm/dd hh:mm:ss" - (Optional) The Start Time for imported 

data in the format yyyy/mm/dd hh:mm:ss. 

•  TIME_END "yyyy/mm/dd hh:mm:ss" - (Optional) End Time for imported data in 

format yyyy/mm/dd hh:mm:ss. 

•  EXPORT_TYPE "TYPE" - (Optional) Limits type of PQDIF output to generate to spec-

ified format (when not specified, all types will be exported):

•  “waveform"

•  “historical"

•  “pq"

•  PERIOD_INTERVAL "TYPE" - (Optional) Specifies if data is to be grouped in files by 

(defaults to “unlimited”): 

•  "day" - Stores data with the period of a day.

•  "month" - Stores data with the period of a month.

•  "year" - Stores data with the period of a year.

•  "unlimited" - Stores as much data as possible in a single file.

--PERIOD_INTERVAL "unlimited"

--EXPORT_TYPE "historical"

--DATABASE "C:\Users\Public\Documents\Electro Industries\Communicator_Ext\Retrieved 

Logs\128Mb_IP203_0000000054211013\128Mb_IP203_0000000054211013.dml"

--EXPORT_PATH "C:\Users\Frank\Documents\PQDIF\

--TIME_START "2016/04/15 07:12:18"

--TIME_END "2016/06/06 08:15:15"
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For example, if you wanted to output the waveform data from May 1st 2016 to June 

30th 2016, on a daily period, to a subfolder of your Public Documents folder:

"C:\Program Files (x86)\Electro Industries\LogViewer\PQDIF\PQDIFExporter.exe"

--DATABASE "C:\Users\Public\Documents\Electro Industries\Communica-

tor_Ext\Retrieved 

Logs\128Mb_IP203_0000000054211013\128Mb_IP203_0000000054211013.dml"

--TIME_START "2016/05/01 05:30:00"

--TIME_END "2016/06/30 23:59:59" 

--EXPORT_PATH "C:\Users\Ndeibler\Documents\PQDIF"

--EXPORT_TYPE "WAVEFORM"

--PERIOD_INTERVAL "day"
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19.3.11.3: Using the PQDIF Exporter

Although PQDIF files are automatically exported upon retrieval of Historical, PQ, and 

Waveform logs, you can also use PQDIF Exporter outside of CommunicatorPQA® soft-

ware by running the PQDIF Exporter executable. If no command line parameters are 

detected upon program execution, the software will start in graphical mode, 

letting you select program parameters and manually export database files in PQDIF 

format. 

Follow these instructions to use the PQDIF Exporter:

1. Run PQDIFExporter.exe without command line arguments. The program is found in 

this directory path:

 [CommunicatorExt Install Dir] \LogViewer\PQDIF\PQDIFExporter.exe

2. Select a source database file: *.db or *.dml by clicking on the “...” button next to 

the Data File field.

3. Select the destination folder for the PQDIF output files by clicking on the “...” but-

ton next to the Output To field.

4. Select the period Start Time from the pull-down menu.

5. Select the period End Time from the pull-down menu.

6. Select the Period to group data by from the pull-down menu. The default grouping 

period is by Month.
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7. Check the types of data to be exported: Historical, Power Quality, and/or Waveform 

by clicking in the checkboxes next to the options.

8. Click the Convert button. Once clicked, the Convert button is disabled until the 

export is finished.

9. The generated PQDIF files will be available in the destination folder (if any valid 

data was found in the selected log(s)). 

19.3.11.4: Supported Files and Meters

The meters supported for PQDIF export are the Nexus® 12xx, 1450, 1500+; and the 

Shark® 200, 250, and 270 meters. Following are the lists of the supported log items 

(i.e., data channels) for the meters:

•  Shark® 200/250/270 meter:

•  1s: Van, Vbn, Vcn, Vab, Vbc, Vca, Ia, Ib, Ic, In (calculated), FQ, V_Imb, I_Imba, 

Wa, Wb, Wc, W, VARa, VARb, VARc, VAR,  VAa, VAb, VAc, VA, PFa, PFb, PFc, PF 

•  Avg.: Ia, Ib, Ic, In (calculated), Wa, Wb, Wc, VARa, VARb, VARc, VAa, VAb, VAc, 

VA

•  %THD: Ia, Ib, Ic, Van/Vab, VBn/VBc, VCn/VCa

•  10 min Avg. Sym. Comp. Mag. Pos.

•  10 min Avg. Sym. Comp. Mag. Neg.

•  Energy +Wh (Q1 & Q4)

•  Energy -Wh (Q2 & Q3)

•  Energy +VARh

•  Energy -VARh

•  Phase A Voltage: 1st Harm. Mag., 2nd Harm. Mag., 3rd Harm. Mag., 4th Harm. 

Mag., 5th Harm. Mag., 6th Harm. Mag., 7th Harm. Mag., 8th Harm. Mag., 9th 

Harm. Mag., 10th Harm. Mag., 11th Harm. Mag., 12th Harm. Mag., 13th Harm. 

Mag., 14th Harm. Mag., 15th Harm. Mag., 16th Harm. Mag., 17th Harm. Mag.

•  Phase B Voltage: 1st Harm. Mag., 2nd Harm. Mag., 3rd Harm. Mag., 4th Harm. 

Magn., 5th Harm. Mag., 6th Harm. Mag., 7th Harm. Mag., 8th Harm. Mag., 9th 
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Harm. Mag., 10th Harm. Mag., 11th Harm. Mag., 12th Harm. Mag., 13th Harm. 

Mag., 14th Harm. Mag., 15th Harm. Mag., 16th Harm. Mag., 17th Harm. Mag.

•  Phase C Voltage: 1st Harm. Mag., 2nd Harm. Mag., 3rd Harm. Mag., 4th Harm. 

Mag., 5th Harm. Mag., 6th Harm. Mag., 7th Harm. Mag., 8th Harm. Mag., 9th 

Harm. Mag., 10th Harm. Mag., 11th Harm. Mag., 12th Harm. Mag., 13th Harm. 

Mag., 14th Harm. Mag., 15th Harm. Mag., 16th Harm. Mag., 17th Harm. Mag.

•  Phase A Current: 1st Harm. Mag., 2nd Harm. Mag., 3rd Harm. Mag., 4th Harm. 

Mag., 5th Harm. Mag., 6th Harm. Mag., 7th Harm. Mag., 8th Harm. Mag., 9th 

Harm. Mag., 10th Harm. Mag., 11th Harm. Mag., 12th Harm. Mag., 13th Harm. 

Mag., 14th Harm. Mag., 15th Harm. Mag., 16th Harm. Mag., 17th Harm. Mag.

•  Phase B Current: 1st Harm. Mag., 2nd Harm. Mag., 3rd Harm. Mag., 4th Harm. 

Mag., 5th Harm. Mag., 6th Harm. Mag., 7th Harm. Mag., 8th Harm. Mag., 9th 

Harm. Mag., 10th Harm. Mag., 11th Harm. Mag., 12th Harm. Mag., 13th Harm. 

Mag., 14th Harm. Mag., 15th Harm. Mag., 16th Harm. Mag., 17th Harm. Mag.

•  Phase C Current: 1st Harm. Mag., 2nd Harm. Mag., 3rd Harm. Mag., 4th Harm. 

Mag., 5th Harm. Mag., 6th Harm. Mag., 7th Harm. Mag., 8th Harm. Mag., 9th 

Harm. Mag., 10th Harm. Mag., 11th Harm. Mag., 12th Harm. Mag., 13th Harm. 

Mag., 14th Harm. Mag., 15th Harm. Mag., 16th Harm. Mag., 17th Harm. Mag.

•  Sym. Comp. Voltage Mag. Zero Seq. Min.

•  Sym. Comp. Voltage Mag. Pos. Seq. Min.

•  Sym. Comp. Voltage Mag. Neg. Seq. Min.

•  Nexus® meters:

•  High Speed: Van, Vbn, Vcn, Vaux, Ia, Ib, Ic, Vab, Vbc, Vca, VA, VAR, W, FQ, PFa, 

PFb, PFc, PFTotal

•  1s: VAn, VBn, VCn, Vaux, Ia, Ib, Ic, In (measured), In (calculated), VAb, VBc, 

VCa, VAa, VAb, VAc, VA, VARa, VARb, VARc, VAR, Wa, Wb, Wc, W, FQ, PFa, PFb, 

PFc, PF, V_Imb, I_Imb

•  Thrm. Avg.: Ia, Ib, Ic, In (calculated), VAb, VBc, VCa, VAa, VAb, VAc, VA, VARa, 

VARb, VARc, VAR, Wa, Wb, Wc, W, FQ, PFa, PFb, PFc, PF

•  Energy: +VARh, -VARh, +Wh, -Wh, +Wh (Q1 & Q4), -Wh (Q2 & Q3)
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•  Phase A-B Voltage: 0th Harm. Mag., 1st Harm. Mag., 2nd Harm. Mag., 3rd Harm. 

Mag., 4th Harm. Mag., 5th Harm. Mag., 6th Harm. Mag., 7th Harm. Mag., 8th 

Harm. Mag., 9th Harm. Mag., 10th Harm. Mag., 11th Harm. Mag., 12th Harm. 

Mag., 13th Harm. Mag., 14th Harm. Mag., 15th Harm. Mag Phase B-C Voltage: 

0th Harm. Mag., 1st Harm. Mag., 2nd Harm. Mag., 3rd Harm. Mag., 4th Harm. 

Mag., 5th Harm. Mag., 6th Harm. Mag., 7th Harm. Mag., 8th Harm. Mag., 9th 

Harm. Mag., 10th Harm. Mag., 11th Harm. Mag., 12th Harm. Mag., 13th Harm. 

Mag., 14th Harm. Mag., 15th Harm. Mag., 16th Harm. Mag., 17th Harm. Mag.., 

16th Harm. Mag., 17th Harm. Mag.

•  Phase B-C Voltage: 0th Harm. Mag., 1st Harm. Mag., 2nd Harm. Mag., 3rd Harm. 

Mag., 4th Harm. Mag., 5th Harm. Mag., 6th Harm. Mag., 7th Harm. Mag., 8th 

Harm. Mag., 9th Harm. Mag., 10th Harm. Mag., 11th Harm. Mag., 12th Harm. 

Mag., 13th Harm. Mag., 14th Harm. Mag., 15th Harm. Mag., 16th Harm. Mag., 

17th Harm. Mag.

•  Phase C-A Voltage: 0th Harm. Mag., 1st Harm. Mag., 2nd Harm. Magn., 3rd 

Harm. Mag., 4th Harm. Mag., 5th Harm. Mag., 6th Harm. Mag., 7th Harm. Mag., 

8th Harm. Mag., 9th Harmonic Mag., 10th Harm. Mag., 11th Harm. Mag., 12th 

Harm. Mag., 13th Harm. Mag., 14th Harm. Mag., 15th Harm. Mag., 16th Harm. 

Mag., 17th Harm. Mag.

•  Phase A Current: 0th Harm. Mag., 1st Harm. Magn., 2nd Harm. Mag., 3rd Har-

monic Mag., 4th Harm. Mag., 5th Harm. Mag., 6th Harm. Mag., 7th Harm. Mag., 

8th Harm. Mag., 9th Harm. Mag., 10th Harm. Mag., 11th Harm. Mag., 12th 

Harm. Mag., 13th Harm. Mag., 14th Harm. Mag., 15th Harm. Mag., 16th Harm. 

Mag., 17th Harm. Mag.

•  Phase B Current: 0th Harm. Mag., 1st Harm. Mag., 2nd Harm. Mag., 3rd Harm. 

Mag., 4th Harm. Mag., 5th Harm. Mag., 6th Harm. Mag., 7th Harm. Mag., 8th 

Harm. Mag., 9th Harm. Mag., 10th Harm. Mag., 11th Harm. Mag., 12th Harm. 

Mag., 13th Harm. Mag., 14th Harm. Mag., 15th Harm. Mag., 16th Harm. Mag., 

17th Harm. Mag.

•  Phase C Current: 0th Harm. Mag., 1st Harm. Mag., 2nd Harm. Mag., 3rd Harm. 

Mag., 4th Harm. Mag., 5th Harm. Mag., 6th Harm. Mag., 7th Harm. Mag., 8th 

Harm. Mag., 9th Harm. Mag., 10th Harm. Mag., 11th Harm. Mag., 12th Harm. 

Mag., 13th Harm. Mag., 14th Harm. Mag., 15th Harm. Mag., 15th Harmonic 

Mag., 17th Harm. Mag.
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•  %THD: Ia, Ib, Ic, Van/Vab, VBn/VBc, VCn/VCa

•  Block Window Avg.: VA, VAR, W

•  Flicker PST: Va, Vb, Vc

•  Flicker PLT: Va, Vb, Vc

•  Flicker Inst.: VAN, VBN, VCN

•  10  min Avg. Van/Ab THD%

•  10 min Avg. VBn/Bc THD%

•  10 min Avg. VCn/Ca THD%

•  Sym. Comp. Voltage Mag. 3s Zero Seq.

•  Sym. Comp. Voltage Mag. 3s Pos. Seq.

•  Sym. Comp. Voltage Mag. 3s Neg. Seq.

•  Sym. Comp. Voltage Mag. 10m Avg. Pos. Seq.

•  Sym. Comp. Voltage Mag. 10m Avg. Neg. Seq.

•  Sym. Comp. Voltage Mag. 10m Avg. , Neg/Pos 100%

19.3.11.5: PQDIF Files

Storage:

•  The PQDIF files automatically generated by the CommunicatorPQA® software are 

stored in this directory:

C:\Users\Public\Documents\Electro Industries\Communicator_Ext\Retrieved 

Logs\PQDIF

•  If command line argument is used to generate the exported files or if the PQDIF 

Exporter is used in standalone mode (see 19.3.11.3: Using the PQDIF Exporter, on 

page 19-38) the files are stored where specified in the EXPORT_PATH command or 

PQDIF Exporter screen.

NOTE: Each meter's output files are stored in a subdirectory with the meter's desig-

nation, an underscore, and the meter's serial number; for example:

C:\Users\Public\Documents\Electro Industries\Communicator_Ext\Retrieved 

Logs\PQDIF\128Mb_IP203_0000000054211013\
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File Structure:

•  PQDIF files have .pqd as their extension.

•  PQDIF output files begin with "yyyy-mm-dd". However if there's too much data for 

a single file, the file is split into multiple files named "yyyy-mm-dd_##" where ## 

is the index of the file in the sequence of data. 

•  If “year” or “month” was specified for the file period, some of the date will be trun-

cated, since days, for a monthly period, and months, for a yearly period, would not 

be relevant. 

•  If the period interval was set to “unlimited,” output files will begin with “unas-

signed.” If there is too much data to be stored in one .pqd file the multiple files will 

be named 'unassigned_##' where ## is the index of the file in the sequence of 

data. 

•  The PQDIF formatted files can be viewed with PQDIF viewers such as Top or PQDif-

fractor. 

•  Below are some examples of PQDIF output files. 

•  A PQDIF file generated for May 2017:

C:\Users\Public\Documents\Electro Industries\Communicator_Ext\Retrieved 

Logs\PQDIF\128Mb_IP203_0000000054211013\2017-05-01.pqd

•  A PQDIF file generated for an unspecified time range:

C:\Users\Public\Documents\Electro Industries\Communicator_Ext\Retrieved 

Logs\PQDIF\128Mb_IP203_0000000054211013\unassigned.pqd
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19.3.12: COMTRADE 

When you click COMTRADE from the main LogViewerPQA screen, the Log Retrieval 

folder opens so you can select the COMTRADE file.Common Format for Transient Data 

Exchange (COMTRADE) is a standard that defines a format for the files containing 

transient waveform and event data collected from power systems or power system 

models. The format is intended to provide an easily interpretable form for use in 

exchanging data. As such, it does not make use of the economies available from data 

encoding and compression that proprietary formats depend upon for competitive 

advantage. The standard is for files stored on physical media, such as digital hard 

drives and diskettes. It is not a standard for transferring data files over communica-

tion networks. This standard defines a common format for the data files and exchange 

medium needed for the interchange of various types of fault, test and simulation data.

The CommunicatorPQA® application offers a COMTRADE converter, which carefully 

adheres to COMTRADE specification IEC 60255-24 (2001) and produces files with a 

data format compliant with the IEEE Stndard C37.111-1999 COMTRADE for Power 

Systems.

The COMTRADE converter will generate the following types of files (see 19.3.12.4: 

COMTRADE Files, on page 19-48, for additional information):

•   filename.cfg

•   filename.dat

•   filename.inf

•   filename.d##

•   filename_*.cfg

•   filename_*.dat

•   filename_*.inf

•   filename_*.d##

•   The term 'filename' represents the user specified file name.

•   The symbol '##' represents a value from '00' through '99'.
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•   The symbol '*' is the number of 1 or above for each additional waveform record.

•   File type 'cfg' is for Configuration.

•   File type 'dat' is for Data.

•   File type 'inf' is for Information.

NOTE: The software will not overwrite an existing file; it will only convert to a new 

filename.

19.3.12.1: Configuring the COMTRADE Converter

To use the COMTRADE Converter, you first need to enable it. 

1. From the Options screen, click the PQDIF and COMTRADE tab and enable 

COMTRADE file creation by clicking the box to check it. 

2.   Click Apply to save the setting.
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19.3.12.2: Using the Command Line Interface

When it is enabled, the COMTRADE Converter works with CommunicatorPQA® soft-

ware to automatically export the COMTRADE files. However, you may need to custom-

ize the export in order to use the log data with other software. You can do so using 

the 

Command Line interface.

NOTES: 

•  All command line arguments must be preceded by -- (e.g., --TIME_START “2017/

02/04 12:24:36”).

•  All command line arguments are optional except for DATABASE.

These are the command line arguments for COMTRADE exports:

•  DATABASE “FILENAME” - Path to the log database file to convert data from.

--DATABASE 

“C:\Users\Public\Documents\ElectroIndustries\Communicator_Ext\RetrievedLogs\128Mb_I

P203_0000000054211013\128Mb_IP203_0000000054211013.dml

•  TIME_START “yyyy/mm/dd hh:mm:ss” - Start date and time for data conversion.

--TIME_START “2017/01/05 12:23:24”

•  TIME_END “yyyy/mm/dd hh:mm:ss” - End date and time for data conversion.

--TIME_END “2017/01/24 18:32:10”

•  EXPORT_PATH “PATH” - Path to the directory where data will be exported.

--EXPORT_PATH “C:\Users\NDeibler\Documents\COMTRADE”

•  OUTPUT_FILE_FORMAT “FORMAT” - File output format - either ASCII or BINARY.

--OUTPUT_FILE_FORMAT “BINARY”

For example, if you wanted to export log data from February 1, 2017 until February 

28, 2017:

"C:\Program Files (x86)\Electro Industries\LogViewer\COMTRADE\ComtradeExporter.exe" 

--DATABASE "C:\Users\Public\Documents\Electro Industries\Communica-
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tor_Ext\Retrieved 

Logs\128Mb_IP203_0000000054211013\128Mb_IP203_0000000054211013.dml"

--TIME_START "2023/02/01 06:45:00" 

--TIME_END "2023/02/28 13:05:20"

--EXPORT_PATH "C:\Users\NDeibler\Documents\COMTRADE"

--OUTPUT_FILE_FORMAT "BINARY"

Example:

To export a single waveform from log data:

1. Find the start time of the waveform you are interested in, from LogViewer.
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2. Using the time of the waveform, subtract one second for the start time and add 1 

second for the end time. Your command line argument will be as follows:

"C:\Program Files (x86)\Electro Industries\LogViewer\COMTRADE\ComtradeExporter.exe"

--DATABASE "C:\Users\Public\Documents\Electro Industries\Communica-

tor_Ext\Retrieved Logs\SubStation1_0000000054211013\SubSta-

tion1_0000000054211013.dml"

--TIME_START "2023/12/01 11:28:19" 

--TIME_END "2023/12/01 11:28:21"

--EXPORT_PATH "C:\Users\NDeibler\Documents\COMTRADE"

3. Once the COMTRADE Converter is finished, you should see two output files:

(File 1) C:\Users\Frank\Documents\COMTRADE\SubStation1_0000000054211013\2016-12-

01_11-28-20-450.cfg

(File 2) C:\Users\Frank\Documents\COMTRADE\SubStation1_0000000054211013\2016-12-

01_11-28-20-450.dat

19.3.12.3: Supported Files and Meters

The Waveform log is the supported file for the COMTRADE Converter. The meters 

supported for COMTRADE export are the Nexus® 12xx and 1500+; and the Shark® 

200 and 270 meters. 

19.3.12.4: COMTRADE Files

Storage:

•  The COMTRADE files automatically generated by the CommunicatorPQA® software 

are stored in this directory:

C:\Users\Public\Documents\Electro Industries\Communicator_Ext\Retrieved 

Logs\COMTRADE

•  If command line argument is used to generate the exported files, the files are 

stored where specified in the EXPORT_PATH command.

NOTE: Each meter's output files are stored in a subdirectory with the meter's desig-

nation, an underscore, and the meter's serial number; for example:

C:\Users\Public\Documents\Electro Industries\Communicator_Ext\Retrieved 

Logs\COMTRADE\128Mb_IP203_0000000054211013\
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Naming Conventions:

•  All output files start with "YYYY-MM-DD_hh-mm-ss-fff" where fff is the time in milli-

seconds.

Details of Files (see 19.3.12: COMTRADE, on page 19-44, for a list of COM-

TRADE files):

•  cfg - Config files specify how the COMTRADE viewer should handle the data in the 

'dat' or 'd##' files. For example, the config file could specify the format of data as 

well as how to scale it.

•  E.g., 2016-01-27_04-21-13-283.cfg

•  dat - Data files contain the waveform data that has been parsed into the 

COMTRADE format.

•  E.g., 2016-01-27_04-21-13-283.dat

•  d## - When there is too much waveform data for a single .dat file, the file is split 

into multiple files with extensions containing the letter 'd' followed by their sequen-

tial number ranging from '00' to '99'. For example:

•  2016-02-01_10-45-23-225.d00

•  2016-02-01_10-45-23-225.d01

•  2016-02-01_10-45-23-225.d02

•  ...

19.3.13: EnergyPQA.com

You can access the usage dashboard viewer of the EnergyReporterPQATM energy 

management, analysis, reporting, and billing software by clicking the EnergyReporter-

PQATM button. See the EnergyReporterPQATM Application Installation and Operation 

Manual for details on the application.
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19.4: HHF Converter

The HHF Converter converts downloaded historical logs from Nexus®/Shark® 200 

meters to HHF format for use with Itron’s MV-90 Meter Reading System. The HHF 

Adapter converts data as it is downloaded to a meter. It cannot retroactively convert 

data that has already been stored in the CommunicatorPQA® software database. This 

limitation is due to the method MV-90 uses to retrieve HHF format files.

The HHF Converter is a standalone executable application module that is called from 

the CommunicatorPQA® application whenever historical logs are downloaded from 

the meter and HHF is enabled. This process is automatic once HHF is enabled. This 

application intercepts the data being downloaded and simultaneously converts the 

data to HHF format.

19.4.1: Configuring the HHF Converter

1. From the Main screen’s Menu Bar, click View>Options to open the Options screen.

2. Click the Miscellaneous tab. You will see the screen shown below.

3. Click the checkbox next to Enable HHF converter for retrieved logs.
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4. Click the HHF Options button. The screen changes as shown below.

5. Key in the Scaling Value. This value is an integer by which all input values are 

divided before being placed into the HHF files. Values must be rescaled when 

loaded into MV-90.

NOTE on Scaling: If Input Values exceed 1,000,000, a Scaling Value must be used 

to bring the values below 1,000,000. This is due to the limitations of the HHF File 

Format.

6. HHF File Path is the root directory for all HHF files. A folder for each meter with con-

verted files is created in this path and .hhf files for that meter are placed in that 

folder. The default directory for HHF Folders is shown in the screen. Click Browse if 

you wish to designate another path.

7. Click Apply to save changes. 

8. Click OK to close the screen.



     Doc#    E107707                                                19 - 52

             19: Viewing Logs

19.4.2: Setting up Logs for Use with the HHF Converter

1. Open the Device Profile for the currently connected meter.

2. Click on Trending Profile Settings > Trending Setup > Log 1 (or Log 2). The Trend-

ing Log Profile screen.

3. Click the “<HHF>” button in the center of the screen. The HHF button automatically 

sets up a default Historical log and settings for the log. 

The HHF changes include the following:

•   All items are removed.
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•   Four items are added: Q1+4 Interval Primary, Q2+3 Interval Primary, Q1+2 

Interval Primary, Q3+4 Interval Primary

•   The Interval between Records is set at 15 minutes

•   The Accumulation Interval is set at 15 minutes

NOTE: These settings can be changed. However, keep the following considerations in 

mind:

•   Only Interval Energy items can be used.

•   The Record Interval and the Accumulation Interval MUST be the same. If they 

are not, the .hhf file created may be corrupt. These intervals are set in the 

Device Profile.

• Record Interval is set in the Trending Log Time Interval. 

• Accumulation Interval is set in Energy, Pulses and Accumulations in the 

Interval.

•   There can be 16 items, maximum.

4. Click OK to go back to the Device Profile screen.

5. Click Update Device to save the settings to the meter.

6. A “Resetting Logs” Warning appears. Click OK to update the meter with the new 

settings.
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19.4.3: Using the Command Line Interface

When it is enabled, the HHF Converter works with CommunicatorPQA® software to 

automatically generate converted HHF files when historical logs are retrieved. How-

ever, you may want to convert HHF files for a specific period interval in order to use 

them with another software. You can do so using the Command Line interface.

NOTES: 

•  All command line arguments must be preceded by -- (e.g., --PERIOD_INTERVAL 

“day”).

•  All command line arguments are optional; running the program without arguments 

will show the screen (see 19.4.4: Using the HHF Converter, on page 19-56).

These are the command line arguments for manual HHF conversion:

•  DATABASE "FILENAME" - (Optional) The path of the database file to be converted 

(*.db, *.sbl, *.nbl, *.mfnbl).

--DATABASE “C:\Users\Public\Documents\Electro Industries\Communica-

tor_Ext\Retrieved Logs\Shark200Unit8.sbl” 

•  OUTPUT_PATH "FOLDER" - (Optional) The folder where the converted output files 

will be saved. The default output path is C:\Users\Public\Documents\Electro Indus-

tries\Communicator_Ext\Retrieved Logs\HHF Files\ 

--OUTPUT_PATH "C:\Users\Ndeibler\Documents\HHF"

•  START_TIME "yyyy/mm/dd" - (Optional) The start date in log data for conversion. 

The default is 1 year earlier than the current date, on the first day of the current 

month; e.g, if today is February 24, 2017, the default start time would be February 

1, 2016. 

--START_TIME "2017/01/05"

•  END_TIME "yyyy/mm/dd" - The end date in log data for conversion. The default is 

a month from the current date, on the last day of the month, at 23:59:59; e.g., if 

today is February 24, 2017, the default end time would be March 31, 2017.

--END_TIME "2017/03/06" 
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•  PERIOD_INTERVAL "PERIOD" - The interval on which to split files. The default is 

"month." 

•  “unlimited" - The entire input date range will be processed at one time.

•  "year" - The input date range will be broken into years and be processed one 

period at a time.

•  "month" - The input date range will be broken into months and be processed one 

period at a time.

•  "week" - The input date range will be broken into weeks and be processed one 

period at a time.

•  "day" - The input date range will be broken into days and be processed one 

period at a time.

--PERIOD_INTERVAL "week"

   For example, if you wanted to convert the log data from January 1st 2017 to Janu-

   ary 15th 2017, with a period interval of week, you could use:

“C:\Program Files (x86)\Electro Industries\LogViewer\HHFConverter\HHFConverter.exe”

--DATABASE “C:\Users\Public\Documents\Electro Industries\Communicator_Ext\Retriev-

edLogs\Shark200Unit8.sbl”

--START_TIME “2017/01/01”

--END_TIME “2017/04/15”

--PERIOD_INTERVAL “week”
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19.4.4: Using the HHF Converter

Although HHF files are automatically converted, when enabled, by the Communica-

torPQA® application, you can also use the HHF Converter independently, either 

through Command Line, shown in the previous section, or as shown in the instruc-

tions in this section.

1. Run HHFConverter.exe without command line arguments. The program is found in 

this directory path:

[Communicator EXT Install Dir]\LogViewer\HHFConverter\HHFConverter.exe

2. Locate the database file of the meter you want to convert data for.

3. Wait for conversion to take place (conversion may take several minutes).

4. The converted file is stored in the location shown in 19.4.6: HHF Files, on page 19-

57.
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19.4.5: Supported Files and Meters

The only supported data for the HHF Converter is interval energy items from a histor-

ical log. The meters supported for HHF export are the Nexus® 12xx and 1500+; and 

the Shark® 200 and 270 meters.

19.4.6: HHF Files

Storage

•  The HHF files automatically generated by the CommunicatorPQA® application (or 

the HHF Converter run manually, as shown in 19.4.4: Using the HHF Converter, on 

page 19-56)are stored in this directory:

C:\Users\Public\Documents\Electro Industries\Communicator_Ext\Retrieved 

Logs\HHF Files 

•  If Command Line argument is used to generate the files, they are stored where 

OUTPUT_PATH was specified.

NOTE: Each meter's output files are stored in a subdirectory with the name of the 

meter’s designation meter, for example:

C:\Users\Public\Documents\Electro Industries\Communicator_Ext\Retrieved 

Logs\HHF Files\MyMeterDesignation

Naming Conventions

•  The extension for the HHF output files is .hhf.

•  .hhf output files are named using the following template:

with [meter_designation]_[start_date]_[start_time]-[log_name]

•  meter_designation - The name given to the meter by the user.

•  start_date - The start date used by the converter; the format is yyyy-mm-dd.

•  start_time - The start time used by the converter; the format is hh:mm:ss.

•  log_name - The name of the log that was converted to HHF.
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•  An HHF output file example is as follows:

C:\Users\Public\Documents\Electro Industries\Communicator_Ext\Retrieved 

Logs\HHF Files\SubStation1\SubStation1_2017-01-11_16-30-00-INTERVAL_1.hhf

Additional File Details

NOTE: The Date (year, month and day) is the date of the oldest record in the log.

•   Log File: Contains a list of actions taken by the converter in the process of convert-

ing the Nexus® meter's file into .hhf format that may cause irregularities in the 

data. Additionally, it contains any errors that were encountered while converting. 

For example: Data that cannot be represented in .hhf format is found in this file. 

Shown in the previous figure is a typical example of Retrieved Log Files.

[HHF file list]

[Conversion action list]

[Error list]

•   Conversion Action List: List of all the conflicts with the HHF format that occurred in 

the Nexus® meter's file and the action taken to convert the files.

•   Trim <Time><Reason>: Value discarded from the .hhf file. “Time” is the time 

stamp of the value discarded and “Reason” is one of the following:

• Invalid Interval: Timestamp falls off the even time intervals. Value time-

stamps are rounded and overlaps are deleted.
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• Invalid Time: Timestamp either lies before the given beginning of the log 

or after the given end of the log. The record containing the timestamp 

has been removed from the list.

• Pad <Time start>”-”<Time end><Reason>: The values for the interval 

before “Time start” are repeated until “Time end”. “Reason” can be:

• Missing Interval: Original log missing values to make a continuous log. 

Values are added to maintain proper timestamps.

•   Error List: List of all errors encountered during conversion.

•   Error in file <File Name> “at” <Position>: Parsing error while extracting data 

from the input file. Position is the number of bytes from the beginning of the file 

to where the error occurred. This error most often occurs when an invalid log 

record type is included in the input.

•   Value out of range <Timestamp> <Channel> <Value>: The given channel’s 

value in the interval given by timestamp is outside of the range HHF can repre-

sent.

•   File not found <File Name>: The given input file (with path) does not exist.

•   File overwritten <File Name>: One of the created files in the path has the same 

name as an existing file. The old file has been overwritten.

•   File collision <File Name>: One of the created files in the path has the same 

name as an existing file and that file cannot be deleted. The new file was not 

created.

•   Invalid file <File Name>: The given input file is not a valid .nbl file.

•   Invalid data type <Data Type>: One of the channels contains data that HHF can-

not represent.

•   Path not found <Path Name>, Created: The given path was not found and the 

folder structure was created.
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19.4.7: Troubleshooting the HHF Converter

For your information, this is a short list of occasional problems with the probable solu-

tion.

•   Problem: Program quits while trying to create the HHF file.

•   Solution: This can be caused by too many values that are too large for the HHF 

file to hold. Try a larger scaling value.

•   Problem: Program quits right after opening; no file is created.

•   Solution: This is most often caused by an item in the historical log that the con-

verter does not recognize. Only Intervaled Energies are valid values for the con-

verter. Remove all invalid items from the log. Make sure that the correct log is 

selected in the HHF Options.

•   Problem: MV-90 will not load the file.

•   Solution: This can be caused by giving MV-90 a file or path that contains ‘ ‘ 

(spaces). Make sure that all files and paths leading to the HHF file contain no 

spaces.

•   Problem: MV-90 downloaded and converted log, but values are either incorrect or 

nonexistent.

•   Solution: This can be caused by downloading both logs and the wrong log is 

converted. Make sure that the correct log is selected in the HHF Options.

•   Problem: Log is OK, convert is OK, but when loaded into MV-90, it is rejected.

•   Solution: There may be too many errors in the historical log, including power off 

gaps, flashing, etc. MV-90 expects no gaps in the data in the .hhf file and tries to 

verify the integrity of the data. If data must be loaded, despite gaps, make sure 

Verification Feature in MV-90 is OFF.
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19.4.8: Set up MV-90 for Use with HHF Files

Follow these steps to set up the MV-90 application:

1. Open MV-90 and go to the MV-90 menu.

2. From the Menu Bar, click System-Control > System Parameters > Operations 

>Data Retrieval > Portable Readers and then click Enable Edit.

3. Change the value of “Retrieval/Import Key” to “Device ID” and click Save.

4. Go to Operations > UOM Codes > Descriptions. Verify that Code 1 is kWh/kW and 

Code 3 is kVARh/kVAR. These are the default MV-90 Mappings.

5. Exit System Parameters. From the Menu Bar, go to Databases >Master File > Main-

tenance.
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6. Click Edit > New Customer. 

The “Add Customer, Recorder & Channels” screen opens. On this series of screens, 

you will create a new Master File entry.

7. Enter the Customer, Recorder and Device ID.

NOTE: The Device ID must match the Meter name of the meter being used.
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8. Set the Number of Channels to 4 and click OK. The next screen opens.

9. On this screen, Enter Customer Information.
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10. Click the Save button to continue to the next screen. 

a. On this screen, Enter Recorder (Device) Information.

• If the meter has its Daylight Savings Time Option turned on, make sure 

the DST Option is checked in the Recorder Information: click the More tab 

>Device Follows DST.
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b. Highlight one of the channels in the list at the top to see the channel setting 

tabs - see the example below. 

• Enter Channel Information in the first tab.
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• Enter Multipliers & Readings Information in the second tab - see the 

example below.

• For Channel 1: On the Channel tab, set the Unit of Measure to 1 and on 

the Multipliers & Readings tab, set Meter & Pulse Multiplier to 0.0001 

(kWh). Fill out any other relevant information.

• For Channel 2: On the Channel tab, set the Unit of Measure to 1 and on 

the Multipliers & Readings tab, set Meter & Pulse Multiplier to 0.0001 

(kWh). Fill out any other relevant information.

• For Channel 3: On the Channel tab, set the Unit of Measure to 3 and on 

the Multipliers & Readings tab, set Meter & Pulse Multiplier to 0.0001 

(kVARh). Fill out any other relevant information.
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• For Channel 4: On the Channel tab, set the Unit of Measure to 3 and on 

the Multipliers & Readings tab, set Meter & Pulse Multiplier to 0.0001 

(kVARh). Fill out any other relevant information.

19.4.9: Import an HHF File into MV-90

Follow these steps to import a file:

1. Open MV-90 and go to the MV-90 menu. In MV-90’s Menu Mode, go to Retrieve-

Data > Import Reader File. 
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2. The “Import Reader File” screen opens. 

Click the Browse icon to locate an HHF file to import. 

•   Verify that the Device ID and Read Time are correct. 

•   The HHF file is saved with the retrieved logs:

C:\Users\Public\Documents\Electro Industries\Communicator_Ext\Retrieved 

Logs\HHF Files

3. Click either the Schedule icon or the Run Here & Now icon:

•   The Schedule option imports the file later.

•   The Run Here & Now option imports the file now.

4. When a file is imported, a report is generated (overview of data and success of 

importing). See your MV-90 documentation to locate the report.

Browse Icon
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5. The HHF file import task should show up in the Task List box - see example below. 

If it doesn’t, click the “Scan for Tasks” icon.

•   The Time In field lists when the task was loaded; The Time Due fields lists when 

the task is scheduled to run.

•   When an HHF file is imported, it is added to the database for that client. This 

data can be viewed in many ways. See your MV-90 documentation for details.

NOTE: MV-90 is based on a DOS Program. File names (including folder names) must 

not contain blank spaces. All blank spaces should be represented by “_” (underscore). 

Folder names cannot be longer than 8 characters. When setting up MV-90, make sure 

that all paths follow these limitations.

•   The Progress Window is displayed while converting the logs. This window is always 

displayed. The window is composed of two parts:

•   Progress Bar: A bar which displays the percentage complete in graphical (bar) 

and text () format.

•   Text: Output which specifies the actions being taken by the converter, including 

errors encountered.

Scan for Tasks Icon
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20: Other Functions and Screens
This chapter explains how to use the Tools Menu options, the Options screen, and 

other CommunicatorPQA® software features. The Tools section of the software pro-

vides a series of settings and features that enable a user to perform a variety of func-

tions and commands in the meters. The features include setting device time, 

upgrading firmware, and many other functions. The Options screen lets you change 

the application’s language, among other features. Note that most of the example 

screens in this chapter are from a meter with the maximum V-SwitchTM key - not all 

options are available at lower level V-SwitchTM keys.

20.1: Tools Menu

The Tools Menu, available from the Main Screen’s Menu Bar, gives you access to addi-

tional software features. Not all meters have the same Tools Menu options. See the 

examples below, from a Shark® 200 meter.
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The following sections explain the options and, where applicable, how they differ 

between meters. Note that some of the Tools menu options are explained in other 

chapters of this manual:

•  Passwords are explained in Chapter 6: Meter Security on page 6- 1.

•  Firmware Update is explained in Chapter 25: Firmware Updating on page 25- 1.

•  Flash Network Card is explained in 25.2.1: Update the Internal Network Card’s 

Firmware on page 25- 3.

20.1.1: Edit Current Device Profile

The first Tools Menu item for all of the meters is Edit Current Device Profile. It 

performs the same action as clicking the Profile icon - opens the Device Profile screen 

for the currently connected meter, allowing you to configure programmable settings 

for the meter. See Chapter 7 for more information on the Device Profile screen.

The Nexus® 1262/1272 meter has an additional Tools Menu option: 

Tools>Edit Current Device Profile (Without the LCD Programmable Settings),

which lets you load the meter’s Device Profile without loading the LCD display’s 

programmable settings, which can take a while to load. This gives you the option of 

opening the Device Profile more quickly, if you do not need to make changes to the 

display’s settings, or if you would rather make those changes separately from the rest 

of the Device Profile. See the next section for instructions on programming the display 

separately.

20.1.2: Edit LCD Programmable Settings

This option lets you set up a meter’s on-board display. The specific fields and 

programming you perform depend on the meter type. 

1. From the Menu Bar, select Tools>Edit LCD Programmable Settings. 
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•   If you are connected to a Nexus® 1500/1500+ meter, you will see the screen 

shown below. It lets you customize the time and date presentation for the 

®meter's touch-screen display. 

a. Use the pull-down menus to select the date and time format you want to 

display on the touch-screen display. The example fields change to show 

you what your selections will look like.

b. Click the Update button to implement your selections and exit the screen; 

click Cancel to exit the screen without making any changes.

•   If you are connected to a Nexus® 1262/1272 meter, this option will open the 

same screen you see when you select Revenue and Energy Settings>Display 

Configuration from the meter’s Device Profile screen. See 12.2.4: Display Con-

figuration on page 12- 37, for instructions on programming the screen, which 

has extensive capabilities and options. This feature lets you program the LCD 

display separately from the rest of the Device Profile.
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20.1.3: Change V-SwitchTM Key

EIG’s Nexus® 1450/1500/1500+, Nexus® 1252, Shark® 200, Shark® 250, Shark® 

270, Shark® 50 meter, Shark® 100, Shark® 100S, MP200TM Metering System, and 

ST40 meters offer V-SwitchTM key upgrade. This feature allows the meter to be 

upgraded to more advanced functionality, in the field, without needing to be removed 

from installation. The specific features and the specific V-Switch levels differ for the 

different meter types. Refer to the Installation and Operation manual for your meter 

for information.

All of the meters that support V-SwitchTM key use the same screen to update the key.

•   For the meters other than the Shark® 50/100/100S meter, click Tools>Change V-

Switch to open the screen. 

•   For the Shark® 50/100/100S meter, click the Change V-Switch button from the 

meter’s Device Profile screen, System Settings tab (see 9.1.4: Configuring Settings 

on page 9- 10).

a. As explained in the screen, you need to contact EIG with your meter’s serial 

number, the number of the V-SwitchTM upgrade you want, and a credit card 

for payment. You will be given a V-SwitchTM key. (See your meter’s Installa-

tion and Operation manual for detailed instructions.)

b. Enter the V-SwitchTM key in the screen and click Update. You will see a 

message when the meter has been updated with the new V-SwitchTM key.
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20.1.4: Set Device Time

The meters that support logging use an on-board clock for time stamping any logs 

being recorded. If you do not have the meter set to line frequency time synchroniza-

tion, IRIG-B, or SNTP the meter’s time is being controlled by its internal crystal. 

Different meters differ in terms of drift, but typically meters with 20 ppm crystals will 

drift 30 seconds per month when set to internal crystal. You may want to use this 

feature to reset the meter’s time if it drifts too far from actual time. Please refer to the 

specific meter specification for actual clock ratings.

1. From the Main screen’s Menu Bar, select Tools>Set Device Time. You will see the 

screen shown below.

•  To synchronize the meter and your computer, leave the Use PC Time box 

checked.

•  To set the date and time independently from the PC, de-select the Use PC Time 

box and enter the time and date settings.

2. Click the Send button to update the meter's time settings and exit the screen; click 

Cancel to exit the screen without making any changes.
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20.1.5: Retrieve Device Time

To retrieve the meter's current time and date settings:

1. From the Main screen’s Menu Bar, select Tools> Retrieve Device Time. You will see 

the screen shown below. Date and running time display in the LEDs.

•  If IRIG-B is enabled for your meter, IRIG-B is displayed next to the time.

•  If Line Frequency Clock Synchronization is enabled for your meter, LINE SYNC is 

displayed next to the time.

•  If Daylight Savings Time is active, DST is displayed.

•  If Cold Load Pickup is active, Active Cold Load is displayed.

•  If clock compensation is active, Clock Compensation Operational is displayed.

2. Click OK to exit the screen.
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20.1.6: Set Clock Compensation (Nexus® 1252/1262/1272 Meters)

Nexus® meters have a feature that allows a user to manually trim the internal clock 

timing. The feature allows the user to determine what the meter’s actual monthly 

error is and compensate for it by adding or subtracting those seconds into the time. 

This feature will trim the clock but is not the preferred meter for improving timing 

accuracy. The more traditional time frequency line synchronization will work better in 

jurisdictions with controlled frequency. 

From the Main screen’s Menu Bar, select Tools>Set Clock Compensation to set the 

meter’s clock to be faster or slower. You will see the screen shown below.

a. Click the box next to Enable Compensation.

b. Enter the number of seconds per month you want the time adjusted.

c. Click the Faster or Slower button.

d. Click Update to save the setting.

20.1.7: Reset Device Information

This feature lets you reset logs, accumulators, and TOU data. The options your meter 

has determine the exact data you can reset. 

This feature will normally be disabled under password control. Resetting the parame-

ters is not reversible so be careful not to reset energy or log data before saving the 

readings elsewhere.
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1. From the Main screen’s Menu Bar, select Tools>Reset Device Information. The 

screen you see depends on the meter type you are connected to. 

•   The screen below is from a Nexus® 1500/1500+ meter. The screen for the other 

Nexus® meters is the same, except that there are less logs to reset; and for the 

1450 meter there is a message that resetting all logs may take up to two min-

utes.

a. This screen has three tabs. The Log Data Reset screen is shown above.

b. Click the tabs to view the Accumulators, Max/Min, and Demands screen 

and the TOU Registers screen. 

NOTE: If you are updating a 1500+ with firmware version 15.2, you must 

first reset the PQ log.
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• For a Nexus® 1500+ meter that is running TOU in Self Read mode, there 

are restrictions on what can be reset from the TOU tab. See the screen 

below.

• None of the disabled/grayed out items can be reset individually when 

the Nexus® 1500+ meter is in TOU Self Read mode. 

• The TOU Master Reset option will reset all current and prior TOU data, 

meter Max/Min values, meter energy values, meter pulse accumulation 

values, and meter cumulative demand values. It should only be used 

in either of the two following conditions: 1. Meter initial deployment 

with new meter profile and/or new TOU profile; 2. Updates to meter 

profile and/or TOU profile which may affect the TOU readings, for 

example, meter scaled energy format changes, Demand Type change, 

access of TOU data via DNP with DNP scaling changes, or Pulse accu-

mulation setup changes. 

IMPORTANT! The user should back up all existing meter data before 

performing this reset operation.

Note that this reset command is only available under the meter’s Level 

2 password access, if meter security is enabled.

• See 15.3: Nexus® 1450/1500+/Shark® 250/270 Meter’s TOU Settings 

on page 15- 45, for additional information on TOU for the Nexus® 

1500+ meter. 
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•   The screen below is from a Shark® 200 meter.

•   The screen below is from a Shark® 100 meter.
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•   The screen below is from an MP200-Y meter. The screen for the MP200-S meter 

is very similar, except that there are 24 individual meters that can be reset for 

Max/Min and/or Energy.
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•   The screen below is from a Shark® 250/270 meter.

•   The screen below is from an ST40 meter.

3. For any of the Reset screens, click on the box(es) beside the value(s) you want to 

reset. 

4. Click OK (Nexus® meters) or Reset to process your selections and exit the screen; 

click Cancel to exit the screen without making any selections. 
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5. For each box you select, a message window opens, telling you the reset is 

complete. Click OK to close the message window(s). 

 NOTES:

•   The screen options you see may vary depending on your meter’s V-SwitchTM key.

•   For the Shark® 250/270 meter, when resetting the non-TOU energy in the meter, 
the TOU energy must be also initialized, in order to keep the TOU module synchro-
nized correctly.

•  For the Shark® 250/270 meter, “Initialize Time of Use Data based upon Accumula-
tor method” will clear time of use data as follows:

•  If the TOU accumulation method is set to "Continue Time of Use accumulation 
where previous energy left off," then the total accumulations will use the current 
energy values of the meter.

•  If the TOU accumulation method is set to "Start from zero," then the accumula-
tions will be set to zero. 

•   For the Shark® 200 meter, when installing a Pulse Output/Digital Input card or a 
Relay Output/Digital Input Card, we recommend you reset the accumulators for the 
card, in order to prevent erroneous counts. 

•   This feature requires a Password if Password for Reset is enabled in the meter. See 
Chapter 6 for more information on passwords.

•   For the MP200-Y and MP200-S, you can perform a reset for all of the meters or 
individual meters.

20.1.8: Reset EN 50160/IEC 61000-4-30 Information (Nexus®
             Meters)

Use this feature to reset the EN 50160/IEC 61000-4-30 counters and accumulators 

for the current period. 

1. From the Main screen’s Menu Bar, select Tools>Reset EN50160/IEC61000-4-30 

Information. You will see the message window below.
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2. Select the option you want: to reset the current week and year data, or to erase all 

of the EN 50160 report files in the meter. 

IMPORTANT! Exercise care as with the other reset options. Be sure you select the 

correct option and/or make sure the data is backed up somewhere if there is the 

possibility you will need it again.

3. You will see a message window asking if you are sure you want to perform the 

reset.Note that the wording is slightly different for the 1252 meter.

4. Click either:

•   Yes - to perform the reset.

•   No - to close the message window without resetting the information.

20.1.9: Retrieve Device Status

This option opens the Device Status screen for your meter. See Chapter 4 for informa-

tion on the Device Status screens.

20.1.10: Device Information

For the Nexus® 1500/1500+ meter, the Shark® meters, and the MP200 metering 

system, this option performs the same action as the Retrieve Device Status option. 
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For the Nexus® 1252/1262/1272 meters, from the Main screen’s Menu Bar, select 

Tools>Device Information to see the screen shown below. This is an example from a 

Nexus® 1272 meter.

•   This screen is the same as the newer Device Status screen. It contains information 

concerning the versions of the meter’s firmware and other, related information.

20.1.11: Option Card Information/Board Information/
                I/O Board Status

The Nexus® 1500/1500+ meter, Shark®200/250/270 meter, and MP200TM metering 

system have optional or embedded I/O cards and boards. This option lets you view 

status information for the cards/boards that are in the meter. Refer to your meter’s 

Installation and Operation manual for additional information about I/O cards and 

boards for your meter.

•   For the Shark® 200/250/270 meter, from the Main screen’s Menu Bar, select 

Tools>Option Card Information to display the screen shown below. It displays 



     Doc#    E107707                                               20 - 16

             20: Other Functions and Screens

information about any Option cards installed in the meter: Type, Sub Type, Card 

Name, Serial Number, and Version. Click Close when you are done with the screen.
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•   For the MP200TM metering system, from the Main screen’s Menu Bar, select Tools> 

Board Information to display the screen shown below. It displays information about 

the Relay Output/Digital Input card: Type, Card Name, Serial Number, and Ver-

sion.Click Close when you are done with the screen.

•   For the Nexus® 1500/1500+ meter, from the Main screen’s Menu Bar, select 

Tools>I/O Board Status to display the screen shown below. All installed I/O Boards 

are listed, along with the following information for the board:

•  Location ID

•  Hardware Name

•  Serial Number

•  Slot Mask

•  Hardware Version

•  Firmware Version

•  Required PPC Run Version

•  Board Status

•  Test Status

•  Test Error

•  Test Location

•  Test Operator
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•  Test Date/Time

Click Refresh to update the display with the most current information; click OK 

to close the screen.
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20.1.12: Relay Control

This feature allows you to manually change the state of an installed relay output for 

the Shark® 200/250/270 meter optional Relay Output/Digital Input card and the 

MP200TM metering system’s embedded Relay Output/Digital Input card. For instruc-

tions for using relay control for the Nexus® meters’ optional external Relay Output 

module, see Chapter 14.

1. From the Main screen’s Menu Bar, click Tools>Relay Control. You will see the screen 

shown below. 

2. The screen displays the current state of the relay outputs. To change the state:

a. Click the checkbox next to the relays you want to change.

b. Select the desired state in the Select New State field.

c. Click Apply. If this feature is Password Protected, the Enter Password screen 

opens. You must enter the correct password to make the change.

3. Click OK to close the screen.

NOTES:

•   A relay output cannot be manually controlled if a Limit has been assigned to it. 

•   If the Relay State field is “State is Unknown,” verify that the Relay Output card’s 
configuration is correct. You may also see this message after you have performed a 
Reset. Select a new state for the relay and click Apply. 
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20.1.13: Manual Waveform Capture

This feature gives you the ability to force the meter to capture a waveform. 

•   For the Shark® 200/250/270.ST40 meter and the Nexus® 1252/1262/1272 

meters, from the Main screen’s Menu Bar, click Tools>Manual Waveform Capture.

•   You will see the screen shown above if you are connected to a Shark® 200/250/

270 meter. It gives you information on the Waveform log: the amount of mem-

ory being used by it, the number of Waveform captures, the number of records 

in the log, the maximum records the log can hold, the time stamp of the most 

recent Waveform capture, and the current time. 

• To perform a waveform capture, click Trigger Manual Capture.

• Click OK to close the screen. 

•   You will see the screen shown above if you are connected to a Nexus® 1252/

1262/1272 meter. It gives you information on the Waveform Triggers and Wave-

form Samples: the number of records for each, the amount of memory being 

used, the timestamps of the newest and oldest records, the record size, the 
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maximum records that can be held by each, and the amount of memory used by 

each.

• To perform a waveform capture, click Trigger Now.

• Click OK to close the screen.

•   For the Nexus® 1450/1500/1500+ meter, click either the Ret Logs icon or 

Logs>Retrieve Log(s) from Device. You will see the screen shown below.

• Click in the pull-down menu that says “Retrieve Selected Log(s) and 

choose Manual Waveform Capture. The bottom of the screen changes as 

shown below.

• Click Start to perform the waveform capture.

• When you are done, click Close.
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20.1.14: Performing CT and PT Compensation

The CT and PT Compensation feature allows you to remove an error caused by the 

CTs (external to unit) and PTs that are connected to the unit. This section is for the 

Nexus® meters. See 20.1.14.1: Performing CT and PT Compensation (Shark® 200 

and ST40 Meters) on page 20- 33, for the Shark® 200 meter’s CT and PT Compensa-

tion instructions; 28.2.8: CT and PT Compensation on page 28- 55, for the Shark® 

250 meter’s CT and PT Compensation instructions; and 26.2.6: CT and PT Compensa-

tion on page 26- 61, for the Shark® 270 meter’s CT and PT Compensation instruc-

tions

1. First make sure that CT/PT Compensation is enabled for your meter (see 11.2.4: 

CT and PT Compensation on page 11- 43 (Nexus® 1500/1500+ meter), 12.2.5: CT 

and PT Compensation on page 12- 57 (Nexus® 1262/1272 meter), and 13.2.5: CT 

and PT Compensation on page 13- 35 (Nexus® 1252 meter).

2. From the Main screen’s Menu Bar, select Tools>CT & PT Compensation>Calibration 

Table Status. You will see the screen shown below.

NOTE: If the screen says Disabled next to CT & PT Compensation, follow the 

instructions mentioned in step 1 to enable CT & PT Compensation.
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3. Click First Time CT & PT Comp Selection. You will see the message window shown 

below. Click OK to close the window.

4. Click Preload CT & PT Comp with initial values in the Calibration Status screen. You 

will see the message window shown below. Click OK to close the window. 

5. Click OK to close the Calibration Table Status screen.

6. Click Tools>CT & PT Compensation>View Calibration Tables. You will see the screen 

shown on the next page.
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7. This screen shows the factory values for CT and PT Compensation and the current 

CT & PT Compensation table. To make changes, first click Copy Factory Table to CT 

& PT Comp Table. You will see the message window shown below.   

8. Click Yes to continue (click No to cancel). CT & PT Compensation is now enabled 

and ready for corrections.
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9. To perform compensation, click Tools> CT & PT Compensation>Compensate CTs & 

PTs. You will see the screen shown below. This screen lets you collect data to deter-

mine the required correction(s)

The four step tabs in the middle of the screen - Voltage, Power at Unity, Power at 

60o phase, and Current Threshold, display Instructions for performing the step and 

entry fields you use to calculate the changes that should be made.

•   The first step, shown above:

a. Lets you enter the voltage phase error percentage you see when you apply 

voltage to each phase. 

b. When you enter an error percentage, the recommended adjustment 

appears in the corresponding Gain Factors New field. 
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c. When you are done, click Write new Gain Factors. You will see the message 

window shown below. Click Yes to update the CT & PT Calibration table with 

the new Gain Factors.

d. You will see the message window shown below. Click OK to close the 

window.
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•   Step 2, shown above:

a. Lets you enter the power error percentage for each phase when current is 

applied. 

b. When you enter an error percentage, the recommended adjustment 

appears in the corresponding Gain Factors New field. 
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c. When you are done, click Write new Gain Factors. You will see the message 

window shown below. Click Yes to update the CT & PT Calibration table with 

the new Gain Factors.

d. You will see the message window shown below. Click OK to close the 

window.
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e. Click Next to follow the procedure for the next calculation point. When you 

are done with all of the calculation points for the Power at Unity step, you 

can continue to the next step.

•   Step 3, shown above:

a. Lets you enter the power error percentage for each phase when current is 

applied to each phase at a 60 degree phase shift from voltage. 

b. When you enter an error percentage, the recommended adjustment 

appears in the corresponding Gain Factors New field. 
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c. When you are done, click Write new Gain Factors. You will see the message 

window shown below. Click Yes to update the CT & PT Calibration table with 

the new Gain Factors.

d. You will see the message window shown below. Click OK to close the 

window.
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e. Click Next to follow the procedure for the next calculation point. When you 

are done with all of the calculation points for the Power at 60o Phase step, 

you can continue to the next step.

•   Step 4, shown above:

a.Lets you enter zero out the current readings by applying zero Amps to the 

current inputs and modifying the threshold value until the current reads 0. 

b. Write the new threshold value in the Current Threshold New field. 

NOTE: Some meters do not have step 4.
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c. When you are done, click Write New Threshold. You will see the message 

window shown below. Click Yes to update the CT & PT Calibration table with 

the new Gain Factors.

d. You will see the message window shown below. Click OK to close the 

window.

e. Click OK to close the CT & PT Compensation screen. You can click Print to 

print the screen information.
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20.1.14.1: Performing CT and PT Compensation 
            (Shark® 200 and ST40 Meters)

1. From the Main screen, click Tools>CT & PT Compensation>View CT & PT Compen-

sation Factors to see the screen shown below.

2. Click OK to close the message window and then correct the Line Frequency if you 

don’t want it to be set to the calibration frequency, which is the default. 
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3. CT/PT compensation is used to correct for errors caused by the current transform-

ers (CTs) (external to the meter) and Potential/Voltage transformers (PTs) con-

nected to the meter. Use this screen to set compensation factors (Input fields), 

save them to a file (Save to File button), write them to the meter (Write Factors to 

Device button), read them from the meter (Read Factors from Device button), load 

from a file (Load from File button), and enable compensation (Enabled checkbox).

    NOTES:

•   PT compensation is not being applied to symmetrical components.

•   For 2.5 Element Wye and 2 CT Delta hookup, set the B phase PT factor to 0.
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4. The entry fields and acceptable entries are as follows:

•   Enabled: click to enable CT and PT Compensation.

•   Percent of error values in voltage reading due to PT: you can enter 4 values per 

phase for 4 voltage levels 69V, 120V, 230V, and 480V. The allowable range is -15 

to +15. For example, if a reading is 1 higher than expected, enter -1 to adjust it.

•   Percent of error in current reading due to CT: you can enter 4 values per phase 

for 4 current levels 0.25A, 0.5A, 1A, and 5A. The allowable range is -15 to +15. 

For example, if a reading is 1 higher than expected, enter -1 to adjust it.

•   Frequency: enter your system’s frequency. The allowable range is between 45 

and 65 Hz.

•   Phase Compensation Correction Factors: Angle, percentage of Deviation, and 

Counts (time advance or delay in phase shift in term of counts) where 1 count 

=1.2 microseconds change. You can enter 4 values per phase for 4 current levels 

0.25A, 0.5A, 1A, and 5A. 

        NOTES:

• The allowable range for counts is -50 to +50.

• Each positive count adds 1.2 microseconds of time delay to the phase 

compensation.

• Each negative count adds 1.2 microseconds of time advance to the phase 

compensation.

5. Click the buttons on the bottom of the screen to perform the following actions:

•   Load from file: click to select a file containing the CT and PT Compensation fac-

tors you want to use.

•   Save to file: click to save the current entries to a file.

•   Write Factors to device: click to load the current entries to a device.

•   Read Factors from Device: click to download the CT and PT compensation factors 

from a device to the screen’s entry fields.
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6. Click OK to close the screen.

Formulas and example settings:

Voltage Compensation

Vcomp= Vcalc * PTcf

PTcf=1+ (0.01*Ve)   

where Ve is the error percentage due to the PT at that voltage level

For example, if Vcalc = 100V; and error percentage @ 100V is 5.

Then:

PTcf =  1+(0.01*5) =  1.05

Vcomp = 100* 1.05 = 105

Current Compensation

Icomp= Icalc * CTcf

CTcf=1+0.01*Ie    

where Ie is the error percentage due to CT at that current level

For example, if Icalc = 5A; and error percentage @ 5A is 5.

Then:

CTcf =  1+0.01*0.5  = 1.05

Icomp  = 5* 1.05  = 5.25 
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20.1.15: Test Mode and Preset Energy Accumulators 

Test Mode lets verify a meter’s accuracy. When a meter is put into Test Mode, all of 

the energy registers are frozen, the display is set to 0, and the user can access the 

energy measurement test sequences.

The Energy Preset, or Preset Accumulators, feature supports Test Mode. This feature 

allows you to easily swap a new meter for a meter being removed for testing and ver-

ification. Download the energy accumulator register values and upload them to the 

new meter. This way, the new meter can continue to accumulate where the old meter 

left off. ®

•  See the Nexus® 1262/1272 Meter Installation and Operation Manual for instruc-

tions on using Test Mode for the Nexus® 1262/1272 meter and see 20.1.15.2: Pre-

set Accumulators for the Nexus® 1262/1272 Meter on page 20- 43, for instructions 

on using Energy Preset for the Nexus® 1262/1272 meter. 

•  For the Nexus® 1500+ meter, follow the instructions in 20.1.15.1: Test Mode and 

Preset Energy for the Nexus® 1500+ Meter on page 20- 38.

•  For the Shark® 250 meter, follow the instructions in 20.1.15.4: Test Mode and 

Energy Preset for the Shark® 250 Meter on page 20- 48. 

•  For the Shark® 270 meter, follow the instructions in 20.1.15.3: Test Mode and 

Energy Preset for the Shark® 270 Meter on page 20- 45.
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20.1.15.1: Test Mode and Preset Energy for the Nexus® 1500+ Meter

1. Click Tools>Test Mode>Set Test Mode. The screen shown below opens.

2. Click Enter Test Mode. The screen shown below opens.

3. Use this screen to select the type of compensation to apply to the Test Mode. You 

should select the same compensation you are using for the meter. Refer to 11.2.4: 

CT and PT Compensation on page 11- 43 and 11.2.5: Transformer / Line Loss Com-

pensation on page 11- 43, for instructions on setting the meter’s Transformer and 

CT/PT compensation. Your choices are:

•  No compensation - Test Mode readings will be obtained without any compensa-

tion applied.
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•  Transformer loss compensation - your setting for Transformer Loss compensation 

will be applied to the readings in Test Mode.

•  CT-PT compensation - your setting for CT/PT compensation will be applied to the 

readings in Test Mode.

•  Transformer loss and CT-PT compensation - both your settings for Transformer 

Loss compensation and CT-PT compensation will be applied to the readings in 

Test Mode.

4. Click Continue. You will see the Test Mode screen again. You will see a message 

that Test Mode is starting and then you will see a message that the meter is in Test 

Mode, with the compensation you selected and the values that are being read, also 

displayed. See the example screen on the next page. 

5. WHQ14/VARHQ12 above indicates that the watt-hour readings from quadrants 1 

and 4, and the VAR-hour readings from quadrants 1 and 2 are being read in Test 

Mode. The BOTH comp means that both Transformer loss and CT-PT compensations 
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are being applied. To choose a different energy reading source, click the Change 

Operation button. You will see the screen shown below.

6. The options on this screen are:

•  WHQ14/VARHQ12 

•  WHQ14/VARHQ12 

•  WHQ14/VARHQ12 

•  WHQ14/VARHQ12 

7. Make your selection and click Continue. The Test Mode screen is redisplayed, with 

the current reading source reflecting your selections. 
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8. If you want to set Energy Presets, click Close to close the Test Mode screen (Test 

Mode will still be active) and continue to step 9. If you do not want to set Energy 

Presets, once you are done with Test Mode, click Exit Test Mode. You will see a 

message that the meter is exiting Test Mode and then Test Mode will stop. Note 

that the timeout that you set up in Test Mode Configuration (see 11.2.10: Test 

Mode Configuration (Nexus® 1500+ Meter) on page 11- 52) will cause the meter 

to exit Test Mode after a certain amount of time with no activity, even if you do not 

actively exit Test Mode.

9. Click Tools>Test Mode>Energy Presets. You will see the screen shown below.

10. The accumulators that can be pre-set are listed on the left of the screen with their

  current values. You can scroll to see accumulators not displayed. 

11. To enter a preset value, click the preset box on the same line with the value and

  enter the preset value in the New Value field. The Settings field shows the format

  your entry needs to be in, that is, the number of digits and decimal places; for

  example, 999999.9kWh.
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12. When you have entered all of the preset values you want, click Set to send them

  to the meter’s memory. Once the meter is out of Test Mode, these new values will

  take effect.

13. You can also save the preset values in a .csv file or load preset values that are

  already saved in a .csv file to this screen:

•  To save the values, click the Save button and give the file a name when you are 

prompted.

•  To load a .csv file, click the Load button and locate the file you want to use.

14. When you have finished with the Test Mode Preset screen, click the red X

  to close it. 

15. When you want to exit Test Mode, click Tools>Set Test Mode to open the Test

  Mode screen, and then click the Exit Test Mode button. 
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20.1.15.2: Preset Accumulators for the Nexus® 1262/1272 Meter

1. From the Main screen’s Menu Bar, select Tools>Test Mode>Preset Accumulators. 

You will see the screen shown below.
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2. Click the tabs to navigate between the Test Mode Preset screens. There are screens 

for: 

•   Primary Energy 

•   Secondary Energy

•   Primary Energy (Quadrants)

•   Secondary Energy (Quadrants)

•   Internal Input Accumulators

•   KYZ Output Accumulators

•   I & V Squared T Accumulators

•   Cumulative Demand (Secondary)

•   Uncompensated Energy

•   Q Hours

• Each screen has a Current Value, New Value and Preset Box for each of 

its accumulators.

• A new meter will have zeros for Current Values.

3. For any accumulators you want to preset, enter the new value, click the Preset Box 

next to it, and when you are done with that tab, go to any other tabs you want to 

enter preset values for. 

4. When you have finished entering all of the preset values you need, click Set to 

implement the new settings in the currently connected meter. You also have other 

options:

•   Save - to save the new settings to a file.

•   Load - to load a file of previously saved settings.

•   Cancel - to exit without making changes.
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20.1.15.3: Test Mode and Energy Preset for the Shark® 270 Meter

The Shark® 270 meter supports Test Mode. This section details the Test Mode and 

Energy Preset features available through software (see 20.1.15: Test Mode and Preset 

Energy Accumulators on page 20- 37). The Test Mode sub-menu is shown below.

20.1.15.3.1: Preset Energy

The Shark® 270 meter lets you pre-set billing revenue registers to specific values. 

This is used when replacing meters in the field, to create continuity with the prior 

register values.

1. From the Main screen’s Menu Bar, click Tools>Test Mode>Preset Energy.

2. The accumulator fields are listed on the left of the screen, along with their current 

value. The settings field shows the format for energy scaling that was set in the 

Configuring Energy, Power Scaling, and Averaging setting of the meter’s Device 

Profile (see 26.2.1: Configuring Energy, Power Scaling, and Averaging Method on 

page 26- 41).
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3. To enter a new value for the accumulator, double-click in the New Value field for 

that accumulator.

4. The Preset box is now checked and the New Value field is highlighted. Enter a new 

value for the accumulator.

5. You can copy a column from an Excel file and then click Paste Column to copy it 

into the “New Value to set in meter” fields. If you are not replacing the entire 

column, click in the first field in which you want to copy the Excel data.

6. Click Copy to copy all of the screen data to the clipboard. You can then paste it into 

another program, e.g., Excel.

7. When you have finished entering the preset values, click the Set button (it 

becomes selectable when you have made New Value field entries).

8. You will see messages on the bottom of the screen as the preset file is being sent to 

the meter. Once the meter is updated, click Exit to close the screen.
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20.1.15.3.2: Poll Test Mode Data

Use this command to view test mode data.

1. From the Main screen’s Menu Bar, click Tools>Test Mode>Poll Test Mode Data.

•  The meter’s internal energy data is shown in the Values column.

•  You can copy this data to the clipboard (for pasting into another application) by 

clicking the Copy button. 

2. Click OK to close this screen.
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20.1.15.3.3: Copy Energy File

Use this command to copy a preset energy file to a Shark® 270 meter.

1. From the Main screen’s Menu Bar, click Tools>Test Mode>Copy Energy File.

2. Click Browse to locate the saved preset energy file.

3. Click Save to save the file to another location, or click Load to load the energy val-

ues from the file to the currently connected meter.

4. Click OK to close the screen.

20.1.15.4: Test Mode and Energy Preset for the 
                     Shark® 250 Meter

The Shark® 250 meter supports Test Mode. This section details the Test Mode and 

Energy Preset features available through software. The Test Mode sub-menu is shown 

below.

NOTE: When the meter is in Test Mode, the following features are blocked or dis-
abled:

•  Blocked - Firmware updates

•  Blocked - Meter Settings (Unit and TOU)

•  Blocked - Energy Preset

•  Blocked - Energy Reset
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•  Blocked - Demand Reset

•  Blocked - Log Resets

•  Blocked - Reset Pulse Accumulators

•  Blocked - Unit Reset

•  Disabled - Line Sync Time synchronization

20.1.15.4.1: Set Test Mode

1. To set up test mode for the meter, click Tools>Test Mode>Set Test Mode.

2. Use the buttons on this screen to perform the following functions:

•  Enter Test Mode: click to enter Test Mode. You will have the amount of time pro-

grammed in the System Settings screen, e.g., 10 minutes, to perform the test-

ing (see 28.1.3: Configuring System Settings on page 28- 7 for instructions on 

setting the Test Mode timeout period). 

NOTE: As long as the meter recognizes measurable load (i.e., total power is 

greater than 0), the meter uses an extended timeout period consisting of the 

programmed timeout plus the programmed Block Interval Time for block window 

averaging or programmed sub interval time for rolling window average. This is to 

insure that the meter completes a Demand test without interruption.

•  Stay in Test Mode: click to restart the timeout period. For example, if the pro-

grammed timeout is 10 minutes and you click Stay in Test Mode, you will have 

10 minutes in which to perform the task. Each time you click Stay in Test Mode, 

the timeout period is restarted.
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•  Exit Test Mode: click to exit Test Mode.

•  CT& PT Compensation: click to have your setting for CT/PT compensation applied 

to the readings in Test Mode.

•  TLC Compensation: click to have your setting for Transformer Loss compensation 

applied to the readings in Test Mode.

•  Configuration Done: click after selecting any compensation options (TLC or CT/

PT).

•  Reset Test Mode Data: click to reset the Test Mode data to 0.

•  Start Test (1-4): click the appropriate button to start tests from 1-4.

•  Refresh Status: click to see the current status of Test mode.

•  Close: click to close the Test Mode screen.

20.1.15.4.2: Preset Energy

The Shark® 250 meter lets you pre-set billing revenue registers to specific values. 

This is used when replacing meters in the field, to create continuity with the prior 

register values.

1. From the Main screen’s Menu Bar, click Tools>Test Mode>Preset Energy.
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2. The accumulator fields are listed on the left of the screen, along with their current 

value. The settings field shows the number of digits and decimals for the number, 

which were set in the Configuring Energy, Power Scaling, and Averaging setting of 

the meter’s Device Profile (see 28.2.1: Configuring Energy, Power Scaling, and 

Averaging on page 28- 36).

3. To enter a new value for the accumulator, double-click in the New Value field for 

that accumulator.

4. The Preset box is now checked and the New Value field is highlighted. Enter a new 

value for the accumulator.

5. When you have finished entering the preset values, click the Set button (it 

becomes selectable when you have made New Value field entries).

 You will see messages on the bottom of the screen as the preset file is being saved.
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20.1.15.4.3: Poll Test Mode Data

Use this command to view Test Mode data.

1. From the Main screen’s Menu Bar, click Tools>Test Mode>Poll Test Mode Data.

•  The test data is shown in the Values column.

•  You can copy this data to the clipboard (for pasting into another application) by 

clicking the Copy button. 

2. Click OK to close this screen.
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20.1.15.4.4: Copy Energy File

Use this command to copy a preset energy file to a Shark® 250 meter.

1. From the Main screen’s Menu Bar, click Tools>Test Mode>Copy Energy File.

•  Click Export to export the meter’s energy readings into a saved preset energy 

file. You will be prompted to give the file a name and location. You can later view 

the file or import it into a meter. 

•  Click Import to import a saved preset energy file into the meter. You will be 

prompted to select the file to import.

•  Click View to see the preset energy file. You will be prompted to select the file to 

view.

2. Click Exit to close the screen.
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20.1.16: Network Card Status (Shark® 200/250/270 Meter)

This feature gives you status information on any installed Network cards in a Shark® 

200/250/270 meter.

1. From the Main screen, select Tools>Network Card Status to open the screen shown 

below.

2. This screen displays the location of an installed Network Card (Option Card 1 or 

Option Card 2), its current status, and information about its settings. Click in the 

pull-down menu to choose Option Card 2.

3. Click Refresh to see the latest status of the Network card.

4. Click Close to exit the screen.
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20.1.17: Hardware Settings (Nexus® Meters)

This feature lets you see the meter’s hardware settings that have been programmed 

into Boot firmware. 

1. From the Main screen’s Menu Bar, select Tools>Hardware Settings. See the exam-

ple screen below.

2. Click OK to close the screen.
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20.1.18: Internal KYZ Pulse Test (Nexus® 1252/1500/
                1500+ Meters)

Use the Internal KYZ Pulse Test feature to test the meter's KYZ pulses.

1. From the Main screen’s Menu Bar, click Tools>Internal KYZ Pulse Test. You will see 

the message window shown below.

2. Click Yes to use the new testing method (this is the correct method to use); you will 

see one of the screens shown below. (depending on your meter)

3. Click Start. You will see a red circle as each KYZ pulse is being tested. 

•  To speed the test pulses, click Faster.

•  To slow down the test pulses, click Slower.

4. Click Stop to end the KYZ pulse testing.

5. Click Close to close the screen.

NOTE: The test pulses are not added to any KYZ pulse accumulators.
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20.1.19: Send Meter Restart Command

This feature lets you reset the meter using software rather than performing a manual 

reset by cycling power to the meter. This option is available for all of the EIG meters.

1. From the Main screen’s Menu Bar, click Tools>Send Meter Restart Command. See 

the example screen below.

2. Click the Select checkbox next to any meter(s) you want to restart.

3. Click Restart. You will see the message window shown below. Click OK to reset the 

meter(s); click Cancel if you don’t want to perform the reset.
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4. You will see messages in the bottom portion of the screen and then the window 

shown below. Click OK to close the message window and the Send Meter Restart 

Command screen.

20.1.20: 4GLTE Cell Modem Status (Shark® 270 Meter)

The Shark® 270 meter has a Verizon-certified 4G LTETM cellular modem card (4GLTE). 

To see the card’s detailed information, such as connection information, and to verify 

the cell modem is registered (SIM Card Status field) and the Signal Strength is at 

least Fair, click Tools>4GLTE Cell Modem Status to display the screen shown below.

•  You can access this screen irrespective of your connection, i.e., whether or not you 

are connected via the 4GLTE card. 

•  The Copy button copies the screen’s data to the computer’s clipboard.

•  The SIM Card Status should say “Healthy.” If it doesn’t, there may be a problem 

with the SIM card or its registration. The possible error messages are shown below.

Message Action

SIM card issue See Note #2 (page 60)

EPS registration Issue See Note #3 (page 60)

Data Integrity Issue See Note #2 (page 60)

PDN Registration Issue See Note #3 (page 60)
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•  The Runtime Status contains important messages regarding the state of the 4GLTE 

connection. If there are no connection problems, this field will say “Healthy.” If 

there are problems, error message(s) will be displayed. See the table below for 

possible messages and actions to take.

•  Error Codes table:

Message Action

Firmware Startup issue Contact Technical Support

Radio Startup Issue Contact Technical Support

Server Initialization Issue See Note #1 (page 60)

Server Startup Issue See Note #1 (page 60)

SIM Card Read Issue See Note #2 (page 60)

Tower Connection Issue See Note #2 (page 60)

APN Not Configured See Note #3 (page 60)

APN not detected See Note #3 (page 60)

Radio Power Issue Contact Technical Support

Error Code (0-15) See table on the next page

Message Action

Radio comms Issue Contact Technical Support

DSP Communication Issue Contact Technical Support

DSP Configuration read issue Contact Technical Support

Configuration invalid See Note #1 (page 60)

Radio power issue Contact Technical Support

Radio startup issue Contact Technical Support

No APN detected See Note #3 (page 60)

Registration issue See Note #2 (page 60)

No IP address assigned See Note #3 (page 60)

Server startup Issue See Note #1 (page 60)

Server Operation Issue See Note #1 (page 60)

Hardware Issue Contact Technical Support

SIM card Issue See Note #2 (below)
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•  Note #1 - Configuration issues:

If there are no registration or SIM card issues, verify that the profile entries are 

correct:

a. APN is entered correctly.

a. The “Allow List” IP address is formatted correctly.

•  Note #2 - SIM card issues:

a. Verify that the SIM card is installed properly.

b. Verify that the SIM card has been properly activated.

•  Note #3 - APN and Data connection issues:

a. Verify that the APN being used is the correct APN for the account.

b. Verify that the account is properly configured for data services.

•  If the errors show up again after trying the actions, please contact technical 

support - see Customer Service and Support on page - ii.

NOTE: If no one is connected to the cell modem, this status is updated every 20 

seconds. If you or someone else is connected to the cell modem, the last status 

before connection is displayed in the screen.

IMEI read Issue Contact Technical Support

Internal Issue Contact Technical Support
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20.1.21: Phasor Measurement Unit Settings

When the Nexus® 1500+ meter is programmed to use the synchrophasor feature, 

the meter acts as a phasor measurement unit (PMU), sending synchrophasor data to 

other devices. This setting lets you configure the synchrophasor data format for the 

meter acting as a PMU. Detailed instructions for the synchrophasor feature and its 

settings are given in appendices E and F in the Nexus® 1500+ meter’s USer Manual 

((download the manual at https://www.electroind.com/products/nexus-1500-power-

quality-meter-with-phasor-measurement-unit/: click Downloads>Tech Docu-

ments>User Manual from the right side of the webpage).

 20.1.22: Network Status

For Nexus® meters using a DHCP server to assign an IP address to the meter’s Ether-

net port, use Network Status to view the IP address:

1. Click Tools>Network Status.

•  The DHCP Client Status will indicate if DHCP is disabled or, if enabled, when it 

assigned an IP address to the port.

•  The renewal lease time indicates the amount of time the address will remain 

active, in seconds. This is set by the DHCP server. 

•  The other fields display: the DHCP server IP address; the Ipv4 address that was 

assigned to the port by the DHCP server; the subnet mask and router/default 

gateway settings; the DNS, SMTP, SNTP server IP addresses, if applicable; 

https://www.electroind.com/products/nexus-1500-power-quality-meter-with-phasor-measurement-unit/
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whether or not DHCPv6 Client status is enabled, and if enabled, the time left on 

the IPv6 address lease, and the IPv6 IP address for the port.

2. Click OK to close the screen.
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20.2: Options Screen

The Options screen gives you access to additional software functions. To open the 

screen, from the Main screen’s Menu Bar, click View>Options. You will see the Options 

screen, shown below.

•   The tabs at the top of the screen let you access the different settings screens.

•   Click Apply on any of the tab screens to implement your changes.
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20.2.1: Paths

The first tab is the Paths tab (shown on the previous page). This screen shows the 

location of the data files stored by the CommunicatorPQA® application. You can 

choose different paths for the data if you want to store the files in different directo-

ries. The screen has three buttons:

•   Reset the paths to their default - click this button if you have made changes and 

want to go back to the default directory paths.

•   Go to selected directory - click on a directory path, and then click this button to 

open the directory for those files, e.g., Retrieved Logs. 

•   Browse for directory - click on a directory path, and then click this button to open 

a window showing the tree structure of this directory. This lets you easily locate a 

specific file in the directory. See the example below, for Device Profiles. 

•   You can also select a new path from this window and click OK to insert the path 

in the Directory field.

You can choose to not show the CommunicatorPQA® software logo by checking the 

box at the bottom of the screen. 

Click Apply to implement any changes.
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20.2.2: Data Scan Mode

1. Click the Data Scan Mode tab to see the screen shown below.

2. The field on this screen is used to specify how long the meter should wait before 

performing the next scan. This is a legacy setting for the Nexus® 1252/1262/1272 

meters.

3. Click Apply to implement your selections.
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20.2.3: Log Retrieval 

1. Click the Log Retrieval tab to see the screen shown below. This screen allows you to 

make specific settings related to meter logs.

•   The first setting is not recommended, but it allows you to stop updates to a log 

when it is being retrieved from a Nexus® 1252/1262/1272 meter. It is better to 

continue to log while downloading so you don’t lose any newly created snap-

shots.

•   The second setting disables backup of retrieved logs. Generally, unless your 

hard drive is very small, leave this block un-checked so that log backup is 

performed.

•   If the meter is not in normal operation, it does not record any data for historical 

logs. For example, during firmware updates or loss of power, data is not saved. 

Some applications may require that data logs contain those missing records. To 

remedy this problem, enable the Pad Missing Records for Historical Logs feature. 

Once enabled, the meter, upon power up after a power down condition, will look 

at all the intervals that are missing and pad with zeros those intervals in the 
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historical log (s).Check the box next to the Pad Device option by clicking on it, 

and enter the number of days in the Days field. 

NOTE: If the box is already checked, this feature is already functional. You can 

change the number of days, or click the box to disable this feature.

•   The fourth setting pertains to Nexus® 1252/1262/1272 meters. It disables log 

retrieval by more than one application at a time.

•   The fifth setting lets you designate this PC as the only log retriever for all 

Shark® 200 meters on the network. If another log retrieval process is taking 

place when this computer’s log retrieval begins, the software will take control of 

that log retrieval. This setting may help to improve the Shark® 200 meter’s log 

retrieval performance, but should not be used if the network has multiple com-

puters that should be able to retrieve Shark® 200 meter logs. 

•   The sixth setting disables Modbus Function code 0x23 when logs are being 

retrieved from a meter. Modbus Function code 0x23 is a custom Modbus function 

code created by EIG to allow for large byte transfers in Modbus protocol. Not all 

Modbus to Modbus TCP converters will support this extended capability. All EIG 

native network cards have extended buffering to support Function code 0x23.

•   The Shark 250/270 and Nexus 1450 meters offer additional settings - click Extra 

Options to see them.

• Check the box next to any options you want to select: Enable Hex Out-

put, Enable Comm Dump, Disable CSV Files, Pause When Completed*, 
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Disable Error Message Box, Delete Old Log Files after 2 days, View Color 

Settings. 

• If you check View Color Settings you will see a selection chart letting 

you choose the colors to be used in the meter’s log retrieval screen. 

• Click on the “...” in one of the setting’s color lines to choose a different 

color.

• Click OK to close the new Options window; or click Load Defaults to put 

the settings back to their original default settings; or click Cancel to close 

the new Options screen without changing anything.

2. Click the checkbox next to any of the settings you want to select and click Apply to 

implement your selections.
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20.2.4: Miscellaneous

1. Click the Miscellaneous tab to see the screen shown below.

2. This screen lets you make the following settings:

•   Enable Kh/Ke Test Pulse Calculation screen - click to enable the screen

•   Ethernet Packet Delay - in milliseconds entered in field

•   Message Response Timeout - in milliseconds entered in field

•   Language - English or Spanish, selected from the pull-down menu

•   Enable HHF Converter for Retrieved Logs - click this box if you want to enable 

the HHF converter. See Chapter 19 for additional information on the HHF 

Converter and meter logs. 

•   The Shark® 200 Series meters use signed energy values. Check the box if you 

need to use unsigned values with your applications. 

•   The Nexus® 1500+ meter gives you the option of showing the meter’s battery 

status in the Main screen’s Status bar. Check the box to display the battery 

status.

3. Click Apply to implement your selections.
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20.2.5: Language

1. Click the Language tab to see the screen shown below if you want to change the 

CommunicatorPQA® application’s default language.

2. This feature gives you the choice of three embedded languages - Default (i.e., 

English), Spanish and Chinese, to choose from; and also the option to add a new 

language.

•  To use one of the embedded languages, select it from the pull-down menu and 

then select either Apply or OK. 

•  To modify an embedded language, select it from the pull-down menu and click 

the Edit Language File button. Continue to step 5.

•  To add a language, select Default from the pull-down menu and click the Edit 

Language File button. Continue to step 3.
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3. When setting up a new language file, you will see the following screen.

4. Click Yes to continue adding the new language file. You will see the screen below.

•  Enter an appropriate name for the language file, e.g., French. 

•  The default selection for code page is the code page your computer currently 

uses. A code page determines how characters are displayed. You will only need 

to change the selection if you are adding a language that uses a different char-

acter set than your default language. For example, if your computer uses a 

Western European code page (used by languages such as English, Spanish, 

French, German, etc.) and you are adding Russian, you would choose Cyrillic 

from the Code Page pull-down menu; if your default code page is Chinese, and 

you are adding German, you would choose Western European from the Code 

Page pull-down menu. 
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•  Note that if a language file with that name already exists, you will see the follow-

ing message.

Click Yes to start the translation all over again, or No or Cancel to close the 

message window.
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5. You will see one of the following screens, depending on whether you are adding a 

new language, or modifying an existing one. 

                  Language Editor Screen with Spanish Language Chosen

                           Language Editor Screen for New Language
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6. The Text Value column contains the English phrases from the application, and the 

Translated Value column lists the phrase in the new language. 

•  For an existing language file (example on previous page), there will be entries for 

each of the English phrases in the Translated Value column. To change an entry, 

click on the translated value and enter a new value. 

•  For a new language, click in the Translated Value of each phrase to type in the 

translation you want to use.

•  The color code used by the screen is displayed at the bottom:

• Green is untranslated phrase

• Blue is modified translation

• White is translated phrase (the phrase line will change from blue to white 

when you click Save Changes) 

• Pink is currently selected phrase

7. When you are done entering translated phrases, click Save Changes and then click 

the red X to close the screen. Note that you can save a partial language file and 

then go back to it to finish translating at a later time. You would just select the 

language from the Language tab’s pull-down menu (see step 2) and then click Edit 

Language file.

NOTE: 

•  The following programs are supported for languages other than English:

•  Log Viewer

•  Script & Scheduler

•  CommunicatorPQA® Main application

•  The following programs are not supported for languages other than English:

•  EN50160 Report Generator

•  EN50160 Report Viewer
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•  EN50160 HTML reports

•  EN50160 PDF Reports

•  PQDIF Converter

•  COMTRADE Converter

•  Log Retrieval Manager

•  Time of Use Editor
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20.2.6: Nexus® 1262 & 1272 Options

 It takes a few minutes longer to load a Nexus® 1262/1272 meter’s Device Profile 

when the LCD (display) settings are retrieved along with the other programmable 

settings. To address this issue:

•   There are two options available from the Tools menu: Edit Current Device Profile 

and Edit Current Device Profile (Without LCD Programmable Settings). Select the 

latter if you do not want/need to load the LCD settings along with the other meter 

settings.

•   You also have the option to change the Device Profile icon so that its default action 

is to load the meter’s programmable settings without loading the LCD programma-

ble settings (the default action of the Device Profile is to load all meter programma-

ble settings, including the LCD settings). To do this you use the Nexus® 1262 & 

1272 Options tab.

1. Click the Nexus® 1262 & 1272 Options tab to see the screen shown below. 
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2. Click the checkbox next to “Do not retrieve LCD Display settings when clicking on 

the device profile icon.” Clicking the Device Profile icon now loads the programma-

ble settings without the LCD programmable settings. If you want to change back to 

the default, un-select the checkbox. 

20.2.7: PQDIF and COMTRADE

PQDIF and COMTRADE are two different types of file format that are commonly used 

by third party software applications. The CommunicatorPQA® software application 

has the ability to automatically create these differing file formats so that waveforms 

captured by EIG meters can be easily imported into the third party waveform and 

fault analysis applications.

1. Click the PQDIF and COMTRADE tab to enable the creation of PQDIF and/or 

COMTRADE files.

2. Click either or both of the following to enable PQDIF and CONTRADE file creation:

•   The checkbox next to Create COMTRADE files after retrieving waveform logs
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•   The checkbox next to Waveform, PQ, and Historical to create PQDIF files after 

retrieving those logs.

• To configure the PQDIF file for your system:

a. Click Open PQDIF Configuration.

b. Select your meter model from the menu on the left.

c. For continuous waveform records, select from Combine Records, 

Keep as Separate Records, and Discard Records. 

d. For PQ Log Data select from Store as Magnitude & Duration Only 

Objects; Store as Magnitude, Duration, & Time Objects; Store Both 

Choice 1 and 2 Objects; and Do Not Store PQ Logs.

e. Repeat steps b-d for any additional meter models you want to make 

settings for. When your settings are complete, click OK.

3. Click Apply to implement your selection(s).
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20.2.8: Software

This setting lets you customize the software functionality.

1. Click the Software tab from the Options screen.

2. You can make these settings:

•  To disable automatic checking for software updates upon opening the software, 

click the checkbox next to the first option.

•  To not display the Device Status screen when you use Quick Connect, click the 

checkbox next to the second option.

•  To set the data format for voltage, current, and power readings, enter the num-

ber of digits and/or decimal places you want.

•  To enable network connection using IPv6, check the box next to the last option.

3. Click Apply to implement your selections. Then click OK to close the screen.
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20.2.9: Enable Communications Logging

This setting lets the user log all communications with meters via the Communica-

torPQA® application. 

1. From the Options screen, click the Enable Communications Logging tab.

2. Select the Comm Logging Mode:

•   Disabled - No communications logging will take place.

•   Fixed Mode - A single communications log is kept across all connections and 

instances. While this setting will keep the file small, it is only useful for immedi-

ate logging. When enabled, communications are logged to the "Comm_Log-

ging.txt" file.

•   Session Mode - A new log file is created for every connection. This setting is par-

ticularly useful in a MeterManagerPQA® application environment (see Chapter 

18 for details on the MeterManagerPQA® application), where many device con-

nections are created sequentially and simultaneously. When enabled, communi-
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cations are logged to a file with a name made up by the connection parameters 

and the time the connection was established, in the format [connec-

tion]_[time].commlog; e.g., if the connection is 192.168.1.105, with Modbus 

TCP, and initiated at 2019/07/10 09:53:22, then the filename would be 

"mn___192.168.1.105_502_1_TCP_20190710095322.commlog".

3. If you selected Session Mode, specify if old logs should be deleted after 7 days.

•   Even though individual communications log files are small, if many connections 

are made the number of files can build up. This setting insures that the commu-

nications logging doesn't fill up the hard drive. 

•   Another option to free up memory is to click Clear Logs, which will delete all the 

log files.

4. Specify the location for the communications logs. The default location is 

[AppData]\Electro Industries\Communicator Ext\commlog, but any directory can 

be specified. 

•   To open the directory to view the log files, click View Logs.

5. When you have completed your settings, click Apply, and then restart the Commu-

nicatorPQA® application.
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21: Total Web Solutions and the
       WebViewTM Energy Dashboard

21.1: Overview 
•  Electro Industries/GaugeTech’s Total Web SolutionsTM (TWSTM) is a fully customiz-

able Web server, providing access to real-time data via the Internet. TWS has an 

open design that allows you to communicate with devices through a variety of open 

protocols. The system incorporates highly programmable network cards with built-

in memory that are installed in meters with the 10/100BaseT Option. The Network 

cards can be programmed to perform an extensive array of monitoring functions. 

NOTE: A Nexus® meter with the INP10 Option does not support Total Web 

SolutionsTM. The other Network cards - INP100/INP102/INP200/INP202/INP100S 

offer various TWSTM options. Not all of the components are available with all of the 

Network cards; refer to 21.13: Comparison of Network Cards, on page 21-63, for 

more information.

•  EIG’s WebViewTM Energy Dashboard is a feature of the Nexus® 1450 meter. It is a 

unique, HTML5-based web server that lets the user access the meter readings, 

view reports, and perform detailed analysis through the Internet. See the Nexus® 

1450 Meter Installation and Operation Manual for a detailed explanation of the 

WebViewTM Energy Dashboard. Note that some, but not all, of the settings 

described in Click OK to save the settings., on page 21-7 are available for the 

Nexus® 1450 meter; e.g., FTP functions are not available for the 1450 meter. If a 

setting is not available, its tab will not be shown in the Advanced Network Option 

Settings screen. Refer to 21.13: Comparison of Network Cards, on page 21-63, for 

more information on the 1450’s features.

NOTE: The Shark® 270 meter’s Gen 2 INP100S also has an HTML5-based Web 

server. I6t has some, but not all, of the features of the WebviewTM Energy Dash-

board. Instructions for using the meter’s We server are included in the Shark® 270 

Meter User Manual, which can be downloaded from EIG’s website: 

https://www.electroind.com/products/revenue-meter-shark-270/

•  Chapter 6 contains details of the Nexus® 1450 meter’s Security feature. The Secu-

rity feature also supports security for the WebViewTM Energy Dashboard software, 

requiring the user to log in when security for the meter is enabled and they are 

attempting to access a restricted permission. In addition, all HTTPS communication 

with the meter is encrypted. See 6.11.4: Enabling/Disabling the Sealing Switch 

https://www.electroind.com/products/revenue-meter-shark-270/
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(Shark® 270 Meter), on page 6-31, for meter security details.

NOTE: The Legacy user is not able to access any restricted webpages when secu-

rity is enabled for the meter. 

21.2: TWS System Components 

TWSTM is made up of the following components. For flow charts of the components, 

see 21.10: WebXML Flowchart, on page 21-60, 21.11: WebExplorer Flowchart, on 

page 21-61, and 21.12: WebAlarm Flowchart, on page 21-62. For the available 

components for each of the Network cards, refer to the comparison charts in 21.13: 

Comparison of Network Cards, on page 21-63.

•  WebExplorerTM: This component utilizes your Web browser to provide you with 

direct access to all power data. Using your browser, you can access any data file. 

And, because it looks like a standard HTML webpage to an IT department, the data 

transmits through corporate firewalls. This fully configurable component allows you 

to customize your own SCADA quality webpages, graphics and configurations via an 

FTP Server and/or FTP Client. The main Default webpage is shown on the next 

page. This is just an example, because the webpages for your data may be 

changed or created to your specifications and needs. To access the meter through 

the Web, just type the IP address of the Network card into your browser’s address 

bar.
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•  WebXMLTM: This component allows you to configure data to your specifications. The 

data is polled, then stored in an XML file for later access by any client on the net-

work. The data can be viewed via multiple applications including Internet Explorer, 

and Microsoft® Excel®, Power Point® and Word® applications.

•  WebReacherTM: With this component, you can access meters anywhere in the world. 

WebReacherTM has a built-in Modbus data concentrator that allows you to poll up to 

16 devices (8 for the Nexus® 1500/1500+ meter) with up to 64 unique polling 

points. WebReacherTM can poll items from any device that speaks Modbus RTU and/

or Modbus TCP/IP protocols, and it can retrieve data and consolidate it into web-

pages without separate software.

•  WebModTM: The 10/100BaseT design allows the unit to speak Modbus TCP. Once the 

programmable Network card is placed inside a meter, a gateway port becomes 

available. The gateway enables a high speed interface between the Network LAN 

and other Modbus-based IED (Intelligent Electronic Device) equipment. Modbus 

TCP is an industry-proven open protocol that can be easily integrated with any 

other software or hardware.

•  WebAlarmTM: With this component, Real Time email alerts are sent via the Internet 

to up to 9 recipients simultaneously for any combination of event notifications. 

Email format can be Short Format or Long Format: Short Format is for cellphones 

with text messaging service; Long Format provides detailed alarm conditions for 

any devices with full email support (computers, PDAs, cell-phones).

21.3: Hardware Connection

The 10/100BaseT Network cards installed in an EIG meter give it the ability to connect 

to a network through an Ethernet LAN or the Internet via Modbus TCP, HTTP, SMTP, 

FTP and/or DHCP. The 10/100BaseT Network cards can auto detect the cable type, 

and work with either straight or crossover cable. Refer to your meter’s Installation 

and Operation manual for connection details.

21.4: Initial Configuration

Connect to the meter through a Network connection, as shown in Chapter 3. The 

Factory set IP address for the Network cards except that of the second Nexus® 1500 

meter Network card, is 10.0.0.1; the Factory set IP address for the Nexus® 1500 

meter’s second Network card is 10.0.1.1. If the IP address has been changed and you 
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do not know the new address, connect to the meter’s serial port and program the 

Network card parameters in the Communications settings of the Device Profile. See 

chapters 13 (1252), 12(1262/1272), 8 (Shark® 200), 11 (1500/1500+), 26 (Shark® 

270 meter), 27 (1450 meter), and 28 (Shark® 250 meter) for details.

21.5: Basic Configuration Details

Setting up the 10/100BaseT Option consists of configuring the Web connection and 

the Advanced Network Card screens so that you can access the data you need from 

the Web. Once the initial configuration is set, you will not need software, unless you 

want to make changes to the configuration. With the basic setup, you will be able to 

access the TWS default screens, which display a variety of Real Time Readings. You 

also have the option of customizing your screens (see 21.7: Customizing Screens, on 

page 21-29). In order for the Web to access the data from a meter, the meter must 

have an IP address that uniquely identifies a computer that uses the Internet. An IP 

address can be assigned by using a DHCP Server or it can be entered manually.

NOTE: For manual IP address setting, see the Communications Setting instructions 

for your manual. 

21.5.1: DHCP 
(Not available in all meters - see 21.13: Comparison of Net-
work Cards, on page 21-63)

DHCP (Dynamic Host Configuration Protocol) was created by IETF (Internet Engineer-

ing Task Force) to enable individual computers on an IP network to extract their con-

figurations from a server (the “DHCP Server”) or servers, that have no exact 

information about the individual computers until they request the information. The 

DHCP Server “leases” the IP address to the DHCP Client for a period of time defined 

by the DHCP server. More information can be found in the Internet RFCs (Request for 

Comments) regarding available servers and technical details. 

NOTE: In DHCP Mode, if a NACK message is received from the DHCP server, the Net-

work card stops all Ethernet activities immediately and starts a new DHCP process.

1. From the CommunicatorPQA® application’s Main screen:

a. Click the Device Profile icon.

b. Click General Settings>Communications.

c. Click on one of the Ports to open the Communications Settings screen.
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d. Click Advanced Settings.

e. Click DHCP tab if you are connected to a Nexus® 1252/1262/1272 meter. You 

will see the screen shown below.

f. Click Enable DHCP.

2. Access a working DHCP Server. DHCP Servers automatically assign an IP address 

and Subnet Mask. Some DHCP Servers, allow you to assign a Default Gateway IP 

(DHCP Option #3), DNS IP (DHCP Option #6) and SMTP Server IP (DHCP Option 

#69) to the meter. If your DHCP Server does not let you assign parameters other 

than the IP address, enter those values manually. See Click OK to save the set-

tings., on page 21-7 for instructions.

3. Click OK to close this screen. 

NOTES: 

•  For the 1450 meter, DHCP is set in the Communications screen - see 27.1.5: 

Communications, on page 27-16.

•  For the 270 meter, DHCP is set in the Gen 2 INP100S card’s IP address and DNS 

screen - see 26.5.1: Configuring a Network Card (INP100S), on page 26-90.
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•  See 20.1.22: Network Status, on page 20-59 for instructions on finding the IP 

address assigned by the DHCP server and additional related information. 

21.5.2: Gateway Settings

Follow these steps to configure the Ethernet Gateway. Port 2 is the Gateway port for 

the Nexus® 1252/1500/1500+ meters; Port 3 is the Gateway port for the Nexus® 

1262/1272 meters. If your meter has the INP102/202 Combo card, the Gateway and 

Modem share the Gateway port.

1. From the CommunicatorPQA® application’s Main screen: 

a. Click the Device Profile icon.

b. Click General Settings>Communications. You will see the Communications Set-

tings screen. See the following screens.

For the 12x2 meter,
enter the Gateway Baud
Rate and Transmission Delay
here.
 NOTE: The time you enter in the
 Delay field is multiplied by 15 ms.
 Note that you only need to enter a

, i.e., is a slower 

 Delay time if the device you are 
 connecting to needs additional
 response time 
device, like a radio modem.
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2. Click OK to save the settings.

For the 1500+ meter,
select Ethernet Gateway
as the Mode for Port 4.
You must also enable TCP/IP
for at least one of ports 5
and 6 - see Section 21.6.1
for instructions. 
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21.6: Advanced Features

NOTE: Not all of these features are available for all meters. See 21.13: Comparison 

of Network Cards, on page 21-63. The settings for the Nexus® 1500+ meter are dif-

ferent as it has additional capabilities. Refer to 21.17: Nexus® 1450/1500+ Meter’s 

Advanced Features Setting, on page 21-74 for instructions on setting the Nexus® 

1500+ meter’s additional Advanced Settings. The Nexus® 1450 meter has slightly 

different screens, which are explained in the appropriate sections. Many of the 

Shark® meters’ Network card settings are made through either the Device Profile 

(explained in their chapter of this manual) or Web server (explained in the meter’s 

User Manual).
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1. From the Main screen:

a. Click the Device Profile icon.

b. Click General Settings>Communications.

c. Click the Advanced Settings button. You will see the Advanced Network Settings 

Options screen. The following sections provide information about each of the 

settings, available by clicking the tabs at the top of the screen.

21.6.1: Services & Security

1. Click the Services/Services & Security tab.

NOTE: The Nexus® 1500+ meter Services tab is shown above. Not all options are 

available for other meters.

2.Check the boxes in front of the listed Services to Enable the features you want.   

•  You can disable or enable Web server and Modbus TCP Server for IP Port 5 only, 

IP Port 6, only or both ports, for IPv4 (IP version 4) and IPv6 (IP version 6). You 

can designate a Com port for IPv4 ports 80 and 502 are the default); the same 

Com port will be assigned to IPv6.
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•  GE EGD protocol setting: can be disabled, set to Auto (either port can accept), 

set for Port 5 Only, or set for Port 6 Only. See 21.6.3: GE Protocol (EGD), on 

page 21-14, for additional settings; and 21.14: GE EGD Details, on page 21-65, 

for details on the protocol.

•  DNP LAN/WAN: can be disabled or enabled for Port 5, Port 6, or both, for IPv4 (IP 

version 4) and IPv6 (IP version 6). See 21.6.7: DNP for LAN/WAN, on page 21-

24.

•  SMTP Client (email) can be disabled or enabled for Port 5, Port 6, or Auto (which-

ever port is available). You can select the Outgoing Mail port from the pull-down 

menu and there is a field that displays the email encryption status. See 21.6.4: 

WebAlarmTM/Email, on page 21-15, for more email instructions.

•  Network Time Sync: meter time synchronization through an NTP server can be 

disabled, set to Auto (either port can accept), set for Port 5 Only, or set for Port 

6 Only. For the 1450 meter, see 27.1.3: Time Settings, on page 27-7, for 

instructions on SNTP configuration.

•  IEC 61850: select Enabled to enable the IEC 61850 server for one of the Network 

cards; select Disabled to disable the IEC 61850 server entirely.

•  IEC 61850 GOOSE: select Enabled to enable IEC 61850 GOOSE messaging for 

the Network card that is the IEC 61850 protocol server; select Disabled to dis-

able the IEC 61850 GOOSE messaging feature.

NOTE: If you enable IEC 61850 GOOSE, you also need to make settings for it. 

See 21.17.2: IEC 61850 GOOSE Tab (Nexus® 1450 and 1500+ Meters), on 

page 21-80, for instructions.

•  IEEE 1588 PTP: this option is for the Nexus® 1500+ meter. See 21.17.4: IEEE 

1588 PTPv2 Master, on page 21-83.

•  Synchrophasor (PMU): this feature and its programming are explained in detail in 

the Nexus® 1500+ meter’s User Manual’s Appendix E and Appendix F. Download 

the manual at https://www.electroind.com/products/nexus-1500-power-quality-

meter-with-phasor-measurement-unit/.

https://www.electroind.com/products/nexus-1500-power-quality-meter-with-phasor-measurement-unit/
https://www.electroind.com/products/nexus-1500-power-quality-meter-with-phasor-measurement-unit/
https://www.electroind.com/products/nexus-1500-power-quality-meter-with-phasor-measurement-unit/
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•  TCP/UDP Port: enter the TCP port to use. You need to use the DNP LAN/WAN Port 

5 and/or 6 tabs to set up the DNP ports. See 21.6.7: DNP for LAN/WAN, on 

page 21-24, for instructions.

NOTES: 

• The Nexus® 1450/1500/1500+ meter does not use Sleep modem but 

other meters do offer it.

• Use Scaled Energy readings setting is only available for the Nexus® 

1252/1262/1272 meters. See Section 21.6.1.1: Use Scaled Energy Read-

ings in Webpages That Contain, on page 21-12.

•  Block Password is only available for the Nexus® 1252/1262/1272 

meters.

•  Network card security for some meters is a different than meter security. 

See Chapter 6 for details on meter security.

•  The Nexus® 1252/1262/1272 meters give you an option to use a differ-

ent port for Modbus TCP/IP communication. 

Check the box if you want to use a port other than the default port 502. 

Then see 21.6.2: Computer Name/DNS, on page 21-13 to enter the new 

port number.

3. Click OK to save your settings or continue to the next section.
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21.6.1.1: Use Scaled Energy Readings in Webpages That Contain
                Energy Readings

Only Nexus® 1252/1262/1272 meters support scaled energy readings. For these 

meters, you have the option to specify which energy readings (old-fashioned energy 

or scaled energy) you want to display in default webpages.

You enable the scaled energy display by selecting that option in Services & Security 

(see 21.6.1: Services & Security, on page 21-9) and you also set up the poll_data.xml 

file to specify scaled energy readings display. 

The following Attributes in the poll_data.xml file are used for the scaled energy dis-

play option: 

•  SYS_Scaled_Energy_Available 

An indicator is provided in the XML file that tells if the meter supports scaled energy 

readings: Yes=scaled energy readings are supported; No=scaled energy readings 

are not supported.

•  SYS_Use_Scaled_Energy

This option is set based on the selection in the device profile and is used by the 

default webpages to determine which energy readings are displayed in the default 

webpages: Yes=use scaled energy; No=use regular energy.

An example of scaled energy settings in the poll_data.xml follows:

<EIG_DATA>

<EIG_SYSTEM>

<sys_info SYS_Use_Scaled_Energy="Yes" 

                 SYS_Scaled_Energy_Available="Yes"/>

</EIG_SYSTEM>

</EIG_DATA>
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21.6.2: Computer Name/DNS

1. Click the Computer Name/DNS tab.

2. Enter the Computer Name (optional). This allows you to access the meter by name, 

if there is a DNS Server working in conjunction with the DHCP Server. See your 

network administrator and the servers’ User manuals for further details. The 

Default Computer Name is EIGNET_XXXXXX where the X’s are the last 3 octets of 

the MAC address.

3. Enter the IP addresses for Domain Name Servers 1 and 2.

4. Enter the port number for the Modbus TCP server. Note that this setting is not 

shown in the Nexus® 1450 or 1500+ meter’s screen, since the TCP server settings 

are on different screens. 

NOTE: If you are entering a different port number here, you must also select the 

checkbox in the Services & Security screen, to enable the port change. See 21.6.1: 

Services & Security, on page 21-9

5. Click OK to save your settings or continue to the next section.
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21.6.3: GE Protocol (EGD) 

(See 21.14: GE EGD Details, on page 21-65, for Detailed Information.) 

1. Click the Services & Security tab. Click the checkbox next to GE EGD Data Port 

Server.

2. Click the GE Protocol (EGD)tab.

3. The settings you make in this screen support your use of GE’s EGD Protocol:

•  Enter the IP address for Multicast or Unicast. The Nexus® 1450 and 1500+ 
meter screens have information about the Multicast address range. See the 
screen captures on the next page.

•  Select Connection type

•  Enter Update interval

•  Select the Product identifier

•  Enter the Data Producer Port Number (Note that not all meters have this 
setting.)



     Doc#    E107707                                               21 - 15

21: Total Web Solutions and WebviewTM Energy Dashboard

4. Click OK to save your settings or continue to the next section.

NOTE: The Multicast section of the screens for the 1450 meter (top) and 1500+ 

meter (bottom) are shown below.They give information on the Multicast IP 

addresses. Click Get Information on Multicast to see more information.

21.6.4: WebAlarmTM/Email 
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(Not available in all meters - see 21.13: Comparison of Net-
work Cards, on page 21-63)

This feature enables email when an alarm condition occurs. Settings for one email are 

configured in the Alarm/Email tab of the Advanced Network Card settings. An addi-

tional 8 email addresses can be configured in the poll_profile.xml file (Nexus® 12xx 

or Shark® meters) or pprofile.xml file in the directory \C\TWS\ (Nexus® 1450/1500/

1500+ meter).

NOTE: For the Nexus® 1500 meter, when both Network cards are installed, email can 

be sent from either card. Generally, the email is sent out on the first network card 

that has a working path to the gateway IP. For the Nexus 1500+ meter you specify 

which card (or both):

Example 1:

Network card 1: IP=192.168.0.2, mask=255.255.255.0, gateway=192.168.0.1 

Network card 2: IP=192.168.0.3, mask=255.255.255.0, gateway=192.168.0.1 

Email will be sent out on Network card 1.

Example 2:

Network card 1: IP=192.168.0.5, mask=255.255.255.0, gateway=0.0.0.0 

Network card 2: IP=192.168.0.3, mask=255.255.255.0, gateway=192.168.0.1 

Email will be sent out on Network card 2.

1. Click the Services tab. Enable/Disable the sending of email by clicking Alarm 

Generated Email or enabling SMTP for either or both ports (see 21.6.1: Services & 

Security, on page 21-9). The Initial Setting is Off or Disabled. 
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2. Click the Alarm/Email tab. You will see one of the screens shown below.

3. Enter the following settings for the top screen: 

•   Email Server IP or Name (Requires DNS Setup).

•   Email Server Port Number: 25
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•   Administrator Email Address/To Address: for user preferred address or any 

monitoring software receive address such as for EIG’s Dial-In Server (INP102/

INP202).

•   Return/Reply/From Address

•   Subject Text: whatever you want to appear in the email subject line.

4. Enter the following settings for the bottom screen: 

•  Email Server IP Address/Name 

•  Alarm Monitor Email Address (To): email address Alarm email should be sent to.

•  Return/Reply Address (From): email address sending the email and receiving any 

replies.

•  Email Subject Text: whatever you want to appear in the email subject line.

•  Email Server requires authentication: if the server is password protected, check 

this box and enter the username and password.

•  Send email on: click the conditions for which you want to send an alarm email. 

The available conditions are: Limit Status Change, Digital Input Status Change, 

Waveform Capture, PQ (Sag/Surge) Event, Relay Output Change, Meter Power 

On, Log Reset, Secure Mode Change, Energy Accumulators Reset, Max/Min and 

Peak Demand Reset, Pulse Accumulators/Aggregators Reset, Clock Changed, 

Programmable Settings Changed, V-Switch Changed, Firmware Changed, TOU 

Settings Changed, Login Failure.

•  Periodic Snapshot: to send an email on a regular interval, which can be used to 

indicate that the meter is online, check the box and enter the interval in min-

utes, e.g., if you enter 15, an email with the meter readings will be sent every 

15 minutes.

   Note that for this screen, the SMTP server port is set in the Services tab - see

   21.6.1: Services & Security, on page 21-9.

5. Click OK to save your settings or continue to the next section.
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21.6.5: FTP Client 
(Not available in all meters - see 21.13: Comparison of Net-
work Cards, on page 21-63)

This feature allows you to substitute your own polling profile, webpages or graphics 

for the Web server. You must also set up an FTP Server with a user account and read-

only access. See sections 21.8: FTP Server, on page 21-55 and 21.13: Comparison of 

Network Cards, on page 21-63, for details.

1. Click the Services tab. To enable FTP, click the checkbox next to FTP Client. 

2. Click the FTP Client tab. You will see the screen shown below. 

3. Enter the following settings:

•   FTP Client Settings:

•   FTP Server IP or Name (requires DNS setup)

•   FTP Server Port: Initial Setting is xx.
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•   Startup Directory: where the TWS files are located. The Network card will get the 

files from this location. When a file in the Startup Directory has the same name as 

the one in the initial files within the meter, the new file will replace the initial file. If 

you have set up this directory through your FTP server, leave this field blank.

•   User Name

•   Password

FTP Client Settings Example:

By default, Microsoft®’s FTP Server will use “C:\Inetpub\ftproot\” as the root direc-

tory. When you log onto the FTP Server, this is the initial directory you will see.

1. If the files for INP100/INP200/INP102/INP202 are stored in the root directory 

(“C:\Inetpub\ftproot\”), leave the “Startup Remote Directory” text box empty. 

Example Files in FTP Server’s Root Directory:

•   ”C:\Inetpub\ftproot\index.htm”

•   ”C:\Inetpub\ftproot\poll_profile.xml”

•   ”C:\Inetpub\ftproot\logo.gif”

   When INP100/INP200/INP102/INP202 starts up, it will check to see what files are in

   the server’s directory and will download all of them.

2. If the files for INP100/INP200/INP102/INP202 are stored in a subdirectory in the 

root directory, such as “C:\Inetpub\ftproot\nexus_meters\feeder_12345\”, put 

“nexus_meters/feeder_12345” in the “Startup Remote Directory” text box. Note 

the different “/” between directory names. When INP100/INP200/INP102/INP202 

starts up, it will check for all files in the server’s directory (“nexus_meters/feed-

er_12345”) and download all files found there. If there is another subdirectory 

inside this directory that is not listed in the server’s directory as above, such as 

“C:\Inetpub\ftp-root\ nexus_meters \feeder_12345\info\”, INP100/INP200/

INP102/INP202 will not locate that subdirectory and no files will be downloaded 

from that subdirectory to INP100/INP200/INP102/INP202. This may cause an error 

during the file downloading process and the system may not enter its normal oper-

ating mode until the subdirectory is removed from the server.
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3. The user should always check the FTP server to ensure it is configured properly. To 

do this, open the IE browser window and enter the correct address in the URL win-

dow. The standard format is: “ftp://[username]:[password]@[ip_address]”.  

Example: 

“ftp://john:1a2b3c@192.168.1.1” where John is the user name and 1a2b3c is the 

password.

4. Click OK to save your settings or continue to the next section.

21.6.6: INP102/INP202 Ethernet/Modem Combination 

INP102/INP202 is an extension of INP100/INP200. It has all the features of an 

INP100/INP200, plus a built-in modem.The communication protocol supported by the 

modem is Modbus ASCII; the communication protocol supported by the RS485 Ether-

net/Modem gateway port is Modbus RTU. The INP102/INP202 converts all Modbus 

ASCII incoming modem requests to Modbus RTU for internal and gateway communi-

cation, then it converts all response Modbus RTU messages into Modbus ASCII proto-

col and sends them out to the modem. Some of the fixed parameters for the 

Ethernet/Modem gateway port are 8 data bits, no parity, 1 stop bit. The Ethernet/

Modem gateway port's baud rate and delay time are configurable.

The modem has three operational modes:

1. Modem Command Mode: Invisible to users. Modem is idle, waiting for an incoming 

call.

2. User Command Mode: Visible to users. If modem password protection is enabled, 

you can enter the password in this mode so the modem can grant the user access.  

In addition, you can query the modem for its boot and runtime firmware version, 

and modem identification information.

3. Pass-through Mode: Normal Operation mode. Modbus requests and responses are 

passed through the modem.
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Example:

call failure reset limit = 1 hour

violation lockout time = 24 hours

incoming connection failure count = 3

INP102/202 Settings

Setting Description

Inactivity Timeout Limits (minutes) In Pass-through mode, if the user does 
not send anything to the modem, the 
modem will disconnect when this Limit 
has been reached.

Rings to Answer (number of rings) Modem will answer the call after the 
programmed number if rings.

Identification User-defined modem ID, up to 32 char-
acters.

Password User-defined modem password, up to 16 
characters.

Enable Password Option to enable or disable the modem 
password feature.

Violation Limit (number of attempts) If password is enabled and the user fails 
to enter a correct password in three 
attempts, a Violation (Call Failure) Flag 
is set and the Violation Counter incre-
ments by 1. Once the total number of 
violations goes over this limit, the
modem will enter Lockout mode. The 
Modem will not answer calls until the 
Violation Lockout Time is reached.

Violation Lockout Time (hours) The modem stays in Lockout mode until 
this Lockout Time is reached.

Call Failure Reset Limit (hours) If the password is enabled and the Total 
Violations (Call Failures) has not 
reached the Violation Limit (not in Lock-
out mode), the modem resets the Viola-
tion (Call Failure) Counter when it 
reaches the programmed limit.

Share the Phone Line Option to enable or disable the modem’s 
Share the Phone Line feature.
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The first connection with a bad password occurred at 10AM. Another occurs at 10:05, 

a third at 10:30, a 4th at 10:45, all with a bad password. That's more than 3 in 1 

hour, so the modem will not answer the phone again until 10:45AM the next day. If 

the 4th connection had come in at 11:31 instead of 10:45, the modem would answer 

the call because the first 3 failed requests "expired" at 11:30.

Additional information about modem operation:

1. When the shared phone line option is set, the modem should drop the connection in 

about 5 seconds, assuming someone picked up the receiver and didn't hang up. If 

the receiver was hung up quickly, then the connection would not drop.

2. When the shared phone line option is not set, the modem should not drop the con-

nection and communication should resume after about 10 seconds when the 

INP 102/202 Modem Commands

Command Description

[3 seconds pause]
:CM
[3 seconds pause]

Set the modem into User Command 
mode

ONLINE<CR> Set the Modem to Pass-through mode

E<CR> Command or querying modem’s charac-
teristic information. Modem returns
“INP-102 Ethernet/Modem<CR>”

MODEM?<CR> Command for querying modem’s ID

PASSWORD?<CR> If the modem password is enabled, the 
modem sends this to the user asking for 
a password once the connection is 
established. The user must enter the 
correct password before sending any 
other user data. The user has 20 sec-
onds to reply with a password. If there 
is no response from the user, the 
modem resends this command. If the 
password was incorrect, the modem 
resends this command. The user has a 
total of 3 attempts to enter the correct 
password before the modem automati-
cally disconnects.

FBOOT?<CR> Command for querying the modem’s 
boot firmware version

FRUN?<CR> Command for querying the modem’s 
runtime firmware version.
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receiver was picked up and then hung up. The modem could still drop the connec-

tion, if the noise level is too high, such as from repeated pick up and hang up, or 

whistling at the receiver. The performance in this situation is not guaranteed. There 

will not be any valid communication if the receiver is picked up and not hung up 

again.

3. There is no dial-out support; you cannot flash upgrade the Ethernet/modem's firm-

ware from the modem connection.

4. Modem and Ethernet connections will close if a change is detected in the device 

profile or if there is a forced reset from the Web interface.

5. If the firmware does not detect the modem hardware, the modem task will be 

stopped.

6. A modem status/diagnostic webpage can be found at/diag_modem.htm.

21.6.7: DNP for LAN/WAN

The original DNP3 was designed for serial point-to-point communication (e.g. RS232) 

with limited support for half duplex serial networks (e.g. RS485). In order for devices 

to exchange DNP messages in a local (LAN) and/or wide area network (WAN), one 

must either augment the protocol to support a network environment or use an exist-

ing network transport mechanism. DNP3 LAN/WAN was specifically defined for trans-

porting DNP traffic on the Internet Protocol Suite.

EIG's DNP3 LAN/WAN implementation was based on the specifications described in

DNP3 Specification, Volume 7, Networking, according to the Version 2.0 Draft E of 

March 12, 2004. The official DNP3 specifications can be found at www.dnp.org.
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EIG's DNP3 LAN/WAN feature is available for Nexus® meters with INP100/INP102/

INP200/INP202 Network Cards and for the Nexus® 1450 meter. To use this feature, 

DNP Parameters (Settings in BOLD are default for Standard Mode)

Name Settings Notes

DNP over TCP Enabled
Disabled

If set to Enabled, network Card will receive DNP over 
TCP requests.

DNP over TCP listen on port 20000
(User 
Defined)

TCP listening port

DNP over UDP Enabled
Disabled

If set to Enabled, Network Card will receive DNP over 
UDP requests.

DNP over UDP listen on port 20000
(User 
Defined)

UDP listening port

UDP respond to Client Port
(User
Defined)

If set to Client Port, UDP response will be sent to the 
UDP Request Port. Otherwise, UDP Response will be 
sent to a User Defined Port Number. Default is fixed 
at 20000.

UDP addressing Unicast
Broadcast
Unicast &
Broadcast

If set to Unicast & Broadcast, all UDP requests are 
accepted.
If set to Unicast, Network Card will check to see if 
the UDP Destination address matches the meter’s IP 
address.
If set to Broadcast, Network Card will check to see if 
the UDP Destination address is 255.255.255.255.
If no match, the UDP connection is refused.

Validate source IPs Validation
Disabled
1 IP Address
2 to 4 IP
Addresses

If set to Disabled, Network Card will not perform Val-
idation on any incoming IP Addresses.
If set to 1 to 4, Network Card will perform Validations 
on every IP address defined by user.

Validate source ports No
Yes

If set to No, Network Card will not perform Valida-
tions on incoming TCP and UDP Ports for a given IP 
address.

IP addresses (User 
Defined)

Up to 4 IP addresses to Validate.

Subnet mask (User 
Defined)

Masking bits applied to IP address. When defined 
properly, user can specify Validation on a single IP 
address, or a range of IP addresses.

TCP ports, start and end (User 
Defined)

TCP Port Range to be validated.

UDP ports, start and end (User 
Defined)

UDP Port Range to be validated.
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you must configure the Nexus® meter's DNP Custom Classes Map in the meter's 

Device Profile.

See chapters 13 (1250/1252), 12 (1262/1272), 11 (1500/1500+), and 27 (1450) of 

this manual for configuration screens and details.

1. Click the DNP for LAN/WAN tab. You will see the screen shown below. Note that the 

1450 meter has two DNP LAN/WAN tabs - one for Port 5 and one for Port 6.

•   Mode of operations (at top of screen):

•   Disabled: Feature is disabled, no DNP3 LAN/WAN communication will be 

accepted.

•   Standard: Feature is enabled. Most communication parameters are fixed, except 

the port number to which the UDP packets respond. Security features are not 

available.

•   Manual: Feature is enabled. All communication parameters are configurable. 

Security features are available.
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•   For Nexus® 12XX meters, a single DNP Over TCP connection and a single DNP 

Over UDP connection is available when enabled; the 1500/1500+ has two DNP over 

TCP connections and one DNP over UDP connection, and the 1450 has up to two 

DNP over TCP and 2 DNP over UDP connections, when both ports 5 and 6 are used 

for DNP. While DNP Over TCP connections may be closed at the decision of the Net-

work Card, the master Nexus® meter may also determine that the current DNP 

Over TCP connection should be closed.

•   Since INP100/INP102/INP200/INP202 have several built-in servers, the DNP 

LAN/WAN TCP and UDP Listen on Ports defined by the user cannot be any of the 

ports shown below

•   DNP Device Address is configurable.

Example of setting up validation for IP addresses:

1. Set Validate Source IPs to 1 IP address.

2. Set Validate Source ports to Yes.

3. Enter IP address, such as 10.0.0.101.

4. Enter Subnet mask, such as 255.255.255.128.

5. Enter TCP ports range, such as 20000-20000.

6. Enter UDP ports range, such as 20000-20000.

As the result, a valid DNP3 LAN/WAN request must come from a device with IP 

address of 10.0.0.1 to 10.0.0.127, with TCP and UDP ports set at 20000.

If a DNP Over TCP connection was established and Validation was also enabled, 

any new incoming DNP Over UDP connection must have the same IP address as 

Name Port #

Echo 7

FTP Server Data 20

FTP Server Control 21

Web Server 80

Modbus TCP Server 502
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the TCP connection. If they are different, the UDP connection is closed.

All incoming communication for DNP LAN/WAN goes to the Master meter; no DNP 

communication goes to the INP100/INP102/INP200/INP202’s gateway port.

2. Click OK to save your settings.
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21.7: Customizing Screens

The following sections explain how to customize the TWS screens for your applica-

tion’s specific needs. Note that the 1450 meter does not support this feature.

21.7.1: Configuring WebExplorerTM

All polled data for the Nexus® 12xx and the Shark® 200 meters is stored in an XML 

file, poll_data.xml. All polled data for the Nexus® 1500/1500+ meter is stored in an 

XML file called pdata.xml. Each polled item is located in its DEVICE_x section as it is 

programmed in the poll_profile.xml file. The standard data format for each device is:

<DEV_NAME> <DEV_TYPE>

up to 64 <items>, each with its D_UID, D_LABEL and D_VALUE.

This XML file can be viewed directly in your browser (click View>Source). To display it 

on a customized webpage, you must set up your browser to run Java Script. (Config-

uring XML is detailed in Section 21.7.2.)

NOTES: 

•   Auto Refresh Rate is set in the Set Timeout ()Function. See the Java Script exam-

ple for Internet Explorer, below.

•   Java Script code or implementation methods may vary for other types of web 

browsers. The webpage files currently support 4 type of browers: IE, FireFox, 

Safari, and Chrome. You can view the code in each file once it is downloaded from 

the meter to your PC.

Example of the data file:

<?xml version=”1.0” encoding=”UTF-8”?>

<!--Electro Industries/GaugeTech embedded network server polled data-->

<EIG_DATA>

<EIG_SYSTEM>

</EIG_SYSTEM>

<DEVICE_1>

<DEV_NAME>Nexus Demo 1</DEV_NAME>
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<DEV_TYPE>Nexus 1250</DEV_TYPE>

<item D_UID=”1_1” D_LABEL=”Inst Van” D_VALUE=”+122.46”></item>

</DEVICE_1>

<DEVICE_2>

<DEV_NAME>N/A</DEV_NAME>

<DEV_TYPE></DEV_TYPE>

<item D_UID=”2_1” D_LABEL=”Inst Watt” D_VALUE=”+0.08 k”></item>

</DEVICE_2>

</EIG_DATA>

Displaying a value in an HTM file: (Use Java Script in the Web browser.)

1. Define a unique name for a value to be displayed, such as data_name. Insert 

<span id=”data_name”></span> in the HTM file where it will be displayed.

2. Create a Java Script code inside the HTM file (Auto Screen Refresh is set at 5000ms 

in the Set Timeout ()Function); see Example below:

Example:

<Script language=Javascript>

<!--var disp_value;

var timerID;

var tmp_name;

var xmlDoc=new ActiveXObject(“MSXML.DomDocument”);

xmlDoc.async=true;

xmlDoc.onreadyststechange=do_get_data;

function do_get_xml()

{
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xmlDoc.load(“poll_data.xml”);

{

function do_get_data()

{

if (xmlDoc.readyState == 4)

{

if (xmlDoc.documentElement == null)

{

timerID = setTimeout(“do_get_xml();”,5000);

}

else

{

disp_value =

xmlDoc.documentElement.selectSingleNode

(“//item[@D_UID=’1_1’]”).

getAttribute(“D_VALUE”);

data_name.innerHTML = disp_value;

timerID = setTimeout(“do_get_xml();”,5000);

}

}

}

//--></SCRIPT>

NOTE: Inside the <body> of the HTML file, add the following:
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Load=”do_get_xml()”

Server Side Include Functions

These functions will send data directly to the browser as part of a requested docu-

ment.

Example of using Server Side Include Functions:

1. In HTM file, add the following to the first line of that file

<!-- ** THIS FILE DOES CONTAIN REALTIME DATA ** -->

Without that line, any server side include functions will not be processed by the 

Web server.

2. Inside the HTM file where you want the info displayed, add

<!--#exec cgi=”/[server_side_include_function_name]”-->

where [server_side_function_name] can be one of the function names.
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3. To display stored email #1’s date/time, add the following to your HTML file at the 

location where you want the data displayed:

<!--#exec cgi=”/ssi_show_email_date_time 1”-->

GENERAL FUNCTIONS

Server Side Include Function Name Parameter Description

get_ip.fn Show Local IP address

DIAGNOSTIC FUNCTIONS

Server Side Include Function Name Parameter Description

ssi_diag_cpu Show CPU info

ssi_diag_ethernet_hardware Show ethernet hardware info

ssi_diag_firmware Show firmware info

ssi_diag_ftp_server Show FTP server info

ssi_diag_imported_files Show FTP Client/Imported 
files status

ssi_diag_memory Show memory info

ssi_diag_modbus_com Show all Modbus communi-
cation info

ssi_diag_modbus_tcp_server Show Modbus TCP server 
info

ssi_diag_modem Show internal modem 
(INP102) status

ssi_diag_system Show system info, such as 
start time

ssi_diag_web_server Show Web server info

stats.fn Show ethernet communica-
tion status
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NOTE: “1” =oldest; “10” = newest.

STORED EMAIL FUNCTIONS

Server Side Include Function Name Parameter Description

ssi_show_email_date_time 1 to 10 Show stored email’s date/
time

ssi_show_email_subject 1 to 10 Show stored email’s subject 
text

ssi_show_email_from 1 to 10 Show stored email’s from 
text

ssi_show_email_to 1 to 10 Show stored email’s to text

ssi_show_email_cc 1 to 10 Show stored email’s cc text

ssi_show_email_device_name 1 to 10 Show stored email’s device 
name text

ssi_show_email_contact_person 1 to 10 Show stored email’s contact 
person name

ssi_show_email_contact_phone 1 to 10 Show stored email’s contact 
person’s phone number

ssi_show_email_alarm_ids 1 to 10 Show stored email’s alarm 
IDs

ssi_show_email_alarm_names 1 to 10 Show stored email’s alarm 
names

ssi_show_email_alarm_details 1 to 10 Show stored email’s alarm 
details

ssi_show_email_send_status 1 to 10 Show stored email’s send 
status
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SPECIAL FUNCTIONS FOR MODBUS DEVICE 1

Server Side Include Function Name Parameter Description

ssi_show_pt Show PT ratio

ssi_show_ct Show CT ratio

ssi_show_system Show hookup info

ssi_show_dev_type Show device type/model

ssi_show_dev_name Show device name

ssi_show_boot Show boot firmware version

ssi_show_run_time Show runtime firmware ver-
sion

ssi_show_dsp_boot Show DSP boot firmware 
version

ssi_show_dsp_runtime Show DSP runtime firmware 
version

ssi_show_sn Show device serial number

ssi_show_com_state Show COM firmware run-
time state

ssi_show_dsp_state Show DSP firmware runtime 
state

ssi_show_pw_state Show password protection 
state

ssi_show_mac Show Ethernet MAC address

ssi_show_ip Show IP address

ssi_show_mask Show subnet mask

ssi_show_gateway Show default gateway IP 
address

ssi_show_dnp_lan_wan Show DNP LAN/WAN status
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21.7.2: Configuring WebXMLTM

The term XML stands for Extensible Markup Language. XML is a markup language 

similar to HTML which is used to describe data. HTML displays the data. XML does not 

replace HTML; it complements HTML. An XML document is information wrapped in 

XML tags. A piece of software has to be written to send, receive or display the docu-

ment.

IMPORTANT! You must follow the “Rules” of XML, listed below:

1. The first line of the document, the XML declaration, defines the XML version and 

the characters used in the document.

2. All XML elements must have a closing tag.

3. XML tags are case sensitive.

4. All XML elements must be properly nested.

5. All XML documents must have a root tag (first tag in an XML document).

6. Attribute values must always be quoted.

7. Comment syntax is similar to HTML. <!-- This is a comment -->

Example of Root Tag and Elements:

The first tag in an XML document is the root tag. All XML documents must contain a 

single tag pair to define the root element. All other elements must be nested within 

the root element.

All elements can have sub-elements (children). Sub-elements must be correctly 

nested within their parent elements as shown below:

<root>

<child>

<subchild>.....</subchild>

</child>

</root>
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Example of Attributes:

<data id=”1” value=”123”></data>

Poll_profile.xml: File configured to poll parameters of each device:

NOTE: The Nexus® 1500/1500+ meter uses pprofile.xml.

Root tags: <EIG_POLL_DATA> and </EIG_POLL_DATA>

System elements: <EIG_SYSTEM> and </EIG_SYSTEM>

Contains system parameters and email addresses

General attribute:

<item DATA_POLL_DELAY=”400”

ALARM_POLL_DELAY=”1000”

SYSTEM_COMM_TIMEOUT=”1000”

ALARM_CONTACT_PHONE=””

ALARM_CONTACT_PERSON=”Administrator”

></item>

SYSTEM ATTRIBUTES

Attributes Description Settings

DATA_POLL_DELAY Poll delay between each Modbus
poll, in milliseconds

Min=500
Max=65536
Default=500 

SYSTEM_COMM_TIMEOUT System communication timeout, in
milliseconds

Min=500
Max=32000
Default=500

ALARM_POLL_DELAY Poll delay between each Modbus
poll for each device’s alarm polling,
in milliseconds

Min= 1000
Max=65535
Default=1000

ALARM_CONTACT_PHONE Alarm contact phone number Max size=10 digits

ALARM_CONTACT_PERSON Alarm contact person name Max size=64 characters
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Email Attributes:

<item EMAIL_1=””FORMAT_1=”long”

EMAIL_2=””FORMAT_2=”long”

EMAIL_3=””FORMAT_3=”long”

EMAIL_4=””FORMAT_4=”short”

EMAIL_5=””FORMAT_5=”short”

EMAIL_6=””FORMAT_6=”short”

EMAIL_7=””FORMAT_7=”short”

EMAIL_8=””FORMAT_8=”short”

></item>

Device Elements: <DEVICE_X> and </DEVICE_X>, where X is from 1 to 16.

Contain parameters for each device.

General attributes:

<item DEV_TYPE=”Nexus 1250”

DEV_PROTOCOL=”Modbus RTU”

DEV_NAME=”Nexus Demo 1”

DEV_ADDRESS=”1”

DEV_IP=””

DEV_MAX_PACKET_LEN=”127”

EMAIL ATTRIBUTES

Attributes Description Settings

EMAIL_X Email address, X is from 1 to 8 Max size = 64 characters

FORMAT_Y Email format, Y is from 1 to 8 Strings ‘long’ or ‘short’
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DEV_POLL_ALARM=”yes”

DEV_ALARM_OPTIONS=”1+2+3+4+5+9”

DEV_ALARM_DELAY=”2000”

DEV_COMM_TIMEOUT=”750”

DEV_PARENT=”1”

></item>

Polling Data Elements: <DEV_DATA> and </DEV_DATA>

Polling data attributes, up to 64 in each <DEV_DATA> element:

<item D_UID=”1_1”

D_LABEL=”Inst Van”

D_ADDR=”180”

D_LENGTH=”2”

D_TYPE=”7”

D_USE_SPECIAL=”3”



     Doc#    E107707                                               21 - 40

21: Total Web Solutions and WebviewTM Energy Dashboard

D_VALUMODE=”Primary”

></item>

SYSTEM ATTRIBUTES

Device Element Description Settings

DEV_TYPE Supported device name Generic Modbus
Nexus 1250
Nexus 1252
Nexus 1260
Nexus 1262
Nexus 1270
Nexus 1272
Nexus 1500/1500+
[~DEVICE_TYPE_LABEL] = 
Auto
detect device’s type 
(Nexus®
devices only)

DEV_PROTOCOL Protocol name Modbus RTU
Modbus TCP

DEV_NAME User assigned device name Max = 32 characters
[~DEVICE_LABEL] = Use the
name stored inside the 
device (Nexus® devices 
only)

DEV_ADDRESS Device address Modbus protocol = 1 to 247

DEV_IP IP address for Modbus TCP devices xxx.xxx.xxx.xxx

DEV_MAX_PACKET_LEN Max Modbus registers for a device’s
response buffer

Nexus® = 127
Futura & DMMS = 50

DEV_POLL_ALARM Enable or disable device alarm poll
function

Yes = Enable
No = Disable

DEV_ALARM_OPTIONS Alarm poll options 1 = Limits changed
2 = Inputs changed
3 = Waveform captured
4 = PQ (CBEMA) event 
      captured
5 = Control output changed
9 = Communication failure

DEV_ALARM_DELAY Delay time for reporting alarm
condition (in milliseconds) for limit
and input type alarms

Min = 0
Max = 300000
Default = 0

DEV_COMM_TIMEOUT Device communication timeout
(in milliseconds)

Min = 500
Max = 32000
Default = 500

DEV_DATA_FORMAT Data format 0 to 0.000000

DEV_PARENT Parent device ID (see NOTES) Value from 1 to 16
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NOTES: 

•   Parent device ID (DEV_PARENT), for polling expansion beyond the 64 items per 

device limitation. If set, it will use the parent device’s communication settings.

•   In a Nexus® 1500/1500+ meter with factory set LCD configuration, some data 

displayed on the LCD screens is configured in the pprofile.xml file, which is also 

used for configuring the data displayed in the webpages. For this reason, modifying 

the pprofile.xml file may affect the LCD's data presentation.

DEV_MODBUS_REG_BASE Device’s modbus register base is
either:

0 based integer value or
1 based integer value 
(default)

DEV_TCP_PORT Remote Modbus TCP device’s port
number 

Default setting = 502

DATA ELEMENT ATTRIBUTES

Attribute Description Settings

D_UID User assigned device polling data
unique ID 

Max = 16 characters

D_LABEL User assigned data label Max = 32 characters

D_ADDR Modbus register address 0 or 1 based integer value

D_LENGTH Number of Modbus registers

D_TYPE Data type For Nexus® Devices, use Fx
Communication Data For-
mats
For Generic Modbus Device 
Type, see NOTE below the 
table for values

D_CHANNEL Channel ID for I/O type values Nexus® devices only

D_SHOW_KM A Format value with k or M auto = auto show k or M
k = fixed to k
M = fixed to M

D_USE_SPECIAL Special functions See NOTE*

D_NA_VAL If a numerical value is set here and
a real polled value matched with this
number, a ‘***’ string will be stored
in the xml data file.

Numerical Value for ‘***’
(Nexus® devices only)

SYSTEM ATTRIBUTES



     Doc#    E107707                                               21 - 42

21: Total Web Solutions and WebviewTM Energy Dashboard

D_VALUEMODE Value mode Raw
Primary
Secondary
Value (for Generic Modbus 
Device Type)
Interpreted. See NOTE**

D_FUNCTION_CODE Modbus protocol function code 1, 2, 3 (default), 4

D_BYTE_ORDER Data byte order for Generic Modbus
device. 
(Settings if source is 0x12345678)

0 MSR, MSB 0x1234, 
0x5678: MS reg
first, MS byte first (default)
1 MSR, LSB 0x3412, 
0x7856, MS reg
first, LS byte first
2 LSR, MSB 0x5678, 
0x1234, LS reg
first, MS byte first
3 LSR, LSB 0x7856, 0x3412, 
LS reg
first, LS byte first

D_SPECIAL Generic multiplier value for Generic
Modbus device; applied when
D_USE_SPECIAL is set to 6

1 = Default

D_TAG_SPECIAL  Cross linked multiplier ID for
Generic Modbus device

Setting is any unique 
D_UID’s setting
within polling profile

D_MASKING_TYPE Data masking type for Generic
Modbus device

0 = do nothing (default)
1 = NOT
2 = OR
3 = AND
4 = NOR
5 = NAND
6 = XOR
7 = XNOR

D_MASKING_VALUE Data masking value for Generic
Modbus device; setting is hex
ASCII string for up to 8 bytes of data

0x0=default
Example of a 3 byte value: 
0xAB12CD

D_CFG_FILE Configuration file name for Generic
Modbus device

Case sensitive file name up 
to 128 characters; the file 
must be available at system 
start up using FTP download

D_VALUE Value processed by Total Web
Solutions and stored in
poll_data.xml file***

D_REF Reference info or value for polled
item; stored in poll_data.xml file*** 
Data source is the configuration file

DATA ELEMENT ATTRIBUTES
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NOTE: Values for Generic Modbus D_TYPE:

1 = ASCII string

2 = 1 byte, signed high byte of the Modbus Register

3 = 1 byte, signed low byte of the Modbus Register

4 = 1 byte, unsigned high byte of the Modbus Register

5 = 1 byte, unsigned low byte of the Modbus Register

6 = 2 bytes, signed integer

7 = 2 bytes, unsigned integer

8 = 4 bytes, signed long integer

9 = 4 bytes, unsigned long integer

10 = 8 bytes, signed long long integer

11 = 8 bytes, unsigned long long integer

12 = 4 bytes, IEEE float

13 = 1 digit, 8 bits representation

14 = 1 digit, 4 bits representation (aka Packed BCD)

15.= 1 byte, signed

16 = 1 byte, unsigned

17 = 8 bytes, IEEE float

NOTE*: Parameters for D_USE_SPECIAL:

0 = do not multiply any number

1 = multiply by CT ratio (mainly used for current values)

2 = multiply by CT Aux ratio
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3 = multiply by PT ratio (mainly used for voltage values)

4 = multiply by PT Aux ratio

5 = multiply by CT and PT ratio (mainly used for power, energy values)

6 = multiply by the value in D_SPECIAL (generic modbus device only)

NOTE**: If D_VALUEMODE is set to Interpreted, when used with Nexus® Input Val-

ues, the result will be a user-defined name in the meter’s Device Profile instead of a 

value of 0 or 1.

NOTE***: Nexus® 12xx and Shark 200® meters’ Network cards use poll_data.xml; 

the Nexus® 1500/1500+ meter uses pdata.xml.

Poll_data.xml/pdata.xml

Root tag: <EIG_DATA> and </EIG_DATA>

One (1) system element: <EIG_SYSTEM> and </EIG_SYSTEM>

Sixteen (16) device elements: <DEVICE_X> and </DEVICE_X>, where X is from 1 to 

16.

In each of the 16 device elements: Device info elements: card copies data from poll_-

profile.xml/pprofile.xml.

<DEV_NAME> and </DEV_NAME>

<DEV_TYPE> and </DEV_TYPE>

Up to 64 polling data attributes: card copies data from poll_profile.xml/pprofile.xml.

<item D_UID=”1_1”

D_LABEL=”Inst Van”

D_VALUE=”+126.06” (Data value).

></item>
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21.7.2.1: Configuration File (for Generic Modbus Device)

The purpose of the configuration file is to allow the user to set what real value or 

information could be available in the poll_data.xml/pdata.xml file. Each configuration 

file allows the user to set up 8 interpreted values or strings. The configuration file’s 

format is XML.

Below is an example xml file with three values:

<?xml version=”1.0” encoding=”UTF-8” ?>

<EIG_CONFIGURATION>

<item CFG_COMPARE_TYPE=”Value” CFG_VALUE=”0” CFG_REF=”Disabled” />

<item CFG_COMPARE_TYPE=”Value” CFG_VALUE=”128” CFG_REF=”Enabled” />

<item CFG_COMPARE_TYPE=”String” CFG_VALUE=”107 Nexus 1250”

CFG_REF=”Nexus 1250 Meter” />

</EIG_CONGFIGURATION>

The root tags are <EIG_CONFIGURATION> and </EIG_CONFIGURATION> with up to 

8 items between the root tags.

CFG_COMPARE_TYPE settings are “Value” for numeric comparison or “String” for text

comparison.

CFG_VALUE can be a numeric value or text string (up to 256 characters) to be used 

for comparison.

CFG_REF is any interpreted value or text string when the comparison returned a 

match (up to 256 characters for a text string).

D_REF is the corresponding value in the poll_data.xml/pdata.xml file.
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21.7.2.2: Order of Data Processing for Generic Modbus Device

The steps in data processing are as follows:

1. Set byte order

2. Apply bit masking

3. Apply multiplying factor

4. Apply interpreted values from generic file(s)

21.7.3: Configuring WebReacherTM

Through the configuration of poll_profile.xml, you can poll up to 16 individual devices 

or up to 1024 unique items via Modbus RTU protocol or Modbus TCP/IP protocol.

NOTE: The Nexus® 1500/1500+ meter supports Modbus TCP/IP and a maximum of 8 

devices. To set up WebReacherTM for the Nexus® 1500/1500+ meter so that it can 

use Modbus RTU, you must have the optional RS485 port and follow these steps:

1. In the Communications Settings screen of the Device Profile, set the 2nd RS485 

port to RTU Master mode and Modbus RTU protocol.

2. In the meter’s device profile set up RTU master polling (see Chapter 11 for instruc-

tions).

3. Configure pprofile.xml with a new device allocation, using Modbus RTU and device 

address 1, to poll data from the main meter, for the polling items set up in the 

meter's RTU master configuration.

Devices supported: any device that supports Modbus RTU or Modbus TCP protocol 

(with at least one available socket).

Devices supported for Advanced Features:

Nexus® 1250/1252, 1262, 1272, 1500, 1500+, CPU1000, DMMS300/350/425 (Use 

generic Modbus device settings for CPU1000 and DMMS meters.) 
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System set up:

NOTE: The instructions below are slightly different for the Nexus® 1500/1500+ 

meter. The Nexus® 1500/1500+ meter does not use the Poll_data.xml file. It’s Web 

data is stored in: \I\pdata.xml; for Web access http://[IP]/I/pdata.xml. All user con-

figurable webpage files are physically located in the directory \C\TWS\, including the 

Web server's index.htm file. All files can be accessed as http://[IP]/C/TWS/

[file_name.ext]. The meter's Web server automatically loads the \C\TWS\index.htm 

file into the Web server's root as the default webpage file, http://[IP]/index.htm. Be 

sure to set the reference link in index.htm properly.

Set DATA_POLL_DELAY in milliseconds; the system will pause between each Modbus 

poll.

Set SYSTEM_COMM_TIMEOUT in milliseconds.

Example:

<EIG_POLL_DATA>

<EIG_SYSTEM>

<item DATA_POLL_DELAY=”400”SYSTEM_COMM_TIMEOUT=”500”

></Item>

</EIG_SYSTEM>

</EIG_POLL_DATA>

Device Set up: within the boundary of <DEVICE_X> and </DEVICE_X>

1. Assign a device type, DEV_TYPE.

2. Assign a protocol, DEV_PROTOCOL

3. Assign user defined device name, DEV_NAME (should be unique in a system).

4. Assign Modbus device address, DEV_ADDRESS.

5. If protocol is Modbus TCP, assign the remote device’s IP address and the TCP port 

number: DEV_IP and DEV_TCP_PORT.

6. Set max Modbus packet length in number of registers, DEV_MAX_PACKET_LEN.
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7. Set device’s communication timeout in milliseconds, DEV_COMM_TIMEOUT. The 

timeout value should be longer for devices that speak Modbus TCP than for devices 

that speak Modbus RTU, depending on network traffic.

8. Set device’s data display format, DEV_DATA_FORMAT, from 0 to 0.000000.

9. You can expand the polling item limitation of 64 items per device by setting a 

device as a child device of a parent device.

For Example, in <DEVICE_X> section, if you set it to be the parent device, 

DEV_PARENT must be X or 0. Then for <DEVICE_Y> section, if you set the device 

to be a child device of X, set DEV_PARENT to X. Other parameters can be omitted.

Example:

<EIG_POLL_DATA>

<DEVICE_1>

<item DEV_TYPE=”Nexus 1250”

DEV_PROTOCOL=”ModbusRTU”

DEV_NAME=”Nexus Demo 1”

DEV_ADDRESS=”1”

DEV_IP=””

DEV_TCP_PORT=””

DEV_MAX_PACKET_LEN=”127”

DEV_COMM_TIMEOUT=”750”

DEV_DATA_FORMAT=”0.00”

DEV_PARENT=”1”

></item>

</DEVICE_1>

</EIG_POLL_DATA>
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Polling Item Set up:

In each DEVICE_X, DEV_DATA section, you can have up to 64 items. Any extra items 

will be ignored.

1. Set a unique ID, D_UID, so any program can easily access this item.

2. Set a data label, D_LABEL, optional.

3. Set Modbus register in decimal, 1 based, D_ADDR.

4. Set how many Modbus registers, D_LENGTH. Note: Each register is 2 bytes long.

5. Set data type, D_TYPE. (See your meter’s Modbus Protocol Register Map Manual.)

6. Set special operations, such as multiplying PT or CT ratio, D_USE_SPECIAL.

7. Set value mode, D_VALUEMODE as primary, secondary or raw value.

8. Set display units, D_SHOW_KM, optional.

9. Set a N/A value, D_NA_VAL, optional.

Example:

<EIG_POLL_DATA>

<DEVICE_1>

<DEV_DATA>

<item D_UID=”1_1”

D_LABEL=”Inst Van”

D_ADDR=”180”

D_LENGTH=”2”

D_TYPE=”7”

D_USE_SPECIAL=”3”

D_VALUEMODE=”Primary”
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></item>

[...up to 64 items...]

</DEV_DATA>

</DEVICE_1>

</EIG_POLL_DATA>

21.7.4: Configuring WebModTM

WebMODTM allows the network to interface with Modbus-based IEDs. WebMODTM 

supports 12 Modbus TCP/IP sockets (12 simultaneous connections). 

NOTE: The Nexus® 1500 meter supports 8 Modbus TCP/IP sockets; the Nexus® 

1500+ meter supports up to 32 simultaneous Modbus TCP/IP sockets per card; the 

Nexus® 1450 meter supports up to 16 Modbus TCP/IP sockets each for ports 5 and 6, 

but up to 28 total, e.g., 12 for one port and 16 for the other.

The Modbus Port Number is 502. The Modbus Port Number is set on the Location 

Editor screen and Devices are added to the Network on this screen.

NOTE: If your system is firewalled, you must ask your network administrator to grant 

communication access on TCP/IP Port 502.

Modbus TCP Format: [6-byte Header] [Modbus RTU message without checksum]

Header detail:

[2 Bytes - Sequences/Transactions ID] [2 Bytes - 0s] [2 Bytes - Length, Number of 

Bytes following]

Example:

Request:

01 03 00 00 00 06 01 03 00 00 00 02

Transaction #259, 6 Bytes long, Modbus RTU Request for Address 01, Function Code 

03 (read holding registers), Start at Register 0 for 2 registers.
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Response:

01 03 00 00 00 07 01 03 04 xx xx xx xx

Transaction #259, 7 Bytes long, Modbus RTU Response for Address 01, Function Code 

03, 4 Bytes long data.

It will not support multiple Modbus requests and responses in a single Modbus TCP 

packet. For INP100/INP200 and INP102/INP202 Options, all requests with Modbus 

Address 01 will transmit to the meter itself. All other requests with Modbus Addresses 

other than 01 will transmit to the RS485 Gateway Port.

21.7.5: Configuring WebAlarmTM

To enable WebAlarmTM, see the instructions in 21.6.4: WebAlarmTM/Email, on 

page 21-15. Through CommunicatorPQA® software you can configure one email 

address, which is stored in the meter for single user or administrative use. Eight addi-

tional addresses can be programmed in the poll_profile.xml/pprofile.xml file (see 

21.7.2: Configuring WebXMLTM, on page 21-36).

To configure additional email recipients:

Edit the poll_profile.xml/pprofile.xml file saved in the FTP Server (see 21.6.5: FTP Cli-

ent, on page 21-19). From EMAIL_1 to EMAIL_8, enter the email address within the 

double quotes From FORMAT_1 to FORMAT_8, enter the format name as either 

“short” or “long” within the double quotes. A section of a poll_profile.xml/pprofile.xml 

file is shown below without values entered.

<EIG_POLL_DATA>

<EIG_SYSTEM>

<item EMAIL_1=””FORMAT_1=””

EMAIL_2=””FORMAT_2=””

EMAIL_3=””FORMAT_3=””

EMAIL_4=””FORMAT_4=””

EMAIL_5=””FORMAT_5=””

EMAIL_6=””FORMAT_6=””
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EMAIL_7=””FORMAT_7=””

EMAIL_8=””FORMAT_8=””

></item>

</EIG_SYSTEM>

</EIG_POLL_DATA>

Short Format:

For all handheld mobile devices with text messaging service capable of receiving up to 

160 characters. Character number includes sender address, subject and body plus 

additional separator characters. This format is defined by EIG - the user cannot 

modify it.

Example of the Short Format:

[64 characters of sender’s email address]##[32 characters of Meter ID]

#Alarm[10digit operator’s phone number]

IDs1+2+3+4+5+6+7+8+9+10+11+12+13+14+15+16

Long Format:

For all handheld mobile devices and PC users who can receive regular email. This 

includes detailed alarm information.

Example of Long Format:

Device Name: Nexus Demo 1

Contact Person: Administrator

Contact Phone: 1234567890

Alarm IDs: 1+2+3+4

Alarm Names:

(1) Limits changed

(2) Inputs changed
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(3) Waveform captured

(4) PQ (CBEMA) event captured

Alarm Details:

Limits:

(4) 1s IA, Below Limit 2, Combination=OR, value = +0.38

(5) 1s IB, Below Limit 2, Combination=OR, value = +0.38

(6) 1s IC, Below Limit 2, Combination=OR, value = +0.38

Inputs:

(1) HSI Input 1 BK101 Off

(3) HSI Input 3 Closed

(4) HSI Input 4 Closed

21.7.6: Configure Alarm Polling Options (Enter values within the 
              double quotes)

To enable the polling for a device, set DEV_POLL_ALARM to “Yes”; to disable it, set 

“No”.

Alarm polling options: 1 to 9 (See table on the next page.)

The default is sending alarm emails for all options, 1 to 9.

You can configure the polling profile to have any combination of options.

Edit the poll_profile.xml. Set up the alarm polling options by concatenating the 

options IDs, such as: “1+2+3+4+5+9”.

Set the alarm delay for limits in Milliseconds (a value of 1000 = 1 second). If a limit 

condition occurs for 1 second or more, an alarm email is sent.

<EIG_POLL_DATA>

<DEVICE_x>

<item DEV_POLL_ALARM=””



     Doc#    E107707                                               21 - 54

21: Total Web Solutions and WebviewTM Energy Dashboard

DEV_ALARM_OPTIONS=””

DEV_ALARM_DELAY=””

></item>

</DEVICE_x>

</EIG_POLL_DATA>

NOTE: Most of the Alarm Triggering Conditions for Nexus® devices rely on the 

device’s configuration in the Device Profile. Make sure that the settings are correct for 

Limits, Inputs, Waveforms, etc.

To configure Alarm polling for more individual devices:

Edit the poll_profile.xml/pprofile.xml file for each device’s section. Configure the 

parameters.

<EIG_POLL_DATA>

<DEVICE_x>

<item DEV_POLL_ALARM=””

DEV_ALARM_OPTIONS=””

></item>

</DEVICE_x>

ALARM POLLING OPTIONS

Option ID Option Name Description

1 Limit exceeded Any exceeded Limit condition

2 Inputs abnormal condition Any internal digital input abnormal condition

3 Waveform captured The meter has captured a waveform

4 PQ (CBEMA) event captured The meter has captured a PQ event

5 Control output changed A relay module connected to the meter 
changed state

9 Communication failure The Network card has difficulty talking to the 
meter
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</EIG_POLL_DATA>

A common problem is described below:

If you entered a name for the SNTP Server instead of an IP address, make sure your 

DNS Server is working and you have either set a DSP IP inside the meter or your DNS 

can supply a DNS IP. If it cannot resolve the name to an IP translation, no email will 

be sent.

Regarding stored emails:

You can access the stored_emails.htm page from any web browser. The last 10 emails 

sent will be stored in the RAM on a FIFO basis (First In, First Out) and will be dis-

played in descending order. The page will be cleared after a complete system restart.

21.8: FTP Server 

A built-in FTP Server is available for a meter equipped with INP100/INP200. It has a 

3-user limit, so no more than three users can connect to the FTP Server simultane-

ously. The FTP Server logon User Name and Password are stored in the INP100/

INP200 card, not in the meter’s programmable settings.

The Initial FTP Server User Name and Password are: eignet and inp100, except for 

the Nexus® 1500 meter which has anonymous as the initial setting for both user 

name and password. The FTP Server’s quota is 4 Megabytes of RAM.

The Nexus® 1450 meter does not support FTP server.

21.9: Update Network Card Firmware from Webpage (in Runtime
          Mode)

Network Card Firmware can be updated through the Web (the Nexus® 1450 meter 

does not support this). Follow these steps:

1. Start your browser. Type the meter’s IP address in the browser’s URL address bar. 

The Main WebExplorer screen is displayed (see page 21-3).
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2. Click Tools>Firmware Upgrade or, add /update1.htm to the end of the URL.The 

Enter Network Password screen opens, prompting you for a User Name and Pass-

word. See the example screen shown below.

3. Enter User Name and Password.

         Initial User Name = eignet (anonymous for Nexus® 1500 meter)

         Initial Password = inp100 (anonymous for Nexus® 1500 meter)

4. Click OK. The Update Run-Time Firmware screen opens- see the screen shown 

below.

5. Click the Browse button to select the correct Run-time firmware file.
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6. Click Update Run-Time Firmware. The update process can take several minutes. 

Make sure that during the process you do not close the Update Run-Time Firmware 

screen (or update1.htm browser window). During the update process, the INP100/

INP200 Update Run-Time Firmware Status screen opens. It displays the current 

status of the update.

7. When you get the message that the update was successful, restart the connected 

meter, in one of the following ways:

a. Click Reset or Restart, which take you to reset_ethernet.htm.

 OR

b. Power down and then power up the connected meter.
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21.9.1: Update Network Card Firmware through Software

There are two methods for updating the network card firmware though Communica-

torPQA® software - flash upgrade and the following procedure.

1. From the Device Profile screen, click General Settings>Communications.

2. From the Communications Settings screen, click the Advanced Settings button.

3. Click the Firmware Update tab. You will see the screen shown below.

4. Click the Enable checkbox.

5. Enter the Server port and IP address; Device’s IP address; Subnet Mask, and 

Default Gateway.

6. In the Download Filename field, enter the path of the Firmware update file. For 

example: C:Electro Industries\Updates\Firmware\V.1.2.3.0.

7. Click OK to save your settings.
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NOTES: 

•   To flash update Network Card firmware through the CommunicatorPQA® applica-

tion, see 25.2.1: Update the Internal Network Card’s Firmware, on page 25-3.

•   The Shark® 200/250/270 meter’s network card can only be updated via its web-

page. See the meter’s User Manual for details.

•  The Nexus® 1450 meter’s Network firmware can only be updated via Communica-

torPQA® software.
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21.10: WebXML Flowchart
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21.11: WebExplorer Flowchart
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21.12: WebAlarm Flowchart
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21.13: Comparison of Network Cards

The following tables describe the Network features supported by the Nexus® and the 

Shark® 200 meters. 

Nexus® 1252/1262/1272, 1450, and Shark® 200/250/270 Meters Network 

Supported Features

EIG Network Features in Runtime Firmware

Meter  Nexus® 12xx Meter Nexus® 1450 Meter Shark® 200/250/270 
Meter

Network card  INP100/102/200/202 Standard INP100S Gen 1 /
Gen2

Runtime Firmware Version of Network card

WebExplorer/Web Server  v1.x.x, v3.x.x Yes v1.x, v3.x, Gen 2

WebXML  v1.x.x, v3.x.x No v1.x, v3.x, Gen 2 
Read access to data 
file only 

WebReacher (FTP client)  v1.x.x, v3.x.x No No

WebMod (Modbus TCP)  v1.x.x, v2.x.x, v3.x.x Yes v1.x, v2.x, v3.x, Gen 
2

WebAlarm/Alarm/Email v1.x.x, v3.x.x Yes Yes

DHCP v1.x.x, v3.x.x Yes, for Port 5 v1.x, v3.x, Gen 2

Modbus LDA Access for
firmware update (alternative 
to TFTP in boot and Web in 
runtime)

v1.x.48+, v2.x.x, 
v3.x.x

No v2.x.x, v3.x.x

Ethernet Gateway port  v1.x.x, v3.x.x No No

Modem  v1.x.x, v2.x.x, v3.x.x Yes Cellular modem for 
the 270

DNP LAN/WAN (requires 
meter firmware support)

v1.x.x, v2.x.x, v3.x.x Yes Yes for the 270

GE EGD protocol v1.x.x, v2.x.x, v3.x.x Yes No

Firmware update via Web 
Server

v1.x.x, v3.x.x No v1.x, v3.x, Gen 2

Sleep Mode (only active 
under certain conditions)

v1.x.x, v2.x.x, v3.x.x N/A Yes for the 270 Gen 2

SNTP Yes Yes Yes
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Nexus® 1500+ Meter TWS Supported Features

•   IP/Mask/Gateway

•   Modbus TCP Server

•   Modbus TCP Client

•   Web Server

•   FTP Server

•   DNP LAN/WAN

•   Alarm Email

•   GE EGD*

•   PING

•   DNS

•   IEC 61850*

•   IEC 61850 GOOSE*

•   SNTP

•   SNMP (with firmware version v15, or higher)

•   IEEE 1588 PTPv2 Master (only available on second Ethernet card) or Slave

Cable auto detect v1.x.x, v2.x.x, v3.x.x Yes v1.x, v2.x, v3.x, Gen 
2

Accept Debug commands 
from meter's UART ports

v1.x.x, v2.x.x, v3.x.x N/A: sends a fixed set 
of parameters- IP, 
MAC address, status, 
etc.

IEC 61850 Yes 200/250/270/200S - 
yes

IEC 61850 GOOSE Yes No

IPv4 Yes Yes Yes

IPv6 No Yes Yes for the 270 Gen 2

EIG Network Features in Runtime Firmware
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•   Synchrophasor (PMU) (available on one Ethernet card at a time)

* These features are supported on Network (Ethernet) Card 1, only.

21.14: GE EGD Details

Firmware Requirements

• Network card firmware v1.0.40

• The meter’s firmware, DSP, and COM must support a 50 ms update

Configuring the Meter and Network Card

The GE EGD data producer uses UDP port 18246. The meter must be configured to 

enable the EGD protocol using CommunicatorPQA® software (this setting is made in 

the Advanced Network Options Setting screen - see the instructions for programming 

your meter). 

NOTE: Only one port at a time can be communicating EGD protocol.

EGD Data Specifications

This section contains detailed information about the EGD data packet being sent from 

a configured meter.

Packet Details

Exchange ID: 1

Configuration Signature: Major=1, Minor=0.

Status bit 0: 1=data is old or not ready to be consumed, 

0=data is ready to be consumed.

Status bit 1: 1=timestamp is not synchronized (no IRIG-B 

signal), 0=timestamp is synchronized (IRIG-B

signal received).

Production Data: Nexus® meter's 50 ms second readings, in 

primary. Total of 124 bytes. Power factor values

will be kept in their raw format. Requires Network
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card firmware v1.0.40 or higher and supporting

meter firmware.

GE EGD times tamp format: POSIX 1003.4 (1003.1b) timespec format, 4 byte

seconds (signed) followed by 4 byte nanoseconds,

signed seconds from 01/01/1970, max year is

2038.

Index  Name  Type  Note

1  Timestamp 8 bytes EIG's date/time for-
mat, see note below

2  Van 4 byte float Little-endian

3  Vbn  4 byte float Little-endian

4  Vcn  4 byte float  Little-endian

5  Vaux  4 byte float Little-endian

6  Ia 4 byte float Little-endian

7  Ib 4 byte float Little-endian

8  Ic 4 byte float Little-endian

9  In-measured 4 byte float Little-endian

10  Vab 4 byte float Little-endian

11  Vbc 4 byte float Little-endian

12  Vca 4 byte float Little-endian

13  VA-a  4 byte float Little-endian

14   VA-b 4 byte float Little-endian

15  VA-c 4 byte float Little-endian

16  VA 4 byte float Little-endian

17  VAR-a 4 byte float Little-endian

18  VAR-b 4 byte float Little-endian

19  VAR-c 4 byte float Little-endian

20  VAR 4 byte float Little-endian

21 W-a 4 byte float Little-endian

22  W-b 4 byte float Little-endian

23  W-c 4 byte float Little-endian

24  W 4 byte float Little-endian
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NOTE: See your meter’s Modbus Protocol & Register Map for complete detail on 

special data formats.

EIG's Time Stamp Format

Length: 4 Modbus Registers (8 bytes)

Each Modbus register contains two bytes. Each byte contains a binary number repre-

senting up to two digits representing a segment of date and time. The units for each 

byte are:

•  Century

•  Year

•  Month

•  Date

•  Hour

•  Minute

•  Second

•  10 Millisecond

Hour is in 24-hour format, i.e., 00H = 0 = 12 AM, 01H = 1 = 1 AM, …, 0BH= 11 = 11 

AM, 0CH = 12 =12 PM, 0DH = 13 = 1 PM, …, 17H = 23 = 11 PM.

Example:

25  Freq 4 byte float Little-endian

26  PF-a  4 byte float Little-endian

27   PF-b 4 byte float Little-endian

28  PF-c 4 byte float Little-endian

29  PF 4 byte float Little-endian

30 Van-Vaux Phase 
Angle 

4 byte float Little-endian

Index  Name  Type  Note
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Registers 00081 – 00084, On Time, might contain the following data:

June 25, 1999 9:19:48.86 AM

In bytes: 13 63 06 19 09 13 30 56 (lower order byte to higher order byte in UDP 

packet)

Century: 19 = 13H

Year: 99 = 63H

Month: 6 = 06H

Date: 25 = 19H

Hour: 9 = 09H

Minute: 19 = 13H

Second: 48 = 30H

Millisecond: 86 = 56H, 86*10=860ms

NOTE: Regarding bit-masking and limit on the values, you have to apply bit-masking 

to each byte and set a maximum valid value for date/time reconstruction.

•  Byte 1: And 63, Max=63

•  Byte 2: And 127, Max=99

•  Byte 3: And 15, Max=12

•  Byte 4: And 31, Max=31

•  Byte 5: And 31, Max=24

•  Byte 6: And 63, Max=59

•  Byte 7: And 63, Max=59

•  Byte 8: And 127, Max=99

NOTE: With the support of DSP/DSP 1 firmware, the meter can provide an advanced 

warning indicator prior to performing a RefCal (Reference Calibration). The indicator 
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flag is set in the MSB of the EIG time stamp's century byte during the final 3 seconds 

before a RefCal. End user software can use this indicator to avoid generating unneces-

sary error warnings.

Power Factor Format

0.000 to 3.999 (raw)

PF values in Nexus® meters have two types of representation, which can be defined 

by the user in the meter's device profile. The values can be in either EIG or Edison 

format.

EIG format

Quadrants                   Nexus® PF raw value                Interpreted PF value

1                                        0 to 1                                          0 to 1

4 >                                    1 to 2                                        <1 to 0

3 >                                    2 to 3                                        <0 to -1

2 >                                    3 to 4 >                                       -1 to 0

Edison format:

Quadrants                   Nexus® PF raw value                Interpreted PF value

1                                        0 to 1                                          0 to 1

4 >                                     1 to 2 >                                      -1 to 0

3 >                                     2 to 3 >                                      0 to 1

2 >                                     3 to 4 >                                      -1 to 0

Phase Angle Format: +/-180 degrees

EGD Data Protocol Data Unit (PDU) Descriptions

Data Production

The Data Production PDU supports the production of Global Ethernet Data. This 

packet contains the user data being produced and sent to the consuming node(s). 
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This message is unacknowledged, that is, it is transmitted by the producing node at 

the configured rate without waiting for a response from the consuming nodes. Receiv-

ing nodes that detect an encoding error in a received Data Production PDU will discard 

the PDU and take no action on its contents. The format of the Data Production PDU is

shown in the table below.

The table below contains additional information about these fields.

0 PDU Type (13) PVN=1 Request ID

4 Producer ID

8 Exchange ID

12  
Timestamp

 16

20 Status 
 

Reserved

24  Configuration Signature Reserved

28  Reserved

32 Production Data (up to 1400 bytes)

PDU field Size (Bytes) Description

PVN  1 Must be set to 1 for com-
patibility with older proto-
col versions.

Request ID  2 2 byte unsigned integer 
which is incremented each 
time a data sample is pro-
duced

Producer ID  4  Producer identifier

Exchange ID  4  Exchange identifier

Timestamp  8 The time stamp value 
should correspond as 
closely as practical to 
when the data sample was
captured
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EGD Data Verification

You can verify the data sent through EGD by polling the meter’s Modbus Registers 119 

to 175.

21.15: Troubleshooting the Network Connection

NOTE: If the connection fails, check the connection with the Master meter first. Once 

that connection is established, check the connections with the Slave devices. 

Suggested checkpoints are as follows:

Master Meter

1. Check cables.

2. Check IP Address, Subnet Mask and Default Gateway settings.

3. Check that the Address is 1.

4. Check that Modbus TCP was selected in Device Properties.

Slave Devices

1. Check all the above except #3.

2. Check that the Address is unique and not set to 1.

Production Status  2 Bit mask indicating the 
validity of the data sample 
produced:
Bit 0: Set if there is pro-
duction error or invalid
(old) data
Bit 1: Set if time stamp is 
not synchronized on pro-
ducer node

Configuration Signature  2 2 byte integer indicating 
relative version of the user 
data contained in the sam-
ple

Production Data  up to 1400 User data sample match-
ing configuration specified 
in Configuration Signature

PDU field Size (Bytes) Description
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3. Check that the Baud Rate settings for the Ethernet Gateway (Port 2) and the 

Devices are the same.

General

Try “Pinging” to a known good network device, such as another computer, to verify 

that your computer is connected properly to the network. 

1. From the Start menu, type Run, then cmd to open the command.exe window. 

2. Type ping and the IP address, for example, Ping 10.0.0.1

21.16: Total Web Solutions (TWS) MEGA PAGE

Displaying Data from Multiple INP100/102 Units on One Webpage

Using the TWS components WebExplorer and WebReacher, you can design a single 

webpage that displays data from multiple meters with INP100/102 Network Options. 

To accomplish this, you should have a basic understanding of TWS, explained earlier 

in this chapter.

You should modify the Java Script Code on the webpages in use and also make a 

change to the Internet Explorer browser setting, as detailed below.

1. Using the default files supplied by the INP100/102 Network Options as templates, 

the user should modify the Java Script code for all webpages using the sample 

below. This sample portion of Java Script code is for demonstration purpose only. 

You must insert your own code where needed.

<script language=Javascript>

// insert your own code here

// Define multiple XMLDOM Documents objects

var xmlDoc_Nexus_1 = new ActiveXObject(“MSXML.DomDocument”);

var xmlDoc_Nexus_2 = new ActiveXObject(“MSXML.DomDocument”);

xmlDoc_Nexus_1.async = true;

xmlDoc_Nexus_1.onreadystagechange = do_get_data_Nexus_1;
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xmlDoc_Nexus_2.async = true;

xmlDoc_Nexus_2.onreadystatechange = do_get_data_Nexus_2;

// function name ‘start_process’should be placed in webpage’s <body> tag

// such as ‘<body onLoad=”start_process()”>’

function start_process()

{

do_get_xml_Nexus_1();

do_get_xml_Nexus_2();

}

// Load each poll_data.xml file from different locations into an XMLDOM Document 

objects function

do_get_xml_Nexus_1()

{

xmlDoc_Nexus_1.load(“http://192.168.1.2/poll_data.xm l”);

}

function do_get_xml_Nexus_2()

{

xmlDoc_Nexus_2.load(“http://192.168.7.8/poll_data.xml”);

}

// functions to read, parse and display data from each XMLfile

function do_get_data_Nexus_1()

{

// insert your own code here

}
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function do_get_data_Nexus_2()

{

// insert your own code here

}

// insert your own code here</script>

2. To enable the MEGA Page on your browser, follow these steps:

a. From Internet Explorer, click Tools>Internet Options>Security.

b. Click the Custom Level button and scroll to the Miscellaneous section.

c. Click the Enable radio button next to “Access data sources across domains” and 

“Navigate subframes across different domains.”

d. Click OK twice to close the windows.

21.17: Nexus® 1450/1500+ Meter’s Advanced Features
              Setting

The Nexus® 1450 and 1500+ meters have some additional advanced features. This 

section contains instructions for additional programming of the Nexus® 1450/1500+ 

meter’s Main and optional Ethernet cards. The additional programming features are 

enabled or set in the Services tab. 
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21.17.1: Services Tab (Nexus® 1450/1500+ 
Meter)
 

The first tab in the Advanced Network Option Settings screen is Services. The screen 

shown on the previous page is for the Nexus® 1500+ meter. The Nexus® 1450 meter 

does not have all of the same options. The settings here let you enable/disable server 

and other network capabilities for each Network card independently - the Main Ether-

net card, which comes standard with the meter, and the optional second Ethernet 

card. This gives you the flexibility to program each card as best fits your application 

needs. These are the settings on the screen:

•  Web Server: select one of the following choices from the pull-down menu:

•  Card 1 Only to allow Internet access to the meter’s readings only through the 

Main Network card.

•  Card 2 Only to allow Internet access to the meter’s readings only through the 

optional Network card.
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•  Both Card 1 and 2 to enable Internet access to the meter’s readings for either 

Network card.

•  Disabled to not allow Internet access to the meter for either Network card.

•  Modbus TCP Server: select one of the following choices from the pull-down menu:

•  Card 1 Only to allow Modbus TCP communication only through the Main Network 

card.

•  Card 2 Only to allow Modbus TCP communication only through the optional Net-

work card

•  Both Card 1 and 2 to allow Modbus TCP communication through either Network 

card.

•  Disabled to not allow Modbus TCP communication for either Network card.

•  FTP Server (see 21.6.5: FTP Client, on page 21-19 for additional information): 

select one of the following choices from the pull-down menu:

•  Card 1 Only to allow only the Main Network card to support file transfer protocol.

•  Card 2 Only to allow only the optional Network card to support file transfer pro-

tocol.

•  Both Card 1 and 2 to allow both Network cards to support file transfer protocol.

•  Disabled to not allow either Network card to support file transfer protocol.

•  GE EGD Protocol (see 21.6.3: GE Protocol (EGD), on page 21-14 for additional 

information): select one of the following choices from the pull-down menu:

•  Card 1 Only to allow only the Main Network card to GE EGD protocol.

• Card 2 Only to allow only the optional Network card to support GE EGD protocol.

•  Auto to allow either Network card to support GE EGD protocol (see *NOTE on 

page 21-79).

•  Disabled to not allow either Network card to support GE EGD protocol.
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•  DNP LAN/WAN: select one of the following choices from the pull-down menu:

•  Card 1 Only to allow only the Main Network card to support DNP LAN/WAN com-

munication.

•  Card 2 Only to allow only the optional Network card to support DNP LAN/WAN 

communication.

•  Both Card 1 and 2 to allow both Network cards to support DNP LAN/WAN com-

munication.

•  Disabled to not allow either Network card to support DNP LAN/WAN 

communication.

       NOTE: If you are enabling DNP LAN/WAN communication for either (or both)

       Network cards, also use the DNP for LAN/WAN Card 1 and/or DNP for LAN/

       WAN Card 2 tabs to make additional settings. The settings are the same as

       described in 21.6.7: DNP for LAN/WAN, on page 21-24.

•  Modbus TCP Client (Master): select one of the following choices from the pull-down 

menu:

•  Card 1 Only to allow only the Main Network card to act as a Modbus 

master.

•  Card 2 Only to allow only the optional Network card to act as a Modbus master.

•  Auto to allow both Network cards to act as a Modbus master (see *NOTE on page 

21-79).

•  Disabled to not allow either Network card to act as a Modbus master.

•  SMTP Client (Email): select one of the following choices from the pull-down menu:

•  Card 1 Only to allow only the Main Network card to receive email.

•  Card 2 Only to allow only the optional Network card to receive email.

•  Auto to allow both Network cards to receive email (see *NOTE on page 21-79)

•  Disabled to not allow either Network card to receive email.
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•  Network Time Sync: select one of the following choices from the pull-down menu:

•  SNTP Card 1 to allow the Main Network card to use a Simple Network Time Pro-

tocol (SNTP) server for time synchronization.

•  SNTP Card 2 to allow the optional Network card to use an SNTP server for time 

synchronization.

•  SNTP Auto to allow either Network cards to use an SNTP server for time synchro-

nization (see *NOTE on page 21-79). 

        NOTE: The Nexus® 1500+ meter also has an SNTP tab that lets you set up the

        Simple Network Time Protocol Server if you are using it for Time synchroniza-

        tion: see 11.1.3: Time Settings, on page 11-7, for instructions.

•  IEEE 1588 PTP - This high-accuracy time synchronization method is available for 

the meter’s synchrophasor PMU feature. See 21.17.4: IEEE 1588 PTPv2 Master, 

on page 21-83.

•  Disabled to not allow either Network card to use an SNTP server for time syn-

chronization.

•  IEC 61850: select Enabled to enable the IEC 61850 server for one of the Network 

cards; select Disabled to disable the IEC 61850 server entirely.

•  IEC 61850 GOOSE: select Enabled to enable IEC 61850 GOOSE communication; 

select Disabled to disable it. For the Nexus® 1450 and 1500+ meters, you also 

need to make settings for GOOSE distributed fault recording - see 21.17.2: IEC 

61850 GOOSE Tab (Nexus® 1450 and 1500+ Meters), on page 21-80 for instruc-

tions.

•  SNMP: SNMP communication can be disabled; enabled for Network card #1; 

enabled for Network Card #2; or enabled for both Network cards. Select the option 

you want. 

NOTE: When you enable SNMP for one or both of the Network cards, you see addi-

tional selections that let you choose to support traps for the card supporting SNMP 

(see figure below). Traps are messages sent to the SNMP manager in response to 

specific conditions. When you enable SNMP you must also configure settings in the 
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SNMP tab. See 21.17.3: SNMP Tab, on page 21-81, for instructions.

.

•  IEEE 1588 PTP Master: to set the meter as a Master clock for IEEE 1588 Precision 

Time Protocol, click Enabled. (Network Card 2 is used for IEEE 1588 PTP communi-

cation.) Then configure settings in the IEEE 1588 tab - see 21.17.4: IEEE 1588 

PTPv2 Master, on page 21-83. Note that you cannot use IEEE 1588 PTP as a 

Master if you are using it as a time synchronization source for synchropha-

sors.

•  Synchrophasors (PMU): you can select either Card to use as a PMU for synchropha-

sors. Then configure settings in the Synchrophasor tab; this feature and its pro-

gramming are explained in detail in the Nexus® 1500+ meter’s User Manual’s 

Appendix E and Appendix F. Download the manual at https://www.electroind.com/

products/nexus-1500-power-quality-meter-with-phasor-measurement-unit/.

•  TCP Ports: use these fields to set up ports for Cards 1 and 2 for:

• Web server

• Modbus TCP server

• Control port

• Data port

•  TCP/UDP port: enter the port that will be used for IEC 61850 (TCP port) or GE EGD 

(UDP port) communication. 

•  Enter the outgoing mail port and the port name if SMTP is enabled.

*NOTE: The Auto setting will let the meter choose which Network card will be used 

for communication, based on the meter IP/gateway IP settings and available connec-

tions to the gateway device. This is most useful when used in a redundant network 

environment, so that the meter will automatically switch to the network card that has 

the connection to the gateway device if the other network card has lost the connec-

tion to its gateway device.

https://www.electroind.com/products/nexus-1500-power-quality-meter-with-phasor-measurement-unit/
https://www.electroind.com/products/nexus-1500-power-quality-meter-with-phasor-measurement-unit/
https://www.electroind.com/products/nexus-1500-power-quality-meter-with-phasor-measurement-unit/
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21.17.2: IEC 61850 GOOSE Tab (Nexus® 1450 
                 and 1500+ Meters)

Use the IEC 61850 GOOSE tab to set waveform capture based on Boolean data 

embedded in a received GOOSE messages sent from another device in the IEC 61850 

network. The Boolean data the meter receives will be related to limits/alarms or digi-

tal inputs state. The meter has memory to accept sixteen pieces of Boolean data from 

received GOOSE messages. The specifics of the Boolean data in specific GOOSE 

messages is set up in the IEC 61850 configuration file (.CID). Refer to the IEC 61850 

Application Guide for instructions on setting this up*.

•  Check the boxes (1-16) which contain the Boolean data that you want to trigger a 

waveform capture. Refer to Appendix C in the meter’s User Manual and the IEC 

61850 Application Guide for your meter, for more details*.

* Nexus® 1450 meter product literature can be found here:

https://www.electroind.com/products/nexus-1450-cyber-secure-power-quality-

meter-with-multiport-communication/

   Nexus® 1500+ meter product literature can be found here:

https://www.electroind.com/products/nexus-1450-cyber-secure-power-quality-meter-with-multiport-communication/

https://www.electroind.com/products/nexus-1450-cyber-secure-power-quality-meter-with-multiport-communication/

https://www.electroind.com/products/nexus-1450-cyber-secure-power-quality-meter-with-multiport-communication/

https://www.electroind.com/products/nexus-1450-cyber-secure-power-quality-meter-with-multiport-communication/

https://www.electroind.com/products/nexus-1450-cyber-secure-power-quality-meter-with-multiport-communication/

https://www.electroind.com/products/nexus-1450-cyber-secure-power-quality-meter-with-multiport-communication/
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https://www.electroind.com/products/nexus-1500-power-quality-meter-with-pha-

sor-measurement-unit/

21.17.3: SNMP Tab

If you selected sending traps in SNMP in the Services tab, click the SNMP tab to make 

the settings for the trap messages.

•  You can enter the IP address of up to eight SNMP manager devices in the Traps 

Managers IP Addresses field. These IP addresses will receive any traps generated 

by the meter. If you are not using all eight addresses, you can leave the unused 

ones as 0.0.0.0. Note that the meter will not accept Broadcast IP addresses that 

are sent to multiple devices in one packet, such as 255.255.255.255 or 12.1.1.255.

•  You can select the conditions that will generate trap messages in the Generate 

Traps for field. Click in the box to the left of any of the listed conditions to generate 

traps that will be sent to the SNMP managers when the condition occurs. For exam-

ple, if you select Limit status Changes, anytime a limit is triggered or goes back 

https://www.electroind.com/products/nexus-1500-power-quality-meter-with-phasor-measurement-unit/
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within limit, a trap will be generated and sent to the devices at the IP addresses 

you entered.

•  Enter the Community Name for Agent and Traps. The default name for both fields 

is: public.

•  The Agent Community name provides security by ensuring that the SNMP man-

ager will only read (the manager’s Read Community name)/write (the manager’s 

Write Community name) from/to a managed object if it matches the Agent com-

munity name. 

•  The Traps Community name provides security by ensuring that only traps that 

match the Traps Community name of the Agent are received by the SNMP man-

ager. 

NOTE: Appendix D in the Nexus® 1500+ Meter Installation and Operation Manual 

contains detailed information on SNMP for the Nexus® 1500+ meter.
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21.17.4: IEEE 1588 PTPv2 Master

If you enabled the IEEE 1588 PTP Master, click the IEEE 1588 PTP tab to make the 

settings for the Master clock. Note that you cannot use IEEE 1588 PTP as a Mas-

ter if you are using it as a time synchronization source for synchrophasors. In 

that case, you would set the time synchronization source and then make settings in 

the Slave Settings tab. Detailed instructions for PMU settings are given in Appendix F 

of the meter’s User Manual (download the manual at https://www.electroind.com/

products/nexus-1500-power-quality-meter-with-phasor-measurement-unit/: click 

Downloads>Tech Documents>User Manual from the right side of the webpage). 

The settings explained here are for using the meter as a Master clock for other 

devices.

The settings are:

•  Announce Method Send Rate: choose from One per Second, Two per Second, Four 
per Second, Eight per Second, or Sixteen Per Second.

•  Sync Message Send Rate: choose from Sixteen per second, Eight per second, Four 
per Second, Two per second, One every second, or One every two seconds.

https://www.electroind.com/products/nexus-1500-power-quality-meter-with-phasor-measurement-unit/
https://www.electroind.com/products/nexus-1500-power-quality-meter-with-phasor-measurement-unit/
https://www.electroind.com/products/nexus-1500-power-quality-meter-with-phasor-measurement-unit/
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•  Minimum Delay Request Interval: choose from Every sync message, Every two 
Sync messages, Every four Sync messages, Every eight Sync messages, Every six-
teen Sync messages, or Every thirty-two Sync messages.

•  Enable Follow-up Messages: Yes or No.

•  UTC Vs TAI Offset: the amount of offset (in seconds) between the UTC and TAI 
clocks. 

•  Port ID: the meter port used for Master clock communication.

•  Priority Number 1: the number of the device that will get communication first.

•  Clock Variance: this number defines the stability of the clock.

•  Domain Number: this number identifies a logical grouping of clocks that are syn-
chronized to each other using the protocol, but that are not necessarily synchro-
nized to clocks in another domain.

•  Priority Number 2: the number of the device that will get communication second.
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22: DNP3 Configuration
A Nexus® 1252/1262/1272/1450/1500/1500+ meter can measure more than 3000 

DNP Static Points, but not all points can be polled at the same time. In order for the 

meter to have the appropriate data, you should customize the DNP Point Map via 

CommunicatorPQA® software.

Up to 250 points of Event Data can be created in the Nexus® meter. Refer to the 

DNP3 Level 2 Protocol Assignments for Nexus® 1252, 1262, 1272,1450, 1500,1500+ 

Meters manual for more details. Refer to chapters 11, 12, 13, and 27 of this manual 

for details on configuring DNP3 for Nexus® meters. See chapters 26 and 28 for 

instructions on configuring DNP for the Shark® 270 and 250 meters, respectively.

22.1: Opening the DNP Settings Screen

 From the meter’s Device Profile, click General Settings> DNP Custom Classes Map > 

DNP Level 2. You will see the DNP Custom Mapping screen. Click on the tabs at the 

top of the screen to move between the following Settings screens.
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•   The Clear All Button clears all assigned items on all the tabs.

•   The Clear Button clears only the items on the current tab view.

22.2: Binary Input (Object 1)

A Nexus® meter can use up to 64 Binary Input Points. Values available for Binary 

Input use can be found in the DNP Object Mapping. Only Class 0 is used when polling 

Binary Input (Object 1) Data. Class 1, 2 or 3 is used when polling Binary Input 

Change (Object 2) Data.

•   Line, Point, Description setting:

a. Double-click on the box under Description to Add, Delete or Modify DNP 

Points to the screen above. 

b. From the pull-down menu, choose a Type (of reading) and a Channel and 

click OK. 

c. The corresponding numbers for the selected reading and channel will 

appear in the Line and Point columns. 
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•   Numbers for a Binary Input value can also be found in the DNP Object Mapping 

(Chapter 7 of the DNP V3.00 Level 2 Protocol Assignments for Nexus® 1252, 

1262, 1272, 1450, 1500, 1500+ Meters manual). 

•   For example, 1 Cycle High Speed Input Delta and Current State has Line 

Number 16 and Point Number 0 in the DNP Object Mapping. Write those 

numbers into the Object 1 – Binary Input tab. When the Line and Point 

Numbers are written, the software fills in the description on the screen. 

Repeat for each desired Binary Input Point. 

•   Object 2 setting: any DNP Static Point can be configured to create a DNP Event 

Point. Class Assignments on the Object 2 screen are used to configure Binary Input 

Change Event Points. In order to create Event Data, Object 2 Points must be 

assigned to Class 1, 2 or 3. Each point can have a different Class Assignment.

•   Click OK to return to the Device Profile screen; click Update Device to update the 

meter. The Nexus® meter will scan the programmed points every second.
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22.3: Analog Input (Object 30)

A Nexus® meter can use up to 64 Analog Input points. Values available for Analog 

Input use can be found in the DNP Object Mapping. Only Class 0 is used when polling 

Analog Input (Object 30) Data. Class 1, 2 or 3 is used when polling Analog Change 

Event (Object 32) Data.

•   Line, Point, Description settings:

a. Double-click on the box under Description to Add, Delete or Modify DNP 

Points to the screen above. 

b. From the pull-down menu, choose a Type (of reading) and a Channel and 

click OK. 

c. The corresponding numbers for the selected reading and channel will 

appear in the Line and Point columns. 
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•   Line and Point Numbers can also be found in the DNP Object Mapping (Chapter 

7 of the DNP V3.00 Level 2 Protocol Assignments for Nexus® 1252, 1262, 1272, 

1450, 1500, 1500+ Meters manual). 

• For example, One Second Phase A-N Voltage is EIG Line Number 34 and 

Point Number 0 in the DNP Object Mapping. Write these numbers into the 

Object 30 – Analog Input tab. When the Line and Point Numbers are writ-

ten, the software will fill in the description. Repeat for each desired Ana-

log Input Point. 

•   Deadband (), Object 32: 

•   Any DNP Static Point can be configured to create DNP Event Points. Deadband 

and Class Assignments on the Object 32 screen are used to configure Analog 

Change Event Points. In order to create Event Data, Object 32 Points must be 

assigned to Class 1, 2 or 3. Each point can have a different Class assignment. 

Deadband () defines the boundary value for that point. 

• For example, suppose One Second Phase to Neutral Volts AN is pro-

grammed and the Voltage Full Scale is 120.00V for the meter. Entering 10 

for Deadband will define the boundary value of 12V (10 of 120V). Every 

second, new Static Data is scanned for One Second Phase to Neutral Volts 

AN. If the new data is different from the previous standard value by the 

boundary value, an Analog Change Event will be created.

For example, if the previous standard value is 110 and new data is lower 

than 98V or higher than 122V, a new Analog Change Event Point will be 

created. The new value then becomes the previous standard value for 

future scans.

•   Analog Input Points have various Full Scales values due to different data types 

(Volts, Amps, Watts, etc.). These Full Scale values are used for Exception Polling in 

DNP. Some Full Scale values are programmable by users and others have fixed 

numbers. See the chart of Full Scale Values on page 22-7.
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•   To use the custom-scaling feature, click the checkbox next to Use Custom 16-Bit 

Scaling. The Custom Scaling button will display - click this button to see the screen 

shown below.

     Use this screen to program the secondary scale that will be used to maximize the

     16-bit resolution precisely around the parameters you choose:

a. Enter values (in Primary) in the Maximum entry fields next to the readings 

you want to scale.

b. Click OK to save your entry and return to the previous screen; click Cancel 

to close the screen without making any changes.

    NOTE: Depending on the age of your meter, you may not have the custom-scaling

    option.
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•   Full Scale values are 4-byte integer numbers. The units are as follows:

•   For example, in order to find out if there is new log data, use a Log Index Num-

ber. One of the Log Index Numbers (Last Index) will increase when a new log is 

created. In Object 30, Program Last Log Record Index:

Waveform Log (Line 499, Point 7). Input Deadband 1.00 and assign a Class. 

The exception data will be created when the Index Number increases by one.

Analog Input Full Scale Unit

I A, B, C, Nc Programmable 1/65536 Amps

I Nm Programmable 1/65536 Amps

V AN, BN, CN  Programmable 1/65536 Volts

V AB, BC, CA  Programmable 1/65536 Volts

V Aux  Programmable 1/65536 Volts

Power Phase  Programmable  1/65536 Watts

Power Total  Programmable  1/65536 Watts

Frequency  Programmable 1/65536 Hz

Power Factor  4000 0.001 PF

Angles  18000 0.001 PF

Percent  10000 0.01

K-Factor  500 0.01

TOU Ratio  N/A  N/A

Temperature  10000 0.01

Flicker  65536 0.0001

In Interval  1000  1000

Day of Week  6 1

Sequence  1 1

Status  100  1

Avg Select  100  1

Delay  100  1

Log Index  100  1

Countdown  100  1



     Doc#    E107707                                              22 - 8

22: DNP3 Configuration

•   Click OK to return to the Device Profile screen; click Update Device to update the 

meter. The Nexus® meter will scan the programmed points every second (except 

for Tenth Second Readings: Tenth Second Readings (Line 18 to 32) are scanned as 

soon as the meter detects a change (as often as every 50 milliseconds).

22.4: Binary Counter (Object 20)

A Nexus® meter can use up to 32 Binary Counter Points. Values available for Binary 

Counter use can be found in the DNP Object Mapping. Only Class 0 is used when poll-

ing Binary Counter (Object 20) Data and Frozen Counter (Object 21) Data. Class 1, 2 

or 3 is used when polling Counter Event (Object 22) Data and Frozen Counter Event 

(Object 23) Data.

•   Line, Point, Description settings:

a. Double-click on the box under Description to Add, Delete or Modify DNP 

Points to the screen above. 

b. From the pull-down menu, choose a Type (of reading) and a Channel and 

click OK. 



     Doc#    E107707                                              22 - 9

22: DNP3 Configuration

c. The corresponding numbers for the selected reading and channel will 

appear in the Line and Point columns. 

•   Line and Point Numbers can also be found in the DNP Object Mapping (Chapter 

7 of the DNP V3.00 Level 2 Protocol Assignments User Manual for Nexus® 1252, 

1262, 1272, 1450, 1500, 1500+ Meters). 

• For example, VA hour has Line Number 133 and Point Number 0 in the 

DNP Object Mapping. Write those numbers into the Object 20- Binary 

Counter tab. When the Line and Point Numbers are written, the software 

fills in the description on the screen. Repeat for each desired Binary 

Counter Point. 

•   Scaling:

•   A Nexus® meter can measure its Binary Counter value using up to a 16-digit 

number (0 to 9,999,999,999,999,999). DNP Binary Counter Points use up to 32 

bits. That means that the range is 0 to 4,294,967,295 (0x0FFFFFFFF). This max-

imum number is only a 10-digit number. In order to deal with a 16-digit number, 

Scaling is necessary.

•   Scaling is used to select a unit in powers of 10: 1 = x10, 2 = x100 and so on. 

The Scaling value can be 0 to 15.

• For example, if the value inside the meter is 3,000,000 and a Scaling 

value of 2 (x100) is used, the Binary Counter value will be reported as 

30000. The actual value is 30000x100 = 3,000,000.

•   Delta, Object 22:

•   Any DNP Static Point can be configured to create DNP Event Points. Delta and 

Class Assignments on the Object 22 screen are used to configure Counter 

Change Event Points. In order to create Event Data, Object 22 must be assigned 

to Class 1, 2 or 3. Each point can have a different Class Assignment.The Delta 

value defines the boundary value for that point.

• For example, suppose VA hour is programmed and the Delta is 5. That 

represents 5 increments from the returned 32-bit Binary Counter value. 

Every second, new Static Data is scanned for VA hour. If new data is dif-

ferent from the previous standard value by the Delta value, the Counter 

Change Event Data will be created.
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That means, if the previous standard polled value is 50000 VA hour and if 

the VA hour reading increases to 50005, it will create a Counter Change 

Event Point for VA hour and 50005 VA hour will become the previous 

standard value for the next Static Data.

•   The Scaling setting for a point also applies to the Delta value. If Delta is 5 and 

Scaling is 2, this indicates a 500-count change in the internal representation.

•   Object 23: Frozen Analog Event (Object 23) will be created if Object 23 is assigned 

to Class 1, 2 or 3.

•   Click OK to return to the Device Profile screen; click Update Device to update the 

meter. The Nexus® meter will scan the programmed points every second.
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22.5: Binary Output (Object 10)

Class 0 is used when polling Binary Output (Object 10) Data. External Relay Output 

Modules can be attached to the Nexus® 1252/1262/1272/1450/1500/1500+ meter. 

Up to 4 Relay Output Modules can be attached and each Relay Module has 4 Relay 

Outputs.

•   To enable control of a Relay by DNP, check its box. If unchecked, the relay will not 

be controlled by DNP. 

•   The Master in DNP protocol can control 16 relays. In order to do that, each relay 

box should be checked and the Nexus® meter should be updated with this profile.

•   Check the box for the Reset Enable you want to control through DNP. The Master 

not only controls relays but also can do various resets. 

•   Relay Status and Reset Status can be polled using Object 10. For Controlling 

Relays and performing Resets, Object 12 is used. Each box should be checked in 

order for the Master to do the reset.
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•   Example 1 - The Master can control Relay 1 by sending this message (Meter 

Address 1, Master Address 10):

           05 64

           18 C4 01 00 0A 00 6C 1A

           C0

           C0 05

           06

           01 17 01

           00 03 01 01 00 00 00 00 00 3B EF 00 00 00 FF FF

•   Example 2 – The Master can control Relay 2 by sending this message:

          05 64

          18 C4 01 00

          0A 00 6C 1A

          C0

          C1 05

          0C

          01 17 01

          01 03 01 01 00 00 00 00 00 E2 5F 00 00 00 FF FF

•   Example 3 – The Master can do a Log Reset by sending this message:

          05 04

          18 C4 01 00 0A 00 6C 1A

          C0

          C2 05

          0C
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          01 17 01

          10 03 01 01 00 00 00 00 00 C5 1B 00 00 00 FF FF

•   Example 4 – The Master can do an Energy Reset by sending this message:

          05 04

          18 C4 01 00 0A 00 6C 1A

          C0

          C3 05

          0C

          01 17 01

          13 03 01 01 00 00 00 00 00 E7 5B 00 00 00 FF FF

NOTE: The preceding examples use Function 5 (Direct Operate Relay) and Qualifier 

0x17.

•   The Point Numbers for Relays and Resets are as follows:

•   Points Assignment

•0 Relay 1

•1 Relay 2

•2 Relay 3

•3 Relay 4

•4 Relay 5

•5 Relay 6

•6 Relay 7

•7 Relay 8

•8 Relay 9
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•9 Relay 10

•10 Relay 11

•11 Relay 12

•12 Relay 13

•13 Relay 14

•14 Relay 15

•15 Relay 16

•16 Log Reset

•17 Reset of Maximum Thermal Average

•18 Reset of Minimum Thermal Average

•19 Energy Reset

•20 Reset Time of Use Current Frozen Register and Current Month

•21 Manual Waveform Capture

•22 Reset Internal Input Accumulations and Aggregations

•23 Reset Unit to Boot Mode – Default Communication Settings

                NOTE: Point 23 is a temporary switch to Boot in Modbus Protocol. This

                switch times out.
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22.6: Global Values

Each Object can be polled by Variation 0. 

•   Using this tab, you can assign a default variation to be returned for each Object.

a. Click on the Object on the left side of the screen.

b. Click on a Variation on the right side of the screen.

•   Click OK to return to the Device Profile screen; click Update Device to update the 

meter. The Nexus® meter will scan the programmed points every second.
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22.7: DNP Settings

With this tab, you can enable DNP Time Synchronization. 

•   The Time Interval is the amount of time the device waits before requesting Time 

Synchronization from the Master (using IINI-4). The Time Interval is configurable 

from 1 minute to 1 day in 1-minute intervals. The initial factory setting is Not 

Enabled.

•   Class 0 Poll Counter Object allows you to select Binary Counter (Obj. 20) or Frozen 

Counter (Obj. 21) for a Class 0 Poll.

•   DNP Auto Freeze Schedule enables and sets the interval for a Class 0 Poll.

•   For the Nexus® 1500+ meter, there is an additional section of settings for the 

Unsolicited Response feature. See the example screen on the next page.
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Unsolicited Response is a DNP feature in which the meter sends an unrequested 

message to the master device when certain specified events occur. This setting lets 

you enable and configure unsolicited response messages for the Nexus® 1500+ 

meter. Refer to the DNP V3.00 Level 2 Protocol Assignments User Manual for Nexus® 

1252, 1262, 1272, 1450, 1500, 1500+ Meters for additional details on Unsolicited 

Response. 

Note that unsolicited response can only take place through a serial port connection. 

The settings for unsolicited response are as follows:

• Enable - check the box to enable unsolicited response - un-check it to disable

unsolicited response.

• Disable on startup - this setting disables (Yes) or enables (No) the sending of a null

(empty) message to the master device, on meter startup.



     Doc#    E107707                                              22 - 18

22: DNP3 Configuration

•   Destination Address - enter the destination address of the master device to which 

the unsolicited response will be sent. The allowable range is from 1 to 65519.

•   Confirmation Timeout - enter the amount of time that the meter will wait for a con-

firmation back from the master device. This is also the amount of time between 

transmissions of unconfirmed unsolicited responses. The range of allowable values 

is from 1 second to 60 seconds.

•   Number of Retries - enter the number of unsolicited retries that the meter will 

transmit in each unsolicited response series, if it does not receive confirmation back 

from the master device. The configured value includes identical and regenerated 

retry messages. The allowable values are from 1 to 16. Selecting 16 causes contin-

ual retries, until there is a response.

•   Enable Unsolicited Response For - the meter can monitor all data points from 3 

DNP3 Classes, which can then be included inside unsolicited response messages. 

Check the box next to Class 1, Class 2 and/or Class3 to include data from those 

classes; uncheck the boxes to not send data from those classes in unsolicited 

response messages. 

•   Click OK to return to the Device Profile screen; click Update Device to update the 

meter.
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23: EN 50160 / IEC 61000-4-30 Power Quality
       Analysis

23.1: Overview 

EN 50160 is the European Standard approved by CENELEC (European Committee for 

Electrotechnical Standardization). This standard and other standards, such as IEC 

61000-4-30, define the properties of the power supply as delivered to the user in nor-

mal operating conditions. The properties are defined in terms of continuity of supply 

and characteristics of voltage (symmetry, frequency, magnitude, waveform, Flicker). 

These standards define the main characteristics of the voltage at the customer's 

supply terminals in public voltage electricity distribution systems. They do not 

describe the typical situation for a customer connected to a public supply network. 

The term "Flicker," for example, is defined by EN50160/IEC61000-4-30 and refers to 

the human eye's perception of luminance differences in light sources. Flicker is 

discussed in the Rapid Voltage Changes section.

In recent years, power quality has become a very important issue. Competitive 

markets require constant attention to customer satisfaction. Increasing use of 

non-linear and pulsed loads can cause mains interference. And, many electronically 

controlled devices that we use to "run" our countries, businesses, and homes require 

quality supply voltage. For these reasons, it is important to collect reliable power 

quality data for electricity suppliers and customers alike. 
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Following are the Power Quality measurements that comprise analysis as per the       

EN 50160/IEC 61000-4-30 standards (depending on the meter model, the measure-

ment label and/or available measurements may differ, as shown in the table below):

Nexus® 12** Meters Nexus® 1500 Meter Nexus® 1500+ Meter

Frequency Fluctuations Power Frequency Power Frequency

Low Speed Voltage Fluctuations Supply Voltage Variations Supply Voltage Variations

Fast Voltage Fluctuations Rapid Voltage Changes Rapid Voltage Changes

Flicker Flicker PLT Flicker PLT

Flicker PST

Supply Voltage Unbalance Supply Voltage Unbalance Supply Voltage Unbalance

Harmonic Magnitude Harmonic Voltage THD Harmonic Voltage and THD

THD

Magnitude of Supply Voltage

Voltage Dip Supply Voltage Dips Supply Voltage Dips

Voltage Swells

Short Interruption Supply Voltage Short Interruption of Supply Volt-
age

Short Interruption of Supply Volt-
age

Long Interruption Supply Voltage Long Interruption of Supply Volt-
age

Long Interruption of Supply Volt-
age

Mains Signaling Voltage on the 
Supply Voltage

Mains Signaling Voltage on the 
Supply Voltage

Temporary Power Frequency 
Overvoltage Between Live 
Conductors and Earth

Temporary Power Frequency Over-
voltage Between Live Conductors 
and Earth
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23.2: Issues Addressed by the Power Quality Compliance Standards

The following sections describe the Power Quality standards for compliance.

23.2.1: Mains Interference

The increased use of power electronics and other devices puts a strain on the 

network. Because of this, electricity suppliers need detailed data on the quality of 

their network. New, advanced measuring and testing systems are used to record volt-

age quality at various points, convert the data and add it to a central database. By 

correlating the applicable fluctuations and studying the time of events, the cause for a 

disturbance can be confined and ultimately eliminated.

For a number of reasons, power quality has become an important issue:

1. Mains interference feedback can be caused by increased use of non-linear and 

pulsed loads.

2. An ever-widening number of electronic devices are very sensitive to mains pollu-

tion. A certain quality of supply voltage is required for them to operate properly.
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3. With deregulation a global reality, a good relationship between supplier and 

customer is essential. Permanent monitoring of voltage quality in networks is one 

key to maintaining quality control, which helps to sustain relationships.

23.2.2: Power Quality and Network Disturbances

The quality of an electric power supply is determined by examining two aspects of 

Power Quality:

1. Reliability of the energy supply 

2. Quality of the voltage (similarity of the waveform of the supplied voltage to an      

ideal sinusoidal voltage)

Divergences from the ideal come in many shapes and sizes. In the next sections, we 

will discuss Network disturbances in detail.

23.2.2.1: Voltage Dips

The Voltage Level determines the Voltage Quality. When the voltage drops to a low 

level, a voltage dip occurs. If the voltage drops to zero, a power failure occurs. The 

depth and duration of the dip determine the severity. 

A dip is a sudden drop of the voltage to a level below 90 of the nominal voltage, fol-

lowed by an increase to a level above 90 within a period of 10ms to 60s. Most dips in 

medium or high voltage networks have durations of less than 0.2s. 

Short dips can cause serious problems, such as failure of equipment and machine 

control systems. Short dips can also cause sudden torque change in motors, which 

causes damage. 

Faults in the insulation of medium and high voltage networks are the primary cause of 

most dips. Other possible causes of dips are branches of trees in contact with lines, 

ice, frost, snow and thunderstorms. During most dips, all customers in the network 

are affected to the same degree. 

Customers themselves can cause many dips. The start-up of big machines or capaci-

tor banks can cause voltage dips, and short circuits can cause losses when there is 

insufficient short-circuit capacity.
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23.2.2.2: Flicker 

The term Flicker, defined in IEC 61000-4-15, applies to luminescent variations of light 

sources as perceived by the human eye. Since each human eye is different, this 

perception varies with each person. Flicker is the sensation that is experienced by the 

human visual system when it is subjected to changes occurring in the illumination 

intensity of light sources. The primary effects of Flicker are headaches, irritability and 

sometimes epilepsy. Flicker can be caused by voltage variations which are caused by 

variable loads, such as arc furnaces, laser printers and microwave ovens.

IEC 61000-4-15, IEC61000-4-30 and former IEC 868 describe the methods used to 

determine Flicker severity. This phenomenon is strictly related to the sensitivity and 

the reaction of individuals. To determine the standard, Flicker measurement was 

performed through observation of groups of people, and statistical operations were 

applied to the observations.

 Flicker is computed using the three phase-to-neutral voltages in WYE configurations 

and the three phase-to-phase voltages when in DELTA. Evaluation occurs in the fol-

lowing forms: Instantaneous, Short Term or Long Term. 

The range of analysis is from 0.01 to 33Hz. Sensitivity of the human brain correlates 

with the frequency of the sensation. To make sure that most people do not perceive 

flickers, the Plt (Long Term Flicker) value must be below 1.00. This value is obtained 

with the following equation:

 

Where Psti (i = 1, 2, 3, …) are consecutive readings of the short-term severity Pst.
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23.2.2.3: Transients 

A transient over-voltage is a short duration oscillatory or non-oscillatory over-voltage, 

usually highly damped and with a duration of a few milliseconds or less. Transients are 

generally incidental and are considered single short term events. Switching capacitor 

banks on, switching inductive loads off, and lightning that affects power lines are the 

primary causes of transients.  

However, regular transients can occur when loads controlled by power electronics are 

switched on and off. Modern switching technology can be applied to minimize regular 

transients.

23.2.2.4: Harmonics 

Harmonic voltage is defined as a sinusoidal voltage with a frequency equal to an inte-

ger multiple of the fundamental frequency of the supply voltage. Harmonic voltages 

can be evaluated:

•   Individually by their relative amplitude (Uh) related to the fundamental voltage 

(U1), where h is the order of the harmonic.

•   Globally, for example by the total harmonic distortion factor (THD), which is the 

sum of all harmonics (all frequency contents), calculated using the following equa-

tion:

Supply voltage harmonics are usually caused by customers' non-linear loads con-

nected to all voltage levels of the supply system. Harmonic currents flowing through 

the system impedance create harmonic voltages.  

In office and residential buildings, harmonics are usually caused by energy-efficient 

lamps, TVs and PCs. These devices in large numbers can produce high harmonic 

content in low voltage networks. Fast Fourier transformation is used to measure 

harmonics. This method generates a spectrum of a signal yielding a frequency-
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domain representation. EN 50160 defines the values for harmonics and THD in per-

centages of the nominal voltage Uh.

23.2.2.5: Frequency 

The supply voltage nominal frequency (Ufn) is 50Hz or 60Hz. Under normal operating 

conditions, the 10-second average value of the fundamental frequency in a 

distributive mains must be in the following ranges: 

Ufn  +/- 1 For mains with connection to an interlinking mains* during 95

of one week.

Ufn   + 4 / -6  For mains with connection to an interlinking mains* during 

100 of one week.

Ufn   +/- 2  For stand-alone mains** during 95 of one week.

Ufn   +/- 15  For stand-alone mains** during 100 of one week.

In today's interconnected grids, frequency fluctuations are very small.

* Interlinking mains are also known as synchronous. They are large, inter-connected 

power grids.

** Stand-alone mains are also known as unsynchronous. They are independent power 

systems, unconnected to the main electrical grid.

23.3: Permanent Monitoring Provides Valuable Data

The types of data provided by permanent monitoring are listed below. This data is 

invaluable to the successful operation of electricity suppliers.

•   Types and levels of disturbances in the network

•   Overview and detailed analysis of voltage quality in the network

•   Time-stamped recordings of disturbances

Through analysis of the data provided, causes of a disturbance can be determined, 

events clarified and associated problems or trends discovered. Preventive mainte-

nance may also be facilitated by the data. Indicators may predict disturbances early 

enough to avoid the event altogether.
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23.4: Power Quality Monitoring 

EN 50160 has standardized the voltage quality of electricity supplied by public distri-

bution systems since 1994. Amendments have been added to the standard to reflect 

changes in technology. Other standards, such as IEC 61000-3-6 and 61000-3-7, set 

the standard for distortions across medium and high voltage networks.  

With this standard in hand, customers have new rights regarding the quality of 

supply. For example, if the voltage quality at the point of common coupling does not 

conform to the standard, according to EN 50160 the customer has the right to 

complain. As a result, there has been a shift towards partnership between the elec-

tricity supplier and customer. The quality of the electricity should be constantly moni-

tored at the point of common coupling and throughout the network to the benefit of 

both partners. And, since disturbances caused by one customer can affect others indi-

rectly linked to them in the network, the continuous monitoring will benefit all cus-

tomers.  

23.5: EN 50160/IEC 61000-4-30 Meter Setting and Report Viewing

You set up your meter for use with the Power Quality Compliance Standards through 

the meter’s Device Profile - see section 11.3.6 (Nexus® 1500/1500+ meter), 12.3.4 

(Nexus® 1262/1272 meter), and 13.3.4 (Nexus® 1252 Meter) for instructions.

•   Through the Flicker Polling screen - see Section 5.4.3 for instructions

•   Through the Flicker log - see Section 19.4.13 for instructions on viewing and 

graphing the Flicker data

•   Through the EN50160 report - see Section 19.4.15 for instructions on viewing the 

data and printing an EN 50160 report. A sample copy of the report follows. Note 

that the example report is for Nexus® 1500+ meter - the EN 51060 report gener-

ated from a Nexus® 1252/1262/1272 meter or a Nexus® 1500 meter with earlier 

firmware, will look slightly different.
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EN50160 Individual Report Summary

Power Frequency (x.1) Fail

Supply Voltage Variations (x.3.x) Fail

Rapid Voltage Changes (x.4.1) Fail

Flicker PLT (x.4.2) Fail

Flicker PST Fail

Supply Voltage Dips (x.5) Pass

Voltage Swells Pass

Short Interruption of Supply Voltage (x.6) Fail

Long Interruption of Supply Voltage (x.7) Fail

Temporary power frequency overvoltage (x.8) Pass

Supply Voltage Unbalance (x.10) Fail

Harmonic Voltage (x.11) Pass

Mains Signaling Voltage (x.13) Pass

128Mb_IP194 Weekly report for

Mon, 06 Oct 2014 16:47:46 -0500 to Sat, 

11 Oct 2014 23:59:59 -0500

Meter Name

113599432Serial

60HzNominal Frequency

120VNominal Voltage (Un) 1/18
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EN50160 (2010) Report Details

Device Info
Meter Type Nexus 1500

Meter Name 128Mb_IP194     

Serial Number 0000000113599432

Firmware    4.6027

Profile CRC 0x9E5B

Profile Date 2014-07-21 15:10:56

Hookup Wye

Supply Type Medium Voltage

Synchronous Connection No

Nominal Voltage 120V

Nominal Frequency 60Hz

Report  Info
Report Version S2010-1

Standard Version EN50160 (2010)

Report Type Weekly

First Day of Week Sun

Time Range 10/6/2014 to 10/12/2014

Report Errors
Date Range Unknown date range type: Weekly

128Mb_IP194 Weekly report for

Mon, 06 Oct 2014 16:47:46 -0500 to Sat, 

11 Oct 2014 23:59:59 -0500

Meter Name

113599432Serial

60HzNominal Frequency

120VNominal Voltage (Un) 2/18
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Section x.1 Power Frequency (Not Synchronized) Fail
Under normal operating conditions for a non-synchronized system, the mean value of the fundamental 

frequency measured over 10 seconds shall be within ±1.0% of the nominal frequency (60Hz) for 99.0% of 

the year, and within +4.0%/-6.0% for 100.0% of the year.  This report gives the results over the course of 

the specified period.

Results Summary
Zone Required Ac tual Resul t
±1.0% 99.0% 76.35% Failed

+4.0%/-6.0% 100.0% 76.35% Failed

128Mb_IP194 Weekly report for

Mon, 06 Oct 2014 16:47:46 -0500 to Sat, 

11 Oct 2014 23:59:59 -0500

Meter Name

113599432Serial

60HzNominal Frequency

120VNominal Voltage (Un) 3/18
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Section x.3.x Supply Voltage Variations Fail
Supply voltage shall vary no more than ±10.0% of Un for 99.0% of the week.  The voltage must be 

within +15.0%/-10.0% of Un for 100.0% of the time.  Situations like those arising from faults or voltage 

interruptions, the circumstances of which are beyond the reasonable control of the parties, are excluded.

Results Summary
Zone Required Volts  A Volts  B Volts  C

±10.0% 99.0% 76.04% 76.04% 76.04%

+15.0%/-10.0% 100.0% 76.04% 76.04% 76.04%

128Mb_IP194 Weekly report for

Mon, 06 Oct 2014 16:47:46 -0500 to Sat, 

11 Oct 2014 23:59:59 -0500

Meter Name

113599432Serial

60HzNominal Frequency

120VNominal Voltage (Un) 4/18
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Section x.4.1 Rapid Voltage Changes Fail
A rapid voltage change of the supply voltage is mainly caused either by load changes in network 

users' installations, or by switching in the system. Under normal operating conditions, a rapid 

voltage change generally does not exceed ±5.0% Un, but a change of up to ±10.0% Un with a short 

duration might occur some times per day in some circumstances. Note: A negative voltage change 

resulting in a voltage less than 85.0% Un is considered a supply voltage dip.

  Note: The results displayed for ±10.0% Un are over the course of the week, and do not represent a 

single day.  14 ±10.0% changes are allowed in one week.

Results Summary
Zone Required Volts  A Volts  B Volts  C
±5.0% 100.00% 100.00% 100.00%

±10.0% 14 2 2 2

> ±10.0% 0 79 36 44

128Mb_IP194 Weekly report for

Mon, 06 Oct 2014 16:47:46 -0500 to Sat, 

11 Oct 2014 23:59:59 -0500

Meter Name

113599432Serial

60HzNominal Frequency

120VNominal Voltage (Un) 5/18
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Section x.4.2 Flicker Fail
Flicker is the impression of unsteadiness of visual sensation induced by a light stimulus whose luminance 

or spectral distribution fluctuates with time. Under normal operating conditions, during a period of one 

week, the long term flicker (PLT) severity caused by voltage fluctuations should be <= 1.00 for 100.0% of 

the time.

Results Summary
Zone Required Volts  A Volts  B Volts  C

<= 1.00 100.0% 95.31% 95.31% 95.31%

> 1.00 4.69% 4.69% 4.69%

128Mb_IP194 Weekly report for

Mon, 06 Oct 2014 16:47:46 -0500 to Sat, 

11 Oct 2014 23:59:59 -0500

Meter Name

113599432Serial

60HzNominal Frequency

120VNominal Voltage (Un) 6/18
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23: EN 50160/IEC 61000-4-30 Power Quality Analysis

Flicker PST Fail
Flicker is the impression of unsteadiness of visual sensation induced by a light stimulus whose luminance 

or spectral distribution fluctuates with time. Under normal operating conditions, during a period of one 

week, the short term flicker (PST) severity caused by voltage fluctuations should be <= 1.00 for 100.0% 

of the time.

Results Summary
Zone Required Volts  A Volts  B Volts  C

<= 1.00 100.0% 99.35% 99.35% 99.35%

> 1.00 0.65% 0.65% 0.65%

128Mb_IP194 Weekly report for

Mon, 06 Oct 2014 16:47:46 -0500 to Sat, 

11 Oct 2014 23:59:59 -0500

Meter Name

113599432Serial

60HzNominal Frequency
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23: EN 50160/IEC 61000-4-30 Power Quality Analysis

Section x.5 Supply Voltage Dips Pass
A Supply Voltage Dip is a sudden reduction of the supply voltage to a value between 90% and 1% of the 

declared voltage Uc, followed by a recovery after a short period of time.

Under normal operating conditions, the expected number of voltage dips in a year may be from a few tens 

up to one thousand. The majority of voltage dips have a duration less then 1s and a retained voltage 

greater then 70%. However, voltage dips with greater depth and duration can occur infrequently.

Results Summary
Zone Required Volts  A Volts  B Volts  C

85.0% to 90% 0 0 0

85.0% to 80.0% 0 0 0

80.0% to 70.0% 0 0 0

70.0% to 60.0% 0 0 0

60.0% to 50.0% 0 0 0

50.0% to 40.0% 0 0 0

40.0% to 30.0% 0 0 0

30.0% to 20.0% 0 0 0

20.0% to 10.0% 0 0 0

10.0% to 5.0% 0 0 0

< 5.0% 5 3 5

128Mb_IP194 Weekly report for

Mon, 06 Oct 2014 16:47:46 -0500 to Sat, 
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23: EN 50160/IEC 61000-4-30 Power Quality Analysis

Results Summary
Zone Required Volts  A Volts  B Volts  C

<= 1 ms 0 0 0

> 1 ms 1 0 0

> 5 ms 0 0 2

> 10 ms 0 0 0

> 50 ms 0 0 0

> 100 ms 1 0 0

> 500 ms 3 3 3
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23: EN 50160/IEC 61000-4-30 Power Quality Analysis

Voltage Swells Pass
A Voltage Swell is a increase of the supply voltage to a value above 115.0% of the declared voltage Uc, 

followed by a recovery after a period of time.

Results Summary
Zone Required Volts  A Volts  B Volts  C

<= 1 ms 0 0 0

> 1 ms 0 0 0

> 5 ms 0 0 0

> 10 ms 0 0 0

> 50 ms 0 0 0

> 100 ms 0 0 0

> 500 ms 0 0 0

128Mb_IP194 Weekly report for
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11 Oct 2014 23:59:59 -0500
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23: EN 50160/IEC 61000-4-30 Power Quality Analysis

Section x.6 Short Interruption of Supply Voltage Fail
  An Interruption of Supply Voltage is a condition in which the voltage at the the supply terminals is lower 

than 5.0% on Phase A, 5.0% on Phase B, and 5.0% on Phase C, of the declared voltage Uc.  A Short 

Interruption is defined as an event which lasts for less than 1 milliseconds.

  Under normal operating conditions, the annual occurence of short interruptions ranges from a few tens to 

several hundreds. The duration of approximately 70% of the Short Interruptions may be less than one 

second.

Results Summary
Zone Allowed Volts A Volts  B Volts  C

<= 1 ms 0 0 0
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23: EN 50160/IEC 61000-4-30 Power Quality Analysis

Section x.7 Long Interruption of Supply Voltage Fail
  An Interruption of Supply Voltage is a condition in which the voltage at the supply terminals is lower 

than 5.0% on Phase A, 5.0% on Phase B, and 5.0% on Phase C, of the declared voltage Uc.  A Long 

Interruption is defined as an event which lasts for more than 500 milliseconds.

  Under normal operating conditions, the annual occurence of long interruptions ranges from 10 to 50, 

depending on the area.  This location is allowed up to 1 long interruptions per year.

Results Summary
Zone Allowed Volts  A Volts  B Volts  C

<= 1 ms 1 3 3 3

> 500 ms

128Mb_IP194 Weekly report for

Mon, 06 Oct 2014 16:47:46 -0500 to Sat, 

11 Oct 2014 23:59:59 -0500

Meter Name

113599432Serial

60HzNominal Frequency

120VNominal Voltage (Un) 12/18



     Doc#    E107707                                               23 - 21

23: EN 50160/IEC 61000-4-30 Power Quality Analysis

Section x.8 Temporary Power Frequency Overvoltage Pass
  A temporary power frequency overvoltage generally appears during a fault in the public distribution 

network, or in a network user's installation, and disappears when the fault is cleared. Under these 

conditions, the overvoltage may reach the value of the phase-to-phase voltage, due to a shift of the neutral 

point of the three-phase voltage system, the actual value depending upon the degree of load unbalance, 

and the remaining impedance between the faulty conductor and earth.

  The duration of the event is limited by the time taken for protection to clear the fault, typically no more 

than 10Secs.

  The magnitude of the event may not exceed 140.0% Uc for Vae, 140.0% Uc for Vbe, or 140.0% Uc for 

Vce.

Results Summary
Zone Required Vne Vae (140.0%) Vbe (140.0%) Vce (140.0%)

< 5Secs 0 0 0 0

5Secs to 10Secs 0 0 0 0

> 10Secs 0% 0 0 0 0
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23: EN 50160/IEC 61000-4-30 Power Quality Analysis

Section x.10 Supply Voltage Unbalance Fail
  Under normal operating conditions, during each period of one week, 100.0% of the 10 Minutes 

mean RMS values of the negative phase sequence component (fundamental) of the supply voltage 

shall be within the range of 0% to 3.0% of the positive phase sequence component (fundamental).

Results Summary
Zone Required Ac tual Res ul t

0% to 3.0% 100.0% 23.30% Failed

> 3.0% 76.70% Failed
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23: EN 50160/IEC 61000-4-30 Power Quality Analysis

Section x.11 Harmonic Voltage Pass
Under normal operating conditions, during each period of one week, a percentage of the 10 min mean 

RMS values of each individual harmonic voltage shall be less than or equal to the limit value given in the 

results table.  Additionally, 5.0% the THD of the supply voltage (including all harmonics up to the 40th 

order) shall be less than or equal to 8.0%.

Volts A Harmonic Summary
Zone Allowed Li mi t % O ut
THD 95.0% 8.0% 0.00%

2nd 5.0% 2.0% 0.00%

3rd 5.0% 5.0% 0.00%

4th 5.0% 1.0% 0.00%

5th 5.0% 6.0% 0.00%

6th 5.0% 0.5% 0.00%

7th 5.0% 1.5% 0.00%

8th 5.0% 50.0% 0.00%

9th 5.0% 1.5% 0.00%

10th 5.0% 0.5% 0.00%

11th 5.0% 3.5% 0.00%

12th 5.0% 0.5% 0.00%

13th 5.0% 3.0% 0.00%

14th 5.0% 0.5% 0.00%

15th 5.0% 0.5% 0.00%

16th 5.0% 0.5% 0.00%

17th 5.0% 2.0% 0.00%

18th 5.0% 0.5% 0.00%

19th 5.0% 1.5% 0.00%

20th 5.0% 0.5% 0.00%

21st 5.0% 0.5% 0.00%

22nd 5.0% 0.5% 0.00%

23rd 5.0% 1.5% 0.00%

24th 5.0% 0.5% 0.00%

25th 5.0% 1.5% 0.00%
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23: EN 50160/IEC 61000-4-30 Power Quality Analysis

Volts B Harmonic Summary
Zone Allowed Li mi t % O ut
THD 95.0% 8.0% 0.00%

2nd 5.0% 2.0% 0.00%

3rd 5.0% 5.0% 0.00%

4th 5.0% 1.0% 76.05%

5th 5.0% 6.0% 0.00%

6th 5.0% 0.5% 0.00%

7th 5.0% 1.5% 0.00%

8th 5.0% 50.0% 0.00%

9th 5.0% 1.5% 0.00%

10th 5.0% 0.5% 0.00%

11th 5.0% 3.5% 0.00%

12th 5.0% 0.5% 0.00%

13th 5.0% 3.0% 0.00%

14th 5.0% 0.5% 0.00%

15th 5.0% 0.5% 0.00%

16th 5.0% 0.5% 0.00%

17th 5.0% 2.0% 0.00%

18th 5.0% 0.5% 0.00%

19th 5.0% 1.5% 0.00%

20th 5.0% 0.5% 0.00%

21st 5.0% 0.5% 0.00%

22nd 5.0% 0.5% 0.00%

23rd 5.0% 1.5% 0.00%

24th 5.0% 0.5% 0.00%

25th 5.0% 1.5% 0.00%
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23: EN 50160/IEC 61000-4-30 Power Quality Analysis

Volts C Harmonic Summary
Zone Allowed Li mi t % O ut
THD 95.0% 8.0% 0.00%

2nd 5.0% 2.0% 0.00%

3rd 5.0% 5.0% 0.00%

4th 5.0% 1.0% 0.00%

5th 5.0% 6.0% 0.00%

6th 5.0% 0.5% 0.00%

7th 5.0% 1.5% 0.00%

8th 5.0% 50.0% 0.00%

9th 5.0% 1.5% 0.00%

10th 5.0% 0.5% 0.00%

11th 5.0% 3.5% 0.00%

12th 5.0% 0.5% 0.00%

13th 5.0% 3.0% 0.00%

14th 5.0% 0.5% 0.00%

15th 5.0% 0.5% 0.00%

16th 5.0% 0.5% 0.00%

17th 5.0% 2.0% 0.00%

18th 5.0% 0.5% 0.00%

19th 5.0% 1.5% 0.00%

20th 5.0% 0.5% 0.00%

21st 5.0% 0.5% 0.00%

22nd 5.0% 0.5% 0.00%

23rd 5.0% 1.5% 0.00%

24th 5.0% 0.5% 0.00%

25th 5.0% 1.5% 0.00%
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23: EN 50160/IEC 61000-4-30 Power Quality Analysis

Section x.13 Mains Signaling Voltage Pass
  In some countries the public distribution networks may be used by the public supplier for the 

transmission of signals. Over 100.0% of a day, the 3 second mean of the signal voltage shall be less than 

or equal to the mains signaling threshold.

  The Mains Signaling Threshold is 120.0% of Un, or 144V.

Results Summary
Zone Required Vae Vbe Vc e

<= 120.0% Un 100.0% 100.00% 100.00% 100.00%

> 120.0% Un <= 0.0% 0.00% 0.00% 0.00%
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   24: Configuring the Dial-In/Dial-Out Feature

24: Configuring the Dial-In/Dial-Out Feature

24.1: Overview

Older versions of the Nexus® 1262/1272 meters have an optional Internal Modem 

that has a Dial-In/Dial-Out feature (the Internal Modem was discontinued in February, 

2020.). This chapter explains how to use CommunicatorPQA® software to configure 

the following settings for the Modem Dial-In/Dial-Out function:

•   Modem Dial-Out Programming (24.4: Modem Dial-Out Programming, on page 24-

7)

•   Dial-In Programming (24.5: Dial-In Settings, on page 24-12)

•   Disable Email / Page Generation (24.5: Dial-In Settings, on page 24-12)

•   Modem Monitor (24.6: Modem Monitor, on page 24-16)

•   Alarm Server (24.7: Nexus® Alarm Server, on page 24-17)
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   24: Configuring the Dial-In/Dial-Out Feature

24.2: Setting the Dial-In Connection

1. Install the modem connected to the computer (the "originate modem"). See your 

meter’s Installation and Operation Manual for details on hardware requirements.

2. From the CommunicatorPQA® application’s Main screen, click the Connect Mgr icon 

or select Connection>Connection Manager. You will see the screen shown below.

3. Click the Add button to add a “New Location”; then click the Edit button. You will 

see the screen shown on the next page.
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   24: Configuring the Dial-In/Dial-Out Feature

4. Configure the Location Editor screen as follows:

a. Type in a Location Name.

b. Select a Com Port Number.

c. Set the Baud Rate to 38400.

d. Enable Hardware Flow Control.

e. Set Data Bits to 8.

f. Set Parity to None.



     Doc#    E107707                                               24 - 4

   24: Configuring the Dial-In/Dial-Out Feature

g. Click the Use Modem checkbox.

h. Enter Phone Number or Setup String - whichever is applicable for your 

modem.

i. If you want to control access, click Use Password and then enter a Pass-

word.

j. In the Devices at Location section, click Add Serial, then select the new 

Device and click Edit. You will see the screen shown below.

5. Configure the Location Device Editor screen as follows:

a. Address will be 1 for the Primary Device; something other than 1 if it is not 

the Primary Device.

b. Type in Name.

c. Type in Description.

d. Select Modbus ASCII from the Protocol pull-down menu.

e. Device Type is Nexus® 1200 Series.
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   24: Configuring the Dial-In/Dial-Out Feature

f. Enter the Com port you are using.

g. Click Close. You will return to the Location Editor screen.

6. Click once on the device you want to connect to your computer and then click

Connect. The computer begins dialing. When the CommunicatorPQA® application

locates the Nexus® meter at that location, the Device Status screen appears to

confirm the connection.

7. The CommunicatorPQA® software will search for a Modem. If you do not get a

“Modem Found” message, check your computer configuration and External Modem

setup.

24.2.1: Troubleshooting the Connection 

If you have communication problems, check the following:

• Confirm that all cables are secure.

• Confirm that the RS232 cable is connected to the correct Com Port on the PC.

• Confirm that the PC and the meter’s ports have the same Baud Rate and are both

set to Modbus ASCII.
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   24: Configuring the Dial-In/Dial-Out Feature

24.3: Setting the Dial-Out Connection

1.From the CommunicatorPQA® application’s Main screen, click the Profile icon. The 

CommunicatorPQA® application retrieves the programmable settings for the cur-

rently selected, connected Nexus® meter. You will see a screen showing the 

retrieval progress.

2. Once the settings are retrieved, the Device Profile menu is displayed. Click on the 

(+/-) icon next to Communications, and then double-click on one of the displayed 

ports. You will see the screen shown below if you are connected to a Nexus® 1250/

1252 meter:

NOTE: The screen for the Nexus® 1262/1272 meter shows only Ports 1 and 4.

3. Configure the Internal Modem Settings as follows:
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   24: Configuring the Dial-In/Dial-Out Feature

a. Answer the Phone on 2 Rings.

b. Modem Gateway Baud Rate set to 38400.

4. Click the Dial-Out Profile button to configure the Dial-Out feature of the Internal 

Modem - see section 24.4 for instructions for configuring the Dial-Out settings.

5. When you have completed your modem settings, click OK to save your settings and 

return to the Device Profile menu.

6. Click Update Device to send your settings to the meter.

24.4: Modem Dial-Out Programming

When you click Dial-Out Profile button from the Communications screen, you see the 

Modem Programming screen, shown below. 
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This screen helps you configure the Dial-Out Profile. It has five sections - each is 

detailed below:

•   Primary Phone Number Settings

•   Number: The first phone number (up to 50 characters) called for automated 

callout.

•   Retry Delay: The number of minutes (1-1000) between retries.

•   Retry Limit: The user-set limit for retry attempts (0-1000).

•   Connection Type: Computer.

•   Secondary Phone Number Settings

•   Number: The second phone number (up to 50 characters) for automated callout.

•   Retry Delay: The number of minutes (1-1000) between retries.

•   Retry Limit: The user-set limit for retry attempts (0-1000).

•   Connection Type: Computer.

The modem will retry the Primary Number according to the Retry Limit set. The 

modem will then dial the Secondary Number for the programmed number of retries 

set in the Retry Limit.

•   Communication Settings

•   Activity Timeout Limit: User-set value that is the number of minutes of inactivity 

(no communication activity) that is allowed on an open modem connection 

before the modem terminates the connection (1-30 minutes).

•   Call Delay Timer Limit: User-set variable that defines the number of seconds the 

modem waits before processing a callback event (0-240 seconds). This setting 

applies to calls caused by Limit or Input Status conditions.

•   Callback Type: There are two types of callback:

• Playback: The Modem waits 500ms after connection and plays back the 

Modem ID string displayed (if programmed) and the reason for the call.
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   24: Configuring the Dial-In/Dial-Out Feature

• Standard: When performing a callback, once connection is established 

the modem waits to be queried by the PC it has called.

        NOTE: You can override Playback mode by turning Playback off. You will not be

        able to override the setting to Playback mode if the Modem ID string is blank 

        (“-----”).

•   Call Failure Reset Limit: User-set value for the number of hours the modem 

locks out incoming calls if the Incoming Connection Failure Limit is reached (1-

50 hours).

•   Share the Phone Line: If checked, the modem monitors phone line voltage 

during all calls. If the phone line voltage drops by more than 30 during a call 

(indicating that someone else has taken another phone off the hook) the modem 

disconnects and returns to normal polling operation. If not checked, the modem 

does not watch for line voltage deviations.

•   Modem Settings

•   Rings to Answer: User-set value for the number of Rings (1-9) before the 

modem goes off the hook and attempts to answer an incoming call. Zero = 

Never Answers. Ring is a Voltage Change.

•   Identification: Up to 32 Western Alphabet Characters (16 Asian Characters).

•   Password: Up to 10 alphanumeric characters (user-set) in addition to passwords 

that restrict access to certain levels of the Nexus® meter. If the password is not 

entered correctly, the modem asks the user to enter the password again (up to 

three times) and disconnects after the third incorrect attempt.

•   Enable Password: If checked, a Password must be entered.

•   Violation Limit: User-set value for number of times the modem allows unsuc-

cessful connection attempts (unable to supply correct password in three 

attempts) before locking-up to incoming calls (1-10). The Modem disconnects 

from the incoming call and does not accept incoming calls for a period of time 

equal to the Violation Lockout Time.
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• Violation Lockout Time: User-set time limit for the number of hours (1-32) the

Modem will be inaccessible. The Violation Lockout provides a level of security

against bad passwords.

• Dial-Out on the Following Conditions:

• Limits Status Change

• High Speed Input Change

• Waveform Record Captured

• CBEMA Power Quality Event

• Control Output Change

• Filling of Meter Memory

• Cycling of Control Power

• Modem Password Failure

• Failure of Communication with the Nexus® meter

• Log Full Limit Threshold (Covers All Logs): Percent that a log is full before

a call is triggered.

• Edit Gateway Port Devices: the Edit Gateway Port Devices button at the bottom of

the screen is used to enable up to 8 devices that are connected via the gateway
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and are to be monitored. When you click the Edit Gateway Port Devices button, you 

will see the screen shown below.

a. Click the Enable Device box next to the Device to be monitored. A Device

address will be displayed next to the Enabled Device.

b. Change the Device Address, if needed, to any address except 1. Address

number 1 is always reserved for the Primary Device.

c. Click either:

• OK to save changes and return to the Modem Programming screen

• Cancel on either screen to cancel changes and return to the previous

screen.

When your Dial-Out settings are complete, click OK to return to the main Device 

Profile menu. For these changes to take effect, you must click the Update Device 

button to send the new settings to the meter.
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24.5: Dial-In Settings

The Nexus® meter’s Dial-In Settings screen is divided into 9 possible event or prob-

lem sections. Any one event/problem or a combination of event/problems can trigger 

a call. The settings on this screen tell the PC what to do when the Modem calls with 

one or more problems:

•   Who to call

•   Where to call

•   What message to send.

NOTE: You must have installed Dial-In Server software for the Dial-In screens to 

work.

1. From the CommunicatorPQA® application’s Main screen, click Dial-In Settings. You 

will see the screen shown below.



     Doc#    E107707                                               24 - 13

   24: Configuring the Dial-In/Dial-Out Feature

2. These are the settings in the screen:

•   Events/Problems

• Limits Status Change: The Nexus® meter contains up to 64 monitored 

limit conditions. One or more limit states had a change.

• High Speed Input Change: One or more of the 8 High Speed Inputs had a 

change.

• Control Output Change: When a control event occurs, an integer counter 

increments (range of 0-65,536).

• Waveform Record Capture: A Waveform Record Capture was triggered in 

response to observed transient conditions. An integer counter increments 

each time a waveform record is captured (range of 0-65,536).

• CBEMA Power Quality Event: The meter captures CBEMA event records in 

response to observed transient conditions. The counter has a range of 0-

65,536.

• Filling of Log Memory: When any one log reaches or exceeds the user-set 

download level, the modem calls to report a log fill condition and perform 

an automated download of all stored data.

• Modem Password Failure: When the Password Limit is reached, the 

modem initiates a callback with no delay (because there is no opportunity 

for the condition to reset). If the phone line is available, the modem 

attempts a reporting call; if the phone line is unavailable, the modem 

continues polling.

• Failure of Communication with Nexus® meter: If the meter fails to the 

modem within the allotted time, the modem initiates a callback with no 

delay (because there is no opportunity for the condition to reset). If the 

phone line is available, the modem attempts a reporting call; if the phone 

line is unavailable, the modem continues polling.

•   Event/Problem Settings

• Retrieve: For those events that trigger log retrieval, six of the screens 

have pull-down menus for you to select the logs to be retrieved.
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• Reset All Logs after Retrieval: Check those sections that apply.

NOTE: In order to use the Reset function, you must select “All Logs” from

the pull-down menu next to the word “Retrieve.”

• Generate Email: Send an email message to the designated recipient.

• Call Pager: Call the designated recipient's pager number.

 NOTE: Selecting “All Logs” from multiple events sections does not cause 

 duplication in log retrieval.

• Email and Pager Settings

• Outgoing Mail Server: Enter name of Valid Email Server that does not

require password and user name to send mail (POP3 type).

• Sender: The CommunicatorPQA® application.

• Pager ID#: User-set numeric value used to identify this meter when a

numeric page is issued (up to 5 digits, 00000 to 99999).

• Reply Address: None or Email Address to let recipient know where to

send replies.

• Port Number: 25 is normal for email servers.

• Test Email: Sends a Test Message to a recipient to test the email settings

(uses email of the first recipient only).

• Test Pager: Sends a Test Message to a recipient to test the paging (uses

the number for first recipient only).

• Recipients: List Name, Email Address and Pager Number.
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• Filter: Double-click and the Edit screen will open. 

• Click in front of message(s) you want to exclude from the highlighted 

recipient.

• Add: Click to Add a Recipient.

• Remove: Click to Remove a Recipient.

• User Defined Message: Type in a message for the highlighted recipient.

3. The screen buttons are used as follows:

•   OK: click to Save Settings and return to the Main screen.

•   Cancel: click to Exit the screen without saving the settings.

•   Print: click to Print the screen.
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24.6: Modem Monitor

The Modem Monitor, as the name implies, checks the PC for connected modems and 

monitors available modems for incoming calls. The Status line coaches you in setting 

up the modem and keeps you informed of the status of the available modems.

1. To start the Modem Monitor screen, click Start>Programs>Electro Indus-

tries>Modem Monitor icon. 

2. After the screen appears, press Start to allow the Modem Monitor to monitor avail-

able modems. After a search for modems, the software will continue to locate the 

modems that were found for a “Call Back.”

3. The main screen lists the available modems with the Ports to which they are con-

nected and their Status. When an incoming call is detected, the Modem Monitor 

starts the CommunicatorPQA® application, which answers the call and processes it.

•   Command Line Switches

        /S: Autostart Modem Monitoring when program is started.

       /M: Minimize program when started. Program will appear as icon in the system

       tray on your computer screen.

       NOTE: When program is minimized, it appears as an icon in the system tray.

       Click on this icon to restore the program to a normal sized window.

• Example Command Line Switches

                  Nexusmonitor.exe /S:

                  Nexusmonitor.exe /M:
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                  Nexusmonitor.exe /S: /M:

                 NOTE: Spaces are required between the components.

•   Screen Buttons

• Click Stop to disconnect the Modem Monitor.

• Click Start to connect the Modem Monitor.

24.7: Nexus® Alarm Server

The Nexus® Alarm Server screen lists all Call Back Events that have occurred. Data 

included with each event entry is as follows: Number of the Alarm on the list, Date, 

Time of the Call Back Event, Name of Modem, Type of Event/Problem, whether that 

Event has been acknowledged and the Time of the Acknowledgement. Settings for 

this screen are located on the Modem Programming screen/Dial Out Profile in the 

Nexus® meter’s Device Profile.

To start the Nexus Alarm Server screen, click Start>Programs>Electro Indus-

tries>Nexus® Alarm Server icon.

•   The screen’s Tool Bar has these options:
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•   File: Select one of the following

• Export - Excel Compatible Values file

• Print - Print the contents of the box of events

• Exit - Exit the program

•   Options:

• Items

Insert to Top of the list of events.

Append to Bottom of the list of events.

• Alarm - Enable or Disable Audio or Visual

• Audio - Can replace with another 2 second sound file with the same 

name (alarm.wav in the directory where the CommunicatorPQA® soft-

ware files are installed)

• Visual - Text box display

• Test - Generate a Test Message

• Action

•Silence Alarm - Turn Noisemaker and/or Alarm Message off (not mute)

•Acknowledge Item - Red to Green color change

•Acknowledge All - Red to Green color change

•Remove All - Erase All Alarms

•   The screen Icons are:

•   Print: lick to select Setup Options.

•   Voice: Microsoft Speech Properties.

•   Alarm Silencer: To stop audio and/or visual alarm until next entry arrives.

•   Acknowledge Event
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•   Delete Entry in Server Box

•   Exit
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25: Firmware Updating

25.1: Overview

•  You can update the following firmware components:

•   Nexus® Communication Processor (“Nexus® Comm”): This processing chip 

performs all tasks related to communication and storing data.

•   Nexus® Digital Signal Processor (“Nexus® DSP”): This processing chip performs 

all tasks related to data calculation.

•   LED Display: This processing chip is installed in the Nexus® External LED Dis-

play.

•   Internal Modem Card: This optional card is installed in the Nexus® meter and 

enables it to act as meter and modem in one device. This card must be updated 

in addition to updating the Nexus® Comm and DSP. (Refer to 25.2.2: Update 

the Internal Modem Card’s Firmware, on page 25-4.)

•   Internal Network Option: This option allows a Nexus® meter to communicate 

with multiple PC’s concurrently. This card must be updated in addition to updat-

ing the Nexus® Comm and DSP. (Refer to 25.2.1: Update the Internal Network 

Card’s Firmware, on page 25-3.)

•   Network Option card: This option gives a Nexus® or Shark® 200/250/270 

meter 100BaseT Ethernet capability. See the meter’s User Manual for instruc-

tions on updating the card’s firmware.

•  Cellular Modem Card: This option gives cellular modem wireless communication 

to a Shark® 270 meter. See 25.4.4: Firmware Update for the Shark® 270 

Meter’s Cell Modem Card, on page 25-13.

•  There are 3 ways to learn what firmware versions are currently installed in your 

meter:

•   Click the Device Stats icon (or select Tools>Retrieve Device Status or 

Tools>Device Status). The “Run-time” field shows the current Comm firmware 

version number; the “DSP Run-time” field shows the current DSP firmware ver-

sion number.
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•   Click the Profile icon to retrieve the current Device Profile from the connected 

meter. Click Report. The Comm and DSP firmware are listed in the Runtime 

column.

•   If you have a Nexus® External Display connected to the meter, see the User 

Manual for your meter for details on using it to access firmware version num-

bers.

•   To update, you must have the most recent update file from Electro Industries.
•   Updating erases the existing firmware and replaces it with the new version.

WARNINGS!

•   Updating should only be done with the proper firmware. Otherwise, data may be 

lost.

•   Perform Backup of your stored data prior to installing new firmware into your unit.

Detailed instructions for performing firmware updates for EIG meters and their net-

work cards are linked on EIG’s website:

https://www.electroind.com/technical-support/product-firmware-release-dates/
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25.2.1: Update the Internal Network Card’s
                Firmware

1. When you have selected Internal Network and clicked Next, you will see the screen 

shown below on the right with the warning message shown on the left in front of 

the screen. Read the warning and do as it says. Click OK to close the warning mes-

sage window.

NOTE: The warning instructs you to retrieve logs before updating and reset logs 

after updating.

2. In the Firmware Update file, click Select to find the Firmware file on your PC.

3. If password protection is enabled, enter the Username and Password.

4. Click Start to begin the Firmware Update process. Updating the Internal Network 

card takes approximately 30 minutes. Note that you may see a warning message 

telling you to retrieve logs before the update and reset logs after the update.

5. The screen displays messages while the firmware is loading. When you see the 

message “Run-time firmware updated to flash successfully,” click Reset Device.

NOTE: You can click Get Firmware Info to verify that you have the correct firmware 

before you reset the meter.
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25.2.2: Update the Internal Modem Card’s Firmware

1. When you have selected Internal Modem and clicked Next, you will see the screen 

shown below. (If the Password Feature is Enabled, you will be prompted to enter 

your Level 2 Password - do so and click OK.) You will see the screen shown below.

a. Click Enter Command Mode. In the Status fields, the words “Entering 

Command Mode,” “Sending Escape Sequence,” and then, “In Command 

Mode” will be displayed.

b. Click Program Flash to open a window that lets you locate the firmware file 

on your computer. You will need only one file (*.hex file) for the Internal 

Modem firmware update. Be sure to read the text file located in the same 

directory as the firmware file.

c. Select the file and click Open. The program automatically uploads the data. 

Lines 1 and 2 of the Status fields display the progress of the update. 
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d. When the firmware update is complete, the Status field will say “The Flash 

has been programmed.” 

2. Click Exit to return to the Main screen.
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25.3: Update a Nexus® 1500/1500+ Meter’s
            Firmware

1. From the Main screen, Click Tools>Firmware Update. You will see the screen shown 

below.

2. Read the warning and do as it says. Click OK to close the message window.

NOTE: The warning instructs you to retrieve logs before updating and reset logs 

after updating.

3. Click Select to locate the firmware update file. You use this same screen to perform 

any firmware updates for the meter.

IMPORTANT! If you are updating a 1500+ with firmware version 15.2, first down-

load the PQ log, and then reset it (see 16.2: Retrieving Log Data, on page 16-1 and 

20.1.7: Reset Device Information, on page 20-7. for instructions).

NOTE: You can click Get Firmware Info to verify that you have the correct firmware 

before you reset the meter.
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4. Enter Username and Password: if password protection is enabled enter the pro-

grammed information. If password protection is disabled, enter anonymous in 

both the User Name and Password fields.

5. Click Start. You will see the window shown below. Click OK to continue.

6. You will see the message window shown below. Click Yes to continue.

7. The progress bar will show the status of the update. When the update has com-

pleted successfully, a message to that effect displays in the message field.

8. Click Get Firmware Info to see and confirm the meter’s firmware version 

information.

9. If the version is correct, click Reset Device. (If the version is not correct, click 

Select to choose another update file.)

10. Click Close to exit the screen.



     Doc#    E107707                                              25 - 8

25: Firmware Updating

25.4: Update the Shark® Series Meters’ Firmware

The next section tells how to perform a firmware update for the Shark® Gen1 50/100 

meter. Section 25.4.2 explains how to perform a firmware update for the Shark® 200 

meter, the ST40 meter, the Gen2 Shark® 50/100 meter, and the MP200TM metering 

system. Section 25.4.3 explains how to perform a firmware update for the Shark® 

250 meter.

25.4.1: Firmware Update for Shark® Gen 1 50/100 Meter

NOTE: There are two versions of the Shark® 50/100 meters’ DSP processor - Gen1 

and Gen2. You can see the processor’s firmware version in the Device Status screen 

for the meter: Gen1 firmware has a version number of 65 or lower and Gen2 firmware 

has a version number of. 76 or higher The procedure in this section is for the Gen1 

processor. Follow the procedure in 25.4.2: Firmware Update for Shark 200/ST40 

Meter, Gen2 Shark 100 Meter, and MP200 Metering System, on page 25-11 if your 

meter has the Gen2 processor. 

1. From the Main screen, select Tools>Firmware Update. You will see the screen 

shown below.



     Doc#    E107707                                              25 - 9

25: Firmware Updating

2. Click Next. You will see the screen shown on the next page.

3. Click Browse to locate the firmware file and click Next. 
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4. You will see the screen shown below.

a. Select the meter’s Com port you want to use for the update: IrDA or 

RS485.

b. If the meter is in Boot Mode, click the Boot Flash checkbox.

3. Click Start to perform the firmware update. You will see the confirmation message 

window shown below. Click Yes to continue.

4. When the update is complete, the Cancel button changes to OK. Click OK to close 

the screen.
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25.4.2: Firmware Update for Shark 200/ST40 Meter, Gen2 Shark 100 
                Meter, and MP200 Metering System

1.From the Main screen, select Tools>Firmware Update. You will see the screen shown 

below. 

2. Click Browse to locate the firmware file.

3. Click Start to update the firmware with the new firmware file.

4. When updating is complete, click Exit to close the screen.

   NOTE: If firmware updating fails, you will see a message to that effect. Check

   Device Status to see if your meter is in Boot Mode.

•   If the meter is in Boot Mode, uncheck the Starting from Run Mode box in the 

Firmware Update screen and try updating the firmware again.

•   If the meter’s status is not displayed in the Device Status screen, the meter may 

be stuck in Boot Mode. If you are certain the communication settings are correct 

for the meter, try connecting to the meter using the following defaults:

• For RS485 connection:

 Address 001

 Baud Rate 9600

 Protocol Modbus RTU

• For IrDA connection:

 Address 001

 Baud Rate 57600

 Protocol Modbus ASCII
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   Once you connect to the meter, you can try updating again.

NOTE: The Shark® 200 meter’s network card can only be updated via its 

webpage. See the Shark® 200/200T Installation and Operation Manual for details.

25.4.3: Firmware Update for the Shark® 250/270 Meter

1.From the Main screen, select Tools>Meter Firmware Update. 

2. Click Browse. You will be prompted to select the firmware file.

3. Once the file is shown in the File field, click Start to begin firmware update. You will 

see messages as the update takes place. See the example screen, below.

4. The screen will show a message when the update is complete. Click Exit to close 

the screen.
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25.4.4: Firmware Update for the Shark® 270 Meter’s Cell Modem
               Card

The Shark® 270 meter offers the Verizon-certified 4GLTE cellular modem card. If your 

4GLTE card has version 0001 firmware, EIG recommends that you upgrade to version 

0002 firmware. You can get the firmware file from EIG’s technical support (phone # 

516-334-0870, 8a.m. - 8 p. m. Monday - Friday) - save the file on your PC. Note that 

you can see the 4GLTE card’s current firmware version in the Device Status screen 

(see Chapter 4: Viewing Device Status, on page 4-1 for instructions on viewing the 

Device Status screen).

Follow this procedure to update the card's firmware:

1. Use CommunicatorPQA® software version 5.0.280 or higher to preset the APN 

number and optionally configure the Allow IP address(s) - these fields are new in 

firmware version 0002. The APN number is necessary in order to connect to a cell 

modem with the new firmware. You can use the cellular connection to connect to 

the meter. 

2. Instructions for setting the APN and allowed addresses are in 26.5.8: Configuring a 

Verizon 4G Cell Modem Card (4GLTE), on page 26-120.

3. When you have updated the meter’s Device Profile with the new settings, click 

Tools>4GLTE Card Firmware Update from the main screen’s Title bar.

4. Select the update firmware file by clicking the Browse button to locate it on your 

PC. 

5. Click Write File to Meter; File Type is 05-4G Cell Modem Firmware.



     Doc#    E107707                                              25 - 14

25: Firmware Updating

6. Click Transfer File. You will see a status update as the firmware is loading.

7. When the update has successfully completed, you will see the following message.

8. Wait about 10 minutes - the unit should connect via the cell modem.
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25.5: Firmware Update for the Nexus® 1450 Meter

You can only update the firmware using an Ethernet (not serial) connection. You can 

find the meter’s current firmware version in the App Archive version number, in either 

the Device Status screen or the WebViewTM Energy Dashboard’s Meter Hardware web-

page.  
Device Status Screen

WebViewTM Energy Dashboard’s Meter Hardware Webpage
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1. From the Main screen, select Tools>Meter Firmware Update. 

2. If you know the firmware file’s path, enter it in the File field, or else click Browse to 

locate the file.

3. Click on the file you want to use and click Open.

4. Once the file is shown in the File field, click Start to begin the firmware update. You 

will see messages as the update takes place. Note that the firmware update may 

take longer than five minutes to complete. When the update is complete, click 

Reset to reboot the meter using the new firmware.
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26: Shark® 270 Certified, ANSI
        C12.20 Accuracy Class Energy Meter

This chapter explains how to configure a Shark® 270 energy meter's programmable 

settings, which are stored in the unit's Device Profile. Chapter 7 contains detailed 

information on how to use the meter’s Device Profile. See 6.11: Shark® 250/270 

Meter’s Security, on page 6-21, for details on programming restrictions when the 

Sealing Switch is enabled.

NOTE: Depending on the firmware in your meter, and whether it is Gen 1 or Gen 2, 

you may see slightly different options than shown in some screen captures.

26.1: Device Profile General Settings

1. From the Tree Menu on the left side of the Shark® 270 meter’s Device Profile 

screen, double-click on the General Settings line or click on the + button next to it. 

All of the settings in the General Settings group are listed.
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26.1.1: Configuring CT, PT Ratios and System Hookup

Use this setting to configure Current Transformer and Potential Transformer ratios and 

to select the System Hookup. The Full Scales values are display only.

Functional Overview of CT and PT Ratios:

Current and Potential Transformers are used mainly for the following reasons:

•  To insulate, and as a result isolate, the meter from high-voltage circuits.

•  To change the primary voltage and current to standard values and sizes that the 

meter can measure.

The CT and PT transformers deliver fractions of the primary voltage and current to the 

meter. With properly set ratios and multipliers, the readings of the meter can be used 

to determine the energy, voltage, current, or power of the system. 

1. From the Tree Menu, click General Settings>CT, PT Ratio and System Hookup. 
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2. Make these settings:

a. Ratios: 

• CT Ratio, enter:

• Primary (CT Numerator): 1 - 65535

• Secondary: this setting depends on the meter class. Enter 5 for a 
Class 20 meter, or 1 for a Class 2 meter.

• PT Ratio, enter:

• Primary (PT Numerator): 1 - 99999999

• Secondary (PT Denominator): 1 - 65535

b. System Wiring:

• From the pull-down menu, select your system’s wiring:

• 3 Element Wye

• 2.5 Element Wye

• 2 CT Delta

   IMPORTANT! The power system type must be selected correctly for the meter to

   calculate readings correctly.

c. Full Scales (display, only, not programmable): 

these fields display the primary values of the 

meter at full scale.
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d. Minimum Voltage Threshold:

• The minimum voltage thresh-

old is a percentage of the volt-

age full scale. This setting 

adjusts the pick up threshold for the voltage, in order to

configure the meter to start readings values above 0 voltage. 

• Set a percentage of the PT primary (PT numerator), up to 12.7, in the 

entry field. 

e. Total 

Demand 

Distortion 

(TDD):

• The TDD is the current harmonic distortion in the system in relation to 

the demand, or load, of the system. Enter the maximum load current for 

your system (i.e., the system the meter is measuring) in the Current 

Reference field. This value will be used in the formula that calculates the 

TDD.

f. CT Phase 

Reversal: Use 

this setting to 

enable CT 

reversal for any phase. This feature is useful if a CT is wired the wrong way and 

you do not want to (or cannot) change the wiring. When CT reversal is enabled, 

the meter’s firmware shifts the current phase by 180 degrees for that phase. 

This will reverse the power direction, and all computations such as power factor, 

phase angle etc., which are derived after that will be affected.

NOTE: This setting is only available for a three element WYE hookup. For any 

other hookup, this setting will be ignored.

• To implement phase reversal for a phase (A, B, or C), select Reversed 

next to that field. 

3. To implement any changes, click the Update Device button to send the new 

profile to the meter.
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26.1.2: Configuring Time Settings

Use this setting to enable or disable Daylight Savings Time for the meter, to set the 

beginning and ending times for Daylight Savings Time, and to set up Time Zone infor-

mation and clock synchronization information.

1. From the Tree Menu, click General Settings>Time Settings. 

2. Make these settings:

a. Check the box to 

Enable Daylight 

Savings time, or 

un-check it to 

Disable Daylight 

Savings Time.
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b. If you are enabling Daylight Savings Time, use the entry fields to set the start 

and end times for it. Select the values you want from the Month, Week, Day of 

the Week, and Hour fields. Note that the Hour field uses a 24-Hour clock.

c. Set the time zone by selecting the time zone from 

the pull-down menu. The time zones are described 

as UTC (Coordinated Universal Time) Plus or minus 

a period of time. If you do not enable the Time 

Zone, the meter defaults to UTC (+0.00), which is 

UTC time.

d. Select the clock synchronization (Clock Sync 

setting) method for the meter: Disabled, if 

don’t want to synchronize the meter’s clock 

with an external source*; Line Sync to use 

the frequency zero crossings to provide a 

time reference for the meter (this is the most common method to synchronize a 

meter’s clock)**; NTP if you have a Network Option card and want to use a 

Network Time Protocol Server for time synchronization***; and IRIG-B if you 

have a Gen 2 meter and an IRG1 (IRIG-B and Pulse Outputs) card.

  *EIG recommends that you set up a clock sync method unless there is a 

    specific reason to not do so. If the meter is not synchronized to either the line

    frequency or an NTP server, it will default to internal crystal. The Shark® 270

    meter’s internal clock has a low drift - between 6 and 15 seconds per month. 

  **Make sure to match the frequency to the meter’s frequency. If it is not the

      same, the line sync will not work. The default value is 50 Hz.

      If line sync is enabled, the duration for logged events that last 100 ms or

      less will be timestamped as 100 ms.

  ***You also need to set up the NTP server information for the Network card.

        See 26.5.1: Configuring a Network Card (INP100S), on page 26-90 for 

        instructions.

Note that the time sync method in use is shown on the meter’s front panel 
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display, in the Status bar, next to time: either C (clock sync); L (line sync); or N 

(NTP sync), as long as sync is active and working properly.

e. Set up the format for date 

and time display: select the 

format and the separator 

from the date and time pull-

down menus, e.g., Date: MM/

DD/YY format and - separator for 02-20-2016 and HH:MM:SS tt; with: separator 

for 12:28:29 PM. The Example field shows what your selections will look like, 

when implemented. 

3. To implement any changes, click the Update Device button to send the new 

profile to the meter.
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26.1.3: Configuring System Settings

Use the system settings to set up a meter ID, various system processing settings, and 

a Test Mode setting.

1. From the Tree Menu, click General Settings>System Settings. 

2. Make these settings:

a. Meter Identification: 

enter a name for the 

meter (Meter Designa-

tion setting). You can 

also use the Profile 

Name and User Memo 

field to enter other relevant information. Any memo entry will be displayed in 

the Memo field in the Main screen’s Status bar - see 2.2.2: Main Screen’s Status 

Bar, on page 2-8.



     Doc#    E107707                                            26-9

26: Shark® 270 Meter

Note that it is important to name each meter individually, since the meter name 

is used to name the log databases when logs are downloaded.

b. Using the up/down arrows, enter the 

amount of time in minutes that Test 

Mode should continue after the last 

user action (Exit Test Mode After setting). After this amount of time, the meter 

will return to its normal processing mode.

c. *VA/VAR Computation Method: Select either Vector Sum or 

Arithmetic Sum from the pull-down menu.

NOTE: There are two optional methods of VA/VAR Computation:

         Arithmetic Sum - the formula for this calculation is:

          Vector Sum - the formula for this calculation is: 

       Generally, the superior method for calculation is the Vectoral method;

       however, both methods are provided. 

      * Note that this setting replaces the previous Power setting in the Energy Scaling

         and Averaging Method screen.

3. To implement any changes, click the Update Device button to send the new 

profile to the meter.

VA VA VA VAT a b c= + +

VA W VART T T= +2 2
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26.1.4: Configuring Communication Settings

Use this screen to enter communication settings for the meter's two on-board ports: 

the Optical Port (COM 1) and RS485 Port (COM 2).

IMPORTANT! The settings on this screen are the current settings for communication. 

Any changes you make may affect communication between the Shark® meter and 

your PC. 

1. From the Tree Menu, click General Settings>Communications>Configure Serial 

Ports. 
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2. Make these settings:

a. COM 1 (Optical): enter the 

settings for the meter’s Optical 

port. The address defaults to 1, 

and can’t be changed. The other 

settings default as shown in this 

screen capture, but they may be 

changed by selecting another 

value from the pull-down menu 

for the field.   

• Protocol: the default is Modbus ASCII. The options are Modbus RTU or 
Modbus ASCII.

• Baud Rate: Options are 1200, 2400, 4800, 9600, 19200, 38400, 57600.

• Response Delay: 0 - 750 (50 msec increments). Response Delay is the 

delay the meter should use before responding to queries. If your connect-

ing device requires a delay before receiving information, use response 

delay to program the time to wait before the meter starts responding to 

queries.

• Parity: Odd, Even, or None.

• Optical Receive Mode: Inverted or Non-Inverted. Inverted Operation is 

used with the A9U and B10U optical readers. These readers can be pur-

chased from EIG’s online store: at www.electroind.com/shop.

b. COM 2 (RS-485): enter the 

settings for the meter’s stan-

dard RS485 port.

• Address:1 - 247 (Mod-

bus only; the address for 

DNP3 protocol is set 

during DNP Configuration 

- see 26.1.4.1.1: General Settings, on page 26-14)

• Protocol:Modbus RTU, Modbus ASCII or DNP3*.

https://electroind.com/shop/
https://electroind.com/shop/
https://electroind.com/shop/
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* Only one serial port can be selected for DNP3 support, due to DNP3 
restrictions. However, one Ethernet port can be set up for DNP3 in addi-
tion to the serial port.

• Baud Rate: 1200, 2400, 4800, 9600, 19200, 38400, 57600.

• Response Delay: 0 - 750 (50 msec increments)

Response Delay is the delay the meter should use before responding to 

queries. If your connecting device requires a delay before receiving infor-

mation, use response delay to program the time to wait before the meter 

starts responding to queries.

• Parity: Odd, Even, or None.

3. To implement any changes, click the Update Device button to send the new profile 

to the meter.

NOTE: If the meter’s sealing switch is enabled, you will be able to edit COM 2 set-

tings, only. the screen will look like the one shown below. See 6.11: Shark® 250/270 

Meter’s Security, on page 6-21, for details on programming restrictions when the 

Sealing Switch is enabled.
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26.1.4.1: DNP3 Configuration

If your meter supports DNP3 communication (V3 and above), there are additional set-
tings listed in the Communications tree. These settings let you customize DNP3 for 
your application needs. Note that the Modbus Map version must be 52 or above. In 
order for the DNP3 settings to be available, you must first enable DNP. You can enable 
DNP for either the RS485 port - see 26.1.4: Configuring Communication Settings, on 
page 26-10, or for an Ethernet Option card (INP100S) - see 26.5.1: Configuring a 
Network Card (INP100S), on page 26-90.

NOTES: 

•  See Appendix C in the Shark® 270 Meter User Manual for detailed information on 
settings, including the meter’s default settings, and example use cases.

•  Clicking the Save XML button in the DNP3 screens generates the DNP XML Profile. 
The DNP XML Profile is a file that contains the characteristics and configuration 
parameters set in the DNP3 screens, as well as data from the meter itself (serial 
numbers, channels, etc.). This file can be used to further configure other peers, 
e.g., the Master device, in the DNP3 Network. If you need a DNP XML Profile, EIG 

https://electroind.com/products/Shark_270/pdf/manuals/Shark%20270%20Revenue%20Energy%20Meter%20User%20Manual_E159708.pdf


     Doc#    E107707                                            26-14

26: Shark® 270 Meter

recommends you click the Save button after making all of your DNP3 settings. 
Refer to official DNP3 documentation for DNP3 Network details.

•  Formatting of energy and power values (number of digits, decimal point position, 

etc.) is used for display, only - DNP3 always uses the raw values from the Modbus 

register.

26.1.4.1.1: General Settings

The first setting is General Settings.

1. From the Tree menu, click DNP3 Configuration>General Settings. You will see the 

screen shown on the previous page. 

2. You have the following options:

•   You can click Load Defaults to load the settings from the meter.

•   You can enter the settings manually. 

•   You can edit any edit any of the settings.

•   You can clear the entries by clicking Clear.

3. The settings on this screen are:

•   DNP Slave Address: enter the DNP slave address for this meter. This is the 

address used with an RS485 serial link, only (not an Ethernet link).

•   Reply Confirm Timeout (ms): enter the reply confirmation timeout in millisec-

onds.

•   Unsolicited Messages: select Enabled to accept unsolicited messages. Note that 

the unsolicited messages are sent to the LAN only if the "Single Socket 

Enforced" option is enabled in the INP100S card’s DNP3 Support setting (see 

26.5.1: Configuring a Network Card (INP100S), on page 26-90). If this option is 

not enabled, DNP3 cannot send the unsolicited messages since it won’t know 

which meter socket to use.

•   Target Device for Unsolicited: select the address for the target device for unso-

licited messages. 

•   Unsolicited Timeout (ms): enter the unsolicited timeout in milliseconds.
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26.1.4.1.2: Time Synchronization

The second setting for DNP is Time Synchronization. Note that EIG recommends you 

use only one method for meter time synchronization: if you enable the DNP Time 

Sync and you have a Network card, do not use the NTP feature for the Network card.

1. From the Tree menu, click DNP3 Configuration>Time Synchronization. 

2. You have the following options:

•   You can load the default setting by clicking the Default button.

•   You can clear the entry by clicking Clear.

•   You can choose to allow time synchronization of the meter through DNP. When 
time synchronization is enabled, a Master must write the time into the meter. 
The time is updated frequently to reduce jitter and offsets. The options for time 
synchronization are:
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• Disabled - no time sync through DNP is allowed.

• From Serial - the time sync will be accepted from DNP only through the 
serial line (RS485 or other serial option).

• From Serial or Network Card - the time sync will be accepted from DNP 
serial or DNP network communication.

3. The Sync Renewal Time is the period the time is considered valid after the Master 

has written it into the meter. After this time, the Meter will flag NEED_TIME in its 

responses, to let other devices know that it needs a time update. 

4. The Send Null unsolicited message checkbox allows the meter to send a null 

unsolicited message when the valid time expires, letting other devices know, imme-

diately, about the need for time resynchronization. This is an additional feature 

which is not required by the DNP3 standard.



     Doc#    E107707                                            26-17

26: Shark® 270 Meter

26.1.4.1.3: Analog Inputs

The third setting for DNP is Analog Inputs, which are non-accumulator readings.

1. From the Tree menu, click DNP3 Configuration>Analog Inputs. 

2. You can make settings for Objects 30, 32, and 34 by clicking on the different tabs. 
The screen above shows the settings for Object 30. You have the following options:

•   You can load the default settings by clicking the Default button.

•   You can clear the entries by clicking Clear.

•   You can enter the Analog Input settings manually:

•Up to 64 points can be defined for DNP Analog Inputs. Select the reading 
you want to use from the pull-down menu, which lets you choose from 
groups of Measured Values, Demand, Harmonics, Angles and Basic setup 
parameters. For example, the reading Volt-A can be selected.

3. For the Object 30 tab:
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•   You can use the Scaling field to enter a multiplier value to change the magnitude 

of the reading for DNP. The scaling can be a positive fraction or integer; enter 1 

for no scaling.

• For example, you might want to scale the Volt-A reading, which has a

 full scale value of 600, to a higher range, e.g., 60000. To do that, you

 would set the Scaling value to 100. Scaling can also be used to scale

 down the value by using a fraction in the Scaling field. If no change is

 needed, the Scaling field must be left as 1.

•   The Class 0 column allows you to include or not include the reading in a DNP 

Class-0 response. This gives you a practical way to poll several readings at a 

time, through grouping them into a class query.

4. For the Object 32 tab (shown above):

• The Analog Event Object 32 is used as a capture placeholder (data storage) for 

dead banding events. Dead banding events are used when you want to know if 
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an Analog Input varies by more than a specified amount. The amount of allow-

able variation is called a deadband. If the Analog Input varies in an amount less 

than the deadband, nothing happens, since it is considered within limits. When-

ever the variation amount exceeds the deadband, a snapshot is taken of the 

Analog Input, i.e., the data is copied to the corresponding Object 32 and an 

event is flagged for that reading. This allows the user to later check on the Ana-

log Input value at the time of the event.

•   Object 32 can be also assigned to Class 1,2 or 3, allows creation of different 

groups for different events.
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5. For the Object 34 tab (shown above):

•   The deadband value is used for detecting the changes in the Analog Input. A 

value of 0 disables this feature. The deadband is always a positive number, but it 

checks for the absolute variation, either positive or negative. Note that if Scaling 

is used, the deadband will compare the Analog Input value after scaling has 

been applied.

NOTE: EIG recommends you do not set the deadband value too small, to avoid 

filling up the DNP Event Buffer with very minor fluctuations, causing bigger fluc-

tuations to be missed.
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26.1.4.1.4: Binary Counters

The fourth setting for DNP is Binary Counters, which are accumulator readings.

1. From the Tree menu, click DNP3 Configuration>Binary Counters. 

2. You can make settings for Objects 20, 21, and 22 by clicking on the different tabs. 

The screen above shows the settings for Object 20 Binary counter. You have the fol-

lowing options:

•   You can load the default settings by clicking the Default button.

•   You can clear the entries by clicking Clear.

•   You can enter the settings manually, for the binary counters:
• Select the reading you want to use from the Group and Reading pull-

down menu, e.g., Group - Uncompensated, Reading - Wh. 

3. For the Object 20 tab:
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•   You can use the Scaling field to enter a multiplier value to change the magnitude 

of the reading for DNP. The scaling can be a positive fraction or integer; enter 1 

to keep the reading’s scaling the same as in the meter.

•   The Class 0 column allows you to include or not include the counter in a DNP 

Class-0 response.

4. For the Object 21 tab (shown above):

•   Frozen Binary Counter Object 21 is a placeholder used when the meter is 

instructed to freeze the respective counter. In other words, when the meter 

receives the instruction to freeze counters, it copies the Binary Counter (Object 

20) into the Frozen Binary Counter (Object 21) placeholder, where it is kept 

available for the user to read. Only a new freeze will update the Frozen Binary 

Counter Object 21.
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•   The Frozen Binary Counter can be assigned to Class 0, only. (It does not have to 

be assigned to Class 0, though.)

•  Clear After Freeze is not supported. To clear the binary counters, Binary Output 

Point #4 must be Pulsed-On/Latched-On via Object 12, V1 - Direct Operate. 

(See Appendix C in the Shark® 270 Meter User Manual for details). Note that 

because the meter does not support clearing individual counters, all the binary 

counters will be cleared.

 

5. For the Object 22 tab (shown above):

•   Use the Change Delta field to set up a value in the same raw unit as the reading, 

which is used to define a threshold value for the counter. This threshold value 

instructs when to create an event for Binary Counter Event Object 22. Every 

time the Binary Counter changes by the value of the Change Delta field, or by a 

greater value, an event for Object 22 is created. If the Change Delta value is 0, 

changes for this reading are not monitored.
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•   The Binary Counter Event Object 22 can be assigned to Class 1,2 or 3.

NOTE: EIG recommends you do not set the Change Delta value too small, to 

avoid filling up the DNP Event Buffer with very minor fluctuations, causing bigger 

fluctuations to be missed.

26.1.4.1.5: DNP3 Auto-Freeze

The meter’s DNP implementation lets you freeze defined Object 20 and Object 30 

points automatically, on a periodic schedule, without needing to send the Freeze com-

mand through DNP. This feature is set up through the fifth DNP setting, DNP3 Auto 

Freeze, which copies the original Object 20 and Object 30 data points into Object 21 

and Object 31 data points, respectively, along with the time stamp of the copy pro-

cess. 

•  The Object 21 and Object 31 data points are also referred to as "previous" values: 

they belong to the previous Auto Freeze period.

•  If the meter loses power, the frozen points in Object 21 and Object 31 are pre-

served. 

•  Note that the frozen DNP points (Object 21 and Object 31) have the same scale and 

unit as their respective points in Object 20 and Object 30. 

•  For example, if point# 0 of Object 20 has been configured with Wh Total register 

and 0.001 scaling, reading point #0 of Object 20 will give us a KWh value. When 

the Auto Freeze period has elapsed, the value in reading point# 0 is copied into 

point #0 of Object 21. Further readings to point# 0 of Object 20 will show the cur-

rent KWh value (increasing, if there is energy flow), but the point# 0 of Object 21 

will stay frozen in its original value until the next Auto Freeze period has elapsed. At 

that point, the new KWh value will be written into the Object 21 point.
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1. From the Tree menu, click DNP3 Configuration>Auto Freeze. 

Note that if you haven’t enabled DNP3 Auto Freeze, the menu option will say Auto 

Freeze: Disabled; and if Auto Freeze is already enabled, it will say Auto Freeze: 

Enabled.

2. To enable Auto Freeze, check the Enabled box.

3. To set up the Auto Freeze period, i.e., the time the current values of objects 21 

and 31 are copied into the Frozen objects 21 and 31:

a. From the Period pull-down menu, select the Auto Freeze period, i.e., 

frequency: Monthly, Weekly, Daily, or Hourly.
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b. From the On pull-down menu, select the day of the month the Auto Freeze 

period starts: 1-31, or “Last Day of Month.” Note that if you selected 

Monthly as your period, you shouldn’t select a day that doesn’t exist in all 

months, since that would cause that month’s Auto Freeze to be disabled; 

e.g., if you select 30, February will be skipped. In that case, use the “Last 

Day of the Month” setting.

c. From the Time of Freeze pull-down menus, select the hour (0-23, using a 

24-hour clock, where 0 is midnight and 23 is 11 P.M.), and minute (0, 15, 

30, 45) the Auto Freeze period begins.

4. If you want the Maximum and Minimum Demand to be reset when Auto Freeze 

takes place, check the box. Note that this box will not be selectable if TOU is 

enabled.
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26.1.4.1.6: Binary Inputs

The next setting for DNP is Binary Inputs, which is used for the digital inputs from the 

meter’s ROIS (relay output/digital input) and/or POIS (pulse output/digital input) 

Option cards.

1. From the Tree menu, click DNP3 Configuration>Binary Inputs. 

You will only see settable fields if an Option card with digital inputs is installed in 

the meter. Note that the ROIS has two digital inputs and the POIS has four digital 

inputs. 

2. You have the following options:

•   You can load the default settings by clicking the Default button.

•   You can clear the entries by clicking Clear.
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•   You can enter the settings manually, for the Binary Inputs:

• For the Event Object 2 fields, select the Class you want to use: Class 0, 

which corresponds to Object 1 (static binary inputs), or Class 1, 2, or 3, 

which all correspond to Object 2 (binary input events).

• If Class 1,2 or 3 is assigned to the Binary Input Event Object 2, the

 Binary Input will be checked for changes. Every time the input 

 changes state, an event will be created and the value put into the

 Binary Input Event Object 2. This allows the user to later check on the

 value at the time of the event.

• Note that when you select a Class, the Allow in DNP3 box is checked 

automatically. If you uncheck the box, all selected classes will be 

unchecked.
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26.1.4.1.7: Binary Outputs

The next setting for DNP is Binary Outputs, which is used for the relay outputs of the 

ROIS Option card.

1. From the Tree menu, click DNP3 Configuration>Binary Outputs. 

NOTE: You will only see settable fields if at least one ROIS card is installed in the 

meter. You can have two ROIS cards installed in a meter.

2. You have the following options:

•   You can load the default settings by clicking the Default button.

•   You can clear the entries by clicking Clear.

•   You can enter the settings manually, for the binary outputs:

• Under Object 12 Allow in DNP, click the checkbox next to any relay output 
you want to be accessed through DNP.
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• For the Object 12 Class 0 fields, Class 0 corresponds to Object 10 (static 
output state).

• The relay outputs require a Select before Operate procedure through DNP 
in order to change them. If instead you want the relay output to be 
pulsed directly, set up Direct Operate for the options listed: Reset Energy 
Counters, Change to Modbus Protocol, Reset Demand Counters, and Man-
ual Waveform Capture. 

• Select a timeout in milliseconds. The timeout is the maximum time 
allowed between the select command being issued and the relay being 
operated.

NOTES on Binary Output Points

Relay Card
Physical 

Output

DNP 

Point
Actions Action Mode Notes

Slot #1
1 0 Latch On / Latch Off  Select Before Operate Physical Relay

2 1 Latch On / Latch Off  Select Before Operate Physical Relay

Slot #2
1 2 Latch On / Latch Off  Select Before Operate Physical Relay

2 3 Latch On / Latch Off  Select Before Operate Physical Relay

Reset Energy 4 Latch On / Pulse On Direct Operate Automatically cleared

Switch RS485 

to Modbus 

RTU

5 Latch On / Pulse On Direct Operate Automatically cleared

Reset Demand 

Counters
6 Latch On / Pulse On Direct Operate Automatically cleared

Trigger 

Waveform 

Capture

7 Latch On / Pulse On Direct Operate Automatically cleared
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Possible Errors When Operating an Output Point Between 0 and 3

Possible Errors When Operating an Output Point Between 4 and 7

Possible Errors Using Select Before Operate command

Error If …

Not Supported

Actions other than Latch‐On or Latch‐Off were issued (Trip, Close, 

Pulse, etc.)

Not Supported Trying to select any DNP3 Output point out of range (0 to 3)

Not Supported

Trying to select a point between 0 and 3, but the corresponding Relay 

Card is not installed

Local

Trying to select an output point that is being used by ElectroLogicTM 

Relay Control (configured in Device profile)

Local

Trying to select an output point that has not been allowed in the DNP 

profile

Accepted Point selected

Error If …

Not Supported Actions other than Latch‐On or Latch‐Off were issued (Trip, Close,Pulse, etc.)

Not Supported

Trying to operate a point between 0 and 3, but the corresponding Relay Card is 

not installed.

Local

Trying to operate an output point that is being used by the ElectroLogicTM Relay 

Control (configured in Device profile)

Local Trying to operate an output point that has not been allowed in the DNP profile

No Select Trying to operate an output which has not been previously selected

Accepted Point selected

Error If …

Not Supported Trying to select any DNP3 Output point out of range (8 or larger)

Not Supported Actions other than Latch‐On or Latch‐Off were issued (Trip, Close, Pulse, etc.)

Not Supported
Trying to operate point 7 (waveform capture) but there is no log memory 

allocated for waveforms

Local Trying to operate an output point that has not been allowed in the DNP profile

Timeout Trying to operate point 4 (reset energy) when the meter has not warmed up yet

Timeout
Trying to operate point 7 (waveform capture) when there is a capture already in 

progress

Not Authorized
Other functionality is solely responsible for reseting energy (TOU, AutoFreeze, 

etc.) or Security settings do not allow it (Seal switch)
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26.1.4.1.8: Strings 

The next setting for DNP is Strings, which is used to set up reporting of static informa-

tion, such as meter model.

1. From the Tree menu, click DNP3 Configuration>Strings. 

2. You have the following options:

•   You can load the default settings by clicking the Default button.

•   You can clear the entries by clicking Clear.

•   You can enter the settings manually, for the strings:

• Points 0, 2 and 3 are hard-coded and fixed in the meter.

• Point 1 can be configured in the meter’s Device Profile. See 26.1.3: Con-
figuring System Settings, on page 26-8.
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• Point 4 is an editable string, which you can enter. The maximum number 
of characters you can use is 16.

• The only assignable class for the strings is Class 0. Click the checkbox to 
assign any of the strings to Class 0.

26.1.4.1.9: Default Variations

The last setting for DNP is Default Variations, which is used to configure the variations 

used by the meter for each object when Variation 0 is requested by a query. Note that 

there are default configurations already set up in the meter for Variation 0, but this 

setting lets you change them. Refer to Appendix C in the Shark® 270 Meter Installa-

tion and Operation Manual for details on this setting.

1.From the Tree menu, click DNP3 Configuration>Default Variations. 

2. For each of the objects listed under Global Values, you can select the Variation 

number you want to use by clicking in the Variation line and choosing the variation.
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•   Some objects have more than one type (i.e., Float, 16-Bit, or 32-bit), depending 

on the reading being mapped. If you need to program a different variation for an 

object depending on its type, uncheck the Simple Mode box. Then you can 

assign a variation to each type, individually. See the example configuration for 

Object 30, Analog Inputs, below; each of the object’s types has been pro-

grammed with a different default Variation.

 

•   If you want to set the same variation for all of an object’s types, check the 

Simple Mode box and select the variation for the object.
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26.1.5: Custom Modbus Map (Shark® 270 Meter Gen 2 Only)

The Shark® 270 Gen 2 meter’s Modbus map has a configurable section in which any 

available reading can be assigned a Modbus address. (See the Shark® 270 Meter 

User Manual for details about the Shark® 270 meter’s Gen 2.)

•  The customizable section starts at address 0x1700. 

•  Up to 256 data points can be configured for this section. 

•  The custom Modbus section can only be read using Modbus commands.

•  See the Shark® 270 Meter Modbus Protocol Application Guide for complete 

information on the meter’s Modbus map.
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1. From the meter’s device profile screen, click General Settings>Custom Modbus 

Map.

2. Any registers already created are shown. 

•  To clear a register item, click on the item and click Clear Item.

IMPORTANT! Do not leave any blank rows between items. If you delete an 

item, either enter another channel in that row, or move the channels up to fill 

the deleted item’s row.

•  To clear all of the register items, click the Clear All button.

3. To add a register, double-click in an empty row.
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4. Use the screen above to select the measured reading you want to use for the regis-

ter and the formatting for the register. Enter the following:
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a. Group: Choose a reading group from the menu items.

b. Sub Group: Choose a reading sub group from the menu items.

c. Channel: Choose a reading from the menu items (use the scroll bar to see all of 

the readings).
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d. Format: Choose a data format for the register.

e. Data Size: Choose either 2 bytes or 4 bytes for the register’s data size.

f. Unit: Choose the unit you want applied to the register. The unit is a multiplier that 

will change the value; e.g., if you select 10, this register value will be multiplied 

by 10.

Unsigned Integer = a whole number (not fraction) between 0 and 65535
Signed Integer = a whole number between -32768 and 32767
Float = a real number with decimal points  
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g. Byte Order: Choose the order you want applied to the register bytes from the 

menu. 

h. Primary/Secondary: Choose whether this energy value is in primary or second-

ary.

i. Absolute Value: Choose Yes or No from the menu. If you choose Yes, a signed 

integer value is read as unsigned.

5. Click OK to save the register and go back to the Custom Modbus map screen. You 

can continue adding registers.

IMPORTANT! Do not leave any blank rows between items.

6. To implement any changes, click the Update Device button to send the new profile 

to the meter

 MSW = most significant word
 LSW = least significant word
 MSB = most significant byte
 LSB = least significant byte
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26.2: Revenue and Energy Settings

From the Tree Menu on the left side of the Shark® 270 meter’s Device Profile screen, 

double-click on the Revenue and Energy Settings line or click on the + button next to 

it. The settings in the Revenue and Energy Settings group are listed. 

26.2.1: Configuring Energy, Power Scaling, and Averaging Method

1. From the Tree Menu, click Revenue & Energy Settings> Energy Scaling and Averag-

ing Method to display the screen shown above. Use this setting to configure: 

•  The display and storage of energy and power registers in the meter.

•  The method of demand averaging and the interval over which average values are 

computed.
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Functional Overview of Energy Scaling, Power Scaling, and Averaging:

•  Energy Scaling

Energy scale setting includes:

Digits (the number of digits in the reading)

Decimals (the number of decimal places in the reading)

Scaling: the scale of the reading - unit; kilo (number times 1000); Mega (number 

times 1 million)

Energy settings allow you to balance the resolution (or accuracy) of the energy 

stored, with the interval over which energy rollover occurs. For example, the 

maximum resolution for a k scale reading is: 99999.999k.

To calculate the speed at which the energy will rollover, you must know the Power 

Full Scale, which is computed from the CT and PT Full Scale values (see 26.1.1: 

Configuring CT, PT Ratios and System Hookup, on page 26-2). The formula for cal-

culating Power Full Scale is:

Wye system: CT Full Scale x PT Full Scale x 3 

Delta system: CT Full Scale x PT Full Scale x 3 x 

For example, for a CT Full Scale of 2000, PT Full Scale of 14400, Wye system:

2000 x 14400 x 3=86400000

In this example, the energy will increment at 86400000 Watts per hour, or 24000 

Watts per second.

This value allows you to determine the number of digits, decimal places, and 

energy scale you want to configure for the Energy settings, when you take into 

account the rollover time. 

To determine the number of hours before rollover, use this formula:

[Max Resolution]/[Full Scale] = #Hours, where Max Resolution = maximum digits 

and decimals for the Energy scale in use. 

Using the previous example, with an energy scale of Mega, the formula would be:

99999.999 M/86.4 M = 1157.4074 hours or about 48 days until rollover. 

NOTE: To increase the number of days until rollover, you can increase the number 

of digits (to 8), decrease the number of decimal places (to 0), or increase the 

Energy Scale (to M).

3
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•  Power Scaling

Power scale setting includes:

Decimals (the number of decimal places in the reading)

Scaling: the scale of the reading - unit; kilo (number times 1000); Mega (number 

times 1 million)

•  Demand Averaging 

Demand is the average rate of energy use over time. The Shark® 270 meter 

supports two types of demand averaging: Block demand and Rolling demand.

Block demand records the average demand for time intervals that you define (

usually 5, 15 or 30 minutes). 

Rolling demand functions like multiple, overlapping Block demands. You define the 

subintervals at which an average of demand is calculated. An example of Rolling 

demand would be a 15-minute Demand block using 5-minute subintervals, thus 

providing a new demand reading every 5 minutes, based on the last 15 minutes. 
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•  Note that the Gen 2 and the original Shark® 270 meter have slightly different 

screens. 

                  Original Shark® 270 Meter’s Energy Scaling
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         Shark 270 Gen 2 Meter’s Energy Scaling and Averaging
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2. Make these settings:

a. Energy Demand Format/Energy Format: for each of the values Watt Hour 

and VA Hour, VAR Hour, Volt Hour and V2T Hour, Amp Hour and I2T Hour, 

Q Hour, Cumulative and Continuous Demand, and Secondary Energy set 

the following, using the pull-down menus:

• Digits: 5; 6; 7; 8. 

• Decimals: 0 - 6. Note that if the entry would cause the accumulator to 

roll over quickly, the Example will be shown in red and there will be this 

note:

• Scaling: unit; kilo (K); Mega (M).
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• Show Leading Zeros: check the box if you want leading zeros to show; 

e.g., if a value has five digits and zero decimals, and the reading is 400, if 

you select show leading zeros the reading would be 0400.

•The Example field shows the result of your choices: e.g., a reading for 
Digits: 8; Decimals: 3; Scale: K would be formatted: 00123.456k.

• Check the box next to “Make all accumulators absolute value” if you need 

to log all energy values as positive energy.

IMPORTANT! If you select this option, you must reset energy after 

updating the meter, to clear previous energy readings. 

• Gen 2 has an additional setting: “Use different display multipliers from 

meter energy scaling.” Check this box if you need the display scaling to be 

different from what the meter uses (this is an uncommon situation). See 

26.8: Custom Display Multipliers, on page 26-148 for instructions on set-

ting up the display scaling.

       NOTES: 

• Your selection in the Energy Scaling fields determines the precision of 

energy stored for display and polling. Refer to the Functional Overview at 

the beginning of this section for more information.

• If you are changing the energy scaling settings, we recommend you first 

reset the energy accumulators, in order to prevent erroneous counts. See 

20.1.7: Reset Device Information, on page 20-7, for instructions on 

resetting the Shark® 270 meter's energy accumulators.

b. Decimal Separator: this is the sym-

bol used between whole numbers 

and decimals. The default setting is 

a period (e.g., 24.3), but if your country uses a comma as a decimal separator 

(e.g., 24,3), click on the Comma radio button to select it. Note that this setting 

only affects the display, since the CommunicatorPQA® software uses the Oper-

ating System’s internal settings. 
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c. Demand Averaging: select the demand 

averaging type you want from the from 

the pull-down menu: 

• If you select Block, select the 
number of minutes in the block 
from the Interval 
(Minutes) pull-down menu. 

• If you select Rolling, you will see 
the bottom screen on the right. 
Select the number of minutes in the 
sub-interval from the Sub-Interval 
(Minutes) pull-down menu (the 
choices are 3; 5; 15; 30; 60); and 
then select the number of sub-
intervals you want from the # of Sub-Intervals pull-down menu (the 
choices are 1; 2; 3; 4; 5). The Interval Window field is display only. It is 
the product of the values entered in the Sub-Interval and # of Subinter-
vals fields.

d. Power/Demand: select the number of Decimals (0. 1. 2. or 3) and Scaling 

(Unit, kilo, Mega, or Auto) that you want to use for power and demand 

readings.

e. Gen 2 has an additional setting - 

Custom Energy Interval. To set an 

energy interval that is different from 

the Demand interval, check the “Use 

custom interval for energy box” and 

then select 1, 3, 5, 15, 0, or 60 from the Minutes field.

IMPORTANT! When you check the box you will see the following warning 

message.
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• If you are certain you want to proceed, click Yes and make your setting.

• If you do not want to continue, click No or Cancel. 

• If you do not use this setting, the meter will use the interval set for 
Demand Averaging, which is displayed in the Interval field for Block 
Demand and the Interval Window field for Rolling Demand.

NOTES: 

•  Unless you selected the option in step e, the setting in the demand averaging/inter-

val window is also used for the energy in the interval readings.

•  If you have set an Input to trigger EOI demand averaging (using either a Relay Out-

put/Digital Input or Pulse Output/Digital Input Option card) any entry you make in 

the Demand Averaging field will be ignored. A message to that effect appears on 

the screen. See 26.5.3: Configuring a Digital Relay Card (RO1S), on page 26-103 

and 26.5.4: Configuring a Digital Input/Pulse Output Card (PO1S), on page 26-109, 

for instructions on setting EOI pulse for demand averaging. 

3. To implement any changes, click the Update Device button to send the new profile 

to the meter.

26.2.2: Power and Energy Labeling

This setting matches the direction of power for the meter to that of the electrical 

system being measured. Use it to designate the system as an inductive (lagging) 

load, with current lagging voltage; or as a capacitative (leading) load with current 

leading voltage. 

Power direction for the meter is determined by setting the power quadrants as lagging 

or leading; setting the sign order for power and energy readings, such as watt/watt-

hour; and setting the quadrant labels as received or delivered. This setting insures 

that the meter’s power measurements match the electrical system. There are exam-

ples of different power direction settings, after the instructions.
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1. From the Tree Menu, click Revenue & Energy Settings> Power and Energy Labeling.

2. Make these settings:

a. Current Phase Angle Direc-

tions: designate each of the 4 

energy quadrants, Q1, Q2, 

Q3, Q4, as Lead(ing) or 

Lag(ging). 

b. Quadrant Sign 

Order: 

designate the posi-

tive and negative 

power quadrants 

for W/Wh, VAR/VARh, and Power Factor.
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c. Quadrant Labels: 

designate the 

Power Quadrants 

as Delivered or 

Received.

d. See the examples of different quadrant settings on the next two pages.

3. To implement any changes, click the Update Device button to send the new profile 

to the meter.

Example 1 
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Example 1 settings are illustrated below. 

Example 2 
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Example 2 settings are illustrated below.

26.2.3: Cold Load Pickup (Demand Forgiveness)

The Shark® 270 meter offers Cold Load Pickup, so that in case a power system out-

age or excessive power system voltage drop occurs, when normal service is resumed, 

the customer will not be billed for the initial surge or in-rush of power to feed its “cold 

loads.” During the initial time period immediately following the return of normal elec-

tric service, the demand is not computed in the Demand Registers if the two threshold 

conditions described below are met, so the customer is not billed for possible exces-

sive demand due to “cold load pickup.”

•  A power system outage which drops the metering potential inputs to the meter (to 

below a programmed threshold) and also drops the meter’s power.

•  A power system outage which drops the metering potential inputs to the Meter (to 

below a programmed threshold), but the meter’s external power remains supplied 

by an alternate source (e.g., station battery, station service, etc.), that is, the 

meter continues to operate.

Note that energy is always continuously measured and is also recorded in the Power 

Profile Logs, if so configured (see 26.4.2: Configuring Historical Logs, on page 26-82, 

for log setup procedures).
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1. From the Tree Menu, click Revenue & Energy Settings> Power and Energy Labeling. 

Use this setting to enable and configure the meter’s cold load pickup/demand 

forgiveness feature. When enabled, this feature lets you set the amount of time 

power is off to identify a power outage that is the responsibility of the utility (as 

opposed to a very short term loss of power that is not their responsibility) and the 

amount of time you want to wait before demand starts again. This time should cor-

respond to the “grace” period the utility applies to avoid charging for motor startup, 

etc. after a power outage.
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2. Make these settings:

a. Click Apply delay if 

Meter’s Auxiliary 

Power is Lost. The 

Intervals fields dis-

play on the screen.

• Demand 

Forgiveness 

Interval: use 

the up and 

down arrows 

to

• Minimum Loss of Service: use the up and down arrows to set a minimum 

time that service is lost before Cold Load is implemented.

• Maximum Allowed Service On-Time: use the up and down arrows to 

select the time.

b. Click Apply Delay if 

Meter Potential Volt-

age Drops Below 

threshold. The Inter-

vals and Thresholds 

(Secondary) fields 

display on the screen.

• You can select 

to apply the 

threshold to 

either all 

phases (click 

On All Phases 

radio button) 

or any of the phases (click On Any Phase radio button).
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• Make the Intervals settings the same as in step a.

• Set the thresholds: use the up and down arrows to enter the percentage 

drop for each phase A-N, B-N, C-N.

3. To implement any changes, click the Update Device button to send the new profile 

to the meter.

26.2.4: Transformer/Line Loss Compensation

Transformer losses are power used by the transformer while working. The more load 

on the transformer, the higher the transformer losses. There are two types of trans-

former losses:

•   No load losses - these are the fixed losses that keep the transformer up and 

running.

•   Load losses - these vary with changes in the load.

When the meter is located on the secondary side of a customer’s transformer, a utility 

will want to add the transformer losses into the energy usage calculation. However, 

this practice is regulated by local jurisdiction and regulations. The meter has the 

capability to add in or subtract out these transformer losses, depending on the user’s 

specific needs.

Line losses are similar to transformer losses, except that they are used to compensate 

for loss incurred on wires, such as transmission lines.

Transformer/Line Loss Compensation allows you to add or subtract transformer and/

or line losses to meter registration.
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1. From the Tree Menu, click Revenue & Energy Settings>Transformer/Line Loss 

Compensation.

2. Make these settings:

a. Use the first pull-down menu at 

the bottom of the screen to enable 

TLC for iron (Fe) and/or copper 

(Cu), or to disable TLC for the 

meter. Click the option you want.

b. Use the second pull-down menu 

at the bottom of the screen to 

specify how the compensation 

should be made; e.g., Add to 

Watts and Subtract from VARs. 

Click the option you want.
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c. Click TLC Calculator to find the values to enter into the Percent Loss fields at the 

top of the screen. The TLC Calculator button launches the TLC Calculator that 

makes the calculations for you once you enter the required data.   

NOTE: Appendix A contains screen captures of the Loss Calculator with example 

numbers, and an explanation of Loss Compensation considerations.

d. Enter the percent Loss of Watts and VARS for copper and iron in the appropriate 

fields:     

• Percent Loss 

of Watts: 

enter the per-

centage of 

positive or negative watts due to iron and/or copper losses.

• Percent Loss 

of VARs: enter 

the percent-

age of posi-

tive or negative watts due to iron and/or copper losses.

3. To implement any changes, click the Update Device button to send the new profile 

to the meter.
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26.2.5: Pulse Factors

Pulse factors are the weight of a KYZ pulse for energy consumed. The meter uses 

pulses for energy accuracy testing, KYZ pulse outputs, and for load profiling of accu-

mulated energy over demand intervals. The pulse weights are assigned in this Device 

Profile setting. There are two settings for Pulse Factors - Test, for setting the Test 

pulses; and Internal Accumulators, for setting the pulses for energy accumulators.

26.2.5.1: Test Pulse Factors

1. From the Tree Menu, click Revenue & Energy Settings>Pulse Factors>Test. Use this 

screen to set the Test pulse factors. 

2. For each of the Test pulses, enter the pulse weight you want to assign to it. The 

pulse weight must be between 0.01000 and 9.99999.

3. For Test Pulse 2 you can also select the energy channel and phase or total value 

from the pull-down menu.

NOTE: In the meter’s Test Mode the Energy measurement used for IR Pulse 2 (Q) 

is always total VARh, irrespective of the setting in this screen. Refer to Chapter 3 in 

the Shark® 270 Meter Installation and Operation Manual for more details and spe-

cific pulse configuration instructions.

https://electroind.com/products/Shark_270/pdf/manuals/Shark%20270%20Revenue%20Energy%20Meter%20User%20Manual_E159708.pdf
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4. To implement any changes, click the Update Device button to send the new profile 

to the meter.

26.2.5.2: Internal Accumulator Pulse Factors

1. From the Tree Menu, click Revenue & Energy Settings>Pulse Factors>Internal 

Accumulators. 

2. For each of the energy reading accumulators, enter the pulse weight you want to 

assign to it. The pulse weight must be between 0.00001 and 9.99999.

3. From the pull-down menu, select pulse computation based on Primary or Second-

ary readings.

4. To implement any changes, click the Update Device button to send the new profile 

to the meter.
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26.2.6: CT and PT Compensation

CT/PT compensation is used to correct for errors caused by the current transformers 

(CTs) (external to the meter) and Potential/Voltage transformers (PTs) connected to 

the meter. 

From the Tree Menu, click Revenue and 

Energy Settings>CT & PT Compensation. 

Two options open under CT & PT Compen-

sation: Compensate CTs and Compensate PTs. Use these settings to enable and set 

compensation factors for the meter.
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26.2.6.1: Compensate CTs

The first CT & PT Compensation setting option is Compensate CTs.

1. From the Tree menu, click CT & PT Compensation>Compensate CTs.

2. Make sure the Enable CT & PT Compensation in Meter box is checked. If it is not, 

any settings you enter won’t be implemented. The top of the screen shows the 

system frequency and the CT ratio (see 26.1.1: Configuring CT, PT Ratios and Sys-

tem Hookup, on page 26-2). Make these settings:

a. The first screen you see displays the settings for Phase A CT compensation. Click 

the Next Phase button at the bottom of the screen to enter settings for phases B 

and C.
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b. For each of the phases, enter up to 8 points of % of rated current, ratio correc-

tion factor (.08500 to 1.1500), or phase error/arcminutes (-60 to +60). The 

Value (A) field displays the current value for the “% of rated current” setting you 

entered. For example, if the current Full Scale is 5 A, and you enter 0.01% in the 

“% of rated current field,” the value will be 0.0005 A. Refer to your CT manufac-

turer’s documentation for the values to enter on this screen.

• If you don’t want to use a test point, enter 0% for the rated current.

c. Continue to the next phase and repeat step 2b. 

3. To implement any changes, click the Update Device button to send the new profile 

to the meter.
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26.2.6.2: Compensate PTs

The second CT & PT Compensation setting option is Compensate PTs.

1. From the Tree menu, click CT & PT Compensation>Compensate PTs.

2. Make sure the Enable CT & PT Compensation in Meter box is checked. If it is not, 

any settings you enter won’t be implemented. The top of the screen shows the 

system frequency and PT ratio (see 26.1.1: Configuring CT, PT Ratios and System 

Hookup, on page 26-2). Make these settings:

a. The first screen you see displays the settings for Phase A PT compensation. Click 

the Next Phase button at the bottom of the screen to enter settings for phases B 

and C.
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b. For each of the phases, enter up to 4 test points of % of rated voltage, ratio 

correction factor (0.8500 to 1.1500), or phase error/arcminutes (-60 to +60). 

The Value (V) field displays the voltage value for the “% of rated voltage” setting 

you entered. For example, if you entered 0.01% of the rated voltage, the value 

will be 0.060 V if the PT Ratio is 600:600. Refer to your PT manufacturer’s docu-

mentation for the values to enter on this screen.

• If you don’t want to use a test point, enter 0% for the rated voltage.

c. Continue to the next phase and repeat step 2b. 

3. To implement any changes, click the Update Device button to send the new profile 

to the meter.
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26.2.7: Time of Use Setting

The Shark® 270 meter offers Time of Use. See Chapter 15: Time of Use, on page 15-

1, for instructions. To enable or disable, Time of Use for the meter:

1. Click Revenue & Energy Settings>Time of Use.

2. Check the box to enable Time of Use; uncheck the box if you want to disable it.

3. To implement any changes, click the Update Device button to send the new profile 

to the meter.
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26.2.8: Aggregators Setting

Aggregators are registers that hold the sum/difference of data from multiple sources, 

internal and external. An example use for an aggregator is to totalize pulses from 

different meters. The Shark® 270 meter offers four aggregators. The aggregators get 

data from two sources: 1. an input that is set up as an accumulator (see 26.5.3: Con-

figuring a Digital Relay Card (RO1S), on page 26-103 and 26.5.4: Configuring a Digi-

tal Input/Pulse Output Card (PO1S), on page 26-109) and 2. one of the meter’s 

energy registers. The value of the Input accumulator(s) and of the energy register 

can either be added to, or subtracted from, the aggregator. 

The Pulse Output/Digital Input card has four inputs and the Relay Output/Digital Input 

card has two inputs. Each aggregator can hold the addition/subtraction of one to eight 

of the digital inputs and 1 energy register listed in the table below and on the follow-

ing page.

Energy (Compensated & 
Uncompensated)

It, Phase A

It, Phase B

It, Phase C

Vt, Phase A-N

Vt, Phase B-N

Vt, Phase C-N

Vt, Phase A-B

Vt, Phase B-C

Vt, Phase C-A

Wh, (Q1+Q4)

Wh, (Q2+Q3)

VARh, (Q1+Q2)

VARh, (Q3+Q4)

VAh, Total

Quadrant 1 Wh, Total

Quadrant 1 VARh, Total

Quadrant 1 VAh, Total
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Quadrant 2 Wh, Total

Quadrant 2 VARh, Total

Quadrant 2 VAh, Total

Quadrant 3 Wh, Total

Quadrant 3 VARh, Total

Quadrant 3 VAh, Total

Quadrant 4 Wh, Total

Quadrant 4 VARh, Total

Quadrant 4 VAh, Total

VAh (Q1+Q4), Total

VAh (Q2+Q3), Total

+Qh, Total

-Qh, Total

Energy (Compensated & 
Uncompensated)
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1. To set up aggregators, click Revenue and Energy Settings>Aggregators>Aggrega-

tor (1-4). All four aggregators are set up the same way.

NOTE: The Shark® 270 meter Gen 2 has an extra setting for the display format-

ting. See step 4 on the next page.

2. In the Source section you set up the Input and the Energy register to use:

a. Depending on the Option card(s) installed in the meter, you will see between 

none and eight Option card Inputs listed. Click the checkbox to the left of any 

Inputs you want to use in the aggregator. The scaling and label for that accumu-

lator is listed to the right of the Input’s field.

IMPORTANT! The Input must be assigned as an accumulator. See 26.5.3: Con-

figuring a Digital Relay Card (RO1S), on page 26-103 and 26.5.4: Configuring a 

Digital Input/Pulse Output Card (PO1S), on page 26-109, for instructions on set-

ting up an Input as an accumulator.
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b. Select Add or Subtract from the pull-down menu next to each Input you are 

using. Add means that you want to add the Input accumulator value to the 

aggregator; subtract means you want to subtract the Input accumulator value 

from the aggregator.

c. Click the checkbox to the left of Meter Energy and select the energy register you 

want to use from the pull-down menu. The top menu lets you select the Energy 

type, e.g., Scaled Energy, and the bottom menu lets you select the energy regis-

ter, e.g., Wh Delivered. 

d. Select Add or Subtract from the pull-down menu next to the Meter Energy field. 

Add means that you want to add the Energy value to the aggregator; subtract 

means you want to subtract the Energy value from the aggregator.

3. In the Format section you set up the energy format and label for the aggregator: 

a. Select the number of digits (5-8), decimals (0-6), and scaling (kilo or Mega), 

from the pull-down menus.

b. If you want to show leading zeros, click the checkbox. 

c. The Example field shows what your formatting choices will look like.

d. Enter a label for the aggregator. The label can be up to 32 characters.

4. The Shark® 270 Gen 2 meter has another field that gives you the option of setting 

a separate scaling for the display than for the meter’s readings (see the energy 

scaling explanation in 26.2.1: Configuring Energy, Power Scaling, and Averaging 

Method, on page 26-41). 

a. To set the display scaling, enter the following:

• Digits: 5; 6; 7; 8. 
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• Decimals: 0 - 6. 

• Scaling: unit; kilo (K); Mega (M).

b. Show Leading Zeros: check the box if you want leading zeros to show; e.g., 

if a value has five digits and zero decimals, and the reading is 400, if you 

select show leading zeros the reading would be 0400.

c. The Example field shows the result of your choices: e.g., a reading for Dig-

its: 8; Decimals: 3; Scale: K would be formatted: 00123.456k.

5. To implement any changes, click the Update Device button to send the new profile 

to the meter.
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26.3: Power Quality and Alarm Limit Settings 

1. From the Tree Menu on the left side of the Shark® 270 meter’s Device Profile 

screen, double-click on the Power Quality and Alarm Limit Settings line or click on 

the + button next to it. The settings in the Power Quality and Alarms Settings 

group are listed: Limits and Waveform/PQ. Note that you will only see the Wave-

form/PQ setting if your meter has V-SwitchTM key 4 or above.
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26.3.1: Configuring Limits 

Functional Overview for Limits:

Limits are transition points used to divide acceptable and unacceptable measure-

ments. When a value goes above or below the limit, an out-of-limit condition occurs. 

You can set and configure up to 16 Limits for the Shark® 270 meter.

Once they are configured, you can view the out-of-Limits (or Alarm) conditions in the 

Limits Log (see Chapter 19) or Limits Polling screen (see Chapter 5). You can also use 

Limits to trigger relays.

1. From the Tree Menu, click Power Quality and Alarm Settings>Limits. The current 

settings for Limits are shown in the screen (see screen on the previous page). Use 

this screen to assign Limits for the Shark® 270 meter. 

2. To set up a limit:

a. Click the arrow in the Assigned Channel field to open a window that lets you 

select the channel you want to place a limit on, from Group, Sub Group and Item 

submenus. 

b. Click the arrow in the Group field to select the group the reading you want 

belongs to.

c. Click the arrow in the Sub Group field to select the sub group your reading 

belongs to (note that the Average Demand group doesn’t have any sub 

groups).

d. Click the arrow in the Item field to select the reading you want to set a limit 

for.

Click Here

Window
Opens

Click to See Groups

Click to See Sub Groups

Click to See Readings
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e. Click OK. The channel you selected is now displayed in the Assigned chan-

nel field.

f. You set the limit as a percentage of the Full Scale value of the channel. (The 

Full Scale values are displayed at the bottom of the screen.)

Program the percentage of the Full Scale that will trigger the limit, for both 

the Above limit setpoint and the Below limit setpoint. The Primary field is 

display only, and shows the actual setpoint value. 

As seen in the example screen below, the Voltage Full Scale is 600. For the 

first limit of A -N voltage, the above setpoint is 110% of full scale, which is 

660 V. The below setpoint is 90% of full scale, which is 540 V. This means 

that: if an A-N reading is greater than 660 V or lower than 540 V, it will 

trigger this limit.
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g. You also set the return hysteresis as a percentage of the Full Scale. The 

Primary field is display only, and shows what the hysteresis value actually 

is. Return Hysteresis is the value at which the limit’s status changes from 

out of limit to within limit: see the following figure.

Program the percentage of the Full Scale that will be considered back 

within limit, for both the Above limit return hysteresis and the Below limit 

return hysteresis. 

As seen in the previous example screen, the Voltage Full Scale is 600. For 

the first limit of A -N voltage, the above return hysteresis is 108% of full 

scale, which is 648 V. The below return hysteresis is 92% of full scale, 

which is 552 V. This means that: if an A-N reading was greater than the 

Above limit setpoint (660 V), it will be back within limit at 648 V; and if am 

A-N reading was lower than the Below limit setpoint (540 V), it will be back 

within limit at 552 V.

    NOTES: 

•   If the Above Return Hysteresis is greater than the Above Set Point, the Above 

Limit is Disabled; if the Below Return Hysteresis is less than the Below Set Point, 

the Below Limit is Disabled. You may want to use this feature to disable either 

the Above Limit or Below Limit condition for a reading.

TIME

Above Limit 
condition

Below Limit 
condition

Above Limit Trigger point

Return point from Above Limit  condition

Below Limit Trigger point

Return point from Below Limit  condition

HYSTERESIS

HYSTERESIS

- MEASURED VALUE
(if applicable)

+ MEASURED VALUE

0
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•   If you are entering negative limits, be aware that the negative value affects the 

way the above and below limits function, since negative numbers are processed 

as signed values.

•   EIG recommends you do not make the set points and hysteresis values too close 

to the reading’s Primary value, e.g., an Above Set Point of 101%, or a Hysteresis 

value of 99%. If these settings are too close to the Primary value you may flood 

the Limits log with very minor fluctuations, causing bigger fluctuations to be 

missed. The software highlights the Limit ID in red if the setting is considered 

outside of the recommended range.

8. To implement any changes, click the Update Device icon to send the new profile to 

the meter.

26.3.2: Configuring Waveform/PQ (with V4 and V5)

The Shark® 270 meter is V-SwitchTM key upgradeable. If you have purchased V-

SwitchTM keys 4 or 5, the waveform recording feature will be available with your 

meter. The Waveform/PQ capability allows the meter to act as a high-speed waveform 

recorder to record any anomaly that occurs within a cycle of duration. This provides a 

user with advanced waveform analysis including pre- and post- waveform recording. 

The meter has the capability to record both surges and sags of the measured signals. 

A voltage surge is any event that increases the RMS voltage for one cycle, calculated 

every half cycle. A voltage sag is a dip in the RMS of one cycle of voltage, calculated 

every half cycle. A current fault (or surge) is also calculated in the same manner. 

When the RMS value of any of these triggers exceeds the threshold settings, the 

meter will trigger a waveform capture.

This setting determines at what point the meter executes a waveform capture and/or 

records a power quality event. See 19.3.5: Waveform Log, on page 19-20 and 19.3.4: 

Power Quality Log, on page 19-16, for instructions on viewing Waveform and PQ logs. 

See 26.4.1: Configuring Log Sizes, on page 26-80 for instructions on configuring the 

log sectors for the Shark® 270 meter.

NOTE: PQ and Waveform Thresholds are given as a percentage of the Full Scales (Full 

Scale fields). Full Scales are based on the CT and PT Ratios set in the CT, PT Ratios 

and System Hookup setting. Before programming the Waveform/PQ Thresholds, set 
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the CT and PT ratios. See 26.1.1: Configuring CT, PT Ratios and System Hookup, on 

page 26-2, for instructions. 

1. From the Tree Menu, click Power Quality and Alarm Settings>Waveform/PQ. The 

current settings, if any, are shown in the screen.

•  Set the Surge and Sag Setpoints (in percentage of Full Scale), for Voltage, and 

the Surge Setpoint (in percentage of Full Scale) for Current. When you enter the 

percentage for a reading, the primary value is displayed in the Primary field. The 

bottom, right of the screen displays the Full Scales for Voltage and Current.

NOTE: EIG recommends you do not make the % Fullscale too close to the read-

ing’s Primary value, e.g., a Surge of 101%, or a Sag of 99%. If these settings 

are too close to the Primary value you may flood the PQ log with waveform 

recordings of very minor fluctuations, causing bigger fluctuations to be missed. 

The software highlights the Limit ID in red and displays a note on the screen if 

the setting is considered outside of the recommended range.
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2. Click the checkbox under PQ to enable PQ recording when the programmed thresh-

old is exceeded.

3. Click the checkbox under Waveform to enable Waveform recording when the 

programmed threshold is exceeded.

4. Select the sampling rate from the Capture Sample Rate pull-down menu. The 

options are 32 - 128, for V-SwitchTM key 4, and 32 - 512 for V-SwitchTM key 5.

5. From the Pre-trigger Cycles pull-down menu, select the number of cycles of wave-

form data prior to the triggering event, that you want to be included in the wave-

form capture. The options are 2 to 63.

NOTE: Increasing the sample rate will decrease the number of available pre-trigger 

cycles. For example, if you select a sampling rate of 128, the maximum number of 

pre-trigger cycles is 15; if you select a sampling rate of 512, you can only set 2 or 

3 pre-trigger cycles.

6. To implement any changes, click the Update Device icon to send the new 

profile to the meter.
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26.4: Logs Setting

From the Tree Menu on the left side of the Shark® 270 meter’s Device Profile screen, 

double-click on the Logs line or click on the + button next to it. All of the settings in 

the Logs group are listed.

  amount of memory allocated to them
This graph represents the logs and the
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26.4.1: Configuring Log Sizes 

This setting allows a user to allocate the amount of memory available for each log, 

based on the number of recording days desired. Once the log’s memory fills, the log 

“rolls over” and the records are overwritten in a FIFO (first in, first out) sequence. 

Depending on the meter’s V-SwitchTM key, the user is able to memory allocation for up 

to 6 historical logs and the waveform and PQ logs, to optimize the number of records 

stored for each log. 

•  For V-Switch™ keys 2 and 3, use this setting to increase or decrease the amount of 

records that each of the Shark® 270 meter's three Historical logs can store. 

•  For V-Switch™ keys 4 and 5, use this setting to set the allocation for the Wave-

form(V4 and V5) and Power Quality (V5 only) logs, as well as for 6 Historical logs.

1. From the Tree Menu, click Logs>Configure Log Sizes. You will see the screen shown 

on the previous page. Note that the example screen is for a meter with V5 - the 

screen you see will look a bit different if your meter has a lower V-SwitchTM key.     

2. For each log, set both the logging interval and size. (Note that for the Waveform 

and PQ logs, you only set the size.) For the historical logs, the Duration field tells 

how many months and days of logging your setting will provide; for the Waveform 

log, it tells how many waveform captures it will provide; and for the Power Quality 

log, it tells how many PQ events, i.e., surges and sags, will be recorded.

a. Select the logging interval from the pull-down menu. The interval is in 

minutes. You can set between 1 and 60 minutes, or EOI pulse, for the 

historical logs.

b. Set the log size (the amount of memory allocated to it), by moving the bar 

in the size field to the right to increase the amount of memory, and to the 

left to decrease the amount of memory. When your cursor is on the bar, the 
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amount of memory for that setting point is displayed.

NOTES: 

•  The maximum allowable size for the historical logs is 6 MB, and for the Waveform 

log, is 8 MB. The V-SwitchTM key level may limit this maximum number, e.g., a 

meter with V2 has 2 MB memory in total to assign to the available logs. 

•  When EOI Pulse is set as the Logging Interval for a Historical log (see 26.4.2: 

Configuring Historical Logs, on page 26-82), the Interval field will display EOI 

Pulse, and the duration field will say “0 Hours.”

•  Note that the more memory allocated to a log, the longer it takes to collect the 

data from the log. Only allocate as much memory as needed for the application. 

The unused memory that remains will be used for wear leveling of the flash chip.

•  If either: a) one (or more) of the historical logs has been configured, but no 

memory has been assigned to it; or b) one (or more) of the historical logs has 

memory assigned to it, but no data items have been configured for it, the follow-

ing message will be shown at the bottom of the screen. 

See the following section for historical log configuration instructions.

3. To implement any changes, click the Update Device icon to send the new profile to 

the meter.

Decrease       Increase
Memory         Memory

Amount of Memory
at this setpoint
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26.4.2: Configuring Historical Logs

Use this setting to select the parameters to be stored in each of the Shark® 270 

meter's historical logs. For additional information on logs, including using the HHF 

Converter, see Chapters 16: Databases and Log Data, on page 16-1 and 19: Viewing 

Logs, on page 19-1.

Functional Overview of Historical Logs:

Depending on the meter’s V-SwitchTM key, the Shark® 270 meter allows a user to set 

up to 6 separate historical profile logs that can log up to 64 parameters, each. Each of 

these logs can log at different time frames (intervals). For example, one log can be 

set for one minute intervals to record voltage; while another log can be set for 15 

minute intervals for energy consumption logging.

Having multiple historical logs additionally affords you the flexibility of programming 

each log with unique parameters. For example, you might program Historical Log 1 to 

record Power Quality parameters (for example, THD), Log 2 to record Demand or 

average power parameters, and Log 3 to record Energy parameters, and so on. 

Historical Log parameters can be selected from these groups/subgroups:

•  Measured Values/Readings (V L-L, V L-N, Ia, Ib, Ic, Current Neutral, Watts, VARs, 

VA, Frequency, PF, Symmetrical Components, Voltage Unbalance, Current Unbal-

ance, Quadrant Indicator, Q Total, V P-N Average, V P-P Average, I Average).

•  Measured Values/Uncompensated Readings (Total Watts/VAR/VA, PF Total, Watts A/

B/C, VAR A/B/C, VA A/B/C, PF A/B/C, Q Total).

•  Measured Values/Phase Angle (Phase A/B/C Current, Angle Volts A-B/B-C/C-A).

•  Energy/Scaled Energy (Wh, VARh, VAh, Quadrants, Qh Total, I2T/V2T per Phase 

and Total).

•  Energy/Scaled Energy in Interval (Wh, VARh, VAh, Quadrants, Qh).

•  Energy/Scaled Energy in Interval (Pulses) (Wh, VARh, VAh, Quadrants, Qh).

•  Energy/Uncompensated Energy (Wh, VARh, VAh, Quadrants, Qh Total, I2T/V2T per 

Phase and Total).



     Doc#    E107707                                            26-83

26: Shark® 270 Meter

•  Energy/Uncompensated Energy in the Interval (Wh, VARh, VAh, Quadrants, Qh).

•  Energy/Uncompensated Energy in Interval (Pulses) (Wh, VARh, VAh, Quadrants, 

Qh).

•  Energy/Secondary Energy (Wh, VARh, VAh, Qh, Scaled Wh, Scaled VARh, Scaled 

VAh).

•  Energy/Secondary Energy in Interval (Wh, VARh, VAh, Qh, Scaled Wh, Scaled 

VARh, Scaled VAh).

•  Energy/Secondary Uncomp. Energy (Wh, Varh, VAh).

•  Max/Min Demand/Maximums (V L-L, V L-N, Ia, Ib, Ic, Current Neutral, Watts, VARs, 

VA, Frequency, PF, Avg. Demand, Aggregators, High-speed Inputs).

•  Max/Min Demand/Minimums (V L-L, V L-N, Ia, Ib, Ic, Current Neutral, Watts, VARs, 

VA, Frequency, PF, Avg. Demand, Aggregators, High-speed Inputs).

•  Max/Min Demand/Voltage Maximums in the Interval (V Short Term Max).

•  Max/Min Demand/Voltage Minimums in the Interval (V Short Term Min).

•  Max/Min Demand/Previous Demand Last Reset (Max Watt/VAR/VA).

•  Average Demand/Demand ( Average I, Watts, VARs, VA, PF, Q, Aggregators, Option 

Cards).

•  Average Demand/Cumulative Demand (Watts, Cont. Watts).

•  Average Demand/Timestamp (Demand Last Reset Time).

•  Harmonics/THD/THD (%THD, % K Factor).

•  Harmonics/THD/Magnitudes (V and I magnitudes to 40th order).

•  Harmonics/THD/Angles (V and I angles to 40th order).

•  Meter Status (Meter On Time, Current Date and Time, Current Temperature, Max/

Min Demand Reset Counter).

•  Accumulators/Inputs Slot 2 (Input 1 and Input 2 Accumulators).
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•  Accumulators/Relays Slot 2 (Relay1 and Relay 2 Accumulators).

•  Aggregators (Aggregators 1, 2, 3).

 

1. From the Tree Menu, click Logs>Historical Log Profile (1-6). 

This screen allows you to select items to be stored in the historical log you selected. 

The Group field determines the items that are available for selection.

2. Click on the arrow in the Group field and select a readings group from the pull-

down menu (the available groups are listed on the previous page). In the screen 

above the Energy Interval group is selected.

3. The available items are displayed under the Group field. Select the values you want 

in your log:

a. Highlight the item(s) you want in the Selectable Items box.
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b. Click Add. The item(s) are added to the Selected Items box.

c. To remove item(s), highlight them in the Selected Items box and click 

Remove.

4. Set the Logging Interval (Minutes). The available choices are: 1, 3, 5, 10, 15, 30, 

60, EOI (End of Interval) Pulse. The Logging Interval determines when the meter 

takes a snapshot.

IMPORTANT! If you are trending Energy in the Interval, the Logging interval must 

be the same as the Demand interval.

    NOTES: 

•  Only one of the following can be set for the EOI pulse feature: 

• EITHER 1 Option card input can be set to receive an EOI pulse from 

another device

• OR 1 Option card output can be set to trigger an EOI pulse

•  When you choose EOI Pulse, the meter takes a snapshot when the pulse is either 

received or generated (depending on whether the EOI pulse is assigned to an 

input or output), rather than on a time interval. 
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NOTE: There are display fields at the bottom of the Historical Log Profile screen. They 

show Time Available (which is dependent on the number of values being logged and 

the logging interval), the Total Bytes Used (which is dependent on the number of val-

ues being logged), and the Bytes Remaining for this historical log. These fields are 

updated as you make selections on the screen. The total number of bytes available 

per log record is approximately 234.

5. To implement any changes, click the Update Device icon to send the new profile to 

the meter.
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26.5: Configuring Option Cards 

The Shark® 270 meter automatically detects the presence of any Option cards 

installed in it. You will see the installed card(s) listed in the Tree Menu (see the figure 

below). Up to two Option cards can be installed in the Shark® 270 meter. Refer to the 

meter’s Installation and Operation Manual for additional information concerning 

Option cards, including installation procedures and firmware updates, if applicable. 

You must configure an Option card before using it. The following sections give   

instructions for configuring each of the Option cards. 

NOTE: You can configure settings for an Option card when you are not connected to a 

meter. 

1. Click Option Card 1 or 2 from the Shark® 270 meter's Device Profile screen. The 

drop-down menu on the displayed screen allows you to select your Option card. 

•  The available selections are: Network (INP100S), Network IEC 61850 (INP300S), 

Digital In/Relay (RO1S), Digital In/Pulse Out (PO1S), Analog Output (0-1 mA) 

(1mAOS), Analog Output (4-20 mA) (20mAOS), RS-232/485 (RS1S), 4G Cell 

Modem (4GLTE), or None; and for Gen 2 only, IRIG-B & Pulse Output (IRG1). 

NOTE: The 4GLTE is only available in the Option card 2 menu.

2. Click Apply. The Option card you chose is now listed in the menu. Refer to the 

instructions for configuring the card, located in the following sections.
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From the Tree Menu on the left side of the Shark® 270 meter’s Device Profile screen, 

double-click on the Option Card 1 or Option Card 2 line or click on the + 

button next to it. The settings for the option card(s) installed in your meter are 

shown.
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Option Card Screens:

The type of Option card installed in the meter determines the settings you need to 

configure. Click on the selectable lines under your Option card in the Tree menu. See 

the example below. 

NOTES: 

•  The Option card settings for your meter will only show the option cards 

currently installed in your meter.

•  For firmware versions 0009 or above, when the meter’s sealing switch is enabled, 

you will be able to configure the communication Option cards: INP100S, RS1S, and 

4GLTE, if they are installed in the meter. Any other Option cards installed in the 

meter are not configurable, and will not be displayed in the Tree menu, while the 

sealing switch is enabled.

Type of 
Option 
card

   Card       
Setting 
screens
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26.5.1: Configuring a Network Card (INP100S)

The INP100S enables 10/100BaseT Ethernet communications. It also acts as a Web 

server, allowing the meter’s data to be viewed on a standard web browser. For techni-

cal specifications, hardware installation, and detailed information on the Web server, 

refer to the meter’s User Manual. 

Note that there are two versions of the INP100S card  

- a legacy version and the Gen 2 version. The Option 

Card screen will indicate which card is installed in 

your meter. See the example on the right.

Gen 2 of the INP100S card has additional features not supported by the legacy card.

•  One major feature is support for both IPv4 and IPv6. IPv6 offers many more IP 

addresses, avoiding the possibility of “running out” of IP addresses for IPv4. IPv6 

does not need to use the network-address translation necessary in IPv4, though its 

larger packet size means that the processing speed of IPv4 and IPv6 is very similar. 

Since IPv6 is used by about a third of the Internet currently, it is a good idea to 

enable both IPv4 and IPV6 for your card.

•  Gen 2 of the INP100S card offers enhanced security, including digital firmware 

signature that authenticates the network card firmware before an update is per-

formed, SSL/TLS (secure socket layer/transport layer security) encryption, support 

for encrypted (SMTPS) and unencrypted (SMTP) alarm and notification emails, and 

access to the Gen 2 INP100S card’s Web server using either HTTP or HTTPS proto-

cols.

See Chapter 10 in the Shark 270 Meter User Manual for additional features and details 

on the Gen 2 INP100S card. This section of the manual will give instructions for both 

the legacy and Gen 2 INP100S card.

Gen 2 INP100S

Legacy
INP100S
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1. From either the Option Card 1 - Network Card or Option Card 2 - Network Card 

menu, click IP Address and DNS. This setting allows you to configure the IP Address 

and DNS for the card, and for Gen 2 to set up the Keep Alive feature.

•  You will see the screen shown below for the legacy INP100S.
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•  You will see the screen below if you are connected to the Gen 2 INP100S.

Note that for Gen 2, the INP100S has both IPv4 and IPv6 settings. You can use 

the screen to make both IPv4 and IPv6 settings that will be used by the card.

a. In the IP Address section, enter the following information for both the 

legacy and Gen 2 IPv4:

• Host Name: To enable a DHCP server to assign the IP address for your 

network card, click the DHCP box and enter the host name. 

• If you are not using a DHCP server, enter the following for the network 

card:

• IP Address.

• Subnet Mask.

• Default Gateway.

NOTE: If no mask is entered (blank) or 0.0.0.0 is used, the network 
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card will use an automatic mask based on the network address class, 
or will not apply a mask, according to the following table:                 

•For the Gen 2 INP100S card, the Keep Alive setting specifies the 

number of seconds the meter will wait before sending a “keep alive” 

message if there is no communication. After the specified amount of 

time, the meter sends the keep alive message to the TCP socket to see 

if the connection is still up and running. If the connection has been lost, 

the TCP socket can then be freed for another connection.

b. In the IPv6 IP Address tab, enter the following:

• Mode: select one of the following options - 

• Use Static Address and then enter the address in the IP address field.

• Use Link Local Address.

• Use DHCP. 

• Prefix Length: this field is similar to the subnet mask in IPv4. You can 

enter a number between 1 and 128.

• Default Gateway: enter the address of the default gateway or leave the 

default of all zeros.

c. Domain Name Server Address(es) (for Gen 2, you can set up to two servers 

for IPv4 and IPv6, each).

NOTE: If you don’t enter a DNS address, the field defaults to 0.0.0.0. In 

this case, you need to enter an IP address (e.g., 163.27.987.53) for the 

NTP server (if enabled) and email features. If you do specify a valid DNS 

address, however, you can use a URL address (e.g., pool.ntp-micro-

soft.org) for the NTP and email features.

Network Class Address range Mask used

Class A 1.0.0.0-127.x.x.x 255.0.0.0

Class B 128.0.0.0-191.x.x.x 255.255.0.0

Class C 192.0.0.0-223.x.x.x 255.255.255.0

Other classes No masking will be applied
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2. From the Option Card menu, click Services and Security.This screen allows you to 

disable certain features of the meter’s Ethernet connection, for security purposes.

•  You will see the screen shown below if your legacy Network card’s Firmware 

version is 3.42 or lower. 
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•  If your legacy Network card’s Firmware version is 3.43 or higher, you will see the 

screen shown below:
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•  If you have a Gen 2 INP100S card, you will see the screen below. Again, you 

make settings for both IPv4 and IPv6.

a. In the Services tab, make these settings:

• The HTTP Web Server can be disabled, or its default port can be changed. 

• The Modbus TCP server can be disabled, or its default port can be 

changed. 

• If the port entered is less than “10,” the standard port is used: 80 for 

Web Server and 502 for Modbus TCP Server. 

• To disable one of the servers, uncheck the box next to it.
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• Check the Enable Email Alarm/Notification box to use the alarm email 

and periodic notification feature of the Network card. Note that the Net-

work card’s firmware must support alarm and notification email for this 

feature to be available. The settings for the alarm/notification email fea-

ture are made using the card’s Web server. See the Shark® 270 Meter 

User Manual for instructions. There is one setting for both IPv4 and IPv6.

• If you have selected NTP as the time synchronization source for the 

meter (see 26.1.2: Configuring Time Settings, on page 26-5), you will 

see the settings below.

• Enable the NTP client for either IPv4 or IPv6.

• Enter the SNTP Server name or IP address of a Network Time Protocol 

server.   

NOTES: 

• The Network Time Protocol server is used for clock synchronization. It 

can be either a device with a real-time clock that is networked with 

your meter, or an NTP server on the Internet. 

• The legacy card’s Network Firmware versions at or below 3.43 

(INP100S) and 3.44 (INP300S), support NTP version 4.0; Network 

Firmware versions 3.45 and higher, support both NTP version 3.0 and 

4.0.

• NTP is supported in Query-Reply method, only.

• NTP can only be enabled for one INP100S card.

b.  For the legacy INP100S card:

• When the Security feature “Silent Mode” is enabled, a TCP/Reset packet 

is not sent when an attempt to connect to an unbound port is made. 

When “Silent Mode” is disabled, the meter follows standard TCP/IP proce-

dures for incoming connections to unused ports. This feature is useful in 

preventing hacking (attempted security intrusions).
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• Network Firmware version 3.43 and higher and CommunicatorPQA® soft-

ware version 4.0.249 and above support the Exclusive Client feature. This 

feature lets you allow an IP and/or MAC address. When that address is 

used to connect to the meter, all other network communication with the 

meter, though the same Network card, is suspended. This ensures that 

anything being done, e.g., updating programmable settings, while the 

allowed address is being used to communicate with the meter, is secure. 

• Click the checkbox and enter the IP address or MAC address you want to 

establish as the Exclusive Client.

NOTE: To disable the exclusive Client feature, uncheck the checkbox - 

the IP and MAC addresses will be set to all zeros.

c. For the Gen 2 INP100S card, the Security section has these settings:

• IPv4 and IPv6 tabs let you set up firewall security:

i. Check the box to Enable IP(v4/v6) Address filtering. (Leave the box 

unchecked if you don’t want to set firewall security).

ii. The Blocked Range Start and End IP Address fields are used to block a 

range of both IPv4 and IPv6 addresses. 

iii. Use the Allowed IP Address to enter an IP address within the blocked IP 

address range that you give access to.

• There is also a MAC address tab, with an Enable checkbox and up to three 

Allowed MAC address fields.

• Check the box to enable Silent Mode for both IPv4 and IPv6. When Silent 

Mode is enabled, a TCP/Reset packet is not sent when an attempt to 

connect to an unbound port is made. When Silent Mode is disabled, the 

meter follows standard TCP/IP procedures for incoming connections to 

unused ports. This feature is useful in preventing hacking (attempted 

security intrusions).
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NOTES: 

•  Contact your System Administrator for proper configuration.

•  See Chapter 25: Firmware Updating, on page 25-1, for instructions on updating 

the legacy Network card's firmware. The Gen 2 INP100S card’s firmware is 

updated via its webpage - see the Shark® 270 Meter User Manual for instruc-

tions.

3. From the Option Card menu, click DNP Support if you want to set up DNP over 

Ethernet for the Network Card. This screen lets you set up a DNP Server gateway 

for the Network Option card. This gateway enables DNP3 protocol communication 

over Ethernet, for the meter.

•  You will see the screen shown below if you have the legacy INP100S.
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•  You will see the screen shown below if you have the Gen 2 INP100S card. 

4. For both legacy and Gen 2 INP100S card’s make these settings:

a. Enable DNP Support: by default the DNP server support is disabled. Check 

the box to enable it. Once it is enabled, the other parameters can be 

entered.

b. DNP Server Port: this is the TCP/IP port where the meter’s Network card 

unit will be listening for incoming connections via the DNP protocol. Valid 

numbers are from 10 to 65534. We recommend that you set a value over 

1024, because most of the lower numbers are reserved, or are already 

allocated to other popular services. If you set a port number of less than 

10, the network card will set the port to its default, which is 20000.
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c. DNP Device Address: this is the meter’s configured address (allowable 

setting is 1-65519).

d. Single Socket Enforced - check the box if unsolicited messages are 

supported by your DNP network. This setting permits only one socket for 

the Network card, so there is a single path to send the unsolicited 

message. 

e. DNP Remote Address Range: this setting implements Internet security by 

letting you specify a range of IP addresses that are authorized to connect 

to the DNP port. Any requester with an IP address outside of this range will 

be rejected. 

• For the legacy INP100S card, enter the range in the Remote Start 

Address and Remote End Address fields. To disable the IP range restric-

tion, write 0.0.0.0 in the start field and 255.255.255.255 in the end field. 

An example of a range is 172.20.167.100 in the Remote Start Address 

field and 172.20.167.150 in the Remote End Address field. That would 

authorize connection to the DNP port for any IP address from 

172.20.167.100 up to and including 172.20.167.150.

• For the Gen 2 INP100S card, for IPv4 and IPv6, enter:

•The Allow List Start and End IP Addresses if you want to set up a range 

of allowed IP addresses.

• For the Gen 2 INP100S card, use the Allow List TCP/IP Start and End 

Ports to set an allowable range of communication ports. Communication 

using any ports outside of the Allowed range will be rejected. This setting 

is used by both IPv4 and IPv6. Valid port numbers are from 0 to 65535. 

Set the start port to 0 and the end port to 65535 to disable the port range 

restriction. 

          NOTE: The DNP3 Allow List settings will not be available if IPv4, IPv6, or MAC

          allow lists have already been configured for the Gen 2 INP100S card.

5. To implement any changes to the Network card settings, click the Update Device 

icon to send the new profile to the meter.
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26.5.2: Configuring an IEC 61850 Network Card (INP300S)

The IEC 61850 Network card INP300S gives the Shark® 270 meter Ethernet TCP/IP 

communication and an embedded IEC 61850 Protocol Server. The card’s settings are 

the same as for the INP100S Network card described in 26.5.1: Configuring a Net-

work Card (INP100S), on page 26-90, except that the Tree menu will say Option Card 

1 - Network Card (IEC 61850) or Option Card 2 - Network Card (IEC 61850) (see 

example, below); there is no Enable Email Alarm/Notification option in the 

Service and Security settings screen, since alarm and notification email is not 

supported for the IEC 61850 Network card; and there is no DNP Support listed in the 

Tree menu, since the INP300S card does not support DNP3 protocol. 

See the Shark® 270 User Manual for detailed instructions on the IEC 61850 protocol 

configuration for the INP300S card.
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26.5.3: Configuring a Digital Relay Card (RO1S)

The RO1S card is a relay output/digital input card that can be used for a few 

purposes. The relay portion is used to send a control output when a limit is exceeded. 

The input portion can be used to either count KYZ pulse or detect the status of a cir-

cuit.

The Relay Output/Digital Input Option Card has:

•  Two relay contact outputs for load switching 

•  Two wet/dry contact sensing digital inputs. 

Accumulators in the CommunicatorPQA® software count the transitions of the Inputs 

and Outputs. For technical specifications and hardware installation, refer to the 

meter’s Installation and Operation Manual. The Input accumulators can be used in 

aggregators - see 26.2.8: Aggregators Setting, on page 26-67.

NOTE: When installing a Relay Output/Digital Input card, we recommend you reset 

the accumulators for the card, in order to prevent erroneous counts. See Chapter 20: 

Other Functions and Screens, on page 20-1. for instructions on using the Reset 

Shark® Information screen to reset card accumulators.
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Example:

An example use of the optional Relay Card is in monitoring the status of circuit break-

ers or relays in your electrical system. The two status inputs could be used to monitor 

two circuit breakers, and the two relay outputs could be used to sound an alarm upon 

the occurrence of a programmed out of limit condition.

1. From the Option Card 1 - Digital Relay or Option Card 2 - Digital Relay menu, click 

Inputs. Use this screen to assign labels and functions to the Inputs. 

b. For each of the two inputs, make a selection in the Assigned to field. The 

available selections are: 

• Status Only - select this to use the digital inputs just to indicate if the 

state is open or closed.
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• Accumulator - select this to use the digital input as a pulse counter. The 

accumulators can be used in an aggregator - see 26.2.8: Aggregators 

Setting, on page 26-67.

• Digital Input Log - select this to use the digital input to trigger an entry in 

the I/O change log.

• EOI Pulse - only one Input can be set to receive an EOI pulse.

NOTES on End of Interval (EOI): 

• EOI is triggered in a device when the programmed condition is met. 

Only one Option Card input can be set to receive an EOI pulse. EOI is 

used for the following:

•As a trigger for demand averaging: the received EOI pulse delin-

eates an interval that results in demand averaging being performed. 

The minimum interval between received EOI Pulses used to trigger 

demand averaging should be 5 minutes. An EOI pulse allows the 

meter to be synchronized with an installed revenue meter, so that 

both meters are calculating Demand at the same time. When an 

Input is assigned to EOI, the demand interval is now the time 

between two received pulses.

•For historical logging: when the EOI pulse is received, it causes any 

log that has been configured for EOI Pulse interval to capture a 

record. Refer to 26.4.2: Configuring Historical Logs, on page 26-82, 

for additional information on EOI Pulse and logging.

IMPORTANT! The EOI setting will affect Time of Use, if it is active 

for the meter. Instead of using the demand interval for TOU accumu-

lations, TOU will perform automatic data usage accumulation and 

calendar actions (rate change, day type change, season/billing 

month self reads) based on the EOI input trigger. This can result in 

shorter or longer interval periods, depending on the EOI input tim-

ing, so the rate/day type/calendar actions may differ from what is 

expected.

c. Select Trigger from the pull-down menu. The Trigger you select depends on 

your Assigned to selection:

•  For Status Only, select None.
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•  For Accumulator, select from Closing, Opening, High Speed Closing or 

High Speed Opening. 

NOTE: Only one accumulator can be assigned to a High Speed Trigger.

•  For Digital Input Log, select Change.

•  For EOI Pulse, select from Closing, Opening, or Change.

d. Enter Units/Count. The Units/Count is the output ratio from the device that 

is being input into the Shark® 270 meter. For example, if you have a KYZ 

module that is outputting a pulse every 1.8 kWh, with the input set to 

Accumulator, Increment on Contact Opening, you would set the Units/

Count to be the value of the KYZ; in this case either 1.8 or a ratio of that 

number.

e. Enter Compression. The Compression Factor is used to adjust how high an 

accumulator will go before rolling over. For example, if you select a Com-

pression Factor of 10, each time 10 Pulse/State changes occur, the accu-

mulator count increments by 1. The available Compression Factors are: 1, 

10, 100, 1000, 10000, and 100000. The default Compression Factor is 1.

f. Enter a Label for the Accumulator.

g. The current Input Labels are displayed in the screen. To change the Input 

Labels, click in the Labels field you want to change, and enter a new label. 

The fields that can be changed are:

•  Input Label - Input ID

•  Open Label - Open state ID

•  Closed Label - Closed state ID
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2. From the Option Card - Digital Relays menu, click Relays to set the limits/alarm 

conditions and logging options for the card's Relay Outputs.

•  Configure up to 8 output conditions for the two Relay Outputs. Note that the Lim-

its used are configured in Power Quality and Alarm Settings>Limits (see 26.3.1: 

Configuring Limits, on page 26-73).

•  Set a Delay and Reset Delay for the Outputs.

•  Choose to log Status Changes for each Relay Output.

•  Assign each Output an Output Label, Open Label, and Closed Label, which are 

used when viewing the Relay Status Log.

•  Assign an Accumulation Compression Factor for each output. 



     Doc#    E107707                                            26-108

26: Shark® 270 Meter

IMPORTANT! First use the Limits screen to set up the limits you want to assign to an 

Output. See 26.3.1: Configuring Limits, on page 26-73, for instructions.

a. The available limits appear in the Limit ID column. You can assign the limit to 

one or both (or neither) of the Relay Outputs.

-  Select the output condition from the pull-down menu next to the Limit ID. The

   options are: Above (the Output is triggered when the Above Limit condition

   occurs), Below (the Output is triggered when the Below Limit condition

   occurs), or None (no limit set condition set).

NOTE: A relay operates when any one assigned Limit is tripped, and stays in the 

Set condition as long as one Limit is in the Alarm state.To assign a limit to an 

Output relay:

b. You can enter Set Delay and/or Reset Delay. These values are the delay before 

the Output is changed: Set is when the common is shorted to Normal Open (this 

is the Set Condition), Reset is when the Output is shorted (closed).

c. Check the box next to Log Status Change if you want to log output status 

changes for either or both Relay. See Chapter 19: Viewing Logs, on page 19-1, 

for information on the I/O Change Log.

d. The current relay condition labels are displayed in the screen. These labels are 

used for logging. To change the labels, click in the Labels field you want to 

change, and enter a new label. The fields that can be changed are:

•  Output label for relays 1 and 2.

•  Open label for relays 1 and 2.

•  Closed label for relays 1 and 2.
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e. If you want, select Set Delay and Reset Delay from the pull-down menus in Addi-

tional Settings. You can choose between 0 and 255 seconds. Use these fields if 

you want to program a delay before the relay is set, or before it is reset 

f. The Relay Output label is the default, but you can change it.

g. You can enter a name for the Relay Open Label and Relay Closed Label. 

3. To implement any changes to the Relay Output/Digital Input card settings, click the 

Update Device icon to send the new profile to the meter.

26.5.4: Configuring a Digital Input/Pulse Output Card (PO1S)

The PO1S is a pulse output/digital input card that is similar to the Digital Relay card 

RO1S, except that the PO1S contains 4 KYZ pulse output contacts instead of relay 

control outputs. These solid state output contacts can be configured to have the 

meter pulse out for user-assigned energy values. The Pulse Output/Digital Input 

Option Card has:

•  Four Pulse Outputs via solid state contacts

•  Four wet/dry contact sensing digital inputs.

Accumulators in the CommunicatorPQA® software count the pulses of Inputs and 

Outputs. For technical specifications and hardware installation, refer to the meter’s 

Installation and Operation Manual. The Input accumulators can be used in aggrega-

tors - see 26.2.8: Aggregators Setting, on page 26-67.

NOTE: When installing a Pulse Output/Digital Input card, we recommend you reset 

the accumulators for the card, in order to prevent erroneous counts. See Chapter 20: 

Other Functions and Screens, on page 20-1, for instructions on using the Reset 

Shark® Information screen to reset card accumulators.
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Example:

An example use of the Pulse Output/Digital Input Card is in a sub-metering applica-

tion where a pulse output is needed. The Input Accumulator allows you to count the 

pulses from another device, for example, a KYZ module or another meter. The Output 

Accumulators allow you to count the pulses being output by the card.

1. From the Option Card 1 or Option Card 2 - Digital In/Pulse Out (PO1S), click 

Inputs. Use this screen to assign labels and functions to the Inputs. 

2. Make a selection in the Assigned to field. The available selections are: 

•   Status Only - select this to use the digital inputs just to indicate if the state is 

open or closed.
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•   Accumulator - select this to use the digital input as a pulse counter. The accumu-

lator can be used in an aggregator - see 26.2.8: Aggregators Setting, on 

page 26-67.

•   Digital Input Log - select this to use the digital input to trigger an entry in the 

I/O change log.

•  EOI Pulse - only one Input can be set to receive an EOI pulse.

NOTES on End of Interval (EOI): 

• EOI is triggered in a device when the programmed condition is met. Only 

one Option Card input can be set to receive an EOI pulse. EOI is used for 

the following:

• As a trigger for demand averaging: the received EOI pulse delineates 

an interval that results in demand averaging being performed. The 

minimum interval between received EOI Pulses used to trigger demand 

averaging should be 5 minutes. An EOI pulse allows the meter to be 

synchronized with an installed revenue meter, so that both meters are 

calculating Demand at the same time.

• For historical logging: when the EOI pulse is received, it causes any 

log that has been configured for EOI Pulse interval to capture a record. 

Refer to 26.4.2: Configuring Historical Logs, on page 26-82, for addi-

tional information on EOI Pulse and logging.

IMPORTANT! The EOI setting will affect Time of Use, if it is active for 

the meter. Instead of using the demand interval for TOU accumula-

tions, TOU will perform automatic data usage accumulation and calen-

dar actions (rate change, day type change, season/billing month self 

reads) based on the EOI input trigger. This can result in shorter or lon-

ger interval periods, depending on the EOI input timing, so the rate/

day type/calendar actions may differ from what is expected.

3. Select Trigger from the pull-down menu. The Trigger you select depends on your 

Assigned to selection:

•   For Status Only, select None.
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•   For Accumulator, select from Closing, Opening, High Speed Closing or High 

Speed Opening.

NOTES: 

• Only one accumulator can be assigned to a High Speed Trigger.

• High speed opening and closing would be used when monitoring pulses 

from water meters that can be pulsing very quickly. 

•  For Digital Input Log, select Change.

•  For EOI Pulse, select from Closing, Opening, or Change.

4. Enter Unit/Pulse. The Unit/Pulse is the output ratio from the device that is

  being input into the Shark® 270 meter. For example, if you have a KYZ module

  that is outputting a pulse every 1.8 kWh, with the input set to Accumulator, Incre-

  ment on Contact Opening, you would set the Units/Count to be the value of the

  KYZ; in this case either 1.8 or a ratio of that number.

5. Enter Compression. The Compression Factor is a divider used to adjust how high

  an accumulator will go before rolling over. For example, if you select a 

 Compression Factor of 10, each time 10 Pulse/State changes occur, the accumula-

 tor count increments by 1. The available Compression Factors are: 1, 10, 100,

 1000, 10000, and 100000. The default Compression Factor is 1.

6. Enter a Label for the Accumulator.

7. The current Input Labels are displayed in the screen. To change the Input Labels,

  click in the Labels field you want to change, and enter a new label. The fields that

  can be changed are:

•  Input Label - Input ID

•  Open Label - Open state ID

•  Closed Label - Closed state ID
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8. You program the PO1S pulse outputs in the Revenue & Energy Settings>Pulse Fac-

tors>Option Card (1 or 2)- Digital In/Pulse Out (PO1S).

• You assign an energy channel, a units/pulse number, and a label for each of the 

four outputs. 
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9. Double-click an Assigned Channel field to open the Energy selection menu. Scroll to 

see all of the options. 

10.Click on the energy value you want to use, “Not Assigned” if you are not using that

  output, or “End of Interval” if the output is being assigned to an EOI pulse.

11. Click OK. The channel you chose is displayed in the Assigned Channel field. For all

  energy channels, the default Units/Pulse value (1.8) is also displayed. You can

  edit this field by double-clicking in it. 

•  The units/pulse should be entered in secondary, i.e., the readings in the meter. 

E.g., for a three-phase meter with 600 W per element for a total of 1800 W the 

Units/Pulse field will be 1.8. Every 1.8 Wh, the count will accumulate by 1, and 

each count will represent 1.8 Wh. If you are using CTs with a ratio of 1000 to 1 

the count will still increment every 1.8 Wh, but the count in that case will repre-

sent 1.8 Wh x 1000, or 1800 Wh.

12. The default output labels are displayed in the Labels field. To change an output

  label, click in the field and enter the new label. 

13. To implement any changes to the Pulse Output/Digital Input card settings, click

  the Update Device icon to send the new profile to the meter.
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26.5.5: Configuring a 0-1 mA Output Card (1mAOS) 

The 1mAOS is an analog output card, which transmits a standard, bidirectional 0-1 

milliamp signal proportional to the value selected. This card mimics an analog trans-

ducer. With the Shark® design, the user can select any measured parameter to out-

put on an analog transducer signal. For technical specifications and hardware 

installation, refer to the meter’s Installation and Operation Manual.

Example:

An example use of the optional 0-1 mA Output Card is in enabling the Shark® 270 

meter to communicate with an RTU. 

1. From the Option Card 1 - 0-1 mA Analog Output or the Option Card 2 - 0-1 mA 

Analog Output menu, click Settings.

    You can set up to four Output IDs for your Output Card. 
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2. Double-click an Assigned Channel field to add or edit an Output ID. You will see the 

window shown below.

3. Select Group for your Output Channel. The available selections are as follows:

•  Primary Readings 

•  Secondary Readings 

•  THD

•  Uncompensated Readings 

•  Maximums 

•  Minimums  

4. Select Item for your Output Channel. The items are the available readings for the 

group you selected. For example, as shown in the window above, Watts Total is an 

item you can select when you have selected Primary Readings as the group.

5. Click OK. The Output Channel you selected is displayed in the Assigned Channel 

field. 

6. Enter Low End and High End for the channel. 

NOTE: For the Item selected for the Assigned Channel, the Output Card takes the 

value in the meter and outputs a DC current within its range. The Low End is the 

lowest value, and the High End is the highest value. For example, for VOLTS A-N 

and Bidirectional Mode, at Nominal of 120 V, the Low End is set to 115 V and the 

High End is set to 125 V. The Analog Output Card will output -1 mA when the read-

ing is 115 V, 0 mA when the reading is 120 V, and 1 mA when the reading is 125 V. 

The analog card can output below -1 mA and above +1 mA, proportionally to 

VOLTS A-N. For limiting values refer to the meter’s Installation and Operation 

Manual's applicable section.
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7. You can select either Unidirectional or Bidirectional for Mode. Unidirectional mode is 

used for unsigned data, e.g., voltage; and bi-directional mode is used with signed 

data, e.g., Watts.

8. To implement any changes to the 0-1 mA Output card settings, click the Update 

Device icon to send the new profile to the meter.
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26.5.6: Configuring a 4-20 mA Output Card (20mAOS) 

The 20mAOS is an analog communication card, which transmits a standard, unidirec-

tional 4-20 milliamp signal. For technical specifications and hardware installation, 

refer to the meter’s Installation and Operation Manual.

Example:

An example use of the optional 4-20 mA Output Card is in enabling the Shark® 270 

meter to communicate with an RTU. 

1. From the Option Card 1 - 4-20 mA Analog Output or the Option Card 2 - 4-20 mA 

Analog Output menu, click Settings. 

2. Follow the instructions for configuring the 0-1 mA Card. The configuration of a 4-20 

mA Card is the same as a 0-1 mA Card, except that this card can only be unidirec-

tional, so there is no Mode setting, and the High End and low end are 20 mA and 4 

mA, respectively.
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26.5.7: Configuring an RS232/RS485 Card (RS1S)

The RS1S card lets you add an RS232 or RS485 serial connection to the meter.

1. From the Option Card 1 - RS232/RS485 or the Option Card 2 - RS232/RS485 

menu, click Settings.   

2. Use this screen to make the following settings for the card:

•   Address: 1 - 247 (Modbus); 1-65520 (DNP).

•   Protocol: Modbus RTU; Modbus ASCII; DNP3.

•   Baud Rate: 9600; 19200; 38400; 57600.

•.  Parity: None, Odd, Even.

•   Response Delay (msec): the suggested delay is 50 msec, but you can increase 
the delay, if necessary.

3. To implement any changes, click the Update Device button to send the new 

profile to the meter.
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26.5.8: Configuring a Verizon 4G Cell Modem Card (4GLTE)

The 4GLTE card lets you add a Verizon-certified 4G LTE1 communication option to the 

meter. When this option is ordered, the card comes pre-installed in a Shark® 270 

socket form meter. However, the card must be commissioned before use. Instructions 

for this are given in Chapter 14 of the Shark® 270 Meter User Manual, available on 

EIG’s website: www.electroind.com.

You can access the 4GLTE card’s status, including SIM card and IMEI card numbers, 

by clicking Tools>4GLTE Cell Modem Status and you can update the card’s firmware 

by clicking Tools>4GLTE Cell Modem Firmware Update. These actions are described in 

chapters 20 and 25, respectively.

1. Click Option Card 2 - 4G Cell Modem (4GLTE)>Settings.

2. On this screen, you can specify the Modbus server port (the default is 502).

3. Select the number of minutes you want for the Inactivity Reset Timer field, from 

the pull-down menu. This timer is used to prevent keeping the connection open 

unnecessarily, e.g, if there is a network communication error. After this amount of 

time with no data activity, the cell modem will close the connection and initiate a 

soft reset.

1. LTE is a trademark of ETSI.
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4. Select the number of minutes you want for the Connection Inactivity Reset Timer, 

from the pull-down menu or enter the number in the field. The available setting is 

from 60 to 65535 minutes.This timer is used to reset the modem if there is a prob-

lem with its connection to the carrier’s system. To use this setting, enter an amount 

of time that is greater than your usual connection time; e.g., if you connect every 

six hours, set this field to 6 1/2 or 7 hours (390 or 420 minutes); if you connect 

once a day, set it to 25 hours (1500 minutes). Then if you are not able to connect 

due to a problem with the cell modem’s connection to the carrier’s system, this 

timer will cause the modem to reset. Resetting the modem should restore its con-

nection to the carrier’s system and you will be able to connect to the modem.

5. APN: enter the APN number given to you by your provider.

IMPORTANT! Be careful when entering the APN, making sure to copy any charac-

ters, numbers, and/or punctuation symbols exactly. Failure to do so can lead to 

communication and connection problems.

6. Allowed List: you can enter an IP address or specify a range of addresses. These IP 

addresses will be able to connect to the 4GLTE card. 

NOTE: It is important to set up this feature if you are not on a private network, to 

ensure there is no unwanted communication with the cell modem and meter.

To enter a range of addresses, use an asterisk as a wildcard. For example:

192.25.6.*

All valid IP addresses beginning with 192.25.6 will be allowed access.

IMPORTANT! Make sure you enter the IP address correctly.

7. Click Update Device to save your settings.

NOTE: To connect to your meter using the 4GLTE, enter its IPV4 address in the Net-

work Connect screen - see 3.2.2: Connect through a Network, on page 3-9. You can 

find the 4GLTE’s IPV4 address either through the Cell Modem Status screen (from the 

CommunicatorPQA® application’s Main screen, click Tools>4GLTE Cell Modem Status 

- see 20.1.20: 4GLTE Cell Modem Status (Shark® 270 Meter), on page 20-58) or 

from the meter’s display.



     Doc#    E107707                                            26-122

26: Shark® 270 Meter

26.5.9: IRIG-B & Pulse Outputs Card (IRG1)

The IRG1 card enables IRIG-B communication for Gen 2 meters. You select IRIG-B as 

the time synchronization method in the Time Settings screen - see 26.1.2: Configur-

ing Time Settings, on page 26-5.

The IRIG1 card does not need any IRIG-B settings. The Pulse Outputs in the card 

have the identical settings as the Pulse Outputs in the PO1S card - see 26.5.4: Config-

uring a Digital Input/Pulse Output Card (PO1S), on page 26-109 for instructions on 

programming the pulse outputs. Access the IRG1 pulse output settings screen by 

clicking Option Card 1 or 2>Pulse Outputs.

NOTES: 

•  The card’s IRIG-B implementation is compatible with all eight schemas for time 

synchronization, but control functions are not supported by the meter.

•  The SBS field included in some schema is not used by the meter.
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26.6: Display Setting

The Shark® 270 meter has an embedded LCD display that contains display screens in 

3 Modes (a Mode consists of screens that will display in order). The meter comes pro-

grammed with pre-defined screens, but the Shark® 270 meter gives you the ability to 

edit the pre-defined screens and/or to create custom screens for the display, letting 

you match the display screens to any application needs you have. Through the Dis-

play setting in the Device Profile, you can:

•  Customize the meter's LCD screens to display any measured readings. 

•  Add the pre-defined and custom screens to one of the Modes, and arrange the 

order of display of the screens (see 26.6.2: Meter Screen Designer, on page 26-

125, for instructions). 

•  Customize the LCD display for any application. Additional features are as follows:

•  You can add screen numbers and/or labels (titles).

•  You can create a customized “look” for the screens.

•  You can add text and lines.

•  You can use the screens to view data from pulse inputs, such as water, gas, 

steam, etc.

The Shark® 270 meter up to 12888 bytes of memory to be used by display screens.

NOTE: Gen 2 meters offer the option of setting custom display multipliers for energy 

readings. See 26.8: Custom Display Multipliers, on page 26-148 for instructions.               
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26.6.1: View Meter Faceplate Screens

1.From the Tree Menu, double-click Display. You will see the View Meter Faceplate 

Screens.

2. All of the screens can be viewed using the arrows. These screens have been loaded 

from the connected meter.

•  Use the right arrow to view screens for the next Mode, and the left arrow to view 

screens for the previous Mode.

•  Use the top arrow to view the next screen in the current Mode, and the bottom 

arrow to view the previous screen in the current Mode.

3. Click Edit Meter Faceplate Screens to launch the Screen Designer screens. Continue 

to the next section.
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26.6.2: Meter Screen Designer

When you click Edit Meter Faceplate Screens you will open the Meter Screen Designer 

Main screen. 

The screens listed here have been uploaded from the currently connected meter’s 

Screen Profile. A Screen Profile consists of the display screens and their Mode assign-

ments. From this screen you can create a new Screen Profile, edit or add to the 

screens in the current Screen Profile, or upload an existing Screen Profile and make 

changes to it. Once you are done, you can save the Screen Profile changes and upload 

them to the meter, if you wish. Note that you can save a Screen Profile and later 

upload it to a different meter or meters. Just connect to the meter and follow the 

instructions for uploading a Screen Profile (see 26.6.5: Additional Commands, on 

page 26-144).

1. The Screen Designer Main lets you assign screens to the three Modes.

•  All of the available screens, pre-defined and custom, are listed on the left side of 

the screen in the Master List column. 
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•  The three Modes are listed in the remaining columns. Under each of the Modes 

are the screen assigned to that Mode. The three Modes are:

• Mode 1: Nrm, Normal Mode.

• Mode 2: CD, Circuit Diagnostic Mode.

•  Mode 3: TOU, TOU Mode.

•  Use the scroll bars to display all of the items in the columns. You can also adjust 

the width of the Mode columns by clicking on the vertical lines between the Mode 

columns and moving to the right or left.

•  The Preview screen shows the screen currently highlighted in one of the Modes 

(the Master List screens are not previewed). Note that the data in the screen is 

simulated, not actual data from the meter.

•   The Total Storage bar tells you the percentage of storage memory used and the 

percentage still free.

•  If you hover your cursor over one of the screen names, you will see a small 

image of that screen.



     Doc#    E107707                                            26-127

26: Shark® 270 Meter

2. To move a screen from the Master List screen to one of the Modes, click on it and 

drag it to where you want it. 

•   You can also drag screens from one Mode to another Mode, or to the Master List, 

which will remove the screen from its display Mode, i.e., it will not be displayed 

on the meter. 

•   Note that if you drag the screen to an entry, it will be placed below that entry. 

•   You can change the order of display of the screens in a mode, by clicking and 

“dropping” them where you want them. 

•   The number that is shown next to the screen is its assigned number - either as 

a default screen or as a custom screen. There is a renumbering option - see 

26.6.5: Additional Commands, on page 26-144, for instructions.

•   You can also right-click on a screen in the Master List and select the View Mode 

you want to assign it to.

3. For each of the Modes, you can edit the Mode Tag, Title Line 1, and Title Line 2 

fields. You can also select the transition time between screens and timeouts for 

screens. To do so:
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a. Either click the Screen Settings icon at the top of the screen, or select 

Tools>Screen Settings from the Title menu.

b. The values shown in the screen can be changed:

• Screen Transition Time: select the number of seconds each screen should 

remain before scrolling to the next screen in the Mode (1-300).

• CD (Mode 2) Timeout: select the number of minutes the display will stay 

in Mode 2 before going to Mode 3 (1-300).

• TOU (Mode 3) Timeout: select the number of minutes the display will stay 

in Mode 3 before returning to Mode 1 (1-300).

• Screen Freeze Time: select the number of seconds a screen should 

remain in hold (1-300). You can place a screen in hold by holding a mag-

net over the reed Mode switch (see the Shark® 270 Meter’s Installation 

and Operation Manual for details). 

• Back Light On Time: select the number of seconds the LCD backlight 

should stay on (1-300).

• Mode Labels: you can enter new names for the Modes, and their titles 

lines.
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• Show Layout Configuration: check this box to set up preset alignments 

for the screens. Preset alignments are screen positions that are saved, so 

that you can use them multiple times. This makes it easy for you to cre-

ate screens with the same format. By default, this box is unchecked. 

When you check it, the screen shows additional information, as shown 

below.    

i. In the Preset Alignments box, you can set up to 8 screen positions 

(preset alignments 1 to 8). The default preset alignments are shown in 

the table. The Preview screen shows you the position of any preset 

alignment you click on. 

ii. For each of the preset alignments, you enter a position for the Label, 

or Prefix, e.g., Van; the Reading, e.g, voltage; and for the Unit of 

Measure, e.g., V. 
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iii. You set the position of the Label, Reading, and Unit of Measure by 

clicking in the field and using the up and down arrows to enter an “x” 

position. (You can also type the number into the field.) You will see the 

fields in the preview screen move in response to your selections. See 

the example below.

Note that the Preview screen will display the values in the Label, Font 

Size, Unit of Measure, and Reading fields located under it. However, 

these are just examples to help you set up the positions. What you are 

saving is the actual “x” position on the screen.

iv. To use one of the preset alignments in a custom screen, you will select 

it when you set the “x” coordinate. See 26.6.4: Display Screen Items, 

on page 26-136, for instructions. 

• Click Apply to implement your changes, Cancel to close the window with-

out changing any screen settings, Help to open instructions for the 

screen; or Load Defaults to set all of the fields to their initial, (default) 

values.
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5. The top of the Meter Screen Designer Main screen has both an Icon Bar and a Menu 

Bar.

•  The Icon Bar gives you the following options:

         Retrieve the current Screen Profile, consisting of the display screens and

         the Modes, from the meter.

         Upload the new Screen Profile to the meter.

         

          Create a new Screen Profile. This removes all of the screens from the

          Modes to let you set up a completely new Screen Profile. 

          Save the new or revised Screen Profile to a location on the PC.

          

          Load a saved Screen Profile to the meter.

  

          Open the Screen Settings screen explained in step 3-a.

•   The Menu Bar gives you the following options:

                                              

Click to exit Meter Screen Designer. You will be prompted

Click to open Screen Settings screen - see 3-a.

to save your changes if you haven’t done so already.

Click to renumber screens - see 26.6.5.

Click to open the Settings Report - see 26.6.5.

Click to view instructions from the software manual.

Click to view version information for the Meter Screen Designer.*

Same as Icon Bar 

Click to open the Options screen - see 26.6.5. 

                      
                 * Clicking on the i in a circle on the extreme right of the meter also displays the version information.
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6. The Meter Screen Designer Main screen lets you:

•  Edit an existing screen: double-click on the screen in the Mode list to open the 

screen in the Edit Screen window. 

•  Create a new, custom screen: click on and drag the Custom(Blank) screen from 

the Master List to the Mode you want the new screen to be in. Then double-click 

on the Custom(Blank) screen. 

7. Continue to the next section, 26.6.3: Create a Custom Screen/Edit a Screen, on 

page 26-133.
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26.6.3: Create a Custom Screen/Edit a Screen

1. When you have double-clicked on a screen in the Modes list, you will see the Edit 

Screen window. Note that these instructions are for creating a new screen, but the 

actions are the same when editing an existing screen, except that there are already 

items in the screen, e.g., text or data values. 

2. The left side of the screen lists items you use to build the screen, e.g., Line to place 

a line on the screen, Value to display a measured reading, or Waveform to display a 

waveform on the screen. See 26.6.4: Display Screen Items, on page 26-136, for a 

detailed explanation of all of the available screen items.
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3. The center of the screen displays the preview screen, where any changes you 

make, e.g., drawing text or entering a value, are reflected. The Screen Storage bar 

lets you know how much memory the screen will use.

•  The item you are currently editing is outlined in blue.

•  When you make changes to the settings in a screen e.g., entering a new screen 

title, click once in the preview screen to see the change implemented.

•  You can click and drag items in the preview screen to change their positions.

•  The preview screen gives you copy/paste and delete options:

• You can copy the entire screen 

and then paste it into another 

document. To do so, right-click 

in the preview screen and select 

Copy Image. The image is cop-

ied into the Clipboard and can 

then be pasted into another application.

• To delete an item on the screen, select it, right-click and select Delete 

Item.

• To remove all the items in the screen, right-click and select Remove All.

4. The bottom right side of the screen contains the Title and screen number fields.

a. You can changes the Title and Screen Number. When creating a new 

screen, give it a unique name and number. 

•To change the title, enter a new title in the Title field.
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•To change the screen number, enter the new number in the Screen# 
field.

b. The Meter Disk Simulator is a scrolling bar at the bottom of the display 

screen. If you want it on the screen, check the The Show Meter Disk Simu-

lator box. Note that you won’t see anything change on the Preview screen.

c. The Status Bar is the text line at the bottom of the screen that contains the 

battery icon, date and time, and system status. This option is selected by 

default. If you do not want the Status Bar on your screen, uncheck its box.

5. The upper right side of the screen displays entry fields for the active item. In the 

example below, the Value field is selected.

 

6. Edit or create a new screen by adding items you want in the screen. See the next 

section, 26.6.4: Display Screen Items, on page 26-136, for a list of all of the screen 

items and their settings.

7. When you have finished creating the screen, click Update Screen to save it. The 

Meter Screen Designer Main screen will be redisplayed, and the new screen will be 

listed in the Mode you assigned it to. (Note that if you do not want to save the 

screen, Cancel will being you back to the Meter Screen Designer Main screen with-

out saving any changes.)

8. When you have finished editing screens, close the Meter Screen Designer to return 

to the Device Profile screen. When you click Update Device, the new screens will be 

uploaded to the meter.
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26.6.4: Display Screen Items

This section explains all of the items used to edit/customize screens and their 

settings. 

 

    (1)
  Items     

                 (2)
       Settings for Items
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Value:

For the Value setting:

1. Select Small, Medium, Large, or Extra Large for the Font size. Note that only num-

bers 1-9 and characters “,”; “,”; “+”; and “-” can use the Extra Large setting.

2. For Coordinates, select the x and y positions from the pull-down menus. 

•  For the x position, the choices are Center Right, Center Left, Fixed Right, Fixed 

Left, and Preset Alignments (the Preset Alignment position is set up in the 

Screen Settings screen - see 26.6.2: Meter Screen Designer, on page 26-125),or 

you can select Actual and enter the x position in the entry field.

•  For the y position, the choices are Center Up, Center Down, Fixed Top, and Fixed 

Bottom, or you can select Actual and enter the y position in the entry field. 

3. The default for the Name field is Primary Readings: Volts A-N. Select another value 

as follows:

a. Click in the register field to display the window shown below.



     Doc#    E107707                                            26-138

26: Shark® 270 Meter

b. Click the arrow in the Group field to select a readings group from the pull-

down menu.

c. Click the arrow in the Item field to select the value you want from the pull-

down menu.

d. The value you selected will now be displayed in the name field.
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Value with Text:

The only difference 

between the Value 

and the Value with 

Text setting are the 

additional settings 

for scaling:

1. Follow steps 1-3 

of the Value set-

ting.

2. For Screen File versions below version 8, the Unit of Measure field can be changed, 

so that you can specify the scaling. The unit of measure will appear after the value; 

e.g., V.

3. You can enter a Label, which will be shown in front of the value; e.g., W.

4. If you want to use the scaling programmed in the meter for this value, click the Use 

Scale checkbox. If there is a scalar for the value, it will be placed after the value on 

the screen, before the unit of measure. See the example below:

Note that for Screen File Version 8 and higher, scaling is always done automatically 

by the meter, so you won’t see the Use Scale checkbox. 
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Text:

For the Text setting:

1. Select Small, Medium, or Large Font size.

2. For Coordinates, select the x and y positions from the pull-down menus. 

•  For the x position, the choices are Center Right, Center Left, Fixed Right, Fixed 

Left, and Preset Alignments (the Preset Alignment position is set up in the 

Screen Settings screen - see 26.6.2: Meter Screen Designer, on page 26-125),or 

you can select Actual and enter the x position in the entry field.

•  For the y position, the choices are Center Up, Center Down, Fixed Top, and Fixed 

Bottom, or you can select Actual and enter the y position in the entry field.

3. Enter the text you want displayed in the Text box.

Bar:

For the Bar setting, you set the y position for the bar.

Line:

For the Line setting, you enter the x1 and y2 settings, and x2 and y2 settings, to 

place the line where you want it in the screen.
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Rectangle:

For the Rectangle setting, you enter the x1 and y2 settings, and x2 and y2 

settings, to place the rectangle where you want it in the screen.

Harmonics:

For the Harmonics setting, you select the phase you want to display harmonics for, 

from the pull-down menu.
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Phasor:

For the Phasor item, you do not need to set any-

thing. This command places a phasor diagram on the screen.

Waveform:

For the Waveform setting, select the current or voltage phase for the waveform from 

the Phase pull-down menu.

Waveforms:

For the Waveforms setting, you do not need to 

change anything. This command places waveforms 

for all voltage and current phases on the screen.

Diagnostic:

The Diagnostic setting 

lets you choose infor-

mation to display on 

the screen. 

Select from the following:

•  Com Port 1 settings (Optical Port): displays this 

port’s communication settings on the screen.
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•  Com Port 2 settings (Serial Port): displays this 

port’s communication settings on the screen.

•  Expansion Slot 1 settings: displays the details for 

an I/O card installed in the first slot.The example 

on the right is for an INP100S Ethernet card.

•  Expansion Slot 2 settings: displays the details for an I/O card installed in the sec-

ond slot (see the example for Expansion Slot 1 settings).

•  Meter Status: displays details about the meter.

•  Segment check: this item creates a black screen. It is 

used to confirm that all pixels are working. (If any 

parts of the screen are not black when the screen is 

displayed, it indicates those pixels are not working.) 
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26.6.5: Additional Commands

This section explains some additional commands mentioned in the description of the 

Menu Bar in 26.6.2: Meter Screen Designer, on page 26-125.

•   Tools>Options: when you click Tools>Options, you see this screen.

It controls the display of small screen images when you hover over a screen in the 

Meter Screen Designer screen. By default, this option is enabled. If you don’t want 

to see the small screens, uncheck the box and click OK. 

•   Tools>Renumber Screens: when you click Tools>Renumber Screens you see this 

warning screen, since the renumbering can’t be undone. 

If you click Yes, the screens are renumbered in order starting at Mode 1’s first 

screen and continuing through Mode 3’s last screen.
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•   View>Settings Report: when you click View>Settings Report, you will see the 

following screen.

This screen contains the details of the current Screen Profile file that is open in 

Meter Screen Designer. The File menu at the top of the screen lets you: 

•   Open this file as a text file (View Text File).

•   Export this file as a Microsoft® Excel file (Export file).

•   Close this screen (Close). 
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26.7: View Screens

The meter’s Device Profile screen gives you the ability to see how settings changes 

will affect the meter’s display screens.

1. From the Device Profile’s Icon Bar, click View Screens. A small screen called Meter 

Faceplate Screens opens next to the Device Profile screen. See the example below.

2. You can check the box Move with Main Screen if you want to move the Meter Face-

plate Screens and Device Profile screens together, rather than separately.

3. When you make changes to a setting that affects a display screen, you will see the 

changes reflected in the smaller screen. For example, in the screens above, the 

Watt and VA hour scaling is 8 digits, with 2 decimal places, as shown in the smaller 

screen. In the next screen, the setting has been changed to 5 digits, still with 2 

decimal places. The next screen capture shows how that change affects the smaller 

screen.
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4. When you have finished using Meter Faceplate Screens, click the X in the top right 

corner to close it.
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26.8: Custom Display Multipliers

Gen 2 of the meter allows you to use different scaling for energy values on the 

meter’s display than for the energy readings in the meter. You set up scaling for the 

energy readings in the meter in the Energy Scaling and Averaging Method screen (see 

26.2.1: Configuring Energy, Power Scaling, and Averaging Method, on page 26-41.) 

One of the settings on that screen is a checkbox that allows different multipliers for 

the display. Once you check that box, you will see the Custom Display Multipliers set-

ting listed under View Meter Faceplate Screens, in the Device Profile screen’s tree 

menu. Note that most meter installations use need to use this setting.

1. Click Display>Custom Display Multipliers from the tree menu.

2. For each of the values Watt Hour and VA Hour, VAR Hour, Volt Hour and V2T Hour, 

Amp Hour and I2T Hour, Q Hour, Cumulative and Continuous Demand, and Second-

ary Energy set the following, using the pull-down menus:

•  Digits: 5; 6; 7; 8. 



     Doc#    E107707                                            26-149

26: Shark® 270 Meter

•  Decimals: 0 - 6. Note that if the entry would cause the accumulator to roll over 

quickly, the Example will be shown in red and there will be this note:

•  Scaling: unit; kilo (K); Mega (M).

•  Show Leading Zeros: check the box if you want leading zeros to show; e.g., if a 

value has five digits and zero decimals, and the reading is 400, if you select 

show leading zeros the reading would be 0400.

•The Example field shows the result of your choices: e.g., a reading for 

Digits: 8; Decimals: 3; Scale: K would be formatted: 00123.456k.

IMPORTANT! Since you are changing display screen fields which have a limited 

amount of space, it is recommended that you verify the meter faceplate screens 

before uploading the new profile to the meter (see 26.6.1: View Meter Faceplate 

Screens, on page 26-124). In general, if the primary energy fields are in a smaller 

unit than the display energy there should not be a problem; for example, if the 

primary energy is in kW, but you want the display energy to be in MW to make it 

simpler for the operator to view usage, that should be fine. However, using MW for 

primary energy and KW for the display will result in frequent rollovers and is NOT 

recommended. 

3. Before exiting the Device Profile screen, click Update Device to upload any new 

settings to the meter.
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27: Nexus® 1450 Meter
This chapter explains how to configure a Nexus® 1450 meter's programmable 

settings, which are stored in the unit's Device Profile. Chapter 7 contains detailed 

information on the Device Profile. 

NOTES: 

•  When the Device Profile of a Nexus® 1450 meter is updated, the meter reboots. If 

security was enabled when the meter rebooted, users may need to login again by 

disconnecting from the meter, reconnecting to it, and logging in again. This is true 

both for the user that updated the Device Profile and for any other users connected 

to the meter when it is updated.

•  If any of the meter settings are not valid, meter update will fail and you will see an 

error message.

27.1: Device Profile General Settings

1. From the Device Profile screen, double-click on the General Settings line or click on 

the + button next to it. All of the settings in the General Settings group are listed.

2. Click on the programmable setting you want to modify. The following sections 

explain the settings in the General Settings menu.
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27.1.1: CT and PT Ratios and System Hookup

Functional Overview of CT and PT Ratios:

Current and Potential Transformers are used mainly for the following reasons:

•   To insulate, and as a result isolate, the meter from high-voltage circuits.

•   To change the primary voltage and current to standard values and sizes that the 

meter can measure.

The CT and PT transformers deliver fractions of the primary voltage and current to the 

meter. With properly set ratios and multipliers, the readings of the meter can be used 

to determine the energy, voltage, current, or power of the system. 

This screen is also where you specify 50/60 Hz or Wide Band Auto frequency (for low 

and high Hz applications). Note that when the meter is operating in Wide Band Auto 

frequency mode, some of the Device Profile settings are not available: Line Frequency 

synchronization (Time Settings), and IEC 61000-4-30 Class A Edition 3/EN 50160. In 

addition, there are restricted Harmonics ranges and Waveform settings. These are 

explained in the relevant sections of this chapter.

1. From the General Settings menu, click the + button next to CT, PT Ratios and 

System Hookup. You will see the submenu shown below.

This submenu displays the current Device Profile's settings for CT, PT ratios and 

connection type. 
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2. Double-click on any of the settings. You will see the CT and PT Ratios screen. 

3. Make changes to this screen according to your application requirements.

When you change a PT or CT Ratio, CommunicatorPQA® software updates the cor-

responding Full Scale value entered in the Limit and Waveform Full Scales setting. 

When you click OK on this screen, CommunicatorPQA® software opens the Limit & 

Waveform Full Scales screen so that you can verify the settings (see 27.1.2: Limit 

and Waveform Full Scales, on page 27-5). 

•   Enter Primary and Secondary Current and Voltage.

•   Using the pull-down menu, choose the Hookup mode that matches the connec-

tion you have to the Nexus®1450 meter. Choose from the following: 

• Wye

• Delta 3 CTs

• Delta 2 CTs



     Doc#    E107707                                            27-4

27: Nexus® 1450 Meter

• 2.5 Element Wye

• 4 Wire Delta 

This value must be set properly for the meter to calculate readings 

correctly.

See the Nexus® 1450 Meter Installation and Operation Manual for 

connection diagrams.   

•  Total VA/VAh Computation Method (not displayed if Hookup is Delta): choose the 

VA/VAh computation you want used: Arithmetic Sum or Vector Sum, from the 

pull-down menu.

         Arithmetic Sum - the formula for this calculation is:

          Vector Sum - the formula for this calculation is: 

       Generally, the superior method for calculation is the Vectoral method;

       however, both methods are available.

•  Frequency Range: select 50/60 Hz or Wide Band Auto from the pull-down menu. 

Wide Band Auto is used for applications with frequencies other than 50/60 Hz. 

The meter can support applications with frequencies as low as 25 Hz and as high 

as 400 Hz. When you select Wide Band Auto, the meter will adjust automatically 

to the frequency used by your application. Your meter must have firmware ver-

sion 3 or higher to support the Wide Band Auto feature.

4. Click OK. If changes have been made, a message window opens asking you to 

verify that the Limit Full Scales are correct. 

5. Click OK. The Limit and Waveform Full Scales screen opens (see Section 27.1.2: 

Limit and Waveform Full Scales, on page 27-5). 

6. To implement any changes, click the Update Device button to send the new 

profile to the meter. 

You will see a warning message that logs will be reset, and you will be given the 

opportunity to retrieve the logs before they are cleared. Resetting the logs 

VA VA VA VAT a b c= + +

VA W VART T T= +2 2
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prepares the meter for placement in a new installation or change of the meter 

Transformers.

27.1.2: Limit and Waveform Full Scales

All Limit and Waveform settings (see Sections 27.1.1 and 27.3.5, respectively) are 

based on a percentage of the Full Scale. Full Scales are based on the CT and PT ratios 

(see Section 27.1.1: CT and PT Ratios and System Hookup, on page 27-2). The % of 

Full Scale is defaulted based on the CT and PT ratio. If the user wants, the Full Scales 

can be adjusted to the actual power system condition, to optimize the triggering con-

ditions.

Set the CT and PT ratios first; CommunicatorPQA® software automatically recalcu-

lates the Full Scales every time the CT and PT ratios change and presents them for 

your verification. 

1. From the General Settings menu, click on the + button beside Limit and Waveform 

Full Scales or double-click on the Limit and Waveform Full Scales line. You will see 

the submenu shown below.

This submenu displays the current Device Profile's settings for the Limit and 

Waveform Full Scales. The values shown here are the default meter settings.

Frequency and Voltage values are nominal values. The Power Phase is computed using 

nominal Voltage and rated maximum current. In most cases the software automati-

cally computes the proper value - you will not need to change it.
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2. Double-click any of the settings. You will see the Limit and Waveform Full Scales 

screen.

3. Enter the Full Scale for each parameter.

NOTES:

•   The Limits and Waveform settings (see 27.3.1: Limits, on page 27-42 and 

27.3.3: PQ Thresholds (Waveform Recording), on page 27-56, respectively) are 

based on a percentage of the Full Scales entered here.

•   CommunicatorPQA® software automatically recalculates the Full Scale Voltages, 

currents and power every time the CT and PT ratios change. 

•   Power Phase is the amount of power per each phase; Power Total is the power of 

all phases combined.

4. When all changes are entered, click OK to return to the main Device Profile screen. 

For any changes to take effect, you must click the Update Device button to send 

the new profile to the meter. 
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27.1.3: Time Settings

To edit a Device Profile's Time settings:

1. From the General Settings menu, double-click on the Time Settings line. You will 

see the submenu shown below. 

•  DST stands for Daylight Savings Time.

2. Double-click on any of the programmable settings; you will see the Time Settings 

screen.
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3. Make changes to this screen according to your application requirements.

•   Zone Descriptor: A Zone Descriptor sets the time zone for the meter. 0 = Green-

wich Mean Time. Consult the chart below to find the Zone Descriptor for your 

time zone.

•  Daylight Savings Information:

• Disabled: Disables an automatic adjustment for Daylight Savings Time.

• Auto DST U.S. EPA 2005: Sets Daylight Savings Time automatically to 

the 2007 standard for the United States: the time changes automatically 

occur at 2:00 AM (your local time), on the second Sunday in March and 

the first Sunday in November.

• User Defined: Allows you to set the Daylight Savings Time start and end 

times manually. Fields open that let you set the beginning and ending 

dates for Daylight Savings Time.

GMT Greenwich Mean Time Table (Dublin, London)

-1.00   Azores +1.00   Brussels, Paris, Warsaw

-2.00   Mid-Atlantic +2.00   Athens, Cairo, Helsinki

-3.00   Buenos Aires, Georgetown +3.00   Baghdad, Kuwait, Moscow, 
Tehran

-4.00   Atlantic Time (Canada), Santiago +4.00   Kabul, Baku

-5.00   Eastern Time (USA and Canada), 
Lima

+5.00   Karachi

-6.00   Central Time (USA and Canada), 
Mexico City

+6.00   Dhaka

-7.00   Mountain Time (USA and 
Canada)

+7.00   Bangkok, Hanoi, Jakarta

-8.00   Pacific Time (USA and Canada), 
Tijuana

+8.00   Beijing, Hong Kong, Singapore

-9.00   Alaska +9.00   Osaka, Sapporo, Seoul

-10.00  Hawaii +10.00  Brisbane, Melbourne, Guam, 
Hobart

-11.00  Midway Island +11.00  Magadan, Solomon Islands

-12.00  Eniwetok +12.00  Auckland, Fiji
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•  Clock Synchronization Source: select the type of meter clock synchronization to 

use from the pull-down menu:

•  Disabled: No Time Synchronization will take place, unless IRIG-B is 

applied.

•  IRIG-B: IRIG-B is a standard time code format that synchronizes event 

time-stamping to within 1 millisecond. An IRIG-B signal-generating 

device connected to the GPS satellite system synchronizes Nexus® 1450 

meters located at different geographic locations. Nexus® meters use an 

unmodulated signal from a satellite-controlled clock (such as Arbiter 

1093B). For details on installation, refer to the Nexus® 1450 Meter 

Installation and Operation Manual and the User’s Manual for the satellite-

controlled clock in use. 

NOTE: When IRIG-B is applied, it takes precedence over any of the other 

Time Synchronization settings - it is not even necessary to select IRIG-B 

from the menu if it is applied.

• Line Synchronization: uses the frequency zero crossings to provide a time 

reference for the meter. The basic function of Line Frequency Clock Syn-

chronization is to adjust the real time clock to track the time based on the 

power line frequency. For this purpose, Phase A voltage only is used. 

When you select this option, a Frequency pull-down menu is displayed, 

letting you select between 60 Hz and 50 Hz. The selection should be 

based on the nominal frequency in the jurisdiction where the meter is 

located. 

NOTE: This option is not available if the meter’s frequency is set to Wide 

Band Auto (see 27.1.1: CT and PT Ratios and System Hookup, on 

page 27-2).

• How Time is Adjusted

After the clock is synced to the line, the meter periodically checks 

the cumulative difference between the real time clock in seconds 

and the line cycle count. If the absolute difference between the two 

accumulations is more than 1 second or 60 (50) cycles, the clock is 

adjusted + / - 1 second accordingly.
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• SNTP (Simple Network time Protocol): with SNTP you access a Network 

Time Protocol (NTP) Server for time synchronization. The NTP server can 

be either a device with a real-time clock that is networked with your 

meter, or an NTP server on the Internet. To use SNTP, select it from the 

pull-down menu. 

a.The screen changes to include a Configure button: click it to set up 

SNTP. 
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b. The Advanced Network Options screen opens, showing the Services

tab, since you need to enable SNTP before you can configure it. From

the pull-down menu next to Network Time Sync, click SNTP Auto (SNTP

enabled for any available port), SNTP Port 5 (SNTP enabled for only

port 5), or SNTP Port 6 (SNTP enabled for only port 6).

c. Click the SNTP tab.

d.Enter:

• SNTP Mode: select Client Unicast or Client Broadcast:

• In Client Unicast mode, the meter connects to the specified SNTP

server using the configured SNTP IP address(es). First, the meter

synchronizes with the SNTP server. After that, the meter periodi-

cally sends time requests to the SNTP server.

• In Client Broadcast mode, the meter listens for broadcast

messages sent by the SNTP server. After receiving the first

broadcast message, the meter synchronizes its clock using the

unicast mode, and afterwards does not send any packets to the

SNTP server. Instead, it uses received broadcast messages from

the SNTP server to adjust its clock.
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• Select Internet Protocol Version (IPv4 or IPv6).

• If Configured Clock Sync is not SNTP, click the Configure Source 

button to display the Time Settings screen, and choose SNTP for time 

synchronization. This situation can occur if you previously selected a 

different time sync method and are now setting up SNTP directly 

through the Advanced Network Settings screen (Chapter 21 explains 

the options in the Advanced Network Settings screen).

Note that if SNTP is already displayed in the Configured Clock Sync 

field, you do not need to click the Configure Source button.

• The SNTP Sync Rate in minutes: this is how often the meter checks 

the SNTP server for time updates. EIG recommends that the sync 

rate be set to other than the logging interval, if possible; for exam-

ple, if the logging interval is every 15 minutes, set the sync rate to 

every seven minutes. This is done to prevent erroneous time stamps 

in the log. 

• The SNTP Sync Process Timeout in seconds: this is how long to wait 

for the server to respond. Typical timeout should be set for 30 sec-

onds.

NOTE: Make sure to set SNTP Sync Rate and SNTP Sync Process 

Timeout as non-zero values; e.g., 1440 minutes, 60 seconds.

• At least one SNTP server: set NTP server 1 to time.nist.gov (you can 

enter a second SNTP server address if you want, if you are using Cli-

ent Unicast mode.)

e.Click OK.

4. To set the meter's on-board clock, use Set Device Time from the Tools Menu (see 

20.1.4: Set Device Time, on page 20-5).

5. When all changes are entered, click OK to return to the main Device Profile screen. 

For any changes to take effect, you must click the Update Device button to send 

the new profile to the meter.
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27.1.4: Labels

Labels are user-defined names for the Nexus® 1450 meter and the I N Measured 

terminal. You also use the Labels screen to select the power direction, and the power 

factor display.

It is important to label the meter (under "Meter Designation") with a unique name 

because that label becomes the file name of any logs retrieved from that meter. Dupli-

cate meter designations interfere with retrieved log databases. See Chapters 16 and 

19 for more details on logs.

1. From the General Settings menu, double-click on the Labels line. You will see the 

submenu shown below.
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2. Double-click on any of the parameters; you will see the Labels screen.

3. Enter labels in the appropriate fields.

•   Meter Designation must be set for partial log retrieval. You can use any charac-

ter allowed by the Windows® operating system. 

• In English versions the following characters don’t work: 

 \ / : * ? " < > | 

• For meters used internationally by multilingual users, we recommend you 

use only alphanumeric characters allowed by your operating system.

•   Your selection in Power Direction determines which quadrants of Watt-hours are 

considered Received and Delivered.

•   Your selection in Power Factor Display determines the display of Quadrants in 

the Power Factor screen.

•   The Memo field is used to enter notes about the meter, such as the location, or 

other relevant details.
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•   The Phase Angle representation determines how the voltage phase angles are 

represented. 90% of users will use the default, which is the first radio button: 

“Positive angle for events after the reference and negative angle for events prior 

to the reference’; however, you can choose the opposite display by selecting the 

second radio button, if you wish.

4. When all changes are entered, click OK to return to the main Device Profile screen. 

For any changes to take effect, you must click the Update Device button to send 

the new profile to the meter.
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27.1.5: Communications 

1. From the General Settings menu, double-click on the Communications line. You will

see the submenu shown below.

2. Double-click on any of the settings (e.g., "Serial Port 1"): you will see the

Communications Settings screen.
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The current Device Profile settings for the Nexus®1450 meter's 4 Communications 

ports are shown: address, baud rate, data bits, parity, stop bits, Tx (Transmit) 

delay, (communication) protocol, and mode. You may use the one of the Nexus® 

External Displays to learn the current baud rate, address and communication proto-

col of each meter port. See the Nexus® 1450 Meter Installation and Operation 

Manual for details. 

3. Make changes to this screen according to your application requirements by clicking

on the box or pull-down menu of any of the following settings:

• Address: assign an address to each port to communicate with other devices.

Multiple Nexus® meters on an RS485 bus must each have a unique address set

for the port that is connected to the bus.

• Baud Rate: from the pull-down menu, select 1200, 2400, 4800, 9600, 19200,

38400, 57600, or 115200. The baud rate entered in this field must match the

baud rate of the device connected to the Nexus® 1450 meter at this port. Use

9600 for modem connections.

• Data Bits: this field is display only.

• Parity: None, Even, or Odd.

• Stop Bits: 1 or 2.

• TxDelay (Transmit Delay): use the pull-down menu to select from: 0ms, 10ms,

20ms, 30ms, 40ms, 50ms, 60ms, or 70ms. Leave the Tx delay at 0ms unless

you are using equipment that requires a delay in the response time, such as a

radio modem.

• Protocol: use the pull-down menu to select from Modbus RTU and Modbus

ASCII. Direct connections made through CommunicatorPQATM software must use

either Modbus RTU or Modbus ASCII protocol (we recommend Modbus RTU).

• Mode: Select the serial port mode from the pull-down menu:

• Serial ports 1 and 2 are Slave ports, which is the only option. Serial ports
3 and 4 can optionally be set as Slave ports.
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• Serial ports 3 and/or 4 can be used for Output modules. To do so, set the
port to Master (I/O modules) mode, and set the port ‘s Baud Rate to
57600, which is the default Baud Rate for the I/O modules.

• Serial port 4 can be used as an RTU Master. To do so, select RTU Master
from the Mode menu. This feature lets the meter poll up to 128 Modbus
registers, for example, one Modbus register from 128 Modbus devices; or
128 Modbus registers from one Modbus device; 32 Modbus registers each
from 4 Modbus devices.

• Network Card Settings: Port 5 is an RJ45 Ethernet port and Port 6 is a Fiber

Optic Ethernet port. You may want to check with your Network Administrator for

the correct settings to enter into these fields, since settings vary from network

to network. The settings for these ports’ cards are:

• IP Address: for the RJ45 Ethernet port - port 5, you have the following choices:

- Enter the IPv4 address of the card.

- Click “Obtain an IPv4 address automatically” to use DHCP to assign the

IPv4 address to the card.

- Click “Obtain an IPv6 address automatically” to use DHCP to assign an

IPv6 address prefix to the card; the firmware will then generate a unique IPv6

address for the card.

- Click “Use Modified EUI-64 IPv6 address” to use the EUI-64 method to assign

an IPv6 address to the card.

NOTES: 

- If you use DHCP for a Network card port, you cannot configure the card as an

IEC 61850 Protocol server.

- You will see the DHCP options if your meter has Firmware version 4 or higher.

See 21.5.1: DHCP, on page 21-4, for an explanation of DHCP.

- Port 6, the Fiber Optic port, does not support DHCP. Enter the meter’s IP

address.

• Subnet Mask: enter the subnet mask.

• Default Gateway: enter the Ethernet gateway’s IP address.

• Advanced Settings button: click it to open a screen that lets you set Network

card features for the Ethernet ports (ports 5 and 6); see Chapter 21: Total Web

Solutions and the WebViewTM Energy Dashboard, on page 21-1, for details.
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4. When all changes are entered, click OK to return to the main Device Profile screen.

For these changes to take effect, you must click the Update Device button. This

sends the new profile to the meter.

IMPORTANT! In order to prevent communications problems, be careful when making 

changes in the Communications Settings screen. For example, if you change the baud 

rate of the port connected to a computer, be sure to make the same change to the 

computer port's baud rate. If you change a port's address, be sure to update the 

address settings of any device that communicates with the port. 
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27.1.6: Configure High Speed Value Update Rate  

The Configure High Speed Value Update Rate setting lets you configure the update 

rate for the meter's High Speed Inputs. You can set a number from two to 20 cycles. 

This number determines how often any values assigned to the High Speed Inputs are 

updated.

1. From the General Settings menu, double-click on the Configure High Speed Value 

Update Rate line. You will see the screen shown below.

2. Enter the number of cycles you want before an update is performed: enter a 

number from 2 to 20.

3. Click OK to save your changes and exit the screen. For any changes to take effect, 

you must click the Update Device button to send the new profile to the meter. 

27.1.7: DNP Custom Classes Map

The DNP Custom Classes Map setting lets you set up DNP communication for the 

meter. From the General Settings menu, double-click on the DNP Custom Classes Map 

line and on the DNP Level 2 line. You will see the screen shown below. For details on 

programming the DNP Level 2 settings, see Chapter 22. 
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27.1.8: Custom Modbus Map

This setting lets you customize the meter’s Modbus map to meet your application 

needs. You can select up to 256 meter data points in a block of 2048 registers (4096 

bytes) and customize the order and format of the data points. 

1. From the General Settings menu, double-click on the Custom Modbus Map line. You 

will see a screen like the one shown below, though most of the fields will be blank if 

you haven’t yet set up this screen.

1. Data entry is straightforward. Each entry field is described below. Note that not all 

selections appear on the screen at the same time. Use the scroll buttons to view 

additional data/entry fields on the screen. Certain entries (such as Format, Data 

Size, etc.) have different allowable selections depending on the data point used. 

The pull-down menu adjusts to provide the appropriate selections for each data 

point.

•   Data Point Selection: there are two different ways to select a data point:

a. Refer to the Nexus® 1450 meter’s Modbus map and find the associated line 

and point for the value you want. When you enter those values into the 

screen table, the software displays the associated group and channel.

• The Nexus® 1450 meter’s Modbus Protocol Application Guide can be 

downloaded from the EIG website: https://electroind.com/products/Nex-

us_1450/pdf/Nexus-1450-Meter-Modbus-Manual_E171707.pdf. 

b. Double-click the Group field. From the pull-down menus, select a group and 

its associated channel value. The software displays the map and line 

values.

https://electroind.com/products/Nexus_1450/pdf/manuals/Nexus-1450-Meter-Modbus-Manual_E171707.pdf
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•   Number of Registers: this field is display only. The software computes the 

number in this field based on the data size selected in the Data Size column.

•   Start Register: this field is display only. The software assigns and adjusts Start 

register numbers to take into account previous entries and data sizes. The Start 

register is the number of the first register used in polling. The Start registers are 

shown as 4x to describe them as holding registers, for SCADA applications.

•   Format: from the pull-down menu, select a format type for a value, such as 

Signed Integer, Unsigned Integer, and 4 Byte IEEE Float.

•   Data Size: from the pull-down menu, select the number of bytes you want to 

represent the data point: 2 Byte or 4 Byte.

•   Unit: if the polled value is viewed as an integer, the Unit field tells the software 

where to place the decimal point. 

Examples 

• If you select .01, a polling value 1,800.92883 is interpreted as 

180,092.883.

• If you select 100, a polling value 1234 is interpreted as 123400.

•   Primary/Secondary: the meter normally computes values in secondary units. 

Where applicable, you may select primary or secondary. If Primary is selected, 

the value is multiplied by the appropriate CT and/or PT values.

•   Absolute Value: where appropriate, you may have the option of having the data 

point computed as a signed or absolute value. Select either:

• No: to have the data point computed as a signed value.

• Yes: to have the data point computed as an absolute value.
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•   Byte Order: for most of the data points, you can select the polling order of the 

registers/bytes to match what the SCADA system needs. The choices are: MSR, 

MSB (most significant register, most significant byte); MSR, LSB (most signifi-

cant register, least significant byte); LSR, MSB (least significant register, most 

significant byte); and LSR, LSB (least significant register, least significant byte). 

EIG meters store data as MSR, MSB, whereas most SCADA systems use LSR, 

LSB. You can either select an alternate order here, for example, LSR, LSB, or 

you can leave the data as is and then have your SCADA system change the 

order after the data is polled. 

•   Display/Modulo/Offset: depending on the data point, select one or more 

additional options with appropriate sub-selections.

• Display: for certain data points, interpretation and display options are 

offered. 

Example: For “AN Angle” values, you can represent and display as 0 to 

360 degrees or -180 to +180 degrees, etc. Selections appear in a pull-

down menu for the associated point. You may want to select -180 to 

+180 degrees if you ant to know if a phase angle is positive or negative in 

relation to the reference.

• Modulo: Certain values are cumulative and can roll over and start 

recounting from zero. For those values, where required, you can enter a 

point at which the rollover will occur.

• Offset: Where allowed, you can enter a value (offset) that will be added 

to the data point when it is computed.

3. Click OK to save your changes and exit the screen. For any changes to take effect, 

you must click the Update Device button to send the new profile to the meter. 
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27.2: Revenue and Energy Settings

Revenue and Energy Settings are the second group of settings in the Device Profile.

1. From the Device Profile screen, click on the + button next to Revenue and Energy 

Settings or double-click on the Revenue and Energy Settings line. All of the settings 

in the Revenue and Energy Settings group are listed.

 

2. Click on the programmable setting you want to modify. The following sections 

explain the settings in the Revenue and Energy Settings menu.
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27.2.1: Energy Scaling

1. From the Revenue and Energy Settings menu, double-click on the Energy Scaling 

line. You will see the Energy Scale 

Settings screen. 

•   Using the Energy Scale Settings screen you can select the number of digits, 

decimal point placement and Energy unit for displayed readings. 

•   The Example field shows you the scaling choices you made applied to an exam-

ple reading.     

2. When you are done, click OK to return to the main Device Profile screen. For these 

changes to take effect, you must click the Update Device button to send the new 

profile to the meter.

To configure scaling for a reading, enter:
1. Number of Digits, 2. Number of Decimal Places, 
3.Unit of Measurement; 4. Example of the resultant scaling is shown here
                             1                2         3                      4
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27.2.2: Demand Integration Intervals

See the Nexus® 1450 Meter Installation and Operation Manual for details on Demand 

intervals.

1. From the Revenue and Energy Settings menu, click on the + button next to 

Demand Integration Intervals or double-click on the Demand Integration Intervals 

line. You will see the submenu shown below.

2. Double-click on any of the settings. You will see the screen shown below.
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3. Click on the tabs at the top of the screen to navigate from one setting to another. 

Make changes to the settings according to your application requirements. Following 

is a brief description of each setting and its function:

•   Thermal Averaging (tab shown on previous page): use to set hours, minutes and 

seconds for a precise thermal window of demand data.

Thermal Averaging (tab shown on previous page): use to set hours, minutes and 

seconds for a precise thermal window of demand data.

• Traditional analog Watt-hour meters use heat-sensitive elements to 

measure temperature rises produced by an increase in current flowing 

through the meter. A pointer moves in proportion to the temperature 

change, providing a record of demand. The pointer remains at peak level 

until a subsequent increase in demand moves it again, or until it is manu-

ally reset. 

The Nexus® 1450 meter mimics traditional meters to provide Thermal 

Demand readings. Electronic thermal demand emulation is the logarith-

mic average of the power used, with a more recent load being weighted 

more heavily than a less recent load, (approximated exponentially). Each 

second, as a new power level is computed, a recurrence relation formula 

is applied. This formula recomputes the thermal demand by averaging a 

small portion of the new power value with a large portion of the previous 

thermal demand value. The occurrence of the proportioning of new to 

previous is programmable, set by the averaging interval. The averaging 

interval represents a 90 change in thermal demand to a step change in 

power. So, for example, with a 15 minute set interval, the meter will 

record 90 of a change in load in 15 minutes, 99 in 30 minutes, and 99.9 

in 45 minutes. 

Because thermal demand emulation is the logarithmic average, the 

demand is not set to zero on a demand reset. On a demand reset, pres-

ent demand becomes the new maximum demand.

• The Max/Min Thermal Average Block Interval fields are used if you 

want to track the maximum and minimum Demand in more than one 

interval, e.g., the Max and Min Demand in a 10 minute (First Interval) 

and a 15 minute interval (Second Interval).
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•   Block Window/Rolling Window: select the type of Demand Averaging to use - 

Block or Rolling - from the Demand Type pull-down menu: 

• Block Window settings: to set the length of the block interval used for 

Demand calculations and other interval-based functions; also used to set 

End of Interval pulse. Block averaging is also known as fixed window 

averaging. A window is the user set time range, e.g., 15 minutes. Compu-

tation is performed on that 15 minute interval, and after that, a new set 

of computations will be started. For example, Window 1 will be from 0 to 

15 minutes, Window 2 will be from 16 to 30 minutes, and so on. 

a. Use the Hours, Minutes, and Seconds fields to set the length of the Block 

Interval.

b. If you want to generate a pulse at the end of the set interval, check the box 

next to the Generate End of Interval Pulse field and select the pulse you 

want to use (choices are: Test Pulse 1, Test Pulse 2, Pulse Output 1, Pulse 

Output 2) and the pulse width (600 - 635 milliseconds).

NOTE: The Block Window Sync field indicates whether the meter is being       

synchronized with pulses from a High Speed input. This option is set in the 

Input Type field of the High Speed Inputs screen (see 27.3.5: IEC 61000-4-

30 Harmonic & Interharmonic Thresholds, on page 27-69).
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• Rolling Window: also known as a sliding window, functions like multiple, 

overlapping Block averages. You define the subintervals at which an aver-

age of Demand is calculated. A window duration is the user set time, such 

as 15 minutes, but it moves, so that, for example, Window 1 is 0 to 15, 

Window 2 is 1 to 16, Window 3 is 2 to 17, and so on.

a. Set the Hours and Minutes fields under Rolling Averaging Sub-Interval 

Window.

b. Rolling Sub-Intervals: set the number of rolling windows you want to 

"string together." The display field shows the amount of time in the Rolling 

Average Interval Window (in the example screen above, 15 minute sub-

intervals x 3 rolling sub-intervals = 45 minute rolling average interval 

window).
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•   Reset: Allows you to specify a Time of Use read whenever Maximum Demand is 

reset.

• Check the box to perform the TOU read. By selecting this, the meter will 

place all of the TOU values in the previous month’s registers. Otherwise, 

the meter will default to self read based on a date set in the meter.

• Leave the box unchecked if you don't want to perform a TOU read. 

4. When all changes are entered, click OK to return to the main Device Profile screen. 

For these changes to take effect, you must click the Update Device button to send 

the new profile to the meter.
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27.2.3: Internal Pulse 

The Internal Pulse setting lets you assign channels to the meter’s pulse outputs and to 

the test LEDs. The channel selection sets the type of pulse that will be generated. For 

example, the Test Pulse 1 LED can generate Energy Pulses for conventional testing or 

Reactive (VARh) Pulses for complex testing and approvals. This setting also allows you 

to determine the frequency and duration of the pulse for each output and LED. 

1. From the Revenue and Energy Settings menu, click on the + button next to 

Internal Pulse or double-click on the Internal Pulse line. You will see the screen 

shown below.

2. To make selections on this screen:

a. Select the assigned channel for the pulse/output. This is the demand that will be 

output as a pulse. 

b. Enter Watt hour per pulse, pulse width, mode and form for each pulse/output.

   NOTES:  

•  Form A = Pulse; Form C = Transition

•  No more than one Pulse Output can be assigned as an Operation Status Output.
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3. When all changes are entered, click OK to return to the main Device Profile screen. 

For these changes to take effect, you must click the Update Device button to send 

the new profile to the meter.

Considerations on Setting KYZ Outputs

KYZ Pulses are produced at a rate proportional to the rate of energy accumulation, a 

feature that makes them useful for accuracy testing. Decreasing the value of the Watt 

Hour per Pulse field increases the pulse rate, improving the moment-to-moment 

precision of the output. The increased pulse rate means that the pulses are of shorter 

duration. Most equipment for detecting and counting pulses has a minimum detection 

time, so pulses that occur too rapidly might not be detected and counted. 

The value in the Pulse Width field is used to force the meter to generate minimum 

width pulses in situations where proportional width pulses would occur too quickly to 

be measured. A pulse width setting that does not match appropriately with the input 

level and Watt hour per pulse setting will result in output that, in the short term, will 

not verify correctly.

For proper operation of this feature, the pulse width should be set to a value that is 

longer than the detection time required by the monitoring equipment, and shorter 

than the pulse period that the inputs and Watt hour per pulse setting would produce. 

The formula for the second quantity is:

3600 x -   

   

Watt hr per pulse

Total Power
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Some example cases are shown in the table below. For proper operation the pulse 

width should be set to a value that is less than the computed value of seconds per 

pulse.     

   Voltage
Phase to

Neutral/Phase

Volts         Volts

Current            

Amps     Watts

Total Power 
Wh/Pulse

Wh

Pulses/Hour

Pulses

Seconds/Pulse

Seconds

69.28 120.00 1 207.85 1.8000000 115.47 31.18

69.28 120.00 1 207.85 0.2078461 1000.00 3.60

69.28 120.00 5 1039.23 1.8000000 577.35 6.24

69.28 120.00 5 1039.23 1.0392305 1000.00 3.60

120.00 207.85 1 360.00 1.8000000 200.00 18.00

120.00 207.85 1 360.00 0.3600000 1000.00 3.60

120.00 207.85 5 1800.00 1.8000000 1000.00 3.60

277.13 480.00 1 831.38 1.8000000 461.88 7.79

277.13 480.00 1 831.38 0.8313844 1000.00 3.60

277.13 480.00 5 4156.92 1.8000000 2309.40 1.56

277.13 480.00 5 4156.92 4.15629219 1000.00 3.60
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27.2.4:Transformer / Line Loss Compensation

Transformer losses are power used by the transformer while working. The more load 

on the transformer, the higher the transformer losses. There are two types of trans-

former losses:

•   No load losses - these are the fixed losses that keep the transformer up and 

running.

•   Load losses - these vary with changes in the load.

When the meter is located on the secondary side of a customer’s transformer, a utility 

will want to add the transformer losses into the energy usage calculation. However, 

this practice is regulated by local jurisdiction and regulations. The meter has the 

capability to add in or subtract out these transformer losses, depending on the user’s 

specific needs.

Line losses are similar to transformer losses, except that they are used to compensate 

for loss incurred on wires, such as transmission lines.

1. From the Revenue and Energy Settings menu, click on the + button next to 

Transformer/Line Loss Compensation or double-click on the Transformer/Line Loss 

Compensation line. You will see the submenu shown below.

2. The menu displays the current values for the meter's Transformer Loss Compensa-

tion.

•  LWFE = percent loss of Watts due to iron

•  LVFE = percent loss of Vars due to iron
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•  LWCU = percent loss of Watts due to copper  

•  LVCU = percent loss of Vars due to copper

3. Double-click on any of the loss values. You will see the screen shown below.

4. Click on TLC Calculator to find the values to enter into the Percent Loss fields. The 

TLC Calculator button launches the TLC Calculator that performs the calculations 

for you once the required data is entered.  

NOTE: Appendix A contains screen captures of the TLC Calculator with example 

numbers, and an explanation of Loss Compensation considerations.

5. Enter the percent loss of Watts and VARS for copper and iron in the appropriate 

fields. 

6. Enable or Disable Transformer Loss Compensation with the first pull-down menu at 

the bottom of the screen. The optional selections are:

•   Disabled

•   Iron (Fe) Only 

•   Copper (Cu) Only
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•   Both Iron and Copper (Fe and Cu)

7. With the second pull-down menu, select from the following options:

•   Add to Watts and Subtract from VAR

•   Subtract from Watts and Add to VAR

•   Add to Watts and VAR

•   Subtract from Watts and VAR

8. With the third pull-down menu, apply the loss based on the power flow direction by 

selecting one of the following options:

•   Both +Watts and -Watts 

•   -Watts only

•   +Watts only 

3. When all settings are complete, click OK to return to the main Device Profile 

screen. For any changes to take effect, you must click the Update Device button to 

send the new profile to the meter. 

27.2.5: Cold Load Pickup 

Cold Load Pickup is used to manage Demand in the event of a power outage. You set 

the amount of time (in seconds) power is off to identify a power outage that is the 

responsibility of the utility (as opposed to a very short term loss of power that is not 

their responsibility); then you set the amount of time (in minutes) you want to wait 

before Demand starts again. This time should correspond to the “grace” period the 

utility applies to avoid charging for motor startup, etc. after a power outage. 

1. From the Revenue and Energy menu, click on the + button next to Cold Load 

Pickup or double-click on the Cold Load Pickup line. You will see the submenu 

shown below.
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2. Double-click on one of the parameters to open the screen shown below.

3. Make the following selections in accordance with your application needs:

•   Time after control power is restored to start demand - can be 1 to 60 minutes, 

or Disabled. 

•   Minimum time control power must be off before using Cold Load Pickup - can be 

from 0 to 255 seconds.

4. When all changes are entered, click OK to return to the main Device Profile screen. 

For these changes to take effect, you must click the Update Device button to send 

the new profile to the meter.

27.2.6: Pulse Accumulations

Pulse accumulators are used to count and/or aggregate pulse information from exter-

nal devices, using the High Speed inputs. These devices may be gas, water, or elec-

tricity meters; energy management systems; SCADA devices; or any pulse-

generating device. 

This section of the Device Profile displays a series of eight running totals available on 

the Nexus® 1450 meter. Each total can be added to (or subtracted from) other totals. 

This allows you to set the High Speed inputs located directly on the meter to accumu-

late pulses. 

NOTE: If you use these inputs for pulse accumulations, do not set them to record 

waveforms - if you do, you will record endless waveforms.
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1. From the Revenue and Energy Settings menu, click on the + button next to Pulse 

Accumulations or double-click on the Pulse Accumulations line. You will see the 

screen shown below.

2. High Speed inputs 1-8 are listed in order under Source. Enter the following 

information or use the pull-down menus to select:

•   Units/Count - this is the scale factor that normalizes the pulses so that they can 

be aggregated. Pulses are stored in primary values.

•   Aggregator - this allows you to place the pulse register into a separate accumu-

lation register that can aggregate (add) or net (subtract) values.

•   User Assigned Label - this window allows you to enter a label designation for the 

source.

•   Mode - you can set Pulse or Transition. A transition means from open to shorted/

closed or from shorted/closed to open; a pulse contains 2 transitions, open to 

shorted/closed, followed by shorted/closed to open. 
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•   Average Full Scale - for Nexus® meters, in order to set a limit on a reading it 

needs a Full Scale value as the 100 reference. You can set a limit on the 

average number of pulses per interval.

•   Device Hour Reading and Aggregator - source device is the meter you are 

connected to. The Hour reading is either Quadrant 1 and 4 Watt-hour or Quad-

rant 2 and 3 Watt-hour. The Aggregators indicate whether the count should be 

added to, or subtracted from, Aggregators 1-4. You can choose None if you don’t 

want the count to affect any of the Aggregators.

•   Aggregators: The “buckets,” or Totalizer fields where pulse counts from the High 

Speed inputs and from the Watt-Hour counters can be totaled. The user can 

assign a label to each of the Aggregators. See the Average Full Scale description 

above for an explanation of this field - it has the same use here, except for the 

Aggregators.

3. When all data has been entered, click OK to return to the main Device Profile 

screen. For any changes to take effect, you must click the Update Device button to 

send the new profile to the meter.

27.2.7: External Display Options

Many utility companies want to read secondary volts and primary power readings. 

This setting configures a P40N+ external display to read either primary or secondary 

Volts. All other readings will be in the primary, regardless of this setting.

1. From the Revenue and Energy Settings menu, double-click on the External Display 

Options line. You will see the screen below.

2. Use the pull-down menu to select either primary or secondary units for Voltage.

3. Click OK to return to the main Device Profile screen. For these changes to take 

effect, you must click the Update Device button to send the new profile to the 

meter.
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27.2.8: Time of Use

Use this setting to enable or disable the meter’s Time of Use (TOU). Instructions for 

configuring the meter’s TOU are in Chapter 15.

1. From the Revenue and Energy Settings menu, double-click on the Time of Use line. 

You will see the screen below.

2. Check the box to enable TOU (uncheck the box to disable TOU).

3. Click OK to return to the main Device Profile screen. For changes to take effect, you 

must click the Update Device button to send the new profile to the meter.
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27.3: Power Quality and Alarm Settings

Power Quality and Alarm Settings are the third group of settings in the Device Profile.

1. From the Device Profile screen, click on the + button next to Power Quality and 

Alarm Settings or double-click on the Power Quality and Alarm Settings line. All of 

the settings in this group are listed.

2. Click on the programmable setting you want to modify. The following sections 

explain the settings in the order in which they appear in the Power Quality and 

Alarm Settings menu.
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27.3.1: Limits

Limits are threshold settings that can be set by a user to trigger a record in a log 

when an alarm condition is met. Utilizing the limits, the user can then control a relay 

or send a warning email on that alarm.

Limit settings are based on a percentage of the Full Scale (% of FS), which is set in 

the Limit and Waveform Full Scales setting (see 27.1.2: Limit and Waveform Full 

Scales, on page 27-5). Full Scale is based on CT and PT ratios set in the CT, PT Ratios 

and System Hookup setting (see 27.1.1: CT and PT Ratios and System Hookup, on 

page 27-2). Limits are based on a percent of Full Scale settings so that the same set-

tings can be used no matter what the CT and PT Ratio needed.

Before programming limits, set the CT and PT ratios. Then, set the Limit and Wave-

form Full Scales if you want to change to automatic configuration. In most cases the 

software will configure the Full Scale optimally. 

NOTE: The software automatically updates the Full Scale; however, you can set it 

separately from the CT and PT Ratios.
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1. From the Power Quality and Alarm Settings menu, click on the + button next to 

Limits or double-click on the Limits line. You will see the submenu shown below.

This submenu displays the current Device Profile Limit settings. Not all limits are 

shown in the figure above: there are 32 Limit ID fields.
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2. Double-click on any of the settings (Limit ID 01, for example). You will see the 

Limits screen, shown below.

•   This screen can be expanded to show all of the limits. Click on the top or 

bottom of the screen to display sizing arrows you can click on and drag to 

expand the screen.

•   Percentage of Full Scale settings (% of FS): The limits are set in % of Full Scale 

so that when you create a profile, you can keep your settings. This is true, even 

though the CT and PT ratios change when the meter (or a new meter) is placed 

in a different location. Changing the CT and PT ratios does not affect the % of 

Full Scale limits previously set. This is useful when you are using large numbers 

of meters because one profile can be used with a common set of limit settings no 

matter what the CT and PT ratio. Full Scale reference information is available in 

the lower left box.

3. Make changes to this screen according to your application requirements.

•   To set the type of limit and the channel assigned to it:
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a. Double-click in either the Limit ID or Assigned Item column. You will see 

the screen shown below.

b. From the pop-up menus, choose the desired settings and click OK. Follow-

ing is a list of the available Groups, Sub Groups, and Items.

Group: Measured Values

Sub Group: High Speed Updated

Item: Voltage A-N

         Voltage B-N

         Voltage C-N

         Voltage Aux

         Current A

         Current B

         Current C

         Current N Measured

         Voltage A-B

         Voltage B-C

         Voltage C-A

         VA A

         VA B

         VA C

         VA Total

         VAR A

         VAR B

         VAR C

         VAR Total

         Watt A
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         Watt B

         Watt C

         Watt Total

         Frequency

         Power Factor A

         Power Factor B

         Power Factor C

         Power Factor Total

         Volts A-Aux Phase Angle

Sub Group: One second updated

Item: Voltage A-N

         Voltage B-N

         Voltage C-N

         Voltage Aux

         Current A

         Current B

         Current C

         Current N Measured

         Current N Calculated

         Voltage A-B

         Voltage B-C

         Voltage C-A

         VA A

         VA B

         VA C

         VA Total

         VAR A

         VAR B

         VAR C

         VAR Total

         Watt A

         Watt B

         Watt C

         Watt Total

         Frequency

         Power Factor A
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         Power Factor B

         Power Factor C

         Power Factor Total

         Voltage Imbalance

         Current Imbalance

         Uncompensated VA A

         Uncompensated VA B

         Uncompensated VA C

         Uncompensated VA Total

         Uncompensated VAR A

         Uncompensated VAR B

         Uncompensated VAR C

         Uncompensated VAR Total

         Uncompensated Watt A

         Uncompensated Watt B

         Uncompensated Watt C

         Uncompensated Watt Total

         THD Volts A

         THD Volts B

         THD Volts C

         THD Current A

         THD Current B

         THD Current C

         K Factor Current A

         K Factor Current B

         K Factor Current C

         Internal Temperature

Sub Group: Harmonic Values

Item: 0 - 127th Harmonic on selectable Harmonic Magnitude

         (Voltage Phases A, B, and C; Current Phases A, B, and C)

Sub Group: Internal Inputs, States

Item: Internal Inputs 1-8

Sub Group: Phase Angles

Item: Phase A-N Voltage

         Phase B-N Voltage

         Phase C-N Voltage
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         Phase A Current

         Phase B Current

         Phase C Current

         Phase A-B Voltage

         Phase B-C Voltage

         Phase C-A Voltage

         Volts A-Aux Phase Angle

         Voltage Phase Sequence

Sub Group: Flicker

Item: Flicker: PInst Volts A

         Flicker: PInst Volts B

         Flicker: PInst Volts C

         Flicker: PST Volts A

         Flicker: PST Volts B

         Flicker: PST Volts C

         Flicker: PLT Volts A

         Flicker: PLT Volts B

         Flicker: PLT Volts C

Group: Averages

Sub Group: Thermal Average

Item: Voltage A-N

         Voltage B-N

         Voltage C-N

         Voltage Aux

         Current A

         Current B

         Current C

         Current N Measured

         Current N Calculated

         Voltage A-B

         Voltage B-C

         Voltage C-A

         VA A

         VA B

         VA C

         VA Total
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         VAR A

         VAR B

         VAR C

         VAR Total

         Watt A

         Watt B

         Watt C

         Watt Total

         Frequency

         Power Factor A

         Power Factor B

         Power Factor C

         Power Factor Total

         Voltage Imbalance

         Current Imbalance

Sub Group: Block Window Average

Item: VA

         VAR

         Watt

Sub Group: Pulse Accumulation/Aggregation Block Window Average

Item: Internal Inputs #1 - #8

         Aggregators #1 - #4

Sub Group: Rolling Window Average

Item: Predictive VA

         Predictive VAR

         Predictive Watt

         VA

         VAR

         Watt

Sub Group: Voltage and Current Means

Item: Volts PN

         Current P

         Volts PP

Group: External I/O Devices

Sub Group: Analog Input Modules

Item: Module 1: Analog Input 1 - Analog Input 8
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         Module 2: Analog Input 1 - Analog Input 8

         Module 3: Analog Input 1 - Analog Input 8

         Module 4: Analog Input 1 - Analog Input 8

•   To designate the limit as either above or below a percentage of the Full Scale, 

click once in each Settings column and select the desired setting from the pull-

down menu.

•   To set the percentage of the Full Scale that will trip the limit, enter the value in 

the % of FS column. CommunicatorPQATM software automatically calculates the 

Primary value.

•   Combination Limit 3 is the logical combination of Limit 1's state and Limit 2's 

state.

Example 1

Limit I D

Type: 1 Second Readings

Channel: Volts AN

Limit 1 Setting: Limit exceeded if Volts AN is below 120 F.S.

Limit 2 Setting: Limit exceeded if Volts AN is above 80 F.S.

Combination Limit 3 Setting: AND 

If Limit 1 AND Limit 2 are tripped (e.g., the reading is 100F.S.), then Limit 3 is 

tripped.

Example 2

Limit I D

Type: 1 Second Readings

Channel: Volts AN

Limit 1 Setting: Limit exceeded if Volts AN is above 120 F.S.

Limit 2 Setting: Limit exceeded if Volts AN is below 80 F.S.

Combination Limit 3 Setting: OR 

If either Limit 1 OR Limit 2 is tripped (e.g., the reading is 75), then Limit 3 is 

tripped. 
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•   Full Scales settings are shown in the lower left of the screen. These values are 

set in the Limits and Waveform Full Scales section of the Device Profile (see 

27.1.2: Limit and Waveform Full Scales, on page 27-5).

3.   Power Factor is broken into four quadrants. Selecting the Full Scale value brings 

up a screen that lets you set a limit in two of the four quadrants.

•   To set the power factor limits, double click on any of the power factor settings in 

the Limit 1 or Limit 2 columns. You will see the Power Factor screen.

•   To set a limit: from the pull-down menus, select a quadrant and Less Than or 

Greater Than (Full Scales). Enter the power factor number. The graph will 

illustrate your selections by shading the out of limit bands. The area of the

graph not covered by shading is within normal operational range.  

NOTE: Whether you see method 1 Quadrants (Q1  +Lag, Q2  -Lag, Q3  -Lead, 

Q4  +Lead) or method 2 Quadrants (Q1  +Lag, Q2  -Lead, Q3  +Lag, Q4  -Lead) 

depends on the setting in the Power Factor Display field of the Labels setting 

(see 27.1.4: Labels, on page 27-13).
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    NOTE: The Nexus® 1450 device is a four-quadrant meter. Therefore, limits

    can be set for capacitive and inductive PF when generating or consuming power.

3. When all settings are complete, click OK to return to the main Device Profile 

screen. For any changes to take effect, you must click the Update Device button to 

send the new profile to the meter. 

27.3.2:  Electrologic Relay Control

1. From the Power Quality and Alarm Settings menu, double-click on the Electro-

Logic™ Relay Control line. You will see the screen shown below.

ElectroLogicTM Relay Control lets you set up a logic tree to control the meter’s 

optional relays. Each relay can be programmed individually. The end result of the 

logic tree is to set, or not set, a relay, with an optional programmed Set Delay and/

or Reset Delay. The initial inputs to the logic tree are chosen from among the 32 

Limits and 40 Digital Inputs (both internal and external inputs). The gates, in 

several stages, perform logical combinations (AND, OR, etc) on pairs of inputs 

(either initial inputs or the outputs of earlier gates), and in combination produce an 

ultimate "true" or "false" state to drive the relay open or closed.

2           3                                                  1           

4
4a

4b

5a

5b

6
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 For example, one of the gates is AND. For data to pass an AND gate, both pieces of 

data must be “true.” For a Limit to be true, the data must be in the Out-of-Limit 

condition on either Limit 1, Limit 2, or both (you decide which). For a Digital Input 

to be true, it must be in the condition you specify - either Open or Shorted. 

The gates used in ElectroLogicTM Relay Control are used as follows:

OR: If either or both of the two conditions are true, the gate is passed

AND: If both of the conditions are true, the gate is passed

Hysteresis: For Limits only, the if the Limit is within the programmed hysteresis 

value, the gate is passed

XOR: If either of the two conditions are true, but not both, the gate is passed

NOR: If either of the two conditions are true, the gate is not passed

NAND: If both of the two conditions are true, the gate is not passed

NHysteresis: For limits only, if the Limit is within the programmed hysteresis value, 

the gate is not passed

NXOR: If either of the two conditions are true, but not both, the gate is not passed

NOTE: See Example settings on page 27-53.

2. To assign an item to the Relay Logic tree:

a. Select the relay card/module from the pull-down menu - see number 1 in the 

screen on the previous page.

b. Select an input for the tree by clicking on a radio button next to numbers 1 

through 8 - see number 2 in the screen on the previous page.

c. Choose Limits or Digital Inputs by clicking on the radio button in front of the 

word - see number 3 in the screen on the previous page. 

d. From the pull-down menus, select the limit (Limit ID) or input (Input ID) you 

want to assign to this Relay Logic tree input (step b) - see number 4 in the 

screen on the previous page. 

• For a limit, use the second pull-down menu to select Limit 1, Limit 2, or 

Combination - see number 4a in the screen on the previous page.

• For an input, use the second pull-down menu to select Shorted or Open - 

see number 4b in the screen on the previous page.
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e. Press Set to confirm your selection. The software places the selection in the 

appropriate field in the screen.

3. After you assign all the Relay Logic inputs, select the gates that will be used to 

combine the logic to trigger the relay. To select a gate type, either: 

•   Click on the gate (yellow fields) - see number 5a in the screen on page 11-50. 

•   Choose a gate type from the pull-down menu below the gate - see number 5b in 

the screen on page 11-50.

4. If you want, select Set Delay and Reset Delay from the pull-down menus. You can 

choose between 0 and 255 seconds. Use these fields if you want to program a delay 

before the relay is set, or before it is reset - see number 6 in the screen on page 

11-50.

5. To change items on the Relay Logic tree, follow the previous steps.

•   To clear an item from the Relay tree, click on that item and click the Clear 

button.

•   To clear all items from the Relay Tree, click the Clear Assigned Items button.

6. When all settings are complete, click OK to return to the main Device Profile 

screen. For any changes to take effect, you must click the Update Device 

button to send the new profile to the meter. 

NOTE: In order to use this screen, you must have purchased at least one Relay 

Option card or one External Relay Output module. For more details on external Output 

modules, see Chapter 14.
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Example of an ElectroLogicTM Relay Logic Tree:

Inputs 1 through 8 are set to High Speed Volts AN Limit 1, High Speed Amps A Limit 

1, High Speed Volts BN Limit 1, High Speed Amps B Limit 1, High Speed Volts CN Limit 

1, High Speed Amps C Limit 1, Not Set and Not Set. The four first gates are AND 

gates, and the remaining three gates are OR gates.

Each first level gate looks at the state of the two limits, and the result is "true" if and 

only if both the inputs (Voltage Limit and Current Limit) are "true" (Out-of-Limit Con-

dition). The second and third level gates look at the state of the earlier gates, and 

their results are "true" if either one (or both) of the previous gates are "true". The end 

result is a relay that is energized if one or more of the three phases (A, B, and/or C) is 

currently Out-of-Limit on both its voltage and current Limit 1 tests.

 Items 
 1-8

Gates 1-4
Gates 5 and 6 Final Gate
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27.3.3: PQ Thresholds (Waveform Recording)

The PQ Thresholds/Waveform Recording capability allows the meter to act as a high-

speed waveform recorder to record any anomaly that occurs within a cycle of dura-

tion. This provides a user with advanced waveform analysis including pre- and post- 

waveform recording. 

The meter has the capability to record both surges and sags of the measured signals. 

A voltage surge is any event that increases the RMS voltage for one cycle, calculated 

every half cycle. A voltage sag is a dip in the RMS of one cycle of voltage, calculated 

every half cycle. A current fault (or surge) is also calculated in the same manner. 

When the RMS value of any of these triggers exceeds the threshold settings, the 

meter will trigger a waveform capture.

The Power Quality (PQ) and Waveform Thresholds setting determines at what point 

the Nexus® 1450 meter executes a waveform capture and/or records a power quality 

event. 

See Chapter 19 for instructions on viewing Waveform and PQ logs. 

NOTE: The 1450 meter also supports Manual Waveform capture. See 20.1.13: Man-

ual Waveform Capture, on page 20-20.

PQ and Waveform Thresholds are given as a percentage of the Full Scales (% of FS). 

Set the Full Scales in the Limits and Waveform Full Scales setting of the Device Profile 

(see 27.1.2: Limit and Waveform Full Scales, on page 27-5). Full Scales are based on 

the CT and PT ratios set in the CT, PT Ratios and System Hookup setting of the Device 

Profile (see 27.1.1: CT and PT Ratios and System Hookup, on page 27-2).

Before programming the PQ and Waveform Thresholds, set the CT and PT ratios and 

the Limits and Waveform Full Scales.

Note on Sampling Rate: A higher sampling rate allows for transients to be 

monitored. Generally, the meter is set to take 1024 samples per cycle for this pur-

pose. Lower sampling rates have advantages, however, because they allow you to 

record more cycles of information per event. Therefore, low sampling rates are better 

for long duration events, like motor starts or distribution faults. The meter enables 

you to tailor its recording for both these applications. For more information on sam-

pling rate, see the table on page 27-62.
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Note for Wide Band Auto Frequency Setting: If your meter is set to Wide Band 

Auto for frequency and your intended working frequency is either 200 Hz or 400 Hz, 

we recommend you set a waveform capture sample rate higher than 64 samples per 

cycle at 60 Hz, to avoid getting misleading results.

1. From the Power Quality and Alarm Settings menu, double-click on the PQ 

Thresholds (Waveform Recording) line. You will see the screen shown below
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2. This screen allows you to set the voltage RMS triggers, the current RMS triggers, 

and the voltage transients triggers for waveform recording. It also allows you to set 

the voltage interruption settings for IEC61000-4-30 Class A recording. Use the tabs 

at the top of the screen to navigate between the voltage, current, and voltage tran-

sient and settings. 

NOTES:

•   The Waveform clipping threshold for the Nexus® 1450 meter is 66.7A RMS and 

1140V RMS on the secondary side of all channels.

•   The High Speed Inputs field allows you to see which High Speed Digital input is 

enabled for Waveform recording. You assign the High Speed input to its trigger 

in the Digital Inputs screen. (Flicker is discussed in detail in Chapter 23.)

•   Voltage and current Full Scale values are shown in the lower left corner of the 

screen. 

3. The Voltage setpoints are used to record voltage type events, such as voltage 

surges and sags. To set the Voltage RMS triggers for a PQ event and waveform 

capture (Voltage RMS Triggers tab):

a. Select either Fixed RMS or USR (radio buttons). 

NOTE on USR Setting: The USR setting lets you configure waveform capture 

thresholds based on sliding reference voltage rather than Full Scale (see instruc-

tions on the next page). This is useful if you know your line voltage will be vary-

ing and you want the voltage reference to be adjusted accordingly.

The formula used is as follows:

Usrn = 0.9967 x Usr (n-1) + 0.0033 x U(10/12)rms

where 

Usrn is the present value of the sliding reference voltage;

Usr (n-1) is the previous value of the sliding reference voltage; and

U(10/12)rms is the most recent 10/12-cycle RMS value.
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When the measurement is started, the initial value of the sliding reference volt-

age is set to the programmed input voltage. The sliding reference voltage is com-

puted every 10/12-cycles. If a 10/12-cycle is flagged as being out-of-limits, that 

voltage is not used - the previous sliding reference voltage is used instead.

b. If you select Fixed RMS:

i. Enter the desired percentage of Full Scale in the Value() column of the 

Above setpoints and Below setpoints sections. After you make an entry, 

the Primary field (display only) adjusts accordingly. When the RMS value 

crosses the setpoint, a capture is taken.

ii.Enter the desired percentage for Return Hysteresis for the Above and 

Below setpoints. After you make an entry, the Primary field (display only) 

adjusts accordingly. Hysteresis is the value that must be met for the out 

of limit condition to be considered ended. Hysteresis is useful in prevent-

ing excessive out of limit conditions when the readings are hovering 

around a setpoint, since it dictates that the readings must recover to a 

certain level before dropping again in order for them to be considered out 

of limit. 

iii.Click the box(es) to enable Waveform Recording (Waveform Enable box) 

and/or PQ Recording (PQ Enable box). 



     Doc#    E107707                                            27-60

27: Nexus® 1450 Meter

c. If you have a load with slowly changing voltage, you probably do not want to use 

Full Scale as your reference point. In that case, you can use the USR function to 

set up a sliding reference voltage rather than a Full Scale voltage reference. 

Follow these instructions:

i. Click the USR button. The top of the screen changes as seen in the exam-

ple below.

ii. Enter the desired percentage of the sliding reference voltage in the 

Value(%) column of the Above setpoints and Below setpoints sections. 

iii.Click the box(es) to enable Waveform Recording (Waveform Enable box) 

and/or PQ Recording (PQ Enable box) when the setpoints are exceeded. 



     Doc#    E107707                                            27-61

27: Nexus® 1450 Meter

3. To set the current RMS triggers for a PQ event and waveform capture (Current RMS 

Triggers tab - see the example screen below):

a. Enter the desired percentage of Full Scale in the Value(%) column of the Above 

setpoints section. After you make an entry, the Primary field (display only) 

adjusts accordingly.

b. Enter the desired percentage for Return Hysteresis for the Above setpoints. After 

you make an entry, the Primary field (display only) adjusts accordingly. Hystere-

sis is the value that must be met for the out of limit condition to be considered 

ended. Hysteresis is useful in preventing excessive out of limit conditions when 

the readings are hovering around a setpoint, since it dictates that the readings 

must recover to a certain level before dropping again in order for them to be 

considered out of limit.
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c. Click the box(es) to enable Waveform Recording (Enable box) and/or PQ Record-

ing (PQ Enable box). 

NOTE: The current setpoints are used to record faults on the line or in-rush 

currents from devices such as motors. Typically, to catch these events, set the 

limit to above 200% of Full Scale. As a general rule you do not want to set either 

any below current thresholds because that will trigger waveforms when the     

current drops, since this setting will constantly trigger waveforms. 

5. Select the number of samples per cycle to be recorded from the Sampling Rate 

field's pull- down menu. Choose from 16, 32, 64, 128, 256, 512 or 1024 samples 

per cycle. The number of samples per cycle you choose above 128 samples per 

cycle affects the number of cycles per capture. 

•   The following table shows the effects of sampling rate on the number of cycles 

captured. Increasing the sampling rate increases waveform resolution; but for     

higher sampling rates, reduces the length of the observed window. The approxi-     

mate length of the observed window is shown in the last column.
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       NOTES: 

• The table shows sampling data for 60 Hz systems.

• The table shows values for one waveform capture window. If you have 

more than one waveform capture window, the maximum time per 

capture increases. 

6. You can select Frequency - either 60Hz or 50Hz - from the pull-down menu next to 

“Samples per cycle @”. This is only to help you decide what options to select - it 

does not affect the meter.

7. From the Pre-Trigger Cycles and Post-Trigger Cycles fields' pull-down menus, select 

the number of cycles you want to record before and/or after the triggered record-

ing. See the table above for the maximum cycles per capture for each sampling 

rate.

Nexus® 1450 Sampling Rate Chart (at 60Hz)

Samples per 
Cycle Channels Samples per 

Channel

Cycles per 
Channel per 

Window*

Time 
(approx.)

Analog pts Digital Inputs
16 6 8 2880 180 3 sec

32 6 8 5760 180 3 sec

64 6 8 11520 180 3 sec

128 6 8 23040 180 3 sec

256 6 8 30720 120 2 sec

512 6 8 30720 60 1 sec

1024 6 8 40960 40 0.6 sec
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8. The Total Waveform Recording Windows per event is fixed at 1, and cannot be 

changed. 

Note on CBEMA (PQ Recording): CBEMA plotting is a power quality standard 

known worldwide for recording the amount of damage Voltage transient conditions 

have done to the equipment being monitored. The meter automatically records this 

information. For CBEMA purposes, program internal set points for Voltage below 90 

and above 110 of Full Scale (+/- 10 from the nominal Voltage). These set points 

are defined by the ITI (CBEMA) specification. The ITI (CBEMA) Curve is published 

by Information Technology Industry Council (ITI) and is available online. You can 

set a recording with tighter Voltage limits to trigger a waveform recording. How-

ever, CBEMA plotting is based only on the limits internally set.

9. When all changes are entered, click OK to return to the main Device Profile screen. 

For any changes to take effect, you must click the Update Device button to send 

the new profile to the meter.
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27.3.4: EN 50160/IEC 61000-4-30 Flicker 

The Nexus® 1450 meter can record power quality reporting values in two indepen-

dent logs. When EN 50160/IEC 61000-4-30 reporting is enabled, entries are made 

into the logs when the associated values occur. All values can be downloaded to the 

Log Viewer where they are available for graphing or export to another program, such 

as a spreadsheet. Refer to Chapter 19 for additional information on viewing logs.

The Nexus® 1450 meter offers customization of EN 50160/IEC 61000-4-30 reporting 

so that the user can meet specific jurisdictional or regional requirements. Note that 

you should program the CT/PT Ratio and System Hookup settings for the Nexus® 

1500+ meter before programming the EN 50160 reporting - see 27.1.1: CT and PT 

Ratios and System Hookup, on page 27-2, for instructions.

NOTE: The meter is calculating its Flicker based upon the EN 61000-4-15 standard 

which is referenced in the EN 61000-4-30 standard. The accuracy requirements for 

this instrument are within the Class A standards for Flicker measurements. Refer to 

Chapter 23 for additional information on Flicker standards. 

IMPORTANT! Since the EN 50160/IEC 61000-4-30 reporting has specific require-

ments for programming, EIG recommends that you refer to the IEC 61000-4-30 2008 

standard before making changes to the default settings of the meter.

The meter’s Runtime Firmware version and above support Edition 3 of IEC 61000-4-

30 standard.

NOTE: This setting is not available if the meter’s frequency is set to Wide Band Auto 

(see 27.1.1: CT and PT Ratios and System Hookup, on page 27-2).
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1. From the Device Profile screen double-click on the EN50160/IEC61000-4-30 Flicker 

line. You will see the following screen, which has two tabs.

2. The initial tab is the EN 50160 tab. Some of the fields are display only and cannot 

be changed. You can select the following settings from their pull-down menus:

•   Allowed Rapid Voltage changes per day: this field determines how many rapid 

voltage variations are allowed before they are considered a fault condition, and 

reported - select between 1 and 50.

•   Synchronous Connection: this field specifies whether the system has a synchro-

nous connection to another system - select Yes or No.

•   Allowed long interruptions in a year: this field determines how many long volt-

age interruptions per year are allowed, before they are considered a fault, and 

reported - select between 1 and 100.

•   First day of the week: for the report, select Sunday or Monday as the first day of 

the week.
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3. Enter the Mains Signaling Threshold: this setting and the next one (Mains Signaling 

Interharmonics Threshold Frequency) are for the Mains Signaling voltage, which is 

a burst of signals (often at a non-harmonic frequency) that remotely control indus-

trial equipment, energy meters, and other devices. In this setting, enter the pass 

thresholds for the Mains signaling voltage (this is a percentage); e.g., if you set the 

threshold at 99.00, 99% or better will be considered a pass and anything less than 

99% will be considered a fail.

4. Enter the Mains Signaling Interharmonics Frequency (in Hz): enter the interhar-

monic frequency for the test. When this interharmonic exceeds the detection 

threshold, reporting is made. See the IEC 61000-4-30 standard’s Section 5.10.1 for 

more details on this setting. 

5. Mains signal Recording Interval (seconds): if your meter supports IEC 61000-4-30 

Edition 3 (Runtime Firmware version  or higher), you can select an interval (from 1 

to 120 seconds) for recording.

6. Click the IEC-61000-4-30 tab.   
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7. Enter: 

•   Voltage: enter the Nominal voltage.

•   Frequency (50 or 60Hz) - this field is used to calculate the harmonics and interhar-

monics associated with the set fundamental frequency. Select the frequency from 

the pull-down menu.

8. Short Term Test Time and Long Term Test Time are display only and cannot be 

changed.

9. IEC 61000-4-30 Rapid Voltage Change Additional Settings: for meters that support 

Edition 3 (Runtime Firmware versions  and higher), you can set a Threshold (the % 

of the voltage Full Scale for each channel) and Return Hysteresis (the % of the volt-

age Full Scale for each channel) per phase AN/AB, BN/BC, and CN/CA.

NOTES: 

• The default for the Threshold value is 3% and the default for the Hyster-

esis Value is 1.5%.

• Make sure that the Threshold setting does not exceed the Dip/Swell 

threshold settings; and that the Hysteresis does not exceed the Threshold 

settings.

10. When all changes have been entered, click OK to return to the main Device Profile 

screen. For any changes to take effect, you must click the Update Device button to 

send the new profile to the meter.

NOTE: Flicker is discussed in detail in Chapter 23.
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27.3.5: IEC 61000-4-30 Harmonic & Interharmonic Thresholds
            

Use this setting to set the group and subgroup harmonic and interharmonic thresh-

olds that will be applied to the IEC 61000-4-30 reporting for the meter. 

NOTE: This setting is not available if the meter’s frequency is set to Wide Band Auto 

(see 27.1.1: CT and PT Ratios and System Hookup, on page 27-2).

1. From the Power Quality and Alarm Settings menu, double-click on the IEC 61000-

4-30 Harmonic & Interharmonic line. You will see the screen shown below.

2. For each of the Harmonic and Interharmonic subgroup levels 0-51, you can enter a 

threshold percentage value. Use the scroll bars to view all of the levels.

3. When all changes are entered, click OK to return to the Main Device Profile screen.

4. For any changes to take effect, you must click the Update Device button to send 

the new profile to the meter.
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27.3.6: Digital Inputs

The Nexus® 1450 meter’s built-in digital inputs can be used in two ways:

•   Attaching status contacts from relays, breakers or other devices for status or 

waveform initiation

•   Attaching the KYZ pulse outputs from other meters for pulse counting and totaliz-

ing

Even though these inputs are capable of being used as high speed digital fault record-

ing inputs, they serve a dual purpose as KYZ counters and totalizers. The function in 

use is programmable in this setting of the Device Profile, which lets you label the eight 

digital inputs and to specify their status. 

•   Labeling the inputs allows you to determine the source of status change when data 

is later analyzed. 

•   This feature lets you set the digital inputs’ status as a KYZ input, a trigger for 

waveform capture or PQ recording, a trigger for logging, or a means of synchroniz-

ing the meter. 

•   In the Pulse Accumulations setting (see 27.2.6: Pulse Accumulations, on page 27-

37), you can assign the digital inputs’ counts to be accumulated in one of four 

internal Aggregators of the meter.

•   You can use Historical Log 2 for logging digital input transitions. This is accom-

plished by setting up a digital input channel



     Doc#    E107707                                            27-71

27: Nexus® 1450 Meter

1. From the Power Quality and Alarm Settings menu, double-click on the Digital 

Inputs line or click on the + button next to it. You will see the submenu shown 

below.

2. Double-click any of the Input lines. You will see the screen below.

3. Double-click a field to enter the following:

•   Name 

•   Open Label

•   Shorted Label
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•   Normal Condition: Open or Shorted

4. Click on the Input Type field to select an option from the pull-down menu. The 

available selections are:

•   KYZ Input - select this option to designate the input as a pulse (KYZ) input.

•   Waveform/PQ Trigger - select this option if you want the input to trigger a 

waveform/PQ recording (see 27.3.3: PQ Thresholds (Waveform Recording), on 

page 27-56).

•   Block Window Sync Pulse - select this option if you want to synchronize the 

meter with pulses from the input (see Section 27.2.3: Internal Pulse, on 

page 27-31).

•   Event Triggered Log - select this option if you want the input to trigger logging. 

Logging occurs when the input's state changes from Open to Closed. Only one 

digital input at a time can be set for Event Triggered logging. You must also set 

the length of logging and the parameters to be logged (see 27.4.1: Program-

ming the Trending Log Time Intervals, on page 27-73 and 27.4.2: Programming 

the Trending Setup, on page 27-76).

5. When you have finished making your selections, click OK to exit the screen and 

return to the main Device Profile screen. For any changes to take effect, you must 

click the Update Device button to send the new profile to the meter.



     Doc#    E107707                                            27-73

27: Nexus® 1450 Meter

27.4: Trending Profile Settings

This section of the Device Profile enables you to configure parameters for the Nexus® 

1450 meter’s eight historical logs.

1. From the Device Profile screen, click on the + button next to Trending Profile

 Settings or double-click on the Trending Profile Settings line. You will see the menu 

shown below.

2. Double-click on one of the Trending lines to access the programming screens.

NOTE on Load Profile Recording: Load Profile recording is a subset of the Nexus® 

meter's more general logging and trending capability. The same screens are used for 

setup, but Load Profile recording only deals with accumulated values; Energy (Wh), 

reactive Energy (VARh) and apparent power (VAh).

Historically, Load Profile recording referred to recording of quadrant 1 Energy (Wh) 

because electromechanical meters only measured energy and were designed to 

prevent reverse rotation outside of quadrant 1.

27.4.1: Programming the Trending Log Time Intervals

The Trending Log Time Intervals setting determines the interval at which the 

Historical logs take a "snapshot" of data. To set the parameters for the logs, see 

27.4.2: Programming the Trending Setup, on page 27-76. See Chapter 16 for infor-

mation on retrieving logs and Chapter 19 for information on viewing logs.
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1. From the Trending Profile Settings menu, double-click Trending Log Time Intervals 

or click the + button next to it. You will see the submenu shown below. The 

submenu shows the interval set for the Historical logs. If one of the High Speed 

inputs has been assigned to the Event Triggered log, the event Triggered Log will be 

shown after Log 8 in the submenu.

2. To change the interval for a Historical log, double-click on one of the logs.

NOTE: You can also access the Interval setting screens from the Trending Setup 

screens (see 27.4.2: Programming the Trending Setup, on page 27-76).

3. You will see the screen shown below. 
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4. Select the interval you want for the log from the pull-down menu: 1, 3, 5, 10, 15, 

30 or 60 minutes.

5. If one of the High Speed Inputs has been set up as a trigger for logging, you will 

see the setting screen shown below. 

Select the number of seconds the log should record when a High Speed Input tran-

sition triggers recording, e.g., if you select 10 seconds, a transition will trigger 

recording of the log’s parameters for ten seconds, and then stop until the next tran-

sition triggers recording for another 10 seconds. You can choose between 1 and 60 

seconds.

6. Click OK to save your changes. For any changes to take effect, you must click the 

Update Device button to send the new profile to the meter.
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27.4.2: Programming the Trending Setup 

The Trending Setup controls the channel assignments for the Historical logs. See 

Chapter 16 for instructions on retrieving logs.

1. From the Trending Profile Settings menu, click on the + button next to Trending 

Setup or double-click on the Trending Setup line. You will see the submenu shown 

below. If one of the High Speed inputs has been assigned to the Event Triggered 

log, the event Triggered Log will be shown after Log 8 in the submenu.
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2. Double-click on the log whose settings you want to configure. You will see the 

Trending Log Profile screen for the log you selected. An example screen is shown 

below.

3. Make changes to this screen according to your application requirements. 

a. Group: Using the pull-down menu, select the type of snapshot. The options are: 

Measured Values, Averages, Accumulators, Interval Accumulators, External 

Output Devices, TOU Cumulative Dmd.
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b. Sub-Group: Using the pull-down menu, select a channel for the snapshot. The 

options are: Fifty Millisecond Updated; One Second Updated; Harmonic Values; 

Internal Inputs, States; Phase Angles; Flicker.

c. Sub-Group 2: With some selections, a second sub-group field will be shown 

underneath the first one. Select a value for this field from the pull-down menu. 

d. Highlight items in the Selectable Items(s) box and click Add to include the selec-

tions in the Log. The items will be copied to the Selected Item(s) box. To remove 

an item from the log, highlight the item in the Selected Item(s) box and click 

Remove or double-click the item. The item will be removed from the Selected 

Item(s) box. 

NOTES: 

• To select multiple items, hold Control while highlighting the items.

• To select a range of items, click the first item, hold Shift, and click the last 

item.

• Move the cursor to the lower left corner of an item, or group of items, to 

view its size in bytes.

e.  Click Check HHF if you want to check if current settings are compatible with the 

HHF Converter.

NOTE: You will not see the HHF options unless you have enabled the HHF 

converter using the Options menu. See Chapter 20 for instructions, and see 

Chapter 16 for HHF information.

f. The Total bytes used and Bytes remaining fields display the amount of memory 

used for each record of the log. The meter assumes 256 bytes of memory for 

each record. Total memory is determined at time of purchase. 

g. The Estimated Log Timespan field displays the length of the time between the 

first and last records in the log when it is full.

h. The Total Records field displays the total number of records that will be in the log 

when it is full.
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i. You can set the log interval by selecting it from the pull-down menu next to Log 

Interval: you can select 1, 5, 10, 15, 30 or 60 minutes.

4. When all changes have been entered, click OK to return to the main Device Profile 

screen. For any changes to take effect, you must click the Update Device button to 

send the new profile to the meter.
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27.5: External I/O Modules

The Nexus® 1450 meter offers expanded I/O through external I/O modules. These 

modules add both analog and digital inputs and outputs to the meter to greatly 

expand the capability of the instrument. 

This setting of the Device Profile lets you set up the meter’s optional external Input/

Output modules (see Chapter 14 for more information on the I/O modules) and RTU 

Master settings. I/O modules work as Modbus slave devices. The meter polls these 

modules to get the data from them. I/O modules generally have default RS485 

Modbus addresses, so, they don’t have to be configured. Once you set up which 

module you want, put in the default address and start with the basic configuration of 

readings you want to gather.

27.5.1: Configuring the Input/Output Modules

1. From the Device Profile screen, double-click on the External I/O Modules icon. You 

will see the screen shown below.
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2. Click in the Type column and use the pull-down menu to select the specific module 

you want to add. The Assigned Address, Nexus® settings, and Module settings you 

can make depend on the module you are configuring. The modules and settings are 

as follows:

* The Assigned address on this screen is the address the meter uses to identify the

    I/O module. The default is the factory set address, which you can change by

    clicking in the field and choosing a new address from the pull-down menu. This

    address is not the actual I/O module address. You set that from the I/O Devices

    menu; see Chapter 14 for instructions. 

Module Assigned
Address* Nexus® Setting** Module Setting

4PO1 - KYZ Output 160* Click to Edit Relay Accumula-
tions

Click to enter Transmit Delay and 
configure KYZ outputs’ Watt/pulse, 
rollover and minimum pulse width.

20mAON4 - Analog 
Transducer Signal 
Outputs, 4 channels, 
4-20 mA

132* Click to Assign Items to and 
configure the Analog Outputs

Click to enter Transmit Delay and 
configure Channel settings 

20mAON8- Analog 
Transducer Signal 
Outputs, 8 channels, 
4-20 mA

132* Click to Assign Items to and 
configure the Analog Outputs

Click to enter Transmit Delay and 
configure Channel settings 

1mAON4 - Analog 
Transducer Signal 
Outputs, 4 channels, 
0-1 mA

128* Click to Assign Items to and 
configure the Analog Outputs

Click to enter Transmit Delay and 
configure Channel settings 

1mAON8 - Analog 
Transducer Signal 
Outputs, 8 channels, 
0-1 mA

128* Click to Assign Items to and 
configure the Analog Outputs

Click to enter Transmit Delay and 
configure Channel settings 

4RO1 - Digital Output 156* Click to configure Relays Click to enter Transmit Delay

8AI1 - Analog Input 
Module, 0-1 mA

247* Click to configure Analog 
Outputs

Click to enter Transmit Delay and 
configure Channel settings

8AI2- Analog Input 
Module, 0-20 mA

247* Click to configure Analog 
Outputs

Click to enter Transmit Delay and 
configure Channel settings

8AI3 - Analog Input 
Module, 0-5 VDC

247* Click to configure Analog 
Outputs

Click to enter Transmit Delay and 
configure Channel settings

8AI4 - Analog Input 
Module, 0-10 VDC

247* Click to configure Analog 
Outputs

Click to enter Transmit Delay and 
configure Channel settings

8DI1 - Digital Status 
Input Module

164* Click to configure Digital 
Inputs

Click to enter Transmit Delay and 
configure Channel settings
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**When you click in this field you see an Edit button. Click the button to open a

    screen that lets you edit that module. See the following example screens.

                                         4PO1 Screen - Pulse Output module

This screen allows you to assign a KYZ output to an accumulator. Click on the pull-

down menu to select accumulation configuration for each of the 4 relays. The 

options are: 

•   Disabled

•   Quad (1+4) Watthr

•   Quad (2+3) Watthr

•   Quad (1+2) VARhr

•   Quad (3+4) VARhr

•   Quad (1+2+3+4) VAhr

•   Quad 1 Watthr

•   Quad 2 Watthr

•   Quad 3 Watthr

•   Quad4 Watthr

•   Quad 1 VARhr

•   Quad 2 VARhr

•   Quad 3 VARhr

•   Quad 4 VARhr
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•   Quad 1 VAhr

•   Quad 2 VAhr

•   Quad 3 VAhr

•   Quad 4 VAhr

•   +Qh Total

•   -Qh Total

•   Internal Input (#1-8) Totals

•   Accumulation (#1-4) Totals

•   External Digital Input Modules (1-4) Inputs (#1-8)

•   I Squared T (A, B, C)

•   V Squared T (A,B,C)
                                      20mAON4 Screen: 4 channel Analog Output 
                                      module, 4-20 mA

   Click in Output channels 1-4 to assign them to a parameter. The other Analog 

   Output Modules - 20mAON8, 1mAON4, and 1mAON8 have similar setting screens,

   except for the number of channels you can program. 

•   The analog outputs are used to send a variable current dependent on the 

programmed reading. This screen lets you select the readings to output.
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                                           4RO1 Screen- Relay Output module

Click in the Relay fields 1-4 to enter relay label, common shorted to N.C., com-

mon shorted to N.O., and check the box to lock the relay to manual control. 

When a relay is locked to manual control, it cannot be used in ElectroLogic Relay 

Control (see 27.3.2: Electrologic Relay Control, on page 27-52, for detailed 

information).

                                       8AI2- Analog Input Module, 4-20 mA

    Click in Input Channels 1-8 to assign a label and a High and Low Value for each of

    the analog inputs. 

•   The two analog input module’s settings are the same, except for the Inputs’ high 

and low range.
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•   The High and Low Value fields let you map the inputs’ high and low range to 

values that are appropriate for the parameters you are measuring. For example, 

in the screen above, the first input is measuring temperature. The high value for 

the input is set to 100, and the low value is set to 0. An input reading of 12mA 

will translate to 50 for the temperature.

The Analog Input modules can be trended in the historical logs, and the data can 

be viewed and graphed in Log Viewer (see Chapter 19 for details). The readings 

shown in the logs and graphs will use the setting range programmed in the 

screen above, i.e., the results will be reported as 0 through 100. 

                                        8DI1 - Digital Status Input module

   Click in Channel Label’s 1-8 to assign a Channel label, Open and Closed label,

   and Normal State (Open or Shorted) for each of the digital inputs.    

    

   NOTE: Log/Limit ID is a display only field. It shows the ID that Communicator-

   PQATM software generates to identify this module in the Log Viewer and

   Limits functions.

3. Click OK to return to the main Device Profile screen. For any changes to take effect, 

you must click the Update Device button to send the new profile to the meter. 
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27.5.2: RTU Settings

The Nexus® 1450 meter provides a feature that allows it to act as a simple Remote 

Terminal Unit (RTU). It can poll Modbus registers from downstream devices and bring 

that data into its memory for logging. This is very useful when trying to integrate data 

from existing, simpler, legacy Modbus devices. This section of the Device Profile 

enables you to configure RTU Master settings. This feature is used when you want to 

have the meter act as an RTU, polling data from other Modbus-based devices, such as 

lower end meters.

1. From the Device Profile screen, click on the + button next to the External I/O Mod-

ules line. You will see the menu option shown below.

2. Double-click on RTU Settings. You will see the screen shown below.

Use this screen to configure the settings when Port 2 is set as an RTU Master (see 

27.1.5: Communications, on page 27-16).
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3. The first view you see is the Group Main tab (shown on the previous page). This 

screen lets you set up the RTU Master groups, i.e. the devices the Nexus® 1450 

meter is polling. You can enter up to 16 groups. You have the following options:

•   Click Add to add a Master group. Fill in the Description, Device Address, Starting 

Register, and Number of Registers; click Save to save your entries.

•   Click on a group and click Edit to change data for the group; click Save to save 

your changes.

•   Click on a group and click Remove to delete the group.

•   Click on a group and click Up or Down to change the position of the group.

4. Click the Group Details tab to set up the readings for the devices. See the example 

screen shown below.

You have the following options:
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•   Click Add to add a reading to the group. Fill in the Data Type, Size in Bytes, Byte 

Order, Multiplier Information, and Slave Starting Register (the Master Starting 

Register is read-only); click Save to save your entries.

NOTE: The readings in the group must have consecutive register numbers. If 

necessary you can break the readings into two or more groups.

•   Click on a reading and click Edit to change data for the reading; click Save to 

save your changes.

•   Click on a reading and click Remove to delete the reading from the group.

•   Click on the Selected Group pull-down menu to select and display details for 

another group.

5. Click OK to return to the main Device Profile screen. For any changes to take   

effect, you must click the Update Device button to send the new profile to the 

meter. 

NOTE: For more details on I/O Modules, see Chapter 14.

You can then use the polled data in the following ways:

•   Access the data using Modbus protocol: Modbus registers, starting at #define 

MB_REG_NEXUS_MASTER_DATABASE 0x03800;

#define MB_REG_NEXUS_MASTER_DATABASE_LEN 0x00080. 

You can see the Nexus® 1450 meter’s full Modbus map in the Nexus® 1450 Meter 

Modbus User Manual. 

http://www.electroind.com/products/Nexus_1500/pdf/manuals/E154703_Nx_1500_Modbus_Man.pdf
http://www.electroind.com/products/Nexus_1500/pdf/manuals/E154703_Nx_1500_Modbus_Man.pdf
http://www.electroind.com/products/Nexus_1500/pdf/manuals/E154703_Nx_1500_Modbus_Man.pdf
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•   Log the data by selecting Master RTU Items for the group in the Trending Profiles 

screen: see the example screen, below. 
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28: Shark® 250 Meter
This chapter explains how to configure a Shark® 250 meter's programmable 

settings, which are stored in the unit's Device Profile. Chapter 7 contains detailed 

information on how to use the Device Profile.

28.1: Device Profile General Settings

1. From the Tree Menu on the left side of the Shark® 250 meter’s Device Profile 

screen, double-click on the General Settings line or click on the + button next to it. 

All of the settings in the General Settings group are listed.
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28.1.1: Configuring CT, PT Ratios and System Hookup

Use this setting to configure Current Transformer and Potential Transformer ratios and 

to select the System Hookup. The Full Scales values are display only.

Functional Overview of CT and PT Ratios:

Current and Potential Transformers are used mainly for the following reasons:

•  To insulate, and as a result isolate, the meter from high-voltage circuits.

•  To change the primary voltage and current to standard values and sizes that the 

meter can measure.

The CT and PT transformers deliver fractions of the primary voltage and current to the 

meter. With properly set ratios and multipliers, the readings of the meter can be used 

to determine the energy, voltage, current, or power of the system. 

1. From the Tree Menu, click General Settings>CT, PT Ratio and System Hookup. 

2. Make these settings:
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•  CT Ratio, enter:

•  Primary (CT Numerator): 1 - 65535

•  Secondary (CT Denominator): this setting depends on the meter class - 

5 for a Class 20 meter or 1 for a Class 2 meter. 

•  PT Ratio, enter:

• Primary (PT Numerator): 1 - 99999999

• Secondary (PT Denominator): 1 - 65535

•  System Wiring, select from pull-down menu:

• 3 Element Wye; 2.5 Element Wye; 2 CT Delta

This value must be set properly for the meter to calculate readings 

correctly.

        Example Settings:

For a CT of 2000/5 A, set the following CT Ratios in the entry fields:

CT Numerator (Primary)           2000

CT Denominator (Secondary)    5

The Current Full Scale field will read 2000. 

For a system that has 14400 V primary with a 120 V secondary line to neutral 

(PT Ratio of 120:1), set the following PT Ratios in the entry fields:

PT Numerator (Primary)  1440

PT Denominator (Secondary) 120

The Voltage Full Scale field will read 14.4k.

•  Use the Minimum Voltage Threshold box to enter the minimum voltage threshold, 

which is a percentage of the voltage full scale. This setting adjusts the pick up 

threshold for the voltage. You set a percentage of the PT primary (PT numerator 

X PT multiplier) up to 12.7 in the entry field, to configure when the meter will 

start reading values above 0 voltage. 

•  Total Demand Distortion (TDD Setting): This setting of the Device Profile allows 

you to set the maximum value for current, which is used for the TDD (Total 

Demand Distortion) calculation. TDD is an index used to measure harmonics. 
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TDD is defined in the IEEE 519 Standard, “Recommended Practices and Require-

ments for Harmonic Control in Electrical Power Systems” as “the total root-sum-

square harmonic current distortion in percent of the maximum load current.” It 

gives a better indication of the impact of distortion on Demand than THD (Total 

Harmonic Distortion), which analyzes the harmonic distortion relative to the fun-

damental, without consideration of load. In this field enter the maximum load 

current for TDD. To disable TDD, enter 0 in the field.

•  CT Reversal Phase Enables: Use this setting to enable CT reversal for any phase. 

This feature is useful if a CT is wired the wrong way and you do not want to (or 

cannot) change the wiring. When CT reversal is enabled, the meter’s firmware 

shifts the current phase by 180 degrees for that phase. This will reverse the 

power direction, and all computations such as power factor, phase angle etc., 

which are derived after that will be affected

NOTE: This setting is only available for a three element WYE hookup. For any 

other hookup, this setting will be ignored.

To implement phase reversal for a phase (A, B, or C), select Reversed next to 

that field. 

3. To implement any changes, click the Update Device button to send the new pro-

file to the meter.
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28.1.2: Configuring Time Settings

Use this setting to enable or disable Daylight Savings Time for the meter, to set the 

beginning and ending times for Daylight Savings Time, and to set up Time Zone infor-

mation and clock synchronization information.

1. From the Tree Menu, click General Settings>Time Settings. 

2. Check the box to Enable Daylight Savings time, or un-check it to Disable Day-

light Savings Time.

3. Use the entry fields to set the beginning and ending times for the Daylight Sav-

ings Time feature, if enabled. Select the values you want from the Month, Week, 

Day of the Week, and Hour fields. 

    NOTE: The Hour field uses a 24-Hour clock.

4. You can choose clock synchronization for the meter. If your meter has a Network 

Option card, you can use it to access a Network Time Protocol (NTP) Server** 
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for time synchronization. You can also select Line Sync for clock synchronization. 

Use these fields to set up clock synchronization:

•   Time Zone: Zone Descriptor - Select the hour and minute of your time zone in 

relation to Greenwich Mean Time. For example, if your time zone is Eastern 

Standard time, you would select -5 from the pull-down Hour menu and leave the 

Minutes field at 0.

•   Clock Sync - To enable clock synchronization, select:

•  Line (line synchronization) or NTP** from the Method pull-down menu

•  For line synchronization, select 50Hz or 60Hz from the Line Frequency 

pull-down menu; for NTP select either Option Card in Slot 1 or Option 

Card in Slot 2 from the Interface pull-down menu.

Line synchronization uses the frequency zero crossings to provide a time 

reference for the meter. This is the most common method to synchronize 

a meter’s clock. EIG recommends that you always select this method 

unless there is a specific reason not to select it. If the meter is not syn-

chronized to line frequency or NTP, it will default to internal crystal. Dif-

ferent meters differ in terms of drift, but typically meters with 20 ppm 

crystals will drift 30 seconds per month when set to internal crystal.

•   If you do not want to use Line or NTP clock synchronization, click 

 Disabled.

         **IMPORTANT! You also need to set up the NTP server information for the 

         Network card. See 28.5.6: Configuring a Network Card, on page 28-91 for 

         instructions.

5. To implement any changes, click the Update Device button to send the new 

profile to the meter.
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28.1.3: Configuring System Settings

Use the system settings to set up a meter ID and a time out setting for Test Mode. 

1. From the Tree Menu, click General Settings>System Settings. 

2. From this screen, you can do the following:

•  Change the Device Designation: input a new meter designation into this field. 

Note that it is important to name each meter individually, since the meter name 

is used to name the log databases when logs are downloaded.

•  You can enter additional relevant information in the User Memo field, if you wish. 

It will be displayed in the Memo field in the Main screen’s Status bar - see 2.2.2: 

Main Screen’s Status Bar, on page 2-8.

•  Test Mode Options: set the number of minutes without activity that will cause the 

meter to exit Test Mode. See 20.1.15.4: Test Mode and Energy Preset for the 

Shark® 250 Meter, on page 20-48 for more information on Test Mode.

•  *VA/VAh Computation Method: Select either Vector Sum or Arithmetic Sum from 

the pull-down menu.
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NOTE: There are two optional methods of VA/VAh Computation:

• Arithmetic Sum - the formula for this calculation is:

• Vector Sum - the formula for this calculation is: 

 

          Generally, the superior method for calculation is the Vectoral method; however,

         both methods are provided. 

     * Note that this setting replaces the previous Power setting in the Energy Scaling

        and Averaging Method screen.

3. To implement any changes, click the Update Device button to send the new 

profile to the meter.

VA VA VA VAT a b c= + +

VA W VART T T= +2 2
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28.1.4: Configuring Communication Settings

Communications settings have two parts: communication settings for the meter's two 

on-board ports: the USB Port (COM 1) and RS485 Port (COM 2), and DNP 3.0 config-

uration.

1. From the Tree Menu, click General Settings>Communications>Configure Serial 

Ports. 

IMPORTANT! The settings on this screen are the current settings for communica-

tion. Any changes you make may affect communication between the Shark® meter 

and your PC. 

2. The screen fields and acceptable entries are as follows:

•  COM 1 (USB)

• Response Delay: 0 - 750 (50msec increments)

NOTE: You will not see the USB setting if you are connected to a Shark 250T 

transducer.
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•  COM 2 (RS-485)

• Address:1 - 247 (Modbus); 1-65520 (DNP)

• Protocol:Modbus RTU, Modbus ASCII or DNP 3.0. If you select DNP 3.0 

communication, see 28.1.4.1: DNP3 Configuration, on page 28-11, for 

configuration settings.

• Baud Rate: 1200, 2400, 4800, 9600, 19200, 38400, 57600 

• Response Delay: 0 - 750 (50 msec increments)

Response Delay is the delay the meter should use before responding to 

queries. If your connecting device requires a delay before receiving infor-

mation, use response delay to program the time to wait before the meter 

starts responding to queries.

• Parity: Odd, Even, or None 

3. To implement any changes, click the Update Device button to send the new pro-

file to the meter.
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28.1.4.1: DNP3 Configuration

DNP3 Configuration consists of multiple settings that let you customize DNP3 for your 

application needs. Note that DNP protocol must be selected for either COM2 (the 

RS485 port) or an Ethernet Option card in order to use these settings screens (see 

28.1.4: Configuring Communication Settings, on page 28-9 and 28.5.6: Configuring a 

Network Card, on page 28-91). To access the DNP configuration screens, from the 

Tree menu, click Communications>DNP3 Configuration. 

NOTES: 

•  See Appendix C in the Shark® 250 Meter User Manual for detailed information on 
settings, including the meter’s default settings, and example use cases.

•  Clicking the Save XML button in the DNP3 screens generates the DNP XML Profile. 
The DNP XML Profile is a file that contains the characteristics and configuration 
parameters set in the DNP3 screens, as well as data from the meter itself (serial 
numbers, channels, etc.). This file can be used to further configure other peers, 

https://electroind.com/products/Shark_270/pdf/manuals/Shark%20270%20Revenue%20Energy%20Meter%20User%20Manual_E159708.pdf
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e.g., the Master device, in the DNP3 Network. If you need a DNP XML Profile, EIG 
recommends you click the Save button after making all of your DNP3 settings. 
Refer to official DNP3 documentation for DNP3 Network details.

•  Formatting of energy and power values (number of digits, decimal point position, 
etc.) is used for display, only - DNP3 always uses the raw values from the Modbus 
register.

28.1.4.1.1: General Settings

The first setting is General Settings.

1. From the Tree menu, click DNP3 Configuration>General Settings. You will see the 

screen shown on the previous page. 

2. You have the following options:

•   You can click Load Defaults to load the settings from the meter.

•   You can enter the settings manually. 

•   You can edit any of the settings.

•   You can clear the entries by clicking Clear.

3. The settings on this screen are:

•   DNP Slave Address: enter the DNP slave address for this meter. This is the 

address used with an RS485 serial link, only (not an Ethernet link).

•   Reply Confirm Timeout (ms): enter the reply confirmation timeout in millisec-

onds.

•   Unsolicited Messages: Select Disabled or Class 1, Class 2, or Class 3 from the 

pull-down menu. Note that the unsolicited messages are sent to the LAN only if 

the "Single Socket Enforced" option is enabled in the INP100S card’s DNP3 Sup-

port setting (see 28.5.6: Configuring a Network Card, on page 28-91). If this 

option is not enabled, DNP3 cannot send the unsolicited messages since it won’t 

know which meter socket to use.

•   Target Device for Unsolicited: enter the address for the target device for unsolic-

ited messages.

•   Unsolicited Timeout (ms): enter the unsolicited timeout in milliseconds.
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28.1.4.1.2: Time Synchronization

The second setting for DNP is Time Synchronization. Note that EIG recommends you 

use only one method for meter time synchronization: if you enable the DNP Time 

Sync and you have a Network card, do not use the NTP feature for the Network card.

1. From the Tree menu, click DNP3 Configuration>Time Synchronization. 

2. You have the following options:

•   You can load the default setting by clicking the Default button.

•   You can clear the entry by clicking Clear.

•   You can choose the allow time synchronization of the meter through DNP. When 

time synchronization is enabled, a Master must write the time into the meter. 

The time is updated frequently to reduce jitter and offsets. The options for time 

synchronization are:
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• Disabled - no time sync through DNP is allowed.

• From Serial - the time sync will be accepted from DNP only through the 
serial line (RS485 or other serial option).

• From Serial or Network Card - the time sync will be accepted from DNP 
serial or DNP network communication.

3. The Sync Renewal Time is the period the time is considered valid after the Mas-

ter has written it into the meter. After this time, the Meter will flag NEED_TIME 

in its responses, to let other devices know that it needs a time update. 

4. The Send Null unsolicited message checkbox allows the meter to send a null 

unsolicited message when the valid time expires, letting other devices know, 

immediately, about the need for time resynchronization. This is an additional 

feature which is not required by the DNP3 standard.
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28.1.4.1.3: Analog Inputs

The third setting for DNP is Analog Inputs, which are non-accumulator readings.

1. From the Tree menu, click DNP3 Configuration>Analog Inputs. 

2. You can make settings for Objects 30, 32, and 34 by clicking on the different 
tabs. The screen above shows the settings for Object 30. You have the following 
options:

•   You can load the default settings by clicking the Default button.

•   You can clear the entries by clicking Clear.

•   You can enter the Analog Input settings manually:

• Up to 64 points can be defined for DNP Analog Inputs. Select the reading 
you want to use from the pull-down menu, which lets you choose from 
groups of Measured Values, Demand, Harmonics, Meter Status, Basic 
Setups, and TOU parameters. For example, the reading Volt-A can be 
selected.
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3. For the Object 30 tab:

•   You can use the Scaling field to enter a multiplier value to change the magnitude 

of the reading for DNP. The scaling can be a positive fraction or integer; enter 1 

for no scaling.

• For example, you might want to scale the Volt-A reading, which has a

 full scale value of 600, to a higher range, e.g., 60000. To do that, you

 would set the Scaling value to 100. Scaling can also be used to scale

 down the value by using a fraction in the Scaling field. If no change is

 needed, the Scaling field must be left as 1.

•   The Class 0 column allows you to include or not include the reading in a DNP 

Class-0 response. This gives you a practical way to poll several readings at a 

time, through grouping them into a class query.

4. For the Object 32 tab (shown above):
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• The Analog Event Object 32 is used as a capture placeholder (data storage) for 

dead banding events. Dead banding events are used when you want to know if 

an Analog Input varies by more than a specified amount. The amount of allow-

able variation is called a deadband. If the Analog Input varies in an amount less 

than the deadband, nothing happens, since it is considered within limits. When-

ever the variation amount exceeds the deadband, a snapshot is taken of the 

Analog Input, i.e., the data is copied to the corresponding Object 32 and an 

event is flagged for that reading. This allows the user to later check on the Ana-

log Input value at the time of the event.

•   Object 32 can be also assigned to Class 1,2 or 3, allows creation of different 

groups for different events.
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5. For the Object 34 tab (shown above):

•   The deadband value is used for detecting the changes in the Analog Input. A 

value of 0 disables this feature. The deadband is always a positive number, but it 

checks for the absolute variation, either positive or negative. Note that if Scaling 

is used, the deadband will compare the Analog Input value after scaling has 

been applied.

NOTE: EIG recommends you do not set the deadband value too small, to avoid 

filling up the DNP Event Buffer with very minor fluctuations, causing bigger fluc-

tuations to be missed.
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28.1.4.1.4: Binary Counters

The fourth setting for DNP is Binary Counters, which are accumulator readings.

1. From the Tree menu, click DNP3 Configuration>Binary Counters. 

2. You can make settings for Objects 20, 21, and 22 by clicking on the different 

tabs. The screen above shows the settings for Object 20 Binary counter. You 

have the following options:

•   You can load the default settings by clicking the Default button.

•   You can clear the entries by clicking Clear.

•   You can enter the settings manually, for the binary counters:
• Select the reading you want to use from the Group and Reading pull-

down menu, e.g., Group - Uncompensated, Reading - Wh. 

3. For the Object 20 tab:
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•   You can use the Scaling field to enter a multiplier value to change the magnitude 

of the reading for DNP. The scaling can be a positive fraction or integer; enter 1 

to keep the reading’s scaling the same as in the meter.

•   The Class 0 column allows you to include or not include the counter in a DNP 

Class-0 response.

4. For the Object 21 tab (shown above):

•   Frozen Binary Counter Object 21 is a placeholder used when the meter is 

instructed to freeze the respective counter. In other words, when the meter 

receives the instruction to freeze counters, it copies the Binary Counter (Object 

20) into the Frozen Binary Counter (Object 21) placeholder, where it is kept 

available for the user to read. Only a new freeze will update the Frozen Binary 

Counter Object 21.
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•   The Frozen Binary Counter can be assigned to Class 0, only. (It does not have to 

be assigned to Class 0, though.)

 

5. For the Object 22 tab (shown above):

•   Use the Change Delta field to set up a value in the same raw unit as the reading, 

which is used to define a threshold value for the counter. This threshold value 

instructs when to create an event for Binary Counter Event Object 22. Every 

time the Binary Counter changes by the value of the Change Delta field, or by a 

greater value, an event for Object 22 is created. If the Change Delta value is 0, 

changes for this reading are not monitored.

•   The Binary Counter Event Object 22 can be assigned to Class 1,2 or 3.

•   Clear After Freeze is not supported. To clear the binary counters, Binary Output 

Point #4 must be Pulsed-On/Latched-On via Object 12, V1 - Direct Operate. 

(See Appendix C in the Shark® 250 Meter User Manual for details). Note that 
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because the meter does not support clearing individual counters, all the binary 

counters will be cleared

NOTE: EIG recommends you do not set the Change Delta value too small, to 

avoid filling up the DNP Event Buffer with very minor fluctuations, causing bigger 

fluctuations to be missed.

28.1.4.1.5: DNP3 Auto-Freeze

The meter’s DNP implementation lets you freeze defined Object 20 and Object 30 

points automatically, on a periodic schedule, without needing to send the Freeze com-

mand through DNP. This feature is set up through the fifth DNP setting, DNP3 Auto 

Freeze, which copies the original Object 20 and Object 30 data points into Object 21 

and Object 31 data points, respectively, along with the time stamp of the copy pro-

cess. 

•  The Object 21 and Object 31 data points are also referred to as "previous" values: 

they belong to the previous Auto Freeze period.

•  If the meter loses power, the frozen points in Object 21 and Object 31 are pre-

served. 

•  Note that the frozen DNP points (Object 21 and Object 31) have the same scale and 

unit as their respective points in Object 20 and Object 30. 

•  For example, if point# 0 of Object 20 has been configured with Wh Total register 

and 0.001 scaling, reading point #0 of Object 20 will give us a KWh value. When 

the Auto Freeze period has elapsed, the value in reading point# 0 is copied into 

point #0 of Object 21. Further readings to point# 0 of Object 20 will show the cur-

rent KWh value (increasing, if there is energy flow), but the point# 0 of Object 21 

will stay frozen in its original value until the next Auto Freeze period has elapsed. At 

that point, the new KWh value will be written into the Object 21 point.
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1. From the Tree menu, click DNP3 Configuration>Auto Freeze. 

Note that if you haven’t enabled DNP3 Auto Freeze, the menu option will say Auto 

Freeze: Disabled; and if Auto Freeze is already enabled, it will say Auto Freeze: 

Enabled.

2. To enable Auto Freeze, check the Enabled box.

3. To set up the Auto Freeze period, i.e., the time the current values of objects 21 

and 31 are copied into the Frozen objects 21 and 31:

a. From the Period pull-down menu, select the Auto Freeze period, i.e., 

frequency: Monthly, Weekly, Daily, or Hourly.
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b. From the On pull-down menu, select the day of the month the Auto Freeze 

period starts: 1-31, or “Last Day of Month.” Note that if you selected 

Monthly as your period, you shouldn’t select a day that doesn’t exist in all 

months, since that would cause that month’s Auto Freeze to be disabled; 

e.g., if you select 30, February will be skipped. In that case, use the “Last 

Day of the Month” setting.

c. From the Time of Freeze pull-down menus, select the hour (0-23, using a 

24-hour clock, where 0 is midnight and 23 is 11 P.M.), and minute (0, 15, 

30, 45) the Auto Freeze period begins.

4. If you want the Maximum and Minimum Demand to be reset when Auto Freeze 

takes place, check the box. Note that this box will not be selectable if TOU is 

enabled.
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28.1.4.1.6: Binary Inputs

The next setting for DNP is Binary Inputs, which is used for the digital inputs from the 

meter’s RO1S (relay output/digital input) and/or PO1S (pulse output/digital input) 

Option cards.

1. From the Tree menu, click DNP3 Configuration>Binary Inputs. 

You will only see settable fields if an Option card is installed in the meter. Note that 

the RO1S has two digital inputs and the PO1S has four digital inputs. 

2. You have the following options:

•   You can load the default settings by clicking the Default button.

•   You can clear the entries by clicking Clear.
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•  You can enter the settings manually, for the Binary Inputs:

• For the Event Object 2 fields, select the Class you want to use: Class 0, 

which corresponds to Object 1 (static binary inputs), or Class 1, 2, or 3, 

which all correspond to Object 2 (binary input events).

• If Class 1,2 or 3 is assigned to the Binary Input Event Object 2, the

 Binary Input will be checked for changes. Every time the input 

 changes state, an event will be created and the value put into the

 Binary Input Event Object 2. This allows the user to later check on the

 value at the time of the event.

• Note that when you select a Class, the Allow in DNP3 box is checked 

automatically. If you uncheck the box, all selected classes will be 

unchecked.
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28.1.4.1.7: Binary Outputs

The next setting for DNP is Binary Outputs, which is used for the relay outputs of the 

RO1S Option card.

1. From the Tree menu, click DNP3 Configuration>Binary Outputs. 

You will only see settable fields if at least one RO1S card is installed in the meter. 

You can have two RO1S cards installed in a meter.

2. You have the following options:

•   You can load the default settings by clicking the Default button.

•   You can clear the entries by clicking Clear.

•   You can enter the settings manually, for the binary outputs:

• Under Object 12 Allow in DNP, click the checkbox next to any relay output 
you want to be accessed through DNP.
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• For the Object 12 Class 0 fields, Class 0 corresponds to Object 10 (static 
output state).

• The relay outputs require a Select before Operate procedure through DNP 
in order to change them. If instead you want the relay output to be 
pulsed directly, set up Direct Operate for the options listed: Reset Energy 
Counters, Change to Modbus Protocol, Reset Demand Counters, and Man-
ual Waveform Capture. 

• Select a timeout in milliseconds. The timeout is the maximum time 
allowed between the select command being issued and the relay being 
operated.

NOTES on Binary Output Points

Relay Card
Physical 

Output

DNP 

Point
Actions Action Mode Notes

Slot #1
1 0 Latch On / Latch Off  Select Before Operate Physical Relay

2 1 Latch On / Latch Off  Select Before Operate Physical Relay

Slot #2
1 2 Latch On / Latch Off  Select Before Operate Physical Relay

2 3 Latch On / Latch Off  Select Before Operate Physical Relay

Reset Energy 4 Latch On / Pulse On Direct Operate Automatically cleared

Switch RS485 

to Modbus 

RTU

5 Latch On / Pulse On Direct Operate Automatically cleared

Reset Demand 

Counters
6 Latch On / Pulse On Direct Operate Automatically cleared

Trigger 

Waveform 

Capture

7 Latch On / Pulse On Direct Operate Automatically cleared
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  Possible Errors When Operating an Output Point Between 0 and 3

Possible Errors When Operating an Output Point Between 4 and 7

Possible Errors Using Select Before Operate command

Error If …

Not Supported

Actions other than Latch‐On or Latch‐Off were issued (Trip, Close, 

Pulse, etc.)

Not Supported Trying to select any DNP3 Output point out of range (0 to 3)

Not Supported

Trying to select a point between 0 and 3, but the corresponding Relay 

Card is not installed

Local

Trying to select an output point that is being used by ElectroLogicTM 

Relay Control (configured in Device profile)

Local

Trying to select an output point that has not been allowed in the DNP 

profile

Accepted Point selected

Error If …

Not Supported Actions other than Latch‐On or Latch‐Off were issued (Trip, Close,Pulse, etc.)

Not Supported

Trying to operate a point between 0 and 3, but the corresponding Relay Card is 

not installed.

Local

Trying to operate an output point that is being used by the ElectroLogicTM Relay 

Control (configured in Device profile)

Local Trying to operate an output point that has not been allowed in the DNP profile

No Select Trying to operate an output which has not been previously selected

Accepted Point selected

Error If …

Not Supported Trying to select any DNP3 Output point out of range (8 or larger)

Not Supported Actions other than Latch‐On or Latch‐Off were issued (Trip, Close, Pulse, etc.)

Not Supported
Trying to operate point 7 (waveform capture) but there is no log memory 

allocated for waveforms

Local Trying to operate an output point that has not been allowed in the DNP profile

Timeout Trying to operate point 4 (reset energy) when the meter has not warmed up yet

Timeout
Trying to operate point 7 (waveform capture) when there is a capture already in 

progress

Not Authorized
Other functionality is solely responsible for reseting energy (TOU, AutoFreeze, 

etc.) or Security settings do not allow it (Seal switch)
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28.1.4.1.8: Strings 

The next setting for DNP is Strings, which is used to set up reporting of static informa-

tion, such as meter model.

1. From the Tree menu, click DNP3 Configuration>Strings. 

2. You have the following options:

•   You can load the default settings by clicking the Default button.

•   You can clear the entries by clicking Clear.

•   You can enter the settings manually, for the strings:

• Points 0, 2 and 3 are hard-coded and fixed in the meter.

• Point 1 can be configured in the meter’s Device Profile. See 28.1.3: Con-
figuring System Settings, on page 28-7.
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• Point 4 is an editable string, which you can enter. The maximum number 
of characters you can use is 16.

• The only assignable class for the strings is Class 0. Click the checkbox to 
assign any of the strings to Class 0.

3. To implement any changes, click the Update Device button to send the new pro-

file to the meter.

28.1.4.1.9: Default Variations

The last setting for DNP is Default Variations, which is used to configure the variations 

used by the meter for each object when Variation 0 is requested by a query. Note that 

there are default configurations already set up in the meter for Variation 0, but this 

setting lets you change them. Refer to Appendix C in the Shark® 270 Meter Installa-

tion and Operation Manual for details on this setting.

1.From the Tree menu, click DNP3 Configuration>Default Variations. 
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2. For each of the objects listed under Global Values, you can select the variation 

number you want to use by clicking in the Variation line and then choosing the vari-

ation from the pull-down menu.

•   Some objects have more than one type (i.e., Float, 16-Bit, or 32-bit), depending 

on the reading being mapped. If you need to program a different variation for an 

object depending on its type, uncheck the Simple Mode box. Then you can 

assign a variation to each type, individually. See the example configuration for 

Object 30, Analog Inputs, below; each of the object’s types has been pro-

grammed with a different default Variation.

 

•   If you want to set the same variation for all of an object’s types, check the 

Simple Mode box and select the variation for the object.



     Doc#    E107707                                            28-33

28: Shark® 250 Meter

28.1.5: Setting Display Configuration

Some users may want to lock the meter to a particular faceplate display or series of 

displays. For example, if you would like the meter to act only as a Volt meter, or only 

as an ammeter, the meter can be configured to display only the relevant screen. Use 

this setting to lock the display of the Shark® 250 meter's faceplate to the specific 

combination you want. Refer to the meter’s Installation and Operation Manual for 

additional information on the faceplate. Note that you will not see this setting if you 

are connected to a Shark® 250T transducer.

1. From the Tree Menu, click General Settings>Display Configuration.

2. The screen fields and acceptable entries are as follows:

•   Phases Displayed: A; A and B; A, B, and C. This field determines which phases 

display on the faceplate. For example, if you select A and B, only those two 

phases will be displayed on the faceplate.   
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•   Auto Scroll Display: Click to enable, leave unchecked to disable. This field 

enables/disables the scrolling of selected readings on the faceplate. If enabled, 

the readings scroll every 5 seconds.

•   Enable on Face Plate of Display: Check the boxes of the Readings you want dis-

played on the faceplate of the meter. If you make no selection, Amps are dis-

played by default.

•   Current (I) Display Autoscale: On to apply scaling to the current display or Off 

(No decimal places).

•    Load Bar Custom Configuration: This allows the meter to display load with an 

analog representation. This way the user can get a visual presentation of the 

loading of the circuit. To enter scaling for the Load Bar:

a. Click the Use Custom Configuration checkbox. Fields display on the screen 

that allow you to enter a Scaling factor for the display. See the 

figure below

b. Enter the scaling factor you want in the Current Scale field. This field is 

multiplied by the CT Multiplier set in the CT, PT Ratios, and System Hookup 

screen (see 28.1.1: Configuring CT, PT Ratios and System Hookup, on 

page 28-2) to arrive at the Primary Full Scale. Make sure you set the CT 

multiplier correctly.

•   Display Voltage in Secondary: Click to enable or uncheck to disable. This setting 

overrides the next setting, i.e., if it is selected, the fixed scale setting is ignored.

•   Enable Fixed Scale for Voltage Display: To enter a scaling factor for the Voltage 

display (note that this setting is ignored if you select to display voltage in sec-

ondary in the previous setting):
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a. Click the checkbox next to Enable Fixed Scale for Voltage Display. The 

screen changes - see the figure below.

b. Select the scaling you want to use from the pull-down menu. The options 

are: 0-9999V, 100.0kV-999.9kV, 10.00kV-99.99kV, or 0kV-9.999kV.

3. To implement any changes, click the Update Device button to send the new pro-

file to the meter.
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28.2: Revenue and Energy Settings

From the Tree Menu on the left side of the Shark 250 meter’s Device Profile screen, 

double-click on the Revenue and Energy Settings line or click on the + button next to 

it. The settings in the Revenue and Energy Settings group are listed.

28.2.1: Configuring Energy, Power Scaling, and 
               Averaging

From the Tree Menu, click Revenue & Energy Settings> Energy, Power Scaling, and 

Averaging (see the screen above). Use this setting to configure: 

•   The display and storage of Energy registers in the meter

•   The display of Power data in the meter 

•   The interval over which Average values are computed, as well as the Interval 

Energy 
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Functional Overview of Energy Settings, VA Computation, and Averaging:

•   Energy Scaling

Energy Setting includes:

Digits (the number of digits in the reading)

Decimals (the number of decimal places in the reading)

Energy Scale: the scale of the reading - unit; kilo (number times 1000); Mega 

(number times 1 million)

Energy settings allow you to balance the resolution (or accuracy) of the energy 

stored, with the interval over which energy rollover occurs. For example, the 

maximum resolution for a k scale reading is: 99999.999k.

To calculate the speed at which the energy will rollover, you must know the Power 

Full Scale, which is computed from the CT and PT Full Scale values (see 28.1.1: 

Configuring CT, PT Ratios and System Hookup, on page 28-2). The formula for cal-

culating Power Full Scale is:

Wye system: CT Full Scale x PT Full Scale x 3 

Delta system: CT Full Scale x PT Full Scale x 3 x 

For example, for a CT Full Scale of 2000, PT Full Scale of 14400, Wye system:

2000 x 14400 x 3=86400000

In this example, the energy will increment at 86400000 Watts per hour, or 24000 

Watts per second.

This value allows you to determine the number of digits, decimal places, and 

energy scale you want to configure for the Energy settings, when you take into 

account the rollover time. 

To determine the number of hours before rollover, use this formula:

[Max Resolution]/[Full Scale] = #Hours, where Max Resolution = maximum digits 

and decimals for the Energy scale in use. 

Using the example from above, with an energy scale of Mega, the formula would 

be:

99999.999 M/86.4 M = 1157.4074 hours or about 48 days until rollover. 

NOTE: To increase the number of days until rollover, you can increase the number 

3
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of digits (to 8), decrease the number of decimal places (to 0), or increase the 

Energy Scale (to M).

•   Demand Averaging 

Demand is the average rate of energy use over time. The Shark® 250 meter 

supports two types of demand averaging: Block demand and Rolling demand.

Block demand records the average demand for time intervals that you define (

usually 5, 15 or 30 minutes). 

Rolling demand functions like multiple, overlapping Block demands. You define the 

subintervals at which an average of demand is calculated. An example of Rolling 

demand would be a 15-minute Demand block using 5-minute subintervals, thus 

providing a new demand reading every 5 minutes, based on the last 15 minutes.

1. The screen fields and acceptable entries are as follows:

•   Energy Demand Format: for each of the readings, enter:

• Digits (number of digits): 5; 6; 7; 8

• Decimals (number of decimals): 0 - 6

• Scaling: unit; kilo (k); mega (M)

Example: shows the result of your choices, i.e., reading for Digits: 8; 

Decimals: 3; Scale: k, show leading zeros, would be formatted as: 

00123.456k

• Check the box to use only positive energy and accumulators.

       NOTES: 

• Your selection in the Energy Demand Format fields determines the preci-

sion of energy stored for display and polling. Refer to the Functional Over-

view at the beginning of this section for more information.

• If you are changing the energy settings, we recommend you first reset 

the Energy Accumulators, in order to prevent erroneous counts. See 

20.1.7: Reset Device Information, on page 20-7, for instructions on 

resetting the Shark® 250 meter's Energy Accumulators.
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•   Power Settings

• Decimals (number of digits): 0-3

• Scaling: Auto; unit; kilo (k); mega (M)

•   Demand Averaging

• Type: Block or Rolling

• Interval (Block demand) or Sub-Interval (Rolling demand): 3; 5; 15; 30; 

60

• Number of Subintervals: 1; 2; 3; 4; 5

• Interval Window: This field is display only. It is the product of the values 

entered in the Sub-Interval and Number of Subintervals fields.

        NOTES: 

• You will only see the Number of Subintervals and Interval Window fields if 

you select Rolling demand.

• If you have set an Input to trigger EOI demand averaging (using either a 

Relay Output/Digital Input or Pulse Output/Digital Input Option card) any 

entry you make in the Demand Averaging field will be ignored. A message 

to that effect appears on the screen. See 28.5.2: Configuring a Relay 

Output/Digital Input Card, on page 28-75 and 28.5.3: Configuring a Pulse 

Output/Digital Input Card, on page 28-81, for instructions on setting EOI 

pulse for demand averaging. Note that this affects Time of Use as well, 

since the TOU accumulations will occur at the EOI trigger point, rather 

than on the programmed interval, which can result in TOU periods of 

longer or shorter length than expected. 

2. To implement any changes, click the Update Device button to send the new pro-

file to the meter.
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28.2.2: Power and Energy Labeling

This setting matches the direction of power for the meter to that of the electrical 

system being measured. Use it to designate the system as an inductive (lagging) 

load, with current lagging voltage; or as a capacitative (leading) load with current 

leading voltage. 

Power direction for the meter is determined by setting the power quadrants as lagging 

or leading; setting the sign order for power and energy readings, such as watt/watt-

hour; and setting the quadrant labels as received or delivered. This setting insures 

that the meter’s power measurements match the electrical system. There are exam-

ples of different power direction settings, after the instructions.

1. From the Tree Menu, click Revenue & Energy Settings> Power and Energy Labeling.
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2. Make these settings:

a. Current Phase Angle Direc-

tions: designate each of the 4 

energy quadrants, Q1, Q2, 

Q3, Q4, as Lead(ing) or 

Lag(ging). 

b. Quadrant Sign 

Order: 

designate the 

positive and neg-

ative power quad-

rants for W/Wh, VAR/VARh, and Power Factor.

c. Quadrant Labels: select 

the labels from the pull-

down menus..

d. See the examples of 

different quadrant settings on the next two pages.

3. To implement any changes, click the Update Device button to send the new pro-

file to the meter.



     Doc#    E107707                                            28-42

28: Shark® 250 Meter

Example 1 

These settings are illustrated below (they are the factory default settings). 
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Example 2 
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28.2.3: Aggregators Setting

Aggregators are registers that hold the sum/difference of data from multiple sources, 

internal and external. An example use for an aggregator is to totalize pulses from 

different meters. The Shark® 250 meter offers four aggregators. The aggregators get 

data from two sources: 1. an input that is set up as an accumulator (see 28.5.2: Con-

figuring a Relay Output/Digital Input Card, on page 28-75 and 28.5.3: Configuring a 

Pulse Output/Digital Input Card, on page 28-81) and 2. one of the meter’s energy 

registers. The value of the Input accumulator(s) and of the energy register can either 

be added to, or subtracted from, the aggregator. 

The Pulse Output/Digital Input card has four inputs and the Relay Output/Digital Input 

card has two inputs. Each aggregator can hold the addition/subtraction of one to eight 

of the digital inputs and 1 energy register listed in the table below and on the follow-

ing page.

Energy (Compensated & 
Uncompensated)

It, Phase A

It, Phase B

It, Phase C

Vt, Phase A-N

Vt, Phase B-N

Vt, Phase C-N

Vt, Phase A-B

Vt, Phase B-C

Vt, Phase C-A

Wh, (Q1+Q4)

Wh, (Q2+Q3)

VARh, (Q1+Q2)

VARh, (Q3+Q4)

VAh, Total

Quadrant 1 Wh, Total

Quadrant 1 VARh, Total

Quadrant 1 VAh, Total
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Quadrant 2 Wh, Total

Quadrant 2 VARh, Total

Quadrant 2 VAh, Total

Quadrant 3 Wh, Total

Quadrant 3 VARh, Total

Quadrant 3 VAh, Total

Quadrant 4 Wh, Total

Quadrant 4 VARh, Total

Quadrant 4 VAh, Total

VAh (Q1+Q4), Total

VAh (Q2+Q3), Total

+Qh, Total

-Qh, Total

Energy (Compensated & 
Uncompensated)
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1. To set up aggregators, click Revenue and Energy Settings>Aggregators>Aggrega-

tor (1-4). All four aggregators are set up the same way.

2. In the Source section you set up the Input and the Energy register to use:

a. Depending on the Option card(s) installed in the meter, you will see 

between none and eight Option card Inputs listed. Click the checkbox to 

the left of any Inputs you want to use in the aggregator. The scaling and 

label for that accumulator is listed to the right of the Input’s field.

IMPORTANT! The Input must be assigned as an accumulator. See 28.5.2: 

Configuring a Relay Output/Digital Input Card, on page 28-75 and 28.5.3: 

Configuring a Pulse Output/Digital Input Card, on page 28-81, for instruc-

tions on setting up an Input as an accumulator.
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b. Select Add or Subtract from the pull-down menu next to each Input you are 

using. Add means that you want to add the Input accumulator value to the 

aggregator; subtract means you want to subtract the Input accumulator 

value from the aggregator.

c. Click the checkbox to the left of Meter Energy and select the energy register 

you want to use from the pull-down menu. The top menu lets you select 

the Energy type, e.g., Scaled Energy, and the bottom menu lets you select 

the energy register, e.g., Wh Delivered. 

d. Select Add or Subtract from the pull-down menu next to the Meter Energy 

field. Add means that you want to add the Energy value to the aggregator; 

subtract means you want to subtract the Energy value from the aggregator.

3. In the Format section you set up the energy format and label for the aggregator: 

a. Select the number of digits (5-8), decimals (0-6), and scaling (kilo or 

Mega), from the pull-down menus.

b. The Example field shows what your formatting choices will look like.

c. Enter a label for the aggregator. The label can be up to 32 characters.

4. To implement any changes, click the Update Device button to send the new pro-

file to the meter.



     Doc#    E107707                                            28-48

28: Shark® 250 Meter

28.2.4: Cold Load Pickup (Demand Forgiveness)

The Shark® 250 meter offers Cold Load Pickup, so that in case a power system out-

age or excessive power system voltage drop occurs, when normal service is resumed, 

the customer will not be billed for the initial surge or in-rush of power to feed its “cold 

loads.” During the initial time period immediately following the return of normal elec-

tric service, the demand is not computed in the Demand Registers if the two threshold 

conditions described below are met, so the customer is not billed for possible exces-

sive demand due to “cold load pickup.”

•  A power system outage which drops the metering potential inputs to the meter (to 

below a programmed threshold) and also drops the meter’s power.

•  A power system outage which drops the metering potential inputs to the Meter (to 

below a programmed threshold), but the meter’s external power remains supplied 

by an alternate source (e.g., station battery, station service, etc.), that is, the 

meter continues to operate.

Note that energy is always continuously measured and is also recorded in the Power 

Profile Logs, if so configured (see 28.4.2: Trending Profiles - Configuring Historical 

Logs, on page 28-68, for log setup procedures).
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1. From the Tree Menu, click Revenue & Energy Settings> Power and Energy Labeling. 

Use this setting to enable and configure the meter’s cold load pickup/demand 

forgiveness feature. When enabled, this feature lets you set the amount of time 

power is off to identify a power outage that is the responsibility of the utility (as 

opposed to a very short term loss of power that is not their responsibility) and the 

amount of time you want to wait before demand starts again. This time should cor-

respond to the “grace” period the utility applies to avoid charging for motor startup, 

etc. after a power outage. 
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2. Make these settings:

a. Click Apply delay if 

Meter’s Auxiliary 

Power is Lost. The 

Intervals fields dis-

play on the screen.

• Demand 

Forgiveness 

Interval: use 

the up and 

down arrows 

to set the amount of time (in seconds) that Demand is not accumulated 

when a cold load condition occurs. 

• Minimum Loss of Service: use the up and down arrows to set the mini-

mum amount of time that power needs to be off before a cold load condi-

tion occurs.

• Maximum Allowed Service On-Time: use the up and down arrows to set 

the maximum time that Demand is not accumulated when a cold load 

condition occurs.

b. Click Apply Delay if 

Meter Potential Volt-

age Drops Below 

threshold. The Inter-

vals and Thresholds 

(Secondary) fields 

display on the screen.

• You can select 

to apply the 

threshold to 

either all 

phases (click 

On All Phases 

radio button) 

or any of the phases (click On Any Phase radio button).
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• Make the Intervals settings the same as in step a.

• Set the thresholds: use the up and down arrows to enter the percentage 

drop for each phase A-N, B-N, C-N.

3. To implement any changes, click the Update Device button to send the new pro-

file to the meter.

28.2.5: Transformer/Line Loss Compensation

Transformer losses are power used by the transformer while working. The more load 

on the transformer, the higher the transformer losses. There are two types of trans-

former losses:

•   No load losses - these are the fixed losses that keep the transformer up and 

running.

•   Load losses - these vary with changes in the load.

When the meter is located on the secondary side of a customer’s transformer, a utility 

will want to add the transformer losses into the energy usage calculation. However, 

this practice is regulated by local jurisdiction and regulations. The meter has the 

capability to add in or subtract out these transformer losses, depending on the user’s 

specific needs.

Line losses are similar to transformer losses, except that they are used to compensate 

for loss incurred on wires, such as transmission lines.

Transformer/Line Loss Compensation allows you to add or subtract transformer and/

or line losses to meter registration.
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1. From the Tree Menu, click Revenue & Energy Settings>Transformer/Line Loss 

Compensation.

2. This screen displays the current values for the meter's Transformer Loss Com-

pensation. The screen fields and acceptable entries are as follows

•   Percent Loss of Watts due to Iron and Copper/Positive Watts and Negative Watts

•   Percent Loss of VARS due to Iron and Copper/Positive and Negative Watts

•   Drop-down menu #1. Choose from: Disabled, Fe Only, Cu Only, Both Fe and Cu.

•   Drop-down menu #2. Choose from: Add to Watts and VAR; Add to Watts and 

Subtract from VAR; Subtract from Watts and Add to VAR; Subtract from Watts 

and VAR.

3. Click TLC Calculator to find the values to enter into the Percent Loss fields. The 

TLC Calculator button launches the TLC Calculator that makes the calculations 

for you once you enter the required data.   

NOTE: Appendix A contains screen captures of the Loss Calculator with example 

numbers, and an explanation of Loss Compensation considerations.
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4. Enter the percent Loss of Watts and VARS for copper and iron in the appropriate 

fields.    

5. To implement any changes, click the Update Device button to send the new pro-

file to the meter.

28.2.6: Time of Use Setting

The Shark® 250 meter offers Time of Use. See Chapter 15: Time of Use, on page 15-

1, for instructions. To enable or disable, Time of Use for the meter:

1. Click Revenue & Energy Settings>Time of Use.

2. Check the box to enable Time of Use; uncheck the box if you want to disable it.

3. To implement any changes, click the Update Device button to send the new pro-

file to the meter.
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28.2.7: Internal Accumulators for Pulse Factors

Pulse factors are the weight of a KYZ pulse for energy consumed. The meter uses 

pulses for load profiling of accumulated energy over demand intervals. The pulse 

weights are assigned in this Device Profile setting. 

1. From the meter’s Programmable Settings screen in the CommunicatorPQA® appli-

cation, click Revenue and Energy Settings>Pulse Factors>Internal Accumulators.

2. For each of the energy reading accumulators, enter the pulse weight you want to 

assign to it. The pulse weight must be between 0.01000 and 9.99999.

3. For the Pulse computation based on setting select either Primary to use primary 

energy or Secondary to use secondary energy.

4. To implement any changes, click the Update Device button to send the new pro-

file to the meter.
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28.2.8: CT and PT Compensation

CT/PT compensation is used to correct for errors caused by the current transformers 

(CTs) (external to the meter) and Potential/Voltage transformers (PTs) connected to 

the meter. 

From the Tree Menu, click Revenue and 

Energy Settings>CT & PT Compensation. 

Two options open under CT & PT Compen-

sation: Compensate CTs and Compensate PTs. Use these settings to enable and set 

compensation factors for the meter.
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28.2.8.1: Compensate CTs

The first CT & PT Compensation setting option is Compensate CTs.

1. From the Tree menu, click CT & PT Compensation>Compensate CTs.

2. Make sure the Enable CT & PT Compensation in Meter box is checked. If it is not,

any settings you enter won’t be implemented. The top of the screen shows the

system frequency and the CT ratio (see 28.1.1: Configuring CT, PT Ratios and

System Hookup, on page 28-2). Make these settings:

a. The first screen you see displays the settings for Phase A CT compensation. Click

the Next Phase button at the bottom of the screen to enter settings for phases B

and C.
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b. For each of the phases, enter up to 8 points of % of rated current, ratio correc-

tion factor (0.08500 to 1.1500), or phase error/arcminutes (-60 to +60). The

Value (A) field displays the current value for the “% of rated current” setting you

entered. For example, if the current Full Scale is 5 A, and you enter 0.01% in the

“% of rated current field,” the value will be 0.0005 A. Refer to your CT manufac-

turer’s documentation for the values to enter on this screen.

• If you don’t want to use a test point, enter 0% for the rated current.

c. Continue to the next phase and repeat step 2b.

3. To implement any changes, click the Update Device button to send the new pro-

file to the meter.
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28.2.8.2: Compensate PTs

The second CT & PT Compensation setting option is Compensate PTs.

1. From the Tree menu, click CT & PT Compensation>Compensate PTs.

2. Make sure the Enable CT & PT Compensation in Meter box is checked. If it is not,

any settings you enter won’t be implemented. The top of the screen shows the

system frequency and PT ratio (see 28.1.1: Configuring CT, PT Ratios and Sys-

tem Hookup, on page 28-2). Make these settings:

a. The first screen you see displays the settings for Phase A PT compensation. Click

the Next Phase button at the bottom of the screen to enter settings for phases B

and C.
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28.3: Power Quality and Alarms Settings 

From the Tree Menu on the left side of the Shark® 250 meter’s Device Profile screen, 

double-click on the Power Quality and Alarms Settings line or click on the + button 

next to it. All of the settings in the Power Quality and Alarms Settings group are listed.
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28.3.1: Configuring Limits 

1. From the Tree Menu, click Power Quality and Alarm Settings>Limits (see the screen 

on the previous page). The current settings for Limits are shown in the screen. Use 

this screen to assign Limits for the Shark® 250 meter. 

Functional Overview for Limits:

Limits are transition points used to divide acceptable and unacceptable measure-

ments. When a value goes above or below the limit, an out-of-limit condition 

occurs. You can set and configure up to 16 Limits for the Shark® 250 meter.

Once they are configured, you can view the out-of-Limits (or Alarm) conditions in 

the Limits Log (see Chapter 19) or Limits Polling screen (see Chapter 5). You can 

also use Limits to trigger relays.

You can assign the eight limits to readings from the following groups and sub-

groups: 

•   Measured Values 

• Subgroups: Readings and Uncompensated Readings

•   Max/Min Demand 

• Subgroups: Maximum, Minimum, Voltage Maximums in the Interval, and 

Voltage Minimums in the Interval

•   Average Demand

•   Harmonics/THD

•   Subgroups: THD and Magnitudes

2. The bottom of the screen shows the Full Scale values for:

•   Voltage

•   Current

•   Power

•   Power Total
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3. To set or change a Limit:

a. Select a limit by double-clicking on the Assigned Channel field.

b. You will see the screen shown below. 

c. Select a Group, Subgroup if applicable, and an Item for the Limit.

d. Click OK. The Limit you selected will now appear in the Limits screen.

3. To configure a Limit, double-click on the following fields to set their values:

•   Above and Below Set Point: of Full Scale (the point at which the reading

  goes out of limit: see figure on the next page)

  For example: 

  100% of 120V Full Scale = 120V

  90% of 120V Full Scale = 108V
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•   Above and Below Return Hysteresis (the point at which the limit’s status 

changes from out of limit to within limit: see figure below)

For example: 

Above Set Point = 110% Below Set Point = 90%

(Out of Limit above 132V)(Out of Limit below 108V)

Above Return Hysteresis = 105% Below Return Hysteresis = 95% 

(Stay Out of Limit until below 126V)  (Stay Out of Limit until above 114V)

    NOTES: 

•   The Primary fields are display only. They show what the set point and return 

Hysteresis value are for each limit.

•   If the Above Return Hysteresis is greater than the Above Set Point, the Above 

Limit is Disabled; if the Below Return Hysteresis is less than the Below Set Point, 

the Below Limit is Disabled. You may want to use this feature to disable either 

the Above Limit or Below Limit condition for a reading.

•   If you are entering negative limits, be aware that the negative value affects the 

way the above and below limits function, since negative numbers are processed 

as signed values.

4. To implement any changes, click the Update Device button to send the new pro-

file to the meter.

TIME

Above Limit 
condition

Below Limit 
condition

Above Limit Trigger point

Return point from Above Limit  condition

Below Limit Trigger point

Return point from Below Limit  condition

HYSTERESIS

HYSTERESIS

- MEASURED VALUE
(if applicable)

+ MEASURED VALUE

0
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28.3.2: Configuring Waveform/PQ (With
            V-Switch™ Key 3 and Higher)

The Shark® 250 meter is V-SwitchTM key upgradeable. If you have purchased V-

SwitchTM keys 3 or 4, the waveform recording feature will be available with your 

meter. The Waveform/PQ capability allows the meter to act as a high-speed waveform 

recorder to record any anomaly that occurs within a cycle of duration. This provides a 

user with advanced waveform analysis including pre- and post- waveform recording. 

The meter has the capability to record both surges and sags of the measured signals. 

A voltage surge is any event that increases the RMS voltage for one cycle, calculated 

every half cycle. A voltage sag is a dip in the RMS of one cycle of voltage, calculated 

every half cycle. A current fault (or surge) is also calculated in the same manner. 

When the RMS value of any of these triggers exceeds the threshold settings, the 

meter will trigger a waveform capture.

This setting determines at what point the meter executes a waveform capture and/or 

records a power quality event. See Chapter 19 for instructions on viewing Waveform 

and PQ logs. See 28.4.2: Trending Profiles - Configuring Historical Logs, on page 28-

68 for instructions on configuring the log sectors for the Shark® 250 meter.

NOTE: PQ and Waveform Thresholds are given as a percentage of the Full Scales ( 

Full Scale fields). Full Scales are based on the CT and PT Ratios set in the CT, PT 

Ratios and System Hookup setting. Before programming the Waveform/PQ Thresh-

olds, set the CT and PT ratios. See 28.1.1: Configuring CT, PT Ratios and System 

Hookup, on page 28-2, for instructions. 
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1. From the Tree Menu, click Power Quality and Alarm Settings>Waveform/PQ. The 

current settings, if any, are shown in the screen.

2. Set the Surge and Sag Setpoints (in percent of Full Scale), for Voltage, and the 

Surge Setpoint for Current. When you enter the percentage for a reading, the 

primary value is displayed in the Primary field. The bottom of the screen displays 

the Full Scales for Voltage and Current.

3. Click the checkbox under PQ to enable PQ recording when the programmed 

threshold is exceeded.

4. Click the checkbox under Waveform to enable Waveform recording when the 

programmed threshold is exceeded.
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5. Select the sampling rate from the Capture Sample Rate pull-down menu. The 

options are: 

•  For V-Switch™ key 3: 32, 64, 128

•  For V-Switch™ key 6: 32, 64, 128, 256, 512.

6. From the Pre-trigger pull-down menu, select the number of cycles of waveform 

data prior to the triggering event, that you want to be included in the waveform 

capture. The options are 2 to 63.

NOTE: Increasing the number of pre-cycles will decrease the number of cycles 

of data recorded after the event.

7. To implement any changes, click the Update Device button to send the new 

profile to the meter.
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28.4: Logs

From the Tree Menu on the left side of the Shark® 250 meter’s Device Profile screen, 

double-click on the Logs line or click on the + button next to it. All of the settings in 

the Logs group are listed: log size settings and configuration screens for the meter’s 

six historical logs..

28.4.1: Configure Log Sizes

This setting allows a user to allocate the amount of memory available for each log, 

based on the number of recording days desired. Once the log’s memory fills, the log 

“rolls over” and the records are overwritten in a FIFO (first in, first out) sequence. 

Depending on the meter’s V-SwitchTM key, the user is able to memory allocation for up 

to 6 historical logs and the waveform and PQ logs, to optimize the number of records 

stored for each log. 

•  For V-Switch™ keys 2 and higher, use this setting to increase or decrease the 

amount of records that each of the Shark® 250 meter's three Historical logs can 

store. 
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• For V-Switch™ keys 3 and 4, use this setting to set the allocation for the Wave-

form(V3 and V4) and Power Quality (V4 only) logs, as well as for 6 Historical logs.

1. From the Tree Menu, click Logs>Configure Log Sizes. You will see the screen shown

on the previous page. Note that the example screen is for a meter with V4 - the

screen you see will look a bit different if your meter has a lower V-SwitchTM key.

2. For each log, set both the logging interval and size. (Note that for the Waveform

and PQ logs, you only set the size.) For the historical logs, the Duration field tells

how many months and days of logging your setting will provide; for the Wave-

form log, it tells how many waveform captures it will provide; and for the Power

Quality log, it tells how many PQ events, i.e., surges and sags, will be recorded.

a. Select the logging interval from the pull-down menu. The interval is in

minutes. You can set between 1 and 60 minutes, or EOI pulse, for the

historical logs.

b. Set the log size (the amount of memory allocated to it), by moving the bar

in the size field to the right to increase the amount of memory, and to the

left to decrease the amount of memory.

NOTES: 

• The maximum allowable size for the historical logs is 6 MB, and for the Waveform 

log, is 8 MB. The V-SwitchTM key level may limit this maximum number, e.g., a 

meter with V2 has 2 MB memory in total to assign to the available logs.

Decrease       Increase
Memory         Memory
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•  When EOI Pulse is set as the Logging Interval for a Historical log (see 28.4.2: 

Trending Profiles - Configuring Historical Logs, on page 28-68), the Interval field 

will display EOI Pulse, and the duration field will say “0 Hours.”

3. To implement any changes, click the Update Device icon to send the new profile 

to the meter.

28.4.2: Trending Profiles - Configuring Historical
              Logs

From the Tree Menu on the left side of the Shark® 250 meter’s Device Profile screen, 

double-click on the Trending Profiles Settings line or click on the + button next to it. 

All of the settings in the Trending Profiles Settings group are listed.

Use this setting to select the parameters to be stored in each of the Shark® 250 

meter's Historical Logs. For additional information on logs, including using the HHF 

Converter, see chapters 16 and 19.

Functional Overview of Historical Logs:

The Shark® 250 meter allows a user to set up 3 (for V2) or 6 (V3 and higher) sepa-

rate historical profile logs that can log up to 64 parameters. Each of these logs can log 
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at different time frames. For example, one log can be set for one minute intervals to 

record voltage; while another log can be set for 15 minute intervals for energy con-

sumption logging.

Having multiple historical logs additionally affords you the flexibility of programming 

each log with unique parameters. For example, you might program Historical Log 1 to 

record Power Quality parameters (for example, THD), Log 2 to record Demand param-

eters, and Log 3 to record Energy parameters. 

Historical Log parameters can be selected from seven groups:

•  Measured Values (choose parameters from readings, uncompensated readings, or 

phase angles sub groups).

•  Energy (choose parameters from scaled energy, scaled energy in the interval, 

scaled energy in the interval (pulses), uncompensated energy, uncompensated 

energy in the interval, uncompensated energy in the interval (pulses), sexondary 

energy, secondary energy in the interval, or secondary uncompensated energy sub 

groups).

•  Max/Min Demand (choose parameters from maximums, minimums, voltage maxi-

mums in the interval, voltage minimums in the interval, or value prior to demand 

reset sub groups).

•  Average Demand (choose parameters from demand, cumulative demand or time-

stamp sub groups).

•  Harmonics/THD (choose parameters from THD, magnitudes, or angles sub groups).

•  Meter Status.

•  Aggregators. 
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1. From the Tree Menu, click Trending Profiles>Historical Log Profile (1-3). 

This screen allows you to select items to be stored in the historical log you selected. 

The Group field determines the items that are available for selection.

2. Select a Group. The possible selections are: Measured Values, Energy, MAx.Min 

Demand, Average Demand, Harmonics/THD, Meter Status, and Aggregators. 

(See 28.5.2: Configuring a Relay Output/Digital Input Card, on page 28-75 and 

28.5.3: Configuring a Pulse Output/Digital Input Card, on page 28-81, for infor-

mation on setting up Aggregators). 

3. Select items for your log:

a. Highlight the item(s) you want in the Selectable Items box.

b. Click Add. The item(s) are added to the Selected Items box.

c. To remove item(s), highlight them in the Selected Items box and click 

Remove.
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4. Set the Logging Interval (Minutes). The available choices are: 1, 3, 5, 10, 15, 

30, 60, EOI (End of Interval) Pulse. The Logging Interval determines when the 

meter takes a snapshot.

IMPORTANT! If you are trending Energy in the Interval, the Logging interval 

must be the same as the Demand interval.

    NOTES: 

•   Only one of the following can be set for the EOI pulse feature: 

• EITHER 1 Option card input can be set to receive an EOI pulse from 

another device

• OR 1 Option card output can be set to trigger an EOI pulse

•   The maximum rate for EOI Pulse used to trigger a log is once per minute.

•   When you choose EOI Pulse, the meter takes a snapshot when the pulse is 

either received or generated (depending on whether the EOI pulse is assigned to 

an input or output), rather than on a time interval. 

NOTE: There are two display fields at the bottom of the Historical Log Profile screen. 

They show the Total Bytes Used and the Bytes Remaining for this historical log. These 

fields are updated as you make selections on the screen. The total number of bytes 

available per log record is approximately 228.

5. To implement any changes, click the Update Device button to send the new 

profile to the meter.
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28.5: Configuring Option Cards 

The Shark® 250 meter automatically detects the presence of any Option cards 

installed in it. You will see the installed card(s) listed in the Tree Menu (see the figure 

on the next page). Up to two Option cards can be installed in the Shark® 250 meter. 

Refer to the meter’s Installation and Operation Manual for additional information con-

cerning Option cards, including installation procedures. 

You must configure an Option card before using it. The following sections give   

instructions for configuring each of the Option cards. 

NOTE: You can configure settings for an Option card when you are not connected to a 

meter. Click Option Card 1 or 2 from the Shark® 250 meter's Device Profile screen. 

The drop-down menu on the displayed screen allows you to select your Option card. 

The available selections are: Fiber Optic, Network, Digital Relay, Pulse Output, Analog 

Output (0-1mA), Analog Output (4-20mA), None. Click Apply. The Option card you 

chose is now listed in the menu. Refer to the instructions for configuring the card.

From the Tree Menu on the left side of the Shark 250 meter’s Device Profile screen, 

double-click on the Option Card 1 or Option Card 2 line or click on the + button next 

to it. The settings for the option card(s) installed in your meter are shown.
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Option Card Screens:

The type of Option card installed in the meter determines the settings you need to 

configure, and so, the screens you see. Click on the selectable lines under your Option 

card in the Shark® meter's Device Profile menu. See the example below. 

NOTE: The Option card settings for your meter will only show the option cards 

currently installed in your meter.

Type of 
Option 
card

       
Card       
Setting 
screens
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28.5.1: Configuring a Fiber Optic Card

The Fiber Optic Option Card is a Communication card that provides a standard, serial 

communication port over a fiber optic application. For technical specifications and 

hardware installation, refer to the meter’s Installation and Operation Manual.

Example:

An example use of the optional Fiber Optic card is in a daisy chain topology, using the 

Echo switch on the Fiber Optic Card to allow messages to bypass the unit.

1. Click Option Card 1/2 - Fiber Optic>Fiber Optic.

2. The screen fields and acceptable entries are as follows:

•   Address: 1 - 247 (Modbus); 1-65520 (DNP)

•   Protocol: Modbus RTU; Modbus ASCII; DNP subset 2; DNP subset 3

•   Baud Rate: 9600; 19200; 38400; 57600

•   Data Bits: 5; 6; 7; 8
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•   Parity: None, Odd, Even

•   Stop Bits: 1 or 2

•   Response Delay (msec): the suggested delay is 50 msec, but you can increase 

the delay, if necessary.

3. To implement any changes, click the Update Device button to send the new 

profile to the meter.

28.5.2: Configuring a Relay Output/Digital Input Card

The Relay Output/Digital Input card is used for a few purposes. The relay portion is 

used to send a control output when a limit is exceeded. The input portion can be used 

to either count KYZ pulse or detect the status of a circuit.

The Relay Output/Digital Input Option Card has:

•  Two relay contact outputs for load switching 

•  Two wet/dry contact sensing digital inputs. 

Accumulators in the CommunicatorPQA® software count the transitions of the Inputs 

and Outputs. For technical specifications and hardware installation, refer to the 

meter’s Installation and Operation Manual.

NOTE: When installing a Relay Output/Digital Input card, we recommend you reset 

the accumulators for the card, in order to prevent erroneous counts. See 20.1.7: 

Reset Device Information, on page 20-7, for instructions on using the Reset Shark® 

Information screen to reset card accumulators.



     Doc#    E107707                                            28-76

28: Shark® 250 Meter

Example:

An example use of the optional Relay Card is in monitoring the status of circuit break-

ers or relays in your electrical system. The two status inputs could be used to monitor 

two circuit breakers, and the two relay outputs could be used to sound an alarm upon 

the occurrence of a programmed out of limit condition.

1. Click Option Card 1/2 - Digital Relay>Relays to set the limits/alarm conditions and 

logging options for the card's Relay Outputs. 

2. From the Relay Assignment screen, you can:

•  Configure up to 8 output conditions for each of the two Relay Outputs. Note that 

the Limits used are configured in Power Quality and Alarm Settings>Limits (see 

28.3.1: Configuring Limits, on page 28-60).

•  Set a Delay and Reset Delay for the Outputs.

•  Choose to log Status Changes for each Relay Output.
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•  Assign each Output an Output Label, Open Label, and Closed Label, which are 

used when viewing the Relay Status Log.

•  Assign an Accumulation Compression Factor for each output. 

IMPORTANT! First use the Limits screen to set up the limits you want to assign to an 

Output. See 28.3.1: Configuring Limits, on page 28-60 for instructions.

3. The available Limits appear in the Limit ID column. To assign a limit to an Output 

relay:

a. Select the output condition from the pull-down menu next to the Limit ID. 

The options are: Above Limit (the Output is triggered when the Above Limit 

condition occurs) and Below Limit (the Output is triggered when the Below 

Limit condition occurs). 

b. You can assign the limit to one or both (or neither) of the Relay Outputs.

NOTE: A Relay operates when any one assigned Limit is tripped, and stays 

in the Set condition as long as one Limit is in the Alarm state.

4. You can enter Set Delay and/or Reset Delay. These values are the delay before 

the Output is changed: Set is when the common is shorted to Normal Open (this 

is the Set Condition), Reset is when the Output is shorted (closed).

5. Check the box next to Log Status Change for if you want to log output status 

changes for either or both Relay. See Chapter 19 for information on the I/O 

Change Log.

6. The current Output Labels are displayed in the screen. These labels are used for 

Logging. To change the Output labels, click in the Labels field you want to 

change, and enter a new label. The fields that can be changed are:

•  Output Label - Label ID

•  Open Label - Open state ID

•  Closed Label - Closed state ID
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7. You can specify an Accumulation Compression Factor. The Compression Factor is 

used to adjust how high an accumulator will go before rolling over. Because of 

this, it is useful in delaying rollover. For example, if you select a Compression 

Factor of 10, each time 10 Pulse/State changes occur, the accumulator count 

increments by 1. The available Compression Factors are: 1, 10, 100, 1000, 

10000, and 100000. The default Compression Factor is 1.

8. To configure the Digital Inputs: 

a. Click Option Card 1/2 - Digital Relay>Inputs. Use this screen to assign 

labels and functions to the Inputs. 

b. Make a selection in the Assigned to field. The available selections are: 

• Status Only - select this to use the digital inputs just to indicate if the 

state is open or closed.

• Accumulator - select this to use the digital input as a pulse counter.
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• Digital Input Log - select this to use the digital input to trigger an entry in 

the I/O change log.

• EOI Pulse - only one Input can be set to receive an EOI pulse.

NOTES on End of Interval (EOI): 

• EOI is triggered in a device when the programmed condition is met. 

Only one Option Card input can be set to receive an EOI pulse. EOI is 

used for the following:

• As a trigger for demand averaging: the received EOI pulse delin-

eates an interval that results in demand averaging being performed. 

The minimum interval between received EOI Pulses used to trigger 

demand averaging should be 5 minutes. An EOI pulse allows the 

meter to be synchronized with an installed revenue meter, so that 

both meters are calculating Demand at the same time. When an 

Input is assigned to EOI, the demand interval is now the time 

between two received pulses.

• For historical logging: when the EOI pulse is received, it causes any 

log that has been configured for EOI Pulse interval to capture a record. 

Refer to 28.4.2: Trending Profiles - Configuring Historical Logs, on 

page 28-68, for additional information on EOI Pulse and logging.

IMPORTANT! The EOI setting will affect Time of Use, if it is active for 

the meter. Instead of using the demand interval for TOU accumula-

tions, TOU will perform automatic data usage accumulation and calen-

dar actions (rate change, day type change, season/billing month self 

reads) based on the EOI input trigger. This can result in shorter or 

longer interval periods, depending on the EOI input timing, so the rate/

day type/calendar actions may differ from what is expected.

c. Select Trigger from the pull-down menu. The Trigger you select depends on 

your Assigned to selection:

•  For Status Only, select None.
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•  For Accumulator, select from Closing, Opening, High Speed Closing or 

High Speed Opening. 

NOTE: Only one accumulator can be assigned to a High Speed Trigger.

•  For Digital Input Log, select Change.

•  For EOI Pulse, select from Closing, Opening, or Change.

d. Enter Units/Count. The Units/Count is the output ratio from the device that 

is being input into the Shark® 250 meter. For example, if you have a KYZ 

module that is outputting a pulse every 1.8 kWh, with the input set to 

Accumulator, Increment on Contact Opening, you would set the Units/

Count to be the value of the KYZ; in this case either 1.8 or a ratio of that 

number.

e. Enter Compression. The Compression Factor is used to adjust how high an 

accumulator will go before rolling over. For example, if you select a Com-

pression Factor of 10, each time 10 Pulse/State changes occur, the accu-

mulator count increments by 1. The available Compression Factors are: 1, 

10, 100, 1000, 10000, 100000, and 1000000. The default Compression 

Factor is 1.

f. Enter a Label for the Accumulator.

g. The current Input Labels are displayed in the screen. To change the Input 

Labels, click in the Labels field you want to change, and enter a new label. 

The fields that can be changed are:

•  Input Label - Input ID

•  Open Label - Open state ID

•  Closed Label - Closed state ID

9. To implement any changes to the Relay Output/Digital Input card settings, click 

the Update Device button to send the new profile to the meter.
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28.5.3: Configuring a Pulse Output/Digital Input Card

The Pulse Output/Digital Input card is similar to the Relay Output/Digital Input card 

except that the card contains 4 pulse output contacts (Form A, closing) instead of 

relay control outputs. These solid state output contacts can be configured to have the 

meter pulse out for user-assigned energy values. The Pulse Output/Digital Input 

Option Card has:

•  Four Pulse Outputs via solid state contacts

•  Four wet/dry contact sensing digital inputs.

Accumulators in the CommunicatorPQA® software count the pulses of Inputs and 

Outputs. For technical specifications and hardware installation, refer to the meter’s 

Installation and Operation Manual.

NOTE: When installing a Pulse Output/Digital Input card, we recommend you reset 

the accumulators for the card, in order to prevent erroneous counts. See 20.1.7: 

Reset Device Information, on page 20-7, for instructions on using the Reset Shark 

Information screen to reset card accumulators.

Example:

An example use of the Pulse Output/Digital Input Card is in a sub-metering applica-

tion where a pulse output is needed. The Input Accumulator allows you to count the 

pulses from another device, for example, a KYZ module or another meter. The Output 

Accumulators allow you to count the pulses being output by the card.

The Pulse Output and Digital Input Card has two screens for configuration: the Pulse 

Output Settings screen and the Digital Input Settings screen. 
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1. To set the pulse outputs, click Pulse Factors>Option Card 1/2 - Pulse Outputs. 

2. You can set up to four Output IDs for your Card. Each Output has a Label, an 

Assigned Channel, and a Unit/Count. Double-click an Assigned Channel field to 

add or edit an the assigned channel. You will see the window shown below.
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3. Select the Energy channel to use for the output. Click OK. The energy channel 

you selected displays in the Assigned Channel field.

4. When you select the Assigned Channel, a value is entered for it in the Units/

Count field. You can edit this field by double-clicking in it. The Units/Count is 

determined by the Secondary (the readings in the meter). For example, if you 

have a three-phase meter with 600 Watts per element, for a total of 1800 Watts, 

the Units/Count field will be 1.8. That means that every 1.8 Watt-hours, the 

count will accumulate by 1, and each count will represent 1.8 Watt-hours. If you 

are using CTs that have a ratio of 1000 to 1, for example, the count will still 

increment every 1.8 Watt-hours, but the count in that case will represent 1.8 

Watt-hours times 1000, or 1800 Watt-hours.

IMPORTANT! The values are based on one toggle instance, when the output changes 

from open to closed or from closed to open state.

5. The current Output Labels are displayed on the screen. To change the Output 

labels, click in the Labels field you want to change, and enter a new label. 
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6. Click Option Card 1/2 - Pulse Output>Inputs. Use this screen to assign labels 

and functions to the Inputs. 

7.  Make a selection in the Assigned to field. The available selections are: 

•   Status Only - select this to use the digital inputs just to indicate if the state is 

open or closed.

•   Accumulator - select this to use the digital input as a pulse counter.

•   Digital Input Log - select this to use the digital input to trigger an entry in the 

I/O change log.

•  EOI Pulse - only one Input can be set to receive an EOI pulse.

NOTES on End of Interval (EOI): 

• EOI is triggered in a device when the programmed condition is met. Only 

one Option Card input can be set to receive an EOI pulse. EOI is used for 

the following:
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• As a trigger for demand averaging: the received EOI pulse delineates 

an interval that results in demand averaging being performed. The 

minimum interval between received EOI Pulses used to trigger demand 

averaging should be 5 minutes. An EOI pulse allows the meter to be 

synchronized with an installed revenue meter, so that both meters are 

calculating Demand at the same time.

• For historical logging: when the EOI pulse is received, it causes any 

log that has been configured for EOI Pulse interval to capture a record. 

Refer to 28.4.2: Trending Profiles - Configuring Historical Logs, on 

page 28-68, for additional information on EOI Pulse and logging.

IMPORTANT! The EOI setting will affect Time of Use, if it is active for 

the meter. Instead of using the demand interval for TOU accumula-

tions, TOU will perform automatic data usage accumulation and calen-

dar actions (rate change, day type change, season/billing month self 

reads) based on the EOI input trigger. This can result in shorter or 

longer interval periods, depending on the EOI input timing, so the rate/

day type/calendar actions may differ from what is expected.

8. Select Trigger from the pull-down menu. The Trigger you select depends on your 

Assigned to selection:

•   For Status Only, select None.

•   For Accumulator, select from Closing, Opening, High Speed Closing or High 

Speed Opening.

NOTES: 

• Only one accumulator can be assigned to a High Speed Trigger.

• High speed opening and closing would be used when monitoring pulses 

from water meters that can be pulsing very quickly. 

•  For Digital Input Log, select Change.

•  For EOI Pulse, select from Closing, Opening, or Change.

9. Enter Units/Count. The Units/Count is the output ratio from the device that is

being input into the Shark® 250 meter. For example, if you have a KYZ 



     Doc#    E107707                                            28-86

28: Shark® 250 Meter

module that is outputting a pulse every 1.8 kWh, with the input set to Accumu-

lator, Increment on Contact Opening, you would set the Units/Count to be the 

value of the KYZ; in this case either 1.8 or a ratio of that number.

10. Enter Compression. The Compression Factor is a divider used to adjust how 

high an accumulator will go before rolling over. For example, if you select a 

Compression Factor of 10, each time 10 Pulse/State changes occur, 

the accumulator count increments by 1. The available Compression Factors are: 

1, 10, 100, 1000, 10000, 100000, and 1000000. The default Compression 

Factor is 1.

11. Enter a Label for the Accumulator.

12. The current Input Labels are displayed in the screen. To change the Input 

Labels, click in the Labels field you want to change, and enter a new label. The 

fields that can be changed are:

•  Input Label - Input ID

•  Open Label - Open state ID

•  Closed Label - Closed state ID

13. To implement any changes to the Pulse Output/Digital Input card settings, click

  the Update Device button to send the new profile to the meter.
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28.5.4: Configuring a 0-1 mA Output Card

The 0-1mA Output Option Card is an analog output card, which transmits a standard, 

bidirectional 0-1 milliamp signal proportional to the value selected. This card mimics 

an analog transducer. With the Shark® design, the user can select any measured 

parameter to output on an analog transducer signal. For technical specifications and 

hardware installation, refer to the meter’s Installation and Operation Manual.

Example:

An example use of the optional 0-1mA Output Card is in enabling the Shark® 250 

meter to communicate with an RTU. 

1. Click Option Card 1/2 - 0-1 mA Output>Settings.    

    You can set up to four Output IDs for your Output Card. 
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2. Double-click an Assigned Channel field to add or edit an Output ID. You will see 

the window shown below.

3. Select Group for your Output Channel. The available selections are as follows:

•  Measured Values

•  Max/Min Demand

•  Average Demand

•  Harmonics/THD

4. Select the Sub Group for your Output Channel. The sub group values are depen-

dent on the group selection.

5. Select Item for your Output Channel. The items are the available readings for 

the group and subgroup you selected. For example, as shown in the window 

above, Volts A-N is an item you can select when you have selected Readings as 

the group, and Primary Readings as the sub group.

6. Click OK. The Output Channel you selected is displayed in the Assigned Channel 

field. 

7. Enter Low End and High End for the channel. 

NOTE: For the Item selected for the Assigned Channel, the Output Card takes 

the value in the meter and outputs a DC current within its range. The Low End is 

the lowest value, and the High End is the highest value. For example, for VOLTS 

A-N and Bidirectional Mode, at Nominal of 120V, the Low End is set to 115V and 

the High End is set to 125V. The Analog Output Card will output -1 mA when the 

reading is 115V, 0 mA when the reading is 120V, and 1 mA when the reading is 

125V. The analog card can output below -1mA and above +1mA, proportionally 
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to VOLTS A-N. For limiting values refer to the meter’s Installation and Operation 

Manual's applicable section.

8. You can select either Unidirectional or Bidirectional for Mode. Unidirectional 

mode is used for unsigned data, e.g., voltage; and bi-directional mode is used 

with signed data, e.g., Watts.

9. To implement any changes to the 0-1mA Output card settings, click the Update 

Device button to send the new profile to the meter.

28.5.5: Configuring a 4-20 mA Output Card 

The 4-20mA Output Option Card is an analog communication card, which transmits a 

standard, unidirectional 4-20 milliamp signal. For technical specifications and hard-

ware installation, refer to the meter’s Installation and Operation Manual.

Example:

An example use of the optional 4-20mA Output Card is in enabling the Shark® 250 

meter to communicate with an RTU. 

1. Click Option Card 1/2 - 4-20 mA Output>Settings. 
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2. Follow the instructions for configuring the 0-1 mA Card. The configuration of a 4-

20 mA Card is the same as a 0-1 mA Card, except that this card can only be uni-

directional, so there is no Mode setting.



     Doc#    E107707                                            28-91

28: Shark® 250 Meter

28.5.6: Configuring a Network Card 

The optional Network Card enables 10/100BaseT Ethernet communications. It also 

acts as a Web server, allowing the meter’s data to be viewed on a standard web 

browser. For technical specifications, hardware installation, and additional information 

on the Web server, refer to the meter’s Installation and Operation Manual.

Note that there are two versions of the INP100S card  

- a legacy version and the Gen 2 version. The Option 

Card screen will indicate which card is installed in 

your meter. See the example on the right.

Gen 2 of the INP100S card has additional features not supported by the legacy card.

•  One major feature is support for both IPv4 and IPv6. IPv6 offers many more IP 

addresses, avoiding the possibility of “running out” of IP addresses for IPv4. IPv6 

does not need to use the network-address translation necessary in IPv4, though its 

larger packet size means that the processing speed of IPv4 and IPv6 is very similar. 

Since IPv6 is used by about a third of the Internet currently, it is a good idea to 

enable both IPv4 and IPV6 for your card.

•  Gen 2 of the INP100S card offers enhanced security, including digital firmware 

signature that authenticates the network card firmware before an update is per-

formed, SSL/TLS (secure socket layer/transport layer security) encryption, support 

for encrypted (SMTPS) and unencrypted (SMTP) alarm and notification emails, and 

access to the Gen 2 INP100S card’s Web server using either HTTP or HTTPS proto-

cols.

See Chapter 7 in the Shark® 250 Meter User Manual for additional features and 

details on the Gen 2 INP100S card. This section of the manual will give instructions 

for both the legacy and Gen 2 INP100S card.

Legacy
INP100S

Gen 2 INP100S
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1. Click Option Card 1/2 - Network Card>IP Address and DNS. You will see the screen 

shown below. It allows you to configure the IP Address, DNS, and Network Time 

Protocol Server for the card.

•  You will see the screen shown below for the legacy INP100S.
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•  You will see the screen below if you are connected to the Gen 2 INP100S.

Note that for Gen 2, the INP100S has both IPv4 and IPv6 settings. You can use 

the screen to make both IPv4 and IPv6 settings that will be used by the card.

a. In the IP Address section, enter the following information for both the 

legacy and Gen 2 IPv4:

• Host Name: To enable a DHCP server to assign the IP address for your 

network card, click the DHCP box and enter the host name. 

• If you are not using a DHCP server, enter the following for the network 

card:

• IP Address.

• Subnet Mask.

• Default Gateway.

NOTE: If no mask is entered (blank) or 0.0.0.0 is used, the network 
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card will use an automatic mask based on the network address class, 
or will not apply a mask, according to the following table:                 

•For the Gen 2 INP100S card, the Keep Alive setting specifies the 

number of seconds the meter will wait before sending a “keep alive” 

message if there is no communication. After the specified amount of 

time, the meter sends the keep alive message to the TCP socket to see 

if the connection is still up and running. If the connection has been lost, 

the TCP socket can then be freed for another connection.

b. In the IPv6 IP Address tab, enter the following:

• Mode: select one of the following options - 

• Use Static Address and then enter the address in the IP address field.

• Use Link Local Address.

• Use DHCP. 

• Prefix Length: this field is similar to the subnet mask in IPv4. You can 

enter a number between 1 and 128.

• Default Gateway: enter the address of the default gateway or leave the 

default of all zeros.

c. Domain Name Server Address(es) (for Gen 2, you can set up to two servers 

for IPv4 and IPv6, each).

NOTES: 

• If you don’t enter a DNS address, the field defaults to 0.0.0.0. In this 

case, you need to enter an IP address (e.g., 163.27.987.53) for the NTP 

server (if enabled) and email features. If you do specify a valid DNS 

address, however, you can use a URL address (e.g., pool.ntp-micro-

soft.org) for the NTP and email features.

Network Class Address range Mask used

Class A 1.0.0.0-127.x.x.x 255.0.0.0

Class B 128.0.0.0-191.x.x.x 255.255.0.0

Class C 192.0.0.0-223.x.x.x 255.255.255.0

Other classes No masking will be applied
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• The Network Time Protocol server is used for clock synchronization. It 

can be either a device with a real-time clock that is networked with your 

meter, or an NTP server on the Internet. 

IMPORTANT! You must also enable Clock Synchronization in the Time 

Settings screen (see 28.1.2: Configuring Time Settings, on page 28-5).

2. From the Option Card menu, click Services and Security.This screen allows you to 

disable certain features of the meter’s Ethernet connection, for security purposes. 

•  You will see the screen below if you have the legacy INP100S card.



     Doc#    E107707                                            28-96

28: Shark® 250 Meter

•  If you have a Gen 2 INP100S card, you will see the screen below. Again, you 

make settings for both IPv4 and IPv6.

a. In the Services tab, make these settings:

• The HTTP Web Server can be disabled, or its default port can be changed. 

• The Modbus TCP server can be disabled, or its default port can be 

changed. 

• If the port entered is less than “10,” the standard port is used: 80 for 

Web Server and 502 for Modbus TCP Server. 
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• To disable one of the servers, uncheck the box next to it.

• Check the Enable Email Alarm/Notification box to use the alarm email 

and periodic notification feature of the Network card. Note that the Net-

work card’s firmware must support alarm and notification email for this 

feature to be available. The settings for the alarm/notification email fea-

ture are made using the card’s Web server. See the Shark® 250 Meter 

User Manual for instructions. There is one setting for both IPv4 and IPv6.

• If you have selected NTP as the time synchronization source for the 

meter (see 28.1.2: Configuring Time Settings, on page 28-5), you will 

see the settings below.

• Enable the NTP client for either IPv4 or IPv6.

• Enter the NTP Server name or IP address of a Network Time Protocol 

server.   

NOTES: 

• The Network Time Protocol server is used for clock synchronization. It 

can be either a device with a real-time clock that is networked with 

your meter, or an NTP server on the Internet. 

• NTP is supported in Query-Reply method, only.

• NTP can only be enabled for one INP100S card.

b. For the legacy INP100S card:

• When the Security feature “Silent Mode” is enabled, a TCP/Reset packet 

is not sent when an attempt to connect to an unbound port is made. 

When “Silent Mode” is disabled, the meter follows standard TCP/IP proce-

dures for incoming connections to unused ports. This feature is useful in 

preventing hacking (attempted security intrusions).

• Network Firmware version 3.43 and higher and CommunicatorPQA® soft-

ware version 4.0.249 and above support the Exclusive Client feature. This 

feature lets you allow an IP and/or MAC address. When that address is 
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used to connect to the meter, all other network communication with the 

meter, though the same Network card, is suspended. This ensures that 

anything being done, e.g., updating programmable settings, while the 

allowed address is being used to communicate with the meter, is secure. 

• Click the checkbox and enter the IP address or MAC address you want to 

establish as the Exclusive Client.

NOTE: To disable the exclusive Client feature, uncheck the checkbox - 

the IP and MAC addresses will be set to all zeros.

c. For the Gen 2 INP100S card, the Security section has these settings:

• IPv4 and IPv6 tabs let you set up firewall security:

i. Check the box to Enable IP(v4/v6) Address filtering. (Leave the box 

unchecked if you don’t want to set firewall security).

ii. The Blocked Range Start and End IP Address fields are used to block a 

range of both IPv4 and IPv6 addresses. 

iii. Use the Allowed IP Address to enter an IP address within the blocked IP 

address range that you give access to.

• There is also a MAC address tab, with an Enable checkbox and up to three 

Allowed MAC address fields.

• Check the box to enable Silent Mode for both IPv4 and IPv6. When Silent 

Mode is enabled, a TCP/Reset packet is not sent when an attempt to 

connect to an unbound port is made. When Silent Mode is disabled, the 

meter follows standard TCP/IP procedures for incoming connections to 

unused ports. This feature is useful in preventing hacking (attempted 

security intrusions).
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NOTES: 

•  Contact your System Administrator for proper configuration.

•  See Chapter 25: Firmware Updating, on page 25-1, for instructions on updating 

the legacy Network card's firmware. The Gen 2 INP100S card’s firmware is 

updated via its webpage - see the Shark® 270 Meter User Manual for instruc-

tions.

3. From the Option Card menu, click DNP Support if you want to set up DNP over 

Ethernet for the Network Card. This screen lets you set up a DNP Server gateway 

for the Network Option card. This gateway enables DNP3 protocol communication 

over Ethernet, for the meter.

•  You will see the screen shown below if you have the legacy INP100S.
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•  You will see the screen shown below if you have the Gen 2 INP100S card. 

4. For both legacy and Gen 2 INP100S card’s make these settings:

a. Enable DNP Support: by default the DNP server support is disabled. Check 

the box to enable it. Once it is enabled, the other parameters can be 

entered.

b. DNP Server Port: this is the TCP/IP port where the meter’s Network card 

unit will be listening for incoming connections via the DNP protocol. Valid 

numbers are from 10 to 65534. We recommend that you set a value over 

1024, because most of the lower numbers are reserved, or are already 

allocated to other popular services. If you set a port number of less than 

10, the network card will set the port to its default, which is 20000.
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c. DNP Device Address: this is the meter’s configured address (allowable 

setting is 1-65519).

d. Single Socket Enforced - check the box if unsolicited messages are 

supported by your DNP network. This setting permits only one socket for 

the Network card, so there is a single path to send the unsolicited 

message. 

e. DNP Remote Address Range: this setting implements Internet security by 

letting you specify a range of IP addresses that are authorized to connect 

to the DNP port. Any requester with an IP address outside of this range will 

be rejected. 

• For the legacy INP100S card, enter the range in the Remote Start 

Address and Remote End Address fields. To disable the IP range restric-

tion, write 0.0.0.0 in the start field and 255.255.255.255 in the end field. 

An example of a range is 172.20.167.100 in the Remote Start Address 

field and 172.20.167.150 in the Remote End Address field. That would 

authorize connection to the DNP port for any IP address from 

172.20.167.100 up to and including 172.20.167.150.

• For the Gen 2 INP100S card, for IPv4 and IPv6, enter:

•The Allow List Start and End IP Addresses if you want to set up a range 

of allowed IP addresses.

• For the Gen 2 INP100S card, use the Allow List TCP/IP Start and End 

Ports to set an allowable range of communication ports. Communication 

using any ports outside of the Allowed range will be rejected. This setting 

is used by both IPv4 and IPv6. Valid port numbers are from 0 to 65535. 

Set the start port to 0 and the end port to 65535 to disable the port range 

restriction. 

          NOTE: The DNP3 Allow List settings will not be available if IPv4, IPv6, or MAC

          allow lists have already been configured for the Gen 2 INP100S card.

5. To implement any changes to the Network card settings, click the Update Device 

icon to send the new profile to the meter.
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28.5.7: Configuring an IEC 61850 Card

The IEC 61850 card enables the meter to fit into an IEC 61850 network, which is an 

architecture used in substation automation. The settings for this card are the same as 

for the Network card, except that there is no DNP setting, since the IEC 61850 card 

uses its own protocol for communication.

1. Click Option Card 1/2 - IEC 61850>IP Address and DNS to set up the adress infor-

mation for the IEC 61850 card, or Option Card 1/2 - IEC 61850>Services and 

Security to enable/disable the servers and other features. 

2. See the instructions in 28.5.6: Configuring a Network Card, on page 28-91, for 

instructions on setting up the IP Address and DNS configuration. For the Ser-

vices and Security tab, click Option Card 1/2 - IEC 61850>Services and Security.
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3.This screen allows you to disable certain features of the meter’s Ethernet connec-

tion, for security purposes: 

•   The HTTP Web Server can be disabled, or its default port can be changed. 

•   The Modbus TCP server can be shut down, or its default port can be changed. 

• If the port entered is less than “10,” the standard port is used: 80 for 

Web Server and 502 for Modbus TCP Server. 

• To disable one of the servers, uncheck the box next to it.

•   To use the card for IEC 61850 communication, check the Enable IEC 61850 

Server box. For INP300S Option cards with Network card firmware version 3.46 

or greater, there is another option box under Enable IEC 61850 Server. It lets 

you specify that all energy values are represented ad positive numbers: check 

the box to enable this option. 
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NOTE: To see what your Network card’s firmware version is, open the Device 

Status screen. See 20.1.10: Device Information, on page 20-14.

•   When the Security feature “Silent Mode” is enabled, the meter will totally ignore 

incoming connections, in such a way that not even TCP/IP Reset packets will be 

sent. When “Silent Mode” is disabled, the meter follows standard TCP/IP proce-

dures for incoming connections to unused ports. This feature is useful in pre-

venting hacking (attempted security intrusions).

•   The Exclusive Client feature lets you Whitelist an IP and/or MAC address. When 

that address is used to connect to the meter, all other network communication 

with the meter, though the same Network card, is suspended. This ensures that 

anything being done, e.g., updating programmable settings, while the Whitelist 

address is being used to communicate with the meter, is secure. 

• Click the checkbox and enter the IP address or MAC address you want to 

establish as the Exclusive Client.

NOTE: To disable the exclusive Client feature, uncheck the checkbox - 

the IP and MAC addresses will be set to all zeros.

        NOTE: If you do not know this information, contact your Systems Administrator.
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28.5.8: Configuring an RS232/RS485 Card

The RS232 card lets you add an RS232 serial connection for the meter.

1. Click Option Card 1/2 - RS232.   

2. Use this screen to make the following settings for the card:

•   Address: 1 - 247 (Modbus); 1-65520 (DNP).

•   Protocol: Modbus RTU; Modbus ASCII; DNP3.

•   Baud Rate: 9600; 19200; 38400; 57600.

•.  Parity: None, Odd, Even.

•   Response Delay (msec): the suggested delay is 50 msec, but you can increase 

the delay, if necessary.

3. To implement any changes, click the Update Device button to send the new 

profile to the meter.
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29: EnergyPQA.com® System
The EnergyPQA.com system documentation has been transferred from this chapter 

into two separate manuals.

•  The EnergyPQA.com AI Driven Energy Management System Setup Guide contains 

instructions for the Admin or whomever is setting up the system.

•  The EnergyPQA.com AI Driven Energy Management System User Manual contains 

instructions for using the system once it is set up: viewing dashboards, printing 

reports, etc.

Both manuals can be downloaded from EIG’s website:

https://www.electroind.com/products/energypqa-com-energy-management-system/

Click Downloads>Tech Documents on the webpage to download the manual you need.

https://www.electroind.com/products/energypqa-com-energy-management-system/
https://www.electroind.com/products/energypqa-com-energy-management-system/
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30: ST40 Meter
This chapter explains how to configure an ST40 meter's programmable settings, 

which are stored in the unit's Device Profile. Chapter 7 contains detailed information 

on how to use the Device Profile.

30.1: Device Profile General Settings

1. From the Tree Menu on the left side of the ST40 meter’s Device Profile screen, dou-

ble-click on the General Settings line or click on the + button next to it. All of the 

settings in the General Settings group are listed.

NOTE: If your ST40 meter is the mV option, you will see the screen shown on the 

next page.
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30.1.1: Configuring CT, PT Ratios, and System Hookup

The first screen you see is the CT, PT Ratios and System Hookup screen (to return to 

this screen from another screen, click General Settings>CT, PT Ratios and Hookup). 

Use this setting to configure Current Transformer and Potential Transformer ratios and 

to select the System Hookup. 

NOTE: the screen shown above is for the ST40 mV meter. If your meter is an ST40 

meter (not the mV option), the screen will look like the one on the previous page.

Functional Overview of CT and PT Ratios:

Current and Potential Transformers are used mainly for the following reasons:

•   To insulate, and as a result isolate, the meter from high-voltage circuits.

•   To change the primary voltage and current to standard values and sizes that the 
meter can measure.
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The CT and PT transformers deliver fractions of the primary voltage and current to the 

meter. With properly set ratios and multipliers, the readings of the meter can be used 

to determine the energy, voltage, current, or power of the system. 

IMPORTANT! You have two options for entering the CT and PT settings. You can 

either enter CT/PT Numerator, Denominator, and Multiplier manually (see instructions 

below), or you can enter the Ratios for CT/PT Denominator and click the Update CT/

Update PT buttons to let the software calculate the Numerator, Denominator, and 

Multiplier for you. You can then empty the Ratio fields and click the Update Ratio but-

tons to confirm the calculated settings: you will see the same ratios you initially 

entered.

NOTES: 

•  This option is available for the ST40 mV PT settings, only.

•  Some ratios cannot be represented in the Shark® ST40 meter. The software will try 

to find the closest value, in that case.

1. For manual entry, make these settings:

•   CT Ratios

• CT Numerator (Primary): 1 - 9999

• CT Denominator (Secondary): 1, 5, or 0.333 V

NOTE: This field is display only. The ST40 meter is ordered as a 1 Amp or 

5 Amp Current Secondary; the ST40 mV meter has a 0.333 V Secondary.

• EITHER CT Multiplier (Scaling): 1, 10 or 100 

Multiplies the CT Numerator by this scale. The display can only read 4 

digits, or 9999. Above that range the number must be multiplied to have 

it read K or M values.

• OR Ratio: the ratio to be applied, and click Update CT 

•   PT Ratios

• PT Numerator (Primary): 1 - 9999

• PT Denominator (Secondary): 1 - 9999

• PT Multiplier or PT Ratio: See the insrtuctions for the CT Multiplier and 
Ratio, above.
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•   System Wiring
• 3 Element Wye; 2.5 Element Wye; 2 CT Delta

This value must be set properly for the meter to calculate readings 
correctly.

Example Settings:

For a CT of 2000/5A, set the following CT Ratios in the entry fields:

CT Numerator (Primary)           2000

CT Denominator (Secondary)    5

CT Multiplier                            1

The Current Full Scale field will read 2000. 

For a system that has 14400V primary with a 120V secondary line to neutral (PT Ratio 

of 120:1), set the following PT Ratios in the entry fields:

PT Numerator (Primary)  1440

PT Denominator (Secondary) 120

PT Multiplier    10

The Voltage Full Scale field will read 14.4k.

2. The Full Scales fields are display only.

3. Use the box at the bottom of the screen to enter the minimum voltage threshold, 

which is a percentage of the voltage full scale. This setting adjusts the pick up 

threshold for the voltage. You set a percentage of the PT primary (PT numerator X 

PT multiplier) up to 12.7 in the entry field. This allows a user to configure when the 

meter will start readings values above 0 voltage. The minimum primary voltage 

based on the percentage you entered is displayed at the bottom of the screen.

4. To implement any changes, click the Update Device button to send the new 

profile to the meter.



     Doc#    E107707                                              30- 5

30: ST40 Meter

30.1.2: Configuring Time Settings

Use this setting to enable or disable Daylight Savings Time for the meter, to set the 

beginning and ending times for Daylight Savings Time, and to set up Time Zone infor-

mation and clock synchronization information.

1. From the Tree Menu, click General Settings>Time Settings. 

2. Check the box to Enable Daylight Savings time, or un-check it to Disable Daylight 

Savings Time.

3. Use the entry fields to set the start and end times for the Daylight Savings Time 

feature, if enabled. Select the values you want from the Month, Week, Day of the 

Week, and Hour fields. 

    NOTE: The Hour field uses a 24-Hour clock.

4. To enable clock synchronization, from the Clock Sync pull-down menu, select:
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•  Line (line synchronization) and then select 50Hz or 60Hz from the Line 

Frequency pull-down menu.

Line synchronization uses the frequency zero crossings to provide a time 

reference for the meter. This is the most common method to synchronize 

a meter’s clock. EIG recommends that you always select this method 

unless there is a specific reason not to select it. If the meter is not syn-

chronized to line frequency, it will default to internal crystal. Different 

meters differ in terms of drift, but typically meters with 20 ppm crystals 

will drift 30 seconds per month when set to internal crystal.

•  If you do not want to use Line clock synchronization, click Disabled.

5. To implement any changes, click the Update Device button to send the new 

profile to the meter.
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30.1.3: Configuring System Settings

Use the system settings to set password protection and a meter ID. You can enable or 

disable a Password for Resetting (Reset Max/Min Energy Settings, Energy Accumula-

tors, and the Individual Logs) and Configuration (Device Profile) in the Systems Set-

tings screen. 

Once password protection is enabled for the meter and the Device Profile is updated, 

anyone who attempts to make a change that is under password protection is 

prompted to enter the password. If the correct Password is not entered, the change 

doesn’t take place.

NOTE: If you enable a Password for Resetting, you must also enable it for Configura-

tion.

1. From the Tree Menu, click General Settings>System Settings. 

2. From this screen, you can do the following:
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•   Enable or Disable Password for Resetting and/or Configuration: check the box 

next to Yes or No. Enabling Password protection prevents unauthorized tamper-

ing with devices. 

IMPORTANT! You must set up a password before enabling Password Protection. Click 

the Change button next to Change Password if you have not already set up a 

password. 

•  Change the Password: click the Change button. 

•  Change the Device Designation: input a new designation into this field.

3. When you click the Change button next to Change Password in the Settings screen, 

you will see the Enter the New Password screen.

a. Type in the new password (0 -9999).

b. Retype the password.

c. Click Change. The new password is saved and you see the following mes-

sage window.

NOTES: If Password Protection has already been enabled for configuration and you 

attempt to change the password, you will see the Enter Password screen after you 

click Change. Enter the old password and click OK to proceed with the password 

change.

4. To implement any changes, click the Update Device button to send the new 

profile to the meter.
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30.1.4: Configuring Communication Settings

Use this screen to enter communication settings for the meter's two on-board ports: 

the USB (COM 1) and RS485 Port (COM 2).

IMPORTANT! The settings on this screen are the current settings for communication. 

Any changes you make may affect communication between the Shark® meter and 

your PC. If your meter is has the Ethernet or BACnet option, keep the RS485 settings 

shown below.

1. From the Tree Menu, click General Settings>Communications. 

2. The screen fields and acceptable entries are as follows:

•  COM 1 (USB)

• Response Delay: 0 - 750 (50msec increments)

•  COM 2 (RS-485)

• Address:1 - 247 (Modbus); 1-65520 (DNP)
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• Protocol:Modbus RTU, Modbus ASCII or DNP3

• Baud Rate: 1200, 2400, 4800, 9600, 19200, 38400, 57600 

• Response Delay: 0 - 750 (50 msec increments)
Response Delay is the delay the meter should use before responding to 
queries. If your connecting device requires a delay before receiving infor-
mation, use response delay to program the time to wait before the meter 
starts responding to queries.

• Parity: Odd, Even, or None (For Parity setting your meter must have Run-
time Firmware version 26 or higher.)

•   DNP Options for Voltage, Current, and Power:

These fields allow you to choose Primary or Secondary units for DNP, and to set 

custom scaling if you choose Primary. The Scaling fields appear after you click 

the Primary radio button (see partial screen capture, below).

 

Scaling is used with Primary readings so that you can ensure that your readings 

will not go beyond the DNP range before they reach Full Scale. The valid range 

for DNP Object 30 is -32768 to +32767. If the scaling you enter will cause the 

values to fall outside the DNP range, the values will be shown in bold or red in 

the DNP Value at Full Scale fields.

Click the Optimal Scaling button to have the software choose a divisor for volt-

age, current, and power, that will not result in an over/under-range.

NOTE: You must set the DNP polling software to multiply by the divisor amount 

before showing the final value.

3. To implement any changes, click the Update Device button to send the new profile 

to the meter.

DNP Primary 
Units
Scaling Fields 

Click for Optimal 
Scaling by 
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30.1.5: Setting Display Configuration

Some users may want to lock the meter to a particular faceplate display or series of 

displays. For example, if you would like the meter to act only as a Volt meter, or only 

as an ammeter, the meter can be configured to display only the relevant screen. Use 

this setting to lock the display of the ST40 meter's faceplate to the specific combina-

tion you want. Refer to the meter’s Installation and Operation Manual for additional 

information on the faceplate.

1. From the Tree Menu, click General Settings>Display Configuration.

2. The screen fields and acceptable entries are as follows:

•   Phases Displayed: A; A and B; A, B, and C. This field determines which phases 

display on the faceplate. For example, if you select A and B, only those two 

phases will be displayed on the faceplate.   

•   Auto Scroll Display: Yes or No. This field enables/disables the scrolling of 

selected readings on the faceplate. If enabled, the readings scroll every 5 

seconds.
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•   Enable on Face Plate of Display: Check the boxes of the Readings you want dis-

played on the faceplate of the meter. If you make no selection, Amps are dis-

played by default.

•   Power Direction: View as Load or View as Generator; this controls how energy is 

accumulated in the Shark® meter. View as Load means the energy readings are 

accumulated as Whrs Received, View as Generator means the energy readings 

are accumulated as Whrs Delivered.

•   Flip Power Factor Sign: Check box for Yes; leave unchecked for No.

•   Current (I) Display Autoscale: On to apply scaling to the current display or Off 

(No decimal places).

•   Display Voltage in Secondary: Check box for Yes; leave unchecked for No.
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•  Use IEEE/IEC Power Coordinate System: Check box for Yes; leave unchecked for 

No. Select Yes to use the IEEE/IEC system shown in the charts below. Select No 

if you want to use the legacy system shown in the charts on the next page.
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•   Enable Fixed Scale for Voltage Display: To enter a scaling factor for the Voltage 

display:

a. Check the box next to Enable Fixed Scale for Voltage Display. The screen 

changes - see the figure below.

b. Select the scaling you want to use from the pull-down menu. The options 

are: 0-9999V, 100.0kV-999.9kV, 10.00kV-99.99kV, or 0kV-9.999kV.

3. To implement any changes, click the Update Device button to send the new profile 

to the meter.
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30.2: Revenue and Energy Settings

From the Tree Menu on the left side of the ST40 meter’s Device Profile screen, double-

click on the Revenue and Energy Settings line or click on the + button next to it. The 

settings in the Revenue and Energy Settings group are listed.

30.2.1: Configuring Energy, Power Scaling, and Averaging

From the Tree Menu, click Revenue & Energy Settings> Energy, Power Scaling, and 

Averaging (see the screen above). Use this setting to configure: 

•   The display and storage of Energy registers in the meter

•   The display of Power data in the meter 

•   The method of VA computation

•   The interval over which Average values are computed, as well as the Interval 

Energy 
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Functional Overview of Energy Settings, VA Computation, and Averaging:

•   Energy Scaling

Energy Setting includes:

Digits (the number of digits in the reading)

Decimals (the number of decimal places in the reading)

Energy Scale: the scale of the reading - unit; kilo (number times 1000); Mega 

(number times 1 million)

Energy settings allow you to balance the resolution (or accuracy) of the energy 

stored, with the interval over which energy rollover occurs. For example, the 

maximum resolution for a k scale reading is: 99999.999k.

To calculate the speed at which the energy will rollover, you must know the Power 

Full Scale, which is computed from the CT and PT Full Scale values (see 30.1.1: 

Configuring CT, PT Ratios, and System Hookup, on page 30-2). The formula for cal-

culating Power Full Scale is:

Wye system: CT Full Scale x PT Full Scale x 3 

Delta system: CT Full Scale x PT Full Scale x 3 x 

For example, for a CT Full Scale of 2000, PT Full Scale of 14400, Wye system:

2000 x 14400 x 3=86400000

In this example, the energy will increment at 86400000 Watts per hour, or 24000 

Watts per second.

This value allows you to determine the number of digits, decimal places, and 

energy scale you want to configure for the Energy settings, when you take into 

account the rollover time. 

To determine the number of hours before rollover, use this formula:

[Max Resolution]/[Full Scale] = #Hours, where Max Resolution = maximum digits 

and decimals for the Energy scale in use. 

Using the example from above, with an energy scale of Mega, the formula would 

be:

99999.999 M/86.4 M = 1157.4074 hours or about 48 days until rollover. 

NOTE: To increase the number of days until rollover, you can increase the number 

3
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of digits (to 8), decrease the number of decimal places (to 0), or increase the 

Energy Scale (to M).

•   VA Computation Method:

     There are two optional methods of VA Computation:

      Arithmetic Sum - the formula for this calculation is:

      Vector Sum - the formula for this calculation is: 

       Generally, the superior method for calculating VA is to use the Vectoral method;

       however, both methods are provided. 

•   Demand Averaging 

Demand is the average rate of energy use over time. The Shark® ST40 meter 

supports two types of demand averaging: Block demand and Rolling demand.

Block demand records the average demand for time intervals that you define (

usually 5, 15 or 30 minutes). 

Rolling demand functions like multiple, overlapping Block demands. You define the 

subintervals at which an average of demand is calculated. An example of Rolling 

demand would be a 15-minute Demand block using 5-minute subintervals, thus 

providing a new demand reading every 5 minutes, based on the last 15 minutes.

1. The screen fields and acceptable entries are as follows:

•   Energy Settings

• Digits: 5; 6; 7; 8

• Decimals: 0 - 6

• Scaling: Unit; Kilo (k); Mega (M)

For example: a reading for Digits: 8; Decimals: 3; Scaling: K would be 

formatted: 00123.456 k.

VA VA VA VAT a b c= + +

VA W VART T T= +2 2
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       NOTES: 

• Your selection in the Energy Settings fields determines the precision of 

energy stored for display and polling. Refer to the Functional Overview at 

the beginning of this section for more information.

• If you are changing the energy settings, we recommend you first reset 

the Energy Accumulators, in order to prevent erroneous counts. See 

20.1.7: Reset Device Information, on page 20-7, for instructions on 

resetting the ST40 meter's Energy Accumulators.

•   Power Settings

• Decimals: Select Auto or the number of decimals you want from the 

examples in the pull-down menu; e.g., XXX.X specifies on decimal place.

• Scaling - select Unit, Kilo (k), Mega (M), or Auto. Note that if you select 

Auto, the Decimals field is grayed out and you cannot make any changes 

to it.

• VA Computation Method: Arithmetic Sum or Vector Sum (See explanation 

on the previous page.)

•   Demand Averaging

• Type: Block or Rolling

• Interval (Block demand) or Sub-Interval (Rolling demand): 5; 15; 30; 60

• Number of Subintervals: 1; 2; 3; 4

• Interval Window: This field is display only. It is the product of the values 

entered in the Sub-Interval and Number of Subintervals fields.

        NOTE: You will only see the Number of Subintervals and Interval Window fields

        if you select Rolling demand. 

2. To implement any changes, click the Update Device button to send the new profile 

to the meter.
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30.2.2: Transformer/Line Loss Compensation

Transformer losses are power used by the transformer while working. The more load 

on the transformer, the higher the transformer losses. There are two types of trans-

former losses:

•   No load losses - these are the fixed losses that keep the transformer up and 

running.

•   Load losses - these vary with changes in the load.

When the meter is located on the secondary side of a customer’s transformer, a utility 

will want to add the transformer losses into the energy usage calculation. However, 

this practice is regulated by local jurisdiction and regulations. The meter has the 

capability to add in or subtract out these transformer losses, depending on the user’s 

specific needs.

Line losses are similar to transformer losses, except that they are used to compensate 

for loss incurred on wires, such as transmission lines.

Transformer/Line Loss Compensation allows you to add or subtract transformer and/

or line losses to meter registration.
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1. From the Tree Menu, click Revenue & Energy Settings>Transformer/Line Loss 

Compensation.

2. This screen displays the current values for the meter's Transformer Loss Compen-

sation. The screen fields and acceptable entries are as follows

•   Percent Loss of Watts due to Iron and Copper/Positive Watts and Negative Watts

•   Percent Loss of VARS due to Iron and Copper/Positive and Negative Watts

•   Drop-down menu #1. Choose from: Disabled, Fe Only, Cu Only, Both Fe and Cu.

•   Drop-down menu #2. Choose from: Add to Watts and VAR; Add to Watts and 

Subtract from VAR; Subtract from Watts and Add to VAR; Add to Watts and VAR; 

Subtract from Watts and VAR.

3. Click TLC Calculator to find the values to enter into the Percent Loss fields. The TLC 

Calculator button launches the TLC Calculator that makes the calculations for you 

once you enter the required data.   
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NOTE: Appendix A contains a screen captures of the TLC Calculator with example 

numbers, and an explanation of Loss Compensation considerations.

4. Enter the percent Loss of Watts and VARS for copper and iron in the appropriate 

fields.    

5. To implement any changes, click the Update Device button to send the new profile 

to the meter.

30.3: Power Quality and Alarms Settings 

From the Tree Menu on the left side of the ST40 meter’s Device Profile screen, double-

click on the Power Quality and Alarms Settings line or click on the + button next to it. 

All of the settings in the Power Quality and Alarms Settings group are listed.
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30.3.1: Configuring Limits 

1. From the Tree Menu, click Power Quality and Alarm Settings>Limits (see the screen 

on the previous page). The current settings for Limits are shown in the screen. Use 

this screen to assign Limits for the ST40 meter. 

Functional Overview for Limits:

Limits are transition points used to divide acceptable and unacceptable measure-

ments. When a value goes above or below the limit, an out-of-limit condition 

occurs. You can set and configure up to eight Limits for the ST40 meter.

Once they are configured, you can view the out-of-Limits (or Alarm) conditions in 

the Limits Log (see Chapter 19) or Limits Polling screen (see Chapter 5). You can 

also use Limits to trigger relays.

You can assign the eight limits to readings from three groups of parameters: 

•   Readings (Instantaneous Voltage; Instantaneous Current; Total and Per Phase 

Power and Power Factor; Frequency; Neutral Current; Symmetrical Components 

and Voltage Imbalances)

•   Demand (Current; Per Phase, Total Power and Power Factor)

•   THD (For Voltage and Current)

2. The bottom of the screen shows the Full Scale values for:

•   Voltage

•   Current

•   Frequency

•   Power

•   Power Total

•   Power Factor

•   THD
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3. To set or change a Limit:

a. Select a limit by double-clicking on the Assigned Channel field.

b. You will see the screen shown below. 

c. Select a Group and an Item for the Limit.

d. Click OK. The Limit you selected will now appear in the Limits screen.

3. To configure a Limit, double-click on the following fields to set their values:

•   Above and Below Set Point: Percent of Full Scale (the point at which the reading 

goes out of limit: see figure on the next page).

For example: 

100% of 120V Full Scale = 120 V

90% of 120V Full Scale = 108 V
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•   Above and Below Return Hysteresis (the point at which the limit’s status 

changes from out of limit to within limit: see figure below).

For example, with a 120 V Full Scale: 

• Above Set Point = 110% of Full Scale (Out of Limit above 132 V)   

• Below Set Point = 90% of Full Scale (Out of Limit below 108 V)

• Above Return Hysteresis = 105% of Full Scale (Stay Out of Limit until 
below 126 V)

• Below Return Hysteresis = 95% of Full Scale (Stay Out of Limit until 
above 114 V)

    NOTES: 

•   The Primary fields are display only. They show what the set point and return 

Hysteresis value are for each limit.

•   If the Above Return Hysteresis is greater than the Above Set Point, the Above 

Limit is Disabled; if the Below Return Hysteresis is less than the Below Set Point, 

the Below Limit is Disabled. You may want to use this feature to disable either 

the Above Limit or Below Limit condition for a reading.

•   If you are entering negative limits, be aware that the negative value affects the 

way the above and below limits function, since negative numbers are processed 

as signed values.

4. To implement any changes, click the Update Device button to send the new profile 

to the meter.

TIME

Above Limit 
condition

Below Limit 
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Above Limit Trigger point

Return point from Above Limit  condition
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+ MEASURED VALUE

0
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30.3.2: Configuring Waveform/PQ 

The Waveform/PQ capability allows the meter to act as a high-speed waveform 

recorder to record any anomaly that occurs within a cycle of duration. This provides a 

user with advanced waveform analysis including pre- and post- waveform recording. 

The meter has the capability to record both surges and sags of the measured signals. 

A voltage surge is any event that increases the RMS voltage for one cycle, calculated 

every half cycle. A voltage sag is a dip in the RMS of one cycle of voltage, calculated 

every half cycle. A current fault (or surge) is also calculated in the same manner. 

When the RMS value of any of these triggers exceeds the threshold settings, the 

meter will trigger a waveform capture.

This setting determines at what point the meter executes a waveform capture and/or 

records a power quality event. See Chapter 19 for instructions on viewing Waveform 

and PQ logs. See 30.4.2: Trending Profiles/ Configuring Historical Logs, on page 30-

31 for instructions on configuring the log sectors for the ST40 meter.

NOTE: PQ and Waveform Thresholds are given as a percentage of the Full Scales ( 

Full Scale fields). Full Scales are based on the CT and PT Ratios set in the CT, PT 

Ratios and System Hookup setting. Before programming the Waveform/PQ Thresh-

olds, set the CT and PT ratios. See 30.1.1: Configuring CT, PT Ratios, and System 

Hookup, on page 30-2, for instructions. 
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1. From the Tree Menu, click Power Quality and Alarm Settings>Waveform/PQ. The 

current settings, if any, are shown in the screen.

2. Set the Surge and Sag Setpoints (in percent of Full Scale), for Voltage, and the 

Surge Setpoint for Current. When you enter the percentage for a reading, the pri-

mary value is displayed in the Primary field. The bottom of the screen displays the 

Full Scales for Voltage and Current.

3. Click the checkbox under PQ to enable PQ recording when the programmed thresh-

old is exceeded.

4. Click the checkbox under Waveform to enable Waveform recording when the pro-

grammed threshold is exceeded.
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5. Select the sampling rate from the Capture Sample Rate pull-down menu. The 

options are: 32, 64, 128, 256, 512.

6. From the Pre-trigger pull-down menu, select the number of cycles of waveform 

data prior to the triggering event, that you want to be included in the waveform 

capture. The options are 2 to 63.

NOTE: Increasing the number of pre-cycles will decrease the number of cycles of 

data recorded after the event.

7. To implement any changes, click the Update Device button to send the new 

profile to the meter.
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30.4: Logs

From the Tree Menu on the left side of the ST40 meter’s Device Profile screen, double-

click on the Logs line or click on the + button next to it. All of the settings in the Logs 

group are listed.

30.4.1:Configuring Log Sizes

The ST40 meter allows a user to configure the amount of memory allocated for each 

log, so you can optimize the number of records stored for each log.

•  Use this setting to increase or decrease the amount of records each of the ST40 

meter's three Historical logs can store, and the duration each log can run, before 

becoming filled. This allows a user to set the amount of memory allocated per log 

for the amount of recording days desired before the memory fills and gets rolled 

over.

•  Also use this setting to set the allocation for the Waveform and Power Quality (PQ) 

logs.
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1. From the Tree Menu, click Logs/Configure Log Sizes. You will see the screen on the 

previous page. The screen is color-coded for ease of use. The color key is shown in 

the box(es) labeled Historical Logs and Waveform/PQ Logs.

•  The first Log box shows the current space allocation for the ST40 meter's three 

Historical logs, including:

•  The number of bytes allocated to each log.

•  The number of records available for each log.

•  The duration of each log.

•  The second Log box shows the same information, along with the current space 

allocation for the Waveform/PQ Logs, including:

•  The number of bytes allocated to each log.

Color keys for logs
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2. To change the current allocation for a log:

a. Click on one of the double yellow lines dividing the individual logs. 

b. You will see a line with arrows on each side. Drag the line in either direction 

to increase or decrease the log allocation. The display fields for the logs will 

reflect any changes you make to the allocation.

NOTE: The Waveform log must have at least 3 sectors allocated to it.

3. To implement any changes, click the Update Device button to send the new profile 

to the meter.

30.4.2: Trending Profiles/ Configuring Historical Logs

Use this setting to select the parameters to be stored in each of the ST40 meter's 

three Historical Logs. For additional information on logs, including using the HHF Con-

verter, see Chapters 16 and 19.

Functional Overview of Historical Logs:

The ST40 meter allows a user to set up 3 separate historical profile logs that can log 

up to 64 parameters. Each of these logs can log at different time frames. For exam-

ple, one log can be set for one minute intervals to record voltage; while another log 

can be set for 15 minute intervals for energy consumption logging.

Having three historical logs additionally affords you the flexibility of programming 

each log with unique parameters. For example, you might program Historical Log 1 to 

record Power Quality parameters (for example, THD), Log 2 to record Demand param-

eters, and Log 3 to record Energy parameters. 

Historical Log parameters can be selected from six groups:

•  Readings (Primary Readings and Uncompensated Readings sub-groups)

•  Energy 

•  Demand 

•  Phase Angles

•  Max/Min (Primary Minimums, Primary Maximums, Short Term Minimums, Short 

Term Maximums sub-groups)



     Doc#    E107707                                              30- 32

30: ST40 Meter

•  Harmonics/THD (For voltage and current) 

1. From the Tree Menu, click Logs>Trending Profiles>Historical Log Profile (1-3). 

This screen allows you to select items to be stored in the historical log you selected. 

The Group field determines the items that are available for selection.

2. Select a Group and sub-group, if applicable. 

3. Select items for your log:

a. Highlight the item(s) you want in the Selectable Items box.

b. Click Add. The item(s) are added to the Selected Items box.

c. To remove item(s), highlight them in the Selected Items box and click 

Remove.
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4. In the Log Usage box, set the Logging 

Interval. The available choices are: 1, 3, 

5, 10, 15, 30, 60. The Logging Interval 

determines when the meter takes a snap-

shot.

IMPORTANT! If you are trending Energy in the Interval, the Logging interval must 

be the same as the Demand interval. 

The Time Available shows how long the log will record before rolling over.

NOTE: The Record Usage box shows the 

total bytes used and the remaining bytes 

for the log.

5. To implement any changes, click the 

Update Device button to send the new 

profile to the meter.
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A: Transformer/Line Loss Compensation 

A.1: What is System Loss Compensation?

System Loss Compensation is a metering technique that adds or subtracts losses to 

meter registration. This technique is used because it is often much less expensive and 

safer to meter the low voltage side of a Power Transformer than the contractual billing 

point.

System Loss Compensation also provides a method for moving the billing point from a 

boundary point on a transmission line back to a practical metering point.

System Loss Compensation adjusts for losses between the billing point and the 

metering point. These losses are lumped into Transmission Line Losses, Power Trans-

former Losses and Substation Conductor Losses. The EIG Loss Calculator allows for 

the use of any or all of these elements at a meter installation.

A.1.1: EIG Loss Calculator Overview

The EIG Loss Calculator is simple to use and can easily be adapted for your require-

ments. It comprises a complete model that handles loss compensation from meter to 

distribution line, covering Power Transformer losses, Substation Conductor losses, 

Transmission Line losses, and optionally, adjustments for Transmission Line Charging 

effects. It produces a printable document of the installation, with technical description 

that can be used with both customers and reviewing agencies.
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To use the calculator, you plug data into Excel Spreadsheet cells, which have been 

color-coded for ease of use. In addition, the calculator contains:

•   Instructions for its use

•   Technical descriptions of calculations performed

•   Equations expressed in typical metering abbreviations

•   “Mouse over” notes on Key Cells, explaining their function.

The current version of the EIG Loss Calculator contains the following enhancements:

•   Substation Conductor losses

•   Optional adjustment for Transmission Line Charging effects

•   Programmable Meter Nominal Current (see explanation in Section A.2)

•   Enhanced color coding of data and page tabs

•   Improved instructions and technical descriptions.

A.2: Loss Model

The model used is a typical Loss Model used in Electricity Metering. The primary 

source for this model is the "Handbook for Electricity Metering". However, if your busi-

ness uses a different model, the Spreadsheet can be easily modified to use your 

model.

The elements and assumptions used in the model are described in the following 

sections.

A.3: Loss Triangles and Calculations

The Loss Triangles are developed from the Simplified Transformer High Side Model. 

Loss values not supplied by the Manufacturer are calculated by solving the Load and 

No-Load Loss triangles.

•   No-Load Calculations:

•   No-Load Watts (NLW) are given by the manufacturer’s data.



     Doc#    E107707                                               A - 3

      A: Transformer/Line Loss Compensation

•   No-Load VA is defined as:

             

NLVA = No-Load VA

Ix =  Exciting Current

NLV = No-Load VARs

NLVC = Compensated No-Load VARs

•   Then, No-Load VARs (NLVC) can be calculated as:

•   Full Load Calculations:

•   Full Load Watts (FLW) are given by the manufacturer’s data.

•   Full Load VA is defined as:

FLVA = Full Load VA

Z =  Impedance

FLV = Full Load VARs

NLVC = Compensated No Load VARs

•   Then, No-Load VARs (NLVC) can be calculated as:

NOTE: All calculations are done on a single element basis averaging the Total number 

or using the per element number entered in the spreadsheet. It is assumed that Total 

numbers are the sum of the three (3) actual element values provided by the Trans-

former Manufacturer.
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A.4: System Losses

A.4.1: Transmission Line Losses

•   Transmission Line Losses are made up of series resistance, series capacitance and 

shunt capacitance. 

•   Total Line Length = 3 x Line Length

Line Current is calculated at rated kVA.

Ip = Primary Current

Then,

Line Loss Watts

where R is the resistance in ohms/unit of length

Line Loss VARs

where X is effective series inductive reactance in

ohms/unit of length
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A.4.2: Substation Conductor Losses

•   Substation Losses are calculated at secondary current of the Power Transformer 

Bank at Rated kVA.

•   Total Conductor Length = 3 x Conductor Length

Rated secondary current

Conductor Loss Watts

where R is the Resistance in ohms/unit of length

Conductor Loss VARs

where X is effective series inductive reactance in

ohms/unit of length

= Apparent Power or Power in Circuit

   (voltage x current)
I
2
r
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A.4.3: Total System Losses

•   Transformer, Transmission Line and Substation Conductor Losses are combined to 

compute Total System Losses. The EIG Loss Calculator does not require that all 

pieces of the model be used to calculate System Losses.

•   Losses are then shifted to the Primary of the Instrument Transformers using the 

Compensation Calculation Assumptions:

LWFE = Core Loss Watts LVFe = Core Loss VARs

LWCu = Copper Loss Watts LVCu= Copper Loss VARs

A.4.4: Meter Loss Coefficients

•   Losses are scaled by the meter rating to compute Meter Loss Coefficients.

Meter VA Rating where:

TA= Test Amps

CTR= CT Ratio

VTR= VT (PT) Ratio

VAm = VA (apparent power) in meter circuit

LWFE= LWFE/VAm  No-Load Loss Watts

LVFE= LVFE/VAm  No-Load Loss VARs

LWCu= LWCu/VAm  Full Load Loss Watts

LVCu=LVCu/VAm  Full Load Loss VARs
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A.4.5: Dynamic Compensation Calculations

•   The EIG meter dynamically computes system losses instantaneously using the 

Meter Loss Coefficients and the assumed voltage and current relationships for 

Watts and VARs.

1. No-Load Loss Watts are proportional to V Squared.

2. Load Loss Watts are proportional to I Squared.

3. No-Load Loss VARs are proportional to V to the 4th power.

4. Load Loss VARs are proportional to I Squared.

     Demand, Energy, TOU and Load Profile values are compensated instantaneously.

A.4.6: Transmission Line Charging Current

•   Capacitive effects are not part of the basic EEI/IMO transmission line loss model 

but can be significant when large energy transfers occur.

•   Capacitive Reactance per unit of length is the only additional input required. The 

unit of measure is megohm-miles or megohm-kilometers.

     So,

in ohms

     then, calculate charging current

in amps

      so,
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     The 3 is included because 3 lines are assumed.

     NOTE: the sign of Capacitive Losses is negative.

     Since both the Inductive and Capacitive Losses are quadrature components they

     can be added as scalars.

     Then,

     Total kvars Losses = Reactive Losses + Capacitive Losses

     NOTE: Adding the Capacitive Losses always reduces total kvar losses because of 

     the negative sign on the capacitive losses.

•   The EIG Loss Calculator makes these adjustments for Line Charging on the Line 

Loss Page of the Excel Spreadsheet. This adjustment is optional and not typically 

used in most metering applications. However, Transmission Engineers do use these 

adjustment on Medium Length Lines (10 to 50 miles), when the meter is upstream 

of net energy flow.

A.5: EIG Meter Loss Compensation Setting

All real and reactive energy measurements in EIG meters, unless otherwise labeled, 

are compensated for losses once Loss Compensation is enabled in the Device Profile. 

See sections 11.2.6 (Nexus® 1500/1500+ meter), 12.2.6 (Nexus® 1262/1272 

meter), 13.2.6 (Nexus® 1252 meter), 27.2.4:Transformer / Line Loss Compensation, 

on page 27-34 (for Nexus® 1450 meter), 8.2.2: Transformer/Line Loss Compensa-

tion, on page 8-21 (for Shark® 200/200S meter), 28.2.5: Transformer/Line Loss 

Compensation, on page 28-51 (for Shark® 250 meter), and 26.2.4: Transformer/Line 

Loss Compensation, on page 26-56 (for Shark® 270 meter), for TLC setting instruc-

tions.
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A.5.1: Common Compensation Examples

NOTE: For Revenue Metering, how compensation is handled is usually dictated by the 

Metering Tariff and that should be your primary guide. These examples may or may 

not agree with your company’s practice and the applicable Tariff at a metering point. 

They are simply intended to present examples of how Loss Compensation can be 

used. Refer to the IMO Loss Diagram, below.
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A.5.1.1: Application Example #1: Substation Instrumentation or
              SCADA Metering

•   Objective: Monitor Net Energy and VAr flow.

•   In this application, the meter will not see the real (Watts) and reactive energy 

(VArs) delivered by the Electrical Distribution System used to charge and energize 

the Power Transformer that it would have seen if it was placed at the metering 

point so these losses must be added to the meter readings.

•   Assumptions:

1. We want to compensate the meter reading to add both No Load (Fe) and Full 

Load (Cu) loses from the Power Transformer. From the Transformer and Line 

Loss Compensation screen’s first pull-down menu, select: Both Fe and Cu.

2. We also want to add both estimated Watts and VArs to the meter readings.

From the Transformer and Line Loss Compensation screen’s second pull-down 

menu, select: Add to Watts and VAr.

3. With the meter on the low voltage side of the Power Transformer only Deliv-

ered Energy needs to be compensated for losses, Received energy is properly 

metered because the Power Transformer is energized from the Primary side. 

From the Transformer and Line Loss Compensation screen’s third pull-down 

menu, select: +Watts.
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A.5.1.2: Application Example #2: Generation Instrumentation or    
              SCADA Metering

•   Objective: Monitor Net Energy and VAr flow.

•   In this application, the meter will see the real (Watts) and reactive energy (VArs) 

delivered by the Generator that is used to charge and energize the Power Trans-

former. However, the billing point is on the Load side of the Power Transformer and 

the losses should not be added to the meter readings. So to compensate the meter, 

we must subtract the metered losses.

•   Assumptions:

1. We want to compensate the meter reading by subtracting both No Load (Fe) 

and Full Load (Cu) loses from the Power Transformer. From the Transformer 

and Line Loss Compensation screen’s first pull-down menu, select: Both Fe 

and Cu.

2. We also want to subtract both estimated Loss Watts and Loss VArs from the 

meter readings. From the Transformer and Line Loss Compensation screen’s 

second pull-down menu, select: Subtract from Watts and VArs.

3. With the meter on the Generator side of the Power Transformer only Energy 

flowing to the Transmission Line needs to be compensated for losses because 

the Power Transformer is energized from the Generator Side. From the Trans-

former and Line Loss Compensation screen’s third pull-down menu, select: 

+Watts.
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A.5.1.3: Application Example #3: Revenue Metering at Industrial or 
              Commercial Customer

•   Objective: Meter per Tariff for this customer class or per contract.

NOTE: The following comments are typical but may not be in agreement with the 

Tariff or Contract to be applied or your company practice.

•   The meter has been placed on the secondary side of the Power Transformer but the 

customer is buying energy on the Primary Side of the Power Transformer, therefore, 

transformer losses are part of the customer’s load and should be added to the 

meter reading. No credit is given to the customer for Watts or VArs the customer 

supplies to the Utility System.

•   In this application, the meter will not see the real (Watts) and reactive energy 

(VArs) delivered by the Electrical Distribution System used to charge and energize 

the Power Transformer that it would have seen if it was placed at the metering 

point so these losses must be added to the meter readings.

•   Assumptions:

1. We want to compensate the meter reading to add both No Load (Fe) and Full 

Load (Cu) loses from the Power Transformer. From the Transformer and Line 

Loss Compensation screen’s first pull-down menu, select: Both Fe and Cu.

2. We also want to add both estimated Watts and VArs to the meter readings. 

From the Transformer and Line Loss Compensation screen’s second pull-down 

menu, select: Add to Watts and VAr.



     Doc#    E107707                                               A - 13

      A: Transformer/Line Loss Compensation

3. At the metering point we want to know only Delivered energy flow and ignore 

any real or reactive energy supplied by the customer to the Electrical System. 

From the Transformer and Line Loss Compensation screen’s third pull-down 

menu, select: +Watts Only.

•   In this example we also need to consider the meter’s displayed quantities. The EIG 

meter is a true Four Quadrant Meter but Tariff Requirements in this case ignore 

Watts and VARs that the customer sends to Distribution System.

NOTE: See A.5.2: Four Quadrant Power Flow Conventions, on page A-16, for a 

graphic display of the terms used.

•   For more information on display options see the User Manual for the EIG meter 

model you are using, but all Shark® and Nexus® meters can display and log Four 

Quadrant Metering Quantities.

•   In this example the quantities used for Revenue Metering would be:

1. Q1 – Delivered Watts

2. Q1 – Lagging VArs

     All of the other quantities are still available in the meter but only these will 

     typically be used for billing purposes and displayed for the customer.
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A.5.1.4: Application Example #4: Revenue Metering at Industrial
              Cogeneration

•   Objectives:

•   Measure Delivered and Received Watts and all VArs supplied to the customer; no 

credit is given to the customer for VArs the customer supplies to the Utility 

System.

•   Meter per Tariff for this customer class or per contract.

NOTE: The following comments are typical but may not be in agreement with the 

Tariff or Contract to be applied or your company practice.

•   The meter has been placed on the secondary side of the Power Transformer but the 

customer is buying energy on the Primary Side of the Power Transformer, therefore, 

transformer losses are part of the customer’s load and should be added to the 

meter reading. No credit is given to the customer for VArs the customer supplies to 

the Utility System, but Watts supplied by the customer are used to offset the 

energy the customer buys.

•   In this application, the meter will not see the real (Watts) and reactive energy 

(VArs) delivered by the Electrical Distribution System used to charge and energize 

the Power Transformer that it would have seen if it was placed at the metering 

point, so these losses must be added to the meter readings.
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     NOTE: Losses are typically subtracted instead of added when the meter is placed

     on the Supply side of the Power Transformer instead of the more typical Load side

     installation.

•   Assumptions:

1. We want to compensate the meter reading to add both No Load (Fe) and Full 

Load (Cu) loses from the Power Transformer. From the Transformer and Line 

Loss Compensation screen’s first pull-down menu, select: Both Fe and Cu.

2. We also want to add both estimated Watts and VArs to the meters readings. 

From the Transformer and Line Loss Compensation screen’s second pull-down 

menu, select: Add to Watts and VAr.

3. At the metering point we want to know only Delivered energy flow and ignore 

any real or reactive energy supplied by the customer to the Electrical System. 

From the Transformer and Line Loss Compensation screen’s third pull-down 

menu, select: Both +Watts and – Watts.

•   To obtain the Tariff Quantities we need to look at 4 Quadrant Data. The following 

metered values would typically be used:

1. Q1 + Q4 - Delivered Watts/Watthours – this is energy delivered to the load.

2. Q2 + Q3 - Received Watts/Watthours – this is energy received from the load.

3. Q1 + Q2 - Lagging VArs – these are typically referred to as Supplied or 

Delivered VARs

•   An alterative would be to measure QHours if that is part of the Tariff.

NOTE: QHours are not typically used with Electronic Meters.

     

     NOTE: Typically, VArs would not be used for billing except if a Power Factor Pen-

     alty condition exists. To determine if PF is outside of Tariff Requirements, we would 

     typically set the Power Factor Limit as a Device Profile Limit in the Communicator

     PQATM software and Log Power Factor. This would provide documentation of

     when and how badly the Metered Load dropped below the required minimum

     Power Factor.
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A.5.1.5: Loss Calculation References

For more information, consult the following documents:

•   MDP_STD_005 - IMO Site Specific Loss Adjustments

•   EEI Handbook for Electricity Metering   

•   MDP_PRO_0011 IMO Market Manual 3: Metering, Part 3.5 Site Specific Loss 

Adjustments

A.5.2: Four Quadrant Power Flow Conventions

NOTE: The Terms “Export/Import” and “Delivered/Received” are equivalent and use 

the Utility Power Grid as their reference. So, “Delivered or Export” refers to Energy 

Flow from the Power Grid to the Load.
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The Delivered and Received conventions shown are the default setting for EIG meters. 

However, these setting can be changed in the meter’s Device Profile Labels screen. 

For instructions, refer to the chapter that explains how to program the Device Profile 

settings for your meter model: 8 (Shark® 200/200S meter) 11 (Nexus® 1500/1500+ 

meter), 12 (Nexus® 1262/1272 meter), 13 (Nexus® 1252 meter), 26 (Shark® 270 

meter), 27 (Nexus® 1450 meter), or 28 (Shark® 250 meter).

A.6: EIG Loss Compensation Calculator Instructions and Examples

Click the TLC Calculator button on the Transformer and Line Loss Compensation 

screen (see A.5: EIG Meter Loss Compensation Setting, on page A-8). The following 

pages contain Loss Compensation Calculator instructions and several copies of the 

Loss Calculator screens with example numbers to assist you.
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A.6.1: EIG Loss Compensation Calculator Instructions

For 3 stator meters with 3 PTs and 3 CTs.

•   This model has been tested by Electro Industries/GaugeTech and has been demon-

strated to provide answers consistent with the Loss Model presented in the EEI 

Handbook for Electricity Metering, 10th Edition. However, Electro Industries/

GaugeTech assumes no liability associated with its use.

•   Information in red text is for advanced users who need to modify the model to 

meet their business requirements.

•   Start

1. Begin data entry on Transformer Loss Calculation Sheet (Xmfr Loss). 

NOTE: Make sure that unwanted data is not left in the spreadhseet from a 

previous use.

2. Data is entered in Yellow cells only: do not change data in other cells. You can 

use the examples later on in this chapter to verify proper operation of the 

model.
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•   Transformer Loss Calculation

3. Enter Transformer Manufacturer Supplied or Measured Data for Transformer 

Bank. Typical values that are often used are shown in the table below.

•The model assumes there are three power transformers.

•Transformer data may be entered as Total or per element values.

•Total values are the sum of the values for all three transformers.

•Calculations are made on a per element basis using either Total values 

divided by 3 or per elect values.

4. Enter configuration of transformer secondary - Wye or Delta.

5. Enter Instrument Transformer Information

          Example Data

          Enter primary and secondary values for voltage and current ITs. The model 

          calculates CTR, VTR, and TF. The Model assumes 3 CTs and 3 VTs (PTs) are

          used.

Value Comment

No Load Loss Watts Core or Iron Losses

Load Loss Watts  Copper or I squared r Losses

 Exciting Current

 Impedance

Transformer kVA Rating  Rating of whole bank in kVA

Rated Primary L_L Volts  Primary Line to Line Voltage Rating

V Secondary Side of Xmfr Line-Line  Secondary Line-Line Voltage

Instrument 
Transformers Primary  Secondary

Voltage Xmfr  7200  120

Current Xmfr 500  5
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6. The meter rating should not be changed unless you are using a special version 

of the meter and the Instruction Book instructs you to change these values.

7. Select Nominal Metered Current (the red box). The EEI/IMO Model uses TA for 

Nominal Current. You can find the TA on the meter nameplate; the TA for 

Nexus® meters is 2.5A. 2.5 is the value most typically entered into this box 

on the spreadsheet. However, many Electric Companies use 1/2 of Class Cur-

rent (10A) or Class Current for Nominal Current. This is a carryover from 

Rates written before Class 20 meters became the standard class for Trans-

former Rated Meter, and has been carried forward as part of the Rate Struc-

ture. The selection of Nominal Metered Current is very important because all 

losses will be scaled against this nominal value. Leave 2.5 as the Nominal Cur-

rent unless your company practice differs. If you are not using Transmission 

Line or Substation Conductor Losses, the values shown in Red on the Total 

Losses Sheet should be entered into the CommunicatorPQA® software when 

programming the EIG meter.

NOTE: If you see values for Transmission Line or Substation Conductor 

Losses, go to those sheets and clear data from yellow cells.

•   If you are using Transmission Line or Substation Conductor Losses, continue 

with the instructions. 

Transmission Line Losses:

8. Entry of transmission Line Data is optional. If the data entries are left at zero 

then no addition losses are added to the Total Losses. This is easily verified by 

checking the loss summary on the System Losses Sheet. The Total System 

Losses will show zero contribution from Line and Substation Losses.

9. Enter per unit ohmic values, resistance per unit and conductive reactance per 

unit.
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10. Enter the length of a single conductor. The model assumes 3 conductors and

  calculates Total Conductor Length.

11. Enter the per unit label. Typically Miles (Mile) or Kilometers (KM). This value

  does not affect the model calculations but is carried for clarity.

12. Line Losses will now be reflected in Total System Losses. If you are not using

  Substation Conductor Losses, the values now shown in Red on the Total

  Losses Sheet should be entered into the CommunicatorPQA® software when

  programming the EIG meter.

 NOTE: If you see values for Substation Conductor Losses go to that sheet;

 clear data from yellow cells.

•   If you are using Substation Conductor Losses, continue with instructions.

Substation Conductor Losses:

13. Entry of Substation Conductor Data is optional. If the data entries are left at

  zero, then no additional losses are added to the Total Losses. This is easily

  verified by checking the loss summary on the System Losses Sheet. The Total

  System Losses will show zero contribution from Substation Losses.

14. Enter per unit ohmic values, resistance per unit and conductive reactance

  per unit.

15. Enter the length of a single conductor. The model assumes 3 conductors and

  calculates Total Conductor Length.

16. Enter the per unit label. Typically Feet (FT) or Meters (M). This value does

  not affect the model calculations but is carried for clarity.

17. Substation Conductor Losses will now be reflected in Total System Losses. 

The values now shown in Red on the Total Losses Sheet should be entered into 

the CommunicatorPQA® software when programming the EIG meter.
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      A: Transformer/Line Loss Compensation

A.6.2: Example 1 Data

System Losses (Transformer, Line and Substation Conductor Losses)

•   This example will use all elements of the Loss Calculator, compensation for Trans-

mission Line Losses, Substation Conductor Losses, and Power Transformer Losses. 

Examples 2 and 3 are less complex Transformer Loss Compensation examples with 

Wye and Delta circuits. This example will present an application and a filled Spread-

sheet. Examples 2 and 3 will present the application.

NOTE: The TLC Calculator has pop-up instructions for all of the entry fields to help 

you fill out the spreadsheet.

•   Application Description

•   Installation Description: The installation includes a 36-mile transmission line, a 

10 MVA transformer bank and 156 feet of substation conductor.

•   Transformer Data Supplied by Manufacturer

        NOTE: If the transformer bank is composed of three single-phase transformers,

        each transformer’s VA, Watt and VAR losses are added to obtain total losses.

kVA rating of transformer bank 10MVA

Rated primary voltage  115kV

Secondary line-to-line voltage  12,470 V

Secondary line-to-neutral voltage  7200 V

No-load watts loss  45 kW

Copper losses at 75oC  135 kW

Percent impedence  7.5

Percent exciting current  1.03

Secondary Connection  Wye
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      A: Transformer/Line Loss Compensation

•   Transmission Line Data

       NOTE: The spreadsheet will compute Total Line Length assuming three conduc-

       tors, Total Line Length = 3 x Line Length.

•   Substation Conductor Data

       NOTE: The spreadsheet will compute Total Conductor Length assuming three

       conductors, Total Conductor Length = 3 x Conductor Length.

•   Metering Data: 

The model assumes a three-phase, 4-wire meter installation with 3 Voltage Trans-

formers and 3 Current Transformers. This is not a limitation because all EIG Trans-

former Rated Meters are 3 stator, 4-wire meters. The model should not be used 

with other meter types.

Resistance per mile  0.306 ohms per mile

Inductive reactance per mile  0.451 ohms per mile

Line length  36 miles

Resistance per 1000 feet  0.005 ohms per 1000 feet

Inductive reactance per 1000 feet  0.090 ohms per 1000 feet

Conductor length  156 feet

Voltage Transformer Ratio, VTR  7200/120 = 60/1

Current Transformer Ratio, CTR  500/5 = 100/1

Meter Voltage Rating, Vm 120V

Meter Test Amps, TA, Inom 2.5A
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      A: Transformer/Line Loss Compensation

A.6.2.1: Example 1 Spreadsheet - System 
Losses Summary for Example 1 with 
Example Numbers

Electro Industries / GaugeTech (877) EIMETER (877.346.3837)
1800 Shames Drive, Westbury, NY 11590

System Losses Summary EIG Loss Compensation Calculator
Meter Correction Factors from this sheet are manually entered into EIG Communicator Software
Note: Begin Data Entry by Going to Xfmr Loss Sheet
Company: Project
Name: Location
Date:

Comments: Example of Loss Calculator with Transformer, Substation, and Line Losses

Meter Correction Factors
for Communicator Software Calc Used
% No-Load Loss Watts %LWFE 0.83344 0.833
% Full-Load Loss Watts %LWCU 1.17956 1.180
% No-Load Loss VARs %LVFE 1.71616 1.716
% Full-Load Loss VARs %LVCU 4.66247 4.662

Losses Shifted to IT Primary per element Total Unit
LWFE Core-Loss Watts 15.00 45.0100 kW
LWCU Watts Loss due to Cu 21.23 63.70 kW
LVFE Core-Loss VArs 30.89 92.67 kVAr
LVCU VA Rated Loss due to Cu 83.92 251.76 kVAr

VAnom Nominal Meter VA Rating 5,400.00 kVA

Total System Losses
total losses Note: If no data entered in Line or Substation Loss sheets contribution to total is zero

Type Source kWatts Loss kVAr Losses
No-Load Losses Transformer Core NLW 135.00 NLV 277.95

Load Losses Transformer Windings FLW 405.00 FLV 2,207.25
Transmission Line LLW 27.77 LLV 40.92
Substation Conductors CLW 0.51 CLV 9.03
Total Load Losses TLW 433.28 TLV 2,257.20

per element losses
Type Source kWatts Loss kVAr Losses

No-Load Losses Transformer Core NLW 45.00 NLV 92.65

Load Losses Transformer Windings FLW 135.00 FLV 735.75
Transmission Line LLW 27.77 LLV 40.92
Substation Conductors CLW 0.17 CLV 3.01
Total Load Losses TLW 162.94 TLV 779.68

Comments: Legend
Information Only

Required Data
Calculated Value

Data from other Sheet
Enter this Data

Comments

Enter These
Values in
Communicator
Software

Copyright 2014 Publishing and duplicating rights are property of Electro 
Industries/GaugeTech. This spreadsheet is designed only to be used with 
EIG named or OEM metering equipment.

Loss Factors

Example 1

EIG L C ti C l l t R 0320140926 144328 9/26/2014 1 f 1
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      A: Transformer/Line Loss Compensation

A.6.2.2: Example 1 Spreadsheet - Xmfr Loss for Example 1 with
              Example Numbers

Electro Industries / GaugeTech
1800 Shames Drive, Westbury, NY 11590 (877) EIMETER [877-346-3837]  

Transformer Losses EIG Loss Compensation Calculator
Company: Substation:
Name: Xmfr  Bank No.:
Date:
Xmfr Manf:

Winding
HV - High
XV - Low
YV - Tert.
Comments:

Transformer Losses
per Element Total Unit

No Load VA NLVA 34.3333 102.9999 kVA
No Load Watts NLW 15.0000 45.0000 kW
No-Load Loss VARs NLV 30.8833 92.6498 kVAr
Full Load VA FLVA 250.0000 750.0000 kVA
Full-Load Loss Watts FLW 45.0000 135.0000 kW
Full-Load Loss VARs FLV 245.9167 737.7500 kVAr
3 Phase Power Transformer Data
Value Total Per element Calculated kVA
No Load Loss Watts LWFe 45,000.00 15,000.00 15.00
Full Load Loss Watts LWCu 135,000.00 45,000.00 45.00
% Exciting Current %Ix 1.03
% Impedance %Z 7.5
Transformer kVA Rating kVA Rated 10,000.00 3,333.33
Rated Primary L_L Volts Vp 115,000
Power Transformer - 3 Transformer bank
Secondary Side Voltage [V] Vs 12470
Secondary Side Rated Current [A] I Rated 267.31
Feed - Load Connection Wye

Meter Setup/ Installation Data Three Element Meter with 3 PTs and 3 CTs
Instrument Transformers Primary Secondary Ratio
Voltage Transformer 7200 120 60
Current Transformer 500 5 100
Transformers Factor TF 6000

Nominal Voltage VM 120
Inom 5

Meter Test Amps TA 5
CL 20
Fm x

Copyright 2014 Publishing and duplicating rights are property of Electro 
Industries/GaugeTech. This spreadsheet is designed only to be used with 
EIG named or OEM metering equipment.

Example 1

Xmfr S/N:
Company Number

Meter Class
Meter Form

Losses

Losses

Nominal Current
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      A: Transformer/Line Loss Compensation

A.6.2.3: Example 1 Spreadsheet - Line Loss for Example 1 with 
              Example Numbers

Electro Industries / GaugeTech
1800 Shames Drive, Westbury, NY 11590 (877) EIMETER [877-346-3837]
Line Losses EIG Loss Compensation Calculator
Three Element Meter with 3 PT's and 3 CT's
Note: Leave Data Entry Cells Blank if not including Line Losses

:noitatsbuS:ynapmoC
:.oN knaB frT ntS:emaN

Date:

Metering Point Information

Line Losses
V tinUlatoTesahp repeula
Total Line Length 108.0000 Mile

pI tnerruC eniL 28.9855 Amp
Line Loss Watts LLW 27.7656 83.2968 kW
Line Loss VArs LLV 13.6408 40.9225 kVA

Transmission Line Impedance Data
V tinUlatoTtinU repeula

000063.0tinu/R ecnatsiseR 33.0480 Ohms
Inductive Reactance XL/unit 0.415000 48.7080 Ohms
Length of Line LL - Units 36.0000

eliMUtinU htgneL
Resistive Losses 27.7656 kW
Inductive Losses 40.9225 kars
Note: Please make sure data entered uses a consistent unit of length

Adjustment for Line Charging Current
V tinUlatoTtinU repeula
Capacitive Reactance XC-unit 0.0000 0.0000 Ohms

spmA0000.0spmAenil rep tnerruC gnigrahC
sravk0000.0ravksessoL eviticapaC

Line Losses refected to Secondary of PT
V tinUlatoTesahp repeula
Nominal Pri kVA Rating VA mom-pri 54.2174 kVA
Nominal Sec kVA Rating VA mom-sec 54.2174 kVA
Line Loss Watts LLW 32.6654 97.9962 kW
Line Loss VArs LLV 13.6408 40.9225 kVA

Transformer Data from Xmfr Loss Sheet
V tinUlatoTesahp repeula
Transformer kVA Rating kvars 3333.3333 10,000.00 kvars
Rated Primary L_L Volts Vp 115,000.00 Volts
Note: This Data must be entered on Transformer Loss Sheet before completing Line Loss Calculation

Legend
Notes: Information Only

Required Data
Calculated Value

Data from other Sheet
Enter this Data

CommentsCopyright 2014 Publishing and duplicating rights are 
property of Electro Industries/GaugeTech. This spreadsheet is designed only to be used with EIG named or OEM metering equipment.  

spreadsheet is designed only to be used with EIG named or

Losses

Losses

Example 1
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      A: Transformer/Line Loss Compensation

A.6.2.4: Example 1 Spreadsheet - Substation Losses for Example 1
              with Example Numbers

Electro Industries / GaugeTech
1800 Shames Drive, Westbury, NY 11590 (877) EIMETER [877-346-3837]

Substation  Losses EIG Loss Compensation Calculator
Three Element Meter with 3 PT's and 3 CT's
Note: Leave Data Entry Cells Blank if not including Line Losses
Company: Substation:
Name: Stn Trf Bank No.:
Date:

Substation Information

Line Losses
Total per Element Unit

Total Conductor Length 156.00 FT
Secondary Current @ Rating Ir 462.991 Amp
Conductor Loss Watts CLW 0.167 0.056 kW
Conductor Loss VArs CLV 3.010 1.003 kVA

Legend
Transmission Line Impedance Data Information Only
Value per Unit Required Data
Resistance 0.000005 Calculated Value
Inductive Reactance x 0.000090 Data from other Sheet
Length of Conductor CL 52.00 Enter this Data
Length Unit U FT Comments

Note: This Data must be entered on Transformer Loss Sheet before completing Substation Loss Calculation
Transformer Data from Xmfr Loss Sheet
Value
Transformer kVA Rating kVAr 10,000 3333.3333
Rated Secondary L_N Volts Vr 7,200

Copyright 2014 Publishing and duplicating rights are property 
of Electro Industries/GaugeTech. This spreadsheet is 
designed only to be used with EIG named or OEM metering 
equipment.

Losses

Example 1
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      A: Transformer/Line Loss Compensation

A.6.3: Example 2 - Transformer Losses Data - Delta Connected 

•   Application Description

•   Installation Description: The installation includes three 115 kV, 3.333 MVA single 

phase power transformers with a Delta connected secondary.

•   Transformer Data Supplied by Manufacturer

        NOTE: If the transformer bank is composed of three single-phase transformers,

        each transformer's VA, watt, and VAR losses are added to obtain total losses.

•   Metering Data: 

The model assumes a three-phase, 4-wire meter installation with 3 Voltage Trans-

formers and 3 Current Transformers. This is not a limitation because all EIG Trans-

former Rated Meters are 3 stator, 4-wire meters. The model should not be used 

with other meter types.

kVA rating of transformer bank 9999kVA

Rated primary voltage  115kV

Secondary line-to-line voltage  2520V

No-load watts loss  28680W

Copper losses at 75oC  56027W

Percent impedence  8.1

Percent exciting current  0.183

Secondary Connection  Delta

Voltage Transformer Ratio, CTR  3000/5 = 600/1

Current Transformer Ratio, VTR  2400/120 = 20/1

Meter Voltage Rating, Vm 120V

Meter Test Amps, TA, Inom 2.5A
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      A: Transformer/Line Loss Compensation

A.6.3.1: Example 2 Spreadsheet - System Losses Summary for 
              Example 2 with Example Numbers

Electro Industries / GaugeTech (877) EIMETER (877.346.3837)  
1800 Shames Drive, Westbury, NY 11590

System Losses Summary EIG Loss Compensation Calculator
Meter Correction Factors from this sheet are manually entered into EIG Communicator Software
Note: Begin Data Entry by Going to Xfmr Loss Sheet
Company: Project
Name: Location
Date:

Comments: Example of Loss Calculation with Transformer Losses only

Meter Correction Factors
for Communicator Software Calc Used
% No-Load Loss Watts %LWFE 0.24087 0.241
% Full-Load Loss Watts %LWCU 0.22242 0.222
% No-Load Loss VARs %LVFE 0.72173 0.722
% Full-Load Loss VARs %LVCU 3.20751 3.208

Losses Shifted to IT Primary per element Total Unit
LWFE Core-Loss Watts 8.67 26.0100 kW
LWCU Watts Loss due to Cu 8.01 24.02 kW
LVFE Core-Loss VArs 25.98 77.95 kVAr
LVCU VA Rated Loss due to Cu 115.47 346.41 kVAr

VAnom Nominal Meter VA Rating 10,800.00 kVA

Total System Losses
total losses Note: If no data entered in Line or Substation Loss sheets contribution to total is zero

Type Source kWatts Loss kVAr Losses
No-Load Losses Transformer Core NLW 28.68 NLV 94.74

Load Losses Transformer Windings FLW 56.03 FLV 807.98
Transmission Line LLW 0.00 LLV 0.00
Substation Conductors CLW 0.00 CLV 0.00
Total Load Losses TLW 56.03 TLV 807.98

per element losses
Type Source kWatts Loss kVAr Losses

No-Load Losses Transformer Core NLW 9.56 NLV 31.58

Load Losses Transformer Windings FLW 18.68 FLV 269.33
Transmission Line LLW 0.00 LLV 0.00
Substation Conductors CLW 0.00 CLV 0.00
Total Load Losses TLW 18.68 TLV 269.33

Comments: Legend
Information Only

Required Data
Calculated Value

Data from other Sheet
Enter this Data

Comments

Enter These
Values in
Communicator
Software

Copyright 2014 Publishing and duplicating rights are property of Electro 
Industries/GaugeTech. This spreadsheet is designed only to be used with 
EIG named or OEM metering equipment.

Loss Factors

Example 2

EIG Loss Compensation Calculator Rev0320140926 144328 9/26/2014 page 1 of 1
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      A: Transformer/Line Loss Compensation

A.6.3.2: Example 2 Spreadsheet - Xmfr Loss for Example 2 with
              Example Numbers

Electro Industries / GaugeTech
1800 Shames Drive, Westbury, NY 11590 (877) EIMETER [877-346-3837]  

Transformer Losses EIG Loss Compensation Calculator
Company: Substation:
Name: Xmfr  Bank No.:
Date:
Xmfr Manf:

Winding
HV - High
XV - Low
YV - Tert.
Comments:

Transformer Losses
per Element Total Unit

No Load VA NLVA 32.9967 98.9901 kVA
No Load Watts NLW 9.5600 28.6800 kW
No-Load Loss VARs NLV 31.5815 94.7445 kVAr
Full Load VA FLVA 269.9730 809.9190 kVA
Full-Load Loss Watts FLW 18.6757 56.0271 kW
Full-Load Loss VARs FLV 269.3263 807.9788 kVAr
3 Phase Power Transformer Data
Value Total Per element Calculated kVA
No Load Loss Watts LWFe 28,680.00 9,560.00 9.56
Full Load Loss Watts LWCu 56,027.00 18,675.67 18.68
% Exciting Current %Ix 0.99
% Impedance %Z 8.1
Transformer kVA Rating kVA Rated 9,999.00 3,333.00
Rated Primary L_L Volts Vp
Power Transformer - 3 Transformer bank
Secondary Side Voltage [V] Vs 2520
Secondary Side Rated Current [A] I Rated 2291.00
Feed - Load Connection Delta

Meter Setup/ Installation Data Two Element Meter with 2 PTs and 2CTs
Instrument Transformers Primary Secondary Ratio
Voltage Transformer 2400 120 20
Current Transformer 3000 5 600
Transformers Factor TF 12000

Nominal Voltage VM 207.8460969
Inom 5

Meter Test Amps TA 5
CL 20
Fm x

Copyright 2014 Publishing and duplicating rights are property of Electro 
Industries/GaugeTech. This spreadsheet is designed only to be used with 
EIG named or OEM metering equipment.

Example 2

Xmfr S/N:
Company Number

Meter Class
Meter Form

Losses

Losses

Nominal Current
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      A: Transformer/Line Loss Compensation

A.6.3.3: Example 2 Spreadsheet - Line Loss for Example 2 with 
              Example Numbers

Electro Industries / GaugeTech
1800 Shames Drive, Westbury, NY 11590 (877) EIMETER [877-346-3837]
Line Losses EIG Loss Compensation Calculator
Three Element Meter with 3 PT's and 3 CT's
Note: Leave Data Entry Cells Blank if not including Line Losses

:noitatsbuS:ynapmoC
:.oN knaB frT ntS:emaN

Date:

Metering Point Information

Line Losses
V tinUlatoTesahp repeula
Total Line Length 0.0000 Mile

pI tnerruC eniL 28.9826 Amp
Line Loss Watts LLW 0.0000 0.0000 kW
Line Loss VArs LLV 0.0000 0.0000 kVA

Transmission Line Impedance Data
V tinUlatoTtinU repeula

tinu/R ecnatsiseR 0.0000 Ohms
Inductive Reactance XL/unit 0.0000 Ohms
Length of Line LL - Units

eliMUtinU htgneL
Resistive Losses 0.0000 kW
Inductive Losses 0.0000 kars
Note: Please make sure data entered uses a consistent unit of length

Adjustment for Line Charging Current
V tinUlatoTtinU repeula
Capacitive Reactance XC-unit 0.0000 0.0000 Ohms

spmA0000.0spmAenil rep tnerruC gnigrahC
sravk0000.0ravksessoL eviticapaC

Line Losses refected to Secondary of PT
V tinUlatoTesahp repeula
Nominal Pri kVA Rating VA mom-pri 32.8696 kVA
Nominal Sec kVA Rating VA mom-sec 32.8696 kVA
Line Loss Watts LLW 0.0000 0.0000 kW
Line Loss VArs LLV 0.0000 0.0000 kVA

Transformer Data from Xmfr Loss Sheet
V tinUlatoTesahp repeula
Transformer kVA Rating kvars 3333.0000 9,999.00 kvars
Rated Primary L_L Volts V 00.0p Volts
Note: This Data must be entered on Transformer Loss Sheet before completing Line Loss Calculation

Legend
Notes: Information Only

Required Data
Calculated Value

Data from other Sheet
Enter this Data

CommentsCopyright 2014 Publishing and duplicating rights are 

Losses

Losses

Example 2

property of Electro Industries/GaugeTech. This spreadsheet is designed only to be used with EIG named or OEM metering equipment.  
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      A: Transformer/Line Loss Compensation

A.6.3.4: Example 2 Spreadsheet - Substation Losses for Example 2
              with Example Numbers

Electro Industries / GaugeTech
1800 Shames Drive, Westbury, NY 11590 (877) EIMETER [877-346-3837]

Substation  Losses EIG Loss Compensation Calculator
Three Element Meter with 3 PT's and 3 CT's
Note: Leave Data Entry Cells Blank if not including Line Losses
Company: Substation:
Name: Stn Trf Bank No.:
Date:

Substation Information

Line Losses
Total per Element Unit

Total Conductor Length 0.00 FT
Secondary Current @ Rating Ir 2290.843 Amp
Conductor Loss Watts CLW 0.000 0.000 kW
Conductor Loss VArs CLV 0.000 0.000 kVA

Legend
Transmission Line Impedance Data Information Only
Value per Unit Required Data
Resistance Calculated Value
Inductive Reactance x Data from other Sheet
Length of Conductor CL Enter this Data
Length Unit U FT Comments

Note: This Data must be entered on Transformer Loss Sheet before completing Substation Loss Calculation
Transformer Data from Xmfr Loss Sheet
Value
Transformer kVA Rating kVAr 9,999 3333.0000
Rated Secondary L_N Volts Vr 7,200

Copyright 2014 Publishing and duplicating rights are property 
of Electro Industries/GaugeTech. This spreadsheet is 
designed only to be used with EIG named or OEM metering 
equipment.

Losses

Example 2
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      A: Transformer/Line Loss Compensation

A.6.4: Example 3 - Transformer Losses Data

•   Application Description

•   Installation Description: The installation includes a 138 kV,16.8 MVA transformer 

bank with a Wye connected secondary.

•   Transformer Data Supplied by Manufacturer

•   Metering Data: 

The model assumes a three-phase, 4-wire meter installation with 3 Voltage Trans-

formers and 3 Current Transformers. This is not a limitation because all EIG Trans-

former Rated Meters are 3 stator, 4-wire meters. The model should not be used 

with other meter types.

kVA rating of transformer bank 16800kVA

Rated primary voltage  138kV

Secondary line-to-line voltage  13090V

Secondary line-to-neutral voltage  7558V

No-load watts loss  15400W

Copper losses at 75oC  69200W

Percent impedence  9.78

Percent exciting current  0.133

Secondary Connection  Wye

Voltage Transformer Ratio, CTR  1500/5 = 300/1

Current Transformer Ratio, VTR  7200/120 = 60/1

Meter Voltage Rating, Vm 120V

Meter Test Amps, TA, Inom 5A
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      A: Transformer/Line Loss Compensation

A.6.4.1: Example 3 Spreadsheet - System Losses Summary for 
              Example 3 with Example Numbers

Electro Industries / GaugeTech (877) EIMETER (877.346.3837)  
1800 Shames Drive, Westbury, NY 11590

System Losses Summary EIG Loss Compensation Calculator
Meter Correction Factors from this sheet are manually entered into EIG Communicator Software
Note: Begin Data Entry by Going to Xfmr Loss Sheet
Company: Project
Name: Location
Date:

Comments: Transformer losses only
Meter Noimnal Current 5A

Meter Correction Factors
for Communicator Software Calc Used
% No-Load Loss Watts %LWFE 0.04314 0.043
% Full-Load Loss Watts %LWCU 0.87524 0.875
% No-Load Loss VARs %LVFE 0.06765 0.068
% Full-Load Loss VARs %LVCU 20.76262 20.763

Losses Shifted to IT Primary per element Total Unit
LWFE Core-Loss Watts 4.66 13.9800 kW
LWCU Watts Loss due to Cu 94.53 283.58 kW
LVFE Core-Loss VArs 7.31 21.92 kVAr
LVCU VA Rated Loss due to Cu 2,242.36 6,727.09 kVAr

VAnom Nominal Meter VA Rating 32,400.00 kVA

Total System Losses
total losses Note: If no data entered in Line or Substation Loss sheets contribution to total is zero

Type Source kWatts Loss kVAr Losses
No-Load Losses Transformer Core NLW 15.40 NLV 26.61

Load Losses Transformer Windings FLW 69.20 FLV 1,641.58
Transmission Line LLW 0.00 LLV 0.00
Substation Conductors CLW 0.00 CLV 0.00
Total Load Losses TLW 69.20 TLV 1,641.58

per element losses
Type Source kWatts Loss kVAr Losses

No-Load Losses Transformer Core NLW 5.13 NLV 8.87

Load Losses Transformer Windings FLW 23.07 FLV 547.19
Transmission Line LLW 0.00 LLV 0.00
Substation Conductors CLW 0.00 CLV 0.00
Total Load Losses TLW 23.07 TLV 547.19

Comments: Legend
Information Only

Required Data
Calculated Value

Data from other Sheet
Enter this Data

Comments

Enter These
Values in
Communicator
Software

Copyright 2014 Publishing and duplicating rights are property of Electro 
Industries/GaugeTech. This spreadsheet is designed only to be used with 
EIG named or OEM metering equipment.

Loss Factors

Example 3
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      A: Transformer/Line Loss Compensation

A.6.4.2: Example 3 Spreadsheet - Xmfr Loss for Example 3 with
              Example Numbers

Electro Industries / GaugeTech
1800 Shames Drive, Westbury, NY 11590 (877) EIMETER [877-346-3837]  

Transformer Losses EIG Loss Compensation Calculator
Company: Substation:
Name: Xmfr  Bank No.:
Date:
Xmfr Manf:

Winding
HV - High
XV - Low
YV - Tert.
Comments:

Transformer Losses
per Element Total Unit

No Load VA NLVA 10.2480 30.7440 kVA
No Load Watts NLW 5.1333 15.3999 kW
No-Load Loss VARs NLV 8.8696 26.6088 kVAr
Full Load VA FLVA 547.6800 1,643.0400 kVA
Full-Load Loss Watts FLW 23.0667 69.2001 kW
Full-Load Loss VARs FLV 547.1940 1,641.5821 kVAr
3 Phase Power Transformer Data
Value Total Per element Calculated kVA
No Load Loss Watts LWFe 15,400.00 5,133.33 5.13
Full Load Loss Watts LWCu 69,200.00 23,066.67 23.07
% Exciting Current %Ix 0.183
% Impedance %Z 9.78
Transformer kVA Rating kVA Rated 16,800.00 5,600.00
Rated Primary L_L Volts Vp 138,000
Power Transformer - 3 Transformer bank
Secondary Side Voltage [V] Vs 13091
Secondary Side Rated Current [A] I Rated 2291.00
Feed - Load Connection Wye

Meter Setup/ Installation Data Three Element Meter with 3 PTs and 3 CTs
Instrument Transformers Primary Secondary Ratio
Voltage Transformer 7200 120 60
Current Transformer 1500 5 300
Transformers Factor TF 18000

Nominal Voltage VM 120
Inom 5

Meter Test Amps TA 5
CL 20
Fm x

Copyright 2014 Publishing and duplicating rights are property of Electro 
Industries/GaugeTech. This spreadsheet is designed only to be used with 
EIG named or OEM metering equipment.

Example 3

Xmfr S/N:
Company Number

Meter Class
Meter Form

Losses

Losses

Nominal Current
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      A: Transformer/Line Loss Compensation

A.6.4.3: Example 3 Spreadsheet - Line Loss for Example 3 with 
              Example Numbers

Electro Industries / GaugeTech
1800 Shames Drive, Westbury, NY 11590 (877) EIMETER [877-346-3837]
Line Losses EIG Loss Compensation Calculator
Three Element Meter with 3 PT's and 3 CT's
Note: Leave Data Entry Cells Blank if not including Line Losses

:noitatsbuS:ynapmoC
:.oN knaB frT ntS:emaN

Date:

Metering Point Information

Line Losses
V tinUlatoTesahp repeula
Total Line Length 0.0000 Mile

pI tnerruC eniL 40.5797 Amp
Line Loss Watts LLW 0.0000 0.0000 kW
Line Loss VArs LLV 0.0000 0.0000 kVA

Transmission Line Impedance Data
V tinUlatoTtinU repeula

tinu/R ecnatsiseR 0.0000 Ohms
Inductive Reactance XL/unit 0.0000 Ohms
Length of Line LL - Units

eliMUtinU htgneL
Resistive Losses 0.0000 kW
Inductive Losses 0.0000 kars
Note: Please make sure data entered uses a consistent unit of length

Adjustment for Line Charging Current
V tinUlatoTtinU repeula
Capacitive Reactance XC-unit 0.0000 0.0000 Ohms

spmA0000.0spmAenil rep tnerruC gnigrahC
sravk0000.0ravksessoL eviticapaC

Line Losses refected to Secondary of PT
V tinUlatoTesahp repeula
Nominal Pri kVA Rating VA mom-pri 142.2826 kVA
Nominal Sec kVA Rating VA mom-sec 142.2826 kVA
Line Loss Watts LLW 0.0000 0.0000 kW
Line Loss VArs LLV 0.0000 0.0000 kVA

Transformer Data from Xmfr Loss Sheet
V tinUlatoTesahp repeula
Transformer kVA Rating kvars 5600.0000 16,800.00 kvars
Rated Primary L_L Volts Vp 138,000.00 Volts
Note: This Data must be entered on Transformer Loss Sheet before completing Line Loss Calculation

Legend
Notes: Information Only

Required Data
Calculated Value

Data from other Sheet
Enter this Data

CommentsCopyright 2014 Publishing and duplicating rights are 

Losses

Losses

Example 3

property of Electro Industries/GaugeTech. This spreadsheet is designed only to be used with EIG named or OEM metering equipment.  
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A.6.4.4: Example 3 Spreadsheet - Substation Losses for Example 3
              with Example Numbers

Electro Industries / GaugeTech
1800 Shames Drive, Westbury, NY 11590 (877) EIMETER [877-346-3837]

Substation  Losses EIG Loss Compensation Calculator
Three Element Meter with 3 PT's and 3 CT's
Note: Leave Data Entry Cells Blank if not including Line Losses
Company: Substation:
Name: Stn Trf Bank No.:
Date:

Substation Information

Line Losses
Total per Element Unit

Total Conductor Length 0.00 FT
Secondary Current @ Rating Ir 790.984 Amp
Conductor Loss Watts CLW 0.000 0.000 kW
Conductor Loss VArs CLV 0.000 0.000 kVA

Legend
Transmission Line Impedance Data Information Only
Value per Unit Required Data
Resistance Calculated Value
Inductive Reactance x Data from other Sheet
Length of Conductor CL Enter this Data
Length Unit U FT Comments

Note: This Data must be entered on Transformer Loss Sheet before completing Substation Loss Calculation
Transformer Data from Xmfr Loss Sheet
Value
Transformer kVA Rating kVAr 16,800 5600.0000
Rated Secondary L_N Volts Vr 7,200

Copyright 2014 Publishing and duplicating rights are property 
of Electro Industries/GaugeTech. This spreadsheet is 
designed only to be used with EIG named or OEM metering 
equipment.

Losses

Example 3
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B: CommunicatorPQA® Software 
Command Line Arguments, Version 1.20

Current 8-5-2014

B.1: Overview

•   The CommunicatorPQA® application supports two forms of command line argu-

ments:

•   The earlier 'slash' commands ('/s'), documented in Section B.2. 

•   The newer 'dash' commands ('--cmd'), documented in Section B.3.

•   Note that the two types are mutually exclusive: if the first command found starts 

with '--', then the command line is processed as dash commands. Otherwise, the 

slash command processing is used. 

•   By default, when used in command line mode, the CommunicatorPQA® application 

will shut down after all the commands are executed.

•   The CommunicatorPQA® application supports log retrieval from Nexus® 1500 and 

Shark® 200 meters via the -- command line.

B.2: Command Line Arguments - Slash Commands

B.2.1: Script Command Line Method

Tells the CommunicatorPQA® software to perform a task corresponding to the Script 

ID Number.

/snnnn Script ID Number

Example:

             CommExt /s1234 (/s Script ID Number)

uc: Start Log Converter

0 Do not start log converter

1 Start log converter

If left out of command line, Start Log Converter is assumed.
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Example: CommExt with Script 1234 will Start Log Converter if Log Retrieval is in the 

script.

             CommExt /s1234 uc:1

B.2.2: Application Command Line Method

Tells the CommunicatorPQA® software to make a connection and display a particular 

application screen.

/c (additional arguments with a space between each argument)

Example 1: Nexus® device with address 2 on network with IP address 135.15.173.79 

using Modbus TCP Start on device status screen.

            CommExt /c cm:1 ad:2 pr:3 ip:135.15.173.12 np:502

Example 2: Nexus® device with address 2 at remote location with Phone Number 

555-545-5110 using Modbus ASCII Start on device status screen.

            CommExt /c cm:0 ad:2 pr:1 cp:3 BR:3 um:1 pn:555-545-5110

cm: Connect Mode

0 Serial Port

1 Network

If left out of command line, Serial Port is assumed.

ec: Echo Mode

0 Off

1 On (When the Shark® meter's Fiber Optic Option Card’s

          switch is set to Echo On)

If left out of command line, defaults to 0. Used when selected

connection mode is Serial Port, with a Fiber Optic Option Card in

a Shark® meter.

ad: Address

1 - 247

If left out of command line, Address 1 is assumed.
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nm: Network Mode

0 One IP Address for n Devices

If left out of command line, 0 is assumed.

pr: Protocol

0 Modbus RTU

1 Modbus ASCII

2 DNP3 (Not Supported)

3 Modbus TCP

4 EI Protocol

If left out of command line, Modbus RTU is assumed.

ip: IP Address or Host Name

xxx.xxx.xxx.xxx or 1 - 16 Alphanumeric characters with no

spaces.

If left out of command line, error is assumed.

np: Network Port

502 Open Modbus (Modbus TCP)

If left out of command line, Port 502 is assumed.

cp: Com Port

1 - 98

If left out of command line, Com Port 1 is assumed.

br: Baud Rate

0 1200

1 2400

2 4800
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3 9600

4 19200

5 38400

6 57600

7 115200

If left out of command line, Baud Rate of 9600 is assumed.

um: Use Modem

0 No

1 Yes

If left out, No modem is selected.

pn: Phone Number

Use No Spaces. User-defined Phone Number of the Remote 

Modem.

ms: Modem Setup String

User-defined Setup String (if the originate modem has been 

used for another program and needs to be reset).

dc: Data Switch Connect String for Modem

User-defined Data Switch String to connect to Remote Modem. 

  Check with the device’s manual to create the Data Switch String

appropriate for the device.

Typical characters used with CommunicatorPQA® software

are:

,                (pause one second)

      (escape sequence or switch to command mode)

PTnn         (command) (number 01-16)

Enter         (<CR> ASCII character 13)
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dd: Data Switch Disconnect String for Modem

User-defined.

ss: Start screen

0 Device Status

1 Phasors Diagram (Nexus® meters Only)

2 Instantaneous Polling

3 Poll All (Nexus® meters Only)

4 Poll Max/Min

5 Poll Power Readings (Use 19 to 22 for Nexus® meters)

6 Poll Harmonics

7 Poll Internal Inputs

8 Poll Multiple Devices (Nexus® meters Only)

9 Poll Pulse Accumulations (Nexus® meters Only)

10 Poll Limit Status

11 Poll Time of Use Readings (Nexus® meters Only)

12 Poll Nexus® External Digital Inputs (Nexus® meters Only)

13 Poll Nexus® External Analog Inputs (Nexus® meters Only)

14 Poll Nexus® ElectroLogicTM Status (Nexus® meters Only)

15 Poll Relay Control

16 Poll Readings with DDE Service (Nexus® meters Only)

17 Poll Log Statistics

18 Log Retrieval Screen

19 Poll Power and Demand (Nexus® meters Only)
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20 Poll Energy (Nexus® meters Only)

21 Poll Power Only (CommunicatorPQA® Application Only,

Nexus® meters Only)

22 Poll Demand Only (CommunicatorPQA® Application Only,

Nexus® meters Only)

23 Poll Nexus® meter Time

24 Poll Shark® meter Volts and Current (Shark® 100 meter)

25 Poll Shark® meter Power and Energy (Shark® 100 meter)

26 Poll Shark® meter Phasor Diagram (Shark® 100 meter)

30 Device Status (Shark® 200 meter)

31 Phasor Diagram (Shark® 200 meter)

32 Instantaneous Polling (Shark® 200 meter)

33 Poll Max/Min (Shark® 200 meter)

34 Poll Power and Energy (Shark® 200 meter)

35 THD/Harmonics (Shark® 200 meter)

36 Average Demand (Shark® 200 meter)

37 Option Card Accumulators (Shark® 200 meter)

39 Option Card Digital Input Status (Shark® 200 meter)

40 Limits Status Screen (Shark® 200 meter)

41 Symmetrical Components (Shark® 200 meter)

42 Real Time Trends (Shark® 200 meter)

43 Shark Time (Shark® 200 meter)

44 Relay Control (Shark® 200 meter)

45 Option Card Status (Shark® 200 meter)
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46 Device Information (Shark® 200 meter)

47 Device Profile (Shark® 200 meter)

48 Log Status/Retrieval (Shark 200)

NOTES:

•   If the number is undefined, i.e. less than 0 or greater than 48, the Communica-

torPQA® application will automatically shut down.

• If left out of command line, Start screen is Device Status.

dn: Device Name

Must use period as placeholder for a space.

ln: Location Name

Must use period as placeholder for a space.

vm: View Mode

0 Normal

1 Hide Main Window and Exit Program upon closing of Start

 Screen. 

CommunicatorPQA® application acts as a plug-in for integrating

with third party software.

If left out, Normal is the View Mode.

am: Answer Modem

0 No

1 Open Port. Wait for Modem to ring and attempt to answer

 Modem if ringing.

If left out, software does not answer Modem.

dr: Dial Out Receive Call

0 No
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1 After software successfully answers the call, it looks for a 

reason of call code. Based on the code, Software performs 

automated functions. Upon completion of all functions, software

places the Remote Modem into command mode, sends an

acknowledgment and hangs up. Software closes the Communi-

cations Port and exits software.

mp: Modem Password

Must use period as placeholder for a space.

dt: User Defined DDE Topic Name for Start Screen 16

Topic Name must contain no spaces.

If left out, Meter Designation is used as Topic.

lr: Retrieve Log Number (Nexus® meters only)

1 Historical Log 1

2 Historical Log 2

3 Both 1 and 2
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The table below shows how to select the additional log combinations.

Use this table in the following way:

a. Put a 1 in column of the log(s) you want to retrieve, a 0 in the column of 

any unwanted logs that are between the selected logs.

In the example above, Historical Log 1 and the Limit Log are selected. A ‘1’ 

is placed in each of their columns. Since Historical Log 2 is between them 

and is not selected a ‘0’ is placed in its column.

b. Convert the Binary number to Decimal. 

In this example: 101(binary) = 5(decimal) = 5

Log to 
Retrieve Bits

 15 14 13 12 11 10  9 8 7 6 5 4 3 2 1 0

Historical 
Log 1 

x

Historical 
Log 2 

x

Limit Log x

PQ/Wave-
form Log 

x

Digital 
Input Log 

x

Digital Out-
put Log 

x

Reserved 
(Max/Min 
Log) 

x

Flicker x

System of 
Events Log 

x

Reset Log 
(Disabled) 

x

EN50160 x

Binary 
Number, 
e.g. 

1 0  1
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c. Put the decimal number in the lr command line. 

In this example, you would use the number 5 to retrieve Historical Log 1 

and the Limit Log.

B.3: Command Line Arguments - Dash Commands 

B.3.1: Command Line Reference

    --connect [connstr] 

    --stay_open

    --retrieve_log [log],[log]

    --username [username]

    --password [password]

    --start_screen [start screen]

B.3.2: Dash Commands

•   If dash commands are used, then slash commands are not processed (and will 

become arguments to the dash commands). Dash commands separate each 

command by the '--', with each argument (separated by spaces) until the next 

command belonging to the previous command.

•   Dash commands do support quoting arguments. So, if an argument has spaces 

(e.g., a filename), you can put quotation marks around it so that it will be pro-

cessed as one argument.

--connect [connstr]: Connect with the specified parameters. If no further commands 

are specified, include --stay_open to prevent the software from automatically shutting 

down.

    [connstr]: The connection string to describe how to connect.

mn://[host]{:[port],[addr],[protocol]} 

Modbus over Network connection

   [host]: The IP address to connect to. May be a dotted quad (1.2.3.4), or an Internet

   address (www.mynexusmeter.com).
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   [port]: The TCP port to connect to; defaults to 502.

   [addr]: The Modbus device address to connect to; must be between 1 and 247.

   [protocol]: The Modbus protocol to use; defaults to TCP. Valid options are:

         TCP: Modbus TCP

         ASCII: Modbus ASCII

         RTU: Modbus RTU

   For example:

   mn://172.20.166.98:502,21,TCP

ms://[com]{:[baud],[databit],[parity],[stopbit],[addr],[protocol]}

Modbus over Serial connection

   [com]: The com port to connect to; may be the name (COM7) or just the number

   (7).

   [baud]: The baud rate to use to connect with; default is 57600.

   [addr]: The Modbus device address to connect to; must be between 1 and 247.

   [protocol]: The Modbus protocol to use; defaults to RTU. Valid options are:

         TCP: Modbus TCP

         ASCII: Modbus ASCII

         RTU: Modbus RTU

Specify a blank argument to use the default. For example: 

ms://COM7:57600,,,,10,RTU

--silent: Prevents warning and error messages from being displayed (when possible).

--stay_open: By default, the software shuts down after all commands are executed. 

This command prevents that from happening, allowing further action by the user.

--retrieve_log: "[log1],[log2], ..., [logn]" 

   Valid Log Names to be used in the command line args:



     Doc#    E107707                                                 B - 12

B: Command Line Arguments

        Historical Log 1:    "INT1" or "INTERVAL_1"

        Historical Log 2:    "INT2" or "INTERVAL_2"

        Historical Log 3:    "INT3" or "INTERVAL_3"

        Historical Log 4:    "INT4" or "INTERVAL_4"

        Historical Log 5:    "INT5" or "INTERVAL_5"

        Historical Log 6:    "INT6" or "INTERVAL_6"

        Historical Log 7:    "INT7" or "INTERVAL_7"

        Historical Log 8:        "INT8" or "INTERVAL_8"

        Event Triggered Log:  "EVTT" or "EVENT_TRIGGERED"

        Limit/Alarm:             "LIMT" or "LIMIT_LOG"

        Digital Input:           "DIGI" or "DIGITAL_INPUT"

        Digital Output:        "DIGO" or "DIGITAL_OUTPUT"

        Flicker:                    "FLIC" or "FLICKER"

        Waveform:               "WAVE" or "WAVEFORM"

        Power Quality:          "PQ" or "PQ_LOG"

        System Event:          "SYS" or "SYSTEM_EVENT"

        Transient:                 "TRAN" or "TRANSIENT"

        EN50160:             "EN50160"

For example: 

--connect mn://172.20.167.39 --retrieve_log "INTERVAL_1, INTERVAL_2"

--username [username]: Set the username for log retrieval to the value in [user-

name]; by default it is blank.

--password [password]: Set the password for log retrieval to the value in [password]; 

by default it is blank.
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--start_screen [start screen]: Starts the program on the screen in [start screen].

   Valid Start Screen Names to be used in the command line args:

   For Nexus®, Shark® 200, Shark® 100, and MP200 Devices:   

   For Nexus® Devices:

Screen [Start Screen]

Device Status Screen:  device_status

Phasor Screen: phasor_diagram

Polling Screen: inst_polling

Demand Screen: demand

Energy Screen: energy

Alarm Status Screen: alarm_status

Device Profile Screen: device_profile

Firmware Update Screen: firmware_update

Screen [Start Screen]

Log Status Screen: log_status

Harmonics Screen: harmonics

Retrieve Time Screen: retrieve_time

Power Screen: power

Max and Min Values Screen: max_and_min

Pulse Accumulations Screen: pulse_accumulations

Short Term Max and Min Values Screen: short_term_max_and_min

Symmetrical Components Screen: symmetrical_components

Flicker Screen: flicker
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   For Shark® 200 Devices:

   For Shark® 100 Devices:

   For MP200TM Devices:

Screen [Start Screen]

Log Status Screen: log_status

Harmonics Screen: harmonics

Retrieve Time Screen: retrieve_time

Power Screen: power

Max and Min Values Screen: max_and_min

Pulse Accumulations Screen: pulse_accumulations

Short Term Max and Min Values Screen: short_term_max_and_min

Symmetrical Components Screen: symmetrical_components

Real Time Trends Screen: real_time_trends

Screen [Start Screen]

Power Screen: power

Real Time Trends Screen: real_time_trends

Screen [Start Screen]

Log Status Screen: log_status

Retrieve Time Screen: retrieve_time

Max and Min Values Screen: max_and_min

Pulse Accumulations Screen: pulse_accumulations

Short Term Max and Min Values Screen: short_term_max_and_min



     Doc#    E107707                                                 C - 1

C: Ethernet Network Error Codes

C: Ethernet Network Error Codes 

C.1: Network Error Codes Reported by Any Software That Uses 
       Ethernet (Including CommunicatorPQA® Software)

Error# 10004: "Interrupted system call."

Error# 10009: "Bad file number."

Error# 10013: "Permission Denied."

Error# 10014: "Bad Address."

Error# 10022: "Invalid Argument."

Error# 10024: "Too many open files."

Error# 10035: "Operation would block."

Error# 10036: "Operation now in progress."

Error# 10037: "Operation already in progress."

Error# 10038: "Socket operation on nonsocket."

Error# 10039: "Destination address required."

Error# 10040: "Message too long."

Error# 10041: "Protocol wrong type for socket."

Error# 10042: "Protocol not available."

Error# 10043: "Protocol not supported."

Error# 10044: "Socket type not supported."

Error# 10045: "Operation not supported on socket."

Error# 10046: "Protocol family not supported."

Error# 10047: "Address family not supported by protocol family."

Error# 10048: "Address already in use."
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Error# 10049: "Can't assign requested address."

Error# 10050: "Network is down."

Error# 10051: "Network is unreachable."

Error# 10052: "Network dropped connection."

Error# 10053: "Software caused connection abort."

Error# 10054: "Connection reset by peer."

Error# 10055: "No buffer space available."

Error# 10056: "Socket is already connected."

Error# 10057: "Socket is not connected."

Error# 10058: "Can't send after socket shutdown."

Error# 10059: "Too many references: can't splice."

Error# 10060: "Connection timed out."

Error# 10061: "Connection refused."

Error# 10062: "Too many levels of symbolic links."

Error# 10063: "File name too long."

Error# 10064: "Host is down."

Error# 10065: "No route to host."

Error# 10066: "Directory not empty."

Error# 10067: "Too many processes."

Error# 10068: "Too many users."

Error# 10069: "Disk quota exceeded."

Error# 10070: "Stale NFS file handle."

Error# 10071: "Too many levels of remote in path."
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Error# 10091: "Network subsystem is unusable."

Error# 10092: "Winsock DLL cannot support this application."

Error# 10093: "Winsock not initialized."

Error# 10101: "Disconnect."

Error# 11001: "Host not found."

Error# 11002: "Nonauthoritative host not found."

Error# 11003: "Nonrecoverable error."

Error# 11004: "Valid name, no data record of requested type."
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D: TFTP Server Program Setup 
NOTE: The Advanced Settings screen for the Nexus® 1252/1262/1272 meters’ 

Network card has a TFTP option you can use to update the card’s firmware. However, 

you may want to use an alternate method, e.g., if the device is “stuck” in Boot mode.

A free shareware TFTP (Trivial File Transfer Protocol) server program known as 

tftpd32 is available to customers to use for updating firmware for the INP100/INP200 

Ethernet card for Nexus® 12xx meters. The program can be downloaded (for no 

charge) online at http://tftpd32.jounin.net/tftpd32_download.html.

The setup requirements for the application are:

•   Windows® Operating System

•   A working Ethernet card with a valid IP Address

•   Winzip software (only if the Windows® Operating System does not open the zip file 

automatically)

1. Install the TFTPD32 application. You will see the screen below after the application 

has installed. Note that the Current Directory is the location of the TFTPD32 appli-

cation.

http://tftpd32.jounin.net/tftpd32_download.html
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2. Click the Settings tab at the bottom of the screen.

3. Be sure that ONLY TFTP Server is selected on this Global tab screen.
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4. Click the TFTP tab at the top of the screen. 

5. Shown above are the settings EIG recommends. The Base Directory is the location 

of the firmware files. You should create a new folder somewhere on your PC’s hard 

drive where you will store any INP100/INP200 firmware files and then Browse to 

locate that folder. In the example above, the folder created is called TFTPD32_Files 

and it was placed in the Tftpd32 folder in the Program Files directory. All firmware 

files for INP100/INP200 would be placed inside the 

C:\Program Files\Tftpd32\TFTP_Files folder before updating firmware.

6. Click OK to save the settings. 

7. You will see a message window informing you that you must restart the application 

to save the settings. Click OK.
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8. Make a serial connection between your PC and the meter.

9. Click Tools>Network Card Settings. You will see the screen shown below. 

10. Click the Connect button. This allows the software to send commands to the

  meter and Network card, causing the Network card to go into Boot mode. As a

  result, Network card Boot firmware information will be displayed in the screen in

  the Boot Version box, as shown in the example above.

2
1

3

4

5

6

7

Screen Elements:
1: Connect button
2: Boot Version box
3: Flash File Update Settings section
4: Write Settings button
5: Update Runtime/Update Boot buttons
6: Refresh button
7: OK button 
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11. When you see from the messages that the Network card is in Boot mode, enter 

the correct settings for the firmware file update using TFTP, in the Flash File Update 

Settings section.

12. Click the Write Settings button.

13. Connect an RJ45 cable from the PC to the Network card so that the Network card

  can access the TFTP server.

14. To update the Network card’s Boot firmware, click the Update Boot button; to

  update the Network card’s Runtime firmware, click the Update Runtime button.

15. The Network card will start the firmware update process. Click the Refresh button

  to retrieve the Network card’s firmware information again, to verify that the firm-

  ware version was updated properly.

16. Click OK to close this screen and allow the Network card to restart.
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E: Troubleshooting

E.1: Troubleshooting Using the Phasor Diagram

A Phasor diagram is a vector representation of the voltage and current angles of a 

three phase power system. By looking at the six channels of waveform in a phasor 

representation, you can obtain troubleshooting information to determine if the voltage 

and current inputs are wired properly. 

Generally, a Phasor diagram relies on Volts AN to be fixed at 0 degrees. Then, rotating 

clockwise, the next voltage is Volts BN, and thirdly Volts CN. Current is also repre-

sented on the Phasor diagram. If the current is leading, it is a capacitative load. If the 

current is lagging, it is an inductive load. For example, current influenced by motor 

loads is usually inductive.

To open the phasor diagram for the connected meter, either:

•   Click Real-Time Poll>Power Quality and Alarms>Phasors

•   Click the Phasors icon in the Icon Bar

Use the following phasor diagrams and their description as a guide.
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1. System: WYE Hookup with Unity Power Factor

This diagram shows an ideal WYE system, with voltage 120o apart, and current having 

a perfect resistive load.
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2. System: WYE Hookup with the VA and VB Swapped
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3. System: WYE Hookup - VA and VC Swapped
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4. System: WYE Hookup with IA and IB Swapped



     Doc#    E107707                                               E - 6

             E: Troubleshooting

5. System: WYE Hookup - Either the Hi and Low Swapped on all CTs 

or Generating Power
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6. System: Delta Hookup - Shark® or Nexus® Meter with 2 Voltage Settings
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7. System: Delta Hookup - Nexus® Meter with 3 Voltage Settings
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8. System: Delta Hookup - VA and VB Swapped
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9. System: Delta Hookup - VA and VC Swapped
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10. System: Delta Hookup - VA in C, VB in A, VC in B
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11. System: Delta Hookup - IA and IC Swapped
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12. System: Delta Hookup - Either all the CTs Swapped or Generating Power
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E.2: Optical Port Communication Problems

If you are having new communication problems with your Optical port reader, this 

may be due to software changes that were implemented for the Nexus® 1500/1500+ 

and Shark® 250/270 meters, to disable a modem from hanging up on a DTR change 

during log retrieval or meter configuration. You may encounter a problem with this fix, 

since the Optical port reader using DTR to determine the Inverted or Not Inverted 

mode.

To fix this issue, follow these instructions:

1. From the CommunicatorPQA® software’s Main screen, click View>Options to open 

the Options screen.

2. Click the Miscellaneous tab.

3. Check the box next to Disable the command to tell the modem not to hang up on 

DTR change. (By default, this box is un-checked).

4. Click OK (or Apply, if you are going to make other changes using the Options 

screen).
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E.3: Installation Error

If you see the following message when you are installing the CommunicatorPQA® 

application, the installation file is corrupt.

Click OK to close the message window and retrieve the software download file again 

from EIG’s website: https://www.electroind.com/products/communicatorpqa-power-

monitoring-software/.

https://www.electroind.com/products/communicatorpqa-power-monitoring-software/
https://www.electroind.com/products/communicatorpqa-power-monitoring-software/
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F: Landis + Gyr Custom Reports  

F.1: Overview

The MeterManagerPQA® application has a custom report function that was developed 

for use with the Landis + Gyr server. This appendix gives you instructions for using 

the custom reports feature. 

Custom reports are generated from the data logged by EIG meters and downloaded 

by the MeterManagerPQA® software. The report data can be formatted and scaled as 

needed for its use. The specific details of the reports are saved in report templates, 

which can be automatically generated on a set schedule. Once the report is gener-

ated, you can store it in a location local to the server or upload it to an SFTP server for 

secured, wider access.

There are three report types:

•  EMED - This is an energy summation usage report. It reports single values on a 

meter by meter basis.

•  CMEP - This is an interval data report. It reports on a meter by meter, channel by 

channel basis. It includes flags for each interval that indicate events such as day-

light savings time (DST), short or long energy intervals, or missing intervals. See 

F.8: Shark® 270 Meter CMEP Custom Report Interval Flags, on page F-28, for the 

flags used for the Shark® 270 meter’s CMEP custom report.

•  Events - This is the System Events report. It contains for each meter all events that 

occurred during the report's period (e.g., for the past 24 hours if the period is set 

as “daily”).

The following sections explain the process of setting up and generating custom 

reports.
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F.2: Step One: Configure the Meter’s Log Profile

To download the specific data you need for your EMED and CMEP reports, you must 

first configure the meters’ trending logs to retrieve the data channels (i.e., data fields) 

you need and to log them every 15 minutes, as required for the custom reports. (The 

Events report doesn’t need to be configured by you, since the report has a fixed 

format. See F.7: Shark® 270 Meter Logged Events, on page F-27 for the events 

logged for the Shark® 270 meter.)The chapters in this manual devoted to the individ-

ual meters contain detailed instructions on setting up the trending logs and their 

intervals. A basic example is given here for a Nexus® 1500+ meter. Refer to the links 

below to access the instructions for all EIG meters.

NOTE: The specific data fields that are available for the custom reports depend on the 

Landis + Gyr implementation for your meters/system. The data fields available for the 

Shark® 270 meter are listed in F.6: Shark® 270 Meter Available Data Channels, on 

page F-26.See you network administrator for the data fields available for other EIG 

meters.

Nexus® 1252 meter: 13.4: Trending Profile Settings, on page 13-71.

Nexus® 1262/1272 meter: 12.4: Trending Profile Settings, on page 12-92.

Nexus® 1450 meter: 27.4: Trending Profile Settings, on page 27-73.

Nexus® 1500+ meter: 11.4: Trending Profile Settings, on page 11-106.

Shark® 200/200S meter: 8.4: Trending Profiles Settings, on page 8-31.

Shark® 250 meter: 28.4: Logs, on page 28-66.

Shark® 270 meter: 26.4: Logs Setting, on page 26-79.

ST40 meter: 30.4: Logs, on page 30-29.

MP200TM Metering System: 10.4: Trending Profiles Settings, on page 10-24.
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1. From the Device Profile, open the log settings for one of the historical logs. See the 

example below.

2. Use the Group and Subgroup fields to display and locate the data channels you 

want to use in the report. To add a field to the report, click on it in the Selectable 

Items list and click Add. The data field will be moved to the Selected Items list. (If 

you want to remove an item from the Selected Items list, click on it and click 

Remove. It will be put back into the Selectable Items list.)

The and Remove buttonsAdd
let you move data channels into Selected Items. 

The data channels here will be logged. 

Click to set the interval for this log to
15 minutes.

The Group and Subgroup menus let you view available 
data channels in Selectable Items.
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3. When you have finished selecting data channels, click Set Interval.

4. Make sure the log you configured is set to a 15 minute logging interval. Click OK to 

close the Interval setting screen and then click OK to close the trending log screen.

5. Click Update Device to send the trending log settings to the meter.

F.3: Step 2 - Configure Demand Reset for the Meter

There are two ways to reset demand for custom reports. You can either set up auto-

matic demand reset using the meter’s Time of Use (TOU) profile, or you can manually 

reset demand using the CommunicatorPQA® application.

NOTE: Resetting demand may not be a requirement of your specific application. 

Consult your metering administrator if you are not sure if it is required.

F.3.1: Automatic Demand Reset (Nexus® 1450/1500+
            and Shark® 250/270 meters only)

1. From the meter’s Device Profile screen, click Revenue and Energy Settings>TOU.

2. Make sure the box is checked to enable TOU, then click OK to close the window and 

click Update Device to save any changes.
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3. Once the meter resets, click TOU Calendar, TOU Rate Configurator. See Chapter 15: 

Time of Use, on page 15-1 for detailed instructions for setting up TOU for your 

meter. The two settings you will need to make for demand reset are:

•  Select Self Read Mode

•  Under Billing Period, select the dates the resets should be performed on. 

NOTE: If specific (that is, non-recurring) dates are required, you will need to 

update the TOU billing period each year to set up those dates. 

4. Save the TOU settings and update the meter.

F.3.2: Manual Demand Reset

1. Connect to your meter through the CommunciatorPQA® application and select 

Tools > Reset Device Information. 

The screen shown here is from a Nexus® 1500+ meter - the Reset screen for your 

meter may look a bit different. 

2. Select Reset Max/Min and Demand (or Reset Max/Min Blocks) and click OK (or 

Reset), depending on your screen.

NOTE: If Reset Max/Min Blocks is disabled, TOU may be enabled, or security may 

not allow you to reset that item. Check the TOU profile, and disable as necessary.

3. To confirm that the demand has been reset, from the CommunicatorPQA® main 

screen click Real-Time Poll > Real Time Readings > Poll Max and Min Readings. 

Scroll to the Demand Last Reset field, and verify that the reset occurred when you 

sent the Demand Reset command.
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F.4: Step 3 - Configure Meter Settings

Custom reports use meter-specific fields, such as ESIID and Meter ID, which are not 

available directly from the meter's programmable settings. To configure these set-

tings:

1. Open MeterManagerPQA® by selecting it from the CommunicatorPQA® application 

icon bar. 

2. From the Meter List, click on the meter you are making settings for and then click 

Configure Meter Scripts.

2. Click Configure Meter Scripts.

1. Click on meter.
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3. Click the Meter Config tab.

4. Add the user data settings you need for the custom reports and click Save. You can 

then select the new data settings from the Fields configuration in the template - 

see F.5.1: Create a New Report Template, on page F-12.

1. Click Meter Config tab.

2. Cick Add.
3. Enter the field you 
    need and its value, 

necessary.

4. Click 
    Save.

     as  
    Repeat steps 2 and 3 
    if applicable. 
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F.5: Step 4 - Configure Custom Report Templates 

You access the Custom Reports feature from the MeterManagerPQA® screen. See 

Chapter 18: MeterManagerPQA® Application, on page 18-1 for full instructions on 

using the MeterManagerPQA® application. 

1. From the top of the Meter Manager Monitor screen, click Tools>Config-

ure>Reports>Landis + Gyr Custom Report Templates.

2. You will see the Custom Report List screen.This screen gives you access to all 

custom report functions.

Menu of Actions List of Existing Templates
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•  Any already created report templates are listed in the screen, with their name, 

type of report, report period, number of reports, and the date and time they 

were last generated.

•  The menu on the left side of the screen lets you perform the following actions:

• New Template - create a new template (see F.5.1: Create a New Report 

Template, on page F-12).

• Clone Template - click on a template in the list and click Clone Template 

to open a copy of the selected template in the Edit Template screen. 

Follow the instructions in F.5.1: Create a New Report Template, on 

page F-12 to make any changes and then save the cloned template with a 

new name.

• Edit Template - click on a template in the list and click Edit Template to 

open the selected template in the Edit Template screen. Follow the 

instructions in F.5.1: Create a New Report Template, on page F-12 to 

make any changes. Note that if you double-click on one of the templates 

in the list, the Edit Template screen opens with that template.

• Remove Template - click on a template in the list and click Remove 

Template to delete the selected template and remove it from the list.

Note that the template history will also be deleted.
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• View History - click to view the report history of the selected template. 

See the example screen, below.

• If you double-click on one of the reports and it is a local file (a file 

stored in a location the local server can access), the file will open. 
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• Click on a date and then click Meter Last Times to open the screen 

shown below.

- This screen is display only. It shows the meters in this template and

   the last date their data was reported. This will generally be the same

   as the most recent date in the template history, but if the meter was

   offline, for example, the date may be different.

• Preview - click to view the report formatting with placeholder (i.e., not 

real) data. See the example screen below. 

Enlarge the screen to view all of the fields.

• Trigger Generation - click to manually trigger generation of the selected 

template.
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F.5.1: Create a New Report Template

The instructions in this section are for creating a new template, but the steps are the 

same for editing an existing template, except that the template will already have set-

tings, which you can then make changes to.

1. Click on the New Template icon in the menu on the left of the Custom Report List 

screen.

2. The Menu of Actions on the left side of the screen gives you the following options:

•  New Template - to create another new custom report template, click this icon. 

Remember to save the first report template you created before creating another 

one.

•  Save Template - click to save a template you created.
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•  Preview Template - same action as for the Custom Reports List screen - see F.5: 

Step 4 - Configure Custom Report Templates, on page F-8.

•  Import Template - click to locate a custom report template file that was previ-

ously exported and bring its settings into the new report template. You can then 

make any changes you want and save the new template with a different name.

•  Export Template - click to export the current template to a file on the local com-

puter. 

•  Exit - click to return to the Custom Report List screen.

3. Make the following settings:

a. Template Name - enter a name for the new template.

b. Schedule - Click edit to the right of the Schedule field. 

- Click on the Period menu to choose the report period.

   The choices are:

• Incremental - select to generate a report from the last time generated 

to the newest time available, for the meters in the report.

• Monthly - select to generate a report on each calendar month.
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• Weekly - select to generate a report on each calendar week, beginning 

on Sunday.

• Daily - select to generate a report for each day, starting at the specified 

time.

• Hourly - select to generate a report for a configurable number of hours.

- Click on the Start From menu to open a calendar that lets you select

   the date when the first report should be generated. 

c. Report Type - click on the menu to choose from EMED, CMEP, or SystemEvents 

for this report (see F.1: Overview, on page F-1 for an explanation of report 

types).
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d. Click the Edit button to the right of the Storage field to set up storage accessible 

to the local server or to upload via SFTP.

- Name Override lets you specify a dynamic name for the report, i.e., a name

   that will change depending on the values at the time the report is generated,

   e.g., the current date. To set up a dynamic name, click Insert Field to the right

   of Name Override.

- Click on a field to add it to the Name Override. You can repeat this step to add

   a second field, or all three fields, to the report title.

Check box to save report on local machine

Check box to save files on an SFTP server 

Browse to select the location for the file

Enter the SFTP server url Enter username
and passwordEnter the SFTP port

Click OK

See instructions below

See instructions below
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e. Click Edit to the right of the Other Options field to open the screen below.

- Check the Lock to Period box to create additional rows if the channel data

   exceeds the period - this applies to reports set up with channel rows.

- Check the Skip Lines with No Data box to eliminate report lines with no data.

- From the pull-down menu, select the number of minutes the system

  should wait for the meter data retrieval to finish, when a report is due. In the

  example screen, the setting of 120 will cause the report to be up to two hours

  later than scheduled. 

f. Click OK if you have made selections on this screen or click Cancel if you do not 

want to change anything.



     Doc#    E107707                                               F-17

            F: Landis + Gyr Custom Reports

g. Click Edit above the Meter/Channels box to add or delete meters from the report.

- If you are creating a report template for an EMED or System Events report 

   type, you will see the screen shown below. 

- If you are creating a CMEP report type, the screen shown also contains data

   channel settings for the meter.
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- If this is a new report, there won’t be any meters listed. Click Add Meter.

- The available meters are listed, showing the meter name, type (i.e., model),

   connection details, and online status. To select a meter, click on it.
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- Note that you are actually selecting the meter’s log, which contains the data 

   channels you want in the report. The log location is listed at the bottom of the

   screen. If you want to use this log, click Select. 

- The Pick Meter to Open Log screen will close and you will see the Custom

   Report Meters screen. You can add another meter or remove meters. When

   you are done, click Exit to close the screen.

- For a CMEP report type template, once you select the meter and its log file,

   you can add data channels for the meter. These data channels can be selected

   from the data channels available in the log file. To add a data channel, click on

   a meter in the list and click Add/Edit Channel.
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- The available data channels depend on the settings you made for the meter’s

   historical log.

- To add a channel, click on it in the Channels for Meter list and click Add. (If you

   need to remove a channel you added, click on it in the Configured Channels

   list and click Remove.)

- When you are done adding channels, click OK. The Custom Reports and 

   Channels screen will now show the additional channels for the meter.
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- The data channel will be listed along with its label. You can specify any label

   you want. This label will be displayed as the channel name in the report. You

   can add scaling and formatting settings by clicking in the Scale and Format

   fields for the channel. If you don’t want to apply scale or format settings, just

   leave these fields blank.

- You can continue to add channels and meters. To edit a channel, click on the

   channel in the list and click Add/Edit Channel. (To remove a channel, click

   Remove Channel.)

- When you are done adding meters and channels, click Exit. The meters and

   channels will be listed in the Add New Custom Report Template screen.



     Doc#    E107707                                               F-22

            F: Landis + Gyr Custom Reports

• The report fields, i.e., report columns, that are listed in the Create New 

Report Template screen are determined by the report type you selected. 

If you want to add or delete a report field, click Edit above the Fields 

box.
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NOTE: If you select SystemEvents as the report type, there are no 

fields listed, since its report fields are fixed. 

- To add a field to the report template, click Add Field.

Click to select Field for report template
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- The possible field types are listed in the Fields submenu. Click on the

   type you are adding.

- After you select the field, you will enter the Label, which will be the 

   column header for that field in the report template. Other than Label,

   each field type has specific settings. The field types and their settings

   are listed, below.

• Fixed – Specifies a fixed value to always use in the report, such as 

the Record Type EMED01 value. The fixed value can then be entered at 

the bottom, in the Value field.

• Meter Setting – Specifies a meter setting to be used in the report, 

such as ESIID. This will pull the matching value from each meter’s 

configuration - see F.2: Step One: Configure the Meter’s Log Profile, on 

page F-2.

• First/Last/Max Channel Value – The first, last, or maximum value 

for the specified data channel in the time range of the report. For EMED 

reports, the channel is specified. For CMEP reports, the channel comes 

from the channel that was configured in the Meters/Channels list.

• First/Last/Max Channel Time – The time of the first, last, or maxi-

mum value for the specified channel in the time range of the report. For 

EMED reports, the channel is specified. For CMEP reports, the channel 

comes from the channel that was configured in the Meters/Channels list.
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• Channel Name (CMEP report type only) The channel name configured 

for the channel in the Meters/Channels list.

• Count of Log Data Items (CMEP report type only) - The number of 

data items for the channel in the report.

• Interval of Log Data (CMEP report type only) – The interval between 

data items in the report.

• Report Start/End Time – The start and end time of the report. Note 

that this is the report’s time range, not the time of an individual meter’s 

data. If the data reported for a meter is from before or after the report’s 

time range and you want to know the specific time range of the meter’s 

data, select the First/Last Channel Time field type, instead.

• Log Data (CMEP report type only)– The log data for the channel, fixed 

to a 15 minute interval. Note that this is an “expanding column.” This 

means that, if necessary, any field after this field will be pushed over, 

and this field will fill the report with as many columns as necessary to 

represent all interval data for all channels.

                - The Edit Fields screen also lets you remove fields, edit existing fields, clear

                  all the fields in the list, and move the listed fields up and down, which will

                  change the location of the field in the report. Use the icons on the left side

                 of the screen to perform these functions. When you are finished with the

                 Edit Fields screen, click Exit. Any changes you made to the fields will be

                 shown in the Add New Custom Report Template screen.

8. Click Save Template from the left side of the screen to save the new report tem-

plate. 
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F.6: Shark® 270 Meter Available Data Channels

As mentioned in F.2: Step One: Configure the Meter’s Log Profile, on page F-2, the 

data channels that will be used for the custom reports depend on the Landis +/ Gyr 

implementation. The data channels used by the Shark® 270 meter are already deter-

mined. They are shown in the table below.

Group Log Channel Custom Report Channel
Measured Values : Readings Voltage A-N Voltage A-N
Measured Values : Readings Voltage B-N Voltage B-N
Measured Values : Readings Voltage C-N Voltage C-N
Measured Values : Readings Current A Current A
Measured Values : Readings Current B Current B
Measured Values : Readings Current C Current C
Energy : Scaled Energy in Interval Wh Received Energy in Interval: Wh Q1+4
Energy : Scaled Energy in Interval Wh Delivered Energy in Interval: Wh Q2+3
Energy : Scaled Energy in Interval VARh Received Energy in Interval: VARh Q1+2
Energy : Scaled Energy in Interval VAh Total Energy in Interval: VAh Q1+2+3+4
Energy : Scaled Energy Wh Received Energy: Wh Q1+4
Energy : Scaled Energy Wh Delivered Energy: Wh Q2+3
Energy : Scaled Energy VARh Received Energy: VARh Q1+2
Energy : Scaled Energy VAh Total Energy: VAh Q1+2+3+4
Max/Min Demand : Voltage max in the Interval V A-N Short Term Max Short Term Interval: Voltage A-N 

Max
Max/Min Demand : Voltage max in the Interval V B-N Short Term Max Short Term Interval: Voltage B-N 

Max
Max/Min Demand : Voltage max in the Interval V C-N Short Term Max Short Term Interval: Voltage C-N 

Max
Average Demand : Cumulative Demand Watts Delivered Cumulative Demand: Wh Q1+4
Average Demand : Demand Received Watts 3-Ph Avg Demand: Positive Watts
Average Demand : Demand Delivered Watts 3-Ph Avg Demand: Negative Watts
Meter Status Max/Min Demand Reset 

Counter
Demand: Reset Count
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F.7: Shark® 270 Meter Logged Events 

As mentioned in F.2: Step One: Configure the Meter’s Log Profile, on page F-2, the 

Events custom report is configured to accept events that the meter automatically logs 

in its System Events log. The events for the Shark® 270 meter Events custom report 

are shown in the following table.

Group Event Category 
ID

startup Meter Runtime Started 0
Default Settings Applied 6

log Log Reset 3
clock Meter Clock Set 2

DST Clock Set 2
Clock Sync Failed 2
Clock Sync Resumed 2

resets Max/Min Reset 3
Energy Reset 3
Accumulators Reset 3
Demand Reset 3
TOU Reset 3

settings Security Settings Edited 10
V-Switch Changed 4
Programmable Settings Changed 4

boot Device Exited to Boot 0
test mode Test-Mode Activated 7

Test-Mode Exited 7
Preset Energy Save 7
Preset Energy Save Failure 7

demand Demand Deferral Inactive 9
Demand Deferral Active 9

security User Login 10
User Logout 10
Secure Action Denied 10
Security Enabled 10
Security Disabled 10
User Login Failed 10
Sealing Switch Enabled 10
Sealing Switch Disabled 10
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F.8: Shark® 270 Meter CMEP Custom Report Interval
          Flags

As mentioned in F.1: Overview, on page F-1, the CMEP custom report contains flags 

for specific situations, such as DST. The CMEP flags for the Shark® 270 meter are 

listed below.

•  Common Status, bitmask flags, high nibble

•  0x00: OK

•  0x01: DST - DST was in effect for this interval.

•  0x04: Clock set forwards

•  0x08: Clock set backwards

• Channel Status, enum, low nibble

•  0x00: OK

•  0x02: Short interval - Flag that the interval was shorter.

•  0x03: Long interval - Flag that the interval was longer.

•  0x04: Missing interval - No data is available for this interval.
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G: Migrating a CommunicatorPQA® Installation 

G.1: Overview

If you are using CommunicatorPQA® primarily for general polling or meter configura-

tion, it may not be necessary to migrate your installation when installing Communica-

torPQA® on a new server. However, EIG recommends you follow the procedure in this 

appendix to migrate your CommunicatorPQA® system to the new server in the fol-

lowing instances:

•  You have custom settings, for example ReportExporter, meter passwords, custom 

logs that are set to auto retrieve, time sync, or complex retrieval schedules.

•  You have large meter lists in MeterManagerPQA®.

•  You need to retain meter log data for longer then the meter’s internal storage 

allows.

•  You are using the EnergyReporterPQATM application.

To migrate CommunicatorPQA® from one server to another involves transferring 

meter log databases, application settings, and the PostgreSQL database. 

•  Meter Log Databases - These files store the logs retrieved from the meters. They 

are the most important files to transfer if you want to keep more log data than 

what is stored in your meters. If you only need the recent meter log data that is 

still in the meter, you do not need to transfer these databases. 

•  PostgreSQL Database - This database stores the MeterManagerPQA® and Ener-

gyReporterPQATM settings and data. It will need to be transferred to retain them. If 

you are not using any features of MeterManagerPQA® or EnergyReporterPQATM, the 

PostgreSQL database does not need to be transferred.

•  Application Settings - Application settings such as paths need to be transferred 

manually, and revised as appropriate for the new server. This procedure lists the 

application settings to check when performing a migration.

NOTE: This process does not migrate all data, and will not include debug information 

or collected statistics. Only the major data, such as meter logs, EnergyReporterPQATM 

data, and settings, will be transferred.
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G.2: Preliminary Steps

Before you begin the migration procedure, follow these steps:

1. Ensure there is sufficient hard drive space.

•  When using EnergyReporterPQATM, exporting the PostgreSQL databases creates 

very large temp files, which are stored on the Windows system drive (C:/). 

While these temp files will be deleted automatically at the end of the export, 

they can equal the size of the PostgreSQL database. The export will fail if there 

is insufficient space on the drive. Make sure you clear extra space before begin-

ning the procedure and minimize the number of running applications.

2. Stop usage of the system.

•  To ensure the integrity of the system transferred, it is best to minimize usage of 

the old server before beginning the migration. This includes logging off users 

and stopping automatic retrievals. This will ensure a consistent system and 

maximize resources during the migration.

3. Check the new system.

•  Always make sure the new installation meets the requirements of running a 

CommunicatorPQA® system before beginning the transfer (see 1.2: Installation 

Requirements, on page 1-3). Pay special attention to recommended disk space, 

as the disk space used will often quickly increase immediately after the migra-

tion, as CommunicatorPQA® updates settings and data for the new system. EIG 

also recommends that you do not use MeterManagerPQA® and EnergyReporter-

PQATM on a system shared with other high usage applications, as this will impact 

the performance of the CommunicatorPQA® system.

4. Make sure you have a license for the new server.

•  Make sure you have an EIG software Enterprise or Professional license before 

beginning your migration. If you have an Enterprise license, activate it by log-

ging in to EnergyPQA® via MeterManagerPQA®, i.e., clicking the Cloud icon 

from the MeterManagerPQA® screen (see 18.10: Scripts, on page 18-112). If 

you have a Professional license, contact Sales at Electro Industries (sales@elec-

troind.com) to determine the best way to license your new server.
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5. Make sure you have admin rights on both the old and new servers.

•  Some of the actions required on both the old server and the new one require 

starting/stopping services and configuring restricted files. Make sure you either 

have, or have access to, admin rights during the migration process.

G.3: Procedure

Follow this migration procedure.

1. Install the software on the new server:

a. Retrieve the latest version of CommunicatorPQA® software from electroind.com 

and install it on the new server (https://www.electroind.com/products/commu-

nicatorpqa-power-monitoring-software/).

b. Enter your license information and ensure that CommunicatorPQA® is activated 

properly (i.e., that your license is accepted). This is important, since you need 

MeterManagerPQA® software to transfer the old settings. (Note that the 

unlicensed version of the CommunicatorPQA® application does not have 

MeterManagerPQA®.)

2. Copy over software settings. Most settings for MeterManagerPQA® and EnergyRe-

porterPQATM are stored in the PostgreSQL database, but some rely on local configu-

ration files. Before transferring the data, copy over the settings for the various 

applications. Following are some common settings to transfer:

•  EnergyReporterPQATM report path - Configure the EnergyReporterPQATM report 

path in EnergyReporter Settings Editor>Options, if you need to create a custom 

path on the server - see the EnergyReporterPQATM User Manual for instructions. 

You can download the manual from https://www.electroind.com/products/ener-

gyreporterpqa-utility-billing-software/).

•  CommunicatorPQA® settings - Most of the CommunicatorPQA® settings can be 

safely left as their default values, but a few features need to be enabled on the 

new server, if you will be using them - specifically, the log retrieval settings, 

communications logging, and extra report generation (such as PQDIF and COM-

TRADE). These can be reviewed in the CommunicatorPQA Tools>Options screen 

- see 20.1.20: 4GLTE Cell Modem Status (Shark® 270 Meter), on page 20-58. 

https://www.electroind.com/products/energyreporterpqa-utility-billing-software/
https://www.electroind.com/products/energyreporterpqa-utility-billing-software/
https://www.electroind.com/products/communicatorpqa-power-monitoring-software/
https://www.electroind.com/products/communicatorpqa-power-monitoring-software/
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IMPORTANT! Do not configure the retrieved logs or archived logs’ paths 

through the CommunicatorPQA® Options screens, as this can result in 

discrepancies between manual and automatic log retrieval.

3. Stop all meter retrievals on the old server. 

•  Before transferring meter log data or PostgreSQL data, stop the MeterManager-

PQA® service (see 18.14: Service Control, on page 18-165 for instructions on 

doing this) and make sure all other users are logged out. This ensures that the 

databases are not being modified during the migration process.

4. Export the PostgreSQL database. 

•  To export the PostgreSQL database you only need to run the pg_tools.exe 

application. This application is available in the MeterManagerPQA® application 

directory:

C:\Program Files (x86\Electro Industries\MeterManager\pg_tools.exe. 

See the screen, below.

a. When you run the application, you will be asked where to store the archive 

file (b). Make sure there is enough space to store multiple GB, as this file 

can be very large on some systems.

     IMPORTANT! Because you are retrieving multiple meters’ log databases, this can

     be an extremely large download. EIG recommends that you download files in

     stages, using the filter shown in the screen shown below (a).

(a) (b)
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b. Pg_tools will then export all the data from the database and create the 

archive file. You can then transfer this file to the new server.

6. Import PostgreSQL database. 

•  Once you've transferred the dbc archive file to the new server, import it by 

dragging the file on to pg_tools.exe, located at (C:\Program Files (x86)\Electro 

Industries\MeterManager\pg_tools.exe). This will then import the data to the 

new server.

7. Verify the migration. 

•  Verify that everything is operating correctly by manually inspecting your 

configuration, as detailed in the following bullets.

• Meter List - Verify that all your meters show up in the meter list and 

meter log data can be accessed. Also verify that you can connect to all 

your meters: this can be done automatically with the Online Scan script 

(see the instructions for the Test All Connections option in 18.12.1: Test 

All Connections, on page 18-158). 

• ReportExporter Configuration - Check that ReportExporter configured 

reports are available and are configured correctly (see 18.6: Report 

Exporter, on page 18-58).
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• EnergyReporterPQATM Data - Verify that the EnergyReporterPQATM data 

can be viewed by going to EnergyReporter Settings Editor>Meter>Edit 

Meter Data and viewing the data. Verify the range of data available and 

spot check the data. See the EnergyReporterPQATM User Manual for 

instructions. You can download the manual from https://www.elec-

troind.com/products/energyreporterpqa-utility-billing-software/.

8. Reconfigure migrated settings.

•  Some settings, such as the ReportExporter report locations, are computer spe-

cific. If you are not using the default export location, check to see if you need to 

reconfigure the report locations. Also, if you are using mapped drives, the con-

figured mapped drive settings may need to be reconfigured for the new server.

 
G.4: Troubleshooting

Following are some issues you may encounter and remedial actions.

1. Meters offline:

•  Meter Ethernet IP addresses can be different on the new server, depending on 

your network topology. Confirm that all IP addresses are configured appropri-

ately and that your network firewalls are not blocking PING or Modbus TCP (TCP 

502) from the new server.

2. Smaller than expected dbc archive or missing data in EnergyReporterPQATM after 

exported the PostgreSQL database:

•  If you are using the EnergyReporterPQATM application and the dbc archive file is 

small (<50 MB) or if EnergyReporterPQATM is missing data, the export may have 

encountered a problem. The most common causes are:

• Restricted space on the C:\ drive on the old server.

• Limited memory on the old server.

• Restricted permissions.

• Older file systems that limit maximum file sizes. 

•  If you encounter this problem and freeing up space does not help, contact Electro 

Industries technical support at 516-334-0870, for further assistance.

https://www.electroind.com/products/energyreporterpqa-utility-billing-software/
https://www.electroind.com/products/energyreporterpqa-utility-billing-software/
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Glossary 
0.1 Second Values: These values are the RMS values of the indicated

quantity as calculated after approximately 50 

milliseconds (3 cycles) of sampling.

1 Second Values: These values are the RMS values of the indicated

quantity as calculated after one second (60

cycles) of sampling.

Alarm: An event or condition in a meter that can cause a

trigger or call-back to occur.

Annunciator: A short label that identifies particular quantities or

values displayed, for example kWh.

Average (Current): When applied to current values (amps) the aver-

age is a calculated value that corresponds to the

thermal average over a specified time interval.

The interval is specified by the user in the meter

profile. The interval is typically 15 minutes.

So, Average Amps is the thermal average of Amps

over the previous 15-minute interval. The thermal

average rises to 90 of the actual value in each

time interval. For example, if a constant 100 Amp

load is applied, the thermal average will indicate

90 Amps after one time interval, 99 Amps after

two time intervals and 99.9 Amps after three time

intervals.

Average (Input Pulse 

Accumulations): When applied to Input Pulse Accumulations, the

 “Average” refers to the block (fixed) window

average value of the input pulses.

Average (Power): When applied to power values (Watts, VARs, VA),

the average is a calculated value that corresponds

to the thermal average over a specified time 
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interval. The interval is specified by the user in

the meter profile. The interval is typically 15

minutes. So, the Average Watts is the thermal

average of Watts over the previous 15-minute

interval. The thermal average rises to 90 of the

actual value in each time interval. For example, if

a constant 100kW load is applied, the thermal

average will indicate 90kW after one time interval,

99kW after two time intervals and 99.9kW after

three time intervals.

Bit: A unit of computer information equivalent to the

result of a choice between two alternatives (Yes/

No, On/Off, for example).

Or, the physical representation of a bit by an 

electrical pulse whose presence or absence 

indicates data.

Binary: Relating to a system of numbers having 2 as its

base (digits 0 and 1).

Block Window Avg: The Block (Fixed) Window Average is the average

power calculated over a (Power) user-set time

interval, typically 15 minutes. This calculated

average corresponds to the demand calculations

performed by most electric utilities in monitoring

user power demand. (See Rolling Window 

Average.)

Byte: A group of 8 binary digits processed as a unit by a

computer (or device) and used especially to 

represent an alphanumeric character.

CBEMA Curve: A voltage quality curve established originally by

the Computer Business Equipment Manufacturers

Association. The CBEMA Curve defines voltage

disturbances that could cause malfunction or

damage in microprocessor devices. The curve is
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characterized by voltage magnitude and the 

duration which the voltage is outside of tolerance.

(See ITIC Curve.)

Channel: The storage of a single value in each interval in a

load profile.

Cold Load Pickup: This value is the delay from the time control

 power is restored to the time when the user

wants to resume demand accumulation.

CRC Field: Cyclic Redundancy Check Field (Modbus 

communication) is an error checksum calculation

that enables a Slave device to determine if a

request packet from a Master device has been

corrupted during transmission. If the calculated

value does not match the value in the request

packet, the Slave ignores the request.

CT (Current) Ratio: A Current Transformer Ratio is used to scale the

value of the current from a secondary value up to

the primary side of an instrument transformer.

Cumulative Demand: The sum of the previous billing period’s maximum

demand readings at the time of billing period

reset. The maximum demand for the most recent

billing period is added to the previously accumu-

lated total of the maximum demands.

Demand: The average value of power or a similar quantity

over a specified period of time.

Demand Interval: A specified time over which demand is calculated.

Display: User-configurable visual indication of data in a

meter.

DNP3: A robust, non-proprietary protocol based on exist-

ing open standards. DNP3 is used to operate
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between various systems in electric and other

utility industries and SCADA networks. 

EEPROM: Nonvolatile memory. Electrically Erasable 

Programmable Read Only Memory that retains its

data during a power outage without need for a

battery. Also refers to meter’s FLASH memory.

Energy Register: Programmable record that monitors any energy

quantity. Example: Watthours, VARhours, 

VAhours.

Ethernet: A type of LAN network connection that connects

two or more devices on a common communica-

tions backbone. An Ethernet LAN consists of at

least one hub device (the network backbone) with

multiple devices connected to it in a star configu-

ration. The most common versions of Ethernet in

use are 10BaseT and 100BaseT as defined in IEEE

802.3 standards. However, several other versions

of Ethernet are also available.

Exception Response: Error Code (Modbus communication) transmitted

in a packet from the Slave to the Master if the

Slave has encountered an invalid command or

other problem.

Flicker: Flicker is the sensation that is experienced by the

human visual system when it is subjected to

changes occurring in the illumination intensity of

light sources. IEC 61000-4-15 and former IEC

868 describe the methods used to determine

Flicker severity.

Form: Wiring and Hookup configuration for the Nexus®

1262/1272 meter.

Harmonics: Measuring values of the fundamental current and

voltage and percent of the fundamental.
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Heartbeat Pulse: Energy indicator on the face of the Nexus® 1252

meter; pulses are generated per the programmed

Ke value.

I2T Threshold: When the current is above the set threshold, data

will begin to be accumulated.

Infrared Test Pulse: Energy indicator located on the upper left side of

the face of the Nexus® 1262/1272 meter; pulses

are generated per the programmed Ke value.

Integer: Any of the natural numbers, the negatives of

those numbers, or zero.

Internal Modem: An optional modem within the meter’s enclosure

that connects to the RJ11 telephone connector.

Invalid Register: In the Nexus® meter’s Modbus Map there are

gaps between Registers. For example, the next

Register after 08320 is 34817. Any unmapped

Register stores no information and is said to be

invalid.

ITIC Curve: An updated version of the CBEMA Curve that

reflects further study into the performance of

microprocessor devices. The curve consists of a

series of steps, but still defines combinations of

voltage magnitude and duration that will cause

malfunction or damage.

Ke: kWh per pulse; i.e. the energy.

kWh: Kilowatt hours; kW x demand interval in hours.

KYZ Output: Output where the rate of changes between 1 and

0 reflects the magnitude of a metered quantity.

LCD: Liquid Crystal Display.

LED: Light Emitting Diode.
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Master Device: In Modbus communication, a Master Device 

initiates and controls all information transfer in

the form of a Request Packet to a Slave Device. 

The Slave reponds to each request.

Maximum Demand: The largest demand calculated during any interval

over a billing period.

Modbus ASCII: Alternate version of the Modbus protocol that 

utilizes a different data transfer format. This 

version is not dependent upon strict timing, as is

the RTU version. This is the best choice for 

telecommunications applications (via modems).

Modbus RTU: The most common form of Modbus protocol. 

Modbus RTU is an open protocol spoken by many

field devices to enable devices from multiple 

vendors to communicate in a common language. 

Data is transmitted in a timed binary format, 

providing increased throughput and therefore,

increased performance.

Network: A communications connection between two or

more devices to enable those devices to send and

receive data to one another. In most applications,

the network will be either a serial type or a LAN

type.

NVRAM: Nonvolatile Random Access Memory is able to

keep the stored values in memory even during

the loss of circuit or control power. High speed

NVRAM is used in EIG meters to gather

measured information and to insure that no 

information is lost.

Optical Port: A port that facilitates infrared communication with

a meter. Using an ANSI C12.13 Type II magnetic

optical communications coupler and an RS232

 or USB cable from the coupler to a PC, the meter
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can be programmed with CommunicatorPQA®

software.

Packet: A short fixed-length section of data that is trans-

mitted as a unit. For example: a serial string of 

8-bit bytes.

Percent () THD: Percent Total Harmonic Distortion. (See THD.)

Protocol: A language that will be spoken between two or

more devices connected on a network.

PT Ratio: Potential Transformer Ratio used to scale the

value of the voltage to the primary side of an

instrument transformer. Also referred to as VT

Ratio.

Pulse: The closing and opening of the circuit of a two-

wire pulse system or the alternate closing and

opening of one side and then the other of a three-

wire system (which is equal to two pulses).

Q Readings: Q is the quantity obtained by lagging the applied

voltage to a wattmeter by 60 degrees. Values are

displayed on the Uncompensated Power and Q

Readings screen.

Quadrant: Watt and VAR flow is typically represented using

(Programmable an X-Y coordinate system. The four corners of the 

Values and Factors X-Y plane are referred to as quadrants. Most

on the Nexus Meter) power applications label the right hand corner as

the first quadrant and number the remaining

 quadrants in a counter-clockwise rotation. 

Following are the positions of the quadrants: 

1st - upper right, 2nd - upper left, 3rd - lower left

and 4th - lower right. Power flow is generally 

positive in quadrants 1 and 4. VAR flow is positive

in quadrants 1 and 2. The most common load 

conditions are: Quadrant 1 - power flow positive,
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VAR flow positive, inductive load, lagging or 

positive power factor; Quadrant 2 - power flow

negative, VAR flow positive, capacitive load, 

leading or negative power factor.

Register: An entry or record that stores a small amount of

data.

Register Rollover: A point at which a Register reaches its maximum

value and rolls over to zero.

Reset: Logs are cleared or new (or default) values are

sent to counters or timers.

Rolling Window

Average (Power):  The Rolling (Sliding) Window Average is the 

average power calculated over a user-set time

interval that is derived from a specified number of

sub-intervals, each of a specified time. For 

example, the average is calculated over a 

15-minute interval by calculating the sum of the

average of three consecutive 5-minute intervals.

This demand calculation methodology has been

adopted by several utilities to prevent customer

manipulation of kW demand by simply spreading

peak demand across two intervals.

RS232: A type of serial network connection that connects

two devices to enable communication between

devices. An RS232 connection connects only two

points. Distance between devices is typically 

limited to fairly short runs. Current standards 

recommend a maximum of 50 feet but some

users have had success with runs up to 100 feet.

Communications speed is typically in the range of

1200 bits per second to 57,600 bits per second.

RS232 connection can be accomplished using Port
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1 of the Nexus® 1252 meter or EIG meters’ 

Optical Ports.

RS485: A type of serial network connection that connects

two or more devices to enable communication

between the devices. An RS485 connection will 

allow multi-drop communication from one to

many points. Distance between devices is 

typically limited to around 2,000 to 3,000 wire

feet. Communications speed is typically in the

range of 1200 bits per second to 115,000 bits per

second.

Sag: A voltage quality event during which the RMS

voltage is lower than normal for a period of time,

typically from 1/2 cycle to 1 minute.

Secondary Rated: Any Register or pulse output that does not use

any CT or VT Ratio.

Serial Port: The type of port used to directly interface with a

PC.

Slave Device: In Modbus communication, a Slave Device only

receives a Request Packet from a Master Device

and responds to the request. A Slave Device 

cannot initiate communication.

Surge/Swell: A voltage quality event during which the RMS

voltage is higher than normal for a period of time,

typically from 1/2 cycle to 1 minute.
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TDD: The Total Demand Distortion of the current 

waveform. The ratio of the rootsum-square value

of the harmonic current to the maximum demand

load current (see equation below).

NOTE: The TDD displayed in the Harmonics

screen is calculated by the meter, using settings in

the Device Profile. 

THD: Total Harmonic Distortion is the combined effect

of all harmonics measured in a voltage or current.

The THD number is expressed as a percent of the

fundamental (see equation below). For example, 

 3 THD indicates that the magnitude of all 

harmonic distortion measured equals 3 of the

magnitude of the fundamental 60Hz quantity. The

THD displayed is calculated by your meter.

Time stamp: A stored representation of the time of an event.

Time stamp can include year, month, day, hour,

minute and second and Daylight Savings Time

indication.

TOU: Time of Use.

Uncompensated Power: VA, Watt and VAR readings not adjusted by 

Transformer Loss Compensation.

V2T Threshold: When the voltage is above the set threshold, data

will begin to be accumulated.

TDDI

I2
2 I3

2 I4
2 I5

2 + + + +

IL
------------------------------------------------------ 100=

THDI

I2
2 I3

2 I4
2 I5

2 + + + +

I1
------------------------------------------------------ 100=
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Voltage, Vab: Vab, Vbc, Vca are all Phase-to-Phase voltage

measurements. These voltages are measured

between the three phase voltage inputs to the

meter.

Voltage, Van: Van, Vbn, Vcn are all Phase-to-Neutral voltages

applied to the monitor. These voltages are 

measured between the phase voltage inputs and

Vn input to the meter. Technologically, these 

voltages can be “measured” even when the meter

is in a Delta configuration and there is no connec-

tion to the Vn input. However, in this configura-

tion, these voltages have limited meaning and are

typically not reported.

Voltage Imbalance/Unbalance: As defined by National Equipment Manufacturer’s

Association (NEMA), the formula for voltage 

unbalance is: 

Voltage Quality Event: An instance of abnormal voltage on a phase. The

events the meter will track include sags, swells,

interruptions and imbalances.

VT Ratio: The Voltage Transformer Ratio is used to scale the

value of the voltage to the primary side of an

instrument transformer. Also referred to as PT

Ratio.

VoltageUnbalance
Maximum deviation from the mean of Vab, Vbc, Vca

Mean of Vab, Vac, Vca
------------------------------------------------------------------------------------------------------------------------------=
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Voltage, Vaux: This is the fourth voltage input measured from

between the Vaux and Vref inputs. This input can

be scaled to any value. However, the actual input

voltage to the meter should be of the same 

magnitude as the voltages applied to the Va, Vb

and Vc terminals.
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